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End User License Agreement (EULA) 

THIS AGREEMENT IS YOUR PROOF OF LICENSE. PLEASE TREAT IT AS VALUABLE 
PROPERTY: 

This legal document constitutes the complete agreement between you, the end 
user, and SoundPLAN GmbH. All rights not expressly granted in this License 
Agreement are reserved by SoundPLAN GmbH. 

The right to use the SoundPLAN program and its auxiliary applications is sold only 
on the condition that the user agrees to the following License Agreement.   

COPYRIGHT/PROPRIETARY PROTECTION 

The SoundPLAN program, auxiliary applications, and documentation are owned by 
SoundPLAN GmbH (hereafter author) and are protected by the Federal Republic of 
Germany and international copyright and trademark laws and treaty provisions.  
You shall be held legally responsible for any copyright infringement that is caused 
or encouraged by your failure to abide by the terms of this Agreement. 

OWNERSHIP OF SOUNDPLAN 

The author retains sole title and ownership of the SoundPLAN software, regardless 

of the form or media in or on which the original and other copies may exist.  As the 
licensee, you own the magnetic or other physical media on which the SoundPLAN 
program is subsequently recorded or fixed.  This Agreement is not a sale of the 
original SoundPLAN software or any copy thereof.  All rights are reserved by the 
author. 

GRANT OF LICENSE 

In consideration of payment of the single license fee, the author grants each 

purchasing location a non-exclusive right to use and display copies of the 
SoundPLAN software on a CPU.  This Agreement grants you the right to make one 
copy of the software for archival purposes, and to copy the software on the hard 
disk of your computer.  The software may be loaded on to multiple computers but 
can only be executed on a single computer at any given time.  The computer 
operating the SoundPLAN software needs to have the hardlock delivered with the 
software attached to the parallel printer port. 

HARDLOCK 

Granting of a license is bound to SoundPLAN software use with a hardlock.  If a 
hardlock is lost, it will be replaced with purchase of a new license.  If a hardlock is 
defective during the warranty period (first licensed year), The author will replace 
the hardlock.  The customer will pay the hardlock fee for replacing the hardlock 
should it become defective after the warranty period. 

LICENSE RESTRICTIONS 

Unauthorized copying of SoundPLAN to others is not permitted.  The modification, 

adaptation, translation, reverse engineering, de-compiling, disassembling, attempt 
to discover the source code of the software, or the creation of derivative work 
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based on SoundPLAN software is strictly prohibited.  In no way may you transfer, 
assign, rent sub-licenses, lease, sell, or otherwise dispose of any portion of the 
software on a temporary or permanent basis. 

TRANSFER RESTRICTIONS 

The SoundPLAN software is licensed only to the licensee and may not be 
transferred to anyone without the prior written consent of the author.  Any 
authorized transfer of the SoundPLAN software shall be bound by the terms and 
conditions of this Agreement. 

TERMINATION 

This license is effective until termination.  This license will terminate automatically 
without notice from the author if you fail to comply with any provision of this 
Agreement.  Upon termination, you shall destroy the written materials and all 
copies of the SoundPLAN software, including archival copies, if any. 

NO LIABILITY FOR DAMAGES 

Neither The author nor anyone else who has been involved in the creation, 
production, distribution or delivery of this program shall be liable (including, 
without limitation, damages for loss of profits, business interruption, loss of 
information, incorrect results, recovery of data, or other pecuniary loss) for any 
direct, indirect, consequential, or incidental damages resulting from any defect in 
the software, update version, or its documentation, or arising out of the use, the 
results of use, or inability to use the product, even if the author has been advised 
of the possibility of such damage or claim. 

LIMITED WARRANTY 

The author makes no warranty or representation, either expressed or implied, 
including, but not limited to, implied warranties or merchantability and fitness for a 
particular purpose, with respect to this product. As a result, this software is sold "as 
is" and you the licensee are assuming the entire risk as to its quality and 
performance.  No author, distributor, agent, or employee is authorized to make any 
modification, extension or addition that will increase the scope of this warranty.  If 
a physical defect in the product is discovered, the author's entire liability and your 
exclusive remedy will be replacement of the disk(s).  This limited warranty applies 
only if you return all copies of the product, along with proof of purchase, including 
purchasing date, to the author or an authorized SoundPLAN distributor within 1 
year of the date you received the product.  Any replacement product will be 
warranted for the remainder of the original 1-year warranty period. 

UPDATE POLICY 

The author may create, from time to time, update versions of the SoundPLAN 
software.  The author reserves the right to make changes to the software or its 
documentation without notice.  At its option, the author will make such updates 
available to registered users who have paid the update fee. 
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GENERAL 

This Agreement constitutes the entire agreement between you and the author 
concerning the SoundPLAN product.  If any provision of this Agreement shall be 
declared void or unenforceable, the validity of this Agreement and all other 
provision shall not be affected.  This Agreement shall be governed and construed in 
accordance with the laws of the Federal Republic of Germany, place of jurisdiction: 
Waiblingen, Germany. 

The author is not bound by any provision of any purchase order, receipt, 
acceptance, confirmation, correspondence, or otherwise, unless the author 
specifically agrees to the provision in writing. 

The author product support and service is only provided to valid, registered 
SoundPLAN users. 
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1  Installation and Service 

New installation 
The SoundPLANnoise software can be installed using several different formats and 
license models. Demo versions only require the installation DVD or the installation 
file downloaded from our website. This version only allows the user to experience 
SoundPLAN via projects downloaded from the web or the SoundPLAN DVD or from 
someone with a licensed copy of SoundPLAN. A SoundPLAN user can use the demo 
version to pass on a project so that the client can explore but not modify it, the 
SoundPLAN demo version acts as a reader for SoundPLAN data. The function to 
save data to the hard-disk is disabled in the demo version. If you want to 
experience SoundPLAN as a fully licensed copy, you can request a license file from 
your SoundPLAN trading partner for a provisional license. This provisional license 
does not require a copy protection key but is restricted to a life of a maximum of 30 
days. Once the provisional license has expired on a PC, it is not possible to install it 
again on the same PC. 

When you have acquired SoundPLAN as a licensed copy, you can install it as a 
stand-alone program requiring the copy protection key attached to your PC or as a 
network license where the copy protection key is installed on one PC in your 
network and the executable copy can be installed on another PC. The network 
license can have up to 50 users working with SoundPLAN at the same time, 
depending on how many seats have been ordered for the network license. 
Regardless if you have a stand-alone or a network copy of SoundPLAN, the initial 
copy of your license file will contain temporary elements. When the license fee has 
been paid, SoundPLAN (GmbH or LLC) will automatically send you the new license 
file. This file must be installed and also should be saved to a safe place as this file 
should be used if you have the need to move SoundPLAN to a different PC. (See 
license update below) 

Newer SoundPLAN versions can be installed parallel to older versions on the same 
PC. 
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If you have a 64-Bit operating system it would be wise to install both SoundPLAN 
versions, SoundPLAN 32-Bit and SoundPLAN 64-Bit, as the 32-Bit SoundPLAN 
version has some advantages for everyday work:  

Google Earth at the moment is only available as a 32-Bit-version and therefore 
cannot be started from the 64-Bit variant.  On some computers and some graphics 
cards OpenGL also is causing some problems in the native 64-Bit version. 

The SoundPLAN installation files are delivered on a DVD. For the installation you 
also need a Hardlock/HASP copy protection key and your specific license file. The 
license file needs to have the same 4-digit serial number as was printed on the copy 
protection key. If you are new to SoundPLAN, have purchased new modules or use 
an educational license, your license file will have modules with a temporary setting. 
This temporary license file must be replaced later by either a new temporary 
license file (with an expiration date in the future if you are using an educational 
license) or by a permanent license file. See below in the chapter Update License. 

The DVD has an auto run function, automatically opening the DVD browser. Within 
the browser, you can install the software and get additional information. During 
the installation the manual is copied to your PC. Demo and test projects can be 
copied after the software installation. If the auto run function is disabled on your 
PC, please call „SPbrowser.exe“ from the Windows Explorer. 

Before starting with the SoundPLAN installation, log in as the Administrator. 

• Attach the SoundPLAN Hardlock / HASP to the USB port before you start the 
installation. 

• If you want to install SoundPLAN as a demo version, there is no need for a 
license file. To install SoundPLAN as a fully licensed copy, you should copy 
the license file you received as an attachment of an e-mail to a location on 
your PC from where you can retrieve it during the installation.  

• Insert the DVD, auto run opens the SoundPLAN Browser. 

• Call INSTALL SOUNDPLAN from the browser and decide whether you want to 
install the FULL VERSION or the DEMO VERSION. 

The installation program will prepare the installation and guides you through it.  

SoundPLAN delivers templates (pre-settings for the calculation standard selection 
and time slices, templates for tables and graphics sheets) and libraries for the 
requirements in different countries. Moreover, the program user interface and the 
online help and manual are available in several languages.  

The language selection is performed in accordance to the language and country 
settings of Windows. You can add further languages and country settings. 
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When starting SoundPLAN for the first time, select the language and country 
settings you want to use - you can change these settings any time in the 
SoundPLAN Manager. 

To complete the installation of the full version, the installation program will ask for 
the path where you stored the license file (BABGxxxx.007). Select the path and click 
„OK“. SoundPLAN transmits your program modules. 

Open SoundPLAN using “Start -> All programs”. 

Installation of a new version if SoundPLAN has already 
been installed 

Several SoundPLAN versions can be installed and run parallel on the same PC. 

The installation checks whether an older SoundPLAN version has been installed on 
your PC. If so, you don’t need the license file, the installation looks for a valid file on 
the hard disk. 

As soon as a license file has been found, the installation will display the path. Click 
OK or enter another path here. 

Starting SoundPLAN for the first time 

When starting the program for the first time, fill in the settings for the SoundPLAN 
initialization: 
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If an older SoundPLAN version is found on the PC, you will be asked with the first 
start of the new version if you want to copy your existing "Globdata" folder to a 
new location. If you have customized the global settings (object definitions, colors, 
libraries etc.), it makes sense to copy them to the new Globdata. If not, it is better 
to start with a fresh set of templates taken over from the system settings. It is also 
possible to copy individual files to the new Globdata using the Windows explorer. 

Updating SoundPLAN 
After you have installed the latest DVD version, updates of SoundPLAN are 
available for download from the Internet. Via HELP -> UPDATES & DOWNLOADS you 
get access to the latest update as well as to updated files in the system folder such 
as libraries and templates and also help text, the handbook and demo projects.  

SoundPLAN analyzes the files installed on your computer and indicates the dates of 
the files available versus the dates on your computer. As soon as the files on the 
SoundPLAN web are of a more recent date, they are automatically checked for 
download, however you can decide if you want to load these files or are also 
interested in loading others. Activate/deactivate the check mark in the box 
accordingly. 

This way you can for example download the most recent version of the manual 
even if the new manual was not ready when the SoundPLAN installation DVD was 
produced. Another possibility is to download and install templates and libraries for 
other regional markets. 

In the lower part of the dialog you can define the path where these files are to be 
stored. By default, these files are set to be saved in the location where your 
SoundPLAN Globdata is stored, the downloaded files are saved to the sub folder 
Download.   
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Please assure that you have the administrator rights. Click on DOWNLOAD. The files 
are subsequently copied into the download folder you specified. To install/activate 
the downloaded files click on INSTALL UPDATES. Before the SoundPLAN update is 
installed you can look at the changes in the readme file and change the installed 
program languages. With OK the update is installed. 

Via the download path you can also make the files available in your computer 
network to distribute the update amongst your colleagues or to update multiple 
computers from this location.  

License update 

A license update updates the license information of your version, e.g. if you had a 
temporary license file or purchase additional modules. Copy the license file 
(BAB?xxxx.007) to your PC and execute the license update from START -> ALL 

PROGRAMS -> SOUNDPLAN XX -> SOUNDPLAN UPDATE LICENSE (may be slightly 
different for other Windows versions than Windows 10). The program will ask for 
the location where you had stored your license file BAB?xxxx.007. 

Notification of new updates 

The first time you open SoundPLAN you can set a check mark that the program 
should search the web if a new version of the program is available. 

In the program settings (OPTIONS -> SETTINGS) you can modify this setting any time. 
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Install network license 

Aside from the single seat license safeguarded by a locally installed Hardlock or 
HASP key, SoundPLAN is available as a network license. The individual PC running 
SoundPLAN does not need a copy protection key, the copy protection is managed 
as a cooperation between the user’s PC and the license server PC. The license 
server PC does not have to be a special “server” with extra computation power, a 
standard PC running 24/7 in the company’s network is sufficient. The licensing 
software installed as a service has the advantage that it automatically starts with 
the PC and can cooperate with the SoundPLAN software in the entire network, 
regardless of the SoundPLAN version (7.2, 7.4, 8.0...) or if the software is 32 or 64 
bit. 

It is absolutely paramount that the license server is installed first, starting with 
attaching the HASP key to one of the servers USB ports. After the server installation 
the SoundPLAN software can be installed on the user’s PC. As the licensing requires 
constant cooperation between the license server and the user’s PC, the PC needs to 
be on the network with a connection to the server PC. The parameters for this 
communication will become the basis of future logins at the license server.              

The network must be stable and available 100% of the time so that the license 
manager will get informed when you terminate the SoundPLAN program. Basically, 
you get a license from the license server and must return it to the license server 
when you end the program, otherwise your license server will run out of license to 
give to SoundPLAN users.  

SoundPLAN can be installed on an unlimited number of PCs but it can only be used 
when a license is available. If you log in from a PC in the network, a request for a 
login is sent to the license server and if a license is available, SoundPLAN starts and 
the number of available licenses is decremented. If the number of user PCs logged 
in to the license server PC is already equal to the number seats acquired, additional 
request for a login to the SoundPLAN license server will be denied.  

In a SoundPLAN networked installation as many users can work concurrently as 
license seats are available.  

The network license can work with a normal in-house network and also via VPN 
(Virtual Private Network) to connect to a SoundPLAN license server out-of-house 
(in another building, from home or another town). If your network is stable but you 
still receive notice that the communication is not working properly, please contact 
the SoundPLAN hotline.  

Another additional (additional charges) option is the borrow function for the 
network license to work for a limited time with a detached license that does not 
require a constant network connection. With this option, a license is detached from 
the license pool from the SoundPLAN license server and assigned to the PC 
borrowing the license. When the borrowed license is returned, the number of 
available parallel logins is incremented. The borrow function for the network 
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license can be installed at any time after the installation of the network license. The 
borrow function is not available for educational licenses. 

Installation of the license server PC 

Any computer in the network can act as the SoundPLAN license server, if you 
expect to be able to start SoundPLAN at any given time, the PC of the license server 
must run 24/7 (does not get powered down at night or on weekends). On the 
license server PC, the HASP driver is installed that organizes the communication 
between the user PC and the license server PC. This installation is not dependent 
on the version of SoundPLAN. This means that the installation at the license server 
is only required one time. 

1. Log in at the PC with the Administrator rights 

2. Attach the HASP HL Net Key to a USB port of the PC. 

3. Install the HASP driver: 

Place the DVD in the appropriate drive and navigate in the auto start browser to 
SOUNDPLAN NOISE / AIR and start the NETWORK INSTALLATION. 

Select INSTALL LICENSE SERVER and select the option LICENSE SERVER (HASP) WITHOUT 

BORROW FUNCTION.  

 

Click OK to start the driver installation. Please follow the installation script.  

To inspect and diagnose the HASP Net Key, you can use the Admin Control Center, 
that was installed along with the HASP driver. It is a web browser based application 
and can be opened directly from the SoundPLAN Manger under HELP -> LICENSE 

INFORMATION or with a web browser such as the Internet Explorer with the address 
http://localhost:1947/. 

Activate the additional option „borrow license“  

License borrowing is an additional functionality of a HASP based network license. 
This option needs to be activated one time on the license server PC and does not 
depend on the version of SoundPLAN. Keep in mind that when all licenses are 
detached and connected to a user’s PC, no additional licenses are available in the 
net. 

http://localhost:1947/
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Important: The license for borrowing is bound to the license server PC and is using 
the unique identifiers of this PC, therefore it cannot easily be moved to a different 
PC. If you need to replace the license server PC, get in touch with your trading and 
support partner before you replace the PC.  

Log in as the administrator. 

Place the DVD in the appropriate drive and in the DVD Browser open the NETWORK 

INSTALLATION for SOUNDPLAN NOISE / AIR. Select INSTALL LICENSE SERVER and here 
the option LICENSE SERVER (HASP) WITH BORROW FUNCTION, STEP 1.  

 

Click OK, the installation of the driver starts and the HASP-update program is 
started, the tab Collect Key Status Information is active.  

Click on COLLECT INFORMATION. The next dialog shows all installed HASP-licenses.  

 

Select the line with HASP SL and click OK. 

In the following SAVE UNDER dialog a file is generated for the key-status. The file 
has the extension c2v. Please enter the file name as BABN and your four-digit 
license number (printed on the HASP LH Max Net key), for example BABN1234. The 
file extension is automatically added.   

Please send this file, in our example BABN1234.c2v, attached to an e-mail to 
marketing@soundplan.com. In the e-mail please write how many of your 

licenses you would like to be able to be borrowed, this can be at the most the 
number of licenses that you have seats for in your network license. 

We will send you back an activation file (BABN1234.v2c) and a modified license file 
BABN1234.007.  

! 

mailto:marketing@soundplan.com
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Save both files to your PC and in the SoundPLAN Browser (SoundPLAN DVD) open 
SOUNDPLAN NOISE / AIR NETWORK INSTALLATIONS. 

Select the option INSTALL LICENSE SERVER and select the function LICENSE SERVER 

(HASP) WITH THE FUNCTION LICENSE BORROWING, STEP 2. Click on ok and the HASP 
update program will open. Move to the tab Apply License Update.  

 

 With the selection button select the activation file (BABN1234.v2c); 
click on APPLY UPDATE. 

Now open the Admin Control Center in the internet browser with 
http://localhost:1947/ to activate the borrowing.  

The list of Sentinel Keys now should show your HL Net key and a -License: 

 

On the left of the Admin Control Center click on CONFIGURATION and select the tab 
Detachable Licenses.  

 

Activate ENABLE DETACHING OF LICENSES and click the function SUBMIT. 

 

http://localhost:1947/
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Replace the license server 

If the license server needs to be replaced, first the HASP driver and the HASP HL 
Net Key must be installed at the new license sever PC, see "Installation of the 
license server PC (page 27)". 

Normally the client PCs automatically recognize the new license server. In case it 
fails, please check the configuration settings in the ACC (Admin Control Center), see 
section "Troubleshooting (page 31) ". 

Installation on you work PC 

Install SoundPLAN like described under "New installation (page 21)". The license 
file is BABNxxx.007 with xxxx being your license number. During the installation 
your PC needs to be connected to the SoundPLAN license server via your network.  

If SoundPLAN has already been installed on your PC, it is enough to do a "License 
update (page 25)" to update the settings for your new capabilities. 

If a borrow function was activated, the license file (BABNxxx.007) sent with the .v2c 
file must be stored in the SoundPLAN folder and then must be activated with a 
"License update (page 25)" on your PC. 

It is also possible to install a user PC installation on the same PC as the SoundPLAN 
license server PC. 

Borrow license 

To borrow (detach) a license from the pool, open the SoundPLAN Manager HELP -> 

BORROW NETWORK LICENSE.  

 

BORROW LICENSE: Takes a license from the networked license pool and binds it to 
the requesting computer. At the same time the number of licenses available in the 
pool is decremented by one. The detached license is valid for the requested time 
frame, but it can be returned before the end of the time, then the detached license 
is no longer functioning and the number of licenses available in the network pool is 
incremented by one. 

RETURN A BORROWED LICENSE: When you decide, you do no longer need the 
detached license although the borrowing time is not used up, you can return it to 
the network license pool. 
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After detaching a license: 

• SoundPLAN needs to be re-started in order to log on to the borrowed 
license. 

• If you have disconnected the computer from the network, wait 1-2 minutes 
before starting SoundPLAN. The license manager needs a little bit of time to 
recognize the new status. If not the program will indicate a network 
connection error. 

• The preferred login of SoundPLAN is to the local borrowed license, even if a 
network connection exists. Before you can log on to a conventional network 
license, you need to return the borrowed license. 

Click on DETAILS, to get more detailed information on the status of the network 
license. When you for example get the message that no more licenses are available 
for borrowing, here you can look up which computer currently has the borrowed 
licenses. 

Troubleshooting 

If you have installed a HASP network license and the installation of SoundPLAN on 
the client PCs fails (e.g. Setup Error 1130,7) then maybe the HASP HL Net Key on 
the server PC is not recognized at the client PC. 

Then check the configuration in the Admin Control Center.  

Open the Sentinel Keys list in the ACC of the local PC: 
http://localhost:1947/_int_/devices.html. 

The SoundPLAN HL Net key should be displayed as shown with the Vendor ID 
“89940”. 

 

If the SoundPLAN HL Net key is not displayed, then enter the configuration page: 

• Select the tab sheet “Access to Remote License Managers” 

• Set the check marks as shown. 

• Specify the computer name or the IP address of the server PC in the Search 
Parameters field. 

• Then press “Submit” to activate the changes; wait a few seconds. 

• At persistent problems try the check mark “Aggressive Search…”. 
 

http://localhost:1947/_int_/devices.html
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Check the keys list again: if the HL Net key is displayed, SoundPLAN will recognize it 
too and work normally. 

If there should be still problems, please send the update.log file 
(c:\ProgramData\SoundPLAN\) and a report from the Diagnostics page 
(http://localhost:1947/_int_/diagnostics.html) of the concerned PC. 

Additional hints 

On a work PC multiple different licenses can be installed with various 
configurations of (Hardlock, HASP, network license; SoundPLAN noise and 
SoundPLAN air). When starting the application, the following license selection is 
shown. 

 

For each license file that should be installed, the license update needs to be carried 
out. 

If you are the proud owner of a new PC and want to move an older version of 
SoundPLAN to the new PC, please keep in mind that the HASP driver is always 
downwards compatible but most likely not upwards compatible if your new PC has 
a new operating system. In this case download a new version of the HASP driver 
from the web. The latest HASP driver is always available under: 
www.soundplan.eu/tools/HASP_Run-time_setup.zip.  

Install updates simultaneously on several computers 
The program “distribute updates“ is a tool to install updates and updated libraries, 
system files/templates and manual/online help from your computer 
simultaneously on any number of computers within a network. Once the update 
program has been installed as a service, administrator rights are no longer required 
to install the updates. "Distribute updates" is automatically installed with the 
SoundPLAN installation. 

http://localhost:1947/_int_/diagnostics.html
http://www.soundplan.eu/tools/HASP_Run-time_setup.zip
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Distribute updates and system files 

Download the latest update vial UPDATES & DOWNLOADS in the Help menu of the 
SoundPLAN Manager of from the external update website. User name and 
password are available from the SoundPLAN support.  

It is advisable to store the updates you downloaded from the internet in the 
specified folder on a specified PC. (This folder does not have to be on the PC you 
use to distribute the updates, it can be on any computer in the network.) 

Select the path where the updates have been stored clicking on the button with the 
two small dots and double click on the update. The path and the update date are 
displayed on the screen.  

Call the program from the start menu (ALL PROGRAMS -> SOUNDPLAN XX -> 

DISTRIBUTE UPDATES). 

Use EDIT PC LIST to type in the computer names or the IP addresses of the 
computers which should be updated. With SEARCH (within the PC list) you can 
search for all computers logged in to the network and display them in the list. (This 
might take some time within large networks.) 

Computers for which no update installation is planned can be removed from the 
list.  

Highlight the desired computers on the left-hand side and select them with the 
arrow button. The double arrow activates all listed computers. 

 

From the table select the updates and system files to be installed.  

Click CONNECT AND DISTRIBUTE UPDATE. As soon as the installation has been 
successful the date of the installed update version is displayed next to the 
computer name. If the old update version is still displayed, the network connection 
was successful but for some reason the update couldn’t be installed (often because 
SoundPLAN or one of its sub-programs is currently open on this computer). The 
logbook shows warnings and errors in red color (for example if a computer was 
running while attempting to distribute the update). 
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The control program for distributed computing does not have to be terminated 
before starting the update. The update program closes the socket server and opens 
it again automatically.  The automatic update installation is also possible for 
Computers on which the demo version is installed for Distributed Computing.  

Parameters for the windowless installation 
x.x stands for the SoundPLAN version, e.g. 8.0 

xxxx stands for the BABG/BABN number 

jjjjmmtt stands for the date of the update, you want to install. 

New installation 

Calling program 

The program starting the windowless installation is the program 
“Install32SPx.x.exe” from the DVD (as an alternative you can copy the content of 
the folder ..\Install SP\WIN32\ to your disk and start the installation from there). 

/LANGUAGE=<LocalID> 

The program language needs to be set as the local ID from Microsoft. A list of the 

language ID parameters can be found on   

https://technet.microsoft.com/de-de/library/cc179219.aspx.  
https://technet.microsoft.com/en-us/library/cc179219.aspx. 

1033 is English for the USA: EN_US  
1031 is German for Germany: DE_DE 

/LANGUAGE=1033 

/BABG=<FileDescriptor> 

This parameter needs to contain the license file to be used in the installation. As 

the BABG/BABN is most likely not in the same folder as the installation program, 
the drive and path must be part of the entry. In case the path contains blanks, the 
blanks must be encapsulated with quotation marks. 

/BABG=“C:\MyFolder\BABGxxxx.007“  

/S 

This parameter indicates that a windowless installation is to be performed. 

/D=<PathDescriptor> 

The parameter for the target of the installation, the parameter must be made for a 
valid folder. In case the path contains blanks, the path must be encapsulated with 
quotation marks. 

/D=“C:\Program Files (x86)\SoundPLAN x.x\“  

https://technet.microsoft.com/de-de/library/cc179219.aspx
https://technet.microsoft.com/en-us/library/cc179219.aspx
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Example 

"D:\Install SP\Win32\Install32SPx.x.exe" /LANGUAGE=1033 /BABG="C:\My 
folder\BABGxxxx.007" /S /D="C:\Program Files (x86)\SoundPLAN x.x\" 

Installation of program updates  

Calling program 

The calling program is SPUPDxx_jjjjmmtt.exe with the full drive letter and path. 

D:\Updates\SPUPD32_20170101.exe 

/LANG=<LocalID> 

The program must be installed with the same local ID from Microsoft as the already 
installed version from SoundPLAN. 

1033 is EN_US  
1031 is DE_DE 

/LANG=1033 

/SILENT 

Parameter indicates that a silent installation is desired. 

Example 

"D:\Updates\SPUPD32_20170101.exe" /LANGUAGE=1033 /SILENT 

System update 

Calling program 

The program starting the installation is program “SPUpdlic.exe” which was installed 
in the SoundPLAN program folder. 

"C:\Program Files (x86)\SoundPLAN x.x\SPUpdlic.exe" 

/SILENT 

The parameter indicates that a windowless installation is desired. 

/INSTALL=<FileDescriptor> 

The parameter describes the files to be installed.  

/INSTALL="C:\Users\SoundPLAN\Documents\SoundPLAN Globdata x.x\downloads 
x.x\lfiles.*.zip" 

/INSTALLPATH=<PathDescriptor> 

The parameter describes the path where SoundPLAN is installed.  

/INSTALLPATH="C:\Program Files (x86)\SoundPLAN x.x\" 
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Example 

"C:\Program Files (x86)\SoundPLAN x.x\SPUpdlic.exe" /SILENT 
/INSTALL="C:\Users\SoundPLAN\Documents\SoundPLAN Globdata x.x\downloads 
x.x\lfiles.*.zip" /INSTALLPATH="C:\Program Files (x86)\SoundPLAN x.x\" 

The SoundPLAN service modules 
The SoundPLAN Handbook is available in printed form and as a pdf document and 
is copied to your hard disk during the installation. Open the manual in the 
SoundPLAN Manager using HELP -> READ MANUAL. 

The SoundPLAN On-Line Help in the program provides information to current 
problems and is updated with every SoundPLAN version. 

The SoundPLAN Hotline is available from your local distributor or SoundPLAN 
International LLC (mailto:support@soundplan.com). Find information on your local 
distributor in the SoundPLAN Manager via HELP -> INFO. 

Local user group meetings keep you up-to-date (ask your local distributor). 

Software and hardware suggestions 
SoundPLAN is available as 32-Bit and 64-Bit-software. Thus, it is possible to process 
projects without a limit to the size (depending only on the amount of memory 
installed in your computer). This is especially interesting for some special tasks and 
for huge projects.  

SoundPLAN supports both multi core and multi-processor PCs. Each processor of a 
multi-processor PC may have several cores. 

For new PCs we recommend purchasing the latest processor type but not the 
fastest processor in the series, because the fastest processor is often too 
expensive. If you choose a slightly slower processor you will get a much better ratio 
of cost versus speed. 

As the pre-calculation in the calculation core (calculation of emissions, searching 
DGM triangles, preparing buildings …) are not (yet) designed to make use of 
multiple core processors, processors with a very high operating frequency (or with 
turbo boost) will yield the highest throughput of the entire system.  For this reason, 
the clock speed at the moment is more important than the number of cores in a 
processor.  

Operating system: Current Windows version and Windows Server version - 
preferably the 64-bit version, because this operating system can request much 
more memory and you have the choice between SoundPLAN 32 and SoundPLAN 
64.  

mailto:hotline@soundplan.de
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SoundPLAN is always executable with the current operating system. If software 
adjustments are necessary, they will be made available at short notice. 

We suggest making the decision for graphics card, RAM memory, hard disk and 
monitor the same way as for the processor itself: Choose the best hardware 
available at a sensible price. The monitor should have FullHD resolution. 

Per calculation core (thread) 1 GB RAM should be included. The graphics card must 
support OpenGL for the 3D Graphics and should have its own memory, because the 
3D performance of so-called „onboard-graphics card“ is rather weak.  

All Windows compatible printers and plotters can be used. 

A second monitor is strongly recommended for checking geometry data in the Geo-
Database (Property Explorer, 3D-Graphics and connection to Online Map Services 
and Google Earth). 
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2  SoundPLAN Manager 

SoundPLAN consists of multiple programs that jointly assure the functionality of 
the suite of SoundPLAN. One of the main advantages of splitting SoundPLAN into 
individual program modules is the possibility to edit data for one variation while 
another is prepared for printing and another is being calculated. Multitasking with 
SoundPLAN not only works within the same project but can also be applied for 
different projects. 

Data organization 
In SoundPLAN a project folder (subdirectory) is generated for each project. This 
way it is guaranteed that all data belonging to the project are stored together. This 
procedure helps you and your colleagues to efficiently manage big and small 
projects. 

In the SoundPLAN Manager you can generate new general subdirectories and new 
project folders. You can also convert general folders into project folders. This way it 
is possible to further organize the project to keep, for example, bitmaps and 
imported files separate from the rest of the project. 
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Functions of the SoundPLAN Manager 

 

All threads come together in the SoundPLAN Manager. At a glance you see 
information on your project and the selected calculation standards. You create new 
projects here, select existing projects and invoke the different program parts of the 
SoundPLAN program group.  

As soon as you home in to an area where you can change settings, the mouse 
cursor changes to a hand so that you can quickly access the information, e.g. 

changing the selected standards or extending the project info.  

In the help menu you have access to the SoundPLAN website; in addition, you can 
directly send a request to the hotline.  

Create new project 
A SoundPLAN project consists of several files which are stored jointly in one 
project folder. When you create a new task or select a project, you select a 

folder, not a file.  

When you start SoundPLAN for the very first time the SoundPLAN opens without a 
project; later on, SoundPLAN will always open the last project you worked on.  

Create a new SoundPLAN project with PROJECT -> NEW.  
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When you create your first project, the selection list on top of the dialog 
shows a standard path, later on the path of the last selected project will be 

shown. Select other project paths using the selection list.  

If you want to store the project in another main directory, click on the symbol 
button SELECT DIRECTORY on the right side of the selection list. 

Enter the name of the project folder. The following fields can be used to store 
additional information to your project. If you don't enter a project title, the project 
folder name is used as title.  

It is up to you to fill in the fields project number, project engineer and customer, 
however you can use this information in text variables to later design your tables 
and maps.  

The DESCRIPTION enables you to store your own information such as contact data of 
the customer or hints on the status of the project. Open the project info with a click 
on the corresponding area or PROJECT -> PROJECT-INFO to amend the description. 

Select a project coordinate system (page 41) and click OK to create the project. 

Define the project coordinate system 

There are many coordinate and reference systems, historical and global ones. It is 
wise to generate the project using the coordinate system that is used by your 
client. If you want to import data from outside sources, the coordinates might be 
using a different coordinate system. If the project coordinate system is defined and 
the coordinate system of the data to be imported are known (and defined in 
SoundPLAN), the data are converted at import time into the coordinate system of 
the project. If the coordinate systems are not made available to SoundPLAN, the 
data most likely will not match. 
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With more and more data becoming available on-line through Online Map Services, 
Open Street Map or Google Earth, you can and should define the project 
coordinate system when starting a new project. Under OPTIONS ->SETTINGS -> 

GLOBAL in the SoundPLAN Manager you can define a default project coordinate 
system that will automatically be activated for new projects. This is very helpful if 
your work is mostly regional with always using the same basic coordinate system. 

Select the coordinate system and the reference system from the selection lists and, 
if needed, an offset (false easting / northing) and a stripe, see "Coordinate and 
reference systems (page 45)". 

 

You can define the project coordinate system later in the Geo-Database when 
opening an Online Map Service or Google Earth for the first time or when you start 
a transformation. 

Under OPTIONS -> SETTINGS -> GLOBAL in the SoundPLAN Manager, you can set a 
default project coordinate system that will be automatically entered for new 
projects. 

Open project 
 The project that was active when the program was terminated last is loaded 
as the default project. Select a different one with PROJECT -> OPEN. 

 

SoundPLAN projects can be identified in the pick list by blue and gray folder 
symbols, depending on the version the project was created with. Additionally, 
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normal yellow folders can be found in the project directory. In the info field on the 
right side, the project description and version number is displayed. 

SoundPLAN projects can be selected by double clicking or with the button OPEN. 

Use the right mouse button -> CONVERT to convert Windows folders into 
SoundPLAN projects, for example when you have already generated the folder to 
store bitmaps or other external data in it. 

Convert projects to newer versions 

When you open a SoundPLAN project with a newer version you are asked for 
permission to convert the project. This procedure is important as files may have a 
different structure. Please note that converted projects cannot be read by an older 
version, therefore if you intend to work with this project in an older version of 
SoundPLAN, back it up! 

Define how the program shall organize the conversion: 

 

Depending on the settings the project is first archived (packed) or copied. This 
procedure can take several minutes. 

Copy, delete, paste and pack projects 

Within the "Open dialog" click right on a project folder to copy, paste, delete and 
rename projects or to pack and extract them. Some of the functions are not 
accessible all the time, for example the option „Paste“ can only be used after a 
project has been copied before. 

Project-Info 

The project info is displayed on the bottom left of the SoundPLAN Manager. 
You can change it or extend it during the project lifetime e.g. to enter contact 

persons, information on the project progress or dates. If you want to modify the 
description, either click on the project description or on the icon or open the menu 
PROJECT -> PROJECT-INFO. 

Save project as 

You can generate copies of the project through the menu selection PROJECT -> 

SAVE AS without accessing the project selection. 
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Enter the name for the project folder and, if needed, a new project title. 

 

Pack and extract projects 

To save space when archiving projects or when you want to send the project 
to someone, SoundPLAN has the capability to compress entire projects into 

packed archives. To pack your project open PROJECT -> PACK.  

 

Click on the symbol FOLDER SELECTION and select the location in order to 
store the packed project in another path than the suggested one.  

When data are sent to an overseeing agency or to the hotline, some of the data 
may not be necessary. In order to keep the packed file as small as possible, 
SoundPLAN has options to customize what is stored in the archive and what is not. 

The setting EXCLUDE TEMPORARY AND NON SOUNDPLAN FILES, SUB FOLDERS AND 

PICTURES should be clicked if you send a project to the hotline. The bitmap for tile 
projects is recognized and packed anyway.  

With the combination of ALL FILES and EXCLUDE RESULT FILES all data but the result 
files will be part of the packed project, for example if you have a graphics or data 
entry problem you want to discuss with the hotline.  
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If a special result file of a big project should be checked, you can use INCLUDE ONLY 

RESULT FILES and enter the calculation run number to send this single result in a 
second round as a separate email.  

After packing the files with PACK, the size of the archive is displayed in the bottom 
of the entry box. With PACK + SEND the zipped project is directly copied as an 
attachment to a new email to send it to the SoundPLAN support (or any other 
email address). 

To extract a project, click on the project in the project selection, invoke EXTRACT 
from the right mouse menu and enter the path where the archive is to be extracted 
to.  

Coordinate and reference systems 
For different functions, SoundPLAN must know the coordinate system in which the 
project data is available, or which should be used as a basis for a project. This is 
necessary for working with map services (such as OSM, WMS, Google Maps, Google 
Earth), as well as for transformation, when the project data and additionally 
imported data are in different coordinate systems. 

The coordinate reference system (CRS) is described by a coordinate system (e.g. 
UTM, …) and a reference system (e.g. WGS84, ERTS89, …). 

The coordinates of the data can have an OFFSET in x and y direction for example, if 
the zone ID for UTM coordinates is missing. 

Geodetic coordinate systems such UTM are divided into zones or strips.  

 

For UTM coordinates, the earth is mapped in sixty 6 ° wide zones. Zone 1 is located 
between 180 ° and 174 ° west of Greenwich. The zones are numbered 
consecutively to the east. The polar regions are not covered by UTM.  
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Overview of the UTM zones 

Photo credits: https://commons.wikimedia.org/wiki/File:Utm-zones.jpg#/media/File:Utm-zones.jpg 

A missing zone or stripe specification may lead to distortions and incorrect 
transformations! 

It is best to use EPSG-codes (page 46) for entering the coordinate system. The 
website https://www.geoplaner.com/ offers a very helpful converter in different 
coordinate systems. For example, specify a location in your study area. The 
coordinates are displayed in different coordinate systems. This will allow you to 
quickly find out in which coordinate system the data is available. Use the 
connection to online map services (Shift + Ctrl + O) to verify that the project 
coordinate system is correctly selected. The map contents jump to the correct 
place. If this is not the case, perhaps an offset or the stripe / the zone is wrongly 
selected. 

EPSG-codes 

Very often, the coordinate systems that a WMS Server is compatible with, or the 
coordinate system for the download of geometry data, are identified by the EPSG 
code. Wherever you can enter coordinate systems in SoundPLAN, you can enter 
the EPSG code directly with the EPSG-CODE button. This saves typing and avoids 
errors. 

 

https://commons.wikimedia.org/wiki/File:Utm-zones.jpg#/media/File:Utm-zones.jpg
https://www.geoplaner.com/
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Click on CHECK, then the coordinate system underlying the code is evaluated and 
entered into the corresponding dialog with OK. 

The website http://spatialreference.org/ref/epsg/ offers a list of EPSG-codes 
together with its geographical scope.  

Non-metric geographical coordinate systems, can only be selected in SoundPLAN as 
the source system for the transformation of geographic data. 

Branching into SoundPLAN modules 
In the SoundPLAN Manager you have access to all modules of the program. 

Select the icon of the program module and click on it to get into: 

• Geo-Database 

Entry of data via digitizer and on screen on top of a scanned bitmap, import 
of data from older SoundPLAN versions, DXF, AutoCAD and GIS systems. 
Data are assembled to Geo-Files that can be freely combined to form 
Situations. 

• Calculation Core 

Calculation on the basis of the data entered in the Geo-Database. Extensive 
log book functions with error and warning log, graphics control of the 
calculation, spreadsheet type definition of the calculation to carry out 
multiple calculations in a row. 

• Result tables (Documentation) 

Table type preparation of the result data from single point calculation and 
Façade Noise Maps from one calculation run with all characteristics of a 
receiver. Master/detail organization of the data, scalable detail for receivers, 
sources and the transmission path. Table type presentation on the printer; 
document manager for easily creating the result documentation as an annex 
of the investigation survey. 

• Spreadsheet 

Spreadsheet type presentation of results from single point receivers and 

Facade Noise Maps. Extra columns can be generated for text and values, 
additional calculation results can be read into the extra columns, result 
columns and formulas can be added to do arithmetic with results from 
multiple calculations. 

The area table is used to generate and evaluate statistics in accordance to 
the requirements of the EU directive on environmental noise.   

• Graphics 

Efficient graphics presentation of calculation results in various formats; 
flexible arrangement of different map types with multiple maps per sheet; 
templates to define an office standard. 

http://spatialreference.org/ref/epsg/
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• Library 

Access to the emission-, absorption-, transmissions- and mitigation library, 
the definitions of 2D- and 3D-directivity as well as day histograms, wind 
statistics, pollution component library and the assessment library. Free 
definition of your own elements in each of the libraries. 

• Wall Design 

Dimensioning of noise protection walls and berms for multiple receivers, 
minimization of cost of the walls, interactive dimensioning with corrections 
to the wall form and instant results, 3D solid view of wall and surrounding, 
wall performance diagram. 

• Expert Industry 

Detailed analysis of the interaction of sources and receivers, sorted lists of 
sources, receivers and source contributions. Generation of noise control 
concepts with cost optimization. Additional detail windows can be added to 
have different views on the data; 3D solid graphics modeling to see where 
the sources and receivers are located. 

• Noise Allotment 

The module Noise Allotment is used to calculate emission contingents and 
additional contingents of industrial sites for land-use plans according to DIN 
45691. The module contains a complete documentation of the results.  

• BA-Outside 

BA Outside calculates which measures at the walls and windows are 
necessary to keep the resulting R’w or the permissible interior level. The 
calculation can be executed according to EN 12354 and the German 
standards 24. BImSchV, DIN 4109, DIN 2719 and 2. Aircraft noise protection 
order. Measure lists and cost tables allow to quickly arrange the tender 
documents for noise redevelopment programs.  

• Window dimensioning 

A dimensioning of noise protection windows for simple cases is included in 
the Spreadsheet: SPREADSHEET -> WINDOW CLASS -> ADD WINDOW COLUMNS. 
This feature contains the dimensioning of the windows for given receivers 
according to the German standards 24. BImSchV, DIN 4109 and DIN 2719. 
The restriction is that each calculation point can only be assigned to one 
room. 

• Long Straight Road 

(EXECUTE -> LONG STRAIGHT ROAD) Rough screening type calculations 
according to German RLS 90 for road noise to determine the necessary 
height of noise protection walls and berms. 
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Hotline support with email and internet 

Open the menu entry HELP -> SEND EMAIL to send an e-mail to the SoundPLAN 
hotline. If you submit a zipped hotline problem (see page 44), please describe in 
detail what the nature of the problem is, for example the calculation run, the 
situation, the graphics sheet that is causing questions. Questions about the 
functionality of the license, hardlock etc should be accompanied with the file 
UPDATE.LOG (C:\documents and settings\all users\application 
data\SoundPLAN\update.log) and the license file BABG*.* file (SoundPLAN 
installation folder). Having the answers makes the turnaround time of the help line 
much faster. 

Internet updates 

Registered customers with guarantee or maintenance can download updates via 
the internet. Use HELP -> UPDATES AND DOWNLOADS to directly access the download 
page. See also "Upgrading SoundPLAN". 

 Options -> Settings 

 

The options provide various pre-settings that are stored globally and edited to 
meet the requirements of each project. 

Path for global settings and templates 

When you first call up SoundPLAN you will be asked to enter a path to a folder 
where the folder “SoundPLAN Globdata xx” will be hosted. In this folder 
SoundPLAN keeps all data (templates and settings) not bound to a specific project. 
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Program settings 

The SHARED PATH FOR GLOBAL SETTINGS determines a folder, for example on the 
server, where the color palette and the global object types as well as templates for 
general plots, results tables, spreadsheets and graphics sheets are stored. The files 
are not automatically stored to this folder, but for organizing reasons the user 
himself must copy them. This procedure is necessary in order to solve questions 
such as „How should SoundPLAN react if the network is not available?“ or „Who 
has priority when two people want to access files in this directory?“ 

Therefore, SoundPLAN still uses a fix folder for the global settings (..\My 
Documents\SoundPLAN x.x\Globdata).  To adjust the data, right click in the tree 
view on the left side on program -> COPY THE CONTENTS OF THE GLOBAL FOLDER TO 

GLOBDATA, or COPY THE CONTENTS OF GLOBDATA TO THE GLOBAL FOLDER. 

The PATH FOR GLOBAL LIBRARIES defines where the global libraries are stored. If the 
global path is not accessible, you will not be able to open the global libraries. 

The NUMBER OF RECENTLY OPENED FILES defines the number of files displayed in the 
history list of the menu file for all parts of SoundPLAN. 

For standards which distinguish between ascending and descending DRIVING ON 

THE RIGHT SIDE YES / NO takes the position of the emission bands into account. In 
the animation track of the 3D graphics this setting also determines whether the 
displacement of the viewer from the axis is added to the left or to the right. 

Settings for Distributed Computing 

Distributed computing (DC) uses other PCs in a network, not currently in use for 
calculations. One PC, called the workstation PC or client PC controls the allocation 
of calculation jobs to the server PCs. In order to make a PC a server PC, at least a 
demo version of SoundPLAN and a control program, DC control, must be installed. 

The network port for the workstation PC, the server PC and DC control can be 
changed here if necessary. The ports must be identical for all PCs used for 
distributed computing. 

For server PCs, data is stored during the calculation, which is deleted after the 
distributed calculation is finished. Because the server PC cannot calculate if there is 
not enough hard disk space available, it is possible to change the PATH FOR DATA 

FOR DISTRIBUTED COMPUTING.  

System settings 

Some computers have hardware components that do not fully support the 3D-
Graphics and the bitmap processing. In order to run these modules satisfactorily, 
you can change some of the system settings. 
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If parts of the bitmap are missing, the size of the original bitmap probably exceeded 
the max size. You can define the max size in MAX BITMAP SIZE IN PIXEL. 

If geometry bitmaps are not printed or are printed incorrectly, the printer driver 
might not support the more effective standard routine for bitmap output. In this 
case, switch USE ALTERNATIVE PRINT ROUTINE FOR BITMAPS to YES. 

The NEAREST CLIP PLANE is also relevant for 3D-Graphics. Even good graphics cards 
often have difficulties displaying the nearest clip plane, which is 0.1m for the 3D-
Graphics. This leads to incorrect display of areas. 

Set the nearest clip plane to 5 m for example and check the result in the 3D-
Graphics. 

  
Example Clip plane 0.1 m   Example: Clip plane 5 m 

You can also change the nearest clip plane for individual scenes in the 3D graphics 
itself (GEOMETRY VIEWPORT -> GEOMETRY PARAMETERS when you edit a 3D model). 

STANDARD PRINTER FOR THE GRAPHICS: Often a different printer than the Windows 
standard printer is used for the graphical printouts. Therefore, you can select 
another printer installed on your system which is automatically selected for 
printouts in the graphics. The Windows standard printer is still used for the table 
printouts. 

DEFAULT FONT: Select a font that is used as default for new tables and graphics 
sheets. When using templates, the font is taken from the template.  

 

Project settings: Global and current project 

Define project settings as needed in most of your projects. When creating new 
projects, SoundPLAN automatically uses global pre-settings for the new project. 
You can change these settings for the current project. 

To transfer settings from one project to another or to the global settings, right click 
on the tree view to the left, select LOAD SETTINGS, select the project6.sp from the 
desired project and press OK. 
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Hint: The settings of the current project are also accessible from the Geo-Database, 
the Calculation and the Graphics via OPTIONS -> PRESETTINGS. Each of the programs 
leads you to the settings in the branch which is relevant for this part of SoundPLAN. 
But you can also open every other branch in the settings, for example to create a 
new graphics object type in the Geo-Database. The changes take immediately 
effect (only the Geo-Database must be closed and reopened if you change 
standards for the current project). Open these nodes in the calculation kernel with 
OPTIONS -> STANDARDS and OPTIONS -> CALCULATION TYPE SETTINGS. 

Definition object number 

The format for the object numbers of receivers / buildings, industrial sources and 
photo locations is defined separately in order to meet the requirements of 
different numbering systems. See „Object Numbering“ for details. 

Emission time slices traffic noise 

Define how the traffic data shall be distributed to the different time slices. For 
three time slices, for example 

Day   6 am to 7 pm   (6-19)  

Evening  7 pm to 10 pm  (19-22)  

Night   10 pm to 6 am  (22-6) 

If you only need the assessment levels for day and night, select 2 TIME SLICES and 
determine the hours for each time slice. The time slices must not overlap and must 
include the 24 hours of a day. 

Graphics settings 

The GRAPHICS-SETTINGS provide the object types (page 542). You can edit the global 
object types directly. 

For the length scale you can also select ‘feet’. 

Presettings Geo-Database 

It is possible to change the standard properties of some Geo-Database objects in 
the settings (e.g. the height of the first receiver above ground floor, the height of 
the floors, the distance of a receiver from the facade and the alignment of road and 
house number. 

Floor descriptor 

The correct formatting for the floors in the different countries can be adapted. 
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Change the formula if necessary, you will immediately see the result. The selected 
floor descriptor will be used automatically in all parts of the program. 

Calculation standards selection 

SoundPLAN supports so many standards that a selection list with all implemented 
standards would be cluttered. The enabled standards are selected according to 
your country settings by default. You can activate other standards or deactivate the 
standards you do not want to have included in the normal standard selection. The 
standards can only be deactivated in the global part of the settings under 
STANDARD SELECTION LIST. For new projects, only the enabled standards are visible, 
but if others are needed in a particular project, the list can be extended under the 
current project section.  
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Presettings for calculation standards 

The STANDARDS are set here globally and for the current project. Click on the 
standards in the SoundPLAN Manager to directly access the branch standards in the 
settings (the mouse cursor is displayed as a hand). 

 

Presettings of coordinate and reference systems 

To transform coordinates between different coordinate systems and when working 
with Google Earth it is paramount to know which coordinate system (Gauß-Krüger, 
UTM …) and in which reference system (DHDN90, ETRS89 …) the project data are 
present. In addition, the data can also contain an offset in x and y (when, for 
example, the first 2 digits in a Gauss-Krüger coordinate system are missing, or with 
the UTM32). 

Most often the transformation automatically recognizes in which stripe / zone the 
coordinates are located (0 in the field stripe). If a coordinate system which refers all 
coordinates to one stripe is used the reference stripe must be defined.  

Example: UTM 32 refers all coordinates in Denmark to the stripe 32. Copenhagen 
however is within the stripe 33. If you move the Google Earth camera to the cursor 
position, the viewport looks correct. As soon as you draw a bitmap of this position 
the viewport is completely displaced from the geo data, because the automatic 
transformation locates the coordinates in stripe 33. In this case it is therefore 
necessary to explicitly enter the stripe / zone number to which the coordinates 
refer (here 32).  

SoundPLAN uses the Tool GeoDLL from Killetsoft for the coordinate 
transformations (www.killetsoft.de). 

As the GeoDLL contains many different systems (530 coordinate systems and 198 
reference systems), please open the SoundPLAN Manager and select the systems 
that should be presented when the project coordinate system is defined (located 
under OPTIONS -> SETTINGS in the global settings SELECTION COORDINATE SYSTEMS 

and SELECTION REFERENCE SYSTEMS).  

http://www.killetsoft.de/
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Unfortunately, the developers do not have proper knowledge of the coordinate- 
and reference systems used country by country. The language dependent system 
settings include a presetting with worldwide used coordinate systems. You can get 
access to the list of the worldwide used coordinate systems via the blue question 
mark when assigning a project coordinate system. Additional information can be 
found here: http://www.killetsoft.de/t_0901_e.htm. Use Ctrl+F to search for a 
specific coordinate system. 

Default project coordinate system: In the global branch you can define a default 
project coordinate system that will automatically be activated for new projects. 
This is very helpful if your work is mostly regional with always using the same basic 
coordinate system.  

Presettings calculation type 

Use CALCULATION TYPE to predefine standard settings that the calculation kernel 
will use when this calculation type is used. Set the definitions for each calculation 
type in the tab index card „settings“ in the run properties and set the parameters 
for the calculation type itself, such as the grid size or the calculation height above 
ground for a grid noise map calculation. 

Object numbering 
SoundPLAN provides three different numbering systems in order to administer the 
objects and to clearly assign them in the tables and graphics: 

Object ID - is a unique key, automatically assigned to the objects during the input 
or import in the Geo-Database. It appears in the status bar. The ID is displayed in 
the calculation log book if error messages occur (e.g. road properties of road #2333 
are missing) and it can be used to find an object in the Geo-Database. 

Serial number - is automatically assigned to each receiver during the calculation 
according to the sequence of the data. Since the serial number is assigned 
automatically, it might change after a recalculation. 

http://www.killetsoft.de/t_0901_e.htm
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Object number - the user assigns the object number to receivers, buildings and 
noise sources in the Geo-Database. The object number doesn’t change - unless you 
consciously change the number. 

The object number is not a value but a text. This has the advantage that the object 
number is not sorted alpha-numerically but via a freely definable sort sequence. 
The object number is incremented automatically 

Changing the format string and sort order allows you to accomplish many tasks. For 
example: 

• Mark free field receivers separately, but sort continuously. 

• Add additional receivers or sources later, without changing the original sort 
order. 

• Insert receivers or sources at a defined location in the table. 

• Use specified object numbers, e.g. for different parts of a project. 

Input and display of the object number 

Define the format string and an additional sequence for the sort order in the 
settings for buildings / receivers, sources and photo points. During data entry in the 
Geo-Database, enter the number as you want it to appear in the output. 

Use the button DEFINE NEW BASIC NUMBER to define the number just entered 
as the new basic number, from which the number for additional objects is 

automatically incremented. 

 

If the defined format string contains letters and/or separation signs, the object 
number might be A100 or 11.1, for example. If the entered object number doesn’t 
correspond to the format string, a message comes up showing the defined format 
string. 

 

Use TOOLS -> OBJECT NUMBER to assign the number for receivers, buildings or 
sources alphabetically according to the object name. If no objects are marked, the 
automatic numbering is executed for all objects in the situation, otherwise it is only 
executed for the marked objects. 
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Placeholders for the format string 

The entry of the format string uses placeholders for letters and numbers in the 
SoundPLAN Manager in OPTIONS -> SETTINGS: 

0,9,1  as a place holder for numbers. 0 fills the numbers from the right to the left 
and is ignored if no number is entered. 9 fills the numbers from the left to the right 
and expects that a number is entered. 1 defines which number block is 
incremented if more than one number block is present in the format string. 

A,a  as place holder for characters. The characters in the format string are 
displayed the way the user entered them (small or capital letters). In character 
blocks, any characters, spaces and special characters except separation marks and 
numbers are allowed. A format string may contain several character blocks. 

.  ,  ;  - as separation marks. Use separation marks to separate character blocks 
and number blocks. Valid separation marks are , (comma) . (point) ; (semicolon) 
and - (minus). 

 
Definition of the numbering in the settings 

Hint: If you want to change the format for the object number while you are 
working on a project, call OPTIONS -> PRE-SETTINGS in the Geo-Database and change 
the format string or the sort order for the current project. The changes take effect 
as soon as you close the settings and return to the Geo-Database. 

Display of the object number 

The object number is written to the result file during the calculation and entered in 
to the table output in the results tables and the spreadsheets. For the graphical 
output, you can use the object number as a reference in the file type „level tables“. 

  
Object number and format string in the tables and as a reference in the graphical output 
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The sort order according to the defined object number uses the column with the 
format string (format string Obj. No.) and not the column „object number.“ 

For the result tables, call the sort order via the right mouse button and select the 
sort column "Format string Obj.-No.". 

For the spreadsheet, click right on the column header - > sort and select the 
column "Format string Obj.-No."  as the first sort criterion and if necessary, the 
floor as the second sort criterion. 

Examples for format string and sort order 

Add additional receivers or sources to a later stage of a project without changing 
the original sort order. 

Format string 0 0 0 . 0 

Sort order 1 2 3 4 5 

 

Entry in the Geo-Database 
= Display in tables /graphics 

stored format for the sort order 

1 001.0 

1.1 001.1 

1.2 001.2 

2 002.0 

2.1 002.1 

The original format string in a project was 00 … 

Entry in the Geo-Database 
= Display in tables /graphics 

stored format for the sort order 

1 01 

11 11 

… now you want to add more receivers and you need to use three-digit numbers. 
Supplement the format string to 000.0. 

The display for existing receivers will not change, only the stored format changes: 

Entry in the Geo-Database 
= Display in tables /graphics 

stored format for the sort order 

1 001.0 

1.1 001.1 

2 002.0 

11 011.0 
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In addition, you can use characters to identify receivers and sources, (for example 
for free field receivers). 

Because the objects should be sorted according to the actual number, the sort 
order becomes important. 

Format string A A 0 0 0 0 A 

Sort order 5 6 1 2 3 4 7 

 

Entry in the Geo-Database 
= Display in tables /graphics 

stored format for the sort order 

T 1 0001T _ 

2 0004___ 

G 3 0003G _ 

5 0005___ 

5a 0005__a 

T-5 005T-_ 

The sort order defines the order in which the characters should be considered. 
Assign a number to each component of the format string: 1 for the first sort order, 
2 for the second sort order and so on. 

Buildings are grouped to different sections. The object number shall include the 
section description which may include a letter and if necessary, a number, and a 
consecutive number for each building.  

Format string  a 0 - 0 0 0 1 

Sort order 1 2 7 3 4 5 6 

 

Entry in the Geo-Database 
= Display in tables /graphics  

stored format for the sort order 

A-1 A00001- 

B1-11 B10011- 

B1-12 B10012- 

C-15 C00015- 

D2-1245 D21245- 
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3  Geo-Database 

All geometry data and their properties (building height, road width, sound power 
level, emission level ...) are entered or imported into the Geo-Database and 
prepared for calculation. 

Quick Reference: Data Entry 
In the Geo-Database all geometry data and their properties (building height, road 
width, sound power level, emission level …) are entered or imported and prepared 
for the calculation. 

Sections of the graphical user interface 

 
Geo-Database - graphics screen 

This picture gives you a first overview of the elements found on screen: 
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(1) The top part of the screen shows on the left-hand side the current Geo-File, in 
which all new data will be stored, together with the settings for the display of Geo-
Files (e.g. hidden or read only) and the Geo-File administration (e.g. save Geo-File 
or load additional Geo-Files). On the right-hand side, you see the currently selected 
object type (e.g. road, railway, building, receiver) and the settings for the display of 
the object types (e.g. highlighted or hidden).  

(2) Below you see the grouped object selection icons (you can also opt to see all 
object types at the same time with OPTIONS -> OBJECT SELECTION 2). 

(3) Below follow the controls for the selection of view ports to quickly and directed 
zoom into parts of the investigation area. Next to it are the functions for scaling 
and rotating the map (in 90°-steps or continuous). Geo-referenced bitmaps are 
selected for display with the selection list on the right.  4 control arrows help to 
fine tune the fit between the bitmap and the other data. View ports and rotations 
are ignored when bitmaps are loaded into the background. 

(4) On the left side in the tool box you can see icons for different modes of input 
(edit mode, digitizing mode, zoom mode and move mode). Below are the buttons 
for the right-angle mode, for coordinates with relative elevations, circle and 
rectangle construction tools and an additional mode to show the line segment 
length. 

(5) On the left side of the status bar on the bottom of the screen you see the world 
coordinate of the cursor position and the elevation of a loaded digital ground 
model. From the second coordinate the distance between the last coordinate and 
the new cursor position is displayed. When you move the cursor to an already 
digitized coordinate, the middle of the status bar will present the coordinate and 
elevation of this point and the right part will show the name of the object and the 
object ID. 

Principle steps of data entry 

Elevation model: A consistent 3-dimensional elevation model is paramount for 
noise propagation calculations (with the exception of very simple models where all 
elevations can be placed on 0.0-elevation). From the available elevations the Geo-
Database can generate a continuously triangulated ground model (DGM) that 
functions as the base for many processing steps in the generation and refinement 
of the entire noise model. The elevation edges from the DGM are also used to 
determine the ground effect and screening.  

Elevation data present on an importable file (for example from an aircraft flyover) 
can be imported and filtered via the import interface „ASCII elevation data“. Often 
the importable elevation data is present in an equivalent resolution of meter by 
meter, thus putting a huge burden on the calculation program. With the filtering it 
is possible to enter a maximum deviation from the original DGM and have the 
triangulation thinned out in a fashion that guarantees that the new triangulation 
does not exceed the set tolerance. “Filtering Elevations” most of the time reduces 
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the DGM to 10% or less of its original size, thus speeding up data loading and 
calculation time. 

Initialize the background graphics: Load a bitmap background graphic and 
calibrate it via pass-coordinates (generate an internal coordinate transformation 
(geo-reference) to project the pixel coordinate system to the world coordinate 
system). If you can find a geo-referenced bitmap, this step is obsolete. After 
creating the geo-reference once, each time you open the bitmap, it will be in its 
correct place. You can also get the geo-referenced bitmap directly from 
OpenStreetMap, Google Maps or Google Earth; SoundPLAN has direct links to the 
software and services.  

Enter objects: Click on the object type icon of choice and select the desired Geo-
File, click on the canvas to generate the first coordinate of the new object. Check 
the objects elevation, enter the objects properties, and digitize additional 
coordinates. To close the entry of a new object, click on the symbol , double 
click or hit F2. As the properties for a new object are taken from the settings of the 
previous one, it is advisable to digitize multiple objects of the same type in 
sequence.  

Import objects: Object data available in digital format (on file) can be imported 
using one of the many import interfaces.  

DXF data are imported as points, lines, areas, and texts in generic, raw format and 
then can be assigned to a SoundPLAN object type.  

With the ESRI ArcView data (shape files) each data file is a small database that fits 
only to the appropriate SoundPLAN object type (CityGML fits only to buildings). The 
shape database can contain any number of properties, some may not even have a 
SoundPLAN equivalent, therefore in the process in importing the data you need to 
reference the shape file properties to the SoundPLAN equivalent. 

Other import data contain a data model in a format where the importation is 
already fixed and SoundPLAN therefore knows how to interpret the data and assign 
the correct properties and objects from the import file to objects inside 
SoundPLAN. An example for this is the QSI data interface and data from 
OpenStreetMap. 

Edit objects: The data objects digitized or imported can be further edited and 
refined in the Geo-Database. For this purpose, the Geo-Database supplies a 
multitude of efficient Geo-Tools. In the Property Explorer the properties of all 
objects of a single type are presented in spreadsheet form. Like in all spreadsheets 
it is possible to visualize/hide columns, to assign values to columns or marked rows 
of columns and to use user defined formulas to set the values. If additional 
properties are available in ASCII- or dbf-files, they can be incorporated into existing 
objects. 

In the SoundPLAN Library additional data is contained, for example emission 
spectra, reflective properties or time history of sources. In order to enter these 
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data only once and being able to apply them to multiple data objects, the data are 
hosted in the library and only referenced to the objects on the Geo-Database. 

Object coordinates 

The object coordinates present valuable hints about the properties and data entry 
direction of the object. As the screen can become very cluttered if these options 
are enabled for all objects all of the time, you can toggle this function by clicking on 
the button  (activate)  (deactivate) for each object type.  

 
Coordinate without any properties 

 Coordinate with a property defined from this coordinate on  

 
Coordinate with an arrow marking the data entry direction 
(between the first and second coordinate of an object) 

 Direction arrow between the coordinates  

 

The last coordinate of an object is presented in red color (as long 
as the object is not closed). If the object is already closed, the 
last point has the same color as previous points.  

 

Objects with properties changing at multiple points. New 
properties are valid from the current coordinate on. (Variant 
objects) 

Variant objects 

For several object types it is possible that the properties are changing from 
coordinate to coordinate, for example the height of a noise protection wall or 
traffic data on a road or the speed of trains on a railway line. The new object 
definition is valid until it is replaced by a new definition.  

 

 

The first coordinate of an object always saves all properties of the object; 
properties are always preset with default settings. At further coordinates, the 
properties of the object may change, but only the properties that change are saved 
at this coordinate so all previously defined properties are keeping their validity  

In the example above the second coordinate has a change of the height of a noise 
protection wall from 2.5 meters to 3 meters. At the third coordinate a cantilevered 
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wall element is added. If you want to alter the reflective properties of the wall, you 
only need to do so at the first coordinate, the modification is passed on to all 
successive elements. 

All properties defined at a specific coordinate can be visualized by clicking on the 
symbol “tree view” in the object dialog.  

 

With the double arrow move directly from one coordinate with defined properties 
to the next/last one. 

Left, right mouse button and the data entry cursors 

In the Geo-Database the mouse is used for numerous functions, for this the left and 
the right mouse button have -depending on the cursor mode- different functions.  

Selection of the cursor modes:  

 

Edit mode 

In the edit mode you can enter new objects and also edit existing objects. If the 
cursor is a crosshair type, the left mouse button is the coordinate entry button, the 
right mouse button opens a menu with editing commands often used. 

As soon as the cursor gets in range of a coordinate, the appearance of the cursor 
changes from a crosshair to an arrow.  The left mouse button in the arrow mode 
opens the properties and the coordinates. For objects without properties, the 
coordinate list and is displayed. 

Object types without properties are general points, general lines, general areas, 
spot elevations, elevation lines and calculation areas. 

Object types with properties are for example roads, railways, industrial sources, 
buildings, receivers. 

Left click to get the object dialog, right click to get to additional editing functions. 

In order to modify objects, they often need to be selected (see below). Selected 
objects can be recognized by the black squares on the coordinates, secondly by the 
pink diamond in the center of gravity of the object. 
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As soon as you home in to a selected object and get into the range of a coordinate, 
the cursor changes into a movement arrow. Keeping the left mouse button pressed 
enables you to move a single coordinate. If you home in on the pink diamond, you 
can move the entire object.   

Synopsis of the editing modes: 

 

Left mouse button: Enter coordinates 

Right mouse button: open often used editing functions for selected 
objects 

Scroll the mouse wheel: zoom geometry  

Pull a frame open with the left mouse button pressed: Create a line, 
rectangle or circle 

Pull open a frame with the right mouse button pressed: Select all 
objects in the area covered by the move 

 
Left mouse button: Open the property dialogue 

Right mouse button: Actions for single objects 

 

Left mouse button: Move individual coordinates (by grabbing the black 

squares) or move the entire object (by grabbing the pink diamond)  

Alt+ Left mouse button: Duplicate selected objects (pink diamond)  

Right mouse button: Rotate the entire object (pink diamond) 

 
Scroll mouse wheel: zoom in and out 

 
Pressed mouse wheel: pan the geometry 

Digitizing mode  

The digitizing mode helps with entering new coordinates, especially when there are 
a lot of coordinates already present. The cursor changes into a cross with a dot in 
the middle and a circle around it.  

In the digitizing mode you enter new coordinates by left clicking, with the right 
mouse button you capture coordinates that are already present. This way it is very 
easy to connect one object to another one. 

Synopsis of the digitizing mode: 

 

Left mouse button: digitize coordinates 

Right mouse button: capture existing coordinates 

Scroll mouse wheel: zoom geometry 

Pull open a frame with the left mouse button pressed: generate line, 
rectangle or circle 

Pull open a frame with right mouse button pressed: select objects in an 
area 

 
Scroll mouse wheel: zoom in and out 
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Move with mouse wheel pressed: pan geometry 

Elevations  

By default, the elevations are displayed in the object dialog as soon as the object is 
completely digitized. If a DGM is loaded in a Situation, the absolute elevation at 
each coordinate is extrapolated from the triangulated mesh. In the menu “Options” 
you can decide whether the object dialog with the elevations should be opened at 
every coordinate or at the first point.  

Tool bar 

Below the controls for the data entry modes are some tools that can be activated in 
the digitizing and the editing mode: 

 

For the four lower tools keep the left mouse button pressed. A dialog will open 
where you can enter numeric values for length, width or radius. 

If for example you want to enter a roundabout, click on the object type for road, 
select the tool for circle and pull open the roundabout. 

Select objects and coordinates 

To process a command, SoundPLAN needs to know for which object the command 
was meant. For this purpose, objects need to be selected. There are different 
objectives and different methods for selecting objects, some can be used only by 
themselves; others can be combined. 

Select all objects visible on screen (setting in the menu „View“ ("current Geo-File" 
or "current object type") are processed): Ctrl+A (EDIT –> SELECT ALL OBJECTS). 

Select all objects in an area: Pull a frame with the right mouse button pressed 
from the upper left corner to the lower right-hand corner of the area to be 
selected. All objects that have at least one coordinate in this area are being 
selected. To select additional areas, keep the Ctrl-key pressed.  
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Select a single object: Either pull a frame around this single object or home in on 
the object and use the right-hand function ->SELECT OBJECT or keep the Alt-key 
pressed and click on the point, line or area. For area type objects the corresponding 
object type in the symbol bar must be active. To select additional objects, keep the 
Ctrl-key pressed. 

Clear selection: Pull open a frame with the right mouse button pressed, this time 
moving from the lower right-hand corner to the upper left-hand corner, use the 
shortcut Ctrl+Q or EDIT -> CLEAR SELECTION. 

Clear selection of single objects: keep the Ctrl-key pressed, home in on the 
selected object, right click and use the function SELECT OBJECT or keep Ctrl + Alt-key 
pressed and click on a point, line or area. For area type objects the object type 
must be selected in the object selection bar.  

Connect lines, fill gaps, split lines 

Other software products often manage polylines as lines with two coordinates. 
Shape files for example (ArcView, QSI) have one property set per object; therefore, 
the objects are split at each change in properties. To benefit of the advantages of 
variant objects they are connected to polylines. Duplicated property records if, for 
example, the "average daily traffic (ADT)" of a road changes but not the speed, the 
properties that are not necessary are removed.  

Connect lines 

Use the „Geo Tools -> connect lines“. The lines can only be connected when the 
last coordinate of one line is identical (x, y and z) to the first coordinate of the next 
line. 

How to recognize double, identical coordinates? 

When you select the lines you want to connect, the selection marks of the squares 
are canceling each other, thus the coordinate appears not to be selected:  

 

Each of the lines at the first coordinate has a double circle and between the first 
and second coordinate an arrow to mark the data entry direction. The double circle 
indicates that properties have been assigned to the object at this coordinate.  

If the lines are present like in the picture above, you can connect the lines with the 
geo-tool „connect lines“. If the operation was successful, all selection squares of 
the entire line will be visible and the direction arrow from the second line vanished: 

  

It may also be that the lines in the original software have been connected with 
small circles. In this case the coordinates are not identical. Using the geo-tool 
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„generate areas“ gaps of up to 10 cm can be bridged. This function first connects 
the lines and then checks if the line can be converted into an area, if not it is still an 
easy way to connect 2 lines.  

Fill gaps 

Unfortunately, often the data are not available with gaps of less than 10 cm, in this 
case you must manually modify the data. 

• If the gap is small and the deviation of the moved coordinates is not critical: 

Select the first object and move the last coordinate to the first point of the 
second object.  

• Extend the first object with an additional coordinate. The location of the 
original coordinates is not modified: 

Right click on the first object and select the command „Activate object“.  
The last coordinate now will be presented as a red circle. In case the red 
circle is at the wrong end of the line, use the right mouse button function -> 
„change input direction“.  

Now right click on the first coordinate of the object you want to connect to 
and select the command „capture coordinate“. 

• Digitize a new object in the gap, the original coordinates remain intact and 
unchanged: 

Activate the digitizing mode. Right click on the last coordinate of the first 
object and then right click on the first coordinate of the second object. Close 
the digitizing with F2 or the Symbol „Finish“. 

Split lines  

Click on the coordinate where you want to cut the line into two sections and with 
the right mouse button select the function „Split object “.  

In case the object has properties defined, they are automatically assigned to both 
lines, this manifests itself with the double circle in the beginning of the second 
object. 

Structuring of the data 

All objects entered in the Geo-Database are stored in Geo-Files and can be 
managed in Situations. The Geo-Files are comparable to the layers in AutoCAD. The 
Geo-Files can be used to group objects in accordance to a user defined logic. 

The Situations are acting as a folder that can contain any number of different Geo-
Files; the same Geo-File can be part of multiple different Situations. This 
organization concept has the advantage that corrections and adjustments made in 
the data of one Geo-File are automatically present in other Situations containing 
the corrected Geo-File.  If for example the sound power for a source is modified for 
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a source that is used in multiple calculations, the source needs to be adjusted only 
once. 

 

The example above shows the principle possibilities of structuring a small project. 

The objects "spot elevations" and "elevation lines" were saved to form the Geo-File 
"elevations". This Geo-File is used to generate the Digital Ground Model from 
within the Geo-Database. Once the DGM is calculated, it is assigned to all 
Situations.   

All buildings, the road, the noise protection walls and the calculation area are saved 
in additional Geo-Files. The “road” and the “building” Geo-Files are assigned to 
both Situations the "noise protection" and the "calc_area" Geo-Files are only 
referenced in one of the Situations. 

The Situations are assigned to the calculations, if desired additional singular Geo-
Files can be added, for example to include a calculation area that was never part of 
a Situation. 

The data structures in the background 

Geo-Files (*.geo) contain the coordinates and elevation information and all 
properties of the objects. 

Situations (*.sit) are a list of all Geo-Files included in the Situation. The Geo-Files 
are not stored physically in the Situation, only references are stored here. This has 
the big advantage that as no redundant data is generated, it is not necessary to edit 
the same data in each Situation where they occur. If a Geo-File in a Situation is 
renamed, the name will automatically be updated in all other Situations where this 
Geo-File is referenced. 

When a Situation is opened, a database copy of the properties of the included 
objects (TmpWorks.*) is generated. During the editing of data, you actually work 
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with the copy of the data until you save the Situation. When the data are stored, 
the temporary copy is replaced and all properties are stored again in the Geo-Files. 
The last version of the Geo-Files or the Situation is always saved as a backup copy 
under the normal names with the extensions  *.~si or *.~ge. Aside from the „undo" 
function this feature of backup copies of the data is increasing the data security. 

The Situation Manager - Situations and Geo-Files 
With the first opening of the Geo-Database in a new project, the program 
automatically generates a new Situation (Situation1.sit) with a Geo-File (Geo-
File1.geo) so that you can start with entering or importing data right away. When 
you leave the Geo-Database, you are asked to rename the Situation and the Geo-
File. The next time you open the Geo-Database the Situation Manager is displayed 
to select a Situation.  

New Situation / Edit Situations 

Call FILE -> OPEN SITUATION. On the screen you see the following dialog: 

 
Situation manager 

On the left side you see all Situations of the project, on the right side there are the 
description and graphics preview of the highlighted Situation. It might be that the 
preview doesn't match to the Geo-Files in the Situation. In this case, yellow 
question marks are added to call your attention. 

Situations like Geo-Files can be duplicated, renamed or deleted. Execute the 
functions via the symbol icons the menu SITUATION or the right mouse button. 

NEW generates a new empty Situation which you need to name first and then 
assign Geo-Files (existing ones or new ones). 
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As soon as you click on the + or triangle symbol, the display changes. Instead of the 
Situation information you now see the Geo-Files contained in the Situation. In the 
middle section of the box all Geo-Files of the project are displayed, on the right side 
is a description and the preview graphics. 

 

Geo-Files contained in the Situation are displayed in gray, once they are assigned to 
the Situation, they cannot be assigned a second time to the same Situation. In case 
you still want to assign the file again, you need to duplicate the file first and then 
assign it and modify it. 

You can jointly move the assignment of Geo-Files to a Situation. To select adjoining 
Geo-Files press the shift key and left click on the first and last Geo-File. Single Geo-
Files are selected with Ctrl and left click. 

Open the selected Situation with a double click on the Situation or the OK icon. 

Hint: If you are working on a tile project, you can distribute ASCII files or Shapefiles 
in the Situation Manager to different Geo-Files (TOOLS -> IMPORT ASCII, TOOLS -> 

IMPORT ESRI SHAPEFILE).  See Import data in tiles (page 651). 

Managing Geo-Files 

In the Situation you work on in the Geo-Database user interface you can generate 
and activate additional Geo-Files and remove the Geo-Files from the Situation, save 
Geo-Files and save them under a new name. When you remove a Geo-File from the 
Situation it is always the current Geo-File shown in the Geo-File selection list. In 
case you made changes to the Geo-File you are removing, you will be asked if you 
want to store the data. 
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For details on the three Geo-File display options please read Geo-File options (page 
90). 

Click on the symbol ADD GEO-FILE  next to the Geo-File selection list to 
request a new Geo-File or to activate an existing Geo-File and open it for 

editing in the current Situation. 

 
Geo-File Selection 

Only Geo-Files not already open in the existing Situation are presented. When all 
Geo-Files of your project are activated in the open Situation, the selection list will 
be empty. Click NEW to generate a new Geo-File.  

In the window on the left side you can select whether you want to see 
just the file name or with details enabled the information with date and 

time when the file was edited last. On the right side the description and a preview 
picture of the Geo-File are presented.  

The following functions are available either with the menu FILE, the right mouse 
button or the symbol icons. 
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You can select multiple adjacent Geo-Files by using the shift + left click or you can 
select single files with Ctrl + left click. In addition, you can activate all Geo-Files 
(EDIT -> SELECT ALL OBJECTS) or invert the selection (EDIT -> INVERT SELECTION). 

With OK or a double click on the Geo-File you get back into the data editing mode. 

View filters for Geo-Files 

Especially in huge projects containing a multitude of Geo-Files, the Geo-File list may 
become so overcrowded that it is cumbersome to navigate. For this case the 
program allows to filter the Geo-Files contained in a project. 

 

As a filter you can either show all files that contain the filter keyword in the file 
name or you use the file description to host the searchable keywords. If you filter 

via the file name  the filter text "building" would find all Geo-Files that have 

"building" in their file name. If you filter via the description , using e.g. "variant 
1"as a key word finds all Geo-Files relevant for variant 1 

Click  to terminate the filter definition and to view all Geo-Files again. 

Enter Objects 
The object coordinates are entered with the left mouse button. The elevation and 
the object properties are defined in the object dialog. Information on the 
properties of each of the objects is described in chapter „Objects and their 
properties (page 183)“. 

To enter the data first click on the object type icon on the object type bar or select 
the object type from the object list. 

 

There are two display options for the object type bar. Select either OBJECT 

SELECTION: GROUPED or OBJECT SELECTION: ALL OBJECTS from the menu OPTIONS. 

Line type and area type objects are finished with a double click, F2 or the symbol 
. 

The Object Dialog 

The object dialog contains all information relating to an object. The sections 
“properties” and “geometry” can optionally be fold in or out.  
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Example: Object dialog road 

The upper section shows the object name, the Geo-File in which the object is 
stored and for some objects additionally the object number.  

On the right, there is a navigation bar to navigate between the objects of one 
object type. 

 

First, previous, next and last object refers to the input order. Point, line and area 
sources are treated as one object type. 

The section “Properties” shows the properties (for objects which have properties). 
Information on the properties for each of the object types can be found in chapter 
“Objects and their properties (page 183)”.  
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The section “Geometry” shows coordinates (Habs and Hrel only for objects which 
have an elevation) together with information about length or area of the object. 
Please read details regarding the elevation definition under “(Elevation) height 
definitions (page 77)”.  

 

Blue coordinates indicate coordinates, where properties are changing. The current 
coordinate is marked with > in the node number. 

Below the geometry, you see a symbol to toggle the presentation between the 
properties themselves and the tree presentation as well as a navigation bar to 
navigate within the coordinates of this object. 

 

The symbols “next / previous coordinate with properties” are only active for variant 
objects with property changes. 

The object dialog can be opened during the entry of the data at different stages: 

 

For objects with relative elevations the object dialog is always opened at the first 
point, so that you enter the relative elevation immediately. 

To later view the properties and coordinates, select the edit mode and click on an 
object coordinate with the mouse (mouse cursor is an arrow). 

With the general objects point, line, area and measurement tape the object dialog 
is suppressed during input. 
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Tree presentation for variant objects 

Click on the symbol “tree presentation” in the last row of the object dialog to 
toggle from the property presentation to the tree presentation.  

 

At the first coordinate all properties are stored and listed in the tree presentation 
(picture above). For variant objects such as road, railway or wall, for which single 
properties may change during the course of the object, only the properties that 
were changed at a coordinate are stored and listed (picture below). 

  

The properties are grouped in blocks that are organized in a tree structure. If one 
property of a block changes, all properties in this block are stored. 

With the black cross you can delete individual blocks of properties, with the red 
cross you delete all properties at this coordinate. 

before   

afterwards   

All properties assigned to the third coordinate have been deleted, the properties 
assigned to the first coordinate apply. 

Hint: To delete all changes in the emission definition for roads and railways you can 
use TOOLS -> RESET EMISSION. 

The graphics object type can also be assigned or generated in the tree view of the 
object dialog, see “Graphics-Object type” page 150. 

(Elevation) height definitions 

For noise simulations the spatial position of the objects is very important. In 
general, when working with SoundPLAN a Digital Ground Model (DGM) is 
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generated. If the project terrain is relative flat, it may be adequate to assume a flat 
terrain height of 0 m throughout the project area without the need to use a DGM.  

The height Habs, assigned to the objects must be defined according to the object 
type.  

roads, parking lots road surface. The height of the source depends on 
the standard selected 

railways  referenced to the rail head, the source heights 
depend on the standard selected and the train type 

buildings / industrial buildings height of the floor slab, difference to the height 
assigned to the building is accounted for as the 
building base 

floating building / floating industrial 
building 

height of the floor slab, no building base but the 
possibility that there is a space underneath where 
noise can propagate through 

point-, line-, area sources emission height 

noise protection walls base height of the wall, difference to the terrain will 

be treated as the wall base height 

floating noise protection walls base height of the wall, no wall base but air space 
underneath is possible 

Noise protection berme terrain 

floating screen base height of the horizontal surface (the bottom of) 

free-field receiver entered height of the first receiver 

Receiver assigned to building automatically generated from the buildings slab 
height and the receiver specific properties of the 
building. 

opening of tunnels a base height averaged from the coordinates left and 
right of the tunnel mouth. 

mitigation area No height information needed always referenced 
directly to the DGM  

The height definitions can be absolute values above mean sea level or relative to 
the DGM or in the case of a totally flat model 0.0. The geometry definitions of the 
property dialog show if an object has the relative or the absolute definition.  

 

 

Absolut height 

The absolute height Habs is the height above mean sea level in meters. When an 
object is defined with absolute heights, the height of the object does not change if 
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the DGM is altered. In most road and railway projects that work with absolute 
heights, the objects are placed manually anew on to the DGM in case the DGM is 
altered.  

Relative height 

The relative height Hrel is the height above the DGM or above 0 meters. With the 
relative height definition, the objects position changes with the DGM, it is 
automatically fitted to the terrain. If the terrain is changed – for example in the 
different stages of excavating in a quarry, the objects defined relative will 
automatically adjust to the new terrain location. In this case the relative definition 
is an excellent choice. For identical source geometries that may be present at 
different location (for example a standardized power plant or super market with 
buildings, parking lots, gas station and other sources) the relative height definition 
is sensible.  

For the better visualization all coordinates with relative reference to the terrain are 
presented in red. 

Terrain following heights 

For line - and area sources and parking lots (such as construction equipment 
moving over the terrain), it is also possible to have the elevation definition 
following the terrain.  

 

For these terrain following objects, not only the coordinates entered are directly 
referenced to the terrain but the entire object. When the data are loaded in the 
calculation core, the terrain following object will be intersected with the triangles 
of the terrain which mean that the source will be following the entire terrain 
triangle by triangle. All coordinates of an object have the same height above the 
terrain. If the relative height changes at one coordinate it will be changed for all 
coordinates. 

 

If an object has only a few entered coordinates, it might be possible that the 
display in the in the 3D view in the Geo-Database and in the Graphics might be 
incorrect as the exact calculation of the object height is done on loading time in the 
Calculation core. 
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Change height definition 

In the object dialog you can alter the entry of relative height to absolute height and 
vice versa by moving the slider from one side to another.  

With the GeoTool CHANGE HEIGHT DEFINITION the height definition of selected 
objects can be toggled between ABSOLUT, RELATIV and for some objects to TERRAIN 

FOLLOWING. When you had defined the height as absolute and then change to 
relative height definition, the difference between the absolute height of the object 
and the height at this position in the DGM is entered as the relative object height 
Hrel. In the other way where the object is defined with relative height, the absolute 
height of the object is then calculated as the sum of the DGM height plus the 
relative Hrel , the result is entered as Habs for the coordinate. When you have a 
height definition that is absolute and switch to terrain following height, the height 
of the first coordinate will be used for all coordinates of the object. All objects that 
cannot be defined as terrain following keep their original height definition. 

Height above terrain from the emission spectrum 

For point -, line-, area- sources and wind turbines the height of the source can be 
already set with the data in the emission spectrum of the emission library, because 
the emission height above terrain is often dependent from the process defined in 
the spectrum.  

 

In this case please activate the setting TAKE OVER TERRAIN REFERENCE FROM LIBRARY 
in the object dialog in the Geo-Database. This checkbox is only available if the 
emission height is defined in the spectrum. 

Objects that are associated with a local coordinate system the local and the world 
coordinates are displayed in the object dialog. 
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 Enter objects with right angles 

Click on the icon  in the tool bar on the left side of the screen to enter the 
objects with right angles. 

From the third coordinate of a string the entry cursor can only be moved in a right 
angle to the last coordinate. When closing the object, the last coordinate is moved 
so that all angles of the object are right angles. 

The right-angle mode automatically calculates the last coordinate of an area object, 
so that you do not need to enter it.  

 

Selected area objects can be converted into right angle objects. Select GEOTOOLS -> 

MORE GEOMETRY TOOLS -> CALCULATE RIGHT ANGLED. All areas with angles in an 
acceptable range (>= 45°) will be rectified. If the message „angles not in acceptable 
range“ is shown, the program cannot decide if an angle is 90 or 180 degrees. In this 
case SoundPLAN leaves the original version of the data unchanged.   

Moreover, area type objects can be generated as rectangular objects with a north 
orientation by pulling open the object with the left mouse button. 

Tools circle and rectangle 

Select the desired object type (line or area type object). Pick the 
rectangle, the circle defined with the center coordinate and the radius 

, or the circle defined with two coordinates on the perimeter  in the tool bar 
to the left. Pull open a frame and enter the elevation of the object and the radius 
or length and width in the following dialog.  

 

 



 SoundPLAN Manual 8.1 
 Geo-Database 

Page • 82/793 The different display options 

3 

Measure distances 

You can see the difference between the last entered coordinate and the cursor 
position in the left part of the status bar: 

 

You can also measure the distance between any positions on the screen: Keep the 
left mouse button and move the mouse from one position to the next. 

The temporary object type measuring tape (in the option "objects in groups" 
under "Tools") is used to digitize dimensional chains.  

 

The 2-dimensional distance between the coordinates as well as the sum of the 
distances is displayed. Using the right mouse button -> CAPTURE COORDINATE, the 
exact position of a coordinate is captured. Because the measuring tape is an object, 
you can use all object options, e.g. insert or delete points. The dimensional chain 
disappears after the data have been updated with Ctrl+ R. 

The tool "measure" (toolbar on the left side of the screen) can be used with 
any of the object types. Enter the first coordinate as usual. For the entry of 

the next coordinate keep the left mouse button pressed to display the distance to 
the previous coordinate. When OPTIONS -> ELEVATION DIALOG ALWAYS is selected, or 
you press the shift key in addition, you can enter the exact distance in the next 
dialog.  

The different display options 

Top View, Side Projection and 3D-Wire Model 

As an important tool for the elevation control of your data you can toggle between 
top view, projections and a 3D wire frame presentation. Select VIEW -> FRONT 

ELEVATION (F8), SIDE ELEVATION (F9) or 3D WIREFRAME (F10). 
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Front elevation projection in the Geo-Database, here it is evident that a bridge is missing 

You see all objects contained in the current Situation in the top view (site map) and 
as a projection. The following information is displayed: 

• Coordinates that contain properties are depicted with a bigger dot than 
regular coordinates. 

• For receivers that are assigned to buildings the base elevation is drawn as a 
double circle, the receivers relevant for the calculation are displayed as 
circles. For receivers without building assignment, the entered object 
elevation is the first calculation point.  

Hint: When your data are displayed very compactly at the upper edge of the 
projection window, objects with incorrect elevations or “zero elevations” are 
within your model data.  

Use EDIT -> SELECT OBJECTS WITH ELEVATION <= [M] to find objects that do not have 
correct elevations. 

With the mouse you can move to the objects in the projection and see the 
elevation of the cursor position in the status line on the bottom. A left mouse click 
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opens the property dialog; a right mouse click opens a popup menu to execute 
further actions. 

The elevation stretch factor can be zoomed by pulling up the frame of the lower 
window. Click on the upper edge of this window and keep the left mouse button 
pressed. When the cursor shape changes to , move the mouse upwards. 

An additional aid in checking your model is the 3D wire frame model. Open it with 
VIEW -> 3D WIREFRAME (F10). 

 
3D-wire frame model in the Geo-Database 

TILTING the model is accomplished with the selection box on the right side of the 
bar on top of the graphics window or with the up/down arrow keys. 

In the wire frame model, you zoom by choosing the magnifying glass cursor and 
clicking on the screen. Click with the left mouse button to zoom in and zoom out 
using the right mouse button. 

Objects without elevations (e.g. Texts or calculation areas) are disregarded in the 
3D view. Other objects can be hidden with the setting hidden 3D in the object 
options (VIEW -> OBJECT OPTIONS or the cogwheel symbol next to the current object 
type). 

Solid 3D-Graphics Model 

[Module 3D-graphics] The 3D-graphics opens in a detached window via VIEW -> 3D-

MAP or Ctrl+ F10.  
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The view of the 3D-graphics window and the top view of the Geo-Database are 
controlled separately so you can see different views. You can move in both 
windows with the mouse wheel depressed and can rotate the 3D-graphics with 
Ctrl+ pressed mouse wheel.  

Depending on the project size a DGM will be rendered only for the existing view in 
the Geo-Database. For this reason, the loading times are much shorter for big 
projects. Via the settings you can define a buffer around the visible area for which 
the DGM is to be rendered. 

 

If no DGM is loaded in a Situation, you can select in the object types to view a 0 m 
based area.  

Receivers and point sources have the option to draw a line from the point type 
object to the ground. This allows a better understanding of the position in space. 
To activate this feature, go to the object types/3 D Graphics and activate LINE TO 

GROUND.  
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 Check the user defined object types in the graphics window 

Open the 3D-window and switch the selection list to “site map” to check your own 
object types defined in the object types and assigned to the objects via the 
Property Explorer or EDIT -> GRAPHICS-OBJECT TYPE.  

The cooperation between the Geo-Database, 3D-graphics and the Property 
Explorer make an efficient and effective project data check possible. Especially 
when a lot of data is imported, a critical eye is required to ensure the model is 
correct. The height of hundreds of buildings can be easily scanned with 3D 
graphics. Then use the Property Explorer to sort the buildings according to height. 
When you scroll through the list, the location of the object can be easily traced in 
the 2D graphics. In addition, the elevation base can be generated, refined and 
tested from within the Geo-Database. 

 

The object selected in the Property Explorer is highlighted in the top view, and if 
the center button is clicked, will also display the object in the center of the screen. 

Rotate 

The data can be rotated in steps of 90 degrees by clicking on the arrow buttons or 
any increment with the slider. The controls are as follows: 

 

Tip: With the left / right arrow key of the keyboard the view is rotated in 
increments of 2 degrees for each click. It is not possible to rotate the geometry 
when a bitmap is loaded. 
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Display of object dots and object properties 
The object dots mark the location of the coordinates; double rings indicate that the 
object has the definition of descriptive properties. The arrow between the first and 
the second coordinate of an object marks the start point and the entry direction.  

 
Object dot, the start of string marker and property changes in the course of an object 

It is much easier to find the coordinates when the object dots are activated. On the 
other hand, the editing speed is much slower especially with big data models. You 
can therefore change the settings to meet your needs, see "Settings for Geo-Files 
and Object types (page 87)". When digitizing new objects, the object dots of the 
new object are always visible. 

The start arrow of an object helps you to check if data loaded from external 
sources are present as poly line or were imported as single stand-alone line 
segments. See the GeoTool „Connect lines and generate areas (page 158)". 

The object properties are always defined at a coordinate. For some objects (roads, 
railways, noise protection walls ..) it is also possible to modify the object definitions 
at any coordinate of the string. The object properties are valid until they are 
replaced by a new definition. To open the object definitions, close in on the 
coordinate until the mouse cursor changes into an arrow and click left. 

When you are still entering a new object or have activated an existing object, the 
last coordinate is displayed with a red circle, this helps finding the object to 
continue with the data entry.  

Settings for Geo-Files and Object types 

For structured editing of complicated data, it is often beneficial that Geo-Files and 
Object types have their own controls of display states. This way all files except for 
the one to be amended can be protected against overwriting and all data except 
the active one can be grayed out whereas a reference object (for example a road) 
can be highlighted while another object (for example a noise barrier) is edited.  

Moreover, you can display only the current object type (VIEW -> CURRENT OBJECT 

TYPE (F6)) or the data in the current Geo-File (VIEW -> CURRENT GEO-FILE (F5)). 

Object options 

For the object options click on the wheel symbol. 
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All object types contained in the open Situation are displayed. Activate the setting 
for the object type of choice by clicking in the appropriate box. 

  HIDDEN - the object type is invisible but will be stored as usual.  

  WITH POINTS - for this object type the entry coordinates are made visible 
with little circles. 

  WITH PROPERTIES - if available, selected properties are shown (for example 
the kilometers or the facades activated for a facade noise map) see picture below. 

  BACKGROUND - the object-type cannot be edited and is displayed in gray 
color. When you select objects, the background objects are not included. However, 
background data are still snapped to when capturing coordinates with the right 
mouse button in the digitizing mode with the red cross. 

  HIGHLIGHTED – the object type is drawn with double thick lines in the 
normal object color. This setting is very helpful when working with background 
bitmaps.   

General areas with the visual property „highlighted“ are presented with a hatch.  

 
The current object type settings are stored in the project. 

Hint: When an object vanishes after it has just been digitized, the currently used 
object type is probably set to the „hidden” state.  

In the field OBJECT DOT SIZE, the size of the dots can be customized. Object dots do 
not change with the zoom factor of the normal map view. When you are displaying 
large amounts of data with a big magnification, the object dots may become so big 
that it may be necessary to resize the object dot size or zoom in the data. 

You can reset all settings for all object types or set the options for several object 
types at the same time. 

 Reset all settings  

 Highlight object-types with the Shift or Ctrl-key and set the options for the 
highlighted object types. 
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Hint: Press F4 to temporarily deactivate the current object type settings. This might 
be helpful if you in general want to view the road properties, but while checking 
the road course, the display of the kilometer is annoying.  

 
Display of object dots and additional information  

The screen section above shows which additional properties are offered in the 
object properties presentation: 

• For roads, the emission level is drawn next to coordinates where the level 
definition changes and the rate of incline > 5% on roads is visualized. 

>5 - 10% "<" or ">" 

>10-15% "<<" or ">>"  

>15% "<!!!>" 

• For roads and railways, the kilometer post is displayed if selected as 
reference road or railway. 

• For traffic lights (German RLS-90) the position of the signal points is shown 

• For noise protection walls, the height of the wall is printed next to each 
coordinate where the height of the wall changes. 

• Facades of buildings enabled for Façade-Noise calculations are marked with 
a bold turquoise line; facades not selected for the calculation are drawn 
with a thin blue line. 

• For receivers, industrial sources and photo points, the object number is 
displayed. 

• If a 2d-directivity is assigned to the frequency spectrum of an industrial 
source, the direction is shown. 

• For photo points, the view direction and the view angle are printed. 

• Receivers assigned to a building are displayed in green color; receivers not 
assigned to buildings are drawn in yellow. Receivers that were originally 
assigned to a building where the reference has been lost (by deleting the 
building or copying them for example) are marked in red. In addition, the 



 SoundPLAN Manual 8.1 
 Geo-Database 

Page • 90/793 Display of object dots and object properties 

3 

sweeping angle from where the noise can be received is drawn with a blue 
arc. Full circles indicate that the incoming noise is not restricted, a half circle 
indicates a sweep angle of 180 degrees. 

Geo-File options 

For the Geo-File settings right click on selection list for the Geo-Files or open VIEW -

> GEO-FILE-OPTIONS.  

All Geo-Files contained in the Situation are listed.  

 

Geo-Files can assume one of the following states: 

  READ ONLY – the Geo-File is drawn normally and can also be edited but any 

modifications will be discarded unless the status of read only is modified before 
storing the Situation. When storing the Situation, you will be asked what to do with 
modifications in a read only Geo-File. If you click CANCEL, you will return to the 
Situation. 

  HIDDEN – the Geo-File is not visible. 

  BACKGROUND – the content of the Geo-File cannot be edited and is drawn 

in gray color.  

F4 or VIEW -> EXTENDED OBJECT VIEW toggles the display between the status of 
„selected settings” and “without settings”. The selected settings are still active 
even if the extended object view is not activated. 

The property „read only“ or „background“ set for the Geo-Files is stored with the 
Situation. 

You can reset all settings for all object types or set the options for several object 
types at the same time. 

 Reset all settings  

 Highlight Geo-Files with the Shift or Ctrl-key and set the options for the 
highlighted Geo-Files. 
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Data entry 
SoundPLAN allows data entry in many different forms and ways depending on the 
format of your data. If you have physical plans you can scan them and digitize on 
screen with the mouse. If your data are already in electronic form you can import 
them with the interfaces to external data (DXF, ESRI shape files1, CityGML1, 
OpenStreetMap1), the QSI interface or via the free programmable ASCII interface. 

Digitizing mode  

When coordinates are close together it often happens that the cursor homes 
in on an existing coordinate and changes into an arrow. As this is usually not 

desirable when digitizing new objects, the Geo-Database offers an additional entry 
mode that does not home into other objects. Click on the red cross icon on the left 
side of the data entry area. The cursor changes into a crosshair cursor. To later edit 
the object properties of already digitized coordinates, activate the default editing 
mode by clicking on the black cross icon. You can also use or F12 to toggle between 
digitizing and editing mode.  

Capture coordinates 

You can capture coordinates that are already present in your Situation. Capturing 
coordinates copies the location and elevation information; thus, the coordinates 
are twice in your data set. The data are handled separately from one another so if 
one gets moved to a new location, the other one will not automatically move. See 
also "Move / capture selected point (page 149)". 

To capture a single coordinate, right click on the coordinate and select -> CAPTURE 

COORDINATE (data entry mode - black cross). For multiple coordinates, it is 
advisable to activate the digitizing mode and to right click on each of the 
coordinates. When a coordinate has been captured and the X, Y and Z component 
has been taken over, there is a confirmation gong. 

Hint: Identical coordinates are visible when you pull a „rubber band“ frame around 
them by moving the mouse over it with the right button pressed. The selection 
mark for double coordinates are canceling each other out so that the movement 
cursor becomes visible when you home in on the coordinate, but the coordinate 
appears to be not selected. 

 

                                                                    
1 Not included in the SoundPLAN basic configuration  
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Digitizing from scanned maps (bitmaps) 

If you don't receive scanned geo-referenced maps, you can create a geo-reference 
for your own scanned maps.  

Please keep in mind that the color depth of the bitmap should not be too high and 
think about possibly reducing a color bit map to a gray scale one. The larger the 
bitmap the more memory is consumed by it and the slower the processing speed. 
To work with scanned plans in SoundPLAN they need to be in the formats *.bmp, 
*.tif, *.jpg or *.png. 

 The connection to online map services (Google Maps and OpenStreetMap) and 
Google Earth allows selecting a view and use it with GET IMAGE in the window of 
the online map services or with BACKGROUND GRAPHICS -> TAKE OVER CURRENT 

GOOGLE EARTH VIEW AS BITMAP in Google Earth as project basis.  

If you already have vector data in your project use the right mouse button -> 
INITIALIZE ONLINE MAP SERVICES AT CURRENT CURSOR POSITION or GOOGLE EARTH 

BITMAP FOR CURRENT CURSOR POSITION, see “Connection to online map services” or 
" Connection to Google Earth ". 

You can also integrate WMS servers, which display the geometry viewport in the 
background and update the background bitmap when moving. You can also request 
a bitmap from images from WMS servers with the right mouse button. See 
“Connection to Web Map Service (WMS) Servers”   

Load background bitmap and enter the reference points 

Scanned plans that are to be used as a background graphic in the Geo-Database 
must be loaded into memory and then adapted to the world coordinates. The geo-
reference can be made differently: 

• Geo-reference in the graphics file 

• Geo-reference in a separad word file (e.g. *.tfw, *.jpw, *.pnw) 

• Project coordinate system (OpenStreetmap, Google Maps, WMS server, 
Google Earth) 

• Project coordinates in SoundPLAN if vector data are available 

• Word coordinates 

Call FUNDAMENTALS -> BACKGROUND BITMAP -> LOAD BITMAP FILE / PDF and open the 
scanned map or PDF file. The PDF file is first converted to a grapic file, see „PDF as 
background graphics“, page 95. SoundPLAN loads the map and presents it in the 
reference coordinate entry screen. 
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Load bitmap 

In the upper area the graphic is displayed, in the lower part the table in which the 
world coordinates are assigned to the bitmap coordinates. If a reference file exists, 
close the bitmap dialogue with OK, the bitmap is automatically geo-referenced.  

With the button SAVE AS in the geo referencing dialog you can select the button 
OPTIONS to modify the size of the graphics file. This is helpful when the graphics are 
very large and threaten to exceed the available memory. The geo referencing files 
are recalibrating the control points so that it is possible to use this modified 
graphics in the Graphics without extra alterations. 

  

Depending on the type of graphics file there are additional controls. For BMP, TIF 
and PNG you can alter the color depth, for JPG the compression.  

Use the button  to transform the coordinate system in a single background 
graphic. 
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Word files – geo-reference files 

World files (tfw, jgw, pgw) or SoundPLAN geo referenced .grf graphics can be 
opened via FUNDAMENTALS -> BACKGROUND BITMAP -> LOAD WORLD FILE(S) (GEO 

REFERENCING). If you keep Shift- or Ctrl-key pressed, you can load multiple file at 
once. If a project coordinate system was defined, the transformation dialog opens 
so that you can transform the background bitmap to conform with the project 
coordinate system. This way you can read already geo referenced bitmaps and 
transform them to a different coordinate system. 

Geo-referencing bitmaps in a new project 

If there are no objects in your project yet, mark two easy-to-find coordinates on 
the plan and note the x / y values. The most suitable are coordinate crosses with 
even values. 

Enter the first numerical value of the reference coordinates with the keyboard in 
the white fields and then click with the mouse on the coordinate in the graphics. To 
accurately enter the data even on a relatively big scale, the first mouse click opens 
a zoom window with the coordinate in its center. Home in on the reference 
coordinate as accurately as possible and click again. Repeat this procedure with the 
other reference coordinate. 

Adapting bitmaps to already existing vector data  

When data are contained in a Situation, the reference point entry dialog opens 
parallel to the regular Geo- Database display in order to enter the reference points 
directly with a mouse click.  

 

In the Geo-Database zoom in on the desired reference point and click on it. The 
coordinates are transferred into the reference point referencing dialogue. Use the 
mouse wheel to zoom in on the reference point and click to synchronize the 
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coordinates. Proceed the same way with the second reference point. It is irrelevant 
whether you first click on the reference point in the Geo-Database or in the in the 
referencing dialog.  The reference points are presented in the Geo-Database and in 
the referencing dialog. 

PDF as background graphics 

Plans available in PDF files format can now be used directly as a background bitmap 
in the Geo-Database, the industrial building, BA-Façade and a graphics box in the 
SoundPLAN graphics. If the PDF file contains multiple pages you can select which 
page to convert for the background bitmap; additionally, you can save view ports - 
for example to cut out the plans description box or to save the top view and the 
projections of buildings in separate files. 

 

Click on the green checkmark or press the enter key to convert the entire page into 
a bitmap. By default, the file name for the bitmap is the same as the name of the 
PDF file, however you can also customize the file name.  

To convert only a portion of the PDF page, please use the left mouse button to pull 
open a frame around the area you wish to convert. If this area is sufficient, click on 
the green checkmark and enter a file name for the graphic. 

If you want to convert multiple parts of the same page, use the mouse to 
mark this portion and then select SAVE AS and enter a file name. In this case 
the PDF convert dialog remains open. Move the frame to the next area you 

want to save. If you re-use the frame, the size of the bitmap will remain the same 
size, if you need a different area, pull open a new frame with the mouse. With Esc 
or by clicking outside the frame, reset the selection. 
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Further options: 

 

Select to show the file either in ORIGINAL SIZE or FITTED TO DIALOG SIZE. MIRROR 

PICTURE is useful for example if you want to change the assignment of the bitmap 
of a ceiling in the industrial building to show the view from above.  

The PDF section is first converted to a 24-bit bitmap as at this time the required 
number of colors of the PDF file is not known. If the color resolution exceeds your 
needs or the PDF has less unique colors, you can reduce the color depth of the 
bitmap to make the file smaller. 

Additionally, you can rotate the PDF file and change the resolution of the 
conversion. For most PDF files the default setting of 150 dpi is sufficient.  

In the status line of the dialog you can see the dimensions and the estimated size of 
the bitmap in MB / kB.  

Working with multiple bitmaps 

Projects may have multiple bitmaps however, in the Geo-Database only a single 
bitmap can be open at a time because the vector data are adapted to the bitmap. 
Select the desired bitmap from the bitmap selection list and use the click box to 
hide the bitmap temporarily. Additional controls allow the bitmap to be moved in 
small increments.  

 
Multi bitmap selection, click box to temporarily hide the bitmap and move controls 

Restrictions when working with bitmaps 

Certain restrictions are imposed when a bitmap is loaded on screen. Neither the 3D 
wire frame model nor the projections can be used while the bitmap is loaded (also 
if temporarily hidden). Rotating the screen was disabled because it would take too 
much calculation time to rectify rotated bitmaps on screen. While the bitmap is in 
memory, the customary viewports are disabled. 
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If you want to use one of these functions, select NO BITMAP from the selection list. 
You can quickly reload the bitmap afterwards. 

Bitmap Zoom box 

Via OPTIONS -> BITMAP ZOOM BOX you can activate a zoom window when digitizing 
in the Geo-Database interface, which displays the original scale of the bitmap when 
entering the coordinates.to activate or deactivate the zoom window. 

Helmert transformation for cases of doubt 

If you enter a third reference point, an error calculation is performed according to 
the Helmert transformation. It is the quadratic error from the comparison of the 
given plan and sent bitmap coordinates. This can be compensated for any 
inaccuracies when scanning or paper distortion. The reference points should be as 
far away as possible or include the investigation area as far as possible. 

The magnitude of the standard deviation decreases with the number of coordinate 
pairs and increases with the scale of the plan. 

The standard deviation should not exceed: 

 Scale 1:500    5 
 Scale 1:5000    20 
 Scale 1:10000    30 

When the standard deviation is too high the reason could be: 

• Entry not precise enough (activate the reference coordinates in the table 
and click on the coordinates on screen again). 

• X and Y swapped (Correct the values in the table) 

Press OK to leave the reference coordinate entry and start digitizing on screen. The 
reference coordinates are stored with the bitmap, so the calibration of the map 
needs to be done only once for this project. 

Data import / export 

DXF Import 

The geometry (X, Y, Z coordinate) from the DXF file is imported as general point, 
line and area information. The actual object type is not known. 

The objects relevant for SoundPLAN use the AutoCAD 2002 format specification. 

To efficiently work with DXF data it is paramount that you know the organization of 
the data in the DXF file. 

In AutoCAD, the data are provided in different layers. Knowledge of the layers in 
the file, the naming convention and possibly a description of the layers (layer list) is 
important for the distribution of the incoming data to SoundPLAN object types. In 
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AutoCAD there is no fixed naming convention for the layers, so it is advisable to get 
information about the layer names from the data supplier. You have the least 
amount of work with importing the data if the supplier of the data only exported 
the data you need. However, in practice this will be seldom the case. 

Call FILE -> IMPORT -> DXF, load the DXF-file and click OK. The layer list is 
alphabetically generated from the content of the file and a preview is shown on 
screen. 

 
DXF-Import layer list 

„All layers“ presents the entire content of the dxf file, the coordinate range and the 
number of objects. Use the arrow keys or the left mouse button to move through 
the layer list and view the content of each layer. Highlight the layers you want to 
import. Select a single layer with the left mouse button or select an area of layers 
with shift and the left mouse button. Multiple single layers can be activated with 
ctrl and the left mouse button. After selecting the layers, click on the OK button to 
import the data.  

Via EDIT -> INVERT SELECTION you can reverse the layer selection (i.e. selected layers 
get unselected and unselected get selected).  
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Use the mouse to pull open a box on the preview panel with the result that 
only the data contained within the box are imported. To cancel the box and 

import data from the entire area, click on the red CANCEL SYMBOL on top of the 
preview panel. 

The layer can be imported optionally when you check mark TEMPORARY GEO-FILES. 
Temporary Geo-Files (TMP_LAYERNAME) are only stored after they have been 
assigned to user defined Geo-Files, SoundPLAN ignores the temporary data when 
saving the Situation.  Permanently imported layers (DXF_LAYERNAME) are always 
stored in the Situation. 

When importing DXF data without knowing the content and structure of the file, it 
is advisable to import all data into temporary Geo-Files and to then select the view 
to look at the data Geo-File by Geo-File (VIEW -> CURRENT GEO-FILE (F5)). By scrolling 
through the list of Geo-Files you see the content of each file as a graphics on 
screen. If you discover that you only need the data from a few Geo-Files, you can 
scroll to the temporary Geo-File, select the data and then move the data to a 
different Geo-File with EDIT -> CHANGE ASSIGNED GEO-FILE. You do not need to 
delete the other temporary Geo-Files, when you close the Situation; the temporary 
Geo-Files are discarded. If you need most of the data from the DXF file in multiple 
layers, it may be faster to import the data again without activating the check box 
temporary. 

You can also import several layers into one Geo-File. Select LOAD ALL HIGHLIGHTED 

LAYERS TO ONE GEO-FILE and define the Geo-File name. 

The following objects are imported, some of them with additional properties and 
functions: 

 
DXF Objects 

• Coordinates with the elevation equal to zero can be ignored when 
importing. 

• Individual line elements are connected to polylines when CONNECT LINES is 
activated. Several lines are connected to polylines if the end coordinate of 
one line is identical to the begin coordinate of the following line. The lines 
must be adjacent in the data file for this function to work. 
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• Polylines with dense coordinates can be filtered during the import (filter 
value 5 cm). 

• Circles and arcs are transformed into polylines. For the conversion you can 
set the density of coordinates in the polyline to low, middle and high. 

• Texts are imported as Geometry texts which you can assign sizes at import 
time. 

• Furthermore, there is the possibility to directly convert texts into spot 
heights. Often the DXF file is not 3 dimensional but the heights are written 
on the plan as a text. With the setting IMPORT AS SPOT HEIGHT you convert 
the text into the Z part of a coordinate. When activating this setting, make 
sure that you only import the layers where the elevation information is 
hosted; the data would become unusable if the property numbers or the 
address of a building were converted into the elevation information. The 
coordinates of the spot height are derived from the position marks of the 
text. This might lead to a systematic position error which needs to be 
corrected with the coordinate operations. 

• With the COORDINATE TRANSFORMATION, reference coordinates from a local 
DXF-scale can be transformed into the world coordinate system SoundPLAN 
uses. You need to read the coordinate twice, once to locate the local 
coordinates of the reference coordinates and the second time to assign the 
coordinates to the reference points. Select 3 or 4 reference points that you 
can identify in the local coordinate system and in the world coordinate 
system. The reference coordinates should be apart as far as possible to 
minimize potential coordinate errors. SoundPLAN uses the Helmert 
transformation to convert coordinates from the local into the world 
coordinate system. SoundPLAN stores the coordinates so that you must 
execute the coordinate transformation only once per project. 

When you press the OK button, the DXF data are imported and converted into 
SoundPLAN unspecified objects of the type point, line, area and texts. Edit the data 
with the functions "Convert object type (page 153)" and "Change Geo-File 
Assignment (page 152)". 

DXF-Export 

Situations from the Geo-Database can be exported into DXF files. Select the menu 
FILE -> EXPORT -> DXF. SoundPLAN exports the displayed geometry data. This allows 
you to export a specific Geo-File with VIEW -> CURRENT GEO-FILE (F5) or a specific 
object type with VIEW -> CURRENT OBJECT TYPE (F6). Choose whether you want to 
export one layer PER OBJECT TYPE or PER GEO-FILE. 



SoundPLAN Manual 8.1 
Geo-Database 

Data import / export  Page •  101/793 

3 

ESRI Shapefile Import 

[GIS interface] Via the ESRI Shapefile import Shapefiles from GIS software 
(coordinates and descriptive properties) can be imported into SoundPLAN. 

This interface is loading the data directly into a Geo-File of your choice with the 
correct data type (e.g. road or building) and the assigned properties. 

The import data for one object type normally consist of at least 3 files:  

*.shp  contains the coordinates and the elevation 

*.dbf contains the properties of the objects 

*.shx is an index file 

DBF files can be opened and if necessary modified in the SoundPLAN Spreadsheet. 
This way, you can see the defined properties and decide which columns you want 
to assign to the properties of the SoundPLAN objects.  

Properties that are valid for all objects (e.g. "emission calculated" or "entry type" 
for the import of roads) can be assigned in the standard properties which are 
opened before the data are imported.  

Invoke the import via FILE -> IMPORT -> ESRI SHAPEFILE and click on the “open” 
symbol to select the shapefile(s) (multiple selection via Ctrl- or shift key): 

 

The selection of multiple shape files is only sensible, if all files have the same object 
type. 

Define to where (object type and Geo-File) and how (assignment of columns from 
the source file to the properties of the SoundPLAN object) the contents of the 
shape file should be imported. 
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All saved property assignments can be revoked at once using the double arrow 
. 

OBJECT TYPE and GEO-FILE: Select the object type and the Geo-File into which the 
data are to be imported. It is also possible to create a new Geo-File. With the 
switch DEFINE DEFAULT PROPERTIES you can define the default properties for all 
properties that are not explicitly defined in the shape file. The assignment of the 
default object properties pops up after you finished all entries in this dialog and 
pressed OK. 

ASSIGNMENT TABLE and OBJECT TYPE PROPERTIES: The column PROPERTY FROM 

IMPORT FILE shows the column headers from the shape file. In the column 
PROPERTY IN SOUNDPLAN you can assign the fields of the respective SoundPLAN 
object type with a double click or the arrow key.  

Click on the OK button to first view the properties set for the first data record and 
add additional properties valid for all objects to be imported and afterwards import 
the file. 

Hint: If a unique identifier for the objects is included in the properties it is wise to 
import it in an unused field (e.g. as object number). You can use this identifier to 
later add further properties, see ”Add properties via the search key (page 110)”. 

For the import of roads all dependent properties are automatically calculated, see 
“Import of roads (ASCII, Shape, dbf)”, page 109. 

Use the GEOMETRY FILTER to filter lines with a high point density directly during the 
import of a shape file. 

Shape files with Triangle Strips and Triangle Fans 

When an object consists of triangle stripes or triangle fans, most of the time the 
object is a completely 3D surface approximated with triangles. With the exception 
of the object types „area“ and „building“ the triangle stripes and triangle fans are 
ignored. 

For the object type „area“ each triangle will be become a unique stand-alone 
triangle. After importing, SoundPLAN does not know any longer that all triangles 
once formed a single object, that connection has been lost. 

For the object type „buildings“, all triangles of the object are imported. In a second 
step the program uses all triangles projected to the terrain surface to generate a 
continuous hull. For this reason, also balconies are part of the buildings floor plan.  

If not, further detailed settings are made, the lowest z-coordinate of the building 
will be used defining the elevation of the lowest floor slab. Often there is an extra 
column in the dbf-file defining the floor elevation. A more accurate model can be 
made when you assign the field h1 to this value (before doing this, check the data 
in the dbf file). 
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ESRI Shapefile Export 

[GIS interface] Call the shape file export via FILE -> EXPORT -> ESRI SHAPEFILE. Define 
which properties shall be exported in addition to the coordinates. Enter the name 
of the folder in which the exported shape files shall be written; the default setting 
is the name of the Situation. The export files are stored in this sub folder in the 
project folder. 

In a tree structure all object types contained in the Situation are listed, for each 
object type all properties are listed as the next level. By clicking on the node sign 
the tree structure is opened up and displays all details. 

 

If you click on the object type, the geometry of the corresponding object type is 
exported (marked by an unfilled square). Open the properties using the "Node" 
symbol. If you click on the property block, for example "profile", all properties 
stored in it are exported (the property block is marked with a check mark). Click on 
individual properties to switch them on or off for the export. If not, all properties 
are switched on, the block is marked with a black, filled square. 

The objects and properties defined for the export are displayed in the window on 
the right-hand side. 

For buildings or noise protection walls you can toggle between export of the object 
basis elevation or the top edge (right mouse click on the object type). 

   

Field names in the Shape files can only be 10 characters long without blanks and 
special characters. As SoundPLAN truncates the names the identifiers can become 
unreadable. Press F2 to enter a meaningful label. You can define a short title (page 
144) for the Shapefile export in OPTIONS -> SELECTION OF OBJECT PROPERTIES.  

The selections and settings are stored either for the project or in the global 
context.  
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QSI Interface (DIN 45687) 

The QSI exchange format was developed to exchange model data between 
different noise modeling programs. The format is based on the ESRI Shapefile 
format. A Shapefile is generated for each object type. The database connected to 
the Shapefile contains all descriptive data and has been agreed upon by the 
manufacturers of the participating noise modeling software. For a complete 
definition of the interface, please read amendment #1 of the DIN 45687. 

With the QSI format, entire situations can be imported or exported. The qsi model 
file (*.qsi) generated during the export contains all object types and the file names 
of the generated shape files. 

Call FILE -> IMPORT -> QSI to import QSI files or FILE -> EXPORT -> QSI to export a 
SoundPLAN Situation to the QSI format.  

Import of single shape files from QSI data 

For noise protection walls and buildings z is described as the upper edge of the 
object; in addition, a shape file with elevation points is generated containing the 
basic elevation at each coordinate. Import this shape file additionally, calculate a 
DGM from the terrain points, set the basic elevation with EDIT -> SET OBJECTS TO 

DGM and determine the building or wall height with the Geotool "Calculate the 
object height from the top edge (page 170)".  

CityGML Import 

[GIS interface] Building data are often issued by the authorities no longer as 
shapefiles, but in the CityGML format. 

CityGML is a very openly formulated standard for the exchange of 3D data, which 
allows many different interpretations and dialects. In Germany, for example, the 
information in the CityGML data differs for each federal state. Of course, this 
makes it difficult to develop a general import interface.  

There are different levels of detail for city models in CityGML (Level of Detail [LoD]): 

LOD 0: Terrain model with texture 

LOD 1: City model, block model without roof structure 

LOD 2: City model with roof structures and texture 

LOD 3: geometrically detailed architectural models 

LOD 4: Geometrically detailed architectural models (inside and outside) 
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Simple examples for LOD1, LOD2, LOD 3 

In SoundPLAN, LoD1 and LoD2 CityGML data are read in as a block model (LoD1). 
The building heights of LoD2 data are calculated from the heights of the roof areas. 
Here, the average height and the swept floor area are determined per roof area. 
From this the average building height based on the proportionate floor plan areas 
is determined. 

 
Block building with building height averaged from the roof areas and original roof surfaces 
from LoD2 data 

Method to import CityGML data 

Invoke the import via FILE -> IMPORT -> CITYGML and select the file(s) with the 
“open” symbol. You can also import CityGML data, which is available in several 
tiles, at once using the Shift or Ctrl key 

Note: CityGML files larger than approx. 500 MB cannot be imported with the 32-bit 
version. Please use the 64-bit version. 

After importing the file(s), the building properties contained in the CityGML data 
are displayed in the assignment table. Depending on the data supplier, the most 
diverse properties can be contained - or none at all - then the assignment table is 
empty. 

We distinguish between the properties between "normalized" properties that can 
be identified by a normalized keyword and other (free) properties. The normalized 
keywords currently only contain address data. 
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If normalized properties are contained in the CityGML data, it makes sense to use 
these for the assignment of road name and house number. If only free properties 
are included, they may also contain useful properties. 

Make the assignment by double-clicking or using the arrow to assign the 
SoundPLAN building properties. 

The building name is - if not explicitly assigned - formed from the GML identifier. 

Calculation of building heights 

If you assign a building height in the assignment table, this is used. Otherwise, the 
search is first made for floor and ceiling surfaces and the building heights are 
determined from their average heights. If there are no floor and ceiling surfaces, 
the heights of the wall bottom and top edges are used for the building height. If no 
information is contained in the CityGML file, the default value of the standard 
building properties will be used. 

OpenStreetMap Import 

[GIS interface] OSM data can be automatically downloaded and imported via 
FUNDAMENTALS -> CONNECTION TO ONLINE MAP SERVICES (see “Connection to online 
map services”). You can also manually import OSM files via FILE -> IMPORT -> OSM 

IMPORT XML, for example, if you have received an osm file or if you have a modified 
osm file. 

Select the file(s) you want to import and additionally the object types.  

Some objects may be helpful only for orientation but are not detailed enough for a 
SoundPLAN model. Data of different object types are imported each into their 
specific Geo-File with the prefix “OSM_”. This procedure should make it easier to 
later on deleted data of object types not desired in the model. After finishing these 
definitions click on IMPORT. 

 Kml Export 

Buildings, noise barriers, roads, railways, parking lots, point sources, line sources 
and area sources, industrial buildings (including point sources, line sources and 
area sources outside) and wind turbines can be exported to a kml file. 

These objects are exported with absolute heights. If the ground model in 
SoundPLAN has lower heights than the ground model in Google Earth (which is the 
case often), the objects disappear in the ground. 

You can lower the terrain height in Google Earth so that all objects get visible again 
(Tools -> Settings -> "Elevation Exaggeration"), or you could put all objects in 
SoundPLAN onto a Google Earth terrain model.  

Buildings and walls are exported with their object height. If the elevation 
exaggeration in the Google Earth settings is defined <1.0, they seem very flat. 
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Open FILE -> EXPORT -> KML and enter a file name. All relevant objects contained in 
the Situation will be exported. Click on Yes if you want to check the data directly in 
your KML viewer. With the shortcut Ctrl + K the data are loaded as a temporary file 
into the KML viewer.  

ASCII Import 

With the ASCII interface you can import ASCII data (*.ASC, *.CSV, *.TXT,) and ASCII 
exported SoundPLAN DOS data (coordinates + properties) into SoundPLAN. As soon 
as properties are contained in the same file, the import file must be restricted to a 
single object type. 

This interface is loading the data directly into a Geo-File of your choice with the 
correct data type (e.g. road or building) and the correctly set properties. Properties 
that are valid for all objects (e.g. "emission calculated" or "entry type" for the 
import of roads) can be assigned in the standard properties which are opened 
before the data are imported.   

Call the import with FILE -> IMPORT -> ASCII-TABLE and answer the entry fields. 

 

FILE: Enter the path to your file here. 

FIXED COLUMN WIDTH / FIELD SEPARATOR: Data can be imported from files where 
they have been written either with a fixed format or separated either by semicolon, 
TAB, blank, comma or |. If you are not sure about the format, please try it out. The 
content of the file is displayed in the file preview window. For files with fixed 
column widths, define the column width for each column by moving the slider in 
the column header with the left mouse button pressed.  

TEXT IDENTIFIER: if necessary, select one of the identifiers, " or ‘. 
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IMPORT STARTING FROM LINE: determines how many lines of file header are not 
interpreted as regular data.  

FIRST LINE CONTAINS COLUMN HEADERS: defines whether the first imported row 
contains a column description. The table header is important for the correct 
assignment of the data. 

OBJECT SEPARATOR: select whether a new object is separated with an EMPTY LINE, a 
single character or a sequence of characters (LINE BEGINS WITH SUBSTRING). When 
new objects begin with a substring, please enter the string in the box next to the 
selection. 

COMMENT LINES BEGIN WITH: Defines how comment and text lines are marked so 
that they are filtered out (for example '*' for SoundPLAN DOS Import) 

With NEXT the tab index card for the ASSIGNMENT opens. 

Define to where (object type and Geo-File) and how (assignment of columns from 
the source file to the SoundPLAN objects) the data should be imported. 

OBJECT TYPE and GEO-FILE: Select the object type and the Geo-File into which the 
data are to be imported. It is also possible to create a new Geo-File. With the 
switch DEFINE STANDARD PROPERTIES you can assign default settings for all imported 
objects. The object properties dialogue is activated after you finished the entry of 
this dialogue and start the import with NEXT. 

ASSIGNMENT TABLE and OBJECT TYPE-PROPERTIES:  If all settings in the format menu 
are correct, the column headers from the imported file are presented in the 
PROPERTY FROM IMPORT FILE. In the column PROPERTY IN SOUNDPLAN you can assign 
the fields of the respective SoundPLAN object type with a double click or the small 
arrows.  

All saved property assignments can be revoked at once using the double arrow. 
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Hint: If the properties contain a unique identifier for the objects, it is wise to always 
import it to an unused field (e.g. the object number). The identifier can be used to 
later add additional properties, see ”Add properties via the search key (page 110)”. 

For the import of roads all dependent properties are automatically calculated, see 
“Import of roads (ASCII, Shape, dbf)”, page 109. 

Click on the NEXT button to first view the properties set for the first data record and 
add additional properties valid for all objects to be imported and afterwards import 
the file. 

In the case of import errors, the line in which the error occurs is displayed. Such 
errors in certain lines can occur, for example, if incorrect key characters appear in 
the file or if a column is empty when you separate columns with TAB. You can use 
the line number to quickly recognize and repair the error. Prerequisite is an editor 
that outputs the line numbers (for example Notepad++ - Download 
https://notepad-plus-plus.org/). 

ASCII Export 

Use FILE -> EXPORT -> ASCII GEOMETRY to create a txt file with the coordinates and 
the elevation above sea level or the relative height above terrain and the elevation 
of the DGM. Depending on the Geo-File or object settings all data included in the 
Situation, the data in the current Geo-File or all objects of the current object type 
are exported.  

Import of roads (ASCII, Shape, dbf) 

All dependent properties of the traffic data are automatically calculated, e.g. the 
percentage cars from the imported truck fraction.  

The traffic data can be assembled from all existing traffic data fields available in the 
import file. The program interprets the assigned fields and sets the entry type. If 
the import fails, you will find more detailed information in the logbook.  

Example: The ASCII file contains for the composition of the traffic data ADT 
(average daily traffic) as well as the hourly traffic figures and the percentages of 
trucks for the individual time slices. The assignment table then looks as follows: 

https://notepad-plus-plus.org/´
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Add properties via the search key 

You can import further properties or update already imported properties for 
existing objects via a SEARCH KEY. These properties can be stored either in an ASCII 
file or in a DBF file (properties of a shape file). 

 

If the properties are stored in an ASCII file, call IMPORT -> ASCII TABLE; for properties 
from a shape file call IMPORT -> DBF. Select the file and, for ASCII data additionally 
the format settings. 

Assign the column which contains the unique identifier (for example name, section 
or object number) in the assignment table. With a double click on this cell in the 
assignment table the SEARCH KEY is defined and displayed in red. The search key 
won’t be imported but used to identify the objects. 

Assign the properties you want to add to the existing objects as usual. 

Activate the check mark MULTIPLE ASSIGNMENT if the properties for line objects 
might change within the course of the object (e.g. different section names during 
the course of a road). If the check mark is deactivated, the additional properties are 
only imported at the first coordinate of an object. 

As soon as you start the import, the newly assigned properties are imported, all 
other properties remain unchanged.  

Example: You have imported buildings without information on the building height. 
Afterwards, you receive data with building heights. Assign the column identifying 

Select search key with 
a double click! 
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the objects and the column containing the building height. Double clicking the 
identifier defines the search key and displays it in red. Proceeding with the import 
will change the building height; all other properties remain unchanged. 

Import of point sources (ASCII) 

IMPORT -> ASCII NOISE SOURCES imports point sources in a fixed format, for example 
data coming from a sound level meter. It generates the point source and a library 
entry. The field definition is fix and without column header. 

The ASCII file must have the following format: 

source name,x,y,z1,z2,v1,v2,v3,v4,v5,v6,v7,v8 

The data must be comma separated with the decimal separator point. 

v1 .. v8 stands for 8 frequency values from 63 Hz to 8 kHz of an octave band 
spectrum. 

The weighting filter of the spectrum in the library is set to dB but you can change it 
to the needed filter (dB(A)..) by selecting the correct filter from the selection list. 
Click "no" when you are asked whether you want to recalculate the values, so that 
only the weighting filter will be changed but not the values. 

Import of SoundPLAN Geo-Files 

Geo-Files from other than the current project can be imported into the Geo-
Database with IMPORT -> SOUNDPLAN -> SINGLE GEO-FILES or IMPORT -> SOUNDPLAN -

> ALL GEO-FILES OF A SITUATION. Select the project and click on the Geo-File(s) or 
Situation you want to import. Multiple selections are carried out with the Shift and 
the Ctrl keys. The Geo-Files are inserted into the current Situation and the objects 
and their references to the library are copied into the project. Library entries such 
as spectra and time histories are automatically copied to the appropriate libraries. 
Changes made to the copied objects have no influence on the original data. 

Imported data can be placed centered in the active view by request. This way you 
can import a discount store and place it centered into the piece of property so that 
additional correction of the location is minimal. 

When importing road and railway Geo-Files and no data is present in the road type 
respective train type library, the road/railway type will be imported into the road/ 
train type library. If roads and railway lines are already present, the existing 
libraries will not be overwritten. A message will inform you that it is possible to 
have discrepancy between the road/railway type definitions. Please check your 
emission calculation in this case. 

As soon as the import finds an industrial object with a reference to the library, you 
are asked how the library elements should be treated in the new project. 
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The option you select will be applied to all data imported in that session, even if 
they are in multiple Geo-Files. 

In the first option, an existing element will be used if it points to the same object 
name. In the other option, a new element will be generated regardless of whether 
an element of the same name already exists, in which case the object name will be 
appended with “(1)”. The first option is helpful if the project already contains the 
library element copied from the system or global library. 

The connection between the object and the library entry is guaranteed in any case. 

This possibility opens the option to generate „Geo-File-libraries “ that you can fill 
with standard cases for recurring tasks  that contain all noise sources and their 
properties, as well as the libraries involved (for example, the emission, day 
histogram or transmission library).  

Example: 

You have already completed an investigation for a big discount store and the 
customer is satisfied and gives you a new job for a very similar store. The building 
follows a similar pattern; the cooling for the refrigeration unit is the same, as is the 
parking and supply of goods to the store. 

Import the „existing“ discount market into the project. If objects are already in 
existence in the new project before the ”existing” store got imported, you will be 
asked if the data to be imported should be moved to the screen viewport. With 
YES, all data is visible on the screen. Adjust the data to the new location. When 
working with relative heights, the elevations automatically adjust to the new 
terrain. 

 Import of photos with GPS data as photo points 

If the metadata of photos contain GPS data (coordinates and view direction), 
SoundPLAN can import them. The geometrical coordinates are converted into the 
coordinate and reference system used in the project. This means that you need to 
have the project coordinate system established if you want to make use of this 
feature.  
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Open FILE -> IMPORT -> PHOTOS WITH GPS DATA. If no project coordinate system has 
been established, click on OK to open the coordinate system dialog. Select a photo 
(file) and define the Geo-File where you want to store the photo. By default, the 
photos are expected in the project sub folder \photo. If the photos are not already 
present in this location, select if you want to COPY or MOVE the photo to this 
location. The program always will import all photos contained in this folder. 

CARD/1, Stratis, Verbund, Vestra Interface 

Select FILE -> IMPORT -> CARD/STRATIS (German road planning software.) 

As the exporting programs have a dedicated SoundPLAN export interface, the data 
are already assembled to import an entire project in the correct format for 
SoundPLAN. The object types are assigned automatically but you still must define 
some of the object properties in the edit object properties menu. 

LIMA BNA Interface 

The LIMA BNA interface automatically imports the data and the object properties. 
Select the Geo-File to which you want the data to be imported and the correct 
object type. Then call the import menu with FILE -> IMPORT -> LIMA BNA. The 
properties are imported, however, with some objects like roads the emission level 
is imported but not the parameters that are used in the computation of the 
emission level. Only the German standards are supported for the import of the 
sources. The interface LIMA BNA is no longer developed as it will be replaced by 
the QSI interface in the future. 

Import of SoundPLAN DOS data 

 Old data generated from the SoundPLAN DOS version 4.0 and newer can be 
imported directly into the Geo-Database. Select FILE -> IMPORT -> SOUNDPLAN DOS. 

First select the path to your DOS data in the right field of the entry screen and then 
select the data type you want to import from the pick list. The available files are in 
the right field. When you select a file, the first comment lines of the DOS files are 
printed in the info box. Select the files you want to import by left clicking, multiple 



 SoundPLAN Manual 8.1 
 Geo-Database 

Page • 114/793 Filter and Import Elevation Data 

3 

successive files are selected with Shift+ left click and multiple single files with Ctrl+ 
left click. Press OK to import the data. 

The following object types are converted from the DOS format to the Windows 
version, some of the object properties have changed and many properties are new, 
others do not have an equivalent under Windows: 

Road alignments - The emission level is calculated, and the width of the traffic 
lanes is assigned to the new object. 

Railway lines - Only the geometry is imported, the emission level needs to be 
recomputed. 

Industrial noise sources - Only the geometry is imported, all other object 
properties need to be redefined. 

Buildings - are imported with the geometry and properties; however, the area 
usage needs to be defined. 

Receivers - are imported with geometry and property but without the assignment 
of the area usage. When receivers are located at buildings, the assignment of the 
receiver to a specific building must be redone. 

Elevation lines, spot heights, calculation area - are imported completely, no 
properties needed. 

Mitigation areas - are imported with geometry and properties 

Noise screens - are interpreted as noise protection walls and the properties are 
assigned.  

Ground effect - is imported with geometry and properties. 

Filter and Import Elevation Data 
Elevation data from laser scanning are nowadays provided mostly in a digital way 
as equidistant grids (e.g. 1x1 m or 10 x 10 m) or as point clouds. Apart from the 
terrain model itself the data partly contain also roof points of buildings to 
determine the height of buildings, and sometimes spot heights on bridges.  

SoundPLAN can read different formats and filter them efficiently to reduce the size 
of the DGM. The size of the DGM has big influence on the work in the Geo-
Database and especially on the calculation time. 

Elevation data in the formats ASCII, ESRI ASCII Grid, GeoTiff, LAS (specification see 
“Import of elevation points in the LAS Format (page 120)”) or Winput SCOP can be 
filtered before they are actually imported.  

In case the spot elevations are present in a different format (for example DXF), you 
can import the data unfiltered and filter them afterwards in the Geo-Database via 
GEOTOOLS -> MORE ELEVATION TOOLS -> FILTER ELEVATION DATA. 

There are two different interfaces for filtering the elevations before the import (the 
following description is valid for both interfaces): 
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1. FILTER AND IMPORT ELEVATION DATA for projects for which you want to import 
elevation spot heights into the Geo-Database and further process the data there 
(generate a DGM, calculate embankments, define men height for a building from 
elevation points,  …).  

2. PREPROCESSING ELEVATION DATA [Module Noise Mapping Toolbox] for projects 
with huge amounts of data that are too big to be processed in the Geo-Database, 
for example elevation points for complete cities or districts. For these data 
normally a tile DGM is calculated in the calculation kernel, see “Preprocess 
elevation data for the Calculation Kernel (page 654)” in the chapter Noise Mapping 
Toolbox. 

Hint: If, during the filter process, you find out that the direct import is not suitable 
for the amount of data, you can toggle to the import interface for preprocessing the 
data for the calculation kernel, because the data are processed the same way. 

The import data can be in a single file or can be tiled, thus distributed over many 
individual files.  

Invoke FILE -> IMPORT -> FILTER AND IMPORT ELEVATION DATA for conventional 
projects.  

Use the OPEN symbol to select the folder where the elevation data are stored.  

 

By selecting one file with a double click, all files with the same extension will be 
sent to the elevation filter.  
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On the left-hand side, the files are displayed as well as a preview of the first file. If 
needed, select the first row for the import and the column numbers (position) for 
the coordinates X and Y and the elevation Z. 

You can select one or several areas and / or lines with a corridor width that are 
used to filter and import the data according to your settings (see "Use areas and 
line corridors (page 118)"). 

Before further tasks can be invoked the elevation tool needs to know the data 
structure. Therefore, as a first step only the option GET FILE INFORMATION is 
available in the selection list. 

In this step the elevation data are additionally stored binary (file extension *.elg for 
grid data and *.elv for point clouds). The binary stored data are much faster 
accessible for the next steps.  

It is necessary for you to have write permission on the folder where the data are 
stored, because SoundPLAN stores file information and interim results in this 
folder. Therefore, you enter a target folder for the scanned files in the SCAN 

OPTIONS, for example if the elevation data have been delivered on a CD. If you 
don’t change the target folder, you can select whether you want the original ASCII 
files to be deleted, moved to the subfolder “OriginalData” or that the data should 
remain in the same folder as the binary files. 

To scan the file information, select the files with Ctrl+ A (if desired single files with 
shift or the Ctrl key) and click on EXECUTE.  SoundPLAN loads the files, extracts the 
structure and stores them binary. 

Depending on the number and size of the files, this may take some time. This 
procedure only needs to be done once; SoundPLAN remembers the structure and 
additional information.  

As soon as the FILE INFORMATION is filled in, the option in the selection list changes 
to “filter elevations” and the filter options are displayed. 

Filter elevations 

For spot elevations positioned on a regular grid, the GRID DISTANCE is displayed. For 
unstructured spot elevations a grid with a spacing of four times the average 
distance between coordinates is assumed but this value can be modified at will. 
The finer the base grid, the smaller the number of iterations needed to force a 
structure where all elevation deviations of the remaining coordinates are below the 
set tolerance, yet for finer grids the number of coordinates remaining will be 
higher, thus the results are not as efficient as with a courser base grid. 

Enter MAXIMUM HEIGHT DIFFERENCE TO ORIGINAL POINTS that shall not be exceeded.  

MAXIMUM POINT DISTANCE: It turned out that the maximal spacing between the 
coordinates shall not be too big and that if the spacing was moderate, the number 
of iterations was smaller. The filtering generated more equal sided triangles that 
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were better suited for all processing later on. If you do not like the results of the 
filtering, try again with reduced maximum point distance. If a tile DGM should be 
calculated afterwards (see “Preprocess elevation data for the Calculation Kernel 
(page 654)”) the maximum point distance may not exceed 80 m.  

After filtering the elevation points according to your settings, a DGM is calculated 
from the remaining spot elevations and compared with the original elevations. If 
elevation points are outside the tolerance, SoundPLAN will insert coordinates to 
force the DGM to conform to the original data. This procedure is repeated 
iteratively until all differences are within the tolerance. 

In the logbook you can also view each iteration step.  

If the elevation data are splitted into several files, test the filter options for a 
selected file, see “Filter single elevation file (page 117)”. Then select all files with 
Ctrl+ A and click EXECUTE. Because it can be very time consuming if many files are 
processed, we recommend using a lunch break or night time for filtering the data.  

The filtered data are stored in tiles of 10 x 10 km in the subfolder “ResElev”. After 
all files have been filtered, the option in the selection list changes to IMPORT 

ELEVATIONS. Click OK to import the filtered elevations to the Geo-Database. 

Filter single elevation file 

In order for you to get a feeling for the settings and the resulting DGM, the 
statistics and preview tab of the filter box shows the result of the elevation 
filtering for one selected file with elevation data. (The tab disappears as soon as 
more than one file is selected.) 

 

You can view: 

• the original data 

• the remaining elevation points in the site map (result) 

• the DGM as a 3D-model 
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• the difference grid map with the statistics 

The difference to the original elevation points is an important criterion to prove the 
quality of the result.  

 

In the example above the elevation points have been filtered with a maximum 
deviation of ± 0.25 m. The difference map proves that 80 % of the remaining points 
are within a range of ± 0.13 m and that the maximum deviation is kept.  

If you are not satisfied with the results, activate the first tab, change the filter 
parameters and start the filter action again.  

Use areas and line corridors 

Reduce the area for the elevation data 

Often you get data with a much bigger scope than you need. You can select an area 
to only process the data within this area. Enter a general area in the Geo-Database 
that generously covers the area for which you need elevation supplied and save the 
area in a Geo-File of its own. Select the Geo-File in USE AREAS AND / OR LINE 

CORRIDORS and filter the data as described above. 

If the area has already been selected when scanning the file information, elevation 
data that are outside the area are disregarded for further processing. 

Unfiltered elevations within the circumference of buildings 

If the elevation of the roofs of buildings is provided, the average height of the 
building can be calculated most accurately with the Geotool EVALUATE POINTS FOR 

BUILDING HEIGHT when you import the elevations within the circumference of 
buildings without filtering. For this option enter a Geo-File or a Situation with the 
buildings under USE AREAS AND / OR LINE CORRIDORS and select the task IMPORT 

ELEVATION POINTS.  
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As no elevation differences need to be filtered, the import is very fast.  

Important: If the elevations of the roofs of buildings have been delivered in the 
same folder as the terrain elevations - only with a different file extension, you 
must select a different folder for the edge data in the step “get file information” 
because otherwise the binary stored files of the terrain and the edge elevation 
points (*.elv) would overwrite each other. 

Unfiltered elevations within bands of roads and railways 

When the terrain information within bands of roads and railways is very accurate, it 
can be sensible to use unfiltered elevation information to set the elevation of the 
road and the railway axis. For this purpose, the unfiltered elevation information can 
be imported only in the band around the road and railway master alignment. In 
order for the import to get the geographical location of roads and railways, enter 
the Geo-File or Situation with the roads or railways under USE AREAS AND / OR LINE 

CORRIDORS and select the corridor width I [m]. 

 

As no elevation differences need to be filtered, the import is very fast.  

Generate a DGM from the unfiltered imported coordinates and place the road and 
railway alignment with the COORDINATE OPERATIONS on top of this DGM. For 
railways the elevation of the rail head must be adapted according to the used 
standard. 

If additional files with the elevations on the bridge are available, the DGM is 
generated from the elevations in road / railway bands and the elevations on 
bridges.  

Extract areas from an overall pool of elevation data 

You have for example received elevation data for a whole city, filtered the data and 
used it perhaps for an action plan. Now you are asked to do detail investigations for 
single hotspots. Enter the area(s) that generously cover the smaller investigation 
area(s) and select them under USE AREAS AND / OR LINE CORRIDORS. In the project 
with the overall elevation data select the filtered elevation points from the sub 
folder “ResElev” and select the task IMPORT ELEVATION DATA. Alternatively, you can 
cut individual areas from a total DGM, see “Extract DGM via an area (page 341)”. 



 SoundPLAN Manual 8.1 
 Geo-Database 

Page • 120/793 Filter and Import Elevation Data 

3 

Delete identical elevation points 

If filtered elevation points imported from an external source contain double 
elevation points, select the elevation points and invoke GEOTOOLS -> MORE 

ELEVATION TOOLS -> FILTER ELEVATION DATA. Here you can select DELETE IDENTICAL 

POINTS from the selection list. If double points have different elevations, the point 
with the higher elevation is deleted.  

Transform coordinates 

The task transform coordinates transforms the elevations from the source 
coordinate system to the project coordinate system, see “Transformation between 
coordinate systems (page 175)”. 

Import of elevation points in the LAS Format 

SoundPLAN has implemented the LAS specification version 1.4-R13 from July 15, 
2013. The LAS Format is a standard by the American society of photogrammetry 
and remote sensing and was designed to share coordinates from laser scanning.  

The point cloud can be considered raw data, the coordinates can be located on the 
terrain, on buildings or on vegetation (trees), and therefore it is paramount to have 
a classification of the data. This classification is normally part of the data file. As the 
classification can vary in accordance to the LAS version, SoundPLAN is only 
distinguishing between two classes, terrain points and surface points.  

The “Terrain model” contains the LAS classes “terrain” and “water”, from point 
format 6 on also the classes for “railway“ and „road surface“, if data are contained 
in the data file.  

The “surface model” contains all other LAS classes. From the point format 6 on the 
classes for “railway” and “road surface” are included in order to import the 
coordinates within the railway or road surface without filtering them.  

If you select the option to filter the elevation (IMPORT -> FILTER ELEVATIONS AND 

IMPORT) for LAS files, additionally select weather you want to import the terrain 
model or the surface model. If you have already imported and filtered the terrain 
model, the scanned data will be deleted before importing the surface model. 

After reading the LAS file header, the logbook shows the LAS classes contained in 
the file. The detail information shows the class ID, the meaning of the points and 
the number of points imported for each LAS class.  

Even if the LAS import offers the distinction between the terrain model and surface 
model data, the option „filter elevations“ after scanning the surface model, for the 
surface model this option is not sensible, please select a different option. 
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Example for the efficiency of the elevation filter 

Below, the example shows the same 3D view and cross-section, on the left-hand 
side as the original and on the right side as the filtered data with an elevation 
tolerance of 50 cm: 

  

The number of coordinates in the original for the grid of 300 x 150 meters with a 
resolution of 1x1 meters was 40326 points. The filtered elevations consist of 2027 
points, almost 95% of the points were filtered out and still the railway line berm is 
sufficient. 

If you want to test the filtering of elevations, you can use the laser scan data in the 
demo project “Wincity” (subfolder import data). 

See also "Evaluate spot heights for mean building heights (page 169)" and 
"Calculate the object height from the top edge (page 170)". 

Digital Ground Models (DGM) 
After importing and filtering or digitizing terrain information (elevation points and / 
or elevation lines), calculate a Digital Ground Model. The DGM edges form the 
diffraction edges for the propagation calculation. 

The elevations of other objects are assigned from the DGM. The elevations are 
either entered as absolute height above sea level or relative to a DGM, see “Set 
objects to DGM”, page 153. 

You can further refine the DGM during project processing, or you can calculate 
different DGMs for different planning variants. 

Often you will first calculate an initial DGM from imported (and filtered) elevation 
points, then place the roads or railways on the DGM, set or detect bridges and 
tunnels if necessary, identify jumps in elevations in the front and side view and 
smooth them. The road and railway edges, bridges, tunnel portals, parking lots, 
area sources and berms will be included in the DGM calculation for the DGM, which 
will later be used for the propagation calculation. 

To calculate embankments, use the calculation run “Calculate objects into the 
DGM”, see chapter Calculation Core. Call this run from within the Geo-Database 
with FUNDAMENTALS -> DGM -> CALCULATE OBJECTS INTO DGM (Alt+Ctrl+D). 
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Calculate DGM from within the Geo-Database 

Open the DGM calculation via the menu FUNDAMENTALS -> DGM -> CALCULATE DGM 

(Ctrl+ D).  

 

Enter a result file number, opt to overwrite an existing DGM, or search for a free 
result number.  

In the lower part, select which object types shall influence the DGM calculation. 
The objects must be part of the Situation for the DGM calculation. 

If the plan contains tunnels, it is wise to generate a new DGM after the tunnel 
portals are defined so the DGM can correctly model the area around the tunnel. 

In the background the calculation kernel is opened during the DGM calculation in 
the Geo-Database and calculates the DGM. The DGM is stored there as a 
calculation run. This has the advantage, that all information regarding the DGM 
(used Geo-Files and object types, version date, possible warnings, …) are 
permanently recorded.  

A DGM calculated in the Geo-Database can be recalculated any time in the 
calculation kernel if needed. DGMs for large areas and tile DGMs are preferably 
calculated in the calculation kernel so that the Geo-Database is not blocked.  
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DGM views 

As default the edge line of the DGM is displayed, to visualize the area which is 
provided with elevations. The elevation of the current cursor position is presented 
in the status line of the Geo-Database screen. The (+) and (-) sign indicates if the 
elevations in the path or the cursor movement is increasing or decreasing. When 
you activate the DGM TRIANGLES, all triangles are presented in light gray on screen.  

 

To help find problems in the DGM and to set the beginnings/ends of bridges 
correctly, you can display elevation lines derived from the DGM with VIEW -> DGM 

CONTOUR LINES.   

  

Enter the elevation spacing in [m]. The closer the elevation lines the longer it will 
take to display the elevation lines on screen. If the screen refresh times are 
excessive, close the DGM elevation line option and re-open it with a different 
spacing.  

If you really need the elevation lines in the Geo-Database as an object of its own, 
you can generate them by loading the DGM into the graphics and then exporting 
the elevation lines in „edit map“ into a Geo-File via EDIT -> EXPORT CONTOUR LINES.  
The distance between the elevation lines is determined in the “additional intervals” 
in the object type DGM.  

You can select a default DGM in the Situation Manger (TOOLS -> SELECT DEFAULT 

DGM which is automatically loaded with all new Situations in this project.  

Use the Del key to remove the DGM from a Situation.   

You can place both the DGM and a bitmap into the background of the Geo-
Database screen. 
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Embankment alignment for road and railway in the DGM 

Spot heights that lay on the road surface or on the ballast bed of railways (see 
below) are excluded from the DGMs triangulation if the appropriate box is checked 
during the DGM calculation. 

  

If roads or railway tracks are part of a DGM calculation, the program will check if at 
intersections the road/rail edge of one road/rail will fall within the surface area of 
another road/rail. If there are coordinates found laying in another road/rail area, 
they will be discarded during the triangulation.  

 

For the embankment alignment of railways two additional parameters are needed 
for regular trains to set the elevation at the foot of the ballast bed that are entered 
in the railway properties: 

 

• Delta h between the rail head and the terrain (basically the thickness of the 
ballast bed) 

• The distance of the DGM edge to the track axis (half the width of the ballast 
bed 

For road and railway bridges elevation points are triangulated on the surface below 
the bridge. If tunnel portals are included in the calculation, they should be present 
for the triangulation.  
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If the situation in the Geo-Database has a DGM that was re-calculated in the 
calculation core, you will be asked after the calculation finished if you want to re-
load the DGM.  

 Connection to online map services 
[Cartography] (Connection to Google Maps + OSM) [GIS interface] (OSM-Import) 

OpenStreetMap and Google Maps are free on-line map services that can be used in 
SoundPLAN.  After loading them, the online maps are presented in a window of 
their own so that you can work parallel either in the Geo-Database or with the map 
server. The current map view can also be downloaded as a bitmap. It is also an 
option to import data from OpenStreetMap maps (see below). Additioanlly a very 
course elevation grid for relatively even terrain can also be imported. 

If no geometry data are present in the situation, you may position the map view via 
an address search. To use the address search or to import elevation data will 
require you to generate a free user account at Google or respectively MapQuest 
(for OSM), to generate API keys and to define the settings for the API keys  

SoundPLAN only supplies the tools, it is the user’s responsibility to work in 
accordance to the license conditions of the Map Servers.  

Google Maps  

Google Maps is the online map service developed by Google. In SoundPLAN a 
component is integrated that either shows satelite immages or mapped data with 
text labels or as a background bitmap.  The user can also choose to activate the 
tilted presentation or the street view mode.  

To work with Google Maps at the first call, you must accept the Google 
usage/license conditions. 

OpenStreetMap 

„OpenStreetMap is an initiative to create and provide free geographic data, such as 
street maps, to anyone. The OpenStreetMap Foundation is an international not-for-
profit organization supporting, but not controlling, the OpenStreetMap Project. It is 
dedicated to encouraging the growth, development and distribution of free 
geospatial data and to providing geospatial data for anyone to use and share.“ 
Quoted from: https://wiki.osmfoundation.org/wiki/Main_Page.  

https://wiki.osmfoundation.org/wiki/Main_Page
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Hint: As OpenStreetMap (OSM) is an "Open Source" project where various map 
makers merge geometry and additional data, the quality of the data can vary. 
Please be aware that SoundPLAN only delivers the tools to use the data, 
SoundPLAN is not responsible for the correctness of the data. The export page of 
the OSM website contains a link to the EULA of the Open Street Map data. 

There are several „keys“ which the founders of the OSM project have defined, 
these should be used by the map makers for the classification of data.  

The key „highway“ for example is for any road or path. This key is further detailed 
by the „value“, which further specifies the type of road with the distinction of 
freeway, motorway, main roads or a simple foot path. SoundPLAN only imports 
roads that are roads for car travel. Additional information about the „keys“ and 
„values“ you can find on the website  

http://wiki.openstreetmap.org/wiki/Map_Features. 

Method  

To use either OSM or Google Maps, a project coordinate system needs to be 
defined. It is highly recommended to work with two computer monitors.  

Open FUNDAMENTALS -> CONNECTION TO OSM & GOOGLE MAPS (Shift+Ctrl+O) or right 
mouse button -> INITIALIZE ONLINE MAP SERVICES AT CURRENT VIEWPORT. 

 

The online map services open up with the same viewport as what you have open in 
the Geo-Database edit screen. If no data are in the project yet, the map services 
are just initialized to location SoundPLAN. From there move to the location of your 
project or use the ADDRESS LOOKUP (API key necessary, see below) to move to the 
appropriate location. 

On the left side select the BACKGROUND MAP. Select from the three views: Google 
Map 2D, Google Map 3D and the OpenStreetMap map. 

http://wiki.openstreetmap.org/wiki/Map_Features
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When you check the box ALLOW MAP TILT AND STREET VIEW in the satellite view of 
Google Maps, Google Maps will show the tilted view if the distance between the 
viewer and the ground is less than 50 meters. With the orange figure activate 
Street View or switch to 360° panorama photos. Both options of course require 
that Google has data for these services available four your current location.   

 

With this service it is very easy to count the number of floors in a building and to 
assess what the building is used for (residential, non-residential).  

“SHOW POINTS OF INTEREST” (POI) references to points of interest in the Google 2D 
map. In the satellite view use the checkbox LABELS to get descriptive labels for the 
objects you see. 

With the button GET IMAGE, the viewport visible in the map will be loaded and 
displayed as a background picture in the Geo-Database. If the tilt view mode of 
Google Maps is active this function is not active. 

The advantage of Google Maps in comparison to Google Earth: 

In contrast to Google Earth, the API interface of Google Maps is continuously 
upgraded. As no terrain is active in the Google Maps display, some of the potential 
differences between the map in Google Earth and the reality is avoided. (Google 
Earth is probably using different data for their triangulation than SoundPLAN and 
these differences will cause inaccuracies in the projection). You do not need to 
install additional software on your PC and the web-based navigator of Google Maps 
is also faster than the one from Google Earth. 

Import OSM-data 

[GIS interface] Select the desired map viewport. Click on DOWNLOAD AND IMPORT 

OSM DATA and select the files to be imported.   
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Select which object type you want to import. Some objects may be helpful only for 
orientation but are not detailed enough for a SoundPLAN model. Data of different 
object types are imported each into their specific Geo-File with the prefix “OSM_”. 
This procedure should make it easier to later on deleted data of object types not 
desired in the model. After finishing these definitions click on IMPORT. 

The data from OSM can contain additional information. Often you find the street 
name and house numbers associated with buildings and names of other objects.  

These definitions are always imported. If available, other additional information 
e.g. the building usage, zip code or city are imported into the additional text 
properties of the buildings. 

If object elevations for buildings and walls are contained in the data, they are 
imported, and the values are assigned as a property to the SoundPLAN objects. If 
no data are in the import file, the default data remain. Our tests have shown that 
object elevations/heights are seldom contained on OSM.  

For example, you can use OSM data to extract address data into OSM Geotexts and 
assign these later to more accurate cadaster data. 

Hint: If you want to import an osm file manually, for example because it had been 
modified in an OSM Viewer, call the import via FILE -> IMPORT -> OSM IMPORT XML. 

API keys for address lookup and elevation import 

To use the functions, for which API keys are necessary you need to open an 
account at Google or MapQuest (OSM elevations).  

 

Click on the symbol SETUP API KEYS. Select open Google in browser or open 
MapQuest in browser. You will access the respective website. If you don’t yet 

have an account, you must open one with „SignUp“. Follow the steps of the 
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wizzard. As soon as you have successfully opened the account, you must generate 
the keys.  

Generate API keys for Google: 

Open a project and go to „Library“. Enter “Places” in the search bar, select „Google 
Places Web Service“ and activate it. The Google Places API is only needed to give 
you address suggestions for the address lookup.  

Then enter „Elevation“ in the search bar, select „Google Maps Elevation API“ aus 
and activate it. Then search for „Geocoding“, select „Google Maps Geocoding API“ 
and activate it. The next step is to go to “access data” and copy the API keys in the 
dialog in SoundPLAN. 

Generate API keys for MapQuest: 

Log in to the website and go to „Manage Keys“. Click on „Create a New Key“. On 
the next page enter an „App Name“ (e.g. elevations OSM) and click „Create APP“.   
Open the details of the newly generated App by clicking on the name and copy the 
„Consumer Key“ in the dialog in SoundPLAN.  

After you closed the setup dialog with the green tick the functions are ready to use. 

Elevations from Google Maps or OSM 

Google Maps elevations (the same as elevations from Google Earth) are based on 
free SRTM elevation data. These elevations have a resolution of approx. 90 m, 
which means, that the measured points have a distance of 90 meters. In-between a 
spline interpolation is done.  Changing topography cannot be represented with 
these elevations.  

The elevations of MapQuest are based on elevations, OSM is using for the display 
of the terrain. The resolution is similar to the resolution of Google Earth / Maps and 
therefore also unsuitable for changing topography. For smaller areas with relatively 
flat terrain, for example for smaller industry noise projects, these data are certainly 
possible. Please check whether the data are suitable for your project.  

This is a 3D comparison between laser scan data and the elevations from Google 
Maps and OSM for changing terrain: 

 

Click on the button import elevation data to import the elevations within the 
viewport. The data is imported and automatically filtered, so that the actually 
relevant elevation points are meshed for the DGM. 



 SoundPLAN Manual 8.1 
 Geo-Database 

Page • 130/793 Connection to Google Earth 

3 

 Connection to Google Earth 
[Module Cartography] With the connection to Google Earth you can  

• coordinate the camera position of Google Earth with your data 

• use a background bitmap from Google Earth 

• reference a project on the basis of a Google Earth viewport 

• get elevations 

It is advisable to have two screens at your disposal. 

Google Earth will discontinue operation of versions 5 and 6 as of 31 October 2018. 
They will no longer function from that date. With the current Google Earth versions 
7 (free and pro) a smooth operation with SoundPLAN cannot always be guaranteed 
and we will therefore not support this interface further in the future. Please only 
use the Google Maps interface available since SoundPLAN 8.0 in the future. 

A good agreement between already entered model data and Google Earth can only 
be attained when the setting "show terrain" is disabled in Google Earth (in tools > 
options).  

When using Google Earth, please observe their usage and licensing conditions. 
SoundPLAN supplies the tools but is not responsible for the licensing conditions. 
This is entirely the responsibility of the Google Earth user. As Google Earth 
licensing may vary between countries, SoundPLAN can’t even assist. 

 

Define the project coordinate system (page 41). Activate Google Earth in the Geo-
Database via FUNDAMENTALS -> CONNECT TO GOOGLE EARTH.  
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Afterwards, you can use the right mouse button function -> MOVE GOOGLE EARTH 

CAMERA TO CURRENT CURSOR POSITION to view the project area in Google Earth 
without first navigating to the correct place.  

The right mouse button click -> GOOGLE EARTH BITMAP FOR CURRENT CURSOR 

POSITION generates a geo referenced bitmap for the view you have on screen. The 
bitmap is available in the bitmap selection under the name "GoogleEarth.bmp". 
When you select a different view and again request a bitmap, the GoogleEarth.bmp 
will replace the old view. 

If you want to work in a project from scratch with a Google Earth bitmap, activate 
Google Earth, determine a project coordinate system and call FUNDAMENTALS -> 

CURRENT GOOGLE EARTH VIEW AS BITMAP. 

Elevations from Google Earth 

Google Earth elevations can be imported from Google Earth via FUNDAMENTALS -> 

DGM -> GET TERRAIN POINTS FROM GOOGLE EARTH. As the origin of the elevations 
cannot be verified and are not very accurate, it is only sensible to use these 
elevations for relatively small projects in areas that are not critical for the 
propagation of noise. Sharp terrain edges are not getting across from the Google 
Earth elevations. Activate the field “show terrain” in Google Earth (in tools > 
options). Navigate in Google Earth to the area of interest; SoundPLAN imports the 
elevations within the screen section (the smaller the section the smaller the 
distance between the elevation points). 

 Connection to Web Map Service (WMS) Servers 
[Module Cartography] With the WMS (Web Map Service) you can load maps to 
form the background of SoundPLAN graphical output. As an example, it is possible 
to load cadaster data or aerial photos that are supplied by the authorities or made 
available by independent services such as OpenStreetMap (OSM). 

Contrary to online map services or Google Earth you do not get fixed sized bitmaps 
but the server will custom generate the bitmaps according to the selected window 
and resolution. Depending on the internet download speed and on the bandwidth 
of the server, sometimes it can be a bit time consuming to load the maps. In order 
to allow you to work without being tethered to the internet, SoundPLAN can save 
the bitmap for the next editing session. 
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Different scopes and resolutions depending on the scope of what you need to do 

At the moment the intellectual property rights for the data are handled in very 
different ways depending on the WMS server. Some suppliers make the data 
available for you to use for free, others require the user to be registered and then 
can use them for free and others are using the WMS as a commercial business 
where you have to order the data and pay for them.  

What is available in your area you must research on the web or ask the local 
mapping agencies for their suggestion?  

We deliver SoundPLAN with the connection to the WMS Server Terrestris, here you 
can get worldwide OpenStreetMap-data.  

Hint: The WMS servers are not completely standardized and fixed, some servers 
that were free of charge in the past as an introduction offer may become pay for 
play or entirely vanish. For this reason, an occasional web search may advisable. 

Configure the connection to a WMS server 

WMS server settings are available under SoundPLAN Manager via OPTIONS -> 

SETTINGS, node WMS settings for all new projects (global settings) or in the Geo-
Database via FUNDAMENTALS -> SETUP WMS SERVER for the current project.  
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In the top list you find the WMS servers you have already had contact with. The 
checkmark indicates that the server is included in the selection list for 
bitmap/WMS server in the Geo-Database.  

Klick on the symbol PLUS, to configure the connection to a new WMS server. 

 

Enter a unique name for the connection and the web-address of the server (best 
found on the website of the WMS server and entered via cut and paste).  

WMS servers can deliver the maps based on a multitude of coordinate and 
reference systems which are defined in EPSG-codes (page 46).  
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Click on CONNECT. SoundPLAN connects to the WMS server, evaluates the best 
matching EPSG code and enters the found coordinate system. In case SoundPLAN 
did not find the right coordinate system, for example at the boundary of zones and 
stripes, use the pick list to select the correct EPSG code and tell the program that 
you did not take the suggested coordinate system but rather use the one you 
picked from the list. Via the checkmark DO NOT AUTOMATICALLY CHOOSE NEW 

COORDINATE SYSTEM, you can prevent SoundPLAN from overriding your choice of a 
coordinate system.  

If the server does not require a password, confirm that you accept the license 
conditions and click on OK.  

If the server requires an authentication, select the right option for the WMS server 
you selected. Some servers contain a link to the WMS server that contains an 
access code that is sent every time a request is transmitted to the WMS server. 
(This access code can be free of charge or require a fee payment) SoundPLAN 
recognizes that an access code is used and automatically takes it from the link. 

 

The WMS server just configured is automatically connected.  

WMS server can have any number of layers that contain various type of 
information. It is possible that layers overly others or supplements them. When you 
activate multiple layers, you can generate a custom hybrid basis of information for 
your maps.  

With the layer list, activate one or multiple layers; with Drag & Drop you can 
change the sequence of the layers. The topmost active layer is drawn first; this 
means that it is most often hidden by other data in layers below. It is advisable to 
have layers with transparent areas near the bottom of the list; fully covering ortho 
photos should be at the top. This assures that as much data as possible will be 
visible.  

You can also switch on and off the layers later with the right mouse button ->  
(DE-)ACTIVATE WMS LAYER.  

After ending the configuration session for the WMS server, SoundPLAN is 
automatically connected to the server. 
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Working with WMS servers 

In order to work with WMS servers, the Situation must already be present with 
geometry data. If the Situation does not contain any data yet, you can import them 
from OpenStreetMap (see “Connection to online map services”), after this you can 
call the WMS server. 

All defined and for the display activated WMS servers are listed in the selection list 
„Bitmap“. 

Select a server from the selection list. The WMS server establishes the web 
connection - which, depending on the connection, may take time. The status line of 
the Geo-Database will indicate „SoundPLAN is loading WMS background bitmap“.  

With the mouse wheel pressed move the viewport of the WMS Servers; rotating 
the mouse wheel zooms the viewport. When you let go of the mouse wheel, the 
background picture is updated – which may take some time.   

Right click to -> SAVE CURRENT VIEW OF THE WMS SERVER AS A BITMAP, to save the 
bitmap in your project under a file name of your choice.  

WMS server in the Graphics  

WMS servers are regarded by the Graphics as its own data type. Select the data 
type for the WMS and the server from which you want to incorporate the 
background pictures. The background pictures are loaded dynamically, when you 
change your SoundPLAN geometry viewport by zooming or rotating, the Graphics 
will re-load the background bitmap from the WMS to suite the new viewport. 
Downloading the data from the WMS server may take time depending on your 
internet speed and the capabilities of the WMS server.  

The WMS bitmap is controlled from the object setup via the object type GEOMETRY 

BITMAP. In the 3D Graphics the WMS bitmap can be used as normal if a DGM or a 
Grid Noise is loaded providing the needed elevation information for the projection 
of the bitmap to the ground. Additionally, the presentation must be requested in 
the object setup under the 3D tab.    

 

Picture left: Colored facades on a cadastral map, the SoundPLAN buildings are 
deactivated. Picture right: 3D buildings on an aerial photo. 
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Editing the data 
After initially entering or importing the data the objects need to be further defined 
and corrected. SoundPLAN offers many different editing tools. The editing tools are 
located in the menus EDIT and GEOTOOLS. Some of the functions have a redundant 
access through the right mouse button. The objects need to be selected before the 
editing can take place. 

The edit mode 

In the edit mode, existing coordinates or their properties are opened for 
editing by moving the cursor to the coordinate dot. When the cursor is within 

the search radius of the coordinate, it changes from the crosshair cursor into an 
arrow cursor. 

For editing your data, it is a good advice to activate the object dots (page 87). 

The arrow cursor is important for editing the data. When the cursor comes 
close to a coordinate, the shape of the cursor changes from the edit cross to 

the selection arrow. 

Define the distance to the coordinate in which the cursor changes to the selection 
arrow in OPTIONS -> SEARCH RADIUS=X. The default setting of the search radius is 5 
pixels. 

Often more than one object is found within the search radius. In this case a list is 
presented with all objects found to select the appropriate object.  

 

If you click on the objects in the selection list, the different objects are highlighted 
to make it easier to find the desired object. Selected objects are displayed in bold in 
the list, coordinates with assigned properties in italics. 

Tipp: Selected objects always appear first in the list. This feature can be used to 
faster find an object from which to capture coordinates.  

The object selection list shows object type, object name and object ID. During the 
entry or the import in the Geo-Database the object ID is generated automatically in 
ascending order. If you copy objects, the objects will lie on top of each other. The 
higher object ID identifies the copied object. 

As soon as the selection arrow appears, the status line will present the coordinates 
and elevations of the nearest coordinate. 
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By left clicking you open the property dialog of the object, by right clicking you 
open a popup menu with further options to edit the data. 

Zoom 

To enlarge or shrink the data range, use the mouse wheel, the "page up" / 
"page down" keys or invoke the zoom mode with the magnifying glass. Then 

you can either pull a “rubber band” around the area you want to enlarge or by left 
mouse click (enlarge) or right mouse click (shrink).  

When opening the Geo-Database, the size in the field ZOOM is set to 100%. In 
the field INC you can select the factor by which you want to scale the view 

port up and down. The default setting is 50 meaning that the view is zoomed in/out 
by 50%. By clicking on the button TOTAL VIEW the zoom is reset. The symbol button 
TOTAL VIEW is also used to update the coordinate range to the coordinates included 
in the Situation (e.g. after a coordinate transformation). 

When the scroll-wheel is pressed, the cursor changes to a hand symbol and 
you can move the data on the screen. In the “hand mode” (hand button on 

the tool bar) the data are moved using the left mouse button.  

Object zoom 

When you want to zoom a specific object to the maximal size, the object 
zoom is the suitable tool. Select the magnifying glass cursor and hold the ALT 

key pressed. The magnifying glass cursor has an additional mark with the letters 
OBJ as soon as the cursor is within the reach of an object. Clicking the left mouse 
button will enlarge the object to maximal size with the scale factor set to 100% so 
that you can zoom in further. If multiple objects are found in the search radius a 
selection list is displayed from which you can pick the correct object. 

Store geometry viewports 

The data included in a Situation are fit in the graphical user interface so that all 
objects are visible.  

For larger projects it might be sensible to store special areas as geometry view port, 
which you can afterwards select directly. 

 When you want to store a view as a repeatable view port, zoom and 
move to the desired settings and store the view port with SAVE CURRENT 

VIEW PORT and enter a name for the view. 

 

When you want to recall a view port to screen, select VIEW -> VIEW PORTS 
activate the zoom mode and click on the little square in the top left-hand 

corner or select the view port by name from the view port list. 
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Selection list of stored viewports 

Rename or delete a geometry view port 

Select the view port you want to delete, move the mouse to the selected view port 
and right click. Select from the options DELETE VIEWPORT or RENAME VIEWPORT. 

The Property Explorer 

The Property Explorer enables a table type view of properties of objects. One 
object type is displayed at a time, the objects in this table are either all objects –if 
no objects are selected- or all objects of a type. The properties contained in this 
table are user selectable. The purpose is to enable the user to control and 
manipulate the data. Changes can be made to a single cell or a block of cells, 
modifications can be made to parameters directly or to references to the library. 
For the manipulation of blocks/entire columns it is possible to sort columns and 
design formulas that involve different columns, it is even possible to insert one 
temporary column.  

Open the Property Explorer via Ctrl+ E or EDIT -> PROPERTY EXPLORER.  

 

Modifications to individual objects can be made directly in the table, while changes 
for multiple objects are done by entering new values or formulas into the field 
CELLS. Formulas are commands that are valid for the active rows in current column. 
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If a property is missing in the columns of the property explorer, you can switch it on 
via the property selection (blue wheel). 

When objects in the Geo-Database are selected prior to opening the Property 
Explorer, only the objects that are selected and of the selected object type are 
opened in the table.  

A double click on the „splitter“-cursor between two columns will optimize the 
column width of the left of both columns. 

 

Using formulas in the Property Explorer 

Cells for which a command (formula) shall be carried out must be activated 
beforehand. To activate an entire column, use Ctrl+A, the right mouse button -> 

ACTIVATE ENTIRE COLUMN or left click on the column number. You can also activate 
adjacent cells with the left mouse button depressed using the arrow keys - 
individual cells cannot be highlighted. 

In contrast to activation, selected objects are identified with the selection mark in 
the Geo-Database. 

Example: If you want to select all buildings with a height of 6 m, the entire column 
1 shall be activated and afterwards they should be selected via a formula.  

 

The formulas in the Property Explorer follow the same syntax as the formulas in 
the SoundPLAN Spreadsheet. Please read "Calculating using Formulas”, page 425. 

The entry of values and formulas has a separate facility from the management of 
selection lists. Simply enter the formula in the field VALUE/FORMULA.  

In a text file accessible with the button  you can save formulas for all projects in 
the Globdata folder and when needed use Ctrl+C and Ctrl+V to copy/paste the 
formula in the formula entry of the property explorer.  

As the formulas in the property explorer only allow single line formulas, it is 
prudent to save the formulas in the text file the same way. To allow a bit more 
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general use, the “own“ column can be substituted with x#. The property explorer 
will insert the correct column number for the substitute command.   

To recognize a formula, the Property Explorer expects the formula statement to 
begin with an “=” sign. Columns are referenced by their column number in format 
x+column number. The column number is displayed in the column header below 
the name. The columns of the Property Explorer are numbered sequentially; when 
you select different columns, the numbering will change.  

The own column is addressed via x#. This way the same formula can be applied to 
several columns. 

After executing the command, the formula will be replaced with the calculated 
value. The formulas are not saved with the table, but it is possible to open the last 
formulas with a pick-list in the field CELL. 

If an error occurs in the execution of a formula a specific and precise error message 
is displayed.  The cursor jumps to the line where the error was found, the error 
description is available in the object-ID.  

Objects with variant parameters  

Variant objects are automatically segmented when opened in the Property 
Explorer. The first segment is displayed in a different color. Individual segments are 
presented in the Geo-Database with the highlighted display property.  

• Properties of the first object coordinate are always presented in bold font 

• Cells that cannot be edited are presented on gray background (calculated 
results. Cells with constant content of fields not relevant to the current type 
of data entry) 

• Blanc lines – fields that do not change at the current position 

• White cells – at this point the properties of a variant object has been 
changed 

• Lite blue cell – cursor position (if the properties are constant the font is 
italic) 

• The last object point is shown for objects where it matters (bridges, road 
surface) 

When leaving the Property Explorer, the objects are re-joined.  

Core functions: 

• You determine which of the -sometimes plentiful- properties shall be 
presented in one of the columns (yellow wheel or via TOOLS -> SELECT 

DISPLAYED PROPERTIES). If you want to hide a column temporarily without 
changing the standard display settings, you can do so by right clicking on the 
table header and selecting -> REMOVE COLUMN (or Shift+ Del in the 
explorer). 
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• To sort the table in ascending or descending order, right click on the column 
header that is to be used as the sorting parameter and select -> SORT. 

• As the field-names sometimes are too long for the table header, you can 
display a self-defined short title. (The short title is defined via TOOLS -> 

SELECT DISPLAYED PROPERTIES in the settings of the object properties. 

• With the statistics functions (right mouse button on the statistics line in the 
column header of value columns) you can generate entries for the sum, 
average or the smallest/highest value and for noise levels also the 
energetical sum of the levels. 

• In value columns you can highlight a block of lines and with the field CELL 
assign a value to all highlighted lines of the current column. 

• Elements from the library can be referenced either with the element names 
or via the element number. 

• A block of references to the library can be reassigned via a pick list 
containing the element names. 

• With the column „selected“, you can select objects with a mouse click in the 
box, with the space bar (also possible for multiple highlighted lines) or with 
formulas (enter „1“ for selected „0“ for unselected). This selected status 
remains active when you close the Property Explorer and further process 
the data on the level of the Geo-Database-canvas (for example to change in 
which Geo-File the data shall be saved). 

• The graphics object type is always visible as a column of its own so you can 
assign a different (already existing) graphical object type to the object. 

• In the Geo-File column, the Geo-File assignment can be changed in the 
Property Explorer, also via a formula 

• .With a temporary column (TABLE -> INSERT TEMPORARY COLUMN) you can 
store intermediate calculation results and use them for further actions in 
additional formulas. Data in this column will not be saved, they are lost 
when the property explorer is closed. 

• You can search for any property of the objects (Ctrl+F) or for the object-ID 
(Shift+Ctrl+F) or invoke "search + replace" with F4.    

Examples of how to use the Property Explorer:  

Redefine the height of all buildings with less than 2 meters to a height of 4 
meters: 

Open the Property Explorer for buildings, click on the column header for the height 
of the building and sort all buildings in ascending order. Click on the top line and 
keep the shift key pressed while you move down in the table with the arrow keys. 
Highlight all values smaller than 2 and then enter the number 4 in the field CELL in 
order to transfer the value 4 into all highlighted cells.  
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Select all buildings with multiple apartments: 

Either: Sort column „Number of Dwellings“ in descending order, activate all rows 
with values > 1 in the column "selected" and select them with the space bar. 

Or: Activate column 1 with a right click on column header or Ctrl + A and write the 
formula  

=x“No. Column number of dwellings“ > 1  

into CELL and execute it. 

Convert the number of inhabitants to the number of dwellings using statistical 
values:  

Activate the column "number of dwellings" and execute the formula "=x"Number 
of inhabitants"/statistical value".  

Modify the emission spectrum for all sources of a group 

Sort sources according to the group ID they are part of. In the column emission 
spectra for all sources of this group, select all sources with a depressed left mouse 
button and select the new desired element from the selection list in the box CELL. 
Via the symbol „Library“, you have direct access to the libraries. 

Free properties 

Each object allows the use of „free properties“, to import additional information 
that are not required by noise or air pollution calculations but may be helpful later 
on to process the data in the property explorer. By default, 3 text-, 3 integer- and 3 
floating point variables are presented. If you need more entries, you can change 
the number for all variables via OPTIONS -> NUMBER OF ADDITIONAL PROPERTIES.  

If the free properties are not displayed in the Property Explorer, use the wheel 
symbol to open the object property settings and select the additional properties 
(deactivate SHOW ONLY EXISTING PROPERTIES). 

Free properties can also be used to assign a preload to receivers (single point 
calculation) and buildings (Façade Noise Map) for the evaluation in the 
Spreadsheet. 

Free properties are only accessible in the Property Explorer not in the properties of 
the objects. 

Object info 

Activate the object info with the setting for it under OPTIONS -> SHOW OBJECT INFO. 
You can deselect either the coordinates or the properties with the click boxes. The 
object info window can be moved to any position or align it to the frame of the 
screen. 
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According to the settings in the property selection (page 143), you select which 
parameter is presented when the mouse is moved over a coordinate of an object of 
the particular type.  

Selection of object properties 

You can determine which properties you want to check or modify in the Property 
Explorer, the object info and for "select via properties" in order to keep the list of 
properties simple. Additionally, you can specify your own short title for the column 
header in the Property Explorer and for the shape file export. 

Use OPTIONS -> OBJECT PROPERY SELECTION or right click on the symbol of the object 
type. In the Property Explorer you click on the blue wheel.  

 

The object properties are stored in multiple records. Each node represents a 
record; the properties contained in the record are expanded by clicking on the + 
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sign in front of the record header (the same as in the Windows explorer). As soon 
as you click on a property itself, the translated field name and the descriptive 
comment is displayed on the right side. The field name is shown in the property 
operations and presented in the object info. The original field name is presented in 
square brackets.  

Enable the check box SHOW PROPERTY IN OBJECT INFO and/or SHOW FOR PROPERTY 

EXPLORER for the desired properties. For roads and railways there are several 
standard dependent properties that are always presented for one standard at a 
time, the standard selected in the SoundPLAN Manager for the current project.  

Short title 

For the Shape-file export the field description may have at the most ten characters 
and must not include special characters and blanks. Moreover, it is often sensible 
to define shorter column headers for the Property Explorer. Use the short title to 
define shorter field names. The short title is stored for all projects in the Globdata 
folder.  

Undo 

Use EDIT -> UNDO (Ctrl+ Z) to cancel changes for coordinates and property definition 
until you stored the Situation. The action for "undo" is included in the menu. 

Activate objects 

If you want to amend an object by adding coordinates at the end, you must first 
activate the object. With the right mouse button select -> ACTIVATE OBJECT. You see 
that the coordinates already entered, the start arrow and the last coordinate now 
appear in red.  You only can continue digitizing at the last coordinate of a string. If 
you want to add coordinates at the beginning of the string, you first need to change 
the data entry direction. 

Select (mark) points or objects 

Already existing objects and object coordinates often need to be selected in order 
to edit them. Some of the GeoTools refer to all objects visible on the screen if no 
objects are selected (marked). 

Under VIEW -> SELECTED OBJECTS (F3) you can show only objects that are selected. 

Selecting objects always is in reference to the data shown on screen. To limit the 
selection, use the filter options (page 87). 

To select objects there are several options that can be used alone or in 
combination. 
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Select objects with the right mouse button  

Click the right mouse button on an object and select the menu entry SELECT POINT 
or SELECT OBJECT. Multiple adjacent coordinates (for example of a noise protection 
wall with zero wall height after dimensioning the wall) you can select by holding 
the Shift-key pressed, with the Ctrl-key pressed you can select multiple, not 
adjacent coordinates.  When multiple objects are within the search radius, first 
select the appropriate object from the pick list. 

To select multiple objects or all objects in an area, click with the mouse on the top 
left-hand corner of the area and hold the right mouse button down while moving 
over the area where you want to select the coordinates. All objects with at least 
one coordinate within the activation rectangle are selected. If you hold down the 
Ctrl-key, you can repeatedly activate areas with all objects of subsequent swipes 
selected. 

 

Clear selection 

Deselect objects with EDIT -> CLEAR SELECTION (CTRL+ Q), the menu on the right 
mouse button or by moving the mouse cursor to the lower right-hand of the entry 
screen and moving the mouse with the right button pressed to the top left 
position. 

Select all objects 

EDIT -> SELECT ALL OBJECTS (CTRL+ A), selects all objects loaded. If you want to select 
all objects fitting a filter first filter out the objects with VIEW -> CURRENT OBJECT TYPE 

(F6) or VIEW -> CURRENT GEO-FILE (F5) and then select all objects. 

Select objects with the Alt + left mouse button 

Objects can also be selected with the Alt+ left mouse button by clicking on the 
object of choice. To select additional objects, hold the Ctrl-key pressed. For area 
type objects the correct object type must be the current object type in the 
selection list. With an additional click (with the Alt and Ctrl-keys still pressed) you 
deselect the object. 
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Select objects via a line or an area  

Select a line or area and invoke the menu EDIT -> SELECT OBJECTS VIA AREA OR LINE to 
select all objects that are intersected by the line or are inside the area. You can 
either use an existing object or generate an auxiliary line or polygon. The line or 
area object if it is selected in the process will remain selected and thus can be 
deleted later on. If you do not want to delete the object used to select the others 
undo the selecting with Alt+Ctrl+left click on the object before you delete all 
selected objects. 

This function too is applied to all visible data, so use the filter options in VIEW -> 

CURRENT OBJECT TYPE (F6) or VIEW -> CURRENT GEO-FILE (F5) to show only certain 
objects. 

Selection via an intersection along a line: 

 

Selection within an area: 

 

When the selection area cuts objects, you can decide whether only objects 
completely within the area or all intersected objects shall be selected.  

Invert the selection 

The function EDIT -> INVERT SELECTION deselects all previously selected objects and 
selects all previously unselected objects. This is an easy option to crop data that 
were imported and are exceeding the scope of the study. Generate a polygon 
around the area you want to keep, select the coordinates in the area with SELECT 

OBJECTS VIA AREA OR LINE and then invert the selecting to select all data outside the 
polygon. 

Selecting objects in the Property Explorer 

Call the Property Explorer with Ctrl+ E and select the desired object type from the 
pick list. 

Click the checkbox or press the space bar in the column "selected" to select objects 
in the Property Explorer. If you highlight several objects and then press the space 
bar, all highlighted objects are selected at the same time. You can also use formulas 
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(1 for selected and 0 for unselected) to select objects. After you close the Property 
Explorer the selection marks remain active. 

Selecting objects via object properties 

In many cases it is faster and clearer to use the Property Explorer. 

If you want to select all objects of the same object type and common properties, 
open menu EDIT -> SELECT VIA OBJECT PROPERTY (or Ctrl+ F). 

 

To define the criteria, the relationship operators <, >, =, <>, <=, >= and * (part) can 
be selected from the selection list. Select the object type and the property for the 
selection. Use the criterion * to find all objects of one object type with a common 
part in one of the properties.  

When the property has the addition named index or ID, you cannot directly use the 
name but have to first find the reference number for the name and then use the 
index number or the number of a library element. Internally, there are references 
often in the database rather than the full object properties. 

Examples: 

You want to select all buildings in Jamaica Road. But the building name also 
includes the house number. Enter the criterion * and the operation “Jamaica”. All 
buildings with the common text part "Jamaica" in the building name will be 
selected (but the “Jamaica Sports Area” would also be found).  

Searching for objects with an undefined property: Enter the criterion = and leave 
the field search string empty. 

Properties that are assigned from the library (source spectra, absorption spectra, 
day histograms etc.) reference the library via the number of the element in the 
project library. The element number is always presented in the library when you 
move the mouse over the element name. 

Select points with elevation <= [m] 

EDIT -> SELECT POINTS WITH ELEVATION <= [M] is a good tool to for example find 
objects that have been imported without any elevation. The selected points 
afterwards can be deleted or corrected with elevation information from the DGM. 
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Select objects with elevation <= [m] 

The GeoTool SELECT OBJECTS WITH ELEVATION <= [M] is a tool to find and select 
objects that were imported without elevation information. Delete the selected 
objects or use a DGM to provide the elevation information. 

Tip: If you import DXF data, you can ignore coordinates without elevation 
information during the import. 

Select objects with length <= [m]  

SELECT OBJECTS WITH LENGTH <= [M] selects all line objects that have a length smaller 
than a threshold value. 

Select objects with an area <= [m²] 

With the GeoTool SELECT OBJECTS WITH AN AREA <= [M²] small buildings e.g. with a 
ground area of less than 40 m² like garages, can be identified and selected. The 
auxiliary buildings once selected can be transferred into a Geo-File of their own. 

Select road segments with gradient > |x|° 

Use EDIT -> SELECT ROAD SEGMENTS WITH GRADIET > |X|° to visualize road gradients 
up or down that are greater than the threshold entered. 

 

Geo-Database editor with projection: the arrows indicate the selected points 

Right click on the points with problems to correct the elevations manually -> EDIT 

OBJECT PROPERTIES.  A second choice is the Geotool ADJUST SHARP ELEVATION STEPS 

to automatically change the elevation problems. 

Delete points or objects 

Move the cursor to the point you want to delete until the cursor changes from the 
crosshair into the arrow. Right click and select DELETE POINT or DELETE OBJECT. To 
delete points and objects with the right mouse button, the coordinates do not need 
to be selected. Selected objects are deleted with EDIT -> DELETE (Del). 
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Insert point after 

If you want to insert a coordinate into an already existing object, select the 
coordinate in front (in data entry direction), press the right mouse button and 
select the menu entry INSERT POINT AFTER. The new coordinate is generated in the 
middle between the selected coordinate and the next one. The elevation is 
interpolated between the 2 bordering coordinates and the point is selected so that 
you can move it to the correct position. 

Insert point before 

With a right click on a coordinate, you can generate a new coordinate before this 
coordinate. If the point was the first point of the object, a new first coordinate for 
the object is generated and the properties of the previous first coordinate is 
transferred to the “new” first coordinate. 

Insert a point at any location 

In addition to the „insert point before“ and „insert point after“ you can insert new 
coordinates in a line directly by selecting the red digitizing cursor and inserting the 
new coordinate on the object with a pressed shift key and the right mouse button. 
The elevation for the new coordinate is interpolated from the coordinates before 
and after, it is not read from the DGM. Graphically inserting coordinates this way 
helps to insert the beginning and the end of bridges that might be visible from the 
background bitmap. Select F12 to toggle between the digitizing and the edit mode. 

Move / capture selected point  

When a point or an object is selected, the cursor changes into the 
movement cursor when you are getting in range of the search radius 

around the point. Move the point with the left mouse button to the new position.  

Keep the right mouse button pressed to move a point to the x, y and z coordinate 
of an existing point. When you release the right mouse button and the cursor is 
close enough to the new position, the coordinate is moved, if you were not close 
enough, the point reverts to the original position.  

With the shift key pressed the captured point will only move the X,Y coordinates 
but not the elevation to the new location. This is particularly helpful if you have 
stacked area sources that should be at the same location but different elevations. 

Move, duplicate and rotate objects 

As soon as one or multiple objects are selected, the Geo-Database places a 
magenta square in the center of gravity of the group. Clicking on this square and 
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keeping the left mouse button pressed will move the group to a new location. The 
new location is indicated as an outline.  

 

Hold the Ctrl-key pressed while attempting to move the objects will rotate the 
object around the center of gravity.  

Rotating objects can also be activated via VIEW -> SHOW DIALOG „EDIT SELECTED 

OBJECTS“ (Shift+Ctrl+R).  

 

You can either enter the rotation angle in DEGREES [°] via the keyboard or use the 
arrows next to the entry field to get to the desired angle. The field INC sets the 
increment for the angle field. Enter 0° to reset the rotation.  You can leave the 
window open parallel to the normal data entry window.  

Keep the Alt-key pressed and move the objects with the left mouse button to 
duplicate the selected objects. 

Copy object 

Select the object you want to copy into another Geo-File and invoke the function 
EDIT -> COPY OBJECT.  

 
Copy object 

You can also use EDIT –> COPY (Ctrl+ C) and EDIT –> PASTE (Ctrl+ V) to copy selected 
objects. The objects are pasted to the Geo-File displayed in the Geo-File selection 
list. After you pasted the objects, only the copy is selected. 

Graphics-Object type 

You can change the basic object types to other predefined layouts, for example 
redefine a noise protection walls or lines as ridges for 3D or assign the different 
buildings types (e.g. auxiliary building, school or hospital). With the module 
Cartography you can additionally assign free definable layouts. 
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Select the objects you want to process and click on the symbol EDIT -> GRAPHICS-

OBJECT TYPE – for a single object you can assign another layout from the selection 
list in the tree view of the object dialog. In the list you find all possible variations for 
the selected basic object type.  Assign the desired layout. A single object can be 
assigned a graphics-object type by right clicking and then executing GRAPHICS -

OBJECT TYPE. 

If you want to assign a new own layout to an object type, click on the symbol EDIT 

OBJECT TYPE. This opens the project object types (see "Generate own object 
types").  

The presentation of the object according to the object design is only done in the 
Graphics, not in the Geo-Database. Store the Situation and then view it in the 
Graphics.    

 Generate own object types 

Duplicating object types allows you to generate multiple layouts for the same 
object type. For example, it may be useful to draw different types of roads with 
different layouts to show one road is under federal jurisdiction, another is the 
responsibility of the state and another is under local jurisdiction.  

Activate the object type you want duplicate. Press the symbol button 
duplicate. Enter a new name for the new object type and customize the 

legend text. Then modify the layout for the new sub-object as described in "Site 
map / geometry data (page 545)". The following example assumes roads and 
buildings have been duplicated for different layouts:  
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Split objects 

Use this function to split an object into 2 separate objects. Right click on the point 
where the new object should start and invoke the function SPLIT OBJECT. If the 
object dots are activated, you will see that the property definition mark is repeated 
at the beginning of the new object and that the new object has between the first 
and second coordinate a new direction arrow. 

 

If you split roads or railways the property "reference line" is transferred to the 
second object. 

Invert entry direction 

Sometimes it is necessary to change the entry direction of a line object (for 
example when you want to add coordinates at the beginning of the line). Another 
use of this facility is to uniform the entry of buildings so that the documentation 
provides a better overview. Trigger the function by right clicking CHANGE INPUT 

DIRECTION. 

For industrial buildings the entry direction is automatically adjusted to have the 
entry of the coordinates in a counter clockwise direction. 

Change Geo-File Assignment 

Select the objects you want to move into another Geo-File and invoke the menu 
EDIT -> CHANGE ASSIGNED GEO-FILE (Ctrl + G) (or click the right mouse button in an 
area where you do not home in on another existing coordinate). All Geo-Files 
present in the Situation are listed in the selection box. When storing your data 
next, all objects that were selected are removed from the old Geo-File and are 
moved to the newly assigned one. 
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It is also possible to open right mouse menu -> EDIT OBJECT PROPERTIES for one 
single object and select another Geo-File included in the Situation. 

Convert object type 

Select the objects you want to convert and trigger the function EDIT -> CONVERT 

OBJECT TYPE (Ctrl + U) (or right click at a place where you do not home in to another 
coordinate) and select the new object type from the pick list. 

 

After you selected the target object type, the property dialog is opened. If the 
object in the existing object type has defined properties, they will be lost when 
converting to the new object type. If this is the case, SoundPLAN will give you a 
warning. 

Set objects to DGM 

 

Selected objects are set to the digital terrain model which is loaded in the 
background with EDIT -> SET OBJECTS TO DGM (Shift+Ctrl+D) (or right click in an area 
where you do not activate another coordinate). The elevation from the DGM is 
assigned to the z-coordinate.  

If you want to add e.g. a pedestal to the buildings, enter the value in the field ADD 

UP TO DGM ELEVATION.  

When buildings or industrial buildings are placed on top of a DGM, you can select if 
the ground floor slab elevation shall be derived from the elevation at the corners of 
the building as the highest/lowest or if it shall be averaged from all coordinates.  
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This way you can determine in cases where the terrain is sloping where the building 
has its entrance. Along with the building property, "number of basement floors," 
you can position the receivers more exactly in their elevation.  

Bridge detection without known gradient 

If roads or railways are included in the data, you can check the SEARCH FOR BRIDGES 
box and then set the bridge search parameters. The checkbox is deactivated if 
bridges are already present in the course of one of the roads or railways.  

 

The bridge detection automatically detects bridges based on the gradient between 
the object points, sets the bridge start and end with a width of 10 m to the right 
and left and adjusts the height of coordinates within the bridge to the bridge level. 
The bridge addition for railways must be assigned manually (Property Explorer).  
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You can use SMOOTH ELEVATIONS to compensate for small height outliers from the 
DGM. The more ITERATIONS you run through, the more the coordinates are 
adjusted. 

Use “Control bridges”, page 180 to verify the length and position of bridges. 

Coordinate operations 

With the coordinate operations you can modify the x and y coordinates and, which 
is more likely, the elevation for one or multiple objects at the same time. Select the 
objects and trigger the function EDIT -> COORDINATE OPERATIONS (or right click in an 
area where you do not activate another coordinate). In the selection box select the 
parameter that should be modified “x”, “y” or “z”, in the field below enter the 
function you want to use for example +0,5 or =125. The DGM elevation is set via 
“Assignment of elevation from a DGM to objects (page Fehler! Textmarke nicht 
definiert.)”. 

In rare cases your data may be stored with y, x instead of x, y coordinates. In this 
case you must swap the x and y coordinates via the "Coordinate Transformation", 
see page 173. 

 

The following operations are possible: 

Set equal to (=), Add (+), Subtract (-), Multiply (*), Divide by (/) 

Property operations 

This tool requires comprehensive knowledge of the properties. It is therefore often 
faster and clearer to use the Property Explorer! 

Property operations are used to modify the properties associated with a single 
object type for one or many objects at the same time. In order not to make the 
selection list too long, you can define the properties you want to be listed for 
property operations, see "Selection of object properties" on page 143. 

Select the objects you want to modify and trigger the function EDIT -> PROPERTY 

OPERATIONS (or right click on an area where the cursor will not snap to a 
coordinate). Select the property from the pick list and enter the desired operation 
in the field below. For example, +3, =102,5 or =Main Street. 
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The following operations are possible: 

Set equal to (=), Add (+), Subtract (-), Multiply (*), Divide by (/) 

Search for an object known by its ID number 

Hint: Search object is nowadays only used rarely. In most cases it is easier to 
directly access the object in question with the Pre-flight (page 179). in the 
calculation logbook can be a 

In the logbook of the SoundPLAN calculation core the warning and error messages 
are sometimes indicating that a particular object in a Situation/Geo-File has a 
problem.    (For example, "Road properties of road #1793 are missing"). The 
search function helps to find the object with the ID that is listed in the error 
message. Select EDIT -> SEASRCH OBJECT and enter the object ID number (or right 
click on an area where the cursor will not snap to a coordinate). The data on screen 
are redrawn in a way that shows the maximum size of the searched object. 

Geo-Tools and Tools 
The Geo-Tool dialogs contain a preselection of the object types that are sensible for 
the individual GeoTools. 

  

The Geo-Database only interferes if nothing is marked or a possible error is 
detected, otherwise the dialog opens directly.  

There are error messages or logbook entries, for example if a DGM is required, if 
there is no object valid for the selected tool in the data or if objects are marked 
that a certain tool cannot process.  If objects with absolute and relative elevation 
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are included or marked, please select for which objects the Geo-Tool should be 
executed. 

If no DGM is loaded and you want to run a GeoTool that requires a DGM, you will 
be prompted to load the DGM before running the Geo-Tool.  

Geometry Tools 

Some geometry tools are explicitly working only on line type objects when they are 
selected. The menu options are only shown when the object has been selected 
(marked). 

Create a parallel object 

Parallel objects are used for example to generate a base line of a noise protection 
wall parallel to a road alignment or for the generation of a 2-track railway line. 
Select the object and trigger the function GEOTOOLS -> CREATE PARALLEL OBJECT 

(Shift+Ctrl+P). 

 

Select the object type from the pick list and enter the distance in [m] between the 
existing line and the new one. A positive value will generate the new line to the 
right (in entry direction of the existing line) and a negative value will generate the 
parallel to the left of the existing line. The input direction can be recognized by the 
small arrows when you switch on the object points for the object type (see “Display 
of object dots and object properties (page 87)”). 

If the object type for the parallel object is the same as for the original object, 
already defined properties are carried over. 

Parallel object from calculated object lines 

Calculated object lines are lines that results from the input of properties. For 
example, the berme top from the height and the tilt of a berme or the position of 
the road edge from the lane width which may also change in the course of the 
road. Start this extra function by right clicking on one of the object coordinates and 
selecting the function CREATE PARALLEL OBJECT. Select the object type of the new 
object and the distance to the existing object. With the distance 0.0 the new object 
is just like copy/paste would generate. 
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Connect lines and generate areas 

Data imported from external sources sometimes are not present as complete lines 
and areas but rather as fragments. Activate the object dots to check the data. To 
process the objects in SoundPLAN, the line fragments should be combined to 
polylines and completed area. This function is done with GEOTOOLS -> CONNECT 

LINES (Shift+Ctrl+V) and GEOTOOLS -> MORE GEOMETRY TOOLS -> CREATE AREAS. 

The Geo-tool connect lines expects the entry of a maximal distance between the 
closest coordinates of the objects to be connected. This distance is interpreted as 
the three-dimensional distance.  

With ALT + CONNECT LINES (or Shift+Ctrl+Alt+V) the height difference is not taken 
into account; the upper elevation is used. 

The name of the object is deleted if multiple objects are concatenated with the 
function. 

The algorithm CREATE AREAS is able to generate the areas if the coordinates 
defining line elements are within 10 cm of each other. The algorithm recognizes 
the area and connects the polyline and converts it into areas. 

Select all lines you want to connect and then trigger the function CONNECT LINES or 
GENERATE AREAS from the menu GEOTOOLS. Activate the object dots to check if all 
object coordinates now share a single start arrow. 

Hint: If not all line fragments are connected into a polyline, the most likely reason is 
that the first and last coordinate of subsequent line elements are not identical or 
that the distance is bigger than 10 cm for areas. On selected objects that share the 
same coordinates the selection mark is not visible. The second drawing of the 
selection mark "undraws" the first drawing.  

 

“Undrawn” selection for identical coordinates 

The example below shows how the lines should look before and after connecting 
the lines: 

 
Lines converted to polylines and lines converted to areas 

When the two sets of coordinates are not identical, a bit of extra work is needed: 
Either select the lines and pull the last coordinate of a line segment with the right 
mouse button depressed on to the first coordinate of the next line (when the 
selection mark vanishes, the point is available twice). The other option, especially 
suitable if the gap between the objects is bigger, is to select the first line with the 
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right mouse button and the option SELECT OBJECT, and then capture the first 
coordinate of the following line with the CAPTURE COORDINATE command of the 
right mouse button. When both lines have different entry directions, the direction 
of the selected object will set the direction for the new object. 

Insert intersections and split 

If you want to split the lines and cut them so that the buffer remains free of the 
line, use this GeoTool. It generates points along the selected intersection line and 
splits the objects. The area itself and the objects within are selected so that both 
are deleted when you hit the Del. When inserting cutting points along a line, the 
cutting line will remain selected. 

Procedure with the example of an area, the functions are the same as with the line: 
You can either use an existing area or digitize an auxiliary polygon. Select the area 
and trigger GEOTOOLS -> INSERT INTERSECTIONS AND SPLIT (1). 

The start arrows indicate that the elevation lines within the area now are objects of 
their own and are also selected (2). With Del the elevation lines in the area are 
deleted (3). If the original area (that was used to select and split the elevation lines) 
shall not be deleted, eliminate the select with an Alt + Ctrl left click on the area (4). 
Be aware that the object type for the area must be the currently selected type! 

(1) (2) (3)   (4)  

Another option to generate the cutting polygon is via the GeoTool CREATE BUFFER.  

Divide areas 

This function is particularly useful to subdivide an apartment building into multiple 
apartments, to separate a string of town houses, or to subdivide area sources and 
parking lots into homogeneous areas.  

 

All properties are copied to all sub areas. For buildings, the number of inhabitants 
is distributed in accordance to the surface area of the sub areas. 



 SoundPLAN Manual 8.1 
 Geo-Database 

Page • 160/793 Geo-Tools and Tools 

3 

Enter lines where you want the area objects to be divided and then trigger the 
function GEOTOOLS -> DIVIDE AREAS. 

Clean-up overlapping areas 

With this Geo-tool (GEO-TOOLS -> CLEAN UP OVERLAPPING AREAS (Shift + U)) smaller 
areas overlapping a bigger area are cut out.  

   

This tool is also useful to make sure contradicting definitions of ground absorption 
areas or volume attenuation areas that cause errors in the calculation are 
corrected. 

 

Filter coordinates 

If the distance between the coordinates of line objects is very small, unneeded 
points, that don’t have influence on the accuracy can be deleted with the filter 
function. A smaller point density reduces the amount of data and has a positive 
effect on the calculation time. Filtering with a maximum deviation of 10 cm is in 
most of the cases not critical.  

 

Select the objects and invoke the function GEOTOOLS > MORE GEOMETRY TOOLS -> 

FILTER . Enter the filter width and click the OK button. The coordinates selected for 
the filter width of 10 cm as in the above example, are all within a zone of 10 cm left 
and 10 cm right between existing, unselected coordinate. Elevation differences are 
considered and the coordinates are not selected. Points with property definitions 
are not selected, even if they are within the filter width. 

If you agree with the result and want to delete the selected coordinates from the 
data pool, press the Del key or use EDIT -> DELETE. If not, clear the selection with 
Ctrl+Q or right mouse button -> CLEAR SELECTION. The objects then remain 
unchanged.  
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Interpolation -> n points per segments 

 

The line must at least contain 3 coordinates. SoundPLAN inserts the number of 
coordinates you requested in a 3-dimensional spline, the already existing 
coordinates will not be modified. Trigger the function GEOTOOLS > MORE GEOMETRY 

TOOLS -> INTERPOLATION -> CREATE N POINTS EACH SEGMENT and enter the desired 
number of intermediate coordinates. The interpolated coordinates are selected. 
The picture above shows the result in the projection. 

Interpolation -> segments with constant distance 

 

The line must at least contain 3 coordinates. SoundPLAN inserts coordinates on a 3-
dimensional spline in the spacing you requested. The existing coordinates remain 
unchanged. Invoke the function with GEOTOOLS > MORE GEOMETRY TOOLS -> 

INTERPOLATION -> CREATE SEGMENTS WITH CONST. DISTANCE IN [M] and enter the 
desired spacing of the coordinates along the line in [m]. The interpolated 
coordinates are selected. The picture above shows the result in the projection. 

Interpolation -> Create a point in a defined distance 

Coordinates are connected with straight lines, which will re result in a light error of 
road length in curved roads and railway lines. This tool inserts a coordinate in a 
selected distance from the start of the line. The distance is calculated using a 3-
dimensional spline rather than the straight-line connections so the distance from 
the start coordinate is very accurate. The line must at least contain 3 coordinates. 
Trigger the function with GEOTOOLS > MORE GEOMETRY TOOLS -> INTERPOLATION -> 

CREATE POINT WITH [M] DISTANCE TO THE FIRST POINT. The interpolated coordinate is 
selected. 
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Divide into sections 

Object edges of line and area type objects can be subdivided into smaller sections 
so that noise protection walls or facades of buildings can be structured more. The 
objects are not cut. 

 

Trigger GEOTOOLS > MORE GEOMETRY TOOLS -> DIVIDE INTO SECTIONS (Shift + Ctrl + L) 
and enter the distance between points to insert in [m]. The elevation of the new 
coordinates is interpolated. Existing points are remaining, if the requested distance 
is smaller than the minimum distance, no further coordinate is inserted. 

Create a buffer 

GEO-TOOLS -> MORE GEOMETRY TOOLS -> CREATE BUFFER allows generating buffers 
around points, lines and areas.  

 

 

The BUFFER WIDTH in [m] is the distance between the marked object and the border 
of the buffer area (for example: enter 4.5m if you want to create a buffer with a 
width of 9 meters).  Via the NUMBER OF INTERMEDIATE STEPS, you determine how 
detailed arcs are generated with regard to 360°. For example, if you set 36 
intermediate steps for a point object, you will get an approximation of a circle with 
36 coordinates (or an angle of 10° between coordinates).  

Examples: With the setting 1 intermediate step for area-type objects the corners 
are not radiused. The setting 3 for a point object will result in a triangle.  
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The switch SEMI-CIRCLE LINE ENDS will cause the ends of a line to be set as a half 
circle.  

 [Module “Noise Mapping Toolbox”] With Shift + GEO-TOOLS –> MORE GEOMETRIE 

TOOLS -> CREATE BUFFER areas around the emission bands of roads are generated, 
the width of the band left and right of the emission line is set with the entered 
parameter. The buffer is selected so that you can quickly select building with EDIT -> 

SELECT OBJECTS VIA AREA OR LINE to detect where the emission band is in conflict 
with buildings. 

Fix area geometries 

If the warning message "Receiver x is within the assigned building, possibly due to 
right angle correction" appears in the logbook during calculation of a facade noise 
map, this is often due to the fact that the lines of a building were put together like 
an 8 after import. This warning and also other errors when calculating, for example, 
if area usages or ground effect areas cut itself, can be cleaned with the Geotool 
MORE GEOMETRY TOOLS -> FIX AREA GEOMETRY. This Geo-Tool goes through all areal 
objects objects of a Situation and cleans up the geometry. The log shows how many 
areas were corrected, how many buildings with courtyards are included and 
whether areas could not be corrected. 

Fix building geometries 

If you receive a warning message, such as " receiver x is within the assigned 
building, possibly because of the right angle correction," in the logbook, it could be 
that this building was imported, but the sequencing of the coordinates was wrong 
and the building actually resembles a figure 8. Use the Geo-tool MORE BUILDING 

TOOLS -> FIX BUILDING GEOMETRY to check and correct all buildings of a Situation. 
The protocol will indicate how many buildings are corrected, how many buildings 
contain an inner courtyard, and if there are buildings that could not be corrected. 

Unite areas 

This Geotool generates a hull around all marked areas (regardless of the object 
type) to generate a bigger area containing all marked sub areas. This can be used 
for example to use areas of city boroughs to generate a calculation area. Holes 
(areas not part of a marked area but totally encapsulated) and overlapping areas 
are ignored. The resulting area is of the type of general area and can then be 
converted into any other type. Select the areas and invoke GEOTOOLS -> MORE 
GEOMETRY TOOLS ->UNITE AREAS.  
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Calculate right angles 

Selected area type objects can subsequently be adapted to right angles using 
GEOTOOLS > MORE GEOMETRY TOOLS -> CALCULATE RIGHT ANGLES. You will get a 
message if the angle is smaller than 45°.  

Clean multiple points 

GEOTOOLS > MORE GEOMETRY TOOLS -> CLEAN MULTIPLE POINTS filters coordinates 
with a default minimum distance of 1 cm. This Geo-tool can also be used to clear 
up double coordinates at the beginning and the end of buildings. 

Building tools 

Prepare buildings 

GEOTOOLS -> PREPARE BUILDINGS is very useful to jointly prepare many buildings in 
an imported set of data and set the needed parameters for the Façade Noise Map. 
The automatically generated properties are entered into the properties of the 
buildings. If no buildings are selected, this Geotool processes all buildings visible on 
screen. 

 

Select the buildings you want to process. DEFINE BUILDING NAME fills in the field 
building name with road name and house number. You can create a ROAD NAME as 
well as a continuous HOUSE NUMBER. The number can be automatically converted 
into a Geotext. 

SELECT ALL FACADES FOR THE FACADE NOISE MAP means all facades of all selected 
buildings that are longer than the MINIMAL LENGTH (min. length in [m]) are 
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selected. Use the minimum length to exclude small areas of the main buildings. 
When you activate the properties of the buildings (Symbol  next to the object 
selection list) you can see which facades are selected for the Façade Noise Map as 
thick dark turquoise lines. With DESELECT ALL FACADES for FNM the calculation of 
receivers for the selected buildings is deactivated. 

With the height of the building in place, SoundPLAN can CALCULATE THE NUMBER OF 

FLOORS of the building and thus define the positions of the receivers. The 
calculation is carried out with the floor height entered in the building properties as 
well as the possibly differing height of the ground floor (check mark DIFFERENT 

HEIGHT OF GROUND FLOOR). 

The height of the first receiver above GF has no relevance on the calculation of 
numbers of floors. 

If, in addition, the ADJUST ELEVATOR HEIGHT switch is activated, the building height 
is changed to a multiple of the floor height and the GF of the building is corrected 
upward, so that the upper edge of the building (diffraction edge) remains the same. 
For building heights smaller "floor height", the GF is adjusted down so that the 
diffraction edge does not change. 

Vice versa you can use CALCULATE BUILDING HEIGHT to calculate a generalized 
building height if instead of the wall height the number of floors is known.  The 
building height is calculated from the floor height * (number of floors + 0.5 * floor 
height). The additional half floor height is used to find a mean height for the top 
floor. A more individual building height can be calculated in the Property Explorer, 
for example to take different floor heights for ground floor and upper floors into 
account.  

HOUSE NUMBER AS GEOTEXT creates a Geotext within the building from value in the 
field house number. 

OBJECT NUMBER AS GEOTEXT creates a Geotext within the building from value in the 
field object number. 

 You can use TOOLS -> CREATE GEOTEXTS FROM PROPERTIES to display any property 
as text.  

DEFINE INHABITANTS calculates the number of inhabitants per building from the 
parameters ground area, number of floors and a user defined area per inhabitant.  

Hint: Data imported from other programs often do not place main buildings and 
auxiliary buildings (garages etc.) into separate layers. For auxiliary buildings no 
Façade Noise Map needs to be produced. Use the GeoTool SELECT OBJECTS WITH 

AREA <= [M²] to select auxiliary buildings and place them into a separate Geo-File.  

Reassign receivers to buildings 

You can reassign receivers to buildings if the Geo-Database lost the assignment. As 
every object in the Geo-Database has a unique object ID and the ID is used as the 
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building reference for the receiver, assignment can be lost, e.g. because the 
buildings have been copied. 

Hint: You can see lost assignments if receivers assigned to buildings are displayed 
in red instead of green. See “Display of object dots and object properties (page 
87)”. 

Aside from the assignment of receivers to buildings, you can use this Geo-tool to 
assign changed buildings properties to the receivers. 

 

If no objects are selected all receivers will be processed. Call GEO-TOOLS -> REASSIGN 

RECEIVERS TO BUILDINGS.  

Select REASSIGN BUILDING REFERENCE, if the connection between buildings and 
receivers has been lost (red receivers).  

To update the receiver properties from the building, click on the relevant 
checkboxes. You can reassign independently from each other the AREA USAGE, the 
RECEIVER NAMES, or the information on FLOORS and HEIGHTS (this option also derives 
the receiver height above ground from the ground floor elevation of the building). 
As the reassignment, depending on the size of the project, may take a while, you 
may use the button USE EXISTING BUILDING REFERENCES to reassign the properties 
from the buildings to the receivers. 

Activate one or more of the options, if you want to update information in the 
receivers. You can transmit separately RECEIVER NAME, USAGE, and the information 
on FLOOR and HEIGHT (this option also updates the object height of the receiver 
from the GF of the assigned building). 

If the existing building reference is used, you can use the check mark CHANGE 

DISTANCE [M] to change the distance of the selected receivers to the façade, for 
example, if the same receivers are to be used for calculations according to different 
guidelines with different position and calculation height requirements (e.g. Total 
noise assessment according to VDI 3722-2 (page 680)). 
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Check the result. In case the receiver was not assigned, the distance of the receiver 
to the facade might be too large. The façade can be found if it is within twice the 
distance as set in the field of the receiver setting the “Dist. Façade”. 

Assign texts to buildings 

Texts that have the position marker (black plus sign) inside the building can be 
automatically assigned to the building properties. 

 

Buildings and texts do not have to reside in the same Geo-File. The buildings must 
be visible on screen. The texts must be selected.  

With the Geo-tool ASSIGN TEXTS TO BUILDINGS, it is possible to automatically set 
texts in all available fields, for example the property number or the owner of the 
building. 

 

Select the assignment type ASSIGN ONE TEXT (OVERWRITE). This assignment type 
overwrites whatever text/value was assigned before. When multiple texts are 
found inside the building, the text found first will be used as the text assigned to 
the field. 

Gather multiple texts in a single field 

When multiple texts are inside a building, the texts can be concatenated to one 
single field. For this option select ASSIGN MULTIPLE TEXTS (ADD). 

 

If multiple buildings of terraced houses have been digitized as a single building and 
the house number or the number of inhabitants is available for each of the 
terraced houses, the text assignment will treat the data appropriately. 
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Value fields (inhabitants, # of dwelling units) are added to a single value (left 
sketch), for text fields (house number, name…) the individual texts are 
concatenated with a blank in between (right sketch). 

Existing texts are not overwritten but amended. 

Transfer area usage to buildings 

With this Geo-Tool the zoning definition from objects of the object type "usage 
areas" is transferred to the appropriate property of the marked building objects.  

Mark the area usages and all buildings that you want to define the area usage 
property and invoke GEOTOOLS -> MORE BUILDING TOOLS -> TRANSFER AREA USAGE TO 

BUILDINGS. If no buildings are marked, all buildings contained in a usage area will 
have the property set. 

Distribute Occupants/ or Dwellings 

If you have the population numbers for the entire town or district by district, you 
can assign the population figures or dwellings to the SoundPLAN usage areas and 
distribute them to all residential buildings in accordance to the number of square 
meters of living space (for each building area times number of floors). To distribute 
the population or dwellings, select the usage areas and call the GEOTOOLS -> MORE 

BUILDING TOOLS -> DISTRIBUTE OCCUPANTS or DISTRIBUTE DWELLINGS.  

UNIQUE ASSIGNMENT distributes the inhabitants only to buildings where the center 
of gravity is completely inside the area. 

EXTENDED ASSIGNMENT distributes the inhabitants also to buildings that are not 
completely inside the areas as long as the center of gravity or the multitude of the 
corners is within the area. 

 

This tool distributes the figures only to buildings assigned the property main 
building. 
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Simplify buildings 

 [Module “Noise Mapping Toolbox”] With the GEO-TOOL ->MORE BUILDING TOOLS -> 

CLEAN WALL LEDGES (Shift + M) you can cut off small outcroppings of buildings and 
thus simplify the buildings. This way you can prevent the program from calculating 
excessive numbers of receivers for a Façade Noise Map at places that are not 
relevant. 

Enter the maximal width of the outcropping on a facade that is supposed to be 
rectified. By default, this parameter is set to 1 meter.  

 

If the wall outcropping is not on the border of the building, the program will 
automatically set a coordinate to separate the facade. 

Select buildings by Spreadsheet 

With this Geo-Tool you can use a Boolean column from the spreadsheet to assign 
buildings and receivers a criterion to mark/unmark the object (if the Boolean value 
is true, the object is marked). Buildings marked this way can for example be moved 
to a different Geo-File or can be assigned a different graphics object type. 

Invoke GEO-TOOLS -> MORE BUILDING TOOLS -> SELECT BUILDINGS BY SPREADSHEET and 
select the spreadsheet and the column which contains the criterion to be 
evaluated. 

Elevation Tools 

Evaluate spot heights for mean building heights 

A geo-tool polls all spot height points located in a building, averages the elevations, 
calculates the difference between the foot of the building and the average height 
and places this parameter into the building property for the building height.  
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Select the buildings and import the spot elevations within the circumference of 
buildings (see page 114). Invoke GEO-TOOLS -> EVALUATE SPOT HEIGHTS FOR BUILDING 

HEIGHT. The buildings need to be selected.  

Calculate the object height from the top edge 

If the object base elevation contains the tops of buildings / industrial buildings or 
the tops of noise protection walls, a SoundPLAN GeoTool calculates the wall height 
by evaluating the tops of the object with the elevation found in the DGM. 
SoundPLAN averages the heights and writes the results into the field “wall height” 
for walls and respectively “building height” for buildings. The DGM must be loaded. 

Select the objects and invoke GEOTOOLS -> CALCULATE OBJECT HEIGHT FROM TOP 

EDGE.  

For buildings or industrial buildings, you can select if the ground floor slab elevation 
shall be derived from the elevation at the corners of the building as the 
highest/lowest or if it shall be averaged from all coordinates. 

 

When you select HORIZONTAL WALL TOP the program -if necessary- will insert an 
additional coordinate at the end of the wall to make sure the horizontal top is 
correct. The base height of the wall is defined as such that the maximum wall 
surface is generated. CONSTANTE ELEMENT HEIGHT is setting the element height at 
the end of the wall in such a way that the wall has a constant height, the height of 
the top of the wall may be variant. USE SEGMENT HEIGHT uses the height of the 
segments and the number of stacked elements of your choice and sets the base 
height of the wall to assure that the section’s height is a multitude of the segment 
height. The gap between the bottom of the lowest element and the DGM is 
regarded as a non-reflective base. All three parameters can be combined.  

Additionally, you can use the option IGNORE EXISTING WALL HEIGHTS. This setting 
sets the top of the diffracting edge to the z-component of coordinate, even is a wall 
height is defined explicitly in the properties. When you deactivate the checkmark 
and the wall height is greater than zero, the top of the wall will be lifted by the wall 
height. 

View the results in the 3D view or side projection. 
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Interpolate elevations 

Between selected coordinates of a line type object you can interpolate the 
elevations. For example, for ramps to motorways where only the start elevation 
and the end elevation of the road are known or to smooth elevation peaks within a 
line type object.  

 

Select the entire object or within an object the coordinates to interpolate in 
between (select the first coordinate with a right click -> SELECT POINT, press the 
shift key and select the last coordinate with a right click -> SELECT POINT) and then 
start GEO-TOOLS -> MORE ELEVATION TOOLS -> INTERPOLATE ELEVATIONS or Ctrl+ H. 
You can also use the front or side projection to mark the beginning and end 
coordinate for the interpolation. 

In conjunction with the function EDIT -> SELECT POINTS WITH ELEVATION <= X [M] it is 
easy to select all coordinates of a freeway ramp and interpolate the elevation 
between all coordinates to get a smooth elevation profile. 

Interpolate elevations on bridges 

GEO-TOOLS -> MORE ELEVATION TOOLS -> INTERPOLATE ELEVATIONS ON BRIDGES 
interpolates between the beginning of the bridge and the end of the bridge the 
elevation of all bridges of all selected roads and railways. If you have several 
bridges in the course of an object, but you only want to interpolate the elevations 
of a specific bridge, select the bridge points of the desired bridge except the bridge 
beginning and the bridge end point and perform the Geo-Tool INTERPOLATE 

ELEVATIONS (Ctrl + H). 

Smooth elevations 

If the digital ground model is inaccurate, some of the road sections will show jumps 
in the elevation that will exceed the allowable limits for roads and will cause 
excessive road incline additions in the emission calculations. 

The elevations of the existing coordinates are moved in an iterative way so that it 
does not result in a systematic error. 
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Open GEOTOOLS -> MORE ELEVATION TOOLS -> SMOOTH ELEVATIONS and enter the 
number of iterations. As the coordinates remain selected, you can view the results 
afterwards and, if needed, run additional iterations. 

This function is also very useful to smooth a road that shall be used as an animation 
track for the 3D-Graphics. 

Adjust sharp elevation steps (out of bounds gradients) 

When objects imported without elevation information are placed on top of a DGM, 
it can happen that DGM triangles are intersecting the road and are pulling the 
coordinates unreasonably up or down. This Geo-tool finds elevation inconsistencies 
within DGMs that are in general correct. 

The Geo-tool under MORE ELEVATION TOOLS -> ADJUST SHARP ELEVATION STEPS 
searches for gradients between 2 coordinates and corrects the gradients that are 
above 10% by adjusting the elevation of the road coordinates (a planned extension 
of this function is to make the threshold user definable). If two coordinates have a 
smaller distance than defined in CONCENTRATE POINTS these coordinates are 
concentrated in one point. Coordinates that contain property information are also 
adjusted in their height but not concentrated even if they are very close to another 
coordinate. 

Please check the result in the projection and via EDIT -> SELECT ROAD SEGMENTS 
WITH GRADIENT > |X|°. 

In the projection you can manually adjust the elevations grabbing and moving 
individual coordinates with the mouse. 

Elevations from terrain intersection 

A line object can be fit into the terrain in such a way that all intersections with 
elevation lines define the elevation of the line object.  

Select the objects you want to use for the Geo-Tool and open GEO-TOOLS -> MORE 

ELEVATION TOOLS -> ELEVATIONS FROM TERRAIN INTERSECTIONS.   
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For each selected line object, the program inserts the intersections to the objects 
that are fitted with elevations and sets the elevation in the selected object to the 
elevation of the object that is intersecting. Objects containing elevation 
information are elevation lines, roads, railway tracks, walls and the berm ground 
line. In the settings of the Geo-Tool, you can restrict the usage of intersecting 
objects to just elevation lines, then other objects that are not marked such as other 
roads will not interfere with the elevations of the objects to be set. 

Additionally, you can determine what to do with the original coordinates:  

• Delete the original coordinates 

• Interpolate the coordinates (only linear interpolation is possible)  

When you opt for the interpolation, the program will search for intersections in the 
extension of the line to produce an intersection with the known terrain. This 
extrapolation will set the beginning and end coordinate of the line to be 
interpolated as long as the program can find an intersection. In no intersection can 
be found, you have the choice to take over the elevation from the next possible 
intersection or to delete the coordinate. 

The default setting what to do with the original coordinates depends on the type of 
object. If only elevation lines are selected, “delete” is the default. SoundPLAN 
assumes that you want to generate extra elevation information to force the DGM 
to connect a ridge of the terrain with the basis. For this purpose, it would be 
difficult if the original terrain points would remain.  For all other line objects, we 
assume that you want to keep the original coordinates and have set the default to 
“interpolate”. 

Bridge detection 

The Geo-Tool Bridge Detection (GEO-TOOLS -> MORE ELEVATION TOOLS -> BRIDGE 

DETECTION) searches for brides in the course of roads or railways, for which the 
gradient is known. This means, the elevation of the given coordinates will not be 
changed.  
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Enter the MINIMUM BRIDGE LENGTH and the MINIMUM BRIDGE HEIGHT as search 
criteria.  

Use “Control bridges”, page 180 to verify the length and position of bridges. 

Coordinate transformation 

Coordinate transformation with rotation / reference points 

The GeoTool Coordinate Transformation offers two alternative transformation 
methods. The first method requires a fixed point for the rotation and a rotation 
angle; the second one uses transformation vectors as are used to initialize bitmaps. 

The transformation is a very useful tool to rotate entire groups of objects for 
example to reorient a planned industrial plant with sources and buildings. 

Select one or multiple objects and use the GEOTOOLS -> COORDINATE 

TRANSFORMATION (ROTATION / REF. POINTS). To rotate selected objects, enter the 
rotation angle and the coordinate around which the rotation shall be carried out 
(for example the corner of the plant). 

 

To move the data to their new location via the full transformation, open the tab 
General and enter at least 2 pairs of reference coordinates. 
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If you enter more than 2 pairs, you can also stretch the objects and correct them 
further. 

Transformation between coordinate systems 

For the work with SoundPLAN, it is not important which coordinate system you use. 
Knowledge of the coordinate system becomes important when you want to join 
data from different sources and suppliers or when you are asked to deliver results 
in a specific coordinate system.    

Define the project coordinate system (page 41), select all objects and select under 
GEOTOOLS -> TRANSFORM COORDINATES (SYSTEMS) if the object shall be transformed 
into the project coordinate system or if the project coordinate system needs to be 
transformed into a target system. 

In the first case, enter the point of origin in the existing coordinate system. In the 
second case, enter the origin of the target system. 

 

After the transformation, the screen will be empty because the coordinate 
range changed. Click on the Symbol “Zoom 100%” to get the coordinate range 

updated. You can verify the correctness of the transformation if you use the 
“Connection to online services” to show the area in question. If you transformed 
from your current project coordinate system to a new one, you must adjust the 
stored coordinate system to the new system in FUNDAMENTALS -> EDIT PROJECT 

COORDINATE SYSTEM before you can verify the transformation. 

Coordinate transformation during import 

The coordinate system is often defined in the import data. In order for the import 
data to be available in the desired coordinate system after the import, it may be 
necessary to perform a transformation during the import. 

The following combinations are possible: 

• Project coordinate system and coordinate system of the import data are the 
same: The import data is imported without transformation. 
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• Project coordinate system and coordinate system of the import data differ: 
You can change the coordinate system of the import data for the 
transformation. 

• No project coordinate system, but a coordinate system is defined in the 
import data: The coordinate system of the import data is displayed for 
information. You can use a check mark to specify a project coordinate 
system, which is pre-assigned with the coordinate system from the import 
data. If another coordinate system is to be used, select it in the selection list. 
The import data is then transformed into the desired system. 

• The project coordinate system and the coordinate system in the import data 
are defined, but the coordinate system of the import data was not 
recognized: In the dialog, you can choose a coordinate system for the import 
data. If possible, the definition of the coordinate system is displayed as text 
in the import data, from which you can optionally close which coordinate 
system is behind it. 

Road /Railway tools 

Location correction of the road master alignment 

Road / Railway alignments are available from various sources and in various 
qualities. For example, it is common that road alignments are divided into sections 
with common traffic characteristics and cross-sections, but they lack the accuracy 
of the master alignment.   

The accuracy of the alignments can be improved by combining the alignment with 
other geometrical data. The higher quality data must be available as object type 
lines (or converted to lines). As an example, Navteq data can be purchased to 
improve the geometrical accuracy (data used in navigation systems). 

Select the objects and invoke GEOTOOLS -> ADAPT ROAD / RAILWAY (Shift + Ctrl + S). 
Enter the maximum displacement within which the road alignment is corrected and 
fit to the geometrical course of the lines. Coordinates that are not moved because 
of spacing, are selected. Under HELP -> PROTOCOL both the moved and not moved 
coordinates are documented. 

Divide the road segments to small sections (5 - 10 m) so that they can be adapted 
to the line. 

 

Left: original situation, middle: road divided into sections, right: result 
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Center road axis 

If you have moved road edges, you can use GEOTOOLS -> CENTER ROAD AXIS to 
center the road axis between the road edges. The position of the emission lines and 
the road edges are not changed, only the distances in the tab cross section. 

 

Estimate multiple reflections (from RLS-90) 

(Only for roads) The Geo-tool ESTIMATE MULTIPLE REFLECTIONS checks according to a 
check line for homogeneous building situations on both sides of the road. If this is 
the case, the multiple reflection addition is calculated from the average height of 
the lower side and the average spacing of the buildings. For the length of the 
checking line, values between 10 and 50 meters are reasonable. 

At the position on the road where the multiple reflection addition changes the 
value, coordinates with the new multiple reflection addition are inserted. The 
elevation is interpolated between the existing points.  

    
Left: present situation, Right: with inserted points 

The program always assumes hard facades; the program only uses facades of 
buildings, not noise control walls. This addition can only be estimated for road 
noise levels derived from calculations, it cannot be incorporated for levels that are 
calculated elsewhere and set in the program. 

The parameters h and w calculated on the basis of the checking line are 
automatically displayed in the emission dialog, tab index card „additions" and the 
multiple reflection addition is calculated. 
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See multiple reflections (page 193) in chapter “Objects – Road master alignment” 

If you want to use another check line length you can reset the multiple reflection 
records with GEOTOOLS -> RESET MULTIPLE REFLECTIONS.  

Reset emissions for roads and railways 

With TOOLS -> RESET EMISSIONS FOR… you can reset the emission records that are 
the basis of the emission calculations (for roads for example traffic volume, speeds 
and corrections). You can keep the properties at the first coordinate of an object. If 
no objects are selected, the program will reset the emissions for all roads or for all 
railways. 

 

 Create geometry texts from object properties 

[Module Cartography] With this tool you can generate texts from any object. Mark 
the objects for which you wish to generate descriptive texts from the properties 
and call TOOLS -> CREATE GEOTEXTS FROM PROPERTIES.  

 

If needed, select a different object type and the property. If the desired property is 
not listed in the selection list, click on the wheel symbol and activate it in the 
“Selection of object properties (page 143)”.   

Under options choose the TEXT HEIGHT in [m] (world coordinates). For area type 
objects all other options are grayed out, the reference point for the text is always 
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the center of the area. For line type objects choose the VERTICAL ALLIGNMENT of the 
geo texts along the line, depending on the data entry direction. Another option is 
to have a vertical displacement (MOVE VERTICAL). For point type objects the texts by 
default will be placed to the right of the object, the vertical alignment is centered. 
For point objects the placement can be set with VERTICAL ALIGNMENT, or with MOVE 
HORIZONTAL / VERTICAL.  

The newly generated geometry texts „know" the object and the property they were 
generated from. If you generate a new geometry text for the same object and 
property, the previous text is deleted. 

Regenerate new object numbers 

Object numbers can be regenerated for a special area (selected objects) or for all 
objects included in the Situation in accordance with the format string. 

Select TOOLS -> OBJECT NUMBER and select whether you want to generate new 
object numbers for receivers, buildings or sources. SoundPLAN knows the last used 
object number for this object type and offers the next free number. Enter any 
number, in accordance to the format string. If the number does not correspond to 
the format string, SoundPLAN shows a message with the current format string. 

Separate objects that occur multiple times  

For each object to be relocated a new Geo-File is generated. The object with the 
lower object ID will remain in the original Geo-File while the one with the higher ID 
is placed into the new Geo-File. If a third identical object is found, this object is 
again placed in a new Geo-File. After the separation, go through the Geo-File list 
and decide about the objects to use and the objects to reject. 

Select the data that may contain multiple identical objects and trigger TOOLS -> 

SEPARATE MULTIPLE OBJECTS. 

After checking and finding the duplicates, you are asked to enter a name for the 
duplicate object Geo-Files. 

Pre-flight 

With the tool pre-flight it is possible to check data of the open Situation directly 
from the Geo-Database. Errors that would cause the Calculation core to abort are 
noted in a logbook along with all warnings you normally find in the calculation 
logbook. Select TOOLS -> PRE-FLIGHT to trigger the check of the geometry, the 
logbook will open automatically.  



 SoundPLAN Manual 8.1 
 Geo-Database 

Page • 180/793 Geo-Tools and Tools 

3 
 

It can be moved at will, even to a secondary screen. When clicking on a warning or 
an error message, the coordinate(s) where the warning/error was detected will be 
marked with circles. By double clicking the object zooms to its max size for a 
complete display.  

With a right mouse click you can select what the preflight shall note in the logbook. 
Errors always will be shown; hints and warnings are optional. 

 

Control bridges 

The logbook writes a protocol where bridges are found and what length the bridges 
have. 

As a warning for the user to check there are messages in the logbook about 
geometrical situations where the bridge is smaller than half the minimum length or 
is one of the embankments has an incline that is consistently smaller than 30°. All 
other bridges are inserted as a hint. Bridges having a warning associated with them 
should be manually checked.  

In addition to the logbook the 3D-graphics (Ctrl+F10) should be opened. With a 
double click on an entry in the logbook the program jumps to the position of the 
bridge in the 3D graphics, the view is rotated so that you see the bridge in the side 
view. 
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Load calculation run logbook 

A logbook can also be loaded from the calculation kernel in the logbook. This 
makes it easier to check and correct errors that occur during calculation. 

Open the logbook and load the log file for the calculation run where errors 
occurred from the results subdirectory in the project directory. The file has 

the same name and the same number as the calculation run, for example 
RSPSxxxx.log for a faulty single point calculation. 

Overview of short cut keys in the Geo-Database 
Additional: Abort screen refresh Esc 

Additional: Rotate Page up / down 

Additional: Zoom Arrow keys left / right 

Edit: Property Explorer Ctrl +E 

Edit: Change Geo-File assignment Ctrl +G 

Edit: Close object F2 (or double click) 

Edit: Convert object type Ctrl +U 

Edit: Copy Ctrl +C 

Edit: Coordinate operations Shift + Ctrl +K 

Edit: Delete Del key 

Edit: Insert Ctrl +V 

Edit: Mark all Ctrl +A 

Edit: Set objects to the DGM Shift + Ctrl +D 

Edit: Refresh view Ctrl +R 
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Edit: Select with object properties Ctrl +F 

Edit: Toggle extended view (object dots, settings …) F4 

Edit: Undo (Caution, not all actions can be un-done) Ctrl +Z 

Edit: Un-select  Ctrl +Q 

File: Open Situation  Ctrl +O 

File: Save Situation  Ctrl +S 

Fundamentals: Calculate the DGM  Ctrl +D 

Fundamentals: Connection to online map services Shift + Ctrl +O 

Geo-Tools: Adjust road / railway course Shift + Ctrl +S 

Geo-Tools: Clean up overlapping areas Shift +U 

Geo-Tools: Clean up wall ledges Shift +M 

Geo-Tools: Concatenate areas Shift +W 

Geo-Tools: Connect lines Shift + Ctrl +V 

Geo-Tools: Divide lines into segments Shift + Ctrl +L 

Geo-Tools: Filter Shift +Ctrl +F 

Geo-Tools: Interpolate elevations Ctrl +H 

Geo-Tools: Parallel object Shift +Ctrl +P 

Geo-Tools: Transform to project coordinate system Shift +Ctrl +I 

Geo-Tools: Transform out of project coordinate 
system 

Shift +Ctrl +A 

Insert a free point on a line or an area 
Digitizing mode (F12),  
Shift+ Ctrl + R.  mouse button 

Tools: Toggle between Edit and Digitizing mode F12 

Tools: Toggle right-angle mode on /off F11 

View: 3D-solid model Ctrl+F10 

View: 3D-wire frame model F10 

View: All objects  
Depending of prior selection 
or again with, F3, F5 or F6 

View: Current Geo-File F5 

View: Current object type F6 

View: Front view F8 

View: Only marked objects F3 

View: Rotate selected objects Shift +Ctrl +R 

View: Side view F9 

View: Top view F7 
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4  Objects and their Properties 

Some of the objects, especially the noise sources, noise barrier and ground effect, 
have special standard dependent properties. Please read the standard or ask your 
local distributor for details.  

 Road Alignments 
Roads are used in the acoustics as a line element. The road master alignment is 
entered with X and Y coordinates and the elevation of the road surface above sea 
level. The width of the road and the distance of the emission bands are defined in 
the tab index card Profile. The elevation of the emission band is computed 
automatically from the elevation of the road surface according to the used 
standard and is considered for the propagation calculation. 

Road properties 
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The properties menu for roads is divided into separate tab index cards for the noise 
emission, the kilometer post, the road cross section and the bridge definition. The 
kilometer post and reference line definition are the same for all the calculation 
methods. The emission properties depend on the calculation standard and are 
different for each of the calculation standards in SoundPLAN. 

Name, section and group 

The NAME describes the object; the SECTION NAME is used to further describe parts 
of a road. Both name and section are displayed in the road emission 
documentation. The SECTION ID can be used to assign a unique key for assignment 
of traffic data from external traffic nets. The road name can only be entered at the 
first coordinate of a road. If the road name changes in the course of the road, 
please define a new road. 

With the GROUP ASSIGNMENT (see “Using the group assignment of sources (page 
253)”) roads can be assigned to groups, for example roads under different road 
authorities. 

Kilometer posts and Reference line 

The km post  is used in the SoundPLAN Spreadsheet, in the emission table of roads 
and in Wall Design and can be displayed in the Graphics, if desired, together with 
the reference kilometer of a noise protection wall (Cartography).  

  

A kilometer post is assigned to each road coordinate together with the direction 
(ascending or descending). You can enter the kilometer post manually or let 
SoundPLAN calculate the distances. Activate the check box CALCULATED for the 
automatic calculation. As line objects are entered as straight lines in SoundPLAN, 
there might be differences between the calculation and the real world. Deactivate 
the automatic calculation in the course of the road entry, if needed, and enter a 
correct value. The automatic calculation is continued with the manually entered 
value. 
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View the kilometer in the Geo-Database with VIEW -> OBJECT OPTIONS or 
much faster click the symbol "with properties" (road as active object type).  

In order to use the kilometer in the Spreadsheet and in the Graphics, one road axis 
must be defined as REFERENCE LINE.  Activate the checkbox at the first coordinate of 
the road. 

 

If a reference axis is defined, it is automatically loaded in the Spreadsheet from the 
situation used in the calculation. If you want to assign a reference line later, use 
FILE -> ADD ADDITIONAL COLUMNS -> COLUMNS WITH FURTHER INFORMATION. You can 
change the Situation or Geo-File used with FILE -> TABLE CONTENTS.  

Emission documentation of roads 

The emission data of roads are documented in the Geo-Database via 
DOCUMENTATION -> ROAD (NOISE). The format of this table cannot be changed. A 
table for the road emission data is stored during a road noise calculation and is 
displayed in the Result Tables in the tab index card “Roads”.  

Cross sections / road profiles 

 
Entry of the road cross section 

Roads are digitized as line objects. The line depicts the road master alignment. For 
the acoustics calculations, the place of emission is not always the middle of the 
road. For the exact definitions of your standard, please read the standard. In the 
RLS 90 for example, the emission is placed in the middle of both outer lanes.  

 
Definition of road profile 
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Either select one of the predefined profiles or enter the lane width, the distances of 
the emission bands for both lanes, and the dimensions of the central reservation. 
Road profiles can also be asymmetric needed to define turning lanes.  

 
Examples for variations in the road profiles and the distances of the lanes 

The lane width is important for all standards where the roads are used as hard 
surfaces for the propagation calculation. With the setting CREATE GROUND EFFECT 

AREAS FROM ROAD SURFACES (calculation run properties, tab index card Settings) all 
roads are regarded as hard ground without the need to enter ground effect areas.  

The lane width is also used to display the roads in the Graphics. 

The position and elevation of the road edges can be taken into account for the 
calculation of the digital ground model (DGM) (page 124). Elevation information 
within the road bands are clipped from the meshing, so that the emission line 
cannot be beneath the terrain. 

 
DGM meshing with road edges, spot heights within the road band are not meshed 

The CENTRAL RESERVATION is symmetrically added to the right and the left of the 
road master alignment. 

Modify the road cross section graphically: When a road is activated for editing, the 
emission bands and the road edges can be moved manually. Emissions- and border 
lines themselves are not presented as „marked“ but the cursor will change in the 
proximity of the coordinates into the movement arrow. Emission and border line 
can be moved along a line marking the bisector between the last and the next 
coordinate. Road width and distance of the emission line to the master alignment 
are automatically adjusted in accordance to the manual movement of the 
coordinates. When the road is displayed with the view option HIGHLIGHTED the 
road surface is displayed as a gray band. Press Ctrl+ R (VIEW -> REFRESH) to update 
the display of the road. 
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Keep the Shift-key pressed to move emission line and road edge line 
independently. 

Single Emission Band  

If you don’t want to split the emission to the outer lanes, activate the check 
box SINGLE EMISSION BAND road at the first coordinate of the road axis. Roads 

with one single lane cannot be combined with roads with two emission lines. In this 
case a new road must be defined. Therefore, the check box single emission band is 
only available at the first coordinate of a road. Use the navigation bar to go to the 
first coordinate.  

For roads with one emission line, enter the LANE WIDTH to the right and to the left 
for ground effects and graphical display.  

 

Emission level calculation for roads 

The entries for the emission calculation of roads differ according to the used 
standard. The definition of the emission level may have different vehicle types, 
different emission heights or other corrections.  

The emission level can be calculated automatically from the emission parameters, 
directly entered or imported in the field LEVELS if the emission level itself is known.  

At all locations where the emission changes due to a change in traffic volume, road 
surface, traffic speed etc., the changes in the emission properties definition is 
stored. Each of the emission definitions is valid from the coordinate of origin to the 
end of the data string or to the place where a new definition is present. 

For roads with 2 separate emission bands, SoundPLAN assumes equal conditions in 
both lanes, so the emission level for both lanes will be equal. If this is not the case 
and you want to enter both lanes with different properties, you must define 2 
separate roads with single emission bands.  

To calculate the emission level from the number of vehicles, speeds etc., activate 
the check box CALCULATED and go to the tab index card Emission. As soon as the 
check box CALCULATED is active, you cannot enter the levels directly. 
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Depending on the calculation standard set in the SoundPLAN Manager, additional 
entry fields are displayed with the parameters needed in the standard. Please read 
the standard for details on the different standards or ask your local distributor.  

For the NMPB 2008 the emission calculation of the Nord2000 road can be selected 
to enable a more flexible definition of the emission coefficients. With this added 
flexibility it is possible to define your own vehicle types and configure them in their 
emission properties (for example to define 2-stroke and 4-stroke driven motor 
rickshaws for Southeast Asia). For details of the Nord2000 please read the road 
documentation from (on www.delta.dk search for User's Guide Nord2000 Road 
(2006)). 

The number of time slices is defined in the project options (SoundPLAN Manager 
OPTIONS -> SETTINGS), node "Emission time slices traffic noise (page 52)". 

Entry of the Traffic Volume 

 

The dialog for the entry of the traffic volume is the same for nearly all standards; 
only the number of vehicle types can vary.  

ONE-WAY TRAFFIC: Some standards need the information whether the traffic flows 
uphill or downhill. If the check box one-way traffic is clicked, the total traffic 
volume is in entry direction or versus entry direction, otherwise the traffic volume 
is divided symmetrically in both directions. 

The GRADIENT in % (see "Gradient Addition" (page 192) is calculated from the 
coordinates and displayed in the lower left corner in blue letters.  

The information driving on the left / right side might be important for two lane 
roads with gradient to decide which level is assigned to which lane. This parameter 

http://www.delta.dk/
http://www.madebydelta.com/imported/images/DELTA_Web/documents/TC/acoustics/Nord2000/av117106_Users_Guide_Nord2000_Road.pdf
http://www.madebydelta.com/imported/images/DELTA_Web/documents/TC/acoustics/Nord2000/av117106_Users_Guide_Nord2000_Road.pdf
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is entered in the SoundPLAN Manager under OPTIONS -> SETTINGS, branch 
"program". For your information the selection is displayed in the lower left corner 
in blue letters.  

Parameters for the emission calculation 

ADT [vehicles/24h]: Average daily traffic volume 

Vehicles/h: Traffic volume per hour for each of the time slices in total or separately 
for different vehicle types. 

k: Factors for the calculation of the hourly traffic volume from the ADT:  
k*ADT=vehicles/h for each of the time slices 

p[%]: Portion of the selected vehicle type at the total traffic volume per time slice. 

Road day histogram: The factors for typical road types are stored in the road day 
histogram library (page 311). There you can add any kind of temporal sequences.  

The k-factors (M/DTV) for individual road type in accordance to table 3 of the 
German RLS-90 are decoupled from the percentage of trucks so that own entries 
will not overwrite the road type and the percentage of trucks settings will remain 
when the road type is modified. 

Entry type 

Define the entry type with the selection list (the number in brackets indicates the 
number of the record; this is relevant for the import of traffic data): 

 

Road Day Histogram Library + ADT (0) 

The distribution of the traffic volume over time originates from the road day 
histogram library; the average daily traffic (ADT) is entered manually or imported. 

You will only see the library elements compatible to the selected emission 
standard. Press the button >> and open the library to edit elements, enter new 
elements or copy elements from another library.  

Portion of the ADT manually (1) 

The portions of the ADT are entered as factors and the heavy traffic portion is 
entered in per cent. 

If a road type of the road day histogram library has been selected, the hourly 
distribution is averaged to the time slices and converted into factors. 
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Vehicle/h from the industry day histogram library (2) 

For investigations of the traffic at industrial facilities or the traffic lanes of a parking 
lot a day histogram from the industry day histogram library can be assigned to each 
vehicle type. If you want to add elements to the industry day histogram library, 
click on the double arrow next to OPEN DAY HISTOGRAM LIBRARY. 

Vehicle/h manually (3) 

Enter the vehicles per hour for each vehicle type and each time slice or the total 
number of vehicles per time slice and the percentage of the vehicle types. 

Road Day Histogram Library + ADT + HT (4) 

Nearly the same as the entry type road day histogram library + ADT, but here you 
can correct the global portion of the traffic parts (e.g. portion of heavy traffic). The 
day histograms of the different vehicle types are scaled respectively i.e. multiplied 
with a suitable factor. 

There are two additional entry types for CRTN (UK): 12, 4, 8, and 18 hour data. 

Entry of Speed, Road Surface and Additions 

 

Enter the additional parameters for the calculation of the emission level in the 
fields of the next tab index card. 
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The SPEED is defined for each vehicle type and time slice. All other parameters (e.g. 
driving conditions, corrections for different road surfaces, age of road surface) are 
standard dependent and are therefore described in different sections. 

The displayed emission levels for the selected time slices are the average levels 
over the hours of the time slice. For the entry types where the road day histogram 
library is used, the emission is stored per hour, so that you can select assessments 
with any assessment time range definition. 

CoRTN specialties 

The input mask shows only the L10-emission values. The calculation of Leq-values is 
performed during the noise propagation calculation since it depends on the L10-
value at the receiver. 

 

The propagation calculation has been reworked and improved. Now all annexes of 
the CoRTN are fulfilled. 

On request an adopted version of the CoRTN for Australia (North South Wales) has 
been introduced.  
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This includes a new emission input which gives the user the possibility to split the 
emission of the truck over three source lines with user definable heights. The split 
is defined in the column Traffic [%]. With the column C[dB] the user can apply a 
correction for each source line to consider for example corrections due to 
measurements. 

For the noise propagation calculation two options are available for the CoRTN in 
the standard details (calculation kernel).  

Gradient Addition 

The rate of incline is usually calculated from the elevation of the coordinates. 

Depending on the used emission standard, the gradient addition might lead 
to very high additions and thus wrong calculation results. Therefore, it is 

visualized in the Geo-Database. Please activate the object option "with properties" 
for roads in the object options. 

 
5-10 %   "<" or ">" 
>5 - 10 %  "<" or ">" 
>10-15 %  "<<" or ">>"  
>15%   "<!!!>"  

The calculation kernel returns an error message if the gradient is higher than 30%. 
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You can also use EDIT -> SELECT ROAD SEGMENTS WITH GRADIENT > |X| % to find 
sections with implausible gradients. 

During the calculation (tab Emission in the road standards) the gradient is by 
default averaged over a reference line of 15 m. 

Multiple reflection 

The multiple reflection addition included in most of the emission dialogs is 
described in the German RLS-90. For other emission calculations, it is a deviation 
from the standard. However, it may be good practice. Multiple reflections in street 
canyons are added as a correction on value to the LME. In this case, the 
propagation calculation may only evaluate the first reflection as otherwise the 
multiple reflections would be overcompensated. The multiple reflections depend 
on the average building height of the lower side of the street (hBeb[m]) and width 
(w[m]) of the street canyon, as well as on the average reflection loss. The reflection 
loss only distinguishes between reflective and absorbent walls. 

Reflecting surfaces: 

Drefl = 4 * Height of walls / Distance of retaining walls =< 3.2 dB 

If the walls have been built with absorbent material, the formula changes to: 

Drefl = 2 * Height of walls / Distance of retaining walls =< 1.6 dB 

Multiple reflections can be set automatically with the GeoTool ESTIMATE MULTIPLE 

REFLECTIONS for bigger communities, but only if the multiple reflection addition is 
part of the emission dialog of the selected standard. 

Road bridges 

The bridge definition uses its own tab index card. Activate the check box bridge at 
the first coordinate of the bridge and enter the distance between the axis and the 
bridge edge (left and right from the axis) and, if necessary, the height of a screen 
on the bridge above the gradient.  

 

Deactivate the bridge check box at the end of the bridge again.  
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The bridge surface is calculated at a right angle to the master alignment. If this 
doesn't correspond to the actual situation, the bridge must be prolonged. 

 

Please observe the following characteristics: 

• Elevations below the bridge are recognized as terrain for the DGM 
calculation. 

• Bridge bottom and bridge thickness are not reflective (except for ASJ Japan).  

• If CREATE GROUND EFFECT AREAS FROM ROAD SURFACES is checked in the 
calculation run properties, the bridge surface is recognized as hard surface. 

Bridges are visualized in the Geo-Database as a black band. 

 

Modeling of bridges 

In case you must model bridges for multiple single lane roads, SoundPLAN expects 
the bridge definition for each lane. The individual bridges should overlap if it is one 
bridge in the model.  

   

Walls on bridges 

You can enter walls on bridges in the bridge tab index card. If noise protection walls 
come from outside the bridge and continue on the bridge you are more flexible if 
you define only the bridge plate and enter the wall outside the bridge and a wall on 
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the bridge as one noise protection wall, on the bridge with the characteristics WALL 

FLOATS ABOVE GROUND see "Wall Properties" (page 266).  

The reflection properties of bridge walls are similar to the properties of noise 
protection walls (page 267). For spectral assessment of the reflection loss for 
standards that calculate the noise in frequency bands rather than as a mean 
frequency, the absorption spectra from the library are used. Activate the selection 
list for which you want to assign an absorption spectrum and click on the library 
button. 

Maximum Level Road 

LMAX-ROAD: This represents a maximum noise level of a single vehicle pass by (in 
general a truck). Depending on the receiver location the maximum noise level can 
be caused by different roads. At the moment the Lmax-road is only used in the 
standards „Statens planverk report no. 48; 1980“ and „Road Traffic Noise – Nordic 
Pred. Method; 1996“.  

 Signal - Intersection Addition only RLS-90 
The signal addition accounts for the increased annoyance of traffic noise close to a 
traffic signal. As the physical effect is hardly measurable, the addition is very 
questionable. However, as it is part of the RLS 90, it is part of SoundPLAN.  

Depending on the distance between the receiver and the traffic signal, the addition 
is between 1 and 3 dB(A).  

The signal object is placed at any position within the junction at the same elevation 
as the road (e.g. using the right mouse menu „Capture Coordinate“ on a coordinate 
in the intersection).   
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The traffic light can be active all day (0:00 to 24:00), during day time (6:00 to 22:00) 
or during night time (22:00 to 6:00).  

Enter the intersection points in the preview box to the right at the intersections of 
the outer traffic lanes (emission lines). For T-junctions please enter also four signal 
marks.  

On the basis of the signal marks the roads concerned are determined during the 
calculation within a horizontal distance of 5 m and a vertical distance of 2 m.  

The intersection addition is assigned if the 3-dimensional distance between the 
nearest signal mark and the receiver is within the following intervals: 

   0 m to   40 m => + 3.0 dB(A) 

from 40 m to   70 m => + 2.0 dB(A) 

from 70 m to 100 m => + 1.0 dB(A) 

All roads connected with the traffic light by the signal marks get the addition of the 
nearest signal mark.  

Delete signal marks: click on the signal mark in the list and press the delete key. 

 Parking Lots 
Parking lots are area sources with a uniform sound power. Enter the outside border 
with the elevation of the asphaltic surface. SoundPLAN adds 0.5 meters for the 
source height above the terrain. The parking lot is triangulated at calculation time.  

If sections of the parking lot are used by different vehicle types or the usage of the 
parking lot is not uniform, subdivide the parking lot into homogenous units e.g. 
with the Geo-Tool "divide areas (page 159)".  

Enter a NAME and, if necessary, an OBJECT NUMBER for sorting the sources. 

With the group assignment for parking lots according to the Bavarian parking lot 
study (see “Using the group assignment of sources (page 253)”) parking lots can be 
assigned to groups.  

Calculation of the emission level of parking lots 

Depending on the propagation calculation you selected in the SoundPLAN Manager 
with OPTIONS -> SETTINGS, the emission is calculated according to RLS-90 
(propagation calculation RLS-90) or the Bavarian parking lot study (all other 
industrial calculation methods). The propagation is calculated according to the 
selected standard. To change the emission calculation for parking lots, you need to 
close the Geo-Database in order to activate the new setting. It is not possible to 
mix the calculation standards (parking lot A according to RLS-90, parking lot B 
according to the Bavarian parking lot study). 



SoundPLAN Manual 8.1 
Objects and their Properties 

Parking Lots  Page •  197/793 

4 

Parking lot RLS 90 

The calculation is performed in accordance with the 16th and 18th Federal German 
Immission Regulation.  

 

The traffic volume of a parking lot is entered with the number of parking bays and 
the movements per parking bay and hour. The number of movements can be 
defined by a day histogram in events per hour or by the movements per time slice 
day and night. 

One parking action (into a parking bay and out of the parking bay) is 2 parking 
movements. 

The ADDITION FOR THE PARKING LOT TYPE considers the different emissions of the 
vehicle types: 
Car parking:    0 dB 
Motorcycle parking:   5 dB 
Truck and bus parking:  10 dB 

The addition is automatically added to the emission level. If you have evidence that 
the additions do not fit your situation, the field „own entry“ allows you to enter 
and document your own values. 

The result is the LmE of the total parking lot in a distance of 25 m. 

Parking lot study 2007 

The 6th revised edition of the parking lot study “Recommendations for the 
Calculation of Sound Emissions of Parking Areas, Motorcar Centers and Bus 
Stations as well as of Multi-Storey Car Parks and Underground Car Parks” published 
by the Bavarian Landesamt für Umwelt provides calculation methods to determine 
the emissions of parking lots. The document is on the SoundPLAN installation DVD 
and can be downloaded from the web 

(www.laerm.ch/dokumente/Parking_Area_Noise.pdf). 

http://www.laerm.ch/dokumente/Parking_Area_Noise.pdf
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Hint: In this manual and in SoundPLAN we use the terms "parking lot" and "parking 
bay" instead of "parking area" and "car park". 

The emissions depend on the type of vehicles, the number of parking moves during 
the different time slices, the behavior of people and other noise on the parking lot 
(e.g. rattling of the shopping trolleys). 

The parking lot study 2007 provides the calculation methods "integrated method" 
and "separated method". 

The general case („integrated method“) assesses the driving lanes as part of the 
overall noise emission level. This method calculates levels "on the save side". 

The special case („separated method“) discounts the driving lanes from the 
parking lot and requests they be modeled separately as line sources or roads. The 
results of this method are lower or equal to the general case. This method is often 
used for big parking lots or if a parking lot can be divided into separate parts. 

The base value for one car parking move per parking bay and hour is a sound 
power of LW0 = 63 dB(A). Additions for the parking lot type KPA, noise peak KI (e.g. 
German TA-Lärm), driving lanes KD and the road surface KStrO (both parameters only 
for the combined method) are added. 

The displayed Ref. Lw is calculated according to the formula 

Ref. Lw = 63 + KPA + KI + KD + KStrO + 10*log (B) 

The number of parking movements N is only taken into account from the day 
histogram during the calculation.  
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According to the selected PARKING LOT TYPE the addition for the parking lot type 
(KPA) and for impulsiveness (if present) are automatically added.  

The reference value BASE B defines the size of the parking lot. Hereby the UNIT B0 

should be noted. The UNIT B0 is preset by the parking lot type (1 parking bay, m2 
sales area, m2 restaurant area or 1 bed) but can generally be changed to1 parking 
bay. The number of the parking bays of the total parking lot is f*B; f is a prescribed 
value of the parking lot study. 

To fit the different base units into the formula for calculating the noise emission, 
they needed a “factor of adjustment”. This factor called “f” is to refer the base unit 
back to “one parking bay”. In case of a supermarket, f is 0.07, which means 0.07 
parking bays for each m2 sales area. “f” is fix because the parking lot study defines 
it precisely. 
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This is because the authors of the parking lot study did a lot of countings at 
different parking lots (documented in the parking lot study). They found out that 
the number of vehicles is not always linked to the number of parking bays. 
Especially supermarkets out of town often have a lot of parking bays – more than 
they need. In this manner the parking lot always looks empty and people think they 
won’t have to spend much time at the supermarket checkout. The unit “m2 sales 
area” is much more suitable in this case. 

Regardless of the parking lot type you can always choose the base unit “1 parking 
bay” if the factor f doesn’t fit to the parking lot in question. 

The selection of the ROAD SURFACE (this is the surface of the driving lanes, not the 
surface of the parking bays) defines the addition KStrO. 

The traffic volume is defined with a day histogram in events per hour (E/h). The 
values must match with the number of parking moves per unit B0 and hour. One 
parking action (into a parking bay and out of the parking bay) is 2 parking moves. 

Example:  B0 = 1 parking bay: the values of the day histogram must match with 
the parking actions per parking bay and hour.    

 B0 = 1m² net sales area: The values of the day histogram must match 
with the number of parking actions per m² sales area and hour. 

The estimated values from the parking lot study (table 33) can be entered directly 
into the day histogram. 

The parking lot can be calculated with a CENTER FREQUENCY of 500 Hz, a TYPICAL 

SPECTRUM, or an OWN SPECTRUM.  

 TYPICAL SPECTRUM refers to a frequency spectrum for "starting car" normalized to 
the reference level of 63 dB(A) 

 Sum 

63 

Hz 

125 

Hz 

250 

Hz 

500 

Hz 

1 

kHz 

2 

kHz 

4 

kHz 

8 

kHz 

16 

kHz 

dB(A) 63,00 46,34 57,94 50,44 54,94 55,04 55,44 52,74 46,54 33,74 

Activate the check mark SEPARATED METHOD to change to the special case 
calculation which doesn’t include a surcharge for the driving lanes (KD + KStrO).  

In this case you need to model the driving lanes and the additions for the surface of 
the lanes separately. Either use the object types road or line source. The 
propagation calculation is done according to the selected road or industry standard 
(the parking lot study refers to RLS-90 and ISO 9613-2). For a line source, you can 
use, for example, emissions of LWA = 47.8 dB(A)/m for cars (referring to the RLS-90) 
or LWA = 63 dB(A)/m for trucks and busses according to the Hessian truck study 
2005. You can enter the driving lanes on top of the parking lot, it is not necessary to 
cut them out from the parking lot. 
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Activate the check mark OWN CORRECTION KI INSTEAD OF DEFAULT VALUE if the 
addition for the noise peak does not equal the default values from the parking lot 
study.  

The field STANDARD DEVIATION FOR LW SIGMA allows to enter a value to calculate 
the uncertainty of a prognosis (page 225).  

The right-hand part of the dialog shows the additions and visualizes the day 
histogram and the spectrum. The day histogram is not included in the displayed 
sound power (Ref Lw) and is therefore only an intermediate value for the 
calculations.  

Important: Enter the parking lot surfaces additionally as ground effect areas. 

Additions 

Additions for parking lot type and noise peak: 

 Addition in dB(A) 

Parking lot type KPA KI 

Car parking lots   

P+R parkings, parkings at house estates, visitors and 
staff parkings, parkings at the city border 

0 4 

Parking lots at shopping centers   

Normal shopping trolley on asphalt 3 4 
Normal shopping trolley on cobbles 5 4 
   

Low noise shopping trolley on asphalt 3 4 
Low noise shopping trolley on cobbles 3 4 

Parking lots at discotheques (incl. noise from talking 
and car radios) 

4 4 

Restaurants 3 4 

Fast food restaurants 4 4 

Central bus stops   
Busses with diesel engine 10 4 
Busses with natural gas engine 7 3 

Parking lots for trucks 14 4 

Parking lots for motorbikes 3 4 

The traffic is calculated according to:  

KD = 2,5∙lg (f∙B - 9) [dB(A)] for f∙B > 10 
KD = 0 dB(A)  for f∙B ≤ 10 
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Additions for parking lot surfaces: 

Lane surface 

Additions KStrO in dB(A)  

Combined  
method *) 

Separated  
method **) 

Asphaltic lanes 0 *) 0 

Concrete paving with joints ≤ 3 mm 0,5 *) 1,0 

Concrete paving with joints > 3 mm 1,0 *) 1,5 

Water bound surface (gravel) 2,5 4,0 

Natural stone paving 3,0 5,0 

*)  Not for parking lots at shopping centers 
**)   The addition must be taken into account for the separate modeling of the driving lanes 

Maximum level parking lot 

Enter the maximum level to calculate the Lmax of a parking lot. Make sure that the 
Lmax is defined in the used assessment library element and check mark Lmax 
industry in the tab index card "assessment" in the run properties of the calculation 
kernel.  

The Bavarian parking lot study includes information on typical maximum levels at 
parking lots: 

 

 LWA,max in dB(A) 
 Accelerated  

pass-by 
Closing doors 

Closing 

tail gate/  boot lid 

Noise from 
compressed air 

Car 92,5 97,5 99,5 - 

Motor bike 98,5 - - - 
Bus 105,5 96,5 - 102,5 

Truck *) 103,5 98,5 (100) - 103,5 (110) 

*) The values in brackets are added from the Hessian truck study 2005 

 Railways 
The track master alignment is entered with the coordinates and the elevation of 
the rail head as reference elevation.  
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The emission elevation(s) are calculated from the elevation of the rail head 
according to the terms in the standard. 

The railway alignment can be taken into account for the calculation of the digital 
ground model. To do so you need two additional DGM parameters see 
“embankment alignment for road and railway in the DGM (page 124)”.  

Multiple Tracks 

Multiple tracks are defined as a set of single track railway lines. Enter geometry and 
properties for one track first, duplicate the track with the GeoTool "Create a 
parallel object" (page 157) and adjust the number of trains for the duplicated 
tracks.  

Railway Properties 

 
Railway properties 

Aside from the emission level calculation with the vehicle and track specific 
correction factors you also define the kilometer posts and a reference axis in the 
railway properties. 

With the group assignment (see “Using the group assignment of sources (page 
253)”) railways can be assigned to groups. 

For the documentation of the emission calculation you can enter the name of the 
railway, the track number, the direction and a status present or future. 

The rail track can be included in the calculation of the digital ground model. You 
will need two additional DGM parameters for this, see "Embankment alignment for 
road and railway in the DGM (page 124)". 
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Kilometer posts and reference axis 

The km post  is used in the SoundPLAN Spreadsheet, in the railway emission 
documentation in the Geo-Database (DOCUMENTATION -> RAILWAY) emission table 
of roads and in Wall Design and can be displayed in the Graphics, if desired, 
together with the reference kilometer of a noise protection wall (Cartography). 

   

A kilometer post is assigned to each road coordinate together with the direction 
(ascending or descending). You can enter the kilometer post manually or let 
SoundPLAN calculate the distances. Activate the check box CALCULATED for the 
automatic calculation. As line objects are entered as straight lines in SoundPLAN, 
there might be differences between the calculation and the real world. Deactivate 
the automatic calculation in the course of the road entry, if needed, and enter a 
correct value. The automatic calculation is continued with the manually entered 
value. 

 

View the kilometer of the reference axis in the Geo-Database with VIEW -> 

OBJECT OPTIONS (activate the PROPERTIES) or click the symbol "with 
properties" (railway as active object type).  

To use the kilometer in the Spreadsheet and in the Graphics (e.g. for the animated 
train pass-by), one railway axis must be defined as REFERENCE AXIS.  Activate the 
checkbox at the first coordinate of the railway. 

 

If a reference axis is defined, it is automatically loaded in the Spreadsheet from the 
situation used in the calculation. If you want to assign a reference line later, use 
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FILE -> ADD ADDITIONAL COLUMNS -> ADD ADDITIONAL INFORMATION COLUMNS. You 
can change the Situation or Geo-File used with FILE -> TABLE CONTENTS. 

Emission Documentation Railway 

  The emission calculation of railway tracks is documented in the Geo-Database via 
DOCUMENTATION -> RAILWAY. You can preview and print the emission table (table 
of trains and resulting emission level) and the emission succession table (changes in 
the emission level because of track specific corrections) separately or as a complete 

printout including all information. It is also possible to export the tables to ASCII  

or copy them to the clipboard .  

 

Define the page layout for the final printout of the emission level documentation. 
The page layout is a central function in SoundPLAN used for all printouts. It is 
described in the chapter “Result Tables”, section “page layout.” 

Emission Level Calculation Railway 

The entries for the emission calculation differ according to the used standard. The 
definition of the emission level may have different vehicle types, different emission 
heights or other corrections.   

The emission level can be calculated automatically from the emission parameters, 
directly entered, or imported if the emission level itself is known.  

At all locations where the emission changes due to a change in corrections, speed 
etc. the changes are stored in the course of the railway axis. Each of the emission 
definitions is valid from the coordinate of origin to the end of the data string or to 
the place where a new definition is present. 
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Enter known emission levels in the lower part of the tab index card Emission. Track 
specific corrections can also be added for known emission levels. Please check 
whether the known emission levels already include possible track specific 
corrections.  

The emission table shows the levels with and without corrections. In some 
standards, the corrections are displayed separately.  

To calculate the emission level, activate CALCULATED in the railway properties and 
go to the tab index card Emission to enter the train data and the corrections. As 
soon as the check box CALCULATED is active, you can no longer enter the levels 
directly. 

Depending on the calculation standard set in the SoundPLAN Manager, additional 
entry fields are displayed with the parameters needed in the standard. Please read 
the standard for details on the different standards or ask your local distributor. 

Train data 

 

Click twice on the first field of the table to open the selection list of the train types 
defined for the selected standard in the train library.  

When selecting one of these trains, the default settings, such as maximum speed 
and train dependent corrections are copied from the library.  

You can enter a TRACK SPEED for the train track. As soon as a train speed from the 
library is higher than the maximal track speed, the speed is lowered, and the 
emission is calculated for the track speed. 

Complete the emission table with the number of trains or units per train N for each 
time slice.  

Use the button TRAIN SETUP to define own trains in the library. 
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Track dependent additions 

The standard dependent track specific additions are defined in the tab index card 
corrections. 

This may be, for example, the following corrections: 

• Addition for the track bed [dB] 

• Addition for the track joints [dB] 

• Addition for the track condition [dB] 

• Addition for crossings [dB] 

• Addition for bridges [dB] 

• Addition for curve squealing [dB] 

• Multiple reflection, see page 193. 

 

Railway bridges 

The bridge definition uses its own tab index card. Activate the check box bridge at 
the first coordinate of the bridge and enter the distance between the axis and the 
bridge edge (left and right from the axis) and if necessary, the height of a screen on 
the bridge above the gradient.  
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Deactivate the bridge check box at the end of the bridge. The bridge surface is 
calculated at a right angle to the master alignment.  

 

Please observe the following characteristics: 

• Elevations beneath the bridge are recognized as terrain for the DGM 
calculation. 

• Bridge surface, bridge bottom and bridge thickness are not reflective 
(except for ASJ Japan).  

• Bridges are visualized in the Geo-Database as a black band. 

 

Modeling of bridges 

In case you must model bridges for multiple single lane railway tracks, SoundPLAN 
expects the bridge definition for each track. The individual bridges should overlap 
if it is one bridge in the model.  
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Walls on bridges 

You can enter walls on bridges in the bridge tab index card. If noise protection walls 
come from outside the bridge and continue on the bridge you are more flexible if 
you define only the bridge plate and enter the wall outside the bridge and a wall on 
the bridge as one noise protection wall, on the bridge with the characteristics WALL 

FLOATS ABOVE GROUND see "Wall Properties" (page 266).  

The reflection properties of bridge walls are like the properties of noise protection 
walls. For spectral assessment of the reflection loss for standards that calculate the 
noise in frequency bands rather than as a mean frequency, the absorption spectra 
from the library are used. Activate the selection list to which you want to assign an 
absorption spectrum and click on the library button. 

Lmax-railway (pass-by level) 

The pass-by level Lmax can be calculated for all railway standards where the check 
box Lmax is available in the emission calculation in the Geo-Database. Some of 
these standards allow more than one train for the Lmax calculation (more than one 
Lmax check box can be activated in the emission calculation).  

You can either calculate single points or a Grid Noise Map for the train pass-by. The 
Grid Noise map can be displayed as a 2D or 3D animated noise map [module 3D 
Graphics Animation]. Read 2D and 3D animated noise map (page 642) for details. 

Select the train(s) for the maximum noise level in the emission calculation for 
railway, add the time slice Lmax railway in the assessment library element, and 
check mark the LMAX RAILWAY in the tab index card assessment. To display the 
level-time chart in the result tables check mark the LEVEL CHARTS in the tab index 
card SPS in the calculation properties. 

Emission 

The train is regarded as a moving line source. The length of the line source is the 
length of the train. The length related emission of the line source is related to the 
Leq emission of the trains.  
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Whereby 

V, v: Train speed [km/h], [m/s] 

N, n: Number of trains per hour, second 

L: Train length [m] 

Leq, Lmax: Leq, Lmax -Emission of a train type 

For standards which allow the emission calculation separately for engine and 
wagons, the emission is calculated in train sections (e.g. for Schall 03-2006). In this 
case the train must be entered according to the train composition.  

As the emission is evenly distributed on the whole train or the train sections, 
effects due to inhomogeneity and increase the Lmax level cannot be described by 
this method. The smaller the distance receiver to track is the higher is the 
difference between the real and the calculated Lmax level.  

Pre-calculation 

From each point along the track to the receiver, transmission losses and elapse 
time (due to the finite speed of sound) are recorded for the direct sound as well as 
for all possible reflection paths. 

Calculation of the level-time history for one train pass-by 

The position of the line source is now iterated along the whole track. The time 
window is about 125 ms between two steps. Therefore, the step size depends on 
the train speed. The level time history at the receivers is determined by integrating 
over the whole train length considering the Lmax emission, the transmission losses 
and the elapse time. 

Lmax, Lmax statistics 

The highest level in the level time history is the Lmax level. If N trains run on this 
track in the time slice day, evening or night, N occurrences are assigned to the level 
class Trunc(Lmax)…Trunc(Lmax)+1 of this time slice. The level time history is 
calculated for all tracks. The occurrences are added to the corresponding level 
classes. If a railway A reaches a switch and branches into k railways, this 
corresponds to k tracks each of them from the beginning of railway A to the end of 
each railway after the switch.  

Generating tracks for calculation of Lmax-Rail 

From the entered railways SoundPLAN tries to build up tracks to be used for Lmax 
calculation. The first and last coordinate of a railway is declared as a knot. If two 
railways have the same first or last coordinate (within a tolerance of 1 cm) they are 
linked to the same knot. Now each of the knots might have some ingoing links to 
knots and some outgoing links to knots, depending on the direction of entry. 
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Trains always travel in the direction of entry. The direction of traveling is very 
important because the speed of trains and the speed of sound are taken into 
account (except Nord2000 simplified Method). 

Tracks are built up by following the knot links, starting at a knot which has only 
outgoing links. 

Examples (the letters stand for knots; the arrows are links to knots): 

 

will lead to the two tracks: A>B>C>E and A>B>D>F  

 

will lead to the two tracks: E>B>A and F>B>A 

The knot B represents a switch. 

If the railways are entered the way that there is no knot having only outgoing links, 
there is no track at all. Therefore, these trains won’t contribute to Lmax at all!  

 

If a train object is travelled by trains in both directions, you should actually create a 
parallel train object (with a distance of more than 1 cm) and invert direction of 
entry. For tracks with switches, this is absolutely mandatory. 

 

The best way to check that all trains have been correctly recognized is to calculate a 
Grid Noise Map or an animated noise map. 

Level time chart 

The level time chart is available in the Result Tables.  
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Open the level-time-chart in the calculation results under the tab Details + 
Graphics. By right clicking -> DIAGRAM PROPERTIES you can switch the scaling of the 
level axis from the auto setting to a fixed scale and can disable the curve depicting 
the speed of the noise increase. 

You can store the diagram in various graphics formats by right clicking and selecting 
the option -> SAVE DIAGRAM. 

You can also calculate the pass-by of a train as a grid noise map and display it as an 
animated noise map [module 3D Animation], see “2D and 3D animated noise map 
(page 642)”.  

 Tunnel openings 
With the object for tunnel-openings the emissions of roads and railway lines inside 
the tunnel are used to determine the sound power and directivity of the 
propagation of noise from the tunnel opening. From the geometry of the tunnel 
opening, the length of the tunnel and the absorption properties close to the tunnel 
opening the program calculates the sound power which is then assigned to four 
point sources in the opening. The directivity is considered. The procedure is based 
upon the Nord2000, in the annex of his paper you can find literature references. 
The tunnel opening is not suitable for underground car park entrances or similar. 
Such objects should be modeled with area sources at an industrial building.  

The propagation direction from the coordinates of the tunnel opening is to the left 
as seen in the direction of entry of the coordinates. If the object is to be displayed 
with properties, as soon as it is closed with F2, the propagation direction of the 
tunnel is shown on screen. When opening the tunnels properties, you can change 
the propagation direction of the tunnel by clicking on ADJUST GEOMETRY, or via the 
right click menu with -> CHANGE INPUT DIRECTION.  
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This plan shows the increase of noise levels due to the noise emitted from the 
tunnel opening: 

 

The calculation regards the different directivity for road and railways and therefore 
is done separately for roads and railways.  

All roads or railway lines intersected by the tunnel opening are contributing to the 
emission of the tunnel. The program uses the local emissions at the tunnel opening, 
so any changes of the emission further in the tunnel will not have any influence on 
the sound power at the tunnel opening. The emissions inside the tunnel are 
summed up as L’w, the sound power per meter, which is used to determine the 
sound power handed over to the 4 substitute sources in the tunnel opening. In the 
tunnel opening the program inserts a coordinate, the section inside the tunnel does 
not contribute to the outside contribution.   

For roads or railways intersecting the tunnel opening multiple times, only the first 
intersection is relevant. 

The 4 point sound sources in the tunnel opening each have LwT – 10 log(4) as the 
sound power.  

The propagation of the four point sources is done according to ISO 9613-2, except 
for TNM roads (TNM industry), Nord2000 roads and railways (Nord2000) and NMT-
96 railways (General Prediction Method). 

Properties of the tunnel opening 

The tunnel opening is defined with a line consisting of 2 coordinates. After the 
entry of the first coordinate the properties dialog for the tunnel itself is started, 
however the entries for the tunnel are only generated after the second coordinate 
is entered. This line must intersect the road-alignment or railway alignment 
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(multiple road or railway lines are also possible) in order to take over geometry and 
emissions from the road/rail into the tunnel opening.  

 

For the SHAPE of the tunnel opening select either a semi-circle or a rectangle. The 
WIDTH of the tunnel opening is first taken from the length of the line; however, it 
can be refined via the control ADJUST GEOMETRY. For the form „semi-circle" the 
radius is automatically calculated, if you select the form „rectangle“ you need to 
enter the HEIGHT. BASE HEIGHT is calculated from the intersection between the 
tunnel opening and the road/railway axis. 

The tunnel can be acoustically split into 2 sections, the area directly behind the 
portal, which often is clad with acoustics panels and the area further into the 
tunnel that most often is left acoustically hard. For the acoustical description of the 
walls, SoundPLAN supplies 4 typical cases with the sound absorption coefficient α, 
see “Formulas for the calculation of tunnel openings (page 216)”.  

With 2 separate tunnel portals for a road with 2 separate lanes, 2 separate tunnel 
openings must be defined. To connect the tunnel opening with the road, the 
following procedure is to be followed: First enter the tunnel opening over the 
master alignment of the road, then open the object definitions and move the 
tunnel opening with ADJUST GEOMETRY. Although the tunnel opening may not 
intersect with the road alignment any longer, the connection between road and 
tunnel is made. Repeat this procedure with the second tunnel opening. 
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Adjust geometry  

 

The tunnel opening width (portal width) is extracted from the length of the 
digitized tunnel opening, the base height is derived from the intersection between 
tunnel opening and road/railway alignment. Both values can be adjusted here. 
When the DISTANCE TO AXIS is 0 m, the tunnel opening is located centrally over the 
road/railway. For separate tunnel openings for both directions of the road, one of 
the distances to axis must be a positive number while the other must be negative. 
The tunnel opening can be moved by clicking on the ADJUST button.  

 

With the checkmark REVERSE EMITTING DIRECTION, the tunnel opening can be 
reversed.  

Particularities for the object type tunnel opening in the Graphics 

A separate object type is delivered for the display of the tunnel opening in the site 
map of the Graphics. In order to show the emitting direction, the symbol is twice as 
large as the tunnel opening. As a default the factor is set to 2 in the base settings of 
the object type. 

   
If you want to use another symbol for the tunnel opening (e.g. a semi-circle), please 
change the factor (size) to 1, in order to display the correct size of the tunnel 
opening.  
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The 3D Graphics uses a semi-circle or a rectangle, depending on the selected form 
of the tunnel opening in the Geo-Database.  

Formulas for the calculation of tunnel openings 

The noise transmission loss (as a factor not in dB) from a stationary source in a 
distance to the tunnel opening is defined as [1]: 

For tunnels with a semicircular cross-section: 

 

For tunnels with rectangular cross-section: 

 
With 
R: radius of tunnel [m] 
wT: half the width of the tunnel opening [m] 
h: height of tunnel [m] 
a: parameter defining the average absorption of the tunnel (0<=a>=1) 

in general:   

where α is the sound absorption index of the walls of the tunnel. 

Typical values for α 

Frequency range [Hz] <160 160-400 >400-1250 >1250 

Smooth concrete surfaces; 
Roads or reflecting ballast bed 
Reference case for directivity 

0.08 0.08 0.08 0.08 

Rough concrete surfaces; 
Roads or reflecting ballast bed 

0.08 0.11 0.14 0.14 

Concrete surfaces; 
Ballast beds for railways 

0.1 0.2 0.3 0.3 

Typical sound absorption material 0.15 0.5 0.8 0.65 

If a line source in the tunnel is regarded with a sound power per meter L’w , the 
total sound power radiated from the tunnel mouth is: 

 

With 

L:  length of tunnel [m] 



SoundPLAN Manual 8.1 
Objects and their Properties 

Tunnel openings  Page •  217/793 

4 

If L’w is constant within the tunnel: 

 

When the tunnel opening is built with absorption material it can be stated [2]: 

 

With 

a1:  Absorption parameter in area 1 (0..x1) 
a2:  Absorption parameter in area 2 (x1..L) 
x1:  distance between tunnel opening and the transition from area 1 and 2 

When L’w is constant within the tunnel: 

 

Directivity 

For roads a directivity correction factor (Φ) is calculated. For the reference case 
(smooth concrete surfaces) this correction is: 

Angle Φ [deg] Frequency range [Hz] 

 <160 160-400 >400-1250 >1250 

0 3 5 6 7 

15 3 5 5 5 

30 3 4 4 4 

45 3 3 2 1 

60 3 2 0 -2 

75 2 -3 -6 -7 

90 -2 -10 -17 -19 

105..180 -6 -24 -26 -27 
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For the Non-reference case the difference level  between 
the sound power in the tunnel opening and for the reference and the non-
reference case is set and the directivity is set according to the table below. 

 

Values for all other angles derived by linear interpolation. 

Literature 

[1] K. Takagi et.al., Prediction of Road Traffic Noise around Tunnel Mouth Proc. 
Internoise 2000, pp3099-3104 

[2] Jonasson, Storeheier, Nord 2000. New Nordic Prediction Method for Road 
Traffic Noise, Version 1.0, 2001-12-21   

[3] Jonasson, Storeheier, Nord 2000. New Nordic Prediction Method for Rail Traffic 
Noise, Version 1.0, 2001-12-21 

 Industrial Noise Sources 
The noise sources for industrial applications (and sports and leisure facilities) can 
be point, line and area sources.  

For point sources, the coordinate marks the source. 

Line sources can be approximated using a polygon. Generate a new line source 
whenever the sound power changes.  

Area sources are defined by the border coordinates. Area sources can be placed in 
any shape or orientation, but they must always form a plane, except they are 
defined as "follow terrain". Small deviations are automatically adjusted. If the 
source does not form a plane, and does not follow terrain, subdivide the source 
into smaller units that are planes. Area sources can be vertical.  

It is possible to nest area sources with different sound power levels. 
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The ground effect is greatly influenced by the height of the source above the 
terrain. SoundPLAN can evaluate the source height for every possible source 
position. 

Source Properties 

The properties for a source are identical for point, line and area sources. 

 

Enter the SOURCE NAME for the documentation of your project data.  

The OBJECT NUMBER is used for the description of the sources in the Result Tables 
and can be displayed as a text attribute in the Graphics. 

With the group assignment (see “Using the group assignment of sources (page 
253)”) sources can be assigned to groups.  

 

COMMENT is used to describe the source. This comment can be placed in the Result 
Tables. You can enter further comments as a "reminder" for the project in the tab 
index card notes. 

Assignment of DAY HISTOGRAMS. Day histograms are defined in the day 
histogram library (page 310) and can be assessed here directly via the library  
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button or a click on the day histogram graphics. All industrial sources which do not 
operate 24 hours a day at a constant sound power output need a day histogram. 
The day histogram is evaluated according to the assessment selected for the 
calculation run.  

The CALCULATION TYPE allows you to choose between mean frequency and entire 
spectral calculations.  

If you want to calculate only the noise in the center frequency, enter the value in 
the CENTER FREQUENCY box, select the dB-weighting. If spectral data are unknown, 
industrial applications in the project phase most often are calculated using the 
center frequency of 500 Hz. Enter the sound power level into the appropriate field, 
select the dB-weighting and additionally for line and area sources, whether the 
sound power level is a level per meter or per unit (see below). 

Hint: The dB-weighting entered here and the dB-weighting in the settings of the 
calculation run must match otherwise the calculation will be aborted. 

For spectral calculations with a FREQUENCY SPECTRUM select the desired spectrum 
from the emission library (page 300) or generate a new entry in the library and 
assign it.  

You can open the emission library here via the library symbol or a click on the 
spectrum graphics.  

The field STANDARD DEVIATION FOR LW SIGMA allows to enter a value or assign it 
from the library (USE LIBRARY DEFINITION must be enabled) to calculate the 
uncertainty of a prognosis (page 225).  

USE LIBRARY DEFINITION: Spectra are referenced in the library as a sound power per 
unit or as the value of the entire unit. When the data is assigned a source, the 
reference is automatically transferred. You can select whether the library element 
is used with all its properties (including the sound power level) or as a reference 
spectrum with a different sound power level. Please check the settings filter and 
reference. 

Level per meter, unit or level 

The sound power can be assigned to line and area noise sources either as a noise 
level for the complete unit as LW/UNIT or as a LW/M,M² (square meter). 

If the sound power is defined per LW/UNIT, the total emission of the entire source 
is entered and will be distributed evenly over the entire source line / area. 

The setting per LW/M,M² will interpret the entered sound power as a sound power 
per meter of length of a line source and as a level per square meter for an area 
source. The total sound power of the source is the value entered plus 10 * log (size 
of source). 

The library includes elements that result from measurements. These elements are 
referenced as sound pressure levels with the reference LP/LEVEL. Either use the 
spectrum as reference spectrum with a manually entered sound power level except 
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if you want to use an element as indoor level Li or transform the spectrum in the 
library to a sound power level (see "Conversion of sound pressure spectra into 
sound power spectra (page 302)"). 

If you calculate with a CENTER FREQUENCY, set the correct sound power level and 
possibly adjust the figure to accommodate the source size. 

Moving point source / Haul road 

 

When the sound power level of a vehicle and the speed are known, SoundPLAN 
calculates a sound power level per meter - e.g. to enter the sound power per meter 
of a truck only once regardless of the track the truck took.  

 

Click on the pocket calculator and enter LW and SPEED. The result is the length 
related sound power level for one pass-by per hour. Correct the number of hourly 
movements with a day histogram with the setting events per hour (E/h).  

Lmax Industry 

It is possible to calculate the maximum noise level caused by one or more sources 
at the receiver. If multiple sources are present in the calculation, the contribution 
level of the loudest source at the receiver is regarded as the maximum level. It is 
evaluated separately for each time slice. 

The program will use the same emission spectrum, directivity, weighting (dB, 
dB(A)…) and for time related maximum levels the reference (per meter/unit) as for 
the Leq calculation. The day histogram is only evaluated to make sure that the 
source is active in at least one hour of the time slice.  

For point sources the maximum is a temporary maximum, for line and area sources 
the maximum may also depend on the location within the source. For line and area 
sources a spatial maximum level is calculated (Lw_Max is interpreted as level per 
unit) if the checkmark TOTAL SOUND POWER LOCATED IN ONE POINT is activated. 
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As shown in the sketch above, the maximum noise level of an area source is caused 
by moving the entire sound power to the spot on the line/area that produces the 
highest noise levels. SoundPLAN determines the worst possible position and the 
corresponding maximum level. 

Sources with a defined height above the terrain 

Noise sources often emit sound at a fixed height above the terrain (for example a 
fork lifter or a truck) and follow the terrain (often relating to coordinates that 
follow the terrain). 

You can therefore define a HEIGHT ABOVE TERRAIN in the emission library under the 
tab "value". When you select a spectrum from the library that has been given this 
property, the check box use library definition will become active, so that you can 
use this value. 

  

Correction for directivity (D Ω Wall), impulsiveness and tonality 

The level increase due to vertical reflecting areas in close vicinity to a source can be 
considered with directivity or the addition k-Wall. 

Example for D-omega Wall: 

Source in front of a wall   D Ω Wall = 3 dB 
Source in a corner  D Ω Wall = 6 dB 

If a source is assigned to a building all reflections of reflecting surfaces with a 
vertical distance of less than 20 cm are suppressed.  

The corrections kI and kT take account of the increased annoyance of sources with 
an impulse characteristic and sources with a strong tonal component. Physically, 
both adjustments should be assigned as add-ons to the noise level at the receiver 
because a tonal or impulse adjustment may be justified for some receivers but not 
for those with different propagation geometry. When one source is dominant, the 
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corrections may be needed. When the ambient noise level masks the previously 
dominant source, the additions should be removed. 

D Ω wall is considered for the maximum level calculation, but not kI and kT.  

The reflection at the ground is considered with ground effect areas and evaluated 
according to terms of the different calculation standards (Agr). In some elder 
standards the reflection at the ground is considered with the correction k-Floor in 
dB.  

D Ω wall and the correction factors for tonality and impulsiveness are entered in 
the tab Additional.  

 

Source documentation 

Under DOCUMENTATION -> SOURCES the spectra and day histograms of all sources 
and parking lots contained in the Situation are listed without the need to calculate 
the situation first. 

Assigning sources to buildings 

SoundPLAN allows individual point, line and area sources to be assigned directly to 
buildings, e.g. for fans or windows.  

If you want to assign several sources, it is advisable to use “  Industrial building / 
office”.  
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Enter the first coordinate of the source near the building; skip the elevation dialog 
with OK, because the elevation is taken from the building. In the index card 
Geometry/Building Ref. you see a zoomed view of the site map in the preview 
window. 

Tools for the assignment (make these entries before you assign a source): 

• The source can be anchored at a set distance from the beginning of a wall.  

• You can define the height of the source coordinate above the ground floor 
(different heights for line sources possible) 

• If the spectrum of the source has been assigned a 2-dimensional directivity 
before assigning it to the building, the rotation angle is adapted so that the 
0° axis of the directivity chart is orthogonal to the façade.  

• There are additional possibilities for the generation of the source geometry 
for line and area sources. The source geometry is no longer displayed after 
the source has been defined and assigned. 

Click left on the side of the building where you want to assign the source. In the 
field BUILDING REF. you will see the Object ID of the building. The first coordinate is 
placed to the position where you clicked on the façade, except you activated the 
check box DISTANCE FROM CORNER. D Ω wall is automatically set to 3 dB(A) and the 
first reflection (seen from the source) of all reflection areas is suppressed for this 
source, if it is less than 20 cm away from the façade. 

Assignment of directivity to sources 

In the emission library (page 300) the directivity is assigned to a spectrum, via the 
spectrum this directivity then is assigned to the sources.  

Under the tab directivity in the source properties you need to give the source an 
orientation for the main direction. Use the pictures to horizontally rotate the 
source and the set the tilt towards the horizon. A rotation around the X'-axis should 
be relevant only in very rare cases.  
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Click with Ctrl+left mouse button on one of the pictograms to set the rotation with 
a single mouse click, with the right mouse button freely rotate the directivity. 
Additionally, a direct entry of the numerical rotation angle is possible. For 
frequency dependent directivities it is possible to assign the main directions for a 
specific frequency as some of them are more pronounced than others and the main 
angles matter the most for the directivity with the biggest differences.  

When you assign a source with a spectrum with directivity to a building, you are 
asked whether the horizontal rotation angle should be aligned to the normal of the 
façade. Please check whether the directivity replaces D-Omega Wall or whether D-
Omega Wall should be used in addition.  

When you activate the properties of the source in the Geo-Database canvas, 
the main direction is presented. 

Estimating the uncertainty of a prognosis 

For point-, line- and area sources (also for industrial buildings and parking lots but 
not indoor calculations) a standard deviation can be assigned to the source as an 
extra parameter. With the uncertainties of all sources, the cumulative uncertainty 
of the entire prognosis can be assessed.   

Define the standard deviation in the Geo-Database when defining the noise level of 
the source. The standard deviation and the cumulative uncertainty are only 
available with the calculation of the Leq. The Lmax is always calculated without the 
standard deviation. 
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For sources without a given value of the standard deviation, the value 0.0 is used 
instead. This is also true for sources that do not have any association with the 
standard deviation (road, rail). 

The standard deviation is carried through the propagation calculation of all sources. 
At the receiver, the cumulative standard deviation is calculated from all source 
contributions. The standard deviation for a time slot t (only Leq-time slots!) is 
calculated with the formula:  

 

With 

 

  Noise level at the receiver for the time slice t 

 Standard deviation at the receiver for the time slice t 

 Standard deviation of the sound power of all sources in the correlation 
group k 

 Partial noise level of the source i of the correlation group k in the time 
slice t 

 Standard deviation of the sound power of an uncorrelated source j 

 partial noise level of the uncorrelated source j in the time slice t 

The standard deviation of the assessed noise level is presented as an addition time 
slot (for each Leq-time slot) in the result documentation or the Grid Noise Map as 
long as this has been requested in the calculation settings (tab for noise 
assessment). 
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 Industrial building / office 

 

The industrial building is a specialized building where all outside surfaces can 
radiate sound (although called “Industrial” for historical reasons, the Industrial 
Building Editor allows you to design a broad spectrum of rooms and buildings for 
various purposes)2.  

If the floor plan has right angles, the roof can be composed using the pre-defined 
roof forms (shed roof, flat roof, saddle roof).  

The radiating sound power level (Lw) can either be entered directly as a numerical 
value or calculated from the noise level inside and the noise reduction index R of 
the outside building shell. The noise level (Li) inside can be predicted or derived 
from measured sound pressure values or set in accordance to values found in 
literature.  

[The SoundPLAN module Indoor Noise] With the module Indoor Noise it is possible 
to calculate the level inside the building from the sound power defined in the 
building and the acoustical properties of all objects in the building. Sound power 
over frequency, exposure time, absorption spectra, transmission spectra and other 
properties are used to simulate the acoustic environment inside the building and 
generate sound pressure levels inside and automatically turn them into sound 
power levels for the exterior noise propagation. 

The Indoor Noise Module allows to design complex interior noise models, for 
example to simulate a call center or office environment or to simulate a fabrication 

                                                                    
2 It is not impossible to simulate analogues of “outdoor” situations with the method but caution is 
required. An outdoor situation can be created by defining a simple industrial building that is 
sufficiently large to act as a bounding box for the region of interest (the user should ensure that the 
roof is sufficiently high). The walls of this bounding box should then be defined as “Opening” so that 
they are fully absorbing. Solid structures may be placed within this open environment. They should 
be at least a few meters away from the bounding box walls to avoid anomalous effects. 
Furthermore, it should be noted that the sound particle method is more naturally suited to 
reverberant situations – larger distances in free field lead to longer run times. 
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shop or the machine house of a power plant with its multiple floors and walls. 
Indoor Noise calculates the noise at individual receivers in the building or noise 
maps in the vertical the Grid Noise Maps or horizontal the Cross-Sectional Noise 
Maps. The calculations are performed using the SoundPLAN Sound Particle 
Diffraction (SPD) model or with somewhat limited functionality in accordance to 
the VDI 3760. 

Room acoustical descriptors such as the STI or EDT as well as measurement paths 
according to the VDI 2569 (E 02/2016) or ISO 3382-3 can be calculated with the 
optional module Room Acoustics. 

Entry of the buildings shell of the factory / office building 

Enter the ground plan in the Geo-Database using the object type of the industrial 
building. With closing the building, the industrial building editor opens with the 
register tabs for Building / room, to set principle parameters such as the height of 
the building or the form and parameters of the roof. When you open the industrial 
building later, it will directly open with the register tab Editor so that you can edit 
the content of the building.  

Important: If the geometry of the industrial buildings is changed, the already 
entered embedded objects are taken over if possible. However, subsequent 
changes to the envelope geometry may lead to the loss of already entered sub-
objects of the affected enveloping surfaces. It is therefore advisable to first define 
the geometry before further processing the hall / room inside! Changes such as 
changing coordinates (graphically or in the coordinates list), inserting intermediate 
points, aligning at right angles, changing height, etc. can lead to possible loss.  

Roof shapes and embedded objects in the roof cannot be taken over. Subsequent 
changes result in an empty flat roof! 

Definition of the roof 

For industrial buildings with a floor plan that only has rectangular corners, the roof 
can be generated using one of the roof forms: 

o Flat roof 

o Saddle roof 

o Shed roof 

If the industrial building has more than 4 corners with varying height, enter the 
building height using the value of the lowest eve height. It is also possible to 
generate buildings with different partial roofs and combinations of roof forms and 
roof heights.  
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The surfaces of the roof are intersected with the facades. Each facade element and 
surface of the roof are listed separately in the building editor and can be assigned 
the parameters for absorption, transmission etc. 

Select the roof form from the picklist. Next click on the facade that is perpendicular 
to the ridge of the roof. In order to generate a roof for this position, the marked 
facade must be smaller or equal to the facade opposite of the selected position. If 
this is the case, the program will show the area for the future roof as a red 
rectangle. If the roof is not a flat roof, the ridges are shown as thick red lines, the 
flow direction of the water is indicated as blue arrows. 

 

Now adjust the parameters to suite the building: 

• the number of ridge lines 

• the tilt of the roof [°], respective the ratio of roof areas or the orientation of 
the ridges 

• height of the roof ridge above the eve height in [m]  

Please also observe that these parameters can influence each other and therefore 
entering one parameter may change others. 

 

For flat roofs you can also enter the extra height of the partial roof above the eves 
(for a building with 4 coordinates the parameter in the field EVE HEIGHT-/ROOM 

HEIGHT will change).  
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Click on the icon GENERATE ROOF PART, before editing the next section of the 
roof. Once the roof surfaces have been generated, the lines are switching 

from red to black and the 3D view will show the roof in the new form.  

 

It is not possible to delete individual components of the roof, i.e. if you need 
to edit part of the new roof, you first need to delete the entire roof. 

For complicated roof forms, you can insert a control bitmap. This bitmap must have 
the same orientation as the buildings floor plan, the bitmap is always aligned with 
the first facade of the building, see "Bitmap operations". 

Industry building editor 

 

The top left window shows the tree structure of all objects and sub-objects of the 
industrial building, to the right of it is the 2D- and 3D-view of the geometry. 

In the lower part you define the properties for each object. 

Between the windows you can see a splitter (visible by 3 short line segments) so 
that you can customize the size of each window to suite your needs.  

A click on the 3D window (DETACH WINDOW) and properties symbol will take 
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this window out of the normal editor and keep it as a separate window so that you 
can enlarge it and host it on a second screen. If you click on the symbol again 
(RESTORE WINDOW), the window becomes part of the building editor. 

In the 2D- and in the 3D-View the view can be best manipulated using the mouse 
wheel: 

• with the pressed mouse wheel, you move the view 

• rotating the mouse wheel will zoom in/out 

• only in 3D-view: press the mouse wheel while pressing the <Ctrl>-key of the 
keyboard (left <-> right movements => rotate around z-axis) and (up and 
down movements => change the tilt of the model) 

• only in 3D-view: press the mouse wheel while keeping the <Alt>-key pressed 
will move the model up or down when you move the mouse up/down. 

In case you have a mouse without a wheel, use the left mouse button. This requires 
that no object type is active, and the selection mode is deactivated: 

• with pressed left mouse button move the view, 

• additionally, pressing the <shift>-key to enlarge/shrink the view 

• in the 3D-view the controls with <Ctrl> and <Alt>-keys have the same 
functions as with the mouse wheel. 

View of outside/inside 

In the editor all objects of the outside facade, the objects on the inside facade 
and all inserted components are defined. Toggle between the inside 

view/outside view with a click on the symbol SWAP VIEW. The „blue sky“ in the 2D 
view is  an indication that you are in the outside view, the 3D view will present the 
entire building shell from your view point, additionally the status line for the 
current object is showing „outside“ or „inside“. 

 

In the outside view you enter the objects within or on the outer facades, these are 
either transmissive areas such as doors and windows or point, line and area 
sources on the outside façade for example a loudspeaker or a pipe. Complete 
facades, too, can emit noise, if you activate the check box ENABLE AS SOURCE. 

The following object types are available in the outside view: 
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Transmissive areas can have outdoor or transmission properties as well as material 
properties (absorption spectrum) for the calculation of the indoor noise level 
[indoor noise]. Outdoor sources have outdoor or transmission properties. The 
properties are described under “Properties of outside sources and transmissive 
areas (page 246)”. 

On the inside of the facades and other vertical objects (walls) and additional floor 
slabs you can place transmissive areas which allow you to define a transmission 
loss from one side to the other side. Point, line and area sources as well as 
absorption areas can be placed at will and will be used in the indoor noise 
calculation.  

 

On the floor of the industrial building and along the horizontal walls enter the 
objects for noise simulation and later visualization in the graphics: 

 

For slanted objects enter the area and the distance from the ground.  
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Enter the area and the distance to the ground. In the second step you select two 
coordinates from the coordinate list so that a plane can be defined. Enter the 
elevation of an additional coordinate. For a triangle, this coordinate will be the 
third coordinate, for a rectangle the elevation for the coordinates not marked as 
fixed will be set. If the object contains more than 4 coordinates or is a shape that is 
not rectangular, the elevations are interpolated. 

It is also possible to uncheck the checkmark „fixed“ to raise or lower the entire 
object. If additional coordinates are inserted, the elevations will be set by the 
program so that all of the coordinates remain on a plane. 

Reference object / Change view 

Initially the floor slab of the hall is the reference position where the objects are 
placed upon. For additional objects it is also possible to use existing objects as the 
reference.  

In the example below horizontal and vertical elements as well as transmissive areas 
are used to simulate a duplex building with its spiral staircase and partially covering 
floor slabs: 

 

For example enter a horizontal object as the floor slab. In order to enter 
objects on the floor above the floor slab, the floor slab must become the 

reference object. Click on the horizontal object and then on the symbol RESET 

REFERENCE AREA to reference the next objects to the floor slab. The referenced 
object presented in its enlarged form in the 2D view.  

The symbol remains active as long as you enter objects that are referenced to 
the floor slab. If you want to return to the initial reference, click on the 

symbol RESET REFERENCE AREA again.  

When a horizontal object is the reference object, you can generate additional 
objects above/below or left/right of these reference objects. Use SWAP VIEW 

to change the view. In the status line of the 2D view and the 3D view you can see 
which side (up/down or left/right) is currently active.  
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Entering a new object 

Initially you are in the SELECTION MODE, the arrow symbol is pressed and in 
the 2D view you see the arrow cursor. When you are in the selection mode 

and the cursor is on another object, the cursor changes into a hand cursor. With 
the hand cursor select the object and edit the objects properties.  

To enter a new object, first select the object type, this deactivates the 
selection mode and activates the ENTRY MODE. The cursor now appears as 

crosshair cursor.  

When your cursor gets close to an object, the cursor changes into CAPTURE 

CURSOR and you can position the cursor precisely on the point of coordinate 
or on the line of another object. In the SETTINGS you determine how close you have 
to be to the object in order to have the capture capabilities. 

If the mode to align along the grid or to enter with fixed angular increments is 
active, press the <Ctrl>-key to capture a coordinate. 

Enter objects in the 2D-view. For entering new objects in this mode, you have 3 
different modes: 

Free entry places the new coordinate at the exact position where the cursor 
currently is. 

Fixed angular increment is very useful to enter new coordinates on an 
existing line. New coordinates can only be generated in a way where the 

angle at your last coordinate is either the angle defined in the settings or a 
multitude thereof. If your coordinate is the second in a line, the angles are in 
reference to the x-axis.  

Align on the grid: the entered new coordinate is moved to the closest grid 
point. From a certain zoom factor on, the grid is shown on screen. 

Angular increment and grid spacing is defined in the settings. Both modes are 
mutually exclusive. When one of the modes is active, it can be temporarily 
deactivated for the next coordinate by pressing the <Ctrl>-key, i.e. you can place a 
free coordinate of capture another coordinate or a line. For lines and area entry the 
status line shows the distance to the previous coordinate in X and Y (dx, dy) and the 
current distance and angle. 

For the support of the data entry you can add a crosshair cursor. 

Except for the entry of point objects, either finish the entry with a double click 
or with <F2> on the keyboard or by changing to the selection mode. If you end the 
entry in the selection mode, you cannot right away enter another object, you first 
need to select the object type. 

If the object requires additional geometry parameters, this for example is needed 
for points with a distance to a reference line of with a vertical object the height, the 
needed dialogs are opened automatically.  
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For a rectangular area type object aligned to the x-axis for example a window on a 
facade, you can generate this object by pulling open the rectangle with the left 
mouse button pressed. 

Click on the tool GENERATE CIRCLE, analog to the rectangle you generate a 
circular object with the left mouse button. The circle is generated ist diameter 

in x- or y-direction. If you click on the <Ctrl> key, you will generate a ellipsoid 
instead of the circle. 

 

Object hierarchy 

The highest hierarchy is the buildings envelope, i.e. the facades, the roof surfaces 
and the floor for interior calculations. 

From the second level of hierarchy it is possible to overlap the different objects and 
nest them. If an object is completely within another object, the object is one level 
below this element in the hierarchy, if they overlap, both objects are on the same 
level. 

On the outside building shell, it is possible to define transmissive objects (e.g. 
windows and doors) and point, line and area sources that have different acoustical 
properties. Within inserted objects it is possible to have others nested on the same 
surface. For example, the door with an open window inserted.   

If parts of an object that is referenced to the buildings shell exceeds the dimensions 
of the parent element, the sub area (often called the child element) is clipped so 
that it does not exceed the dimensions of the hull. This simplifies the entry of the 
object as it is possible to pull open areas from the outside of the building for 
example. 

If a band of windows is stretching over the entire facade, it is very easy, simply start 
the rectangle of the window outside the parent element on one side and pull it to 
the outside on the side of the object. SoundPLAN automatically will clip the band of 
windows to their maximal dimensions.  
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When you have objects overlapping, both objects will retain their coordinates, so if 
you move one of the objects, the part that was covered will re-appear. 

 

The area being covered by another area will be clipped later on when the data are 
loaded for the calculation. The information concerning the total area of the object 
and of the part that is not covered up by another object are both visible under the 
register tab General. Transmissive areas are always showing higher in the hierarchy 
than area sources. For sources of the same object type the rule is that the area first 
entered will remain while areas entered later on will be placed under the first 
areas. 

When you have a situation where one object needs to be inserted on top of 
another object, start by entering the larger area which will be the base for the 
other areas that will be placed on top. You can also start pulling open the area in a 
manner that the first coordinate of the new area lays inside the area it will be 
cutting out. Excessive area overlapping the parent area will be trimmed. 

 

The child object (small square) will be cut out of the parent object which will 
reduce the size of the parent area, which will be diminished by the size of the child 
object. 

Object groups and Machines 

Vertical objects with more than 2 coordinates are gathered to form object groups. 
This way you can quickly enter the enclosure for a source or a closet.  

If object groups are not as high as the building or the room, you can check mark AS 

BODY. In this case the object group has a horizontal object as top and – if the object 
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group is not directly located on its reference object (another horizontal object or 
the ground) – a horizontal object as base plate.  

Machines are groups of horizontal and vertical area sources, they always have a top 
and a bottom and four sides. As long as machines are not sitting directly of the 
floor, they will radiate to all six sides. 

It is not possible to insert extra coordinates into machines and object groups, 
existing coordinates however can be grabbed and moved. Moving one coordinate 
will automatically move the coordinates for all three surfaces where this 
coordinate is part of. If you have already inserted child objects that are referenced 
to these object group or machines, they must be checked by hand as the program 
is not clipping the child objects when the coordinates of the parent object are 
moved. 

Object groups and machines are moved or duplicated with all sides. 

 

Select one or multiple objects 

Select the objects on the tree structure, the 2D view or the 3D-view. In the 
2D-view mode, the SELECTION MODE must be activated. 

In the tree click on the desired object to activate it. In the 2D-view the cursor 
changes to the POINTING HAND, when you are moving over a coordinate or an 

edge of the object, in the 3D-view the pointing hand appear when your cursor is on 
top of the object 

If there already is a selected object, it will be de-selected. To avoid this, keep the 
<Ctrl>-key pressed before activating other objects. 

In the 2D-view you can select objects close to each other by pulling open a 
rectangle with the right mouse button pressed. As long as a coordinate of an object 
falls inside the rectangle, the object will be marked. Object groups and machines 
can only be selected from the tree structure. 

You can always move objects when the object has the purple diamond and 
you move the cursor onto this diamond, keep the left mouse button pressed 

and then move the mouse. 

If you want to move an object by a fixed margin in x-, y- and / or z-direction, 
or rotate objects by a known angle use the tool MOVE OR ROTATE MARKED 

OBJECTS. Positive values will move the object to the right/top, negative values will 
move them left or down. 
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 For a free geometrical rotation, press the Ctrl-key and move the mouse to the red 
diamond. As soon as the cursor changes into the „rotation symbol“ keep the left 
mouse button pressed and rotate the object with movements of the mouse. 

The tool DUPLICATE MULTIPLE OBJECTS functions in a similar way. Enter the 
distance in x- and / or y-direction and the number of copies you want to 

generate. Duplicates with positive values will be generated to the right/top while a 
negative value for duplicates will generate them to the left/bottom.  

 

Insert coordinates / modify 

If a single line or area object is selected, you can insert new coordinates on 
the line/edge when the arrow cursor with the plus sign is active. Left click 

with the mouse on the position where you want to generate a new coordinate (this 
does not work for object groups and machines).  

If you are positioned on a coordinate, the movement cursor appears (arrow 
cursor with cross). With pressed left mouse button move the coordinate.  

When you move the mouse with the pressed <Shift>-key on a coordinate, the 
arrow cursor with a minus sign appears. Clicking on the coordinate will delete 

the coordinate (this is not working for object groups and machines). 

Hint: If the movement of a coordinate would cause the area to change the 
direction of the surface normal vector or if the boundary of the area would cross 
itself, the program will ignore your entry. 
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You can modify the coordinates manually under the register tab general in the 
section COORDINATES. If you enter a value that is not in valid range, the program 
corrects it (if a child object for example would exceed the boundaries of ist parent) 
or ignores it (if the surface normal is reversed). 

 

As vertical and horizontal objects must be either vertical or horizontal, you can only 
edit the xy coordinates for the first 2 coordinates of a vertical object or the first z 
coordinate of horizontal objects.  

Move the origin 

With the tool Move the Origin select a different edge upon which to reference the 
X-axis. This can become necessary if you want to have a bitmap as the background 
for the object. Bitmaps cannot be rotated, which means that you must select the 
origin in such a way that the hall and the bitmap are oriented the same way.  

Activate the function to move the origin. The blue cross will change into a red 
coordinate frame. Select the corner by moving the mouse on top of the edge to be 
fitted to the X-axis. Select with the left mouse button, abort with <Esc>.  

The last tool will load a bitmap, fit it or removes it -> Background bitmap. 

Enter Bitmap  

One or more background graphics can be assigned to the facades, the hall floor 
and the roof areas. The graphic can also come from a pdf file, which is 

automatically converted into a bitmap, see "PDF as background graphic” in the 
Geodatabase chapter. The bitmap must be oriented in the same way as the 
building outline. This depends on the first entered edge. 

With BITMAP LOAD / FIT IN OR REMOVE you select the desired bitmap. If you fetch it 
from another folder, it will be copied into the project. The bitmap is first fitted so 
that it lies exactly in the rectangle surrounding the building. But you are still in "Fit 
Bitmap" mode. Press the left mouse button at the lower left corner of the bitmap. 
Hold down the mouse button and drag the bitmap to the corresponding corner of 
your building envelope. Do the same with the upper right corner.  

With this the mode „fit bitmap“ is finished. In case you are not satisfied with your 
fit, you can repeat this procedure by selecting BITMAP LOAD / FIT IN OR REMOVE 

again. You are immediately in the mode „fit bitmap“, there is no need to select a 
new bitmap. If you want to select a different bitmap, you need to first delete the 
first one with a click on the <Del>-key. 
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If you have accidentally clicked on the button, you can cancel the action with 
<ESC>. 

The bitmaps can be exchanged via the selection list.  

 

With + further background images can be loaded or with - removed from the 
assignment list. 

The 3D-view 

The view direction „from outside“ or „from inside“ is linked between 2D view and 
3D view. If the industrial building is viewed from outside in the 2 D view, it is also 
viewed from outside in the 3D View and vice versa. If you have a look from the 
outside to the inside, all outside surfaces are hidden that have a surface normal 
vector pointing at the viewer (floor, facades, roof). 

 

With the left mouse button select an object. If the <Crtl>-key is pressed along, 
objects already selected are staying marked.  

When KEEP VIEW DIRECTION is not active, the building is rotated in a way that 
the selected object is pointing to the viewer. 

Additional options that also affect the 2D view. 

With the switch HIDE BITMAP / SHOW BITMAP toggle the bitmap presentation.  

 

The switch will toggle between the wire frame model and the hidden surface 
model: Sometimes it has advantages to see all boundary lines of surfaces of 

all objects instead of hiding objects below others. 
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When the mode SHOW OBJECTS TIL HEIGHT, the slider to its right is active. By 
clicking on the slider, you set the height from which on the objects are cut away. 

After letting go of the mouse button, the 2D and 3D views are redrawn. 

If you want finer height spitting, use the divider to the right of the slider to make 
the slider more sensitive. 

Click on the height symbol again to deactivate this mode and SHOW ALL OBJECTS. 

The object tree 

The object tree depicts the hierarchy of all objects for the industrial building. The 
top level represents the buildings shell with floor, facades and all surfaces for the 
roof structure. If present, you will find all transmissive objects below this with the 
group definitions for outside / inside. This structure may repeat itself for multiple 
horizontal and vertical objects. 

 

Object groups and machines only consist of a single reference coordinate; the 
surfaces are located in a separate branch of the tree. 

If the object tree is closed, only the top level is shown. The triangles in front 
of the shells object indicate that the object contains other objects.   
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The command OPEN TREE opens the tree with all branches and sub branches. 
Via the small triangles in front of the objects in the tree you can expand the 

individual branches.   

In case you activated in multiple objects either in the object tree or the 3D-view 
that are not in the same level of hierarchy, the 2D-view will show a gray empty 
area. 

In the SETTINGS define the parameter for the entry of the objects. Change the 
default values only if really needed as courser settings often will lead to 

difficulties in the 2D-view. To make it easier to document the situation, you can 
also have the program present the unique object numbers in the tree. 

 

With the PREFLIGHT button ask the program to check the data if nothing 
important was forgotten for the calculation. The logbook will contain the 

results of the check.  

The logbook-icon will change in color if hints, warnings and errors are found. 

 

In the properties table, you will see the properties of all absorption and noise 
transmission definition for all objects along with the definition of all sources 

associated with the industrial building. Select the objects by their properties from 
the pick list.  

In the General tab, you can enter any information about the individual objects 
under NOTES. In the case of sources, the first row of comments is documented in 
the results tables in the COMMENTS column. 
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Import outside geometry into an industrial building 

If your project requires a containment of fans/air conditioners in front of the 
facade or on the roof, you can import the outside geometry with the sources into a 
building itself. Open up a new industrial building that fully contains the sources. 
Adjust the elevations so that all outside objects are higher than the floor of the 
new industrial building. Change from the tab general properties/room to the tab 

editor.  Click on the symbol IMPORT . All point, line and area sources as well as 
buildings, walls and floating screens that are completely within the new industrial 
building will be imported.  

 

For sources the spectra and day history will be transferred. Buildings are converted 
into horizontal and vertical objects. The reflective and transmissive properties must 
be defined later on for all the new objects. 

Properties of the building and the objects 

In addition to the geometry of solid objects and the positions of sources and 
receivers, you will need to define the emission spectra for all the sources, along 
with absorption spectra for all surfaces and sub-surfaces. Bear in mind that the 
frequency spectra that we perform the calculations with takes the lowest common 
denominator from your input – the source or surface with the least detail in terms 
of frequency definitions decides the detail level for the calculation as a whole. If, 
say, you have one surface which defines absorption only in the bands 500 Hz, 1000 
Hz, 2000 Hz and 4000 Hz, these are the only bands we will use for the calculation, 
even if you have defined everything else in third-octave bands from 1 Hz to 20000 
Hz. 

We take a slightly more relaxed attitude with transmission. You are free to leave it 
undefined (in which case we assume no transmission whatsoever), or you may 
define a limited number of bands. In the latter case, if the calculation wants to use 
a frequency band which is not defined by a transmission spectrum, we either take 
the lowest or highest available band if the frequency lies outside the defined range, 
or, if the frequency lies between two defined transmission bands, we interpolate 
between the two. 

An important point to reiterate is that while it is tempting to try and improve the 
quality of results by increasing the input detail, there is usually little to be gained 
beyond a certain point – excessive detail can even lead to additional difficulties. Six 
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or seven octave frequency bands may well be sufficient and geometrical features 
smaller than about 50 cm can often be safely neglected. Absorption coefficients are 
rarely known within an accuracy of ±0.1. Even the best measurements can struggle 
to get accuracy below 0.5 dB in certain circumstances and calculation methods 
come with systematic errors – discrepancies of several decibels are seen regularly 
in realistic noise control situations in general. It therefore makes sense to start with 
a relatively crude model and then possibly explore what difference further detail 
might make. 

It’s worth bearing these things in mind when you set up you SPD situation. 

Inside properties of the building 

 

The mean room height is only valid for calculations according to VDI 3760, because 
this model can only calculate horizontal ceilings. Enter a mean room height in case 
of suspended ceilings, saddle roofs or shed roofs. The actually bigger surface of the 
roof must be considered by a higher scattering object density.  

Please note that further restrictions apply to calculations according to VDI 3760, 
e.g. no intermediate ceilings may be entered. 

Definition of the scattering objects 

Scattering objects are not explicitly modeled elements inside a room, leading to 
screening and scattering of the incident sound. Scattering objects are all kinds of 
structures inside of the factory, (e.g. machines, installations or pipes), but only if 
they are large with respect to the wave length. It is therefore recommended to only 
take those structures into account which are balls with a diameter of at least 1 m or 
cuboids with a side length of at least 1m. Smaller elements only minimally act as 
scattering object; larger structures divide the room and should be considered as 
walls. 

Facades and ceiling are no scattering objects. 
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The SCATTERING OBJECT DENSITY q can be described as the mean free path length 
Lm. (q = 1/Lm, Lm = mean free distance between scattering objects). This can be 
traced back to the relation of the surface Sl of all structures in the room (except 
boundary surfaces) to the room volume V.  

 

The free path length can be assumed to be 30 m for a hall with few machines and 
10 m for dense fill with machines. 

The density of scattering objects increases with increased grade of filling the hall 
with machines. Here some guidance values for  

Dense fill with machines  0.1 m-1 
Middle fill with machines  0.08 m-1 
Scattered fill with machines  0.03 m-1 
Hall with very few machines   0.01 m-1 

The only other source for absorption spectra we know is the book „Technischer 
Lärmschutz (technical noise protection)“ (Springer Verlag, ISBN-10: 3-540-25507-9) 
with the following suggestion: 

Room with flat roof, scarce scattering object allocation  
(e.g. machine room in a power plant): q = 0,015 – 0,03 m-1 

Room with flat roof, middle scattering object allocation  
(e.g. room with machine tools):  q = 0,03 – 0,06 m-1 

Room with shed roof, dense scattering object allocation  
(e.g. shed hall with textile machines): q = 0,06 – 0,12 m-1 

Inaccuracies in the estimation of the scattering object density is only scarcely 
noticeable in low and middle distances to a source but fairly noticeable in big 
distances. 

Definition of the absorption of scattering objects aS 

The absorption of the scattering objects is frequency dependent. The VDI 3760 
proposes the following absorption spectra that are included in the system library: 

Scattering objects metal (machinery) 

Scattering objects wood (other installation) 

The only other source for absorption spectra we know is the book „Technischer 
Lärmschutz (technical noise protection)“ (Springer Verlag, ISBN-10: 3-540-25507-9) 
with the following suggestion: 

All kind of machinery (except textile machines), pillars, sheds, 
material piles: 

as = 0,05 – 0,15 

Textile machines: as = 0,2– 0,25 

Sound absorbing partition walls (e.g. in an open-plan office): as = 0,7– 0,9 
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Properties of outside sources and transmissive areas 

You can assign an OBJECT NUMBER in the General tab (see "Object numbering" on 
page 25), which is used to label the sources in the Result Tables and can be output 
as label text in the Graphics. 

Once you entered a source, transmissive area or a complete façade is enabled as 
source (tab General), a tab index card for the properties of the outside sources is 
shown.   

   

The organization unit GROUP gathers the results of multiple sources under a single 
label for the result tables. The selection list shows already existing groups (or "not 
defined" in a new project).  

 

The lower area contains the core of the object settings with the definition of the 
emission, the corrections, standard deviation and the max noise level are entered. 
On the right-hand side, the spectral data and day histogram are visualized. If a 
directivity is associated with a source, it can be selected and viewed on the second 
tab. 

Emission definition 

Select how the emission shall be defined.  

 

Select LW, if you want to enter the sound power directly. The sound power can 
either be entered as a mean frequency in the left field or selected as a spectrum 
from the library. The spectrum can contain the final values or can be used as a 
reference spectrum which will be converted into a full spectrum with the sum level 
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that the spectrum is supposed to represent. In this case all levels of the reference 
spectrum are only relative levels.  

 

With the entry as a mean frequency select the desired mean frequency in the filed 
CF/RANGE [HZ]. In general the LW REFERENCE is set to "Lw/m,m²" (the sound power 
is referenced to a meter/ square meter of the source) 

As soon as you select an emission spectrum from the library, the first spectrum in 
the field is presented and the frequency sum (total sound power over all 
frequencies) from the library is entered. If you change the frequency sum, all values 
of the spectrum will automatically adjust up or down.  

Select L'W = Li+Cd-R as the entry type to calculate the L“w from the interior noise 
level and the noise transmission through the wall. You can enter the interior noise 
level and the noise transmission as a single value (equation 7b of the VDI 2571) or 
as a spectrum from the library. If Li and R have different ranges of definition, only 
the frequencies that are part of the Li and the R will be used. It is recommended 
that the frequency range in the library should be adjusted.  

 

With L'W = Li(CALC)+Cd-R the interior noise level of the industrial building is 
calculated with the module Indoor Factory Noise. The calculation saves the spectral 
data in the Li(Calc) day histogram spectra library. This means that when you 
calculate the interior levels the definition of the Li in the industrial building is only 
complete after a Hallout (in->out) calculation is done. 

In addition, enter the diffusion parameter Cd. According to EN DIN 12354 this term 
is dependent on the room properties and on the surface properties of the inner 
side of the building. 
Situation Cd in dB 

Relatively small, uniform rooms (diffuse field) in front of reflective surface -6 

Relatively small uniform rooms (diffuse field) in front of absorptive surface -3 

Big flat or long halls, many sound sources (average industrial building) in 
front of reflective surface 

-5 

Industrial building, few dominant and directed emitting sources in front of 
reflective surface 

-3 

Industrial building, few dominant and directed emitting sources in front of 
absorptive surface 

0 
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In the equation 7a of the German VDI 2571 the diffusion term Cd is -6.  

By selecting [Li+Cd](calc)-R in the properties of outside sources and transmissive 
areas, you can automatically calculate the diffusivity term Cd for “hallout” 
simulations according to ISO 12354-4 (not for VDI 3670). Cd is included in the 
calculation of the internal level and is not shown separately. 

The correction for D Ω-WALL is automatically set for the surfaces of the industrial 
building to 3 dB. In case you use a directivity from the library it is assumed that the 
half spherical propagation is set via the directivity and D-Omega Wall is set to 0. 
The directivity is selected in an additional tab and already has the main direction of 
the sources set to the surface normal of the wall, see „Assignment of directivity to 
sources (page 224)“.  

It is also possible to assign a day history to the sound power radiated from the 
building.  

Multiple emission definitions 

An emission definition for the environmental noise (not the noise inside the factory 
building) can be assigned up to 3 emission definitions, to model different 
configurations of the source for example to simulate the different breakout for 
„door open“ - „door closed“ correctly with the correct amount of time where the 
door is open versus closed and with a different transmission loss.   

Hint: The day histogram library includes a function to invert a day histogram.  

Procedures with a calculated in factory noise level 

Use the red plus sign to generate a new state of the source, the geometry 
remains unchanged but the source description will allow the change of the 

transmission index R. Each source has a day history where each state of the source 
needs to be assigned a percentage of the time this state will be active, the total 
needs to sum up to 100%. This means that when a gate is open 18 minutes of a 
certain hour, the time history for this state needs to be set to 30%, the closed state 
= 42 minutes will be the other 70%. 

Procedures with an indoor level selected from the library 

With the red plus-symbol request a new source definition with a different 
noise transmission. The day history for this operation can only be resolved 

for the number of hours when this source definition shall be active rather than the 
detailed information which hour had what source definition. For example, a gate 
that is open between 9:00 and 12:00 but is closed the rest of the time. If the 
operations time of the factory is between 6:00 and 22:00, then the day history for 
the open gate from 9:00 to 12:00 is 100% open, for all other hours it is closed = 0%.  
The day history for the closed gate is 100% for 6:00 to 9:00 and from 12:00 to 
22:00, the time from 9:00 to 12:00 the closed gate is active by 0%.  This means that 
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at night time where the noise limits are stricter, the closed gate is active and not 
the open gate, thus it is much quieter in the environment. 

Interpretation of inserted point and line sources as an area 

Often the geometric form and exact location of a source is not determined at the 
time the noise study is made. To accommodate this, point and line sources can be 
assigned an area, this area will be subtracted from the higher instance source to 
correct the number of square meters this source is radiating noise. This is helping 
with sources that have the sound power defined as per meter, for example when 
calculating the noise breakout from the internal noise of the factory to the 
environmental noise. 

Indoor source properties 

The organization unit GROUP gathers the results of multiple sources under a single 
label for the result tables. The selection list shows already existing groups (or "not 
defined" in a new project).  

The lower area contains the core of the object settings with the definition of the 
emission and the day histogram. If a directivity is associated with a source, it can be 
selected and viewed on the second tab. Below the spectrum and the and the day 
histogram are visualized.  

Single values are not possible for indoor sources, always select a spectrum from the 
library. You can apply the settings from the library or use the spectrum as reference 
spectrum. In this case define the dB-weighting and the reference (emission per 1 
m² area size, or per 1 m line length or in relation to the total source). On the right 
side, select the daily histogram from the library (important only for Leq 
calculations, not for room acoustics). 

Absorption properties 
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For indoor calculations all facades, ceilings inner walls and inner ceilings etc. 
mandatorily need an absorption spectrum. Therefore, select a spectrum from the 
library.  

The button „Library“ takes you to the library (either to select an element 
from the system library or to edit a selected element). 

Transmission properties 

 

Horizontal objects (intermediate ceilings), vertical objects (walls) and transmissive 
areas can be treated as sound-permeable for calculations according to the sound 
particle model SPD. Select a transmission spectrum from the library. Select the 
transmission spectrum for horizontal and vertical objects as well as for transmissive 
objects at horizontal and vertical objects in the tab Material properties and for 
transmissive areas at facades (doors, windows) in the tab Outdoor source 
properties.  

The button „Library“ takes you to the library (either to select an element 
from the system library or to edit a selected element). 

Interior transmission areas inside the building can also be considered as an 
opening. In this case, activate the check box OPENING. 

 

In the 3D view, objects lying behind the opening are visible. 
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Edit properties of multiple objects 

If you want to edit the properties of multiple objects, select them in the tree (with 
Ctrl + left mouse button). All changes you make in the property dialogs are valid for 
all selected objects. 

The property table is another possibility to quickly edit the properties of 
multiple objects as well as to get an overview of the properties. 

 

Select the property you want to edit or view. You will see a table with all objects 
with this property (e.g. absorption inside / left). A click on the column header sorts 
the table accordingly. Properties can be transferred from one object to another. 
Place the cursor on the lower right corner of an entry field and pull it with pressed 
left mouse key downwards.  

 Wind Turbine 
Wind Turbines can be evaluated in accordance to the standards ISO 9613-2, 
ÖNORM ISO 9613-2, IoA Windturbines and the Danish Status Order No. 1284.  
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With the group assignment (see “Using the group assignment of sources (page 
253)”) wind turbines can be assigned to groups. 

 

For the source of a wind turbine, place the source at the height of the hub. The 
wind turbines included in the system library already contain the height above the 
terrain from the manufacturer's data. This value is taken over to the source 
element as Delta h if you activate the check box USE LIBRARY DEFINITION under 
TERRAIN REFERENCE. In this case, the height definition is set to relative.  

Under the tab Additional enter the diameter of the rotor (for the calculation in 
accordance to the IoA Windturbines respectively for the presentation).  

To get a realistic visualization in 3D you can use the object type „Wind energy“ to 
set the direction of the rotor. 

 

As a nice add on, you can let the wind turbines rotate with Ctrl+T in the 3D View, 
(Ctrl+1 - Ctrl+9 will change the rpm of the wind turbine in 9 steps).  
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Using the group assignment of sources 

 

All sources (roads, railways, parking lots, industrial sources, wind farms and sources 
associated with an industrial building) can be assigned to groups. Results for 
individual groups can be saved separately in the calculation. In the Documentation 
(Result Tables and Spreadsheet) and the Graphics can present the results of the 
groups separately from the documentation of all individual results.  

In the Geo-Database assign the sources to a GROUP.  

 

In the Calculation core in the definition of the calculation run for single receivers 
and Facade Noise Maps check the box for GROUP-RESULTS.  

 

For Grid Noise Maps use the double arrow to select groups for the calculation.  

The ALLOWED TOLERANCE in the tab Settings in any case needs to be set VALID FOR 

EACH GROUP CONTRIBUTION LEVEL, in order to have the levels of groups stay 
constant when other groups are added or taken out of the calculation. If detail 
tables are activated, the tolerance is calculated on the basis of each source partial 
noise level.  

For the table type (Result Tables and Spreadsheet) and the graphical 
documentation of the results, the results can be presented either based upon 
Group Contribution levels or on total results. 

In the Result Tables the group contribution levels at the receiver are presented for 
single receivers and Facade Noise Maps under Details + Graphics in the detail table 
Groups.  
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In the Spreadsheet (Receiver table) -in the column selection- select if group 
contribution levels should be part of the spreadsheet and if desired, which ones. 
Depending on the selection there are additional columns.  

 

The groups can be used in the area table for the statistical evaluation.  

 

In the Graphics during the file selection menu, choose if sum levels or contribution 
levels are to be used in the plan.  

 

Accordingly, also the grid operations and the operations in the Facade Noise Map 
can be performed for groups. 
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 Measurement point 
[Expert Industry] The measurement point is an object to calculate the sound power 
level from measured spectra. See "Calculate sound power from measured data 
(page 735)". 

 Stage 
The environmental noise at a festival created by one or multiple stages can be 
calculated in SoundPLAN in accordance to either the Nord2000 or ISO 9613-2. 

Calculations with the Nord2000 offer higher accuracy because the formulae used in 
the propagation are closer to the propagation of a wave that what the ISO 9613-2 
offers. The ground effect is using Fresnel zones to calculate the reflection of the 
wave on the ground, the ISO 9613 only regards a single reflection point. The ISO 
9613-2 also calculates the scenario as a downwind case which automatically means 
that you are assessing the worst-case scenario with downwind in all directions. The 
Nord2000 allows for more detailed modeling of the meteorological conditions with 
wind velocity, wind direction or alternatively with downwind conditions. 

A stage is a combination of the position of the noise sources, the properties of the 
loudspeaker array and the area for the spectators. The data are defined in the 
ArrayCalc file.    

ArrayCalc is a software product from d&b audiotechnik GmbH, in which all 
properties and settings of the d&b speaker arrays. For example, the number of 
arrays, the directivity and the tilt of individual speakers as well as the location of 
the concert attendees. 

You can download the software for free from the website of d&b audiotechnik 
under 
http://www.dbaudio.com/en/support/downloads/category/detail/software/simulation.html  

In SoundPLAN the entire stage from the ArrayCalc file is defined as a point object. 

 

ArrayCalc must be installed, in order that the object type stage is visible in the Geo-
Database. 

Select the symbol stage from the object bar and with the mouse place the 
stage on the canvas. When you open the object settings, you not only see the  

http://www.dbaudio.com/en/support/downloads/category/detail/software/simulation.html
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object as a point symbol but can view the entire stage with all sub-objects as they 
were defined in ArrayCalc.  

 

In the object dialog click the symbol OPEN to open the ArrayCalc file. Depending on 
the complexity of the stage, this can take a moment. With the symbol ArrayCalc 
open the program ArrayCalc if you need to make changes to the stage or to 
customize the “NoizCalc Reference point” (see below).  

To explore all settings and definitions for the stage. I SoundPLAN the stage is 
represented only as a point object, in reality there are many sub objects that 

are defined in ArrayCalc itself.  

Customize the DIRECTION of the venue. 

Via the library symbol select a frequency spectrum. As the spectra often are 
relative spectra with the sound power of LAeq =0 dB, use the field for LEVEL 

CORRECTION to set the level selected at the sound mixing booth. A non-
standardized spectrum that was measured with a sound level meter can also be set 
to the level defined at the sound mixing booth.  
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Calibrate the stage 

 

In the picture above, you see the venue with the loudspeakers and additionally a 
blue and a green dot. The blue dot represents the position that you see in 
SoundPLAN, the green dot is the green dot is the position of the sound mixing 
booth or respectively the location used to calibrate the stage to, this point is called 
the “NoizCalc reference point”.   

In ArrayCalc under “settings -> advanced features”, the „NoizCalc reference point” 
must be activated for SoundPLAN to be able to calculate the stage. You can 
customize the “NoizCalc reference point” in ArrayCalc in the “3D plot”. SoundPLAN 
uses this location to calibrate the noise level to the total sound pressure of all 
loudspeakers. Usually this calibration point is positioned at ear level at the sound 
mixing booth. The calibration point must be at least 0.1 meters above the ground. 
The calibration is done in a pre-calculation of the SoundPLAN calculation core.  

 Buildings 
Buildings are an important factor in the outdoor noise propagation. For this reason, 
the elevations of the building, the building height (diffraction edge) and the 
reflection properties are important parameters.  

For aircraft noise calculations, buildings are used for display purposes only. 

Some of the properties that are assigned to buildings can later be inherited to 
receivers to reduce the effort of the definition of manually assigned and 
automatically generated receivers (Single point calculations and Façade Noise 
Maps). 

Statistical data such as the number of occupants and the number of dwellings is 
necessary for the evaluation of occupants affected by noise, for example for the 
statistics in connection with the EU noise mapping and noise action planning as 
well as for conflict and annoyance analyses. 

A building is described with the ground floor elevation (normally the elevation of 
the entrance above sea level) and the building height above the ground floor. The 
building edge points are derived from the DGM. 
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The ground floor elevation is the same for all building coordinates. The first 
entered coordinate is defining the ground floor elevation for the whole building. If 
buildings are placed on a before calculated DGM, you can select whether the 
ground floor elevation is derived from the building corners as the highest/lowest 
elevation or if it shall be averaged from all coordinates of the building. 

The positions of receivers and the building height are measured from the ground 
floor elevation. 

The difference between the ground floor elevation and the terrain defines the 
building base, which is used as extended reflecting façade area. Buildings situated 
on a hillside can be assigned receivers in basement floors. 

Enter the coordinates of the building; double click, F2, or FINISH) closes the 
building. Main buildings are displayed with green hatches, auxiliary buildings with 
blue hatches.  

Building Properties 

Each building has only a single set of property information. For building complexes 
with different wall heights, the building needs to be split up in several buildings. 

 
Building properties 
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When you assign receivers to a building, the BUILDING NAME is proposed as receiver 
name. For Façade Noise Map calculations, the building name is automatically used 
as receiver name. We recommend not filling in the building name manually but to 
define the entry fields ROAD NAME and NO and then assign both entries with a 
double click on the field BUILDING NAME. Use the GeoTool PREPARE BUILDINGS to 
define several building names at the same time. The order of road name and house 
number is selected via OPTIONS -> PRESETTINGS, branch Geo-Database.  

Use the object number (page 55) for individual numbering of the Façade Noise Map 
receivers, if the automatically assigned serial number (alpha-numerical numbering 
according to the receiver name) is not sufficient.  

Select whether the BUILDING TYPE is "main building" (residential building) or 
"auxiliary building" (garage, industrial building) for a different display in the 
graphics. For the evaluation according to the EU directive on environmental noise 
you can also assign the building types "school", "hospital", "kindergarten" and 
"unknown".  

If you want to determine the building type in the Property Explorer via a formula 
you need to know the number, the building type is stored with in the selection list: 

0 Main building 

1 Auxiliary building 

-1 Unknown 

-2 School 

-3 Hospital 

-4 Kindergarten 

 You can add further display types if the module Cartography is licensed, see 
"define your own object types".  

 

The new layout has no influence on the appearance of the buildings in the Geo-
Database but only in the Graphics. You can check the Layout in the Geo-Database, 
if you open the 3D map with Ctrl+ F10 [module 3D Graphics] and select the site 
map in the selection list.  



 SoundPLAN Manual 8.1 
 Objects and their Properties 

Page • 260/793 Buildings 

4 

The BUILDING HEIGHT is relevant for screening and reflection during the propagation 
calculation. It is entered relative to the ground floor elevation. If gutter elevations 
are available from laser scan data, the building height can be calculated with the 
GeoTool “Evaluate points for mean building heights (page 169)”. 

The form of the roof is usually not relevant for the propagation calculation. In most 
calculations it is sufficient to set the building height in the middle between gutter 
and ridge. Only for special problems or to show the roof in cross sections and in the 
3D-Grapics it might be useful to enter the ridge as a noise protection wall. The base 
line is entered at the position of the ridge in m above sea level with a wall height of 
0. Assign the graphics-object type "ridge" for the display in cross sections and 3D-
Graphics. 

The REFLECTION LOSS describes the loss of energy occurring at each reflection of 
sound waves off an object. The magnitude of the loss depends on the material of 
the wall, the impact angle, the frequency, and the size of the wall. For normal noise 
assessments, the reflection losses are estimated with the following table.  

Facade type 
Reflection loss  

in dB 
Absorption coefficient 

α (fyi) 

smooth facade of a building 1 0,21 

facade with balconies and uneven fronts 2 0,37 

The reflection loss is entered in dB. 

Activate the check box BUILDING FLOATS ABOVE GROUND, if the difference between 
the ground floor elevation and the terrain should not be considered as reflecting 
pedestal. See "Floating buildings and industrial buildings (page 263)".  

Settings for Receivers in the Building Properties 

If receivers are assigned to a building (single point receivers or Façade Noise Map 
receivers), all relevant data is entered with the building. When referencing the 
receiver, the parameters are reused for the receivers. This way parameters such as 
number of floor or area usage are defined only once per building. 

The field HEIGHT OF 1. RECEIVER ABOVE GROUND FLOOR defines the calculation height 
of the first receiver (this is not the floor height of the first floor). Depending on the 
standard, this might be for example in the center of a floor (e.g. 1.5 m) or the 
ceiling of a floor (e.g. 2.4 m). The height is entered relative to the ground floor 
elevation. 

The HEIGHT OF FLOORS defines the position of additional receivers above the first 
receiver.  

The NUMBER OF FLOORS defines the number of calculated receivers lying on top of 
each other. 

The parameter NUMBER OF BASEMENT FLOORS is used to take into account receivers 
below the ground floor for buildings on a hillside. 
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The label of the first floor for floating buildings makes it possible to correctly label 
the floors for nested buildings. See "Floating buildings and industrial buildings 
(page 263)". 

The AREA USAGE is used to compare the resulting noise levels (assessment levels) 
with the noise limits and to map the noise excess as a conflict in the tabular 
documentation (Result Tables and Spreadsheet), for dimensioning noise protection 
walls (Wall Design) and in the Graphics (Façade Noise Map and level tables). The 
rest period additions according to the German TA Lärm are area usage dependent. 
The area usage definition entered in a building is transferred to the receivers 
assigned to the building. When optimizing a noise protection wall, the target level 
is proposed according to the area usage.  

Assignment of the area usage to buildings 

Use GEOTOOLS -> MORE BUILDING TOOLS -> ASSIGN AREA USAGE TO BUILDINGS in case 
the area usage is provided in the object type "area usage". 

Façade Noise Map - Activate Façades 

 

The module Facade Noise Map allows calculating automated single points without 
the need to enter single receivers. All facades where receivers should be placed 
need to be marked. The position of the receivers (in the center of the façade, 
distance in meters …) is later defined in the calculation properties. In the preview 
window in the tab index card "Façade Noise Map" you see the building and its 
surroundings. The cursor marking the facades is a small cross. Click on all sides of 
the buildings you want included in the calculation.  

SELECT ALL activates all facades of the building, INVERT SELECTION deactivates the 
previously activated facades and vice versa.  

As the facades will usually be activated at one time for several selected buildings, 
use the Geo-Tool PREPARE BUILDINGS to prepare the façade receivers. You can define 
a minimum length so that small facades such as balconies are excluded. In PREPARE 

BUILDINGS you can also deactivate all facades for the Façade Noise Map. 
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Activate the object properties of the buildings to see the activated facades 
with a thick turquoise line. 

 

If two buildings have a common façade or if a receiver is below the terrain, the 
receivers within this façade will not be calculated. Receivers are only calculated if 
they are located 0.5 m above the lower building. 

Property number, owner, inhabitants 

Each building can be assigned further properties such as PROPERTY NUMBER, OWNER 
or the number of INHABITANTS per building in the tab index card Additional.  

The number of inhabitants / dwellings is needed to show the affected people in a 
noise interval for annoyance analyses, strategic noise maps and action plans 
according to the European directive on environmental noise. Without exact 
knowledge of the number of inhabitants, you can roughly estimate the inhabitants 
with the option "m² per inhabitant" in the Geo-Tool PREPARE BUILDINGS. 

If information on inhabitants is available in an area (object type "area usage") or in 
a grid, you can use the Geo-Tool Distribute occupants (page 168).  

Building information as well as settings resulting from the building geometry (e.g. 
area * number of floors) can be inserted in the Spreadsheet to evaluate annoyance 
analyses. 

  

For investigations according to the EU directive on environmental noise, use the 
check box SPECIAL NOISE PROTECTION MEASURES to distinguish buildings, which, for 
example have already got noise protection windows.  
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IGNORE THIS BUILDING IN THE PROPAGATION CALCULATION CONCERNING REFLECTION 

AND SCREENING: In some cases, it is demanded that shielding and reflections from 
buildings are suppressed. For the location of the receiver on a building and the 
references to the Façade Noise Map the buildings are vital, so it is not possible to 
simply ignore the buildings in the calculation. This procedure might also be useful 
in urban land use planning, when the exact position of the buildings is not yet 
known.  

In order to supply the calculation core with the required information and to 
facilitate this, some extra controls are introduced: 

Check the box SEARCH RANGE DEFINED BY FACADE and also check the box IGNORE 
BUILDINGS FOR PROPAGATION CALCULATION WHICH HAVE APPROPRIATE FLAG IN THE 

BUILDING PROPERTIES in the Calculation settings Facade Noise Map. 

Floating buildings and industrial buildings  

With the check box BUILDING FLOATS ABOVE GROUND (NOISE CAN PASS UNDERNEATH) 
the base of the building is not connected to the ground.  

   

For the calculation only the screening is regarded not the reflections between the 
ground and the bottom of the buildings! If you want to regard the reflections 
between the ground and the bottom of the buildings correctly, you need to 
simulate the interaction with an Indoor Noise Calculation and manually generate an 
area source at the bottom of the building and assign it the sound power that is 
equal to the reflected noise components between the ground and bottom of the 
building. Please also observe that any floating structure will significantly increase 
the calculation time. For that reason, floating objects should be used sparingly for 
detail calculations.  

With this switch several new modeling options become possible: 

• Buildings where higher floors are bigger than the ground floor 

• Modelling of passageways under buildings and entries to courtyards  

• Buildings that have different usages, floor heights and reflection losses  

• Industrial buildings with multiple floors (parking garages) 

• Aggregates in (compressors, engines…) in containers on industrial racks (the 
noise radiation of the bottom of the box will be available shortly) 
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In order to allow receivers in stacked buildings to be labeled continuously, the label 
for the lowest floor was amended. 

 

 Elevation Lines and  Spot Heights (Terrain Points) 
Elevation lines and spot heights form the base data for the supply of elevation for 
the 3-dimensional calculation model. A digital ground model (DGM) is calculated 
out of elevation lines and spot heights and is later used to determine the elevations 
of the model data (roads, buildings …). The DGM edges are evaluated to calculate 
the ground effect and the screening (if applicable). The particular functions depend 
on the calculation standard. Some standards tie the ground effect to the average 
height of the line of sight above the terrain, whereas others calculate the ground 
reflection position in great detail. Please read the chapters detailing the ground 
effect in the SoundPLAN reference handbook. Although the screening does depend 
on the standard, please remember an effect which may not seem so obvious: Most 
calculation standards require the screening to be evaluated not only in the shadow 
zone but also in the illuminated zone. 

The object type elevation line applies to ISO elevation lines in the cartographic 
sense and to lines following a terrain. The first type represents lines of the same 
elevation, whereas the second type models elevation profiles and cutting edges. 
Elevation lines are also generated with the Geo-Tool CREATE EMBANKMENTS. 

If a DGM is calculated only out of ISO elevation lines, it might have the tendency to 
form plates. The screening effect will not be taken into account correctly. In this 
case, extra profile lines describing the elevation course will help: 
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The object type spot height describes singular elevation information. Elevation 
grids or point sets (point clouds) from laser scanning, which ensure the supply of 
elevation information in the investigation area, are imported as object type spot 
heights (FILE -> IMPORT -> ELEVATION DATA). These spot heights are normally thinned 
out before import in order to minimize the number of points and the size of the 
DGM, see “Import and filter elevation data (page 114)”. 

Terrain points which are available in a DXF file as a text can be converted to spot 
heights, see DXF Import (page 97). It is sensible to use the option IGNORE 

COORDINATES WITH Z=0 during the DXF import of elevation lines or spot heights. 

Calculation of the negative extra path length / terrain edge 

As soon as a calculation standard demands the calculation of the negative extra 
path length (screening in the illuminated zone), SoundPLAN automatically 
calculates this value. In projects modeled with a pre-7.0 version SoundPLAN 
replaces the terrain edge with 2 elevation lines.  

 

 Terrain base line 

If between source and receiver no obstacle is found that would result in a positive 
extra path length, SoundPLAN defines a line between the ground at source and 
receiver labeled the terrain base line. All elevation lines and DGM triangle edges 
above below this terrain base line are checked if negative extra path length needs 
to be considered. The point delivering the highest value of extra path length for the 
terrain base line is chosen for the calculation of the negative screening. 

 Noise Protection Walls 
Walls are used to describe noise control walls and retaining walls for the noise 
calculation. Sometimes they are also used to define the ridge of a roof.  

The wall height refers to the base line (example: with a wall height of 4 m the 
screening edge is 4 m above the base line). A wall with the wall height "0" is taken 
into account for the screening effect. The elevation of the screening edge is the 
elevation of the base line. 
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Wall Properties 

 
Wall properties 

Activate the check box OPTIMIZATION to use a wall for the pre-calculation for Wall 
Design, see Wall Design (page 461). The optimization walls must be stored in a 
separate Geo-File. This means, only walls to be optimized may be in this Geo-File. 
Walls with additional elements are already finally defined and therefore cannot be 
used for a wall design calculation. 

Check mark WALL FLOATS ABOVE GROUND, in order not to extend the bottom of the 
wall to the ground, but to use the object elevation as the bottom. If there is a gap 
between terrain and bottom of the noise protection wall, noise can propagate 
under the noise protection wall. 

With this feature noise protection walls on bridges can be modeled better. Roads 
and Railway lines should still be marked to be on a bridge in order to prevent the 
propagation through the bottom of the bridge. This way it is also possible to 
graphically document the height and reference kilometer of walls on bridges. 
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Please make sure that all entry points of the wall sections on the bridge must be on 
the bridge plate. In case of doubt define the bridge plate a bit wider. 

When a search ray intercepts a line element, the elevation is calculated from the 
elevations of the previous and next points, and the distances to these coordinates. 
For a noise control wall, the interpolated position is the base of the wall. An 
interpolation of the wall height for the intersection position is used to calculate the 
top of the wall. 

Noise control walls often have sudden changes of height. For example, there may 
be a 5 meter noise control wall which at one point changes to 3 meters. In this case 
the wall height should not be interpolated. To prevent interpolation, activate the 
checkbox CONSTANT ELEMENT HEIGHT. 

 
Definition of wall elements with constant height for sudden changes in the wall height 

For constant wall height, the wall is parallel to the ground and the height remains 
constant within a wall section. If the checkbox is not marked, the wall top is 
adjusted to the height of the next point. This means that the height of the wall 
elements changes within the element. Check the data with F8 or VIEW -> FRONT 

ELEVATION. 

Reflection loss for noise protection walls 

In the wall properties the reflective properties of the wall are listed, as walls have 
two sides, the properties are listed for the left and the right side (left and right side 
as seen in data entry direction).  

The reflection loss can be defined either as a single value or as an absorption 
spectrum from the SoundPLAN library. 
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Reflection properties as a single value  

The reflection properties are dependent on the material of the wall. You can enter 
the reflection loss in dB or the absorption coefficient or the reflection coefficient. 
When you enter a value, SoundPLAN calculates the other two from your entry. 

To ignore any reflections, use a reflection loss of 200 dB.  

For traffic noise you normally do not need a spectral calculation of the reflection, 
you can use the following reflection loss settings that the German RLS 90 defines: 
Wall type Reflection  

loss in dB 

Absorption  

coefficient α 

Reflection  

coefficient  

Hard (fully) reflective (concrete, glass) 1 0,206 0,794 

Absorbent noise protection wall 4 0,602 0,398 

Highly absorbent noise protection wall 8 - 11 0,842 - 0,921 0,158 - 0,079 

Reflection properties from the absorption library 

For the spectral calculation of reflection losses (only possible for standards with 
calculation frequency by frequency) the program will use the data from the 
absorption coefficient library. Open the absorption library with the symbol button. 

 

The program will either use a single value or use the entire spectrum. When you 
activate the spectral calculation, the single value will be ignored!  

For calculations that contain spectral and non-spectral sources, SoundPLAN applies 
the following logic: If a wall contains an absorption spectrum, it will be used 
directly for all sources that are entered with a spectrum. Sources without a 
spectrum will use a mean absorption value which has been derived from a 
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reference spectrum for traffic noise. The reference spectrum for traffic noise has 
been taken from the Japanese road standard ASJ 2008 (Third octaves in dB(A)): 

 

 

Additional Wall Elements (Slanted Walls) 

Open the tab Additional elements and use the + to request new elements.  

  

As soon as an element is no longer vertical, the reflection properties are discarded, 
no reflection is calculated in this case.  

The SLANT BASED ON PREVIOUS ELEMENT tilts the noise protection wall. A positive 
value will tilt it to the right (in the direction of entry of the object); a negative value 
will tilt it to the left. HEIGHT/WIDTH defines the size of an element in meters.  

If only one additional element is present, you can define the slanted element with 
the parameters dx and dy. 

 

The data is automatically calculated to the angle and height / width. 
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Via the NO. OF SIMILAR ELEMENTS ON TOP OF EACH OTHER you can request that a 
number of elements are stacked. If for example you entered a slant of 10 degrees 
and requested 9 elements, you have created a quarter pipe as a noise protection 
wall.  

Example: 

 

 

  

Galleries or wall combinations as printed in the image to the left should be 
defined as floating screens so that the reflection on the top vertical element 
still can be calculated.  

Ridges 

You can enter a ridge as a noise protection wall. The base line is entered at the 
position of the ridge in m above sea level with a wall height of 0. Assign the 
graphics-object type "ridge" for the display in cross sections and 3D-Graphics. 

Useful Geo-Tools for Walls 

Generate a wall which is parallel to a road with GEOTOOLS -> CREATE PARALLEL OBJECTS. 

Use GEOTOOLS -> MORE GEOMETRY TOOLS -> DIVIDE SECTIONS to create a wall with constant 
wall segments for Wall Design. Nevertheless, it is better to divide the roads or 
railways in beforehand. 
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 Berms 
For berms constructed as noise abatement facilities, the foot of the wall is digitized. 
The screening edges of the berm are automatically constructed from the height, tilt 
and top width.  

Berm Properties 

 

Activate the check box OPTIMIZATION to use a berm for the pre-calculation for Wall 
Design, see Wall Design (page 461). The optimization berms must be stored in a 
separate Geo-File. When a berm with different element heights is stored back to 
the Geo-Database after the optimization, the height differences are smoothed.  

Enter the height of the berm, the tilt and the top width. The tilt of the back side is 
irrelevant for noise control calculations but is used for assessing the mass to be 
moved when constructing the berm.  

The berm tilt is calculated using the factor of 1:m: 

m

1

 
Principle sketch of the berm tilt 

The factor for the wall tilt and the top width are always entered in regard to the 
data entry direction. Positive values will cause the berm (and top) to be 
constructed to the right of the entered line; negative values will construct them to 
the left of the line. 
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Data entry of a berm with tilt and top width 

Use VIEW -> REFRESH (Ctrl+ R) to show the calculated berm lines.  

 

You can click on the berm lines calculated from slope, height and top width with 
the right mouse button (CAPTURE COORDINATE) or in the digitizing mode to place a 
wall on top of the berm.  

 Floating Screens 
Floating screens can be used define a horizontal or slanted diffraction edge with a 
defined height above ground, for example the roof of a petrol station or a noise 
protection gallery.  

The floating screen is not reflective. No ground to ceiling reflections are 
calculated. 

You can define a wall height for the floating screen which may change within the 
object, e.g. if you want to define a wall only at one edge of the floating screen. The 
wall height can be negative to model, for example, the backside of a gallery. 

 

The properties of walls on a floating screen are similar to the properties of a noise 
protection wall (page 266). Enter the reflective properties, even with different 
properties for the inside and outside. The reflection properties apply only to the 
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walls, not to the screen itself. You can also declare the wall elements to be of a 
CONSTANT or a varying height. 

The reflection loss is defined the same way as for noise protection walls, see 
“Reflection loss for noise protection walls (page 267)”. 

 Volume attenuation area  
Enter the polygon enclosing the area. Volume attenuation areas are referenced to 
the DGM: 

 

 

This means, the exact course is evaluated from the profile. In the Geo-database 
graphic, the evaluation is done only for the entered points of the volume 
attenuation area. Local terrain unevennesses are therefore not always displayed.  

The first line of buildings, as viewed from the receiver, should be modeled as 
buildings for the attenuation types "industrial site" and "built-up area", for "forest" 
the whole area is defined as volume attenuation area. Volume type areas can be 
inserted in each other if the top height of the area or the absorption coefficient 
differs. In the Graphics inserted volume attenuation areas are presented as „holes“, 
if the volume attenuation areas are defined with an effective height of 0 meters.  

Principally there are three types of volume attenuation areas: 

• Foliage (forest, brushwood): Afol 

• Built-up areas (buildings that are not defined explicitly and are only included 
in the average attenuation effect): Ahouse 

• Industrial area: Asite 
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The name, the effective height above the DGM and the type of volume attenuation 
area are defined in the volume attenuation area properties of the Geo-Database.  

 

How volume attenuation areas shall be calculated is only defined in a few 
standards and not all of the possible volume attenuation standards are mentioned 
in all of the propagation standards. For this reason, the properties for each 
standard include - for each type of attenuation – a list of available standards 
(Calculation Kernel -> run properties, tab index card Standards). 

  → 

 

Depending on the selection of the standard for road, railway, industry and parking 
lots and the selection of the standard for the assessment of the volume 
attenuation areas, the parameters of the volume attenuation areas are shown 
when the box SHOW DETAILS is checked. 
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In principal the attenuation is calculated as the product of the length of the 
transmission path through the volume attenuation area and the attenuation per 
distance a. Here the attenuation per distance can be set as a fixed value (values 
between 0.05 and 0.1 dB/m are found in the literature) or be calculated from other 
parameters. 

The absorbing distance SG is the length of a specific arc (standard dependent) 
positioned between source and receiver. If screens, buildings and other 
impermeable objects are found between source and receiver, all distances 
between the tops of the objects are connected with arcs. 

Possible standards for the calculation of the attenuation:  

Foliage:  

• No attenuation (Afol=0) 
Attenuation due to foliage is ignored. 

• User defined 
Afol [dB] = d * a(f) <=Amax 

a(f) is a user specified mitigation value that can be defined as spectral values 
in octaves. If the calculation standard only calculated broad band values, the 
mitigation for 500 [Hz] will be used. 

Amax can be adjusted in the settings of the standard.  
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• ISO9613-2 

d < 10 m  Afol [dB] = 0 
10 m <= d < 20 m Afol [dB] = A10-20 
20 m <= d < 200 m Afol [dB] = d * a(f) 
d >= 200 m  Afol [dB] = 200 m * a(f) 

A10-20 and a(f) are fixed. 

• ÖAL28 

Afol [dB] = Min(4, Trunc(d/50)) * a(f) 

a(f) is fixed. 

• Nord2000 

Afol [dB] = d * a(f) 

a(f) is calculated from the average tree density, the mean tree trunk 
diameter and a mean absorption coefficient. Default values are selected for 
best fit with the ISO9613-2. 

• NTAcou099 

Afol [dB] = d * (4 * a(f) + 5) / 200 

a(f) is fixed. 

Built-up areas 

• No attenuation (Ahouse=0) 

Volume attenuation areas for buildings are ignored. 

• User defined 

Ahouse [dB] = d * a(f) <=Amax  

a(f) is a user specified attenuation value that can be entered for an octave 
band. If the calculation is broad band the value for 500 [Hz] is used.  

Amax can be adjusted in the settings of the standard.  

• ISO 9613-2 

Ahouse [dB] = d * a(f) - Agr  

a(f) is a user specified mitigation value that can be entered for an octave 

band. If the calculation is broad band the value for 500 [Hz] is used  

Amax can be adjusted in the settings of the standard  

Agr is the dampening due to the ground effect. 

• Nord 2000 

Ahouse [dB] = d * a(f) 

a(f) is calculated from various parameters to set the properties of the 
volume attenuation area.  
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Industrial site 

• No attenuation (Asite=0) 

Industrial site volume attenuation areas are ignored. 

• User defined 

Asite [dB] = d * a(f) <=Amax  

a(f) is a user specified attenuation value that can be defined as spectral 
values in octaves. If the calculation standard only calculated broad band 
values, the mitigation for 500 [Hz] will be used.  

Amax can be adjusted in the settings of the standard.  

• ISO 9613-2 

Asite [dB] = d * a(f) <=10 dB  

a(f) is fixed. 

• Nord 2000 

Asite [dB] = d * a(f) 

a(f) is calculated from various parameters to set the properties of the 
volume attenuation area.  

 Ground Absorption Areas (Ground Effect) 
Ground effect areas describe the acoustic ground properties (absorbing - 
reflecting). They are important for the acoustic model, because they influence the 
sound propagation particularly near the source and the receiver. 

 
Ground absorption properties 

Nearly all standards evaluate different ground properties of acoustically hard or 
soft ground for the propagation calculation; most of them use the ground factor. 
TNM (USA), ASJ (Japan) and Nord2000 describe the ground effect by the "effective 
flow resistivity", Nord2000 additionally uses the parameter "roughness class". 
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Below is a list of the settings of the different standards, with the default values 
used when no ground absorption area has been entered, highlighted in gray. So 
you only need to enter ground absorption areas where the ground properties 
deviate from the default values. 

The ground factor G is accordingly defined 

G = 0: 100 % hard ground. Asphalt, concrete, pavement, water, rough scattering 
area, industry site. 

G = 1: 100 % soft ground. All with possible or present growth (agricultural, forest, 
grass, garden). 

G = p/100: Partially soft and hard ground. Percentage p of soft to total ground. 

The effective flow resistivity has the following selection possibilities (the respective 
Sigma value is displayed in the selection list) 

ASJ: Concrete, asphalt 

ASJ: Hard ground surface such as sports ground 

ASJ: Soft ground surface: farmland, cultivated rice field 

ASJ: Lawn, rice field, grass 

TNM: Field grass 

TNM: Granular snow 

TNM: Hard soil 

TNM: Lawn 

TNM: Loose soil 

TNM: Pavement, water 

TNM: Powder snow 

N2k: A: very soft (snow, moss-like) 

N2k: B: soft forest floor (short, dense heather like or thick moss) 

N2k: C: uncompacted, loose ground (turf, grass, loose soil) 

N2k: D: normal uncompacted ground (forest floors, pasture field) 

N2k: E: compacted field and gravel (compacted lawns, park area) 

N2k: F: compacted dense ground (gravel road, parking lot) 

N2k: G: hard surface (most normal asphalt, concrete) 

N2k: H: very hard and dense surface (dense asphalt, concrete, water) 

Roughness class  Nk2: 

N: Nil ± 0.25 m 

S: Small ± 0. 5 m 

M: Medium ± 1 m 

L: Large ± 2 m 

The ground factor G and the effective flow resistivity are not linked, that is, for ASJ, 
TNM and Nord 2000 calculations, the input of the ground factor is not relevant. 
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Use the setting CREATE GROUND AREAS FROM ROAD SURFACES in the run properties 
under the tab settings in order to set all roads to acoustically hard surfaces for the 
calculation, unless all roads are within a hard surface area (e.g. within a town). 

Ground effect areas with different ground properties may be nested into each 
other but must not cut (this leads to a calculation abortion). To check the ground 
areas, they can be displayed in the Calculation Kernel in different shades of gray 
(VIEW -> GROUND EFFECT AREAS).  

 

In the Graphics inserted ground effect absorption areas are presented as „holes“, if 
the ground absorption areas are defined with a ground factor of 1. 

 Area usage 
Use the object type area usage to derive noise limit exceedance for conflict maps 
and to take penalties for the rest hours for the assessment according to TA Lärm 
for Grid Noise Maps and Meshed Noise Maps into account.  

In SoundPLAN you can define different usage types which may be assigned 
different limit levels depending on the used assessment. To change usage names, 
go to the SoundPLAN Manager OPTIONS -> SETTINGS, branch usages. The time slices, 
noise limits and penalties are defined in the assessment library. 
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In addition, you can use the area usage to enter or import the number of 
inhabitants per area or block for evaluation and annoyance analyses.  

For evaluation and statistics, the number of inhabitants can be transferred with the 
GeoTool Distribute occupants (page 168). 

The number of inhabitants can be inserted in an area table (Spreadsheet) and used 
as evaluation criterion.  

The Swiss cost / benefit index evaluates the fields NUMBER OF FLOORS and FLOOR-

SPACE INDEX, see “Calculation of the Swiss cost benefit index (page 454)”.  

To make the area usage available for buildings and receivers it need to be 
transferred to the buildings, see building properties (page 258).  

 Single Point Receivers 
Single point receivers are used for single point calculations and for the Wall Design 
pre-calculation with single points. A receiver can either be a measurement point or 
a receiver in the garden or it can directly be assigned to a building. Assigned 
receivers inherit the relevant properties of the building.  

One receiver can have any number of floors. This means that one receiver 
definition represents receivers in different elevations which is defined with the 
distance between the floors (no matter if a receiver is assigned to a building or 
not). 
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Receivers assigned to buildings 

SoundPLAN uses the building reference to recognize that a receiver is connected to 
a building. This is necessary to correctly consider the reflection at the assigned 
façade according to the used standard (no reflection or façade correction). 

Activate the object type "receiver" and left click near the building side where you 
want it attached. In the properties dialog a zoomed window of the area around the 
receiver is displayed. To assign the receiver to a building, click on the desired 
façade in the preview picture. If you specifically want to consider only the noise 
intake in the sector that is not screened by the building, assign the receiver to the 
façade with the shift key pressed (not recommended!). If the check mark CENTERED 
is active, the receiver is placed on the center of the façade, otherwise the position 
where you place the cursor on the façade is used. 

The properties of the building are transferred as a default to the receiver: The 
building name as receiver name, the area usage and the information on the floors. 

The standards specify the position where the noise should be calculated, for 
example beneath the floor ceiling or in the middle of the window. The distance to 
the façade (DIST. FACADE) is defined in the standards, too. 

  

When assigning the receiver, the distance of the first calculation point from the 
ground floor elevation (RECEIVER HEIGHT ABV. GF) and the position of additional 
calculation points (FLOOR HEIGHT) are transferred from the building properties to 
the tab index card floors as well as the number of floors and basement floors. This 
information defines how many calculation points are automatically positioned on 
top of each other.  
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Receivers at a dormer are not moved inwards. In order to have correct calculations 
for these receivers, half the roof height above the gutters should be added.  

 

Assign receivers without transferring the building properties 

A receiver can be assigned to a building without assigning the building properties, 
for example to process imported measurement points if you keep the Ctrl-key 
pressed. It is important to deactivate the check box CENT. (centered). The elevation 
of the receiver is used as calculation height; the height above ground floor is set to 
0 and the number of floors to 1.  

Receivers at basement floors 

If a building has the front even to the ground but is located on a slope, the backside 
of the building may still be exposed to noise albeit it is a basement room and needs 
addressing with SoundPLAN. For the location of basement floors, the floor height is 
subtracted from the ground floor slab elevation. Receivers below grade will not be 
calculated. This is the same for receivers at positions where a neighboring building 
will prevent the intake of noise. They will only be calculated if they are 0.5 m above 
the neighboring building. 

Free field receivers 

The object elevation is the elevation of the first calculation point above sea level. 
Define the number of floors and the vertical distance of the calculation points 
(HEIGHT OF FLOORS) in the tab index card floor.  

If a receiver is placed on a balcony in front of the main facade, the influx of noise is 
to 360 degrees including the reflection on the facade. 

To transfer the building properties for a receiver on a balcony you can reference 
the receiver to the building with the needed distance from the façade and delete 
the building number in the field BUILDING REF. later.  
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Limit the angle range 

Most often the noise is assessed for 360° to include the noise from the other side 
of the building. However, some standards or assessments require a limited 
segment for noise intake. A limitation of the angle segment might also be used if 
you want to examine one single angle segment for the detailed calculation 
protocol. 

Activate the check box LIMIT ANGLE RANGE, then click on the angle beginning 
(counterclockwise) and then on the end of the angle. 

Calculate the noise for a receiver (attached to a building or free field) in 
the receiver properties 

Open the receiver properties and click on the button CALCULATE. If a receiver has 
just been generated or if there are changes in the properties, the dialog must be 
closed and reopened for the changes to take effect. 

The first call to this facility will open the calculation settings so that you can check 
them.  

When you calculate receivers from the Geo-Database next time, the 
parameters from the last run will be used, check or modify them by clicking 

on the wheel symbol.  

The calculation kernel is opened in the background and calculates the current 
receiver. The calculation results and the level chart are displayed so that you can 
check quickly if a planned noise protection wall is sufficient to keep the noise below 
the limit or if the noise from a road carries further requiring you to model 
additional geometry.  

The values are only temporary, they are only visible as long as the receiver 
properties dialog is open; the values are discarded when this dialog is closed 
because the geometry might have changed when opening the dialog, the next time. 

 

The logbook for the calculation is opened with a button. When hints, warnings and 
errors were found in the calculation the font of the text “Logbook” changes to blue-
cursive for hints, red-cursive for warnings and red-bold for errors. 
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Receiver representation in the Geo-Database 

The colors of assigned and not assigned receivers differ. A yellow circle displays a 
not-attached receiver, a green circle shows that a receiver is assigned to a building 
and a red circle shows that the receiver was originally assigned to a building, but 
the assignment got lost.  

 

The assignment of a receiver to a building might get lost if the buildings were 
copied. If you see red receivers in the Situation or if the calculation kernel or the 
preflight displays the warning message ""receiver name" assigned building not 
found" update the building reference with the Geo-Tool “Reassign receivers to 
buildings (page 165)”.  

 

Display the receiver properties to see the entered angle range: Receiver with 360° 
(on the right), 180° (in the middle) and 5° (on the left).  

 Cross section 
Cross sections are used to define the cross section for cross sectional grid noise 
map calculations.  

Enter the two coordinates for the cross section. Elevation lines, spot heights, roads, 
railways and berms are used to define the terrain. The ground relief is 
automatically calculated out of the highest and the lowest point of the relief.  

A cross section of the input data can also be defined in the graphics. 

Display of Objects in the Cross Section 

Point objects are displayed and used for the calculation if the distance between the 
point and the cross section is smaller than a defined maximum distance. The 
maximum distance for the calculation is defined in the run kernel. For the display of 
point objects, the distance can be entered in the graphics.  

There are two types of line objects. One has a wall height, such as walls, the other 
is only available as a line, such as line sources, emission bands and so on. Walls are 
displayed as a vertical line, the others as horizontal lines with a length of 10 cm. 

There is also a difference in the definition of areas. Areas with height (buildings, 
volume absorption areas) are displayed as a cross section through the area; areas 
without height (road and railway bands) are displayed with a thickness of 10 cm.  
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 Calculation Area 
Calculation areas are used to define the area for grid type calculations for noise. 
The calculation area can be any form or shape, convex or concave. 

The calculation area polygon itself does not require elevation information. The 
calculation area must therefore be within the area where elevation information is 
available unless the whole project is referenced to 0. 

For Grid Noise Maps a receiver grid is generated using a digital ground model 
according to the selected height above ground and the grid size which defines the 
position and calculation height of the grid receivers.  

The calculation area limits the area for Meshed Noise Maps in which succeeding 
triangulations define the receivers.  

Use the calculation area for Façade Noise Maps and single point calculations to 
limit the area in which the receivers are calculated. Receivers outside the 
calculation area are displayed in gray in the graphics tab index card of the 
calculation kernel.  

 

A grid of receivers is generated within the calculation area with all receivers at a 
user defined height above the ground. The noise or air pollution values are either 
calculated or interpolated for each of the grid points. 

Except for Meshed Noise Maps more than one calculation area may be included in 
the calculation data. If a calculation area is inside of another the overlapping area is 
not calculated. 
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 Geometry Texts 
Enter geometry referenced texts such as road names, house numbers and other 
describing texts as geometry texts. They are positioned at a location fixed in world 
coordinates and adjusted to the map in the graphical presentation (length scale 
and rotation). Texts describing particular elements of a plot are entered in the 
Graphics in sheet coordinates. 

If many geometry texts are part of the data, the drawing speed is greatly reduced. 
Click on the symbol  next to the object selection list to display only the text 
position cross but not the text itself. 

Text properties 

 

Enter the text and look at the text in the graphics window. The cross marks the text 
coordinates. The text size is shown in [m]. Define the text font, character size, color 
and attributes (normal, bold, italic, underlined). Click the appropriate field. Clicking 
the color selection field opens the color palette.  

The ROTATION can be entered manually in degrees or by dragging it with the 
mouse. Move the mouse with the right button depressed until the text is suitably 
aligned. The dotted line helps with the alignment of the text. 
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The ALIGNMENT determines the text direction from the text anchor: 

 

The position of the little cross at the text is the anchor for rotating text. The angle 
of rotation is entered in degrees.  

You can reposition the text with the little cross cursor. Move the cross to a new 
location and the text is anchored at the new location. 

If there are many geometry texts in the data, the speed of drawing the 
objects on the screen decreases sharply. Click on the "Hide properties" icon 

next to the object selection list, to display only the cross but not the text. 

   Point, Polyline, Area 
Points, polylines and areas are general objects without calculation relevant 
properties, but they can have elevations. The layers from DXF files are always 
imported as points, lines and areas and afterwards transformed to SoundPLAN 
objects with the relevant acoustical properties.  

You can use these general objects to display additional objects in the graphics if 
you assign a graphics object type (page 150) such as the boundary of the 
investigation area, a river or trees for the 3D-view. 

 Photo Point 
[Module Cartography] Photo points describe the location of the photos you took 
for example during a site inspection. Aside from the link to the picture file you can 
enter a description, a name, an object number (page 52) and the direction. Photos 
with GPS data can be imported, see "Import of photo points with GPS data” (page 
112). 
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Photo point definition in the Geo-Database  

The photo documentation in the Geo-Database enables you to document the 
situation with photos taken with a digital camera. The dataflow is complete from 
the entry in the Geo-Database over the display of the photo locations in the 
Graphics to the printout of the photos. As you can use the page layout you can 
easily create the photo documentation for the annex of your report. 

Photo documentation 

The pictures you have defined as photo locations in the Geo-Database are 
automatically transferred into the folder "Photo" in your current project. In the 
properties of the photo define the view direction and angle and under the tab INFO 
write your description of the photo. Enter an object number for the photos to 
ensure that you can identify the photo locations in the Graphics sheet in the 
printout. 

Open the photo documentation in the Geo-Database with DOCUMENTATION -> 

PHOTO. 

Customize the layout of the printout. The place holder shows the placement of 
portrait and landscape pictures within the frame and adjusts with modifying the 
number of pictures on the page. The actual layout on the page is visible in the 
preview section. 
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Above the photo you can enter the photo number and the title (name) from the 
photo point definition as well as the file name. The description from the photo 
definition can be placed. Customize content and layout under show/font below the 
picture.  

The WIDTH OF THE SEPARATION LINE determines the line width around the picture 
with all information. 

 

Define which information with which layout shall be included in the photo 
documentation. View the changes in the layout in the layout preview. 
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Define the spacing of texts and pictures and the size of frames and lines under the 
tab picture area. 

Define the page layout with the customary header and footer sections.  

 Tree 
 The object type Tree with the selection of the tree type and the height of the 

tree. The additional properties for the configuration as a rotational symmetrical 
object and to define the thickness of the tree trunk are defined in the object types 
of the Graphics. The height of the tree is used to relate to the thickness of the tree 
trunk.  

 Map section 
 New object type map section: With this new object you can enter map sections 

in the Geo-Database or store the current map section in the Graphics as a Geo-File. 
See Map section, overview map and sheet tools (page 657).  

 Camera track / Animation track 
[Module "3D Animation"] With the object type camera track you can define a free 
animation track for the 3D graphics, for example a flight over an investigation area. 
Use the GeoTools for the spline interpolation to generate a smooth flight from a 
few sampling points. There is an example in the demo project "Wincity", Graphics 
sheet 7-1. 

 Value grid (Scandinavia) 
(Module "Tools NMP") A new object type "value grid" is introduced for the layout. 
In some countries the population numbers are available in a grid of 100 by 100 
meters. The ASCII file containing this information has the fixed format: 

municipality code gridID households persons 
157 7197_61835 12 31 

157 7197_61836 10 23 
157 7197_61837 8 26 

157 7197_61838 8 22 

The GridID is the yx Coordinate of the lower left-hand side divided by 100. In 
SoundPLAN the fixed format was extended to allow values from a general value 
grid to be entered.  

For the adaptation of the specialized table a convert program is available, which 
resolves the GridID into x and y coordinate components (jklconvert.exe).  
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After converting the data, they can be imported via the ASCII data import.  

In the standard properties of the value grid you can enter the grid spacing, the 
reference for the value grid (lower left-hand side or middle of the grid) and a 
description of the value.   

The population figures are distributed to individual buildings with the Geo-Tool 
Distribute occupants (page 168). 

 

Buildings that are located in multiple grid cells are assigned to belong to the grid 
cell where the center of gravity of the building is located. 
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5  Libraries 

In SoundPLAN, basis data such as emission spectra, transmission loss spectra, 
directivities or train tables is managed in libraries.  

There are three library hierarchies. The system libraries delivered with SoundPLAN 
and updated and extended with new updates, the global libraries to host your own 
reusable information and the project libraries containing only the data needed in a 
project. 

The system libraries contain many elements coming from very different sources. 
The different standards and publications are evaluated as well as manufacturer's 
data e.g. for transmission losses of noise protection walls or directivity 
characteristics of loud speakers. The source and, if needed, comments how to use 
the data are described in detail. 

Standard dependent data, for example the train tables or the meteorological 
parameters for Nord2000, originate from the standards. 

In most of the cases you won't open the libraries from the SoundPLAN Manager but 
click on the library symbol in the different objects of the Geo-Database. This button 
directly opens the library you need. A click on the button behind the emission 
spectrum of a noise source immediately opens the system and the project emission 
library. Moreover, intelligent filter functions and the assignment of elements to 
groups help to quickly find the needed spectrum in the system library. 

Data organization of the libraries 
The system libraries are installed in the SoundPLAN program sub directory under 
the path "language"\System\libs. "en\system\libs" is the default for the English 
libraries, but there are some amended libraries available for different countries 
(especially the assessment library). 

You can toggle between several installed system libraries in the SoundPLAN 
Manager, OPTIONS -> COUNTRY AND LANGUAGE SETTINGS.  
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By default the path for the global libraries is "..\Documents\SoundPLAN Globdata 
x.x\ libs" as soon as you store own library elements globally.  

You can change this path in the library via LIBRARY -> GLOBAL PATH. The global path 
may also be on a network drive to enable the access to the same system library to 
all SoundPLAN users.  

As a common approach means that data on the server may be changed, it is 
mandatory that a local copy of the data is available that cannot be changed by 
someone else. Therefore, SoundPLAN creates a local empty copy of the library in 
the project folder when the library is opened for the first time in a project. You can 
then copy the required library elements to the project library. If no library data is 
accessed in your project, no local libraries are cluttering your hard disk.  

Working with the Libraries 
The libraries are automatically opened when data from the libraries is required in 
the properties of an object. This is the case for example for day histograms and 
spectral data describing sources or the absorptive characteristics of reflective walls.  

According to the needs of the respective library, the number and content of the 
index cards may vary. The next section describes the general features of the library 
and the special requirements of the libraries.   

 
The libraries with the example of the emission library 

The libraries consist of two parts. A list of all elements is shown in the left window. 
New entries are inserted in this list. The right window is fitted with several index 
cards that are specific to the library type. The index cards contain spectra, 
numerical values, group definitions, noise limits, diagrams, etc...  
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Edit Library Elements 

The library elements are managed in a database. Each element is a record which 
can be edited, generated and deleted. The symbol bar is used to control the 
records:  

 
When you are editing a library element and want to move to the next element, 
SoundPLAN asks if you want to store the changes in the library or continue editing. 
If you do not want to permanently store the data in the library, press undo the 
changes, otherwise you will not be able to leave the edit mode.  

Deleting multiple elements from a library: With Ctrl+ left click on the elements you 
want to delete and then use the red “minus” sign in the navigation bar to delete 
them. Multiple consecutive elements can also be marked with shift and the arrow 
keys, all elements are marked with Ctrl+A. 

Copy Library Elements 

Records can be copied from the global to the project library and vice versa, from 
the system library to the project library, from the library of a different project or 
within one library.  

To copy one selected element from the system to the project library, click on 
ACCEPT in the system library. It is copied and assigned to the source after you 
clicked ACCEPT in the project library. 

To copy several elements or elements from another library select the records to be 
copied (Ctrl+ left mouse click for single elements and Shift+ arrow keys for an 
element block) and click on > PROJECT OR > GLOBAL.  

 

If one of the elements already exists in the target library, there are several options 
how to handle it: 
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The global library is only generated after you copied an element to global. 

Copy values 

You can use the clipboard to paste hourly values from external software (e.g. an 
Excel spreadsheet). 

Make sure the cursor is placed in the table and not in the section of the element 
name (the element name may not be highlighted) and press Ctrl+ C. 

 

Select from the list what you want to copy. The menu item TOTAL GRID WITH 

HEADER is only possible for copying to an external program. 

Then select the element to copy the values to, make sure that the table is active, 
and press Ctrl + V. 

You can copy the definition of a complete element if you click right on the element 
name, copy it to the same library and give it a new name. 

Enter Comments and Numeric Values  

For each record you can enter a comment of any length and descriptive 
parameters. It is often useful to document the origin of the data, the literature 
where information was found, the reliability of the data and any special knowledge 
about the elements.  
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Up to 4 CHARACTERISTIC VALUES for example for size, weight or speed can be set in 
the tab index card Characteristics. 

Edit Sum 

The sum level of a frequency spectrum can be modified for all octaves / third 
octaves by a fixed value. Click on the right mouse button in the tab value and select 
EDIT SUM. Enter the new sum or enter a value with + / - by which the spectrum 
needs to be adjusted. The difference between original and new sum is added up to 
each frequency.  

 

Group Reference 

A library element can be assigned up to four groups. The groups function as search 
criteria and will appear in the source documentation.  

 

To assign a record to a group, open the index card for groups. The four 
empty fields can now be assigned a group by opening the selection arrow. If 

none of the present groups fit your needs, a new group can be created using the 
navigation keys  

If several people in your office use SoundPLAN, coordinate the nomenclature 
so the group will not lose its usefulness quickly.  
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Delete (the minus in the navigation bar) removes a group definition. Caution!! All 
records belonging to this group will lose the membership to the group!  Please 
think first and delete later!  

Scale of the Y Axis 

For the graphical presentation of spectra (source, absorption, transmission and 
attenuation) the Y axis default is set to the auto scale mode and is filling the entire 
available area optimally. If you want to browse and compare spectra quickly, it may 
be advisable to disable the auto scale function and assign a value range. To do this, 
open „View“ and disable the „Auto Scale“ mode in the „Y-Scale“ entry. The fields 
Min and Max indicate the range you will see from the spectral data in the graphical 
form.   

 

Color definition 

Colors can be customized for the printout of the libraries and graphics within the 
documentation.  

Select VIEW -> COLORS. If selection positions are not available, then they do not 

apply to the library currently open (assessment library). Double clicking color 
modifies the colors.  
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Backup copy of libraries 

The libraries offer the possibility to save the library as a backup (FILE -> BACKUP). 
The numbers of the library elements are kept intact so that the references between 
the library elements and the sources etc. will not get corrupted. The backup of the 
library is hosted in the folder "Backup". This backup copy can also be used to 
convert a project library by copying the project library from the backup folder into 
the project. 

Emission, Absorption, Transmission, Attenuation 
Libraries - General 

On the first tab you see the graphics with the diagram and the sum level, a picture 
of the element (if one exists) and a comment to the origin of the spectrum.  

 

Filter functions 

You have filter functions at your disposal to filter the library elements according to 
the membership in groups (in addition you can use AND or OR to filter according to 
2 groups), within a certain value range, or according to a text which is included in 
the element name or the description. 

Insert pictures 

In the picture area you can assign your own pictures or sketches to each element. 
As the pictures are stored directly in the library, the size of the image files should 
be as small as possible. Without resizing the picture area, graphics of 250 x 250 
pixels are displayed in total, this for practical means should be the max size for the 
pictures. The frames can be resized by grabbing and moving them. 
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Press the right mouse button and select LOAD to select a picture file or select 
INSERT to enter a picture from the clipboard. If you want to remove the picture, 
select CLEAR.  

Insert OLE links 

In addition to the direct storage the program offers 2 OLE connections to connect 
library elements with any information such as a recording of the sound of the 
source, a measurement protocol in a word file or an Excel spreadsheet.  

The files you are connecting via OLE will be copied into the project respectively the 
Globdata area. This ensures that the data will be copied with the project. The 
library only contains the reference and this way does not get too bloated.  

With a double click or via the right mouse button you can start the program behind 
the OLE connection. If you copy the library element to a different project, the 
background files are copied along with it.  

Emission Library 

 

Select whether the values are available as OCTAVE or THIRD OCTAVE SPECTRUM or as 
CENTER FREQUENCY and determine the lower and upper boundary of the frequency 
range respectively the center frequency.  

Enter the values in the table or use copy & paste if values are available e.g. in an 
Excel sheet.  

Check your data to see if it is linear or weighted with an A..D filter, and select the 
filter type accordingly.  

If your data is available in [dB] but you want to keep it in the library as an A 
weighted spectrum, enter the data as a linear spectrum and change the weighting 
to [dB(A)] after the data is typed in. SoundPLAN will ask you whether you want to 
convert the spectrum. Click "yes" to convert the spectrum. "No" only changes the 
display, the linear spectrum remains unchanged.  

Above the emission spectrum with the selected frequency filter the spectrum is 
shown with a linear filter. The user defined spectrum and the selected filter are 
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displayed in blue. You can modify values in the filtered or the linear spectrum. 
Either way, the values of the other spectrum are immediately calculated to reflect 
the modification.  

Select whether the spectrum is a sound pressure level for transmission purposes 
(Lp level), a total sound power level (Lw/unit) or a length- / area-related sound 
power level (Lw/m,m²). 

HEIGHT ABOVE GROUND: If the emission of a source is always in the same height 
above ground, you can determine the source height relative to the ground already 
in the library. When the spectrum is transferred to a source the source height is 
transferred, too. In the property dialog of the source the check box USE LIBRARY 

DEFINITION in the group box TERRAIN REFERENCE must be activated.  

STANDARD DEVIATION: For some sources the measurement uncertainty can be 
assigned to the library element. If assigned, the standard deviation is transferred to 
the source together with the spectrum. 

Low frequency noise 

The wave length is the only parameter for the screening, it can be calculated for 
any frequency. The air absorption in accordance to the ISO 9613 / 1 also can be 
calculated for any frequency. 

Ground effect: For standards such as the Nord2000, the ground effect is calculated 
explicitly as a function of the frequency, therefore the ground effect is valid for any 
frequency. For standards based on the ISO 9613 or CONCAWE where the ground 
effect is only defined for certain octave middle frequencies, the value of the lowest 
defined frequency is used, because the ground effect changes only insignificantly 
below this lowest octave band. 

Assignment of a directivity 

You can assign 2D or 3D directivity adjustments from the directivity library to the 
source. Select an already in this project stored element from the selection list or 
click on the library symbol to open the directivity library (page 304).  
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Conversion of sound pressure spectra into sound power spectra 

When a frequency spectrum is only available as a sound pressure spectrum in the 
emission library and the situation is sufficiently simple (assumption source is a 
point source) the spectrum can be converted to a sound power spectrum. 

Open EDIT -> CONVERT SOUND PRESSURE TO SOUND POWER (or click right mouse 
button while the cursor is on the spectrum). 

Hint: The reference must be set to “Lp/level, before, afterwards it will be 
referenced per “Lw/unit”. 

 

Select the surface type that was the basis of your measurement of the sound 
pressure level. Enter the distance D in meters at which the measurement was taken 
and enter the width, length and height in meters for machines the equivalent size 
of a box. By clicking the OK button, the sound pressure spectrum is converted into 
a sound power spectrum and the reference is set to per unit. 

Absorption library 

 

Select either OCTAVE or THIRD OCTAVE SPECTRA and determine the lower and upper 
boundary of the frequency range.  

Enter the ABSORPTION COEFFICIENTS (vales between 0.001 and 1) in the table or use 
copy & paste if values are available e.g. in an Excel sheet.  
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The SCATTERING COEFFICIENT is used in SPD calculations and describes the diffuse 
scattering of particles after impact with the absorption surface. The scattering 
coefficient depends on the roughness length and the frequency. Selecting a surface 
profile depth from the button ESTIMATE SCATTERING COEFFICIENT FROM ROUGHNESS 
provides an educated guess for suitable values. If you can obtain more accurate 
values, enter the scattering coefficient manually. 

If the scattering isn’t high enough, unphysical structures can emerge in the sound 
field; zero scattering is for academic purposes only. 

For fibrous absorber materials, the effective flow resistivity is often given instead of 
the absorption coefficients. The absorption coefficients can be calculated from the 
effective flow resistivity. 

Right-click on the values and select CALCULATE ALPHA VALUES FROM FLOW 

RESISTANCE. First, frequency-dependent complex impedances are calculated from 
the effective flow resistivity ("M.E.Delany and E.N. Bazley: Acoustic properties of 
fibrous absorbent materials, Appl. Acoust. 3, 105-116, 1970"). Subsequently, the 
absorption coefficient is calculated from the complex impedances ("P.M. Morse 
and K. Uno Ingard, Theoretical Acoustics, ISBN 0-691-08425-4, page 580"). 

Transmission library 

 

Select whether the values are available in an OCTAVE or THIRD OCTAVE spectrum or 
as a SINGLE VALUE and determine the lower and upper boundary of the frequency 
range for frequency dependent transmission loss. Select whether the values refer 
to the SOUND REDUCTION INDEX R or to the NORMALIZED LEVEL DIFFERENCE DN,E (EN 
12354). 

Enter the values in the table or use copy & paste if values are available e.g. in an 
Excel sheet. 

The correction factors C and Ctr are used calculations according to EN 12354.  
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Attenuation library 

 

The attenuation library is used with the module Expert System Industry. Select 
either octave or third octave spectra and determine the lower and upper boundary 
of the frequency range.  

Enter the values in the table or use copy & paste if values are available e.g. in an 
Excel sheet.  

Directivity library 
The directivity library stores the directivities in different variants horizontal, with 
rotational symmetry, 3D and full-3D. The directivity elements are assigned to a 
source via the emission library. Broadband sources with only a mean frequency and 
those with an emission spectrum can be associated with directivities.  

 

Enter directivity 

Under the tab settings select the directivity type, the rate of angular increment and 
the frequency resolution.  
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If all angles and values are available in the selected angular step size (5° or 10°) 
enter them in or copy them to the tab values in angle step. If angles and values are 
provided in another step sizes you can have the program interpolate the values for 
5° or 10° steps from the available values. To interpolate, open the tab raw data and 
process them under this tab.  

Add new lines by clicking on the red plus sign or generate multiple 
angles/values with help of the WIZARD. 

 

Enter the STEP SIZE of the pairs to be generated and if needed an OFFSET of the first 
pair against the 0°.  
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Depending on the directivity type that you have selected, enter the values for the 
angles Phi and/or Theta. For frequency dependent directivities you need one value 
for each frequency. The pairs are entered in a way that for each direction where 
values are known the angle and the level difference to the neutral in dB is entered 
in the table. The raw data are immediately converted into the requested angular 
steps. The raw data are still saved so that it is possible later on to understand the 
relationship of the raw information and the derived directivity pattern.  

Interpolation 

Under the tab diagram you find three different spline functions for the 
interpolation.  

 

The tension factors respective the Fourier order can be set between 1 and 30, it 
will influence the smoothness of the spline. The tensions factor/Fourier order 1 is 
equivalent to the cubic spline. The interpolation line is marked in color.  

0° is the axis of the noise sources. For the assignment of sources to the facades it is 
the normal to the building's facade pointing away from the building.  

Double or quadruple symmetry 

Certain symmetries (quadruple and double) the program will recognize 
automatically if data are only made available for angles between 0° and 90° or 
between 0° and 180°. 



SoundPLAN Manual 8.1 
Libraries 

Directivity library  Page •  307/793 

5 

Data entry example for double symmetry 

angle  delta [dB] 
30  5 
60  5 
90  4 
120  3 
150  2 
180  1 

Data entry example for quad symmetry 

angle  delta [dB] 
20  5 
40  3 
60  1 
80  -1 
90  -2 

Change to the tab Diagram – the values will be filled in for all quadrants. 

3D-directivity 

The full-3D-directivity most of the time will be describing a loudspeaker or a signal 
horn and the directivity pattern most often can be imported from the 
manufacturers data. When you import the spectrum of a loudspeaker, the 3D 
directivity is automatically imported at the same time and stored in the directivity 
library, see "CLF Import (page 316)". 

The delivered 3D directivities are loudspeakers, normalized to 0 dB. This means, 
that the loudspeaker emits to the z direction. The directivity must in any case be 
adapted when you assign a directivity to a source.  

  
Emission in z direction 

In case you want to compile your own 3D-directivity, SoundPLAN has a wizard to 
generate the values for phi and theta.   
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3D of horizontal and vertical directivity 

If you get information about a horizontal and a vertical directivity for a source, you 
can use this information to construct a 3D directivity. 

In the tab Settings, FULL 3D must be selected as the directivity type. Click on the 
WIZZARD in the tab Raw data and check mark HORIZONTAL AND VERTICAL CUT. Enter 
the horizontal directivity values in the front, left, rear, and right areas, and the 
vertical directivity values in the front, top, rear, and bottom areas. At the points of 
intersection of the two directivities (front / rear), the entered value must be 
identical. 

3D-presentation under the tab Diagram 

For rotational symmetry and full-3D-directivity under the tab Diagram you find the 
cross section and additionally a 3D-representation for each frequency available.  

 

With the left mouse button, you can rotate the 3D-view into the horizontal 
shift+left mouse button rotates around the vertical axis and Ctrl+ left mouse 
button has all degrees of movement active.  

With the right mouse button toggle between the displays: 

 

AS SPHERE shows the values of the directivity as a color-coded sphere. The coloring 
indicates the addition to the average that makes up the directivity. The display 
tools SHOW RASTER, SHOW CIRCLES and PLANES help with the checking of the data 
for the directivity. 
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Li(Calc) day history frequencies 
When there are multiple sources present in an industrial building, each with a 
spectrum and a day history, each receiver in the factory hall has a frequency 
spectrum of its own that can vary by the hour. For Grid Noise Maps this is not 
relevant, but it is for receivers close to the halls walls that are used to drive the 
Hallin/Hallout calculation. For the calculation of the indoors noise levels for the 
sake of calculating transmission through the wall and calculating the propagation 
into the environment, these data are stored in the Li(Calc) day histogram spectra 
library.  

When selecting the calculation type LI(CALC)+CD -R in the industrial building an 
(empty) element is generated for each component in the Li(Calc) library. After 
executing an indoor - outdoor calculation the elements are assigned the respective 
value for each hour of the day.  

 

This lib contains the day history frequencies as a calculation result of an indoor 
simulation. You cannot enter own elements. 
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Day Histogram Library 
The day histogram or times of operation are needed for sources not transmitting a 
constant sound power over 24 hours. Often the noise assessments prescribe a 
quiet time during the day where a penalty is added to the noise level of quiet 
hours. Single descriptors similar to SEL, LDN and others can be created and 
customized only if the sound power is known for the entire day. 

For each hour of the day the information on the status of the source is needed. The 
source can be active 100% or a fraction of it. The definitions of the fraction can be 
either the number of noise events during the hour or the fraction of time during 
which the source is active (either so many minutes or seconds per hour or as a 
percentage). If the selected base data is events per hour, the sound power needs to 
represent a single event.   

 

Example: A fork lifter drives between the store and the production hall 20 times an 
hour. In this case the sound power of the source should be set to cover a single 
event and the day histogram should be for 20 events per hour.   

Use the +
   

to request a new element and click on the index card for VALUES. Enter 
the duration of the event.  

You can define the hours of operation in one of the following modes:  

• minutes / hour 

• seconds / hour 

• events / hour 

• % 

• dB  

The values in a dB day histogram are always added to the sound power level of 
the source. When you enter measurement values in the dB day histogram that 
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refer to the total sound power level the sound power level of the source must be 
set to 0 dB. 

The value in the dB day histogram must be -1000 dB for hours in which a source 
does not operate. 

The day history with the units %/h, min/h and sec/h can now be INVERTED with the 
click of a button. This is particular helpful to generate for example „door closed“ 
from the day history of „door open“. 

The Road Day Histogram Library 
For different road types, the number of vehicles or factors for each hour is entered 
in the road day histogram library. The library manages the vehicle types defined in 
the appropriate standard. Therefore, SoundPLAN divides the vehicle types into cars 
/ trucks or cars, noise reduced / normal heavy and light trucks.  

Assign the road types in the road properties of the Geo-Database, according to the 
entry type of the emission calculation. 

You can either enter the number of vehicles of an actual traffic count or the factors 
of a characteristic time distribution for a specific road type. 

 

Use the DISPLAY FORMAT to select if decimal places should be displayed and how 
many to display. The display format is necessary because the elements may contain 
factors of the average daily traffic (ADT) (e.g. 0.008 * ADT) or vehicles per hour (e.g. 
12,500). 

You can choose to display "-" for values equal 0, to get better clarity. The definition 
of the display format is fixed, so you have to define negative values (in the middle 
range), too, even if it doesn't make sense in this case. 

+;-;0 Definition of the value range  

0.00;-;- Shows positive values with two decimal places and 0 as "-". 

0 Shows all values without decimal places. 

A semicolon separates the ranges; a point separates a decimal. 

Select the appropriate standard from the selection list STANDARD. SoundPLAN 
summarizes standards with the same vehicle types. 
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Activate DO NOT NORM if the sum of all 24 values is not 100%, as for the table 3 of 
the RLS-90. 

Assessment Library 
The assessment library contains noise limits for defined usage areas and 
procedures for evaluating the level. SoundPLAN is delivered with a number of 
assessment standards, but the library can be amended with your procedures and 
noise limits.  

The noise limits vary depending on the type of noise, the assessment procedure 
and the characteristic of the area (area usage). The area usage abbreviations and 
the name are adapted in OPTIONS -> SETTINGS in the SoundPLAN Manager, branch 
area usage. 

Creating a New Assessment Record 

Create a new element. In the index card DEFINE set the time slices for which the 
assessed noise levels shall be calculated from the 24 hours of the day. A single time 
slice is the minimum requirement.   

 

Define the assessment type for the time slice, Leq or one of the Lmax types. Enter 
the name of time slice and identifier in the appropriate fields and define the hours 
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assigned to a specific time slice. The identifier is used to characterize the time slice 
in the documentation.  

TA is the number of hours for averaging the time slice in the assessment level. 
SoundPLAN calculates the assessment level using the formula sum over the hours x 
1/Ta. Ta may cover the all hours of the time slice or only specific hours.  

The assignment of hours to a time slices can overlap. For example, the overall Leq 
and the loudest hour at night time can form individual time slices.  

Some assessment procedures demand only the noisier hours within a time period. 
In this case enter the number of hours in the field N LOUDEST. For the single loudest 
hour at night, enter the value „1“. The loudest hour will be used from the hours 
assigned to the time slice night time.  

ADD is used to define new time slots. The number of time slots is not limited. If you 
want to delete a time slot, make sure the index card you want to delete is active 
before you click DELETE. 

Enter the noise limit for each time slot in the index card Limits. The values are 
preset with „0“ and only the time slots associated with a limiting value need to be 
set.  

The index card Additions (penalties) is used to define penalty times for certain area 
usages and hours. In the table you can assign the same value to multiple fields by 
clicking on a field and moving the mouse with the left button pressed. All marked 
fields will be set to the value of the base cell.  

Select whether the defined additions shall be used in each of the time slots with 
the check box TAKE PENALTIES INTO ACCOUNT. For the Lden, assessment the 
additions are only taken into account for the Lden but not for Lday, Levening and 
Lnight.   

Time slices for maximum noise levels 

The maximum levels are administered the same way as the Leq time slices. 

LMAX-ROAD: This represents a maximum noise level of a single vehicle pass by (in 
general a truck). Depending on the receiver location the maximum noise level can 
be caused by different roads. At the moment the Lmax-road is only used in the 
standards „Statens planverk report no. 48; 1980“ and „Road Traffic Noise – Nordic 
Pred. Method; 1996“.  

LMAX-RAILWAY: SoundPLAN first calculates a time history of a passing by train and 
then calculates the maximum noise level and the SEL from the data.  

The calculation of the Lmax-rail is possible with any of the following standards: 

„Schall 03“, „ÖNorm S5011“, „Kilde Rep. 130“, „NMT96“, „Japan Narrow-Gauge 
Railways“. 

The level-time chart can be opened in the Documentation under the tab graphics. 
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LMAX-INDUSTRY: Here the peak noise level that is caused by one or by multiple 
sources is calculated. If multiple sources are involved, the contribution levels of 
these sources at the receiver are considered as not coincided. 

Importing Libraries 
If spectra have already been stored as ASCII files or in Excel, you can easily use 
them in SoundPLAN. This import is also used to import SoundPLAN libraries from 
older versions. A special import for point sources with spectra is available in the 
Geo-Database, see "Import of point sources (ASCII) (page 111)". 

After you opened the library, select the path, from which you want to import the 
data. Open the import via FILE -> IMPORT and select the desired file format.  

 
Import definition for an Excel or ASCII file 

The columns of the Excel or ASCII file have to be assigned to the fields in the library. 
SoundPLAN offers an AUTOMATIC LINK to compare the column headers with the 
library fields. The automatic link only works properly if the column headers 
correspond to the library field names. The list of assigned columns is displayed in 
the field on the left side of the import dialog.  

Hint: Import templates for Excel files are included in the SoundPLAN installation 
folder (..\en\System\Libs\). If you arrange your Excel libraries in the format of the 
templates, you only have to select AUTOMATIC LINK, check the result and then 
START IMPORT in the Excel import dialog. 
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Column assignment via the automatic link 

Check the links. If not, all columns are assigned correctly, you can define further 
assignments manually.  

Click DEFINE LINK to define a new assignment or double click on an automatic link to 
change it. Define the assignment of single columns with the library fields or a text 
which is automatically added to all imported library elements in a defined field.  

 
Manual column assignment 

Select the desired column and assign a library field from the lower selection list.  

You can add a text or a value to a defined column. This is useful, if you want to add 
an "A" to the library field "filter", because the imported spectra are A-weighted. 
Activate the field FIX and enter the text or value.  

APPLY adds the link to the list of links without leaving the dialog. If you want to 
define several links, it is faster to use apply instead of OK.  

Remove existing links with CLEAR ALL LINKS.  

Enter the data range for the new library elements with START IMPORT FROM LINE 

NO. The column definition (field names from the library) is displayed in the first 
header row, the data from the Excel or ASCII file in the following rows.  

If necessary, activate the check box STOP IMPORT IN LINE NO., e.g. if additional 
information is part of the file or if you only want to import some of the elements in 
the file.  
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After all assignments are correct, import the library elements with START IMPORT.  

CLF Import (Common Loudspeaker Format) 

Call FILE -> IMPORT in the emission library and select the file format "Common 
Loudspeaker Format" from the selection list. The frequencies of the loudspeaker 
are imported and a directivity element (with the same name) is generated for the 
directivity library.  

Print and Export Libraries 
You can print the element list of the selected library as well as the detail data of the 
elements.  

The element lists are a tabular output of all elements with the assigned values of 
the selected library. If you select element data, the selected element is printed with 
all details (charts, values, comments ...). 

Open first FILE -> PAGE LAYOUT for the ELEMENT LIST or THE ELEMENT DATA and select 
to customize the appearance of the headers and footers, see page layout. 

Via FILE -> PRINT, also separate entries for the element data and the element list, 
the print preview opens.  

 
Example: Preview element data from the emission library 

Here you can print the data or export them with the “floppy disk symbol” in 
different formats.  
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6  Calculations 

Open the Calculation from the SoundPLAN Manager. The user interface of the 
calculation core is a table, so that you always have an overview of all calculations in 
the project and you can quickly re-run a calculation in case the model data 
changed. 

Run file and calculations 
Each line in the run file is defining a calculation of its own. In the calculation 
definition you select the basic data to be calculated, select the function that should 
be run, define additional parameters for the calculation and request the type, 
amount and location of the results from the calculation. Calculation settings that 
were defined globally or for the project through the SoundPLAN Manager can be 
modified here to suite the need of a particular calculation run.  

 

You see in one glimpse what type of calculations, what result file number and 
which geometry information was sent to the calculations and when the data was 
last edited and when the calculation was run last.  

With a click on the column header the calculation runs can be sorted ascending or 
descending (e.g. according to the calculation type or according to “last run”). 
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Calculation runs can be blocked from executing again, this way unintended 
destruction of already performed calculations can be prevented. When performing 
a batch-run the grayed out blocked runs are ignored, if you want to perform a 
single calculation on a blocked run, you are asked for a confirmation.  

An additional benefit of the table type arrangement is that multiple calculations 
can be chained easily via the green triangle to be processed one after the other. 
This is especially helpful if you want to have multiple jobs done overnight or on the 
weekend.  

CONTINUE is useful if you calculate several calculation runs one after the other in 
order to not loose already calculated parts of a result, see "Start or terminate a 
calculation run (page 324)". 

An in-depth log book informs you of warnings and error messages that happened 
during the calculation and also logs events that might have an influence on the 
calculation results. Security settings that define when the calculation will be 
aborted are user defined. This way you are always in charge of the calculation and 
the overseer of the quality assurance. 

With the right mouse button -> DELETE RESULT FILES you can delete the result files of 
all selected calculation run lines. The calculation runs remain. 

Generate calculations runs and edit the properties 
When you open the calculation core for the first time in a new project the 
run properties are opened. In the course of project work you will generate 

multiple more calculations, to request a new one click on the icon + on the 
navigation bar. 

Select the calculation run properties of an existing calculation by double click on 
the fields NAME or CALC TYPE or open the properties via the menu EDIT -> RUN 

PROPERTIES. 

Calculation run properties 

Every calculation run needs certain parameters and a unique number. When you 
generate a new calculation run all parameters are set to default conditions.  

If you change certain parameters each time, it is sensible to change the defaults via 
OPTIONS -> DEFAULT STANDARDS and OPTIONS -> DEFAULT CALCULATION SETTINGS 
globally for the future. 

The option SET THE DEFAULTS OF THE CALCULATION PARAMETERS FOR THIS RUN 
overwrites the parameters of this run with the parameters defined in DEFAULT 

CALCULATION SETTINGS.  
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The different parameters are provided in several tab index cards. Under the tab 
"General" you enter the name of the calculation run, select the calculation type, 
the data and the DGM to be processed and a unique number that will identify the 
results afterwards.  

For grid noise maps and façade noise maps in tile projects, you can additionally 
define the tiles to be calculated. See Calculate tiled projects (page 652). 

The settings in the run properties cannot be edited as soon as results are available. 
Changes in the properties require that the result files are deleted first. This 
guarantee, that calculation info and calculation result have the same parameter 
settings.  

 

Calculation types 

Select a calculation category and a calculation type from the selection lists. 
Depending on the selected type of calculation the definition box will have a 
number of extra tabs to host the calculation type specific information: 

Geometry 

➔ Digital ground model (page 339) 

The DGM calculation can be executed either in the Geo-Database or in the 
calculation kernel. Spot heights, elevation lines and if necessary, 
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additional elevation information from roads and tunnel openings are 
triangulated as a basis for the 3D model and the noise calculations. 

➔ Clip DGM (page 341)  

➔ Calculate Objects in DGM (page 341) 

➔ Import DGM (page 343) 

Outdoor noise 

➔ Single points sound (SPS): (page 343) Calculates manually entered single 
receivers (free field or assigned to buildings) for any number of floors.  

➔ Grid Noise Map (GNM): (page 345) The grid noise map calculates a receiver 
grid within a calculation area in a specified height above ground.  

➔ Façade Noise Map (FNM): (page 351) The Façade Noise Map is an 
automated single receiver calculation for facades marked in the Geo-
Database for the calculation (Geo-Tool "prepare buildings"). Receivers can 
either be calculated for all floors or in a specified height above ground (e.g. 
for the EU directive). 

➔ Meshed Noise Map (page 356) The Meshed Noise Map combines DGM 
calculations with single point calculations. For detail investigations and 
especially for industry noise this calculation procedure has distinct 
advantages over the Grid Noise Map.  

➔ Cross-sectional Noise Map: (page 350) The Cross-sectional Noise Map is a 
vertical Grid Noise Map.  

➔ Noise Allotment: (page 769) Pre-calculation of the decisive receivers for 

the evaluation of emission and additional allotments (calculation takes only 
the distance correction into account, no additional propagation influences). 

➔ Wall Dimensioning: (page 468) Pre-calculation of a wall matrix with 

information of the efficiency of each wall element. 

Indoor 

➔ Single Points, Grid Map, Sound Propagation Curve, Cross Section Map 

(page 358): Calculates the levels and room acoustical parameters in 
industrial buildings from indoor noise sources and the properties of the 
industrial building 

➔ Hallout (In -> Out): From the noise level inside the industrial building and 
the transmission loss of walls and roof, the sound power level emitting to 
the environment is calculated.  

Aircraft noise 

➔ Single points, Cross Section Map and Grid Noise Map (page 701) 

Tools:  

➔ Grid-Operations and Façade-Operations: (page 367) Differences, 

superimposing several calculation results (for example road and railway) or 
adding a constant value. File operations can be executed either in the 
Graphics and in the Spreadsheet or in the calculation core. If you want to 
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store the result of a file operation, it is mandatory to use the calculation 
core.  

➔ Grid map import: (page 372) Import of ASCII data from grid noise maps for 
example to overlay different noise types.  

➔ Hotspots: (page 369) Determines the density of people annoyed by noise 

on the basis of grid noise maps and façade noise maps. 

Selection and assignment of Situations and Geo-Files 

Assign the geometry data that shall be used in the calculations. In general, this will 
be done with the situations created and stored in the Geo-Database. It is also 
possible to connect Geo-Files.  

By clicking the double arrow  for the calculation data, you open the window for 
the file selection where the data are selected and assigned to the calculation run.  

 

Selection of the geometry 

The left-hand side shows the available Situations, the right side the files selected 
for the calculation run. As soon as you click on a Situation the contained Geo-Files 
and a pictogram of the Situation are displayed below the Situation listing. To 
include one or multiple Situations, mark them (for a single just click on it, for 
multiple ones use the Shift and Ctrl keys and click) and click on the   icon or pull 
them across to the right with “Drag & Drop”. A DGM which is part of a Situation is 
automatically selected. 

In some cases, it is sensible to include singular Geo-Files in the calculation, for 
example to include a Geo-File with a calculation area in calculation run or a Geo-
File with single receivers. Before selecting the files switch the FILE TYPE to "Geo-
Files (*.geo)".  
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In the same way you can select DGM’s, attenuation files from Expert Industry or 
GausBeam Script files that are the result of a calculation of complex meteorology 
(wind and temperature inversions) for industry noise. All different file types can be 
used in one calculation.  

If you want to exclude a Situation or Geo-File from the calculations, mark the files 

and either by clicking on the icon  or with “Drag & Drop” transfer the files from 
the right side back into the left side.  

File number of the results 

All results of a calculation run contain the same unique number as part of the file 
name. This number was entered in the general tab of the calculation run definitions 
under the label NUMBER OF RESULT FILES.  

The result file number can have up to 4 digits and can only be used once to give the 
result files a unique identifier. In case you are assigning a number to the calculation 
run that is already in use in another calculation run, SoundPLAN will warn you. The 
result files have a fixed format and follow the naming convention as listed in the 
annex. 

Depending on the degree of detail you request for the storage of results, result 
tables, level charts and detail tables are stored using the same unique number as 
part of the file name (for example RPGDxxxx.* for level charts and RROAxxxx.* for 
the road emission table for roads.) The Result Tables, Spreadsheets and the 
Graphics all can read the result database when the result files are opened. When 
you delete one or more calculation run entries from the table, you are asked 
whether want to delete the result files, too.  

Calculation results are saved in sub-folders of the project folder so that you can 
find all files related to a calculation at the same location. The RES-files are saved 
directly to the project folder so that the results can be opened by the different 
program parts. 

Group the run file and filter settings 

It is often useful to group the calculations in a project. To do so, generate groups in 
the calculation run properties. Create for example one group for calculations 
referring to the elevation model and one group for each variant.  

 

The run file can be filtered sorted according to these groups (amongst other 
criteria).  
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Filter settings 

The filter settings are stored. As soon as a filter is active you are informed how 
many calculation runs are not visible because of the filter. 

 

Click on filter active and select the filter option: 

• Group name 

• Calculation type 

• Calculate selected yes / no 

• Text filter 

When a filter is active and you change a setting, the filter is not automatically 
updated, so that a calculation run does not disappear because of the change. Click 
the update button to refresh the filter. 

Duplicate a calculation run 

Another handy possibility to create new calculations is to right click on an existing 
calculation and duplicate it with all settings and used data using COPY + PASTE IN 

NEW ROW(S) (Ctrl + Alt + V). The cursor jumps to the column RESULT to enter a 
result number that have not been used in other calculations. You can also highlight 
several rows with Shift+ arrow keys or Ctrl+ left mouse key.  

Reconstruct the calculation run from the result file 

In case by accident you have deleted a calculation run entry and already have 
stored the run file, you can reconstruct the entry in the run file from the result files. 
Click on EDIT -> IMPORT RESULT FILE from the list of results select the one you want 
to reconstruct and click on the OK button. If you want to import more than one file, 
press the shift or Ctrl key and select the result files with the left mouse button. 

Append run file from another project 

It is possible to calculate several run files from different projects successively. This 
is useful if you work on different projects and your PC could deliver more than one 
result over night or over the weekend. Or if different colleagues use a joint 
computer pool for example for distributed computing. Each run file is displayed in a 
separate tab index card. 

Go to FILE -> ADD RUN FILE FROM ANOTHER PROJECT (F12) and select the 
corresponding project. All run file rows selected for the calculation are calculated. 
If a calculation runs, it must be aborted.  
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You can remove completed run files from the project with FILE -> CLOSE RUN FILE; a 
running calculation must be paused (CALCULATION -> PAUSE CALCULATION).  

Start or terminate a calculation run 
With the symbols below the calculations are controlled: 

 

These functions are also accessible via the menu CALCULATION or via the function 
keys listed in the menu.  

With F7 a calculation run can be processed STEP BY STEP in a way that the program 
calculates a receiver and then pauses until you hit F7 to calculate the next receiver. 

All calculations can be stopped and resumed later. When you call the calculation 
the next time the following screen is displayed: 

 
Restart/Overwrite/Continue/Cancel a calculation run 

Select the option RESTART / OVERWRITE to start the calculation from the beginning, 
CONTINUE to resume a calculation that had been interrupted and CANCEL to exit 
from the calculation. With the continue option the program resumes exactly where 
it was terminated, therefore this is a very handy way to quit a pause the 
calculation, do some other work and then continue without having lost the 
calculation. Make the choice while the pause progression bar on the bottom of the 
box is active. The time for this bar is set in OPTIONS -> RUN SETTINGS -> DURATION OF 

WAITING LOOPS.  

If you select CONTINUE in the table, CONTINUE is the default setting as soon as 
results are available.  
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For details on Distributed Computing please read section "Distributed Computing 
(page 373)". 

Calculate calculation runs successively (batch run) 

A batch run calculates all calculation runs that are marked in the second 
column (green triangle) with a check mark. Start the calculation with the 

green triangle. 

If a calculation has been executed before, you can select that the query for existing 
results (overwrite or continue) is only shown at calculation start. Set the check 
mark DO NOT DISPLAY AGAIN DURING THIS BATCH RUN. The setting you select is used 
for all calculations during the batch run.   

Logbook, Error messages and Default settings 
The logbook keeps track of all actions that occur during a calculation run. For 
example, which files are loaded, what is calculated and if there are warnings and 
error messages. The logbook is stored in each project under the name "Lastlog.rtf", 
if the file grows to a bigger size than 300 kB, the display in the logbook is emptied 
and the data stored under the name Logbk0.rtf. You do not have to wait for this to 
happen, you can manually empty the logbook or store it or print its content.  

Calculations can produce errors! Most errors are caused by faulty data or missing 
parameters and properties, some occur at special conditions for a particular 
geometry and some occur because SoundPLAN simply has made a mistake 
(unfortunately no program is completely free of bugs).   

In general, SoundPLAN distinguishes between hints, warnings, exceptions and fatal 
errors. Warnings are logged with red italic writing, exceptions are printed in 
magenta and fatal errors are in bold red writing. In addition, blue text is used to 
indicate that the user has aborted the calculation. 

HINTS are displayed to call your attention to certain conditions during the 
calculation. If desired these conditions do not cause problems. For example, the 
hint "There are sources without a spectrum, for these sources ground effect is 
calculated according to alternative method of ISO 9613/2!", But if you only want to 
calculate source with frequency spectra, you should pursue the information.  

When WARNINGS are given, the calculations are continued as normal and for the 
most part the results are reliable. For example, the warning message "Grid 
elevations could not be calculated for all receivers, x receivers were not calculated" 
means that the elevation data did not make it possible to securely interpolate the 
elevations for all receivers of a Grid Noise Map. A warning message "K0-Wall >=0.1, 
but no wall found in the vicinity of the source" – is hinting that a data entry error is 
present, either K0-Wall is set to the wrong value or a wall should be present but is 
not because it was deleted or is in a Geo-File that is no longer part of the situation 
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that is assigned to the calculation. The examples show that you should always look 
into the logbook after a calculation, there might be warnings that something in the 
data was not correct and if this is the case corrections should be made in the Geo-
Database. 

EXCEPTIONS do not necessarily lead to an exit from the calculations. SoundPLAN can 
handle certain exceptions and still continue with the calculations. The number of 
possible exceptions is set in the "run settings". For example, exceptions can occur 
resulting in one receiver not having been calculated, but the rest of the Grid Noise 
Map would be calculated correctly. If exceptions occur, something unexpected 
happened in the calculation core and you should pack the project and send us the 
data along with the description so that we can research what happened and fix the 
problem. "Division by zero" for example is indicating that a certain geometrical 
constellation has not been correctly handled. Problems like this need to be fixed 
and the program authors do this, but in order to reproduce the error they need the 
data.  

ERROR will immediately terminate the calculation. Errors can have various roots but 
very often are caused by the geometry data. For example, "No calculation area in 
the data" or "Building xxx, No. yyy has no properties". Use TOOLS -> PREFLIGHT in 
the Geo-Database to find conflicts in beforehand.  

Run Settings 
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In OPTIONS -> RUN SETTINGS define general pre-settings for all projects and all 
calculation runs.  

Calculations can be finished even if problems have occurred. The number of such 
exceptions can be set for single point receivers and for Grid Noise Maps. By default, 
up to 10 exceptions are allowed. Please always look in the logbook if an exception 
has caused a receiver not to be calculated.  

With Grid Noise Maps exceptions will mark the receiver that has not been 
calculated properly, the receivers with the exceptions can be processed later. 
Define how many grid points can be skipped until the program terminates.   

CANCLE BATCH RUN ON SINGLE RUN TERMINATION: Determines if the entire batch run 
of multiple calculations shall be terminated if one of the runs is reporting 
unrecoverable errors.  

Hint: To avoid a failure of the batch calculation due to errors in the input data, 
check the Situations with the PREFLIGHT in the Geo-Database before you start the 
batch calculation.  

The checkbox SAVE RUNFILE BEFORE EACH CALCULATION stores the run file so that no 
data loss will occur. By default, this setting is active. 

BACKUP PREVIOUS RESULT BEFORE EACH CALCULATION stores the previous result files 
in a sub folder of the project. 

Multithreading: The calculation kernel automatically recognizes how many cores 
the PC has (NUMBER OF THREADS). By default, the full number of cores are used for 
calculations but if you want to use the PC for other tasks while a SoundPLAN 
calculation is in progress, it is wise to reduce the number of cores used in the 
calculation (normally by one). 

DURATION OF WAITING LOOPS sets the time available to select between different 
options. In the batch run the calculation always goes to the next step, so if you 
need to intervene or have the data presented a different way, there is only a 
limited time until the automatic process continues.  

Statistics 

After you started a calculation run, SoundPLAN displays status information about 
the calculation that is running.  
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The statistics shows the coordinate of the receiver currently calculated the number 
of total receivers and how many are already done. The calculation times are only 
estimates based on the time of the first receivers. The times can vary during the 
calculation, often with Grid Noise Maps SoundPLAN is under predicting at first, 
then over predicting slightly in the middle of a big area. Often the edges of the Grid 
Noise Map contain more interpolated coordinates than the average, thus the 
program thinks at first that the calculation is faster than it actually is. For Grid Noise 
Maps the timer is updated after each calculation block for all other calculations it is 
updated after each receiver.  

Calculation run-info 

The calculation run-info writes a protocol of all parameters relevant to the 
calculation, the files that were activated for the calculation and the version of the 
calculation program. This assures a complete documentation of the entire 
calculation run. The run info is displayed below the list of calculation runs. This way 
you can check the used calculation settings and data without the need to load the 
data.  

The calculation run-info is copied into each result table and can be printed from 
there as well.  

Graphical presentation of geometry in calculations 

To graphically check the calculation results you can click on the tab Graphics while 
the calculation is running. For single receivers, Façade Noise Maps and Meshed 
Noise Maps the level chart is presented along with a table of the calculation results 
for each floor. For Grid Noise Map and Cross-sectional Noise Maps the results are 
presented as squares painted in accordance to a color scale. If you want to know 
which of the receivers was interpolated, right click on the map and select the 
option GRID POINT TYPE.  



SoundPLAN Manual 8.1 
Calculations 

Logbook, Error messages and Default settings  Page •  329/793 

6 

Bright red squares are calculated receivers, dark red squares indicate interpolations 
and gray squares are indicating the square is completely inside a building. 

A print function is not planned for the graphics in the calculations; this is the 
domain of the Graphics modules themselves. 

Hint: The graphical display increases the calculation time considerably, also for 
distributed computing!  

 
Display of level chart and the results from single point receivers, Façade Noise Maps and 
Meshed Noise Map 

    
Display of a Grid Noise Map with the color scale and the presentation of 
calculated/interpolated receivers  

Even when the calculation is finished, the results are available in the calculation 
core. Click on the calculation run; activate the graphics by clicking on the Graphics 
tab. If the noise map has been calculated, you can right click on the map area and 
select LOAD GRID MAP. Right click on a point on the map and get the information: 
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To present the entire map for a different time slot or to present the terrain 
elevations instead of the noise levels, activate the correct selection. If you want to 
change to display the terrain elevations, you probably need to correct the color 
scale. To change the colors, click on the EDIT button on the color scale.  

For single point receivers and Facade Noise Maps the level charts can be called 
back on screen if the option LEVEL CHART has been activated in the run parameters, 
if this option was not clicked only the noise levels are shown in tabular form. 

When opening the graphics tab of a calculation run, loading and drawing the DGM 
can be suppressed by deactivating it in VIEW -> DGM TRIANGLES. 

Calculation settings for noise calculations 

 
Calculation settings for noise calculations 

The calculation settings are preset with defaults, available for the current project 
and as global setting under OPTIONS- > DEFAULT CALCULATION PARAMETERS.  

The default settings are on the safe side; you can change them in the tab index card 
Settings. To get a feeling on the effect of the parameters on calculation time and 
accuracy it may be wise to calculate statistic runs, see "Statistical accuracy (page 
378)". 

Use the button SET DEFAULTS to reset your changes to the default settings of the 
project. 
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The parameter REFLECTION ORDER determines how many reflections shall be 
calculated. For calculations "Strictly according to RLS-90" only the first order 
reflection is evaluated, "Strictly according to Schall 03" calculates without 
reflections, no matter what you entered. All other objects (industrial, parking lots) 
present in the calculation will be calculated using the defined number of 
reflections.  

During the calculation SoundPLAN searches for sources in a set distance around the 
receiver. The MAXIMUM SEARCH RADIUS sets how far a source can be from the 
receiver and still contribute to the noise level at the receiver. This restriction is 
mostly effective for big noise mapping projects. The accuracy for line type sources 
is only sufficient if the search radius is higher than 5 times the orthogonal distance 
to the source.  

The DB-WEIGHTING filter can be switched between dB(A), dB(B), dB(C), dB(D), dB(G) 
or dB (linear). In the calculation, sources with a frequency spectrum that do not 
correspond to the weighting filter set here are converted to this filter.  

Sources to which a center frequency has been assigned in the Geo-Database cannot 
be converted. This means that for these sources the weighting filter in the Geo-
Database and in the Calculation Core must match, otherwise the calculation will be 
aborted.  

Railway noise has been assessed as being less annoying so there is the possibility to 
set a RAILWAY BONUS that subtracts 5 dB to compensate for this difference. 

CREATE GROUND EFFECT AREAS FROM ROAD SURFACES automatically generates hard 
ground areas according to road width. Activate this check box for all standards that 
use this option (e.g. NMPB 86 und 2008). 

MAX. REFLECTION DISTANCE TO THE RECEIVER [M] (default value 200 m) and MAX. 

REFLECTION DISTANCE TO THE SOURCE [M] (default value 50 m): 

The program only calculates reflections for reflecting surfaces that are either closer 
to the receiver than the first parameter entered or closer to the source than the 
second parameter. The default settings in general produce sensible results. 
Reflection edges that are far away from the source and far away from the receiver 
do normally not contribute to the immission level.    

ALLOWED TOLERANCE: This parameter is designed to increase the calculation speed. 
With high values of tolerance, the results are overestimated rather than 
underestimated. The value for the tolerance depends on the task to be calculated. 

The tolerance either holds for the total result, for each group contribution level or 
each source contribution level. 

If the tolerance holds for the TOTAL RESULT, only the most important sources are 
calculated in detail so that for the total result the deviation is less than defined by 
the allowed tolerance. This setting has the disadvantage that less important 
sources are not calculated in detail or for area and line sources to a smaller extent. 
For sources not calculated in detail no contribution level will be calculated and 
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displayed in the result tables. So, if you do a recalculation and remove or add an 
important source the relative importance of sources might change and therefore 
their contribution levels.  

If the tolerance holds for each GROUP CONTRIBUTION LEVEL or EACH SOURCE 

CONTRIBUTION LEVEL the calculation is done group by group or source by source, so 
that the allowed tolerance holds with respect to the contribution level of each 
group or each source, therefore the contribution levels for the other groups or 
sources do not change when adding or removing important sources. 

Principles of the method: 

In the first place all sources are calculated in free field. This means that basically 
only the geometrical spreading will be used. Now only so many sources - from high 
to low free field contribution - are calculated correctly with all spreading 
parameters which are necessary to guarantee the allowed tolerance. This is made 
sure for every hour of the day. The sum the free field contribution of the remaining 
sources makes up a remaining level which will be added to the receiver level so 
that it is guaranteed that the receiver level is rather over estimated than under 
estimated. This remaining level is listed in the result tables, table source 
contribution “ as “remaining sources”.  

There it holds 

10*log((10^(0.1*R)+10^(0.1*F))/ 10^(0.1*R))<T 

where 

R: sum of the correctly calculated contribution levels [dB] 

F: sum of the remaining free field contribution levels (remaining level) [dB] 

T: allowed tolerance 

Recommended values:  

0.5 - 0.8 dB + TOTAL RESULT (GROUP CONTRIBUTION LEVEL): Noise mapping projects, 
calculations in accordance to the END. 

< 0.2 dB + TOTAL RESULT (GROUP CONTRIBUTION LEVEL): Road, railway and industrial 
projects where only the total level or group contribution level is of interest (e.g. 
Grid Noise Maps). 

< 0.2 dB + EACH SOURCE CONTRIBUTION LEVEL: Sensitive industrial projects where the 
group or source contribution level is of interest. 

Standards 
Check the standards, selected in the calculation run. As a pre-setting the standards 
selected in the SoundPLAN Manager are presented here.  
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If necessary, you can change the standards for the propagation calculation and the 
emission calculation, here. 

The calculation can only be successful, if the correct emissions have been entered 
in the properties of road, railway or parking lot in the Geo-Database.  

Standard details 

Check the standard details with the double arrow. Depending on the standard 
some options will be available or not. 

Tab index card "Diffraction" 

 

SIDE DIFFRACTION can be used with all standards, regardless if side diffraction is 
required in the standard or not. For standards that by default do not use side 
diffraction, the checkbox by default has the setting “off”.  
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As the calculation of the side diffraction is very computation intensive, this feature 
should be deactivated in a draft type calculation. Do not forget to re-enable this 
feature later on for the final calculation.  

Buildings that are connected to each other and walls that are connected to 
buildings are recognized, the screening will use the entire block for side diffraction 
around the objects. 

LIMITATION OF DIFFRACTION: A certain maximum screening loss can be entered for 
single and multiple diffraction. These values refer to vertical screening loss only. 

DIFFRACTION CONSTANT: According to VDI 2720 / ISO 9613-2 the screening loss Dz is 
calculated with following equation: 

DZ=10lg[3 + (C2/λ) C3 z Kmet] 

C2 equals 20 and includes the effect of ground reflection; in rare cases if the ground 
reflection is taken into account separately with mirror sources, C2 equals 40 
(citation from ISO 9613-2). 

ABAR CALCULATION: There are three options for the calculation of the insertion loss 

(1) Abar=Dz-Agr equaling eqn. (12) of ISO 9613-2 

(2) Abar=Dz-Max(0,Agr) a modified version of eqn Gl. (12) of ISO 9613-2 

(3) Abar=Dz equaling eqn. (13) of ISO 9613-2 

Remarks to (2) 

There are two different versions of the ground effect in ISO 9613, the regular 
method and the alternative method. In the alternative method there is a k0, 
describing the effect of a constructive reflection on ground, leading always to a rise 
in level in the range of 0..3 dB. Furthermore, there is a destructive reflection on 
ground leading to a reduction in receiver level in the order of 0…4.8 dB. In the 
regular method we have a spectrally resolved ground effect combining constructive 
and destructive reflections, so positive as well as negative values for the ground 
effect can occur.  

From the historical development the insertion loss was developed for the 
alternative method (being the regular method at that time). Due to the separation 
between k0 and Agr, Agr was always a positive number. The equation Abar=Dz-Agr 
does not make sense if Agr is negative, which is possible in the regular method. To 
ease this problem, we propose option 2. This workaround delivers results which are 
more comparable with the alternative method. 

Remarks to (3) 

Option 3 has been implemented to satisfy remark 15 of ISO 9613-2 but we do not 
advise to use it.  
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Tab index card "Dissection" 

 

These parameters define how line and area sources are dissected in a number of 
point sources. 

After dissection due to screens and buildings, etc. further conditions are checked. 
The first is the DISTANCE TO DIAMETER FACTOR. If this value is e.g. 8 the distance to a 
source segment must at least 8 times its diameter respectively length. If this is not 
the case, the source segment will be divided, and the check is repeated for both 
sub segments until the condition is fulfilled or the distance is less than the MINIMAL 

DISTANCE [M]. 

Next the ground effect and screening loss for the extremal points of the source 
segment are calculated. Is the maximal difference of ground effect + screening loss 
of these extremal points larger than MAXIMUM DIFFERENCE GROUND EFFECT + 

DIFFRACTION the source segment will be divided and the check repeated for both 
sub segments until the condition is fulfilled or the iteration depth is larger than the 
MAX. NO. OF ITERATIONS.  

Tab index card "Environment" 

 

HUMIDITY, AIR PRESSURE, TEMPERATURE: The environment parameters are important 
to calculate the air absorption. Furthermore, is the sound speed a function of 
temperature, influencing the wave length and therefore the screening calculation.   
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Tab index card "Standard" 

 

AIR ABSORPTION: Select the standard to calculate air absorption with. 

ALTERNATIVE GROUND EFFECT: If you select this option, the ground effect of ISO 
9613-2 is not going to be calculated by the frequency dependent regular method, 
but by the in chapter 7.3.2 described alternative method. 

For sources which do not have a spectrum the calculation according to the regular 
method doesn’t make sense. Therefore, SoundPLAN always uses the alternative 
method for these sources. 

Following the recommendation of the DIN/VDI standardization group NA 001 BR-02 
SO, the calculation of the average height of the line of sight above ground hm for 
the alternate calculation procedure of the ISO 9613-2 was changed from 
SoundPLAN 8.1. This change can lead to slight changes in the results, especially if 
the terrain elevation for source and receiver are very divergent. 

For the noise propagation calculation two options are available for the CoRTN:  
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In the run properties you can choose between two methods to convert the L10-
values to Leq. The first option is the original method from TRL (the UK's Transport 
Research Laboratory). The second is preferred in Australia (North South Wales) and 
uses the simple formula L10 – 3 dB for the conversion. If you choose this option, 
you have the option to disable the low flow correction at the same time. 

Tab index card "Cmet" 

 

The calculation of the meteorological correction Cmet to derive the long term 
mean value is described e.g. in ISO 9613-2 

Cmet=Max(0, C0[1-10(hs+hr)/dp]) 

The factor C0 can either be set fixed for certain time slices (definition in the 
SoundPLAN Manger OPTIONS -> EMISSION TIME SLICES) or calculated from a wind 
statistics. 

Methods to calculate C0, if a wind statistics is used: 

 

Depending on the county in Germany basically two methods are used to calculate 
C0. Furthermore, is it possible in SoundPLAN to enter C0 values directly per wind 
direction. 

The time slices for Cmet are determined in the SoundPLAN Manager, OPTIONS -> 

SETTINGS, node "time slices for road / railway emission and Cmet" 
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Tab index card “Attenuation loss” 

 

How volume attenuation areas shall be calculated is only defined in a few 
standards and not all of the possible volume attenuation areas are mentioned in 
these standards. For this reason, the settings for each standard now allow you to 
select how the volume attenuation areas –for each type of area- shall be treated by 
the program. Select from the standard options. 

See object type Volume absorption area (Mitigation Areas) 

Tab index card “Emission” in the road standards 

 

As sometimes 2 close coordinates are having an elevation difference that leads to 
excessive inclines, the program allows averaging of the incline over a user defined 
distance in the properties of the road standard, tab Emission. Whatever was used 
will be found in the logbook. The default setting for the averaging is taking the 
average for a section of 15 m of road length. The incline can also be limited to a 
specific value to prevent unrealistic local level spikes when the DGM is not quite 
good. 

Calculation of the frequencies 

Up to and including version 7.3 for most of the standards calculations were 
performed on rounded third octave band frequencies. Due to the extension to low 
frequencies and a harmonization SoundPLAN version 7.4 switches to frequencies 
calculated by band numbers.  

Hereby applies for the frequency f [Hz] = 10 ^ (0.1*b), with band number b.  
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b 13 14 15 16 17 18 19 20 21 22 23 24 25 26

Nominalfrequenz 20 25 31 40 50 63 80 100 125 160 200 250 315 400

10^(0.1*b) 19.95 25.12 31.62 39.81 50.12 63.10 79.43 100.00 125.89 158.49 199.53 251.19 316.23 398.11

b 27 28 29 30 31 32 33 34 35 36 37 38 39 40

Nominalfrequenz 500 630 800 1000 1250 1600 2000 2500 3150 4000 5000 6300 8000 10000

10^(0.1*b) 501.19 630.96 794.33 1000.00 1258.93 1584.89 1995.26 2511.89 3162.28 3981.07 5011.87 6309.57 7943.28 10000.00  

This has effects especially on air absorption and on weighting filters dB(A)..dB(D) 
and may lead to slight deviations in the results compared to previous versions of 
SoundPLAN. The weighting filters have been calculated from complex transfer 
functions and tabularized with three decimals. 

Assessment 
Select the assessment from the Library. As a default the assessment selected at 
project setup is entered. 

 

Below the assessment list there is a selection for the assessment type. There you 
can select certain assessment types. An assessment type can only be calculated if 
it’s also included in the time slices defined in the assessment library. If a time slice 
is not defined, it is crossed out. The possibility to deselect certain assessment types 
was introduced to reduce calculation time and to make the results more compact. 
Especially the calculation of Lmax is more time consuming than pure Leq-
calculation.  

If you entered a standard deviation for industrial sources for the calculation of the 
prognostic uncertainty, activate the checkbox for the time slices of the standard 
deviation to document them in the Result Tables.  

Calculation Types 

Digital ground model 

All calculations using a 3-dimensional model mandatorily require a DGM as the 
base. A DGM loaded in a situation automatically taken over to the calculation run. 

If anyway no DGM is entered, SoundPLAN calculates with a constant ground 
elevation of 0 m. Unless all objects are located on the 0.0 m plane, the calculation 
results will be wrong! To warn the user, in this case a warning message will appear.  
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Elevation lines and elevation points that are part of a situation but not included in 
the DGM are ignored! 

 

Select which object types shall influence the DGM calculation. Next, to spot 
elevations and elevation lines, it may be sensible to also use the edges of the 

roads and railways to deliver input to the DGM (see "Embankment alignment for 
road and railway in the DGM (page 124)").  

In the lower part, select which object types shall influence the DGM calculation. 
Next, to spot elevations and elevation lines, it may be sensible to also use the 
edges of the roads and railways to deliver input to the DGM. This ignores the 
elevation information within the bands.  

The following geometry is calculated into the DGM (only objects entered with 
absolute elevations): 

Roads  The carriageway resulting from the road cross section 

Railways Edges and delta Hof the track bed (DGM parameters in the 

object dialog) 

Tunnel openings Tunnel width and height 

Parking lots/ Area sources The input points of the edge lines 

Berms The calculated lines of the berm top and the calculated 
backwards wall line. 
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Additionally, you can check the box “Central reservation”, if the elevations within 
the central reservation shall be incorporated into the DGM or not.  

If the plan contains tunnels, it is wise to generate a new DGM after the tunnel 
portals are defined so the DGM can correctly model the area around the tunnel. 

For huge amounts of spot elevation data which have been processed via 
"Preprocess elevation data for the calculation kernel (page 654)" select one file 
from the files stored in the subfolder "ElevData"; all *.elv files in this folder will be 
used for the DGM calculation.  

Activate CALCULATE IN TILES for large DGMs (complete urban areas or counties) and 
select the tile size in [m].  

If the data contains tunnels, it is wise to generate a new DGM after the tunnel 
portals are defined so the DGM can correctly model the area around the tunnel. 

Extract DGM via an area 

When a DGM for the entire project is already present and you want to restrict the 
DGM to cover only a portion of the entire DGM, you can clip the DGM. In the Geo-
Database define an area (calculation area or general area) and save this area in a 
Geo-File of its own. In the Calculation Core select CLIP DGM from the category 
GEOMETRY. 

 

Enter the Geo-File with the area functioning as the clipping template and the 
existing DGM and in the bottom of the definition box the number for the part DGM 
to be created. Additionally, you can add a buffer around the selected clipping area 
in order to assure the elevation provision for the part DGM.  

Calculate Objects in DGM 

With the calculation run "Calculate objects in DGM" you can modify an existing 
DGM with the information of additional objects (road edges, railway edges, parking 
lots, area noise sources and berms).  
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Additionally, embankments can be incorporated into the DGM. The program will 
search for embankments up to a distance of 100 m from the road/railway edge. In 
order to create the embankments, the height of the fill/depth of the cutting must 
be greater than 0.5 meters for a distance of 5 meters along the road/rail edge. This 
calculation run replaces the Geo-Tool „Create embankments“ and also can be 
started from the Geo-Database via FUNDAMENTALS -> DGM -> CALCULATE OBJECTS 

INTO DGM (Alt+Ctrl+D). 

Cutting and embankment slopes can have different inclinations. The inclination is 
calculated from the factor 1:m.  

  

Embankment definition for roads: 

 

Slope definition for railways: 

  
Forced edges in DGM 

Since the embankments usually do not start immediately at the edge of the road, 
specify an ADDITIONAL DISTANCE TO THE OBJECT EDGE, for roads for example for a 
ditch. For railways, the DGM parameters from the object dialog are used. 

This calculation run can also be started from the Geo-Database via FUNDAMENTALS -

> DGM -> CALCULATE OBJECTS INTO DGM (Shift+Ctrl+D). 
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3D check of the resulting DGM in the Geo-Database (Ctrl+F10): 

 

Import DGM 

Choose from the category GEOMETRY the calculation type DGM IMPORT.  

In SoundPLAN you can import DGMs in the ITF format. ITF (Intermediate TIN 
Format) is a format to exchange DGMs which is described in the internet. 

Single point receivers sound (SPS) 

A single point calculation calculates the levels at the manually entered receivers 
(free field points or assigned to a building). Single points are documented in the 
Result Tables. Results from different variants can be compared in the Spreadsheet. 
Single points can be displayed in the Graphics as small level tables [module 
Cartography] or with a colored scale as small symbols at the buildings [module 
Façade Noise Map].  

Click on the tab “SPS” (Single Point Sound) to set additional parameters: 

 
Settings for a single point sound calculation 
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The checkbox CALCULATE REFECTIONS OF THE ASSIGNED FACADE AND IGNORE 

STANDARD DEPENDENT FAÇADE CORRECTIONS means that regardless of the terms in 
the standard the reflection at the façade is calculated (default: unchecked).  

Some standards suppress the reflection for the façade levels other use specially 
described corrections and yet others calculate the assigned façade. If a calculation 
area is contained in the data, receivers are only calculated within the calculation 
area. 

A Nordic acoustics standard demands that reflections on objects on the “own” 
property shall not be part of the noise evaluation. The properties are entered as an 
area usage object. For single receiver calculations and Facade Noise Maps the 
calculation core in the calculation settings for /SPs or /Facade Noise Map contain a 
new checkbox SUPPRESS REFLECTIONS OF OBJECTS ON OWN PROPERTY (NORDIC 

REGULATION).  With this setting the area usages are evaluated and where needed 
the reflections are suppressed. 

If a calculation area is in the data, only the receivers inside the calculation area are 
calculated. 

Tables for Single Point Calculations 

Select, which calculation results should be stored for the tabular and graphical 
documentation of the results.  

Plain result tables:  

• Receiver list  

• Road emission table (if roads are contained in the data)  

• Railway emission table (if railways are in the data) 

• Source table (if industrial sources are in the data)  

• Day histogram of the noise level at the receiver 

• Emission frequency tale (if industrial sources are in the data) 

• Emission day histograms (if industrial sources are in the data) 

• Result table with frequencies (if industrial sources are in the data) 

Level Charts: 

• Level charts and pass-by level for railways (for presentation in the 
calculation core, the Result Tables and to include in the Graphics in a map) 

Group Result Tables:  

• Result tables of groups of sources  

Detail-Result Tables:  

• Result table for mean propagation and partial noise levels.  

• Result table of assessed noise level contributions (if industrial sources are in 
the data)  
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Tables for Industry Expert 

• Result tables for the Industry Expert Spreadsheet (generates vast amount of 
data!) 

Protocol Tables 

• Protocol tables detailing the intermediate values for each standard. The 
protocol tables generate huge files and will slow down any calculation, 
therefore this option should be used only for selected receivers where every 
detail of the calculation needs to be checked.  For answers that look 
implausible the protocol can be even used on a limited angular range to 
check the details in the section where the user has doubts. 

Grid Noise Map Calculations 

Grid Maps and the derived contour maps are the tools to visualize the noise at 
street level outside buildings and in nature. As the Grid Noise Map calculates 
reflections from all buildings, the levels can be up to 3 dB higher than Single Point 
Receivers Sound at the buildings. SPS receivers often suppress reflections at the 
“own façade” (exception is CoRTN). Comparing SPS receivers and Grid Noise Map 
receivers is only possible if the SPS receiver is located in front of the building and is 
not attached to the building. The angular area must be set to contain all 360 
degrees. 

The Grid Noise Map generates a grid of receivers over the calculation area defined 
in the Geo-Database. The seed address for the grid depends on the grid spacing 
and is always set in a manner that adjacent grids would have the same pattern of 
grid points. For the middle of each grid cell the noise level is either calculated or 
interpolated from the receivers around it.  

The receiver grid can only be calculated within the elevation supply due to a DGM. 
If you activate the tab index card graphics (page 328) display in the beginning of the 
calculations, the terrain elevations are mapped according to a color scale for all grid 
points in the calculation area. This is helpful to inspect whether the DGM is smaller 
than the calculation area.  
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Display of the terrain elevations before the noise calculation 

As a correct elevation model is paramount for the noise propagation calculation, 
the colored elevation plot helps pinpoint problems in the model before the 
calculation actually starts. Errors can only be fixed in the Geo-Database.  

 Define the parameters under the Tab Grid Noise Map. 

 
Parameter definition for Grid Noise Maps 
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CALCULATE NEW GRID NOISE MAP is used to calculate a Grid Noise Map for the entire 
calculation area, continue a Grid Noise Map that is already partially calculated or 
recalculate the Grid Noise Map after the geometry was altered. RECALCULATE GRID 

NOISE MAP (See “Correct or recalculate a Grid Noise Map” page 349) is used to 
recalculate a part of the noise map after a local correction to the date model has 
been made.  The choice of GRID SPACING depends on considerations of accuracy, 
calculation time and memory/file size. In un-congested landscape a grid spacing of 
20 to 50 meters (aircraft noise) is sufficient whereas in a city environment the 
spacing should be between 5 and 15 meters. The RECEIVER HEIGHT ABOVE TERRAIN 
sets the elevation of the receivers as the elevation interpolated from the DGM + 
the height entered. The default height above the terrain is defined through the 
options in the SoundPLAN Manager.  

Interpolation during the Grid Noise Map Calculation 

The calculation of the Grid Noise Map is organized in blocks of 9 by 9 receivers. 
From the entire map a sub-grid of 81 receivers is read into memory, calculated and 
then stored. The Distributed Computing distributes those sub-grids to the 
participating servers. The 4 corners of the blocks and the middle receiver are 
always calculated. Other receivers of the block are interpolated if the following 
conditions are fulfilled: 

• The corners of the block and the middle are within the calculation area, 

• the level of the middle of the block is between the minimum and maximum 
found in the block, 

• all corners and the middle do not exceed the maximum spread allowed for 
the block defined in the field MIN/MAX, 

• the deviation for the interpolation of the block middle does not exceed the 
maximal DIFFERENCE.  

SoundPLAN averages the values of opposite corners and compares the result 
to the calculated value. For the middle of the block there are 3 values to 
compare, one calculated one and 2 interpolated ones. If the difference 
between the calculated and the interpolated one is smaller than the value 
entered in the field DIFFERENCE the rest of the block is interpolated. The 
default setting of 0.15 dB is conservative. Higher values will accelerate the 
calculations as the interpolation is less likely to be suppressed, however the 
accuracy will be reduced with higher settings. 

The FIELD SIZE defines the maximal size of blocks for the interpolation. Field size 1x1 
entirely suppresses the interpolation of receivers. The following settings are 
possible: 

1x1 no interpolation 

3x3 interpolation block maximal with 9 receivers 

5x5 interpolation block maximal with 25 receivers 

9x9 interpolation block maximal with 81 receivers 
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If all criteria are satisfied, all receivers in the block not already calculated will be 
interpolated. If not, the block is subdivided into 4 blocks and the same procedure 
starts again until all receivers of the block are either calculated or interpolated. 

      

Interpolation, to the left all criteria are satisfied in the block of 81 points, to the 
right the criteria are satisfied after the dissection in 4 smaller blocks (dark red 
interpolated, light red calculated). 

Depending on the settings of the interpolation criteria, the geometry and the 
terrain, the interpolated values may diverge from the calculated values. 

To accelerate the calculation of Grid Noise Maps you can now opt to interpolate all 
results that are below a threshold value of xx dB. By default, all new calculations 
will now have the setting to always interpolate if the neighboring values are 
below 40 dB.  

Store additional results 

Results for individual groups 

Activate the check box group results and select via the double arrow the groups 
that are used for this calculation. 

The ALLOWED TOLERANCE in the tab Settings in any case needs to be set VALID FOR 

EACH GROUP CONTRIBUTION LEVEL, in order to have the levels of groups stay 
constant when other groups are added or taken out of the calculation. If detail 
tables are activated, the tolerance is calculated on the basis of each source partial 
noise level.  

For the table type (Result Tables and Spreadsheet) and the graphical 
documentation of the results, the results can be presented either based upon 
group contribution levels or the sum level. 

Results for individual frequencies 

The results can be saved for selected frequencies and presented in the Graphics. In 
the tab Grid Noise Map in the section save results additionally for check RESULTS OF 

SINGLE FREQUENCIES [HZ]. 

When you load the data in the Graphics, the graphics file manager checks if there 
are results frequency by frequency and will prompt you to select either the sum of 
all frequencies or an individual frequency. 
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Animated noise map 

[D Graphics Animation] Only for railway noise calculations, the grid noise map can 
be displayed as a 2D or 3D animated noise map if ANIMATED NOISE MAP (MOVING 

TRAIN) is checked. Read "Train animation (page 642)" for details. 

The animated noise map generates a level-time diagram for each grid point 
which leads to very big files. Because the interpolation of the results is disabled, 

the calculation time will be much more than for a normal Grid Noise Map. 

Possibilities for the acceleration of Grid Noise Map calculations 

Depending on the area, the topographical conditions and accuracy requirements, 
the calculation of the Grid Noise Map can be accelerated by the following means: 

• Check and maximize the interpolation criteria for the accuracy desired 

• Decrease the reflection order 

• Reduce refection distance at source and receiver 

• Decrease the maximal search radius 

• Increase the allowed tolerance 

Correct or recalculate a Grid Noise Map 

If you only want to recalculate part of the calculation area because in a section of 
the map the base data have changed but the change will not affect the entire map, 
activate the option RECALCULATE GRID MAP. Assign the Situation or Geo-File which 
includes the partial calculation area. The settings of grid spacing and height of the 
receivers above the ground are disabled for the correction calculations, these 
parameters are taken from the existing grid file. Click OK and start the calculation 
with New/Overwrite. The existing grid map is loaded; the grid cells within the 
recalculation area have been deleted. 

 

! 
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The results are re-calculated in a rectangle within the original calculation area. In 
the graphic below, the original calculation area is depicted with a thin yellow line. 
The calculation area for the re-calculation is shown with a thin black line. In the 
lower section of the noise map you can see the re-calculation area contains grid 
points outside the original calculation area which will be ignored in the re-
calculation.   

 

Tables stored for Grid Map calculations 

The results of Grid Noise Maps are only documented in graphical form, not in the 
format of single receivers. However, to check the calculation tables detailing the 
emission of the different noise types are generated: 

• Road emission table (if roads are in the data) 

• Railway emission table (if railways are in the data) 

• Source table (if industrial sources are in the data) 

• Emission day histograms (if industrial sources are in the data) 

In the graphics the grid values and the contour lines can be exported in various file 
formats. 

Cross-sectional Noise Map 

For the Cross-sectional Noise Map a vertical noise map is generated along the 
Cross-section line entered in the Geo-Database as the line type receiver. The 
elevation supply along this line must be assured. It is impossible to extrapolate 
elevations in areas without sufficient elevation data. 
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With the GRID SPACING the spacing of the receivers is defined, the spacing is the 
same in height and along the Cross-sectional line. The spacing has big influence on 
the calculation time and the accuracy of the results. The CALCULATION HEIGHT 
determines the number if receivers in vertical direction relative to the receiver with 
the lowest elevation. Receivers are placed and calculated in an equidistant grid 
between the lowest terrain coordinate along the cross-sectional line to the top of 
the calculation area.  

For Cross-sectional Noise Maps the same interpolation criteria apply as for the Grid 
Noise Map. Please read the paragraph "Interpolation during the Grid Noise Map 
Calculation (page 347)". 

For Cross-Sectional Maps, too, you can additionally store the group results and the 
frequencies for individual results, see “Store additional results (page 348)”. 
Checkmark the desired results. 

Tables stored for a cross section map 

• Road emission table (if roads are in the data) 

• Railway emission table (if railways are in the data) 

• Source table (if industrial sources are in the data) 

• Emission day histograms (if industrial sources are in the data) 

In the graphics the grid values and the contour lines can be exported in various file 
formats. 

Facade Noise Map Calculations 

The Façade Noise Map is featuring an automated single point receiver calculation 
where the receivers are generated for all facades enabled for the calculation and 
the calculation settings. As the receivers are generated automatically this mapping 
module is especially useful for big calculation areas. The result of a Façade Noise 



 SoundPLAN Manual 8.1 
 Calculations 

Page • 352/793 Calculation Types 

6 

Map can be documented in tables or graphically as colored symbols at the 
buildings.  

Manually entered single receivers (e.g. for free field points) can be calculated 
together with the Façade Noise Map. If a calculation area is included in the data, 
receivers for the Façade Noise Maps are only calculated in the area inside the 
calculation area, receivers on the outside are suppressed. 

Facades of buildings connected to each other are recognized and skipped in the 
calculation. If one of the facades is higher than the other, the higher one will have 
receivers calculated only in the section that is 0.5 m above the adjacent building.  

 Define the parameters under the Tab Façade Noise Map. 
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With checking the click-box ONE RECEIVER INT HE MIDDLE OF EACH FACADE each 
facade will have one receiver in the middle. For aircraft noise calculations, you can 
select to calculate only one receiver per building. 

 

You can request TWO RECEIVERS AT THE END OF EACH FACADE with a defined spacing 
in [m] or [%] from the corner. This might be sensible when the building is very close 
to a congested road where a single receiver would not represent the noise levels 
on the façade correctly. The entry in [%] is used when receivers should be moved in 
from the corner by a defined percentage of the façade length. 

 

Place the receivers in a defined distance to each other in [m] with RECEIVER WITH 

SPACING OF. If you want to have a 3D presentation of the Façade Noise Map, a close 
spacing (1 meter spacing) of the receivers is producing a nice presentation, 
however the calculation time will be by magnitudes longer than with only a single 
receiver per facade:  

 

The VBEB (Germany - Preliminary standard for the evaluation of affected people 
according to the EU Directive) defines how to generate the receivers at the 
buildings for projects according to the EU directive in Germany. But the distribution 
of the receivers has proven to be very useful also for other types of investigations 
and non-German areas, as it generates a sensible distribution of inhabitants and 
dwelling units as long as the accounting does not require setting the loudest level 
as default for the entire building (in this case this procedure generates too many 
receivers and unnecessary long calculation times). 

Select RECEIVERS ACCORDING TO VBEB to automatically generate the receivers 
according to VBEB:  
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• Facades longer that 5 meters are divided into smaller segments for which a 
single receiver is calculated. 

• Facades with a length between 2.5 meters and 5 m are represented by a 
single receiver 

• Smaller facades are ignored except if multiple subsequent facade segments 
reach the combined length of more than 5 meters. In this case the combined 
façade is then treated as a façade longer than 5 meters and if needed 
subdivided into 5-meter sections. 

Receivers are generated as soon as one facade is highlighted for the Facade Noise 
Map.  

The DISTANCE TO THE FACADE defines how far in front of the facade the receivers 
shall be located. Some standards have specific requirements for this (CoRTN, for 
example, locates the receiver 1 meter in front).  

Click RECEIVERS IN HEIGHT ABOVE GROUND if you want to calculate one receiver in a 
defined height above ground instead of calculating receivers for each floor (e.g. for 
calculations according to the EU Directive).  

The checkbox CALCULATE REFECTIONS OF THE ASSIGNED FACADE AND IGNORE 

STANDARD DEPENDENT FAÇADE CORRECTIONS means that regardless of the terms in 
the standard the reflection at the façade is calculated (default: unchecked). Some 
standards suppress the reflection for the façade levels other use specially described 
corrections and yet others calculate the assigned façade.  

In urban land use planning, when the exact position of the buildings is not yet 
known the property boundaries might be regarded as buildings without height. In 
this case only the noise in front of the façade is to be taken into account. Activate 
the checkbox LIMIT SEARCH ANGLE BY OWN FACADE (180°). You should not use this 
check box for other correct geometries. 

In some cases shielding and reflections from buildings must to be suppressed for 
buildings specially marked in the building properties. You can do so with the 
checkbox IGNORE BUILDINGS FOR PROPAGATION CALCULATION WHICH…  

A Nordic acoustics standard demands that reflections on objects on the “own” 
property shall not be part of the noise evaluation. The properties are entered as an 
area usage object. For Single Receiver Calculations and Facade Noise Maps the 
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calculation core in the calculation settings for /SPs or /Facade Noise Map contain a 
new checkbox SUPPRESS REFLECTIONS OF OBJECTS ON OWN PROPERTY (NORDIC 

REGULATION).  With this setting the area usages are evaluated and where needed 
the reflections are suppressed. 

Reset building IDs 

If the presentation of the Facade Noise Map does not present the facades or does 
not fill the building, often this is due to the fact that buildings have been copied 
and thus the building ID from the Façade Noise Map no longer matches the 
building ID of the geometry from the situation or Geo-File. To rectify this problem, 
open the calculation core, right click on the calculation run in question and select 
the action RESET BUILDING ID from the menu. After the confirmation, all building IDs 
in the Facade Noise Map will be reset to the value found in the building geometry. 

Tables for the Façade Noise Map 

Define what RESULT TYPES for table type and graphical presentation you want to 
generate. Normally the SIMPLE RESULT TABLE is sufficient for the Facade Noise Map.  

Simple result tables  

• Receiver table 

• Road emission table (if roads are in the data) 

• Railway emission table (if railways are in the data) 

• Source table (if industrial sources are in the data) 

• Receiver day history 

• Emission day histograms (if industrial sources are in the data) 

• Emission frequency table (if industrial sources are in the data) 

• Receiver frequency table (if industrial sources are in the data) 

Level charts: 

• Level charts (for the display in the calculation core, the Results Tables detail 
table under "Details + Graphics" and in the Graphics) 

Group results: 

• Result table of groups 

Detailed result tables:  

• Result table of groups 

• Result table of the mean propagation conditions and partial noise levels 

• Result tables of assessed partial noise levels (if industrial sources are in the 
data)  

It is not recommended to store level charts and detailed result tables. This option 
will create vast amounts of data and extend the calculation time!  



 SoundPLAN Manual 8.1 
 Calculations 

Page • 356/793 Calculation Types 

6 

Meshed Noise Map 

[Modules Grid Noise Map + Façade Noise Map] The Meshed Noise Map is a series 
of single point receiver calculations where the location of the receivers is 
determined by an iterative triangulation analog to the DGM. For the graphical 
results the wire mesh of the triangulation is used to interpolate the location of the 
noise contour lines. Contour lines then are drawn using color scales. 

For detailed investigations and especially for industry noise, the Meshed Noise Map 
offers a better accuracy than the Grid Noise Map. The Meshed Noise Map achieves 
the better mapping quality by using more receivers where the noise levels are 
changing and having a coarser wire-mesh where the noise levels are only changing 
gradually. If the detail tables have been stored, you can display single frequencies 
or frequency bands in the Graphics. 

The Meshed Noise Map only calculates receivers in one elevation that is calculated 
from the terrain elevation of the elevation DGM and the relative height of the wire-
mesh above ground. 

Please do not use Meshed Noise Maps for large areas such as noise maps for 
whole cities or districts! You will probably run into problems regarding memory 
and file size! For these types of investigation, the Grid Noise Map is always the 
better choice.   

 
Triangulation in the Meshed Noise Map 

The picture above shows the different density of receivers in the free field and 
around buildings, barriers and the source lines.  

Receivers are generated along the following objects: 

• Road edges 

• Railway lines, industrial line sources (left and right at a distance of 1.25 
meters) 

• Facades 

• Noise protection walls 
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• Front and back side of the plateau of berms 

• Area usages 

• Around point sources, the program sets 4 receivers one meter from the 
point source 

• The points of an area source are used as receivers for area sources. 

Free field points lying on road bands, railway bands or within area sources are not 
included in the list of receivers. 

 

In the first step the Meshed Noise Map is setting receivers along the mandatory 
line elements of the table above. The position of the receivers is determined by 
following the line elements and placing receivers in the set RECEIVER SPACING, the 
elevation of the receiver is calculated from an interpolation of the DGM and the 
HEIGHT ABOVE GROUND parameter. After this initial placement the receivers are 
iteratively triangulated and if the triangles proved bigger than the receiver spacing 
around the original line elements and bigger than the receiver spacing * FREE FIELD 

FACTOR, receivers are inserted in the middle of the triangles and the procedure 
starts anew until all placement criteria are met.   

Terrain checking: Within the iterative distance checking, the program interpolates 
and uses the DGM to check the height of the middle between 2 receivers. If the 
interpolated and actual elevation varies by more than the set height of the map 
above the ground, the program includes the point in the list of receivers. 

This allows more thinning of receivers in the free field than before (bigger grid size 
factor in the free field). 

Tables for the Meshed Noise Map 

Plain result tables:  

• Receiver table 

• Road emission table (if roads are contained in the data) 

• Railway emission table (if railways are in the data) 

• Source table (if industrial sources are in the data) 
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• Emission day histogram table (if industrial sources are in the data) 

Group results: 

• Result tables for groups 

Detail tables: 

• Contribution noise levels. For Meshed Noise Maps based on octave or 1/3 
octave band calculations, you can show single frequencies or a special 
frequency band, if you activate the detail tables.  

Indoor calculations 

Use the Indoor Noise module to execute the following calculations: 

• Single point sound. Day histograms and assessments are considered.  

• SPC calculation (sound propagation curve). Enter a sound propagation curve 
with 2 points (VDI 3760) 

• Measurement path (SPD) 

• Indoor Noise + Grid Noise Map: If no calculation area is part of the Situation 
(smaller than the industrial building), select the industrial building as 
calculation area. 

• Calculation from inside the industrial building to the outside. All 
components, defined as sound sources must have the setting "Li(Calc)+c-R". 
Day histograms of the indoor sound sources are not taken into account! 

• Indoor Noise + Cross Section Map: Calculation of a cross section within the 
industrial building. 

SoundPLAN automatically creates result tables for indoor to outdoor calculations 
and for sound propagation curves. For the other calculation types, define the 
stored results (indoor noise single points) or grid distance and interpolation criteria 
(grid noise map / grid cross sectional map) in separate tab index cards. 

Calculation according to VDI 3760 

The calculation method used in the SoundPLAN Indoor Factory Noise Model is 
extending the concept of the of “Spiegelquellenverfahren mit Streuung“ = “Mirror 
Source Method with Scattering” (according to Kutruff & Jovicic) as it is described in 
the German VDI 3760. The calculation of the sound pressure level is considering the 
room parameters sound power of the source, density of scattering objects, and 
absorptive properties of scattering objects and all other surfaces in the building. 
The calculation is split into a direct component and a scattered component.  

Direct Noise Component  
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P = sound power of the source  
q = scattering object density 
c = speed of sound 
r = distance source to receiver  
m = air absorption coefficient 

Scattered Noise Component  

 

P = sound power of the source  
q = scattering object density 
c = speed of sound 
r = distance source to receiver  
a = absorption coefficient (contains the absorption of scattering objects and the 
absorption of ceiling and floor)     

The noise level is the sum of the direct and the scattered component summed up 
with direct and reflects paths.  

 
ρ = absorption coefficient of the walls 

The standard procedure is extended by the evaluation of mitigation effects: 

 

The screening objects in the factory building cause a mitigating effect that for the 
direct noise is calculated from the extra path length the noise has to travel over the 
obstacle and for the scattered noise component the ratio of the areas permitting 
transmission versus the areas blocking the transmission. 

Calculation parameter VDI 3760 in the Calculation Kernel 
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Enter the tolerance and the weighting filter in the tab index card Indoor Noise.  

The TOLERANCE determines the number of calculated reflection orders. The level 
increase at the receiver gets smaller from one reflection order to the next. The 
expected total level can be estimated from the history of the level increase. The 
calculation is cancelled when the expected level increase for all further reflection 
orders is less than the entered tolerance.  

Use the double arrow to open the properties of VDI 3760 (humidity, air pressure 
and temperature). 

Calculation according to a Sound Particle Model with Diffraction 
(SPD) 

Introduction 

Sound Particle Diffraction is a method of simulating sound propagation and may be 
used to make a prediction of sound levels and acoustic parameters at a chosen 
point in the vicinity of one or more sound sources. It belongs to a family of 
methods known as “geometrical acoustics” and is strongly related to ray tracing 
methods. A feature of all geometrical acoustics methods is that they do not 
implicitly include wave effects such as interference and diffraction – approximate 
procedures must be added to recreate this physics. However, by taking a more 
approximate approach, the geometrical methods make themselves much more 
practical for use in room and environmental acoustics than fuller wave-based 
methods. These often take too long to perform the necessary calculations, even if 
the heavy memory requirements allow them to be performed on a normal 
computer in the first place. 

Sound Particle Diffraction is an extension of Sound Particle Simulation Methods, 
which, along with their algorithmic relatives, have been in use for many years in 
indoor acoustics. The basic sound particle method looks rather like someone 
throwing bouncy balls around a room in various directions. The particles bounce off 
the walls and objects in the room (specularly or diffusely). The method is better 
suited to reverberant situations than the mirror-source techniques typically used 
for outdoor noise. The simulation checks each deflection to see if the particle’s 
path would take it through a receiver, represented by some finite volume. If there 
is an intersect, energy is added to the receiver. Effects such as averaged room 
scattering and transmission may be considered. However, a suitable method of 
recreating diffraction effects has proved to be a challenging problem. 

The SoundPLAN Sound Particle Diffraction module is based on recipes developed 
and tested over many years by Prof. Uwe Stephenson and co-workers at the 
HafenCity University in Hamburg, known as “Uncertainty-based diffraction”. 
Although an approximation, it has been shown to compare favorably with more 
time-consuming wave-based diffraction procedures and represents a considerable 
improvement over the “detour” methods that have been traditionally used in noise 
standards. The method works by noting when a particle flies past a diffraction edge 
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(“virtual walls” are extended out from the edge to check for intersections) and the 
particle is assigned a new angle based on how closely it bypasses the edge. 

Some general points to watch out for 

Sound Particle Diffraction (SPD) simulations operate with a slightly different 
calculation philosophy than users may be used to from other calculation methods. 
We therefore start by making a few points and recommendations to help avoid 
confusion and annoyance. 

SPD is designed to work at relatively short range, so we restrict the situation area 
radius. Please don’t try and input anything intended for an SPD simulation that’s 
larger than 1 km. 

When setting up your situation, it’s worth starting with a very crude model and 
then progressively adding detail, testing with each new addition 

A common mistake made by inexperienced users of noise control software in 
general is to assume that greater input detail gives more accurate results – the 
critical factor is often lack of knowledge of the absorption properties of surfaces, 
not the lack of centimeter geometrical precision. 

SPD goes through a range of involved geometrical procedures to enable diffraction 
and increase simulation efficiency – situations with more than a few hundred 
polygons may experience issues with computer memory shortages. 

Due to the nature of the procedures that set up the diffraction during the 
preparation phase, it is possible the algorithms may reach a point where they are 
unable to decide how to best to proceed and issue an error report – in these cases, 
please contact support. More complicated situations have a higher probability of 
running into trouble here. 

Run times increase with the number of frequencies. Don’t use more than you need, 
six or seven bands are often sufficient (bear in mind, however, that the calculations 
work out which frequency bands to use based on the source or surface with the 
lowest level of definition). 

Run times increase with the number of sources – if insignificant sources can be 
identified and deleted, this will save time. 

When setting up the situation in the editor, do use the “duplicate” function with its 
transformation capabilities instead of putting in similar objects individually by 
hand. Duplication often allows us to make some efficiency-gaining simplifications. 

SPD simulations are “statistical” and don’t necessarily have a well-defined end 
point, they fluctuate and progressively converge towards stable results 

The simulations naturally come with random fluctuations which reduce the longer 
the calculation is run for. These vary from receiver to receiver, from location to 
location, and between repeat runs – don’t be surprised if you repeat a run and the 
results come out slightly different, this is normal. Areas with higher sound levels 
have lower fluctuations than those with lower sound levels.  
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The simulations define a “tolerance”, the minimum level of fluctuations that the 
results should exhibit before the simulation pronounces itself satisfied and stops 
automatically. 

We give the user greater responsibility for inspecting the results as they progress 
and decide when they want to stop. 

Some receivers may converge very slowly, even if all others converge quickly. The 
calculation only stops automatically when ALL receivers have either converged or 
have received no signal at all. 

Regarding the previous point: it can happen (especially for loose tolerances and 
multiple sources) that some receivers register no signal when something would be 
expected. If this appears to be the case, try reducing the tolerance and repeating 
the run. 

Receivers close to walls require extra effort to converge – don’t be surprised if the 
fluctuations here are large and the convergence slow. 

Receivers close to diffracting edges and corners require even more effort.  

Well-shielded receivers that are hard to reach with reflected sound (e.g. those in 
sealed rooms or shielded in a free field situation) also tend to converge slowly. 

Receivers that are far away from all the sources converge more slowly, especially in 
free-field. 

A noise map or cross section is likely to put receivers in “harder-to-reach” places. 
Please bear this in mind, monitor the results, and end the calculation as 
appropriate to your circumstances – if you are checking for legal noise thresholds, 
you may find the relevant areas have all sufficiently converged and the calculation 
is being held up by some irrelevant, quiet areas. 

Please note that neither the tolerance nor the statistical fluctuations represent the 
total error/uncertainty in the results, they merely provide an estimate of the 
statistical error. Uncertainties due to input parameters can create 
errors/uncertainties that greatly exceed this statistical error. Furthermore, the 
mathematical models use approximations that contribute to systematic errors. 

Even the best measurement systems can have trouble with reproducibility below a 
few tenths of a decibel. Our 0.1 dB minimum tolerance setting is therefore unlikely 
to serve any purpose beyond making noise maps look more aesthetically pleasing 
due to increased smoothness. 

There’s no point in spending time nailing down accuracy below a situation’s natural 
noise floor (even a very quiet room has a background level of around 20-30 dB). 

Remember that the larger the level drop you are trying to simulate, the longer it 
will take – if it looks like a receiver will have a level 30-40 dB below the sound 
power of the sources, this is unlikely to go quickly. 
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When using grid maps, keep receiver grid spacings as large as you can. Remember 
that large numbers of receivers can noticeably slow down both the preparation 
stage and the sound particle run itself.  

SoundPLAN graphics routines provide smoothing of grid maps, so it’s worth starting 
with a relatively low resolution and later dialing it up to what you need.  

(For those with Room Acoustics licenses) If you’re interested in doing speech 
intelligibility with STI, don’t forget to define all sources and absorption spectra with 
the 7 octave bands 125 Hz, 250 Hz, 500 Hz, 1000 Hz, 2000 Hz, 4000 Hz, and 
8000 Hz. 

SPD calculation properties 

 

Click the “Indoor noise” tab – this will take you to the SPD calculation properties. 
These are normally displayed by default; if they are not, please select “Sound 
Particle Diffraction” from the uppermost drop-down menu. 

At the top of the SPD Indoor Noise panel, you can specify your DB-WEIGHTING (dB, 
dB(A) etc.) as usual. 

We recommend that you accept the defaults for “Tolerance”, “Receiver size” and 
“Diffraction enabled” at least for getting started. 

An important control is the TOLERANCE setting - it is worth taking a bit of time to 
understand what this does. We implement our sound particle method as a so-
called “statistical” procedure. This means that if you were to send off infinitely 
many sound particles, the results would look smooth and the same every time. 
Using a finite number of particles means the results have fluctuations and 
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variations between runs. The longer you run for and the more particles you send 
off, the smaller these fluctuations become – we say that the results “converge”. 

The TOLERANCE setting specifies how much the results should converge before the 
calculation stops. If you halve the tolerance from 1.0 dB to 0.5 dB, the calculation 
will take about 4 times as long, the number of particles received by the receivers 
will go up roughly by a factor of 4, and the level of fluctuation in the results will go 
down by about one half. 

For those familiar with statistical errors – the tolerance and the statistical 
fluctuations seen in the results do not map one-to-one with the standard deviation 
(this is because we do not necessarily always deal with normal distributions) but in 
many situations, they will be similar. As is also the case with standard deviations, 
the spread of results from repeat calculations will almost certainly include results 
outside the tolerance range. 

You can decide if the TOLERANCE should apply to the SOUND LEVEL AS A WHOLE 
(default) or if you wish to aim for the tolerance level of uncertainty for ALL 

INDIVIDUAL FREQUENCY LEVELS (normally takes longer). Bear in mind that if a 
receiver is reliant on diffraction for sound contributions, the high frequencies may 
be extremely reluctant to converge. 

With the RECEIVER RADIUS you define the size of the receiver sphere. Sound 
particles must work with finite-sized receivers (we use spheres) and the general 
rule is to go as big as you can justify. If you halve the receiver radius, the calculation 
can take up to 8 times as long because the receiver must “catch” particles as they 
fly by in 3D. The disadvantage of large receivers is that the sound level you 
calculate lacks spatial precision – you get an average of the field across the volume 
of the receiver. 

The receiver radius you set on the panel sets the default maximum size for a 
receiver. However, in some cases it is necessary for us to automatically reduce the 
receiver size to enable accurate results. This is especially true when a receiver lies 
close to a diffracting edge so don’t be surprised if receivers close to edges take 
longer to converge. 

When automatically adjusting the receiver size, we do not go below 0.1 m radius. It 
is therefore possible that anomalies can occur on this length scale close to 
diffraction edges; our experience suggests this is an acceptable compromise for our 
users. 

In order to speed up the calculation, the NEAR FIELD CORRECTION can be switched 
off, in addition, QUIET RECEIVERS that fall below the level of background noise and 
immission points WITHOUT AIRBORNE ROUTE TO A SOURCE can be ignored. 

elect which INDUSTRIAL BUILDING to use - the “Select Industrial Building” drop-down 
menu in the panel allows you select which industrial building you want to use. SPD 
calculates only one building per run so if there is more than one building in the 
situation, please select the you want to calculate. Otherwise, the first building in 
the list is chosen automatically. 
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Select the calculation area – if you have more than one calculation area defined in 
the situation in the data, you can choose which to use with the corresponding 
drop-down menu on the panel. 

Set grid map properties, if relevant. If you are calculating a noise map or cross-
section, you have the opportunity to specify the resolution (and height) in the 
separate “Grid” tab. 

Select the ASSESSMENT TYPES you wish to use.  

Start the calculation: Close the Run Command Editor (it will save your settings 
automatically). Select the run you want to start and hit “START SINGLE CALCULATION” 
(you can, of course, click “Start all runs checked for calculation” to run the entire 
list of calculations). Assuming no errors, the calculation will process the geometry 
and then begin launching sound particles. If you have forgotten to define necessary 
properties in the situation, an appropriate error message will be displayed. 

Monitor your run: Click on the graphics tab – this provides a color-coded display of 
your receivers. 

Right-clicking on a receiver gives the current estimate of its level and the associated 
statistical error along with any other specified assessment types. 
Stop the calculation and save the current results by clicking the red square “CANCEL 

CALCULATION” button”.  

You can always pick up where you left off by restarting the calculation and selecting 
“Continue” when the “Result exist” window appears. 

With the check box DIFFRACTION ENABLED you can optionally turn the diffraction on 
and off. Sound Particle Diffraction uses an innovative procedure to calculate sound 
diffraction with better accuracy than with the traditional noise standards. It is, 
however, possible to turn diffraction off (e.g. for comparison purposes) using the 
“Diffraction enabled” checkbox on the “Indoor noise” tab of the “Run Command 
Editor”. In these circumstances, a calculation may run faster. 

METEOROLOGICAL CONDITIONS: Relevant air conditions can be edited by clicking the 
double arrow >> button next to “Sound Particle Diffraction” at the top of the 
indoor noise tab in the run properties. Humidity, air temperature and air pressure 
can be specified under the “Environment” tab, while the method used for air 
absorption can be specified under the “Standard” tab. 

Calculation of room acoustics parameters 

Users with a room acoustics license can ask SoundPLAN calculations that use the 
Sound Particle Diffraction method to estimate room acoustic parameters. The 
current list of available parameters is: 

• Reverberation time (T60, calculated using either a T20 or T30 procedure) 

• Speech Transmission Index (STI) – male voice, female voice, and average 

• Early Decay Time (EDT) 
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• Clarity (C80, C50) 

• Definition (D50) 

• Centre Time (TS/CT) 

• Sound Strength (G) 

• Early lateral energy fraction (LF) 

Furthermore, SoundPLAN calculates the parameters required to assess buildings 
and rooms according to the standards ISO 3382-3, E VDI 2569 and DIN 18041.  

Room acoustics are available in the calculation types “Single Points” and “Indoor 
Measurement Path”.  

Single Point Calculations 

In the tile rating via the double arrow, select the room acoustics rating element. (If 
this item does not yet exist in your system library, perform a system update 
through the SoundPLAN Manager HELP -> UPDATES & DOWNLOADS.) Select the 
parameters you want to calculate: 

 

Measurement Path Calculations 

Measurement path calculations are tailored to the requirements of the guidelines 
ISO 3382-3, E VDI 2569 and DIN 18041. The required types are automatically 
activated; hence no “Assessment” tab sheet appears in the Run Command Editor 
for this calculation type. 

Reverberation times are estimated using T20. 

IMPORTANT NOTES 

As of SoundPLAN version 8.1, the default method for calculating room acoustic 
parameters is a linear regression analysis of the level decay curve, which is done 
without storing the echogram. This drastically reduces the memory requirements, 
and, in our experience, converges with less computational effort.  

A portion of the early sound field is ignored since this can bias the analysis. The 
Schroeder method is still available (for single point and measurement path 
calculations, not grid calculations) and may be selected in the SPS tab index card of 
the Run Settings. If selected, the program will calculate room acoustics using stored 
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echograms and backward integration. In addition, it will output the echograms to 
the results tables, and as text files in the results folder.  

Please note that although widely used, the Schroeder method can have issues in a 
sound particle context. In particular, if the late “tail” of the echogram is sparsely 
described with only a few particles, there is tendency for the method to 
overestimate reverb times, even if the estimated statistical uncertainty is low. A 
warning is given in these cases. We recommend running calculations several times 
with different tolerance levels to gain a feel for how the results are responding 
(lower tolerances result in longer run times and hence better results statistics).  

For the DIN 18041 we do not explicitly issue an "A" classification for the result 
tables. This is because the category "A" is not defined by strict limits, but by 
recommended values that depend on the intended use of space. However, the 
reverberation times are available to the users in order to be able to make an 
appropriate assessment here. 

The calculation results are documented in the result tables. 

File operations as calculation run 

File operations can be executed either in the Graphics and in the Spreadsheet or in 
the calculation core. If you want to store the result of a file operation, it is 
mandatory to use the calculation core.  

If you have for example calculated road and railway noise independently and want 
to further evaluate the overall noise level, it is mandatory to store the file 
operation. Only this way the Spreadsheet and the Graphics can further process the 
result of the operation. By this it is possible to generate inhabitant or area statistics 
for summed-up results. 

 

Go to the calculation core and add a new calculation run. In the tab index card 
General enter a run title and select from the calculation type TOOLS the GRID 

OPERATIONS or the FAÇADE MAP OPERATIONS.  

For façade map operations the data entry as well as the DGM selection is invisible. 
For grid operations you can optionally assign a DGM. This is not necessary, if you 
use SoundPLAN grid noise maps as base files, because the elevations are 
automatically taken from the grid noise map. If you anyway assign a DGM the grid 
elevations are newly determined. The selection of a DGM is sensible, if you use 
ESRI-ASCII grids (which don’t have elevations) as base files. This way ESRI-ASCII 
grids are supplied with elevations during the grid operation.  
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Go to the tab index card File operation and enter a new file operation with .  

A calculation run can host several time slices or different operations.  

 

The dialog to define the file operation is opened automatically. Fill in the file 
operation as described in “Procedure for the file operations (page 606)” in the 
Graphics chapter. 

If you define file operations with several time slices, the grid map(s) used as base 
file(s) must cover the same (calculation) area for grid operations; for façade map 
operation(s) the façade noise maps used as base map(s) must contain the same 
receivers.  

Enter a time slice ID and a time slice name and change the unit if necessary. This 
information is displayed in the Spreadsheet and Graphics file selection manager 
and can be used as text variables in the Graphics.  

Optionally you can use the formula of the file operation as time slice name, for 
example to document the selected operation. To do so activate the check box USE 

FORMULA AS TIME SLICE NAME in the file operation dialog. 

 

Use  to edit the file operation of the current time slice. With  you add a new 
time slice and access the dialog to define additional operations. 

Use  to delete a file operation. 

When calculating a facade map operation all information for the receivers is taken 
from the base file(s). The limits are only filled in if the number of time slices in the 
file operation definition is the same as number of time slices in the base file(s). 

Grid and facade map operations are stored with the file names RROPxxxx.RES (grid 
operation) or RGOPxxxx.RES (façade map operation).  

Hints: If you received ESRI-ASCII grids for different time slices you can import them 
with the file operations to the SoundPLAN grid structure. 
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Hotspot-Calculation 

Hotspot maps are used to visualize areas with high noise pollution. They are very 
clear to read and are therefore often provided for public relation work.  

If the basis is a Façade Noise Map the inhabitants are distributed to the calculation 
points at the building. If a Grid Noise Map is used instead, VBEB points are 
generated at all buildings with inhabitants and the inhabitants are distributed to 
the generated points.  

Normally the Façade Noise Map should be used as basis for hotspots. The result of 
a hotspot calculation with a Grid Noise Map shows a higher number of annoyed 
people because of the reflection at the building.  

For the hotspot calculation the whole area is divided into grids of 10 x 10 m. It is 
then evaluated for each grid cell how many inhabitants are affected by noise within 
a perimeter of 100 m.  

The calculation of the annoyance from the levels of the grid is done on the basis of 
the Medima curves from the "Good Practice Guide on Noise Exposure and Potential 
Health Effects" (Technical Report 11/2010) or by using threshold values. Afterwards 
the annoyed inhabitants are normalized to "inhabitants/km²".  

Example curve for Lden according to the "good practice guide": 

 

The number of how many people (in %) feel annoyed when the certain Lden level is 
exceeded is different for road noise, railway noise and aircraft noise. 

For road noise the curve refers to the formula  

% A = 1,795 * 10 -4 (Lden -37)3
 + 2,110 * 10 -2 (Lden -37)2

 + 0,5353 (Lden-37) 
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Example (thin blue line in the picture above): If a receiver has the level 65 dB and 
0.7 inhabitants are assigned to this receiver, the curve shows that 35 % of the 
inhabitants feel annoyed, which results to 0.24 annoyed for this receiver. 

Calculate Hotspots 

For the hotspot calculation you need: 

• Calculated Façade Noise Map or Grid Noise Map 

• Situation (or Geo-File) with buildings and assigned inhabitants 

• Calculation area 

• DGM (for the 3D presentation) 

Select in the run properties the CALCULATION TYPE "Grid Noise Hotspots" in the 
category "Tools". 

 

Under DATA enter the situation with the buildings and the inhabitants, a calculation 
area and the already calculated Façade Noise Map or Grid Noise Map. 

Define the parameters for the calculation in the tab index card "hotspots": 

 

The GRID SPACE is set by default to 10 m and should remain like this for traffic 
noise. A smaller grid spacing only increases the calculation time but would not 
result in higher accuracy. For aircraft noise it may be wise to increase the grid 
spacing. 

Select whether you want to use the calculation method WITH RADIUS or WITHIN 

GRID CELL. The SEARCH RADIUS of 100 m is a sensible default for action planning, 
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because the result is normalized to inhabitants/km². As the calculation run type for 
hotspots is useful for other projects too, the search radius may be adjusted to 
different settings in these projects. With the hotspot calculation within each grid 
cell, the inhabitants are not spread over the search radius but summed-up per grid 
cell, see "Total Noise Assessment according to VDI 3722-2 (page 680)".  

One calculation may include several methods for the hotspot calculation which you 
can add with the + in the navigation bar. Select the time slice and the method (the 
selection list opens with a double click on the fields).  

Implemented methods 

• above threshold 

• LA - little annoyed  

• A - annoyed  

• HA - highly annoyed  

• LSD - little sleep disturbance  

• SD - sleep disturbance  

• HSD - high sleep disturbance  

Whereby "LA" contains all inhabitants of the categories "A" and "HA" as well as 
"LSD" contains all inhabitants of the categories "SD" and "HSD". “Little annoyed” 
also contains the figures from the “annoyed” and the “highly annoyed” tally. 

Additionally, enter the threshold for the calculation method "above threshold".  

Graphically present hotspots 

In the file selection select the situation and choose the calculated hotspot map via 
the FILE TYPE General Grid Map. If the calculation contained several methods, 
select the method you want to display in the next dialog. 

 

Hotspots of different noise types can be superimposed with the Grid Operations. 
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Import of Grid Noise Maps 

If you have received Grid Noise Maps calculated by other software products than 
SoundPLAN (for example from an aircraft noise model) and the data is given as a 
text file (TXT file), it is possible to import the data directly into the calculation core 
of SoundPLAN and convert the data into the SoundPLAN format; Grid Noise Maps 
generated this way can be overlaid with other SoundPLAN data. 

To trigger the import function, select the calculation type “tools” and the select the 
sub-type “Grid Noise Import”. 

 

Select the TXT file in the DATA section (select the “text files” in the selection list for 
the file types. 

Under the tab Grid-Noise-Map-Import the structure of the import file is visible in 
the top portion. Select if a title line is present and from which line the regular data 
shall begin. 

 

In the lower section the columns from the import file are assigned to the columns 
of the grid noise map. Depending on the selected noise assessment the time slices 
are displayed for the assignment. 
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Distributed Computing 
With Distributed Computing SoundPLAN starts a calculation mode where the 
process of calculation is distributed to any number of PCs in a network. 
Multithreading for any number of cores is also supported.  

Because Distributed Computing is very easy to use it is worth to use it also for 
smaller calculations.  

The calculation is controlled by a master computer that distributes parts of the 
calculation to calculation slaves available in the network.  

In order for SoundPLAN to find the other computers and see that the users have 
given the permission to use the resource, a communications kernel must be 
running on all participating PCs.  

SoundPLAN must be installed at least as a demo version and with the same update 
date on all participating PCs. The TPC/IP protocol must be active. 

Hint: Updates can be installed from one PC to any number of other PCs at the same 
time, see "Install updates simultaneously on several computers (page 32)". If you 
use PCs for distributed computing that are normally not used for working with 
SoundPLAN it is sensible to install the SoundPLAN demo version. This has the 
advantage that the license file cannot expire and that no hardlock is needed for the 
manual update installation. 

Control program "Socket Server" on the slave 

In order that the master PC finds the other PCs in the network and to make sure 
that the users of these PC agree in the use of their PC for distributed computing, a 
control program must run on all participating PCs. Open the control program in the 
start menu with ALL PROGRAMS -> SOUNDPLAN XX -> SOCKET SERVER or in the 
SoundPLAN Manager through EXECUTE -> SOCKET SERVER. If you often work with 
distributed computing, it is the best to start the socket server automatically on 
booting the computer. 

When the socket server is running the SoundPLAN icon is visible in the task bar. 

Properties and settings for the Socket Server 

Click right on the symbol for the Socket Server in the task bar and open the 
PROPERTIES.  
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In order that a computer can be connected the Socket Server must be enabled for 
distributed computing. Via a timer you can activate PCs for certain time periods 
(PCs that for example at night would be idling). You can select here whether the 
Socket Server should be launched on Windows startup. A third option (restart DC 
server on every disconnection) tries to reactivate the Socket Server after 
unexpected malfunctions during a calculation. 

 

The lower section of the properties hosts the option to activate a debug protocol 
(checkbox ENABLE). This protocol might help the hotline to find a solution to 
possible malfunctions. Normally the checkbox should be deactivated. 

Use the button settings to change the used port numbers (see "Use "Distributed 
Computing" for different SoundPLAN versions" on page Fehler! Textmarke nicht 
definiert.), the path to which the calculation data are stored during the calculation 
and the used number of threads of multi kernel PCs. 

 

Set the number of SOCKET SERVER THREADS equal to the number of threads of the 
computer as long as it is only used for calculation. If the computer is used for other 
tasks, too, reduce the number of threads (it is often sufficient to reduce the 
number by 1). 
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In addition to the number of threads, you can specify the number of instances. The 
number of SOCKET SERVER INSTANCES indicates how often the VR control is started.  

For computers with many cores (about 8 cores or more with hyperthreading, that 
is, 16 threads), the existing threads should be divided among several instances, 
since otherwise the memory may run out.  

Set the number of instances so that the threads can be evenly distributed. For 
example, 2 instances with 8 threads each. 

Exit the control VR (right mouse button on the icon in the taskbar -> TERMINATE) 
and start it again (EXECUTE -> SOCKET SERVER in the SoundPLAN Manager). The VR 
control is then opened twice with different port numbers on a computer with 2 
instances, for example.  

The PATH FOR DISTRIBUTED COMPUTING DATA is the path where the project data are 
stored. This is by default the Globdata path. You may change this location for 
example, if there is not enough disk space available.  

RETRIEVE SOCKET SERVER INFORMATION may help you or the hotline with memory 
problems and should normally be set to "no". 

Setup of the communication between the PCs 

Click on the symbol button or open CALCULATION -> DISTRIBUTED COMPUTING 

in the calculation kernel. 

 

Edit PC list 

Click on EDIT PC LIST below the empty left field and enter the names of the PCs you 
want to use for the calculation. The computer names are displayed in the Windows 
Explorer if you select Network -> complete network. 
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Use the SEARCH button to browse through the network. All PCs available in the 
network are displayed no matter if the Socket Server is running or not. Depending 
on the network it might take quite some time. To keep the PC list clear, you can 
delete not needed PCs from the list. The PC list is stored in the Globdata folder and 
is displayed the next time you start Distributed Computing. 

Select PCs 

PCs that shall participate in the SoundPLAN calculation need to be activated and 
then with the arrow to the right or Drag&Drop transferred to the list of PCs that are 
participating in the calculations. The DC master immediately is trying to establish 
communication with the servers that are in the field of the PCs participating in the 
calculation. The slaves for which the connection was successful are displayed with 
OK in the columns "C" (connected) and R (reconnection successful). 

If you use multiple instances, each computer has to be transferred multiple times 
to the right (according to the number of instances). 

The connected computers are displayed with computer name, IP address and port 
address.  

Common trouble with the connection  

• If a computer has not been recognized correctly, for example because the 
name conversion in the network has not been successful try to establish the 
connection using the IP address in the PC list.  

• If the cell "C" states "version mismatch" the SoundPLAN update on the slave 
has another date than on the master.  

• If the cell "C" states OK but the cell "R" still states "nc" (not connected), first 
click on the computer name. If the text then changes to "OK" everything is 
correct, if not the reconnection could not be established. In this case check 
the Windows Firewall of the slaves. "SPCalc.exe" and SPSktSrv.exe" must be 
enabled as exceptions. 

The master computer can try to reconnect a slave automatically for which the 
connection broke down for any reason. Activate the checkbox TRY TO RECONNECT 

EVERY [MIN] and select the time interval. 
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Start calculation 

To start the calculation, click on the field START CALCULATION OF ALL RUNS MARKED 

WITH “YES”. SoundPLAN will now pack the project and send it to all slaves. The 
socket server icon in the task bar is now displayed with a red arrow and when you 
move the mouse over the icon you will see "status: connected to master." 

Each slave unpacks the data, tells the master computer that it is ready to work and 
receives a calculation job from the master computer. For single receivers, Façade 
Noise Maps and Meshed Noise Maps each slave will receive one receiver at a time, 
calculate the noise levels and send the results back to the client. For Grid Noise 
Maps the master computer will send the slave a field of 9 x 9 receivers to do the 
calculations. 

 

The calculation job statistics shows the number of jobs done by each computer.  

The graphics display during the calculation considerably extends the calculation 
time! It is therefore wise to only take a brief look to see how far the calculation is 
completed and then switch back to the run file tab. Use VIEW -> TILES in tile 
calculations to see the tiles already calculated. 

If the communication breaks down, a client is shut down or a server does not 
respond with result data, the client will eventually reassign the missing receivers to 
another server to make sure none of the receivers is left without calculations. 
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Add or exclude computers 

It is easily possible to exclude a slave or to add another during the calculation. 

Call CALCULATION -> PAUSE CALCULATION or click on the symbol button. It is 
then possible to add or exclude PCs or to edit the PC list.  

As soon as you are ready to continue the calculation click on CLOSE. In case new PCs 
have been added to the calculation, the needed project data are copied to the 
additional PCs before they get calculation blocks.    

Use "Distributed Computing" for different SoundPLAN 
versions and 32 Bit / 64 Bit 

To use Distributed Computing parallel for different SoundPLAN versions, the port 
numbers in the distributed computing settings must be different for each version 
(version number and 32 bit / 64 bit). For exactly one version, the port numbers 
must be the same for all participating computers. The port number must not be 
higher than 65635.  

By default, the version number is used as an identifier in the port number.  

V 8.1 32 Bit 
Port job manager: 58131 
Port VR control: 58132 

V 8.1 64 Bit 
Port job manager: 58163 

Statistical accuracy 
The German DIN 45687 in its annex F demands that the accuracy of the noise level 
simulation is to be classed and different parameters influencing the balance 
between calculation speed and accuracy can be disclosed. 

Via a statistics calculation run the program first draws a sample with highly 
accurate reference settings; the results of this run later are compared with results 
from calculations with different calculation settings or abbreviated geometry. 

The samples can be taken up front in order to determine the calculation settings 
needed in order to attain a desired accuracy or as a post calculation check to verify 
that the calculations were done correctly. The following options are available: 

• Single Receivers (up front) 

• Façade Noise (up front) 

• Grid Noise Map without interpolation of grid values (up front) 

• Grid Noise Map with interpolation (already calculated maps) 
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Draw a sample in the Calculation Core 

(Statistics up front) 

Like normal generate the entries for a normal calculation run with the reference 
settings and the data you want to check with the accuracy statistics. Under the tab 
statistics select the option DRAW STATISTICS (NUMBER OF RECEIVERS) and select the 
size of your sample. According to DIN 45687 the minimum is to evaluate a sample 
of 20 but the recommendation is to draw a sample of 1 %. For very large 
calculations with big areas and thus a very high number of receivers the number 
sampled will certainly be between the 2 values. 

In the calculation core you can calculate the samples for single receivers, Façade 
Noise Maps or Grid Noise Maps. 

 

The samples are calculated with the settings you define, however for the grid noise 
map the criteria for interpolation will be ignored, the receivers are always 
calculated in the statistics calculation run. 

Draw a sample in the Graphics 

(Statistics of maps already finished) 

The samples from grid calculations can be drawn either in the Calculation Core or 
the Graphics. Reference receivers can only be generated if a DGM was used in the 
calculation. 

If you generate the statistical sample for a Grid Noise Map from within the graphics 
also interpolated grid points are selected as reference points. If a sample is drawn 
in the calculation core, all reference points are calculated. 

First calculate the Grid Noise Map and load all data into the Graphics. 

Open EDIT MAP and open EDIT -> GENERATE STATISTICAL SAMPLE FROM GRID MAP. 

In the following dialog define the number of reference receivers. The 
recommendation is to use 1 % of the map you want to generate the statistics for – 
for large areas this is probably too much.  
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Statistics run and processing 

Generate a calculation run with different calculation settings or different geometry 
(for example tolerance, search radius, smoothed buildings, rougher DGM) and 
select the tab statistics for a statistic run: COMPARE WITH STATISTICAL SAMPLE FROM 

CALCULATION RUN NO. Enter the number under which the reference calculation results 
were saved. 

 

For statistical samples from the Calculation Core enter the number under which 
you saved the reference statistics results, for samples in the Graphics the results 
are saved under the same number as the original results. 

To compare contour line samples, a calculation run with the calculation type "single 
points" is needed.  

After the statistics run finished successfully, the run file receives an extra tab for 
the statistics. 

To analyze here results, a diagram and a table is for your disposal. The differences 
for the receiver locations and the elevation of the receiver and the elevation of the 
terrain at the receiver as well –of course- the noise levels of all time slices 
contained in the noise assessment is contained (for contour lines only the time slice 
of the loaded data is processed). Via the LEVEL FILTER receivers with a value < then 
the threshold value will be ignored in the processing. 
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The processing of the statistics is done in accordance to DIN 45687. As the result 
you will get the confidence interval (deviations up or down) in which 80% of all 
results will lay. 
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7  Result Tables 

Overview 
Single receiver results (single point calculations or façade noise maps) as well as the 
propagation parameters are clearly presented in the freely formatted Result Tables 

Aside from plain result tables there are so-called ma detail tables, for which the 
upper part of the screen shows the receivers and the assessment levels and the 
lower part presents detail information for each of the receivers. 

To compare the propagation parameters of different calculations multiple tables 
can be clearly arranged vertically or horizontally on the screen. 

Each calculation result is accompanied with an extensive run info, which 
documents all calculation parameters, standards and geometry data used in a 
calculation. This assures a high level of quality control. 

The run info as well as the documentation of the calculated sources (road, railway. 
industrial sources, and parking lots) is the basis information for all calculations (also 
for grid noise maps). 

The displayed columns with headers and legend texts as well as the page layout 
which contains the possibility to use text variables in the header and footer 
sections can be defined as desired. 

Getting started with the Result Tables 
All information regarding the sources and the results are stored in different 
database tables. The result number manages that these tables are identified to 
belong together. When you open a result file "Rxxx0000.res" in the Result Tables 
(xxx is the identifier for the calculation type, 0000 is the result number) the program 
recognizes automatically which tables are to be loaded. 

Depending on the calculation type, the calculated sources and the documentation 
depth selected in the calculation run different tables are present. 
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• Plain result tables: only final results 

• Detail result tables: intermediate and final results  

• Protocol tables: calculation protocol with all calculation steps  

• Tables for Expert Industry: Expert industry results 

• Level charts: graphical presentation of results (level chart, spectrum, day 
histogram, railway pass-by level) 

For a single point or FNM calculation with roads and plain result tables, for 
example, the following tables are generated during the calculation and presented 
here in different tab index cards: 

o Run-Info 

o Receiver table 

o Road emission table  

For a single point or FNM calculation with industrial sources and plain result tables 
the following tables are displayed: 

o Run-Info 

o Receiver table 

o Source spectrum and source day histogram 

If you stored the detail result tables, additionally the intermediate results for each 
receiver are displayed: 

o Day histogram at the receiver 

o Contribution level of each of the sources at the receiver 

o Day histograms of the contribution levels at the receiver 

o Spectra of the contribution levels at the receiver 

o Table with all propagation parameters for each time slice for the Leq 
levels (mean propagation table) 

o Table with all propagation parameters for each time slice for the Lmax 
levels 

o Group table 

o Charts of the day histogram and the spectrum at the receiver 

To compare the propagation parameters of different calculations, press the shift or 
the control key in the file selection to load several result files at the same time. Use 
WINDOW -> HORIZONTALLY or WINDOW -> VERTICALLY to arrange the files on the 
screen.  

A presetting for the table and page layout for each of the tables is delivered in the 
SoundPLAN system directory. Changes you make for layouts and texts are provided 
in the global format file "Tab_Layout.fmt" and assigned to a result file as soon as it 
is opened for the first time. 

When you close a result file, a format file containing the layouts, headers and 
legend texts of all tables belonging to the result is stored under the name "result 
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file.fmt". This format file is used instead of the global settings when you open the 
result file for the next time.  

For the result documentation in the report, the needed tables are printed. The 
definition of header and footer sections with text variables (e.g. project title or 
project number) and own texts and logos, helps you to easily provide a 
standardized and professional documentation.  

The different table types 
Depending on the selected documentation depth in the calculation properties, the 
calculation type and the sources included in the calculation, different table types 
and tab index cards are available in the Result Tables.  

Run Info 

The run info is extremely helpful for the consistency of long-lasting projects. Even 
after years you can exactly ascertain the parameters used in the calculation:  
SoundPLAN version, kernel version, calculation parameters and geometry data. The 
project description is also part of the run info.  
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Depending on the settings in the table settings for the run info (right mouse button 
-> TABLE SETTINGS) the different parts of the run info can be printed for your 
records. Use the TAB WIDTH to define the width of the first column. 

 

As for all other tables, you can also enter the table title and if needed additional 
texts. 

Single receivers 

The single receiver table is stored for all calculations. 

 

Select whether you want to display all floors or filter on the highest level 
exceedance or the loudest level per facade. You can also select the rows to be 
displayed yourself in the filter column (see below). With the right mouse button 
activate SELECT FILTER and select the HIGHEST LIMIT EXCEEDANCE PER RECEIVER, the 
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HIGHEST LEVEL PER RECEIVER or OWN SELECTION. With the right mouse button -> USE 

FILTER respective SHOW ALL you switch the view. 

If a filter is used for the table of single receivers this setting is documented with a 
small triangle in the header of the single receiver table. 

 

Filter to own selection 

If a filter is used, the corresponding rows are marked with an x in the filter column. 
You can set the markers in the filter column yourself. Make the filter column visible 
in the table settings.  

 

Details and Graphics 

Under the tab "Details and Graphics" the bottom table presents different details 
for the receiver selected in the top list. 
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For the printout, the receiver table and the detail information are combined to one 
table, thus delivering a structured, readable document. The content of the upper 
table is displayed in a header column. 

 

The columns of the top list look so squeezed on the screen, because they are 
formatted for the header rows in the printed table. The column widths refer to the 
distances of the column contents in the header row. The texts "title 1" and "Unit" 
are considered as "text before" and "text after" the column contents. Delete the 
text in "title 1" for columns in which the contents don’t need further explanation, 
e.g. "receiver name" The formatting for the header row is the same for all detail 
tables.  

Hint: The sort order of the receiver table cannot be changed in the upper table. 
Please go to the single receiver tab index card and click the right mouse button to 
change the sort order.  

You can toggle between different views on the data in the detail tables.  

dB filter weighting 

In the spectra and contribution spectra you can change or switch off the dB filter 
weighting. The selected setting is stored in the table format. 

 

Toggle between 1/3 octaves and octaves 

Click right on the spectra or contribution spectra tables to toggle between the 
display of octaves or third octaves.  

Show time slices 

The propagation parameters in the mean propagation table Leq can be presented 
for all time slices in a single line or with a line for each time slice.  
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Right click on TIME SLICES to change the selection of the time slices and to change 
the display type.  

 

If all time slices are displayed in one row, the time slice dependent parameters are 
displayed in separate columns for each time slice.  

The maximum noise levels are documented in a second mean propagation table; 
here the time slices are always using a line per time slice. 

For the contribution spectra, too, you can select the time slices to be displayed. 

Show remaining sources 

If you calculated with an allowed tolerance, sources with a low contribution at the 
receiver are not calculated in detail. Select whether you want to display or hide the 
remaining sources in the tables.  

Enter attenuations to source contribution levels 

The source contribution table allows adding attenuations for individual sources. 
The attenuations are deducted from the source contribution and the assessment 
level is corrected accordingly. 

Sort the receivers in the single receiver table descending according to the noise 
limit violation and the source contributions descending according to the 
contribution level for the desired time slice. 

Store the attenuations to assign them again after a new calculation. If you load the 
attenuations again, you will see the attenuations stored in the file. 
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To reset the attenuations for all sources, select RESET ATTENUATION from the right 
mouse menu.  

Attention: If you use an assessment type, which considers the loudest night hour, 
the decisive night hour might change due to the attenuation for individual sources.  

This is not taken into account in the Result Tables. The changed levels are always 
displayed for the initially decisive hour.  

Charts / Diagrams 

The charts can be stored in different graphics formats to a file on the hard disk or 
copied to the clipboard to use them in other programs. Click the right mouse 
button. 

Roads, railways, sources, parking lots 

Depending on the sources contained in the calculation the entry data that are the 
basis for the calculation are documented. 

For roads and railways formatted emission documentation is additionally available 
in the Geo-Database. 

Select the settings for the road inclination in the road table.  

WITHOUT GRADIENT ADDITION shows the road coordinates with changes in the 
emission level but without taking the road inclination into account. 

WITH GRADIANT ADDITION additionally shows road coordinates with changes in the 
emission level because of the gradient addition. 

ALL GRADIENTS additionally shows road coordinates with changes in the road 
inclination even if the emission level does not change.    

The table of the industrial noise sources is divided into the source spectra table 
and the source day histogram table.  

You can toggle between Lw spectrum / L'w spectrum and octaves / third octaves in 
the upper table and between Lw 24h distribution and L'w 24h distribution in the 
lower table. 
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The source spectra can be displayed in third octaves or octaves and in different dB 
filter weightings. 

Tables for room acoustics 

For room acoustics calculations, the indoor sources are offered as a source table 
and a separate table for the documentation of the surfaces. 

Depending on the room acoustic parameters contained in the calculation, 
additional tabs are created to document the measurement paths, reverberation 
times (table and diagram), user-defined and source-defined noises and signals and 
auralization.  

The echogram of the room impulse response is available as a diagram in the result 
table. You can select whether you want to see the raw data, the decay time or an 
additional regression line. Additionally, choose single frequency / single source or 
all frequencies all sources.  
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Table settings and page layout 

 

Depending on the calculation type, calculation settings, noise types and source 
types, the Result Tables offer different tables for the result data. Each tab in the 
Result Tables represents a single database table. Each database table saves its own 
format and layout settings so content and appearance can be controlled and saved 
independently.  

In the global format file (Tab_Layout.fmt in the SoundPLAN Globdata-folder), all 
pre-settings for the SoundPLAN tables are defined.  

When you open the result in the Result Tables, the program saves a format file in 
the project folder (for example, RSPS0001.fmt). This format file contains all settings 
made for these results. When a format file does not exist, it will be generated from 
information defined in the global format file.   

You can individually customize the selection of columns, their titles and units, and 
all settings for the table layout such as the font, size and color, and also set the 
texts for the table headers and footers. These settings can be saved globally to 
serve as templates for future tables.  

As the appearance of all headers and footers should be uniform, there is a 
possibility to extend this table format to all types of tables. Header and footer texts 
are constructed with text variables (project title, project number, date…). When 
these building-blocks are customized and saved in the global format file, they can 
be used in other tables. 
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 Table settings 

Column Setup 

 Open the column setup via the right mouse button -> TABLE SETTINGS. In the first 
tab index card select the columns you want to display and the format.  

 

The list on the left-hand side of the dialog shows all the available columns of the 
table. The column settings for the highlighted column can be viewed to the right.  

The checkbox in front of the column name shows whether the column should be 
displayed and printed. Change the setting with a double click on this checkbox or 
the checkbox VISIBLE, for several columns at one time (Shift + arrow key) only via 
the checkbox VISIBLE. 

The fields for TITLE1, TITLE 2 and UNIT define the texts in the column headers. 

The alignment of the column headers and the column contents can be justified left, 
right or centered. 

The COLUMN WIDTH is set in [mm]. The field REST next to the column width shows 
the remaining print width for the chosen layout and paper size. The numbers 
automatically adjust to changes from landscape to portrait and to the margin size. 
Positive numbers on the right side indicate the table still has some room. If the 
number is negative, part of the table is outside the area that will be printed. Extra 
space in the table is printed as a free column. Use the mouse to change the column 
width.  
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Presentation of Numerical Values in the Columns 

The fields DISPLAY and ROUNDING define the layout of the column and how the 
numerical values are rounded.  

The DISPLAY FORMAT of a table column can be configured individually.  

; The display format can be defined differently for values >0, <0 and =0 (in 
this order). A semicolon divides the three sections.  

. Decimal. Which character is used in your table depends on the Windows 
country code set in your PC. 

, Separator for thousand. Which character is used depends on the Windows 
country code set in your PC. 

0. # Acts as a place holder for digits. 0 is always displayed; # only if a digit is 
contained in the place of the place holder. 

0.# shows 45 as 45 and 45.3 as 45.3. 

0.0 shows 45 as 45.0 and 45.3 as 45.3  

### shows  45 as 45 

000 shows 45 as 045 

„Text“ Hyphenated characters are output as they are. 

ROUNDING the numbers can be accomplished in many different ways. The value for 
the rounding addition can be between 0 and 9.999.  

The numerical values are always rounded to the number of digits after the decimal 
delimiter. If your format does not contain any „0“ or „#“ behind the decimal the 
values will be rounded to integers. 

The rounding addition is added to the first digit not shown after the decimal and 
the value is truncated after the last digit then. This means that a value of "0" will 
not round, "5" will cause the program to round the normal way, "9,5" will round 
according to RLS-90 and "9,999" will always round up to the next value. 

Rearranging Columns 

The sequence of columns can be changed. Click on the gray column header to 
move and drag it with the left mouse button depressed to the new location. A black 
vertical line will show the new location. 

In column layout keep the left mouse button pressed on the line to be moved and 
drag it to its new location. 

Column Setup for Diagrams 

Select the charts you want to print. The column width and the diagram height 
define the size for all diagrams. The size of the diagram is automatically adjusted to 
keep the ratio of height and width constant. For the diagrams too you see the 
remaining printable width.  
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Detail header setup 

The definition of the column width in the setup for the column headers in detail 
tables differs from other tables. The column width is the length of the field in the 
column header. Title 1 is printed before the content, the unit after the content. 
Title 2 is not displayed.  

If you don't want to display the text before the column contents e.g. for the 
receiver name, delete the text in title 1. To see the meaning of the column in the 
column list anyway, you can enter it in the field title2.  

Reset titles 

Use RESET TITLES to overwrite the settings in the current table with the global 
settings and the assessment library settings. Please select, whether you want to 
overwrite the highlighted columns, all columns of the table you are just working on 
or all columns of the open result file with the default settings 

 

The assessment used during the calculation is also stored in the format file (*.fmt). 
If the assessment columns in the format file and the assessment used during the 
calculation do not correspond (for example after a recalculation with another 
assessment); you will get a warning message. Please use reset titles to initialize the 
column headers from the assessment library.  

Legend 

The legend text output in the legend section of the printed sheet can be assigned 
freely. Enter the legend text in the field LEGEND in the COLUMN SETUP. The legend is 
printed with the table according to the definition in the table settings.  

To print the legend individually, click the right mouse button in any of the tables 
and select LEGEND REPORT. 
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Table layout 

 

The table layout defines the layout of the different tables of a calculation result, 
because each table has different requirements to the layout. The single point table, 
for example, will normally be printed with another orientation (portrait) and with 
another font size than the mean propagation table that contains much more 
columns. 

Select the display in the column headers with the checkboxes TITLE1, TITLE2 and 
UNIT. These settings are used for the display on screen and for the printout. For the 
printout you can adjust the COLORS for the column headers of the master table and 
for detail tables additionally the color for the header rows of each receiver. 

For the receiver table select whether you want to display the receiver name for all 
floors or only for the first floor. With the selection FOR FIRST FLOOR ONLY, object 
number and serial number are only printed for the first floor, too. This option is 
only used, if the single receiver table is sorted by the receiver name. 

Define for the printout of master/detail tables whether a PAGE BREAK is allowed 
within a block. Otherwise the complete block with the column header will be 
printed on the next page.  

Determine the position and printout of the LEGEND. The page number is adjusted 
automatically.  

If you used a filter in the single receiver list, it is also used in the printout. 

In the table layout, the report title and two additional texts can be entered to be 
placed in the headers or footers of the table.  
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Delete and store result files 
Many different tables are stored during the calculation depending on the 
calculation type and result documentation depth.  

Go to FILE -> OPEN, click on the result file (*.res) you want to delete and press the 
Delete key. For security reasons, the selected results are displayed in a message. 
Please confirm the action.  

 

As a backup copy, you can store all database tables related to a result file under a 
new name. Go to FILE -> SAVE AS and change the number or enter a text instead of 
the number. The file name must begin with RSPS. 

Sort order 
Sort single receiver tables, source tables and detail tables according to the columns 
in the table.  

 

Select sort from the right mouse menu. Click on the sort column on the left-hand 
side and click on the arrow. If necessary, select a second sort column that shall be 
used as a secondary sort criterion. The sort order can be ascending or descending 
for all selected columns. 
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Table formats and layouts of the result tables 
Depending on the calculation type, calculation settings, noise types and source 
types, the result tables offer different tables for result data. Each tab in the result 
files represents a table, single receivers, sources, source spectra, time history…   

Each table saves its own format and layout settings so content and appearance can 
be controlled and saved independently.  

All pre-settings for the SoundPLAN Result Tables are defined in the global format 
file (Tab_Layout.fmt in the Globdata folder).  

When you open the result in the Documentation, the program saves a format file in 
the project folder (for example, RSPS0001.fmt). This format file contains all settings 
made for these results. When a format file does not exist, it will be generated from 
information defined in the global format file.   

You can individually customize the selection of columns, their titles and units, and 
all settings for the table layout such as the font, size and color, and also set the 
texts for the table headers and footers. These settings can be saved globally to 
serve as templates for future tables.  

As the appearance of all headers and footers should be uniform, there is a 
possibility to extend this table format to all types of tables. Header and footer texts 
are constructed with text variables (project title, project number, date…). When 
these building-blocks are customized and saved in the global format file, they can 
be used in other tables.   

Save, load and transfer formats  

With these functions you can save changes in the column setup (visible columns, 
column width, column headers…) and the changes in the table layout for all loaded 
tables. You can also change the global format file or generate a new format file. 

Generating a new format file may be useful if you work for different clients that 
require different layouts or if you need different table headers for different 
purposes.  

To transfer the page layout or a header or footer from one table to another, use 
transfer:  
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By default, the settings are transferred to all tables loaded from the selected result 
file. However, you can opt to transfer the paper format (letter or A4), the table font 
(but not the font size), or the table header color.  

Afterwards, click Save in the column setup or the table settings: 

  

If the settings are to be saved in the global format file tab_layout.fmt, change to 
column setup and table settings of all loaded files.  
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Page layout, header and footer texts previously transferred to all active tables are 
saved globally for each of the tables.  

If you want to modify a result table for which an fmt already exists, load the 
appropriate file: 

 

Transfer table settings to open results 

Transfer column setup, table layout, page format and headers / footers in one step 
from the active result to all other open results with FILE -> TRANSFER TABLE SETTINGS 

TO OPEN RESULTS.  

It is therefore sensible to first design all tables of one result as desired, then load 
further results and transfer the table settings.   

 Page Layout 
The page layout is used in SoundPLAN for all tabular printouts. It is also used for 
the Spreadsheet, the printouts from the libraries, the road and railway 
documentation in the Geo-Database and the photo documentation. Some features 
of the page formatting is only used in the Result Tables, because special 
information such as name of the calculation run or table title are only available 
here.  
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The page layout in SoundPLAN not only includes the paper size and the frames, but 
also the contents and layout of the headers and footers so that all enclosures of an 
investigation report look the same.  

Open the page layout with TABLE -> PAGE LAYOUT or right mouse button -> TABLE 
SETTINGS. 

Hint for the page layout of the Result Tables: Just like for the column setup and 
the table layout the page format and the header and footer text is formatted for 
each table of a result file separately because the requirements might be different. 
In order to minimize the effort for formatting the tables it is nevertheless possible 
to transfer page format and header and footer texts to other tables. The settings in 
the table layout are not affected; the orientation (portrait / landscape) for example 
is not changed. 

Define the format of the page in the tab index card "page format". 
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Define the print sheet size and the margins. The line widths and the colors of the 
frames and the separator lines can be defined for each section separately.  

The header and footer sections have three partitions: Left, middle, right. Texts or 
logos in the left partition are left aligned, in the middle partition centered and in 
the right partition right aligned. 

A graphics can be inserted in the header as well as the footer, for example your 
company logo or the logo of the customer. Click on the gray field to select the 
graphics file. Define the position (left, middle, right partition) the height and the 
width of the graphics. When you check the logo justification button ("STRETCH"), 
the logo is fitted into the allocated space. The print preview however will decrease 
its speed because of it and therefore it is advisable to select a logo of proper size.  

Format the content and the size of the page frame in the tab index card "header 
and footer texts". The texts can be text variables, automatically updated with 
information stored in the project or own texts.  

 

Page header and page footer are printed on all pages of the table as well as for the 
legend. To format the texts, highlight the text or text variable and click on the 
button FONT. Define the width of the left and right partition and the height of the 
frame. The three sections can be partitioned with vertical SEPARATOR LINES.  

USE RICHTEXT FORMAT: Enables the use of different fonts in one header or footer 
section.  

For the entry the following TEXT VARIABLES are prepared for you and will 
automatically be updated in case the information changes. Click the cursor to the 
partition where the text should be displayed and select the variable to be 
displayed: 
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Variable name Origin 

Company name License file 

Project engineer Project info 

Customer Project info 

Project title Project info  

Project number Project info 

Project path  

calculation run title (only Result Table) Calculation kernel / calculation run  

Table title  Text defined in the table layout of a result table, 
for all other printouts the name of the table 

File name  

Result Number (only Result Table) Result file 

Page number  

Total number of pages  

Date + Time  

Text 1 + 2 (only Result Table) Text defined in the table layout 

The variables can also be combined: 

<pp:Project path><fn:File name> 

will be displayed as  

D:\SoundPLAN projects\Demos\Wincity 71\RSPS0001.res 

In the tab index card table layout (Result Tables) or in the tab index card "print 
options" (all other printouts) you can select the first page number for the printout, 
so that it is possible to have a consecutive numbering if the annex of a report 
contains more than one table.  

Click on the button PREVIEW to check the page layout.  
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 The Print Preview 

 
Preview 

The preview shows you the documentation on screen the way it will look printed 
later on. The preview can be accessed from the documentation main menu via   

or in the table layout with the button . 

The functions of the icons are as follows: 

 

With the text search  you can search for any text string contained in the table, 
for example to search for a specific receiver. Under the tab search results you will 
find all pages where the search string was found. With the check box MATCH CASE 
checked, only texts are found with identical upper/lower case.  

Via the symbol the currently active page of the table can be copied to the 
clipboard as a graphics. 

 Print Result Table 

With the icon PRINT send the print job to the printer. Select all pages or only a part 
of the result documentation. Depending on the print options, the legend is printed 
before the table, after the table or not. You can also start the printout from the 
main menu of the Result Tables (TABLE -> PRINT). 
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Export of the Result table 
You can save individual detail tables or receivers in the format xls or csv, or copy it 
to the Windows clipboard. For this export you can select if you want to see the 
detail tables only or the detail table along with the information of the receiver. 
Individuel columns or the raw data can be selected for export. 

  

If you choose the export as xls file, the table is directly opened in Excel. 

In the print preview (TABLE -> PREVIEW) you can export the results to various 
graphics formats. The tables are stored without header and footer sections.   
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8  Spreadsheet 

Overview Spreadsheet 
The SoundPLAN Spreadsheet was developed to load and compare several results 
(variants), for example to calculate the differences with formulas or to depict the 
benefit of different variants using statistical functions. Moreover, additional 
evaluations, for example to determine conflicts or affected inhabitants can be 
done. 

 
Sample of a receiver table 

Additional columns are used to enter formulas as in other spreadsheet programs, 
for example "prognosis day - status quo day" or "level day +3". Conditional 
formatting is used to highlight special cells. 

Because you can load additional information from the properties in the Geo-
Database (e.g. the number of inhabitants per building or the façade length per 
receiver) and use statistical functions nearly each and every evaluation is possible.  

It is not necessary to export the data and after a result has been recalculated you 
get updated results and evaluations by just pressing a button. 

The Spreadsheet executes different table types, which can also be linked together: 
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• Receiver table (*.ntd) for the receiver related tabular processing of the 
results of single point and façade noise map calculations. 

• Building table (*.bld) for the building related post processing of the results 
of single point and façade noise map calculations.   

• Area table (*.bfl) for statements referring to areas, also inhabitant and area 
statistics according to the EU directive for environmental noise.  

• Measurement table (*.pli) for the tabular evaluation of measurement 
results, available as ASCII data (*.txt) 

• Tables, that contain the properties of Shape-file import data (dBase tables 
(*.dbf)) can be opened, modified and saved (FILE -> OPEN DBF FILE). 

 

The column header shows the physical order of the columns. Some columns are 
nearly never displayed in the table (e.g. x, y, z), other columns might have been 
added later or you changed the position of a column in the table. Therefore, the 
physical order is not a consecutive number. The formulas use the physical column 
number.  

Use the right mouse button on the column header to access often used functions 
(formulas, sort order …). 
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The table header contains the titles of the columns. In the table header cells can be 
combined to create easy to read headings. The header attributes can be edited 
when clicking on the COLUMN LAYOUT while the cursor is positioned in the header.  

The table content is created out of the data loaded to the table. The text size and 
font for the table contents and the header can be changed in the TABLE LAYOUT of 
the TABLE SETUP. Once the settings have been made the text size can be shrunk or 
enlarged in the field text size. All texts are modified proportionally. 

In addition to table contents and header, text rows can be inserted. The text size 
and font of the text rows is defined in the section layout for standard text and title 
on the right-hand side of the tool bar. 

One of the main advantages of the Spreadsheet is possibility of creating formulas 
(right mouse click on the column header) for specified columns which can be as 
complex as in a program such as Excel.  

Structure rows (TABLE -> TABLE STRUCTURE) allow summarizing columns with the 
same contents in header and footer rows and to use statistical functions (e.g. 
highest level exceedance per building).  

The table statistics (TABLE -> TABLE STATISTICS) allows statistical statements for the 
whole table, to compare for example costs and efficiency of different noise 
protection concepts. 

Another feature is the permeability between tabular and graphical presentation. 
Depending on the table type the tables can be displayed in the SoundPLAN 
Graphics as a flag at a receiver, with a colored scale for an area or directly as a 
Spreadsheet box. 

The Spreadsheet uses different column types: 

• Value columns contain values as floats with any number of decimals. 

• Integer columns contain values as integer (without decimals).  

• Text columns contain text. 

• Boolean columns (logical columns) differ between true and false. 

Due to the exchange of information between area and receiver table, receiver 
related information, e.g. "number of inhabitants above a certain limit" can be 
summed up for annoyance analyses (e.g. building blocks or districts of a town). 

The delivered sample templates help you to create meaningful tables in a short 
time. Thus, the concept is very flexible; many documentation tasks can be 
accomplished. For example, the comparison of different variants of an 
investigation, the creation of complex formulas definition of header blocks and so 
on. Check the formulas of the sample tables and if necessary, modify them for your 
purposes. You can create your own templates which contain the information 
needed for special tasks or special demands.  
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The page layout is defined in FILE -> PAGE LAYOUT. The page layout is only visible in 
the preview of the page layout. While processing the Spreadsheet the page layout 
is not visible. The maximum width of the table to fit in the page and the page 
breaks are displayed as red dotted lines. 

Getting started with the Spreadsheet 
Process to create a standard receiver table with the results "prognosis without 
noise protection" and prognosis with noise protection" and a difference column: 

• Open the Spreadsheet from the SoundPLAN Manager. The Spreadsheet file 
manager is opened. 

• Keep the presetting for the table type "receiver table" and the template 
"new template" to generate a standard table.  

• Click the NEW button. Select the first calculation result "prognosis without 
noise protection" and in the next dialog the limit columns and time slices 
you want to be included. 

• Afterwards you can use the filter settings to load only certain receivers (e.g. 
the loudest receiver per facade). 

• Click OK to generate the table. 

• Load the second calculation result ("prognosis with noise protection") with 
FILE -> ADD RESULT COLUMNS. 

• Select the desired columns for this result, too. Because the limits are the 
same as for the first result, deactivate the checkbox "limit". 

• The program recognizes identical receivers by checking the coordinates and 
the building ID and adds the results in additional columns after the first 
result.   

• Create two new value columns with the symbol button . 

• Combine the two upper and the two lower cells in the table header with the 

symbol button  and fill in the header cells (e.g. "Difference" in the upper 
line, then the names of the time slices and "[dB]" in the lower line). 

• Click right on the column header of the first new column and select 
FORMULA from the context menu. The table settings are opened which 
provide the column selection, the legend texts and the formulas for the 
calculation and for conditional formatting. Enter the difference formula in 
the section "formula for the calculation": here "x17 - x15;" (the Spreadsheet 
formulas are closed with a semicolon). Mark the formula, copy it with Ctrl+ 
C, click on the second difference column in the section "columns" and insert 
the formula with Ctrl+ V in the section "formula for the calculation". Adjust 
the column numbers in the formula and close the table settings with OK. 
The differences are now calculated.  
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• Highlight a data cell of both of the difference columns with the mouse, click 
right on the column header and select COLUMN LAYOUT DATA:19-20 from the 
context menu. Change the decimals to 1. In addition, you can insert lines 
between the columns to the left and to the right. 

• The receiver name and the usage shall only be displayed if the receiver 
name changes. Highlight one cell in both of the columns and open the 
column layout with a right click on the column header. Activate DO NOT 

SHOW TEXT IF SAME AS PREVIOUS TEXT and USE REFERENCE COLUMN. Enter the 
column number of the receiver name as reference column. Furthermore, 
horizontal lines shall divide the receivers. Check mark SHOW LINE BETWEEN 

DIFFERENT TEXTS. Close the column layout with OK. 

• Use the layout possibilities for the table layout. 

• Adjust the page layout. In the header and footer section, you can for 
example include your company logo and enter own texts and text variables 
to customize the table. 

Process to create an area table [module Tools SIP]: 

• Open the Spreadsheet from the SoundPLAN Manager, the Spreadsheet file 
manager is opened.  

• Choose the table type "area table (conflict map)". 

• Click the NEW button.  

• Select a Situation or a Geo-File containing areas (object type area usage in 
the Geo-Database). For the EU statistics it is sufficient if a calculation area is 
in the data. If area usages are in the data, the statistics are generated for the 
individual areas, too. 

• Click OK to generate the table.  

• For the EU statistics, select the desired statistics with FILE -> ADD ADDITIONAL 

COLUMNS and select a grid noise map for the area statistics or a façade noise 
map for the inhabitant statistics. See "Post processing in the Spreadsheet" 
(page 667). 

• If you select the result of a grid noise map with FILE -> ADD RESULT COLUMNS, 
the averaged value per area is added in an additional column. These values 
can also be used for calculation e.g. conflict maps or annoyance analysis. 
When you create a conflict map (page 674) in the Graphics, an area map is 
automatically generated. You can further edit this table, for example to 
generate summed up conflict maps using the formulas. 

Table Templates of the Spreadsheet 
Depending on the languages to be installed during the installation, additional 
localized templates are offered. The default templates (subfolder en) are always 
installed and displayed.  
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Select the template you want to use in the file manager: 

NEW TEMPLATE generates a table with predefined columns: receiver name, floor, 
direction, limit levels and level columns.  

CURRENT TEMPLATE uses the columns and the layout of the currently opened table. 
When you start the Spreadsheet, the current template is the same as the new 
template.  

DIFFERENT FORMATTED TEMPLATES are supplied as sample tables. 

Store your own templates for further use! If you have created a table or 
customized one of the supplied templates so that you can use them in different 
projects, store it with File -> save as template in the folder GLOBDATA. A format file 
including the page layout, logos, fonts and the header and footer definition for the 
printout is automatically stored to each table template. 

File Manager of the Spreadsheet 
Upon opening the spreadsheet, the first program part is the Spreadsheet file 
manager.  

 

If you want to generate a new spreadsheet, first select the table type. If you want 
to open one of the spreadsheets you worked on last, go to the bottom of the 
dialogue and open an existing file.  
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Generate a new Spreadsheet with an existing template 

After selecting the table type (receiver table, area table), you are presented with all 
templates fitting the selected file type. The current template is shown in the 
preview window. Select the desired template and continue with NEW.  

The box TABLE CONTENTS opens where you assign all connections simultaneously. 

  

Activate the results for the different variants contained in the template by double 
clicking or using the arrow to the right. The reference axis and the limits (receiver 
table) are automatically selected from the geometry of the first result file. Click on 
the column labeled reference line in order to select reference axis from a different 
situation.  

When a calculation of one calculation variant was split up in several calculation 
runs, additional result files can be appended to the end of the table. Click the + sign 
and attach the result file.  

 

The TABLE CONTENT is automatically opened when a new table is generated from a 
template. If you want to open this dialog later, use FILE > TABLE CONTENT.  

Use SETTINGS / FILTER to reduce for example the number of receivers (e.g. only the 
loudest receiver per building), see "Settings and Filter" on page 415. The document 
settings are automatically displayed before the table is opened if the template 
contains customized filter.  
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Generate new Table with a new Template 

After selecting a spreadsheet type (receiver table, area table) you see the columns 
that by default are included in the spreadsheet. Result columns are not shown 
because the number of desired time slots is not known at this point.   

With the button COLUMNS you get to the column selection where you can activate 
all possible columns fit for the file type of the current spreadsheet or deactivate 
not needed columns. 

Next select the result columns, the noise limit columns and the time slices for 
which you want them presented.  

Use SETTINGS / FILTER to reduce for example the number of receivers (e.g. only the 
loudest receiver per building), see "Settings and Filter" on page 415. 

Click OK to load the table.  

dBase Tables 

dBase tables (*.dbf) can be opened in the SoundPLAN Spreadsheet. Shape-files 
consist of a dBase-table containing the objects properties and all of their definitions 
and a file with the coordinates. In any case it is advisable to view this database 
table before importing the Shape-files. The Spreadsheet makes it possible for 
example to re-configure traffic data given in a format incompatible to SoundPLAN 
so that it can be imported. The formula generator in SoundPLAN is a very helpful 
tool here.  

As the Excel spreadsheet from the version 2007 can no longer save the data in the 
dBase-format, we have generated a possibility here within SoundPLAN to cope with 
these data. 

If the dBase table is stored in the project: Open the Spreadsheet, click on the menu 
topic OPEN in the file selection manager and select the file filter for dBase (*.dbf).  

If the dBase table is stored anywhere on the computer: Open the Spreadsheet, 
close the file selection manager, invoke FILE -> OPEN DBF FILE and select the table.  

The functionality was restricted to open Shape-file dBase-tables: 

• Load and save (save as is not offered as the dBase-table must have the same 
name as the rest of the Shape-files, safety copies can be generated using the 
Windows-Explorer). 

• Generation of extra columns. 

• Entry and calculation of formulas. 

When you save the table, it is saved in the dbf-format rather than in the 
SoundPLAN format. Formulas and references entered are converted into values.  
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Settings and Filter 
 There are several options and filters to select the receivers you want to display in 
the table. This is mainly needed for the results of facade noise maps.  

The document settings are automatically displayed before a table is opened if the 
template contains customized filter. In the Spreadsheet you open the document 
settings with OPTIONS -> SETINGS / FILTER.  

 

Normally the Spreadsheet performs all calculations without truncating. Because of 
rounding the numbers if you display a column with only one or without decimal 
places it may be that differences have unexpected results depending on where in 
the process the results are rounded. 

Activate the setting CALCULATE WITH DISPLAYED DECIMAL VALUES to get results 
consistent with the values displayed in the table. 

Example with one digit after the decimal: 51. 5 (51.541) - 51. 5 (51.450) results in  

setting is activated: 0.0 

setting is not activated: 0.1 

When receivers differ between two result files the option UPDATE AND ADD DATA IN 

NEW COLUMNS ONLY FOR EXISTING RECEIVERS assures that the program is not 
generating extra receiver lines for the second result file but rather amends only the 
ones already present. 

The setting CONSECUTIVE NUMBERING OF THE AUTOMATICALLY GENERATED RECEIVER 

NUMBER fills gaps in the receiver numbering that will occur, for example, when a 
Facade Noise Map is calculated only within a calculation area. This setting is 
required if you want to amend results to existing files. 
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With the SEARCH TYPE to assign receivers you can compare receivers, for which the 
receivers do not have the same position. This may be necessary for the total noise 
assessment, if different standards have different requirements for the position or 
the calculation height of the receivers.  

Choose how the receiver table should find “identical” receivers: 

x / y / z 

x / y / floor 

Object number / floor 

Also read “Process receivers with non-identical positions (page 686)”. 

DO NOT DISPLAY POINTS ON THE FACADE SMALLER THAN... [M] loads all receivers but 
only displays the receivers fitting the filter definition. Receivers blanked out are still 
included in the table statistics. This filter is used to prepare a Spreadsheet for the 
Graphics: Receivers at non-relevant facades (balconies, oriels...) shall not be part of 
the Spreadsheet but shall be loaded and displayed in the Graphics if the limit at the 
facade is violated. 

With the selection LOAD ONLY POINTS WHICH ALSO ARE IN you can restrict the loaded 
receivers to those receivers, included in another receiver table. 

Column dependent filter 

The column dependent filters are dependent of a (or all) level column(s) of a result. 

The there is a distinction between 2 filter types, filters depending on buildings and 
filters depending on coordinates. For the coordinate-wise filtering only the 
coordinates are loaded whereas the building dependent filtering will load all 
coordinates of a building as long as the criterion for at least one coordinate of the 
building is met. 

As soon as you change the filter settings for the current document with OPTIONS -> 

SETTINGS / FILTER, you are asked if you want to regenerate the table. In this case all 
coordinates of all results are loaded and sorted building by building, afterwards the 
filter is applied. 

Filter column and type of rounding type 
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With the FILTER COLUMN you define the column that should be used as filter. These 
can be all value and Boolean columns contained in the table. You can also specify 
the column for checking for conflicts. With the check mark APPLAY FILTER TO ALL 

TIME SLICES the filter criteria are applied to all time slices of the results. For 
example, for the filter „load only receiver points with conflict “, this means that 
only the receiver point with the highest magnitude of excess to the noise limit is 
used, regardless of the time slice. Please be aware that this is not necessarily the 
receiver point with the highest noise level. 

For the decision which point has a conflict, the ROUNDING MODE is important and 
also the information to which decimal it shall apply. It is for example possible that a 
receiver point in accordance to the RLS90 is not a conflict in the un-rounded state 
but that the rounding lifts it to the criterion to become a conflict. For this you need 
to define the parameters here.  

If due to rounding, multiple values are becoming identical, the value of the highest 
infringement to the limit is used to set the biggest conflict.   

The setting “calculate with displayed float values” is not used for the filtering. 

Filter by buildings 

 

In accordance to the checkboxes the program loads either only buildings WITH 

CONFLICT, or buildings WITH THE LEVEL >= an entered threshold value. All receiver 
points are loaded as long as at least one meets the filter criteria. In addition, you 
can opt to only load a single receiver point per façade.  

Filter by receiver points 

 

With the receiver point type filtering criteria on the same line are mutually 
exclusive whereas criteria below each other can be added. For example, you can 
select to load only POINTS WITH CONFLICTS or to load POINTS WITH LEVELS GREATER 

THAN. You can further refine the selection by checking the box for loading receiver 
points with the highest level / conflict PER FAÇADE, PER FLOOR or PER BUILDING 
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With loading floors ONLY WITH HIGHEST LEVEL / CONFLICT only the single floor with 
the highest values is loaded whereas ALL AFFECTED will look at every floor of the 
building.  

Effect of the filtering upon calculations 

If for example you are using the point receiver filter to LOAD ONLY POINTS WITH THE 

HIGHEST LEVEL PER BUILDING and only LOAD FLOORS WITH THE HIGHEST LEVEL, only a 
single value is loaded per building. This point then all inhabitants of the building are 
assigned to (the columns „inhabitants“ and „inhabitants /façade/floor“ will contain 
identical values). If the filter to show ONLY CONFLICT is active, you can easily 
generate worst case calculations for an area as all inhabitants of all building are 
assigned to the point on the building that shows the highest conflict value.   

Additional information: Hidden rows are calculated and evaluated for the 
structure lines. They are only omitted for the statistics (Menu Tools). 

Filter settings in Façade Noise Map and level tables 

If multiple receiver points on a façade have been calculated and only some of them 
are showing a conflict, the display without filtering will only display sections of the 
facade representing the conflict receiver. If you use the filter to LOAD ONLY THE 

POINTS WITH THE HIGHEST LEVEL PER FACADE, the entire facade is marked as having a 
conflict. 

 

Similarly, the display of the Facade Noise Map in the object settings will use scale 
colors to paint the facade either for a single receiver or for the entire facade. 

For the level tables the display combination of showing conflict facades in 
combination with the selection to load only the POINT WITH THE HIGHEST VALUE FOR 

THE ENTIRE BUILDING is not sensible as only a single point is marked even if there are 
multiple conflicts. 

Insert Results and Columns 

Add new (empty) columns 

The quickest way to add value columns, text columns or Boolean 
columns is to click on one of the symbol buttons. The columns are 

appended to the end of the table. The less frequently used integer columns are 
selected with TABLE -> ADD COLUMNS ->. Move the columns afterwards to the 
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desired position. To do so, keep the left mouse button pressed on the column 
header and move the column. 

In the cursor is in one specific column, you can insert column before the current 
column with TABLE -> INSERT COLUMNS ->. The column is then inserted physically to 
the selected position. This means that the column numbers of the following 
columns is incremented. The column reference in formulas is automatically 
corrected. 

Add columns with data and results 

 

Add result columns 

For the documentation of the results of several calculation runs e.g. different noise 
sources or different states of investigation (analysis, forecast), add columns with 
FILE -> ADD RESULT COLUMNS to the existing table. If the coordinates of the receiver 
locations are the same as in the previous result file (“same” is specified by the 
SEARCH TYPE TO ASSIGN RECEIVERS, see “Settings and Filter (page 415)”), the results 
are added in additional columns for the same receiver.  

Select the desired result file and define the limit columns and level columns you 
want to load in the next dialog. It is for example only necessary to insert the limit 
columns again, if the results use different assessments.  
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Receivers that have not been included in the first result file are appended at the 
end of the table. For these receivers only the new column can be filled in. You are 
informed about the number of receivers that do not match: 

 

Click OK to implement the new result columns in your table.  

Add results 

To append a result to an existing column of the receiver table, for example, if the 
calculation was split up in several calculation runs are processed with FILE -> ADD 

RESULTS. The dialog "table contents" is opened, in which you can assign one or 
more result files to the different level columns: 

  

Click on the right-hand side on the variant for which you want to add results and 
select the file on the left-hand side. Select the file with the right arrow or with a 
double click. To further add a result to a variant, click on the +.  
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Add additional columns 

Add columns with further information 

You can load additional information for the documentation and evaluation of the 
data using ADD ADDITIONAL COLUMNS -> COLUMNS WITH FURTHER INFORMATION. The 
origin of the information for the receiver table can be the building properties, the 
building geometry or a calculated value. The origin of the information for the area 
table is area usage properties. 

 

When moving the mouse over the column name, the origin of the information is 
displayed. You can see, for example, whether the column is a calculated value or a 
property. 

These additional columns are used to create any kind of evaluation of the 
calculation results using the formulas. 

Example: 

With the information columns "ground area * number of floors" and "count of 
receivers at a building" the inhabitants that are assigned to a building can be 
allocated to a receiver, which means to a level value to determine annoyances 
according to special criteria. 

The calculated columns can be summarized per building or per area in structure 
rows or in statistics rows as well as used for further calculations, see "Structured 
Tables and Table Statistics" on page 443.  
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Add columns from receiver tables or area tables 

A receiver table can use references from columns of an area table, whereby the 
information which is available for an area in the area table are added as a column 
for each receiver.  

And vice versa information that is available for each receiver in the receiver table 
can be summarized in the area table for each of the areas. 

Reference road or railway 

A reference road or railroad can be selected from a Situation in the Geo-Database 
to show the kilometer post in the table. It is necessary that the field reference line 
in the road or railroad properties is hooked. 

 
Reference line is check marked in the properties in the Geo-Database 

The reference axis is automatically assigned from the geometry data used in the 
calculation. If you want to use the reference axis from another situation, OPEN FILE -

> TABLE CONTENTS and select the Situation or Geo-File. 

Check column content 

By right clicking on a column header the selection CONTENT is showing the origin of 
the data. For columns tied to time slices, the time slice is presented as additional 
information. For result columns the time when the results were calculated is 
presented; with this date you can make the decision if this particular column needs 
to be updated. Open FILE -> TABLE CONTENT to check all file sources simultaneously. 

   

Change the content of geometry containing columns 

When you generate a new spreadsheet using existing templates, the current result 
file is always marked as the data source. For the geometry dependent columns, the 
situation used in the calculation run is used as the data source.  

If you have a spreadsheet with 2 variants and do not want to reference the data to 
the situation contained in the first result file, open FILE -> TABLE CONTENT and select 
another Situation which contains the geometry data. 
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Update or Rebuild Spreadsheet Content 
During the program session you can access newly calculated results with FILE -> 

UPDATE TABLE (Ctrl+ R) and FILE -> REBUILD TABLE.  

A dialogue opens where you can select groups of columns to be updated to new 
information generated in a more recent calculation. This route was chosen because 
it is seldom needed to update the geometry columns, which for large tables would 
consume a lot of on–line time. 

 

Groups are always updated completely. If you are amending a group, the complete 
group will be updated. 

REBUILD TABLE completely builds the table, executes the filters in OPTIONS -> 

SETTINGS / FILTER, adds new receivers and removes receivers no longer in the data. 
Manual cell layout, text rows and manual changes are lost. The Spreadsheet will 
inform you about the number of added and removed receivers.  

UPDATE TABLE updates only the results already included in the table. No receivers 
are added or removed and no filters are executed, but manual cell layout and text 
rows are kept.  
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 Table Settings 
The table setup is accessed via the symbol button or TABLE -> TABLE SETTINGS.  

 
Table Settings 

All available columns are displayed in the list. The X in the first column shows 
whether a column is visible in the current table or not. Double click with the left 
mouse button on the field in the appropriate row to change the mark.  

The column number is the physical number of the column which is used by the 
formula interpreter. This field cannot be edited.  

The data type is helpful for creation of own formulas, if the data type is important 
for the syntax of the formula. 

The column width can either be changed in the table itself when the cursor shape 
changes to a splitter (with a double click to the longest entry in the column), or in 
the TABLE SETTINGS or the COLUMN LAYOUT if you want to enter the accurate 
number.  

The column title is taken from the header entered in the table. If you want to edit 
the column headers in the table setup, please make sure that the line break for the 
headers is defined with a semicolon. The header text for connected columns, the 
header text is the same for all columns. 

Each column can be assigned a legend text, a calculation formula (only for columns 
that are directly assigned from a result) and a formula for conditional formatting. 
For columns from a calculation result the origin of the contents is displayed instead 
of a formula. 
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Calculating using Formulas 

General Information on the Formula Entry 

Formulas can be entered in value, integer, Boolean or text columns which are not 
generated from a result or as additional information column. 

To enter a formula, click right on the column header and select FORMULA from the 
popup menu or invoke TABLE -> TABLE SETTINGS.  

SoundPLAN formulas are interpreted column by column not cell by cell, so it is not 
necessary to copy the formula. The commands are more or less the same as in 
table calculation programs but there are additional SoundPLAN specific commands, 
for example for the logarithmic level addition (++). 

Formula Syntax 

The structure of the formulas is described using syntax charts. Please read these 
charts always from left to right. If branchings are used in the syntax chart, select 
the branch needed. If a branch leads back, it is marked with an arrow. When 
returned to the main branch, read further to the right. Such a construction is called 
a loop. 

The instruction is such a loop (see chart below): 

Enter a value in the main branch, e.g. 5, in the backwards branch an operator has 
to be entered, e.g. +.  Back in the main branch a value is needed again, e.g. 4. The 
instruction therefore is: 5 + 4; 

The terms operator and value are place holders for additional syntax charts, which 
can be further encapsulated by other place holders. In the description the key 
words are written in capital letters. 

Instruction: 

 

Conditional Instruction: 

 

The end of a formula should be marked with a semicolon ;. 
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Table of the formula commands 

A formula is a set of column references values, functions and operators which 
together form a new value. Formulas must be closed with a semicolon (;). The list 
below describes the functions available in the Spreadsheet and shows examples. 
The key words are written in capital letters, optional parameters are shown in 
square brackets ([]). 

The formulas are also used in the property explorer (Geo-Database) and for the file 
operations (extended formula input calculation kernel / graphics). In the case of file 
operations, what is here referred to as column X is the result, for example FNM or 
GNM with parameters. 

Column selection 

X1, X3/ Res(1,2), Res (11,2): The columns x1 and x3 are interpreted: Correspondingly for 
the file operations Result 1 and Result 11. 

X1..X3: The columns x1, x2, x3 are interpreted, only Spreadsheet 

Operators  

Arithmetic 
operators 

 +, -, *, / (division), ^ (xy  power) 

Relational 
operators 

 <, <=, =, >=, >, <> 

Boolean 
operators  

AND, OR, AND NOT 

Assignment := 

Instructions 

 Simple instruction 

Value 1 Arithmetic operator Value 2 

Example: Evaluation of a level exceeding the limit 

x17-x15;  

IF, THEN, 
ELSE 

Conditional instructions check the truth value of an instruction. If the 
instruction in the IF branch is true, the result of the THEN branch is 
displayed otherwise the result of the ELSE branch. 

Example 1: Evaluation of a level exceeding the limit; values < 0 shall be 
displayed as 0. Add a value column. 

IF x17 - x15 > 0 THEN x17 - x15 ELS 0; 

Example 2: If the limits day and night are kept a dash shall be displayed 
otherwise the limit exceedance day and night. (The limits are in the 
columns x14 (day) and x15 (night) and the levels day / night are in the 
columns x16/x17.) Add a text column. 

IF (x11 - x7 <=0) AND (x12 – x8 <=0) 
  THEN "-"  
  ELSE TEXT(x11-x7) + “/” + TEXT(x12-x8) ; 
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CASE Case branching can be used to assign different cases different results or 
formulas. 

CASE result OF 
   value : formula ; 
  value : formula ; 
   … 

   [ELSE: formula ;] 

END; 

The result can be an integer value or a text; therefore, the value must 
also be an integer value or a text.  

The ELSE branch is optional. In case no case is true and no else branch 
was defined, the formula interpreter will terminate with an error 
condition. 

Example: 

X9 is the column with the area usage. The formula column is the noise 
limit column.  

CASE X9 OF 
  „GR“:  59; 
  „MI“:  64; 
  „BD“: 69; 
  ELSE: 0; 
END; 

General text functions 

With relations and instructions, VALUE can also be a text. The text has to be marked by "". 
Text relations do not differ between normal letters and capital letters. As all characters 
marked by "" are interpreted as text, also slash (/) or dash (-) can be used in text columns. 
Because text columns can only interpret text and value columns can only interpret values, 
there are special functions to convert text in values or values in text. The column type 
cannot be converted. 

TEXT TEXT converts a value in a text, additionally the number of decimal 
places can be entered 

 TEXT (instruction[, decimal places]) 

 Example: TEXT (x11-x9,1) 

VALUE converts a text in a value 

 

RIGHT, LEFT, 
PART 

Function if only a part of a text shall be displayed 

 RIGHT(column, number of characters) 

 LEFT(column, number of characters) 

 PART(column, start position, number of characters) 

 Example: x7=SoundPLAN  

LEFT (x7,5) results "Sound" 

RIGHT (x7,4) results "PLAN" 

PART (x7,4,2) results "nd" 
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LENGTH Results the number of characters of a text 

POS Results the start position of the first text part, which is included in 
the text 

 POS(“Text part”, column complete text) [=P] 

P is the position of the text part within the column. Without the 
definition of the position, the text part is searched within the whole 
column.  

Example: 

IF POS ("G", x9)=1 THEN … 

looks for G only at the first position 

The formula  

IF POS ("G", x9) THEN … 

finds all texts that contain a G. 

Combination of 
the text 

functions 

You can combine different text functions for example if you want to 
extract a set of values from the receiver name.  

Examples: 

x7 contains the text “001-road name No.” 

LEFT(x7,POS(“-“,x7)-1); Results “001” 

x7 contains the receiver name: 

RE1 – road name 
RE2 – road name 
RE10 – road name 

PART(x10,3, POS(“-“,x7)-3);  

Extracts the number from the receiver name. The start position of 
the number is the same for all rows (third character).  

X7 contains the receiver name: 

RE-1 road name 
REC-2 road name 
RE-10 road name 
REC-100 road name 

PART(x7,(POS(“ “, x7)+1),(POS(“ “, x7)-1)-(POS(“-“, x7)-1)); 

Extracts the number form the receiver name, if the star position of 
the number differs.  

Statistic functions 

COUNT COUNT (Columns) Relational operator Value 

Counts the specified columns that meet the criterion 

Count(x18..x22) >55 

MIN MIN (Columns) 

Results the lowest value of the specified columns 

MIN(x18, x22) 

MAX MAX (Columns) 

Results the highest value of the specified columns 

MAX(x18.. x22) 
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Arithmetic functions (-  Function (instruction) - 

ROUND ROUND (column number [,decimal places]) 
Results the arithmetical rounded value. You can optionally determine 
which decimal should be rounded. Without specifying decimals 
results the rounded integer value. 

ROUND(x10,1) 

TRUNC TRUNC (column number[,decimals])  

Truncates the value at the determined decimal and results the 
truncated value 

ROUNDUP ROUNDUP (column number [,decimals]) 

Results are rounded up to the specified decimal.  

SQR  result is x² 

SQRT  result is square root of x 

EXP  result is xy 

LN  result is the natural logarithm 

LOG  result is the logarithm to the base 10 

ABS result is the absolute of a value 

  

SoundPLAN specific functions 

RLS90 Rounded value according to RLS 90 (intermediate values rounded to 
the first decimal, assessment level rounded up to total dB(A)) 

RLS90(x12); 

KM Converts the km post calculated in the Geo-Database into km+meter 
(in GeoDB; 0,665 -> 0+665). KM(x10); 

++ 

(LEVELSUM) 

x17++x18 energetically sums up the levels in the assigned columns. 

You can also use LEVELSUM (x17..x21) for the level addition of more 
than two columns 

-- 

(LEVELDIFF) 

x17--x18: the result is the energetical difference of the assigned 
columns. 

You can also use LEVELDIFF(x17..x21) for the level difference of more 
than two columns 

CONFLICT-
VALUE  

CONFLICTVALUE(x19-x17) 

If the result of the instruction is <0, the result is 0 else the difference 
between level value and limit level. If the instruction includes a limit 
level column, the spreadsheet checks, if the limit level is 0 (not 
available). In this case, the result of the instruction is also 0. Example: 

Level column x19 Limit column x17 Conflict value  
(x19-x17) 

60,3 59 1,3 

58,7 59 0 

60,3 0 0 
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CONFLICT  
 

Example: Are levels exceeding the limits, yes or no. Enter a Boolean 
column. 

CONFLICT(x19-x17) 

If the result of the instruction is <0, the result is "false" (0) else "true" 
(1) (Boolean values). If the instruction includes a limit level column, 
the spreadsheet checks, whether the limit level is 0. In this case, the 
result of the instruction is also 0. 

 x19=60,3, x17(limit)=59, Result "true" 

x19=58, x17(limit)=59, Result "false" 

x19=60,3, x17(limit)=0, Result "false" 

FIRSTROW 

PR (prior row) 

If you want to renumber buildings with consecutive numbers and 
column 7 is the building ID and the column for the consecutive is 28 
(this is also the column where the formula is present), request a new 
integer column with TABLE -> ADD COLUMN and write the following 
formula for column 28 

If FIRSTROW then 1 
else if x7 =PR7 then PR28 
else PR28+1;  

The first line of the table is set to 1. After setting the first value, the 
formula checks if the building ID is the same as in the previous line. If 
it is, the consecutive number is copied from the last line. If not, it is 
incremented by one. 

NEW The keyword NEWcolumn number in the formula makes it easier to 
pol a column for a changed content.  

If NEW7 then … means „if a values in column 7 differs from the 
previous line, then …“ 

With this new keyword the keywords „Firstrow“ and „PR“ can often 
be replaced. 

BH 

BF 

STAT 

Assign fields of structure lines.  

BHnumber  Block begin- or Header line 

BFnumber  Block end- or Footer line 

STATnumber Statistics row 

"number" refers to the position of the column in the list of block 
header or block footer; see "Usage of structure fields in formulas" on 
page 448. 

Area table 

GV  Grid value: instead of x if the grid value shall be used (Area table) 

CV  Conflict value: instead of x if the conflict value shall be used (Area 
table) 

GRIDCOUNT Counts the number of grid values  

CONFLICT-
COUNT 

Counts the number of conflict values  

CONFLICTCOUNT(column number) 

SUMX SUMXstatisticsscolumn (no blanks permitted) in a value column: 
sums up the contents of a statistics column 
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File operations – extended formula entry (fyi entry with double click on the file 
in the table)  

GNM - GOP 

 

CNM 

 

FNM - FMO 

 

MNM 

Grid Noise Map– Grid Operation 

RGNM(No[,group No.][,frequency No.],time slice No. [,time step]) 

Cross sectional Map  

RCNM(No[,group No.][,frequency No.],time slice No. [,time step]) 

Facade Noise Map– Façade Map Operation 

RFNM(No[,group No.],time slice No.  

Meshed Noise Map 

MNM(No. time slice No.[,group No.][,Type, frequency, dB-weighting]) 

 All results are entered at least with the result number and the number 
of the time slice.  

If the groups and/or frequencies were stored during calculation, these 
results are entered as optional parameters. The group or frequency 
number is according to the order in the selection list. As the sum level 
is the first entry in the list, the first group / frequency in the selection 
list is assigned with “2”. 

The number of the time slice is the order, the time slices are defined in 
the assessment library. For example, time slice 1 = day, time slice 2 = 
night, time slice 3 = Lmax.  

For grid operations with animations, you can optionally add a time 
step for the delay of one of the grid maps. One time step corresponds 
to approx. 0,125 seconds. 

For Meshed Noise Maps the parameter selection is slightly different. 
The parameters are assigned in brackets. Here you can do operations 
with single frequencies or frequency bands and specify the dB-
weighting.  

The parameters for extended operations with frequencies are: 

Type: B (band), O (octave), T (third-octave) 

Frequency: Enter the frequency, e.g. 63 for the types octave and third-
octave or the frequency band, e.g. 63-8000 

dB-weighting: _, A, B, C, D  

Instructions for conditional formatting (cell layout formulas)  

 CELL  CELL (Parameter, [Parameter,[Parameter …]]) 

Defines text color, text style and the cell background color. It is defined 
using special key words or RGB values.  

Example: CELL(red, bold) 

Keywords for text and colors: 

bold, italic, underline 

red, green, blue, black, white, yellow, magenta, cyan, gray 

light and dark can accompany the color names (except black and white).  

e.g. LIGHTRED The color name must be written in one word. 

Except for gray, full colors use the RGB values 255 and 0, light colors use 
255 and 200, the dark colors use 200 and 0. 
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CC Cell color: To set the cell color, it is always necessary to add the 
instruction CC.  

CELL(CC=keyword) 

Example: Cell color should be lightgray and the cell text red and bold. 

CELL(CC=lightgray, red, bold) 

CELL(CC(r,g,b)) sets the colors according to the red, green and blue 
partitions. Example: CELL(CC(100,150,100)) 

Example: 

If X19>X17 
   then CELL (CC=lightred, bold) 
   else CELL (gray); 
If a conflict occurs, the cell background is light red and the text is bold. 
Because the text color doesn't change, the definition of the text color is 
taken from the column layout. Without a conflict, the text color is gray. 

As often only the cells with conflict should be changed, the ELSE branch 
can be omitted. 

Instead of  

If CONFLICT (X19-X17) 
   then CELL (ZF=lightred, bold) 
   else CELL (); 

If CONFLICT (X19-X17) 
   then CELL (ZF=lightred, bold); 

 Example color exceedance according to the usage: 

if x11="GR"  
 then Cell(CC(255,200,255)) 
  else if x11="MI"  
 then Cell (CC=lightgreen) 
  else if x11="BU" 
  then Cell(CC=lightgray) 

  else Cell(CC=white); 

TC  Text color:  

CELL(TC(r,g,b),bold) 

The instruction TC is needed if you use RGB values, otherwise the 
keyword is sufficient.  

Example CELL(TC(255,150,0)) 

Variables (Example see "Variables in formulas for Spreadsheet and file operations (page 
433)") 

float Value as decimal value 

integer Value as integer value 

Boolean Logical value (true / false) 

text Text 

var Definition of the variables needs to start with the keyword „var“ 

begin … 
end; 

Formulas must be enclosed in a begin – end block, each command must 
be ending with a semicolon; 
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Variables in formulas for Spreadsheet and file operations 

Now you can use your own variables in the Spreadsheet and the extended file 
operations of the graphics and the calculation core. This enables the user to make 
complex queries without the need to insert an auxiliary column.  

Assign the variable a value using the operator „:=“. The value can be a constant or 
can be derived from a calculation. The definition of variables always start with the 
keyword „var“, commands must be made visible as a block with the commands 
„begin“  and „end“. Each command needs to be ended with a semicolon („;“).  

Example: A column needs to show the higher noise exceedance (violation of the 
noise limit) for day or for night.   
var 

   dPGwT, dPGwN, dMax  :float; 

begin 

   dPGwT := x16-x14;     // noise limit exceedance day 

   dPGwN := x17-x15;    //  noise limit exceedance night  

   if  dPGwT > dPGwN  

       then  dMax := dPGwT 

       else  dMax := dPGwN; 

  // the result is written into the column where the formula is 

located: 

   if  dMax > 0 

       then  dMax 

       else  0; 

end;  

In the „var“ block define which data types correspond to the variables. Decide on 
the names of the variables; the data types are recognized by keywords.  

With // you can mark the rest of the line as a comment that is not processed in the 
formula.   

Keywords for data types: 

float  The declared variable is a floating point value 

integer  The declared variable is an integer value 

Boolean The declared variable is a logical value (true/false) 

text  The declared variable is a text 

Advantages: 

• When columns are assigned variables, the formulas are much easier 
transferred to other columns / operations as only the initial assignment of 
the column numbers must be adjusted. 

• By using variables, even complex formulas are becoming readable. 
Complicated nested „if then else“-queries are more readable with auxiliary 
variables. 
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Export formulas 

In order to get an overview on the used formulas, especially for big tables, use FILE -

> EXPORT FORMULAS. All Spreadsheet columns with content, legend text and 
formula are written into an ASCII file.  

Correction of errors in a formula 

If there should be a mistake in the formula, SoundPLAN will open a window 
showing which information is needed and at which position in the formula.  

 

You can correct the formula in the dialog. OK executes the formula and corrects it 
in the formula entry, too. 

When an error is detected in a formula, the cursor will jump to the cell causing the 
error. The error description contains the line number where the error was 
detected. 

Designing Spreadsheet tables 
There are a lot of possibilities to design the Spreadsheet tables.  

• Formatting of the columns using the column layout 

• Format single cells, for example to highlight level exceeding 

• Combine cells in the table header  

• Make tables easier to read using the table structure  

• Use the 3 section layouts for the formatting of text  

Column layout 

The column layout can be accessed either via the right mouse button menu from 
the column header or via TABLE -> LAYOUT -> TITLE COLUMN or DATA COLUMN. The 
column layout is always valid for all column marked or the current column in which 
the cursor is positioned. If the cursor is positioned in the table header, the column 
layout enters the header layout; if it is positioned in the table contents, the layout 
for the table contents is opened.  
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Column layout of a float column in the Spreadsheet 

Depending on the column type (float column, text column, Boolean column, integer 
column) the column layout slightly differs.  

The background color of the columns can be set to highlight a column. The 
background color is set to transparent by default for the table contents. 

The column width can be set numerically. Via the button right to the 
numerical entry, the column width is assigned to the longest entry in 

each column.  

Enter the number of decimal places and the round mode. The section VALUE is only 
visible if you edit the layout of a value column.  

The rounding only is only used for the display of the values in the columns; they are 
internally always stored with all decimal places. Therefore, you have the possibility 
to use the parameter CALCULATE WITH DISPLAYED FLOAT VALUES under OPTIONS -> 

SETTINGS / FILTER. If you deactivate this parameter, the program calculates with the 
original values and you might get differences. 
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The round mode has several rounding options 

 

The round mode NORMAL rounds according to the mathematics standards on the 
specified decimal places: 

1 decimal place: 0,3499 -> 0,3  0,3500 -> 0,4 

2 decimal places: 0,3499 -> 0,35  0,3500 -> 0,35 

The round result depends on the numbers of decimal places defined in the field 
DECIMAL PLACES. 

The round mode DOWN (TRUNCATE) cuts down the value to the specified decimal 
places:  

1 decimal place: 0,3499 -> 0,3  0,3500 -> 0,3 

The round mode UP (TRUNCATE+1) cuts down the value to the specified decimal 
places and adds 1 on the last decimal place:  

1 decimal place: 0,3499  -> (0,3 + 0,1) = 0,4  0,3500-> (0,3 + 0,1) = 0,4 

Values <= 0 can be displayed with a minus (-) instead of the value. Activate the 
check box “-“ FOR VALUES <= 0.  

If the column setup has been set to „- for values <= 0“, then values < 0 are ignored 
for table statistics (i.e. for the average).   

USE THOUSANDS SEPARATOR groups values > 1,000 to groups of three figures and 
inserts a comma (or a point, if the decimal separator is a comma).  

The FACTOR can be used to rescale the unit for the display, e.g. -3 to display [km] 
instead of [m]. 

There is no round mode for Integer columns. If a value in an integer column comes 
from a float column, it is rounded arithmetically. You can change the display of the 
numbers from Arabic to Roman numbers. 

 

The floor column 6 (integer column) can be formatted in the column layout as 
„ground floor, 2. floor, 3. floor“. The floor description from OPTIONS -> SETTINGS in 
the SoundPLAN Manager is used. 
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Boolean columns distinguish between true and false. Enter the text that shall be 
displayed in the table for true statements and for false statements. 

 

To improve the readability of the table, you can define if a text should only be 
displayed if it differs from the previous text. Additionally, it is possible to 
automatically generate lines between the differing texts.  

 
Only texts different to the previous text are displayed. 

Enable this function with a click in the field DO NOT SHOW TEXT IF SAME AS PREVIOUS 

TEXT. If more than the text in one column should not be shown, it is necessary to 
define a reference column to which the column text refers. Click on the field USE 

REFERENCE COLUMN and enter the column number from the column header.  

E.g. the area usage is always the same but it should be displayed with every 
receiver location. Click in the column area usage on the field DO NOT SHOW TEXT IF 

SAME AS PREVIOUS TEXT, activate USE REFERENCE COLUMN and enter the column 
number of the receiver name (in the example column No. 7). 

Click on the field SHOW LINE BETWEEN DIFFERENT TEXTS and define the line width and 
the color.  

Another possibility to make big tables easy to read is to use "Structured Tables" 
(see page 443). 

Define the font, the text style and the text color via the button FONT and the 
ALIGNMENT of the text. All settings hold for the complete column. Enter a TEXT 

DISTANCE left or right if you want to have a distance from the cell edge. (Use 
conditional formatting to highlight single cells). 
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The EDGE LINES define for each edge line separately whether the edge lines should 
be displayed, and if yes in which line width and color. 

Changes in the table header  

You can connect cells in the column title. 

 

Highlight the cells you want to connect and select TITLE -> CONNECT 

HIGHLIGHTED CELLS .  

Click on the connected cell and select TITLE -> DISCONNECT CELLS  to get 
separate cells again. Or use the symbol button. 

It is possible to insert the logical number or the physical column number in the 
column title. Select TITLE -> INSERT LOGICAL NUMBER or INSERT COLUMN NUMBER.  

In order to insert the numbering in the last row of the column header, activate 
OPTIONS -> INSERT ROWS AFTER. Position the cursor in the last title column and 
insert the numbering. 

The formulas refer to the physical column numbers. If someone else should work 
with the formulas without having the table itself, it is necessary to insert the 
physical column numbers so that the other person can recognize the references. 

With the logical column numbers, all visible columns are consecutively numbered 
and if you defined it that way printed with the legend. See “Print legend” on page 
451.   

You can delete the column numbering with Ctrl+ Del or with the symbol 
DELETE LINES from the column header.  

Column width optimization tools 

SoundPLAN offers tools to optimize the column width: 

To adjust the column width to the longest entry in the column, select 
the button  in the COLUMN LAYOUT.  

A double click on the „splitter“-cursor between two columns will optimize the 
column width of the left of both columns. 
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To optimize the column widths for the whole table, i.e. to enlarge or shrink all 
columns so that they fit in the page width, choose TOOLS -> OPTIMIZE COLUMN 
WIDTHS.  

Or you can adjust the column widths of all columns so that all columns fit in the 
selected page format (portrait or landscape). Select TOOLS -> FIT IN COLUMN WIDTH 
IN PAGE WIDTH. 

To adjust the last column of the table to fit in the page width, choose TOOLS ->FIT 

LAST COLUMN IN PAGE WIDTH. 

Hint: Be careful with combined cells in the header. The optimization tool cannot 
optimize combined cells. In this case SoundPLAN will optimize the cells in the table 
content. 

Layout settings for the whole table (Table settings) 

The three record cards on the right-hand side of the dialog box TABLE SETTINGS 
handle table header, table contents and table width definitions. 

 

The FONT definition is the same for table header and table contents. Once the fonts 
and text sizes have been modified, the texts can be proportionally enlarged or 
shrunk via the text size field on the right hand of the tool bar . The text size 

displayed is the table contents text size.  

The ROW DISTANCE is the height of each row in table contents or table header. TEXT 

DISTANCE FROM CELL TOP defines the position of the text in the row and is 
automatically adjusted to the row distance.  

A BACKGROUND COLOR can be defined for the table header.  

Sort  

The Spreadsheet can use structured sorting. Open the TABLE -> SORT and select the 
column that is used for sorting. A second list allows a second sort criterion for cases 
where multiple entries are the same.  
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If columns are highlighted, the sorting is only valid within the range of the 
highlighted columns. 

Page break 

Use TABLE -> INSERT PAGE BREAK or Alt+ Ins if you need to insert a manual page 
break. The page break is displayed with a dotted green line.  

Delete a manual page break: Place the cursor near the page break and select the 
page break with the arrow keys. As soon as a row is not highlighted, the page break 
is active. Press Del to delete it.  

Conditional formatting with formulas 

The analysis of results and statements must often answer to the following 
questions: 

• Where do we have limit violations? 

• What are the highest levels? 

• Where are most of the inhabitants affected? 

Use conditional formatting to easily highlight interesting cells or unusual values and 
make them visible with different colors.  

 

In TABLE -> TABLE SETTINGS you can define a second formula for the cell layout, so 
the cell layout can be stored in the templates and is still correct after a 
recalculation. 
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The display of a cell is changed on the basis of conditions. If the condition in the IF -
THEN branch is fulfilled the cell is formatted according to this condition otherwise 
according to the condition in the ELSE branch. 

The key is: 
CELL (Parameter, [Parameter,[Parameter …]]) 

You can determine the text color as well as the background color of the cell. For the 
instructions and key words see "Instructions for conditional formatting (cell layout 
formulas" on page 431. 

Calculate and highlight 

Single cells can be marked by either clicking Ctrl+ left mouse button or by using the 
function CALCULATE AND HIGHLIGHT in the right mouse button menu from the 
column header.  

 

With this function for example all cells in which the acceptable noise limit has been 
exceeded can be marked automatically to be displayed in bold.  

The item MARK marks the current column to modify the layout.  

 Section Layout 
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The section layout is used to define the title, body text and block layout of text 
rows or structured tables in the table. Changes in the font, letter type and size, line 
spacing and section spacing can also be reviewed. The text rows or structured 
tables can be assigned a top and bottom line and a background color. The items in 
the section layout are self-explaining. The layout of the table columns and table 
header is modified in the column layout or in the table setup. 

 Subscript Texts 

In text boxes, legends, scales and with general texts in the graphics as well as for 
headers in the Spreadsheet it is possible to have texts with the attribute subscript. 
Write the text like normal, mark the spot that needs to be turned into subscript 
and click on the symbol SUBSCRIPT. As you still process the text, control characters 
are marking the subscript part. 

 

R’w,res for example will be displayed as "R'@\l+w, res@\l-". As soon as you finish 
editing the text, the subscript will be effective. 

In case you need other text attributes, you can manually insert them: 

@\l+text@\l-  = subscript 

@\h+text@\h-  = superscript 

@\i+text@\i-  = italic 

@\b+text@\b-  = bold 

Additional tools and hotkeys 

Use EDIT -> OPERATION to do manual changes to a nearly completed table. If the 
column comes from a calculation result, the changes will be gone as soon as you 
rebuild the table.  

Select the cells you want to change (or the whole column with right mouse button 
on the column header -> MARK) and enter the value or text that should be entered 
to all marked cells. With the function "replace text" (->) you can, for example 
correct a spelling error in the receiver name without the need to recalculate the 
result. 

old->new: The text "old" is replaced by the text "new". 



SoundPLAN Manual 8.1 
Spreadsheet 

Structured Tables and Table Statistics  Page •  443/793 

8 

TABLE -> HIDE ROWS hides marked or not marked rows, for example to check 
receivers at the end of a table when the table is very long. TABLE -> SHOW HIDDEN 

ROWS displays them again.  

Display a cell statistics of a single column or marked cells with TOOLS -> STATISTICS. 

  

TOOLS -> LEVEL SUM calculates the level sum of a column or the marked cells.  

Ctrl + Pos1 or Ctrl + End moves to the beginning / end of the table, Ctrl + Shift + 
Pos1 or Ctrl + Shift + End marks all lines from the current line to the first/ last line 
of the table. 
 

Structured Tables and Table Statistics 

 
Example of block definitions in the Spreadsheet 
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The structured table shows selected columns as a header row and exclude them 
from the table. Thereby the table becomes easy to read and smaller.  

This way you can combine information that is the same for the whole building, for 
example, the receiver name, the area usage and the limits in the header line. 
Moreover, you can use statistical functions to further evaluate information from 
individual columns, for example the highest limit violation per building.  

Statistical evaluations for all receivers of a table are stored in the table statistics, 
e.g. to compare the costs of different noise protection measures. 

Create and format table structure and table statistics 

We here describe the procedure of creating structured tables using the block 
header. Block footer and table statistics are created the same way.  

Mark the columns in the table that should be displayed in the header row by 
selecting them with the mouse (Ctrl+ left mouse button). You don’t have to mark 
the whole column but only a single cell. 

 

Select TABLE -> STRUCTURED TABLE -> DEFINE BLOCK HEADER, the dialog box might 
look like that: 

 
Block definition – not modified 

The first column is the column number in the table. In the column "function" 
statistical functions (page 447) can be stored (not for text columns). X and y 
position show the position of the text in the header row in mm. It is automatically 
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taken from the column width. TEXT BEFORE and TEXT AFTER are taken from the 
column header in the table. FONT describes the selected section layout.  

The preview shows that the field definitions need to be modified. The preview does 
not show the first but the longest entry, so that your modifications surely fit for all 
entries.  

Unnecessary texts can be deleted, moreover the information often overlap because 
the distances are taken from the column widths. Open the table structure again to 
rework the texts and positions (TABLE -> TABLE STRUCTURE -> DEFINE BLOCK HEADER). 

Without modifications the column receiver name looks like 

Name: Beech Lane 1 

because the column header is displayed as “text before”.  

But in the header row it is not necessary to display the text “Receiver name”. You 
can therefore delete the text before.  

The noise limits are unmodified displayed as 

  Limit day 64 dB(A) Limit night 54 dB(A) 

perhaps shall be displayed as 

  Limit day / night   64 / 54 dB(A) 

Enter “Limit day / night” in the field text before of the column “limit day”, delete 
the text of the following text of the same column and enter “/” instead. Delete the 
text before in the column “limit night” and enter “ dB(A)” in the field  following 
text. You should add a blank to the text before and in front of the following text, as 
the column contents is added directly to the text.  

Activate the check box XREL for the column “limit night” and set the value for the x 
position to 0; this way the limit night is added directly after the limit day.  

Place the cursor to the first row and click on the pocket calculator to calculate the 
distances (x position). Between each field the user defined DISTANCE BETWEEN 

FIELDS is kept.  

You can also define the x position manually. With the check box KEEP DISTANCES 
activated, distances that have been defined before are proportionally adjusted. 

Hint: The pocket calculator calculates the x position always from the row, where 
the cursor is placed. This way it is possible to recalculate parts of the table 
structure. 

The y position has only to be modified if different text sizes are used in the header 
row to vertically center the texts or if the header is displayed in more than one 
row. 
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The modified dialog box might look as follows: 

 
Block definition - modified 

The different section layouts are modified with the symbol button section layout.  

If more than one column is displayed in the block header, it is necessary to define a 
reference column to which the column text refers to. Select the column number 
from the column header in the field REFERENCE COLUMN.  

The block footer has a dedicated reference column so that multiple block end 
definitions are possible within one block. 

If the check box ALLOW PAGE BREAK IN BLOCK is disabled, only whole blocks are 
printed on one page. With long blocks it might be suitable to allow the page break 
in the block.  

As soon as you press OK the selected columns are automatically hidden from the 
table and inserted in the header. 

To change the table structure or statistics or to add or remove columns as fields 
invoke the table structure again with TABLE -> TABLE STRUCTURE -> DEFINE BLOCK 

HEADER. Use the symbol INSERT ROW to add additional fields in the table structure 
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itself. Enter the column number from the column in the table. If the column 
number is 0 you can use it as a header row. The symbol DELETE ROW deletes a 
column definition.  

To delete a defined structured table definition, select TABLE -> STRUCTURED TABLE -> 

DELETE BLOCK HEADER. The columns that had been displayed in the header row have 
to be made visible manually in the TABLE SETTINGS. 

Hint: Once a structured table has been defined, this definition can be stored as a 
template so that the definition is available for other projects and tables. In the new 
project, open the table structure once to adjust it with the pocket calculator to the 
longest entry in the field definition.  

Statistical Functions 

The definition of block header, block footer and table statistics contains statistical 
information per block (e.g. per building) or for the whole table.  

Add new value columns and enter a formula in the table settings. If these columns 
are only used to calculate the statistics, you can hide the columns in the table 
settings.  

These functions are available: 

 

If the column setup has been set to „- FOR VALUES <= 0“, then values < 0 are ignored 
for statistics. For the calculation of the averaged level reduction due to a noise 
protection measure you can this way omit levels that have already been within the 
limits without the measure. 

The table statistics can be placed at the beginning (default) or at the end of the 
table. Check INSERT STATISTICS ON TOP at the bottom of the definition mask table 
statistics. 

Definition of a statistics in TABLE -> TABLE STATISTICS -> DEFINE: 
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Effect in the Spreadsheet: 

 

Usage of structure fields in formulas 

You can assign fields in structure lines to formulas, too. This way the contents of a 
column for which an operation has been carried out per unit (e.g. per building) can 
be written back to a table cell in a new column.  

BHposition  Block header 

BFposition Block footer 

STATposition Table statistics 

„position“ refers to the row number of the field the table of the block header 
footer or statistics: 

  

The field "No. of conflicts" in the block header for example is evaluated in a formula 
with "BH5". 
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Example 1: 
As soon as one single receiver at a building is exceeding the noise limit, all receivers 
shall indicate that they are eligible for noise control subsidies.  

Add a Boolean column and enter the following column to mark the receivers with 
conflicts: 
„xLevelD > xLimitD OR xLevelN > xLimitN;“  

Click at least on one cell of this new column, open the block header definition and 
enter the FUNCTION "count" for this column. Click OK and add another Boolean 
column (noise control subsidies) and enter the formula  

„BHposition > 0;   position is the row number in the block header definition. 

Example 2: 
Only the receiver with the highest exceedance per building shall be printed as a 
receiver flag in the Graphics.  

Add a value column and calculate the exceedance using the formula  
xLevelD - xLimitD;. 

Click at least one cell of this column, open the block footer definition and enter the 
FUNCTION "max" for this column. Close the block definition, add a Boolean column 
and assign the formula  
xExceedance =BFposition  position = row number in the block footer definition. 

Example 3: 
The total number of exposed people should be used within a formula. 
x32/STAT2*100; 

 Print Spreadsheet 

 Page Layout 

The page layout in SoundPLAN not only includes the paper size and the frames, but 
also the contents and layout of the headers and footers so that all enclosures of an 
investigation report look the same.  

Open the page layout with TABLE -> PAGE LAYOUT. 

Define the format of the page in the tab index card "page format". 
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The different parts of the printout 

 

Define the print sheet size and the margins. The line widths and the colors of the 
frames and the separator lines can be defined for each section separately.  

The header and footer sections have three partitions: Left, middle, right. Texts or 
logos in the left partition are left aligned, in the middle partition centered and in 
the right partition right aligned. 

A graphics can be inserted in the header as well as the footer, for example your 
company logo or the logo of the customer. Click on the gray field to select the 
graphics file. Define the position (left, middle, right partition) the height and the 
width of the graphics. When you check the logo justification button ("STRETCH"), 
the logo is fitted into the allocated space. The print preview however will decrease 
its speed because of it and therefore it is advisable to select a logo of proper size.  

Format the content and the size of the page frame in the tab index card "header 
and footer texts". The texts can be text variables, automatically updated with 
information stored in the project or own texts.  
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Page header and page footer are printed on all pages of the table as well as for the 
legend. To format the texts, highlight the text or text variable and click on the 
button FONT. Define the width of the left and right partition and the height of the 
frame. The three sections can be partitioned with vertical SEPARATOR LINES.  

For the entry the following TEXT VARIABLES are prepared for you and will 
automatically be updated in case the information changes. Click the cursor to the 
partition where the text should be displayed and select the variable to be 
displayed: 

 

In the tab index card "print options" you can select the first page number for the 
printout.  

Click on the button PREVIEW to check the page layout. 

Open the printer via FILE -> PRINT. If the printout of the legend is active, it is 
automatically printed before or after the table.  

Print legend 

The legend of the column headers is automatically created using the legend texts 
you entered in the TABLE SETTINGS. The legend contains only visible columns with 
assigned legend texts. All other columns are ignored. If you combined columns in 
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the column title, the legend text is only inserted from the first of the combined 
columns. The legend is drawn in the section layout standard text.  

Select FILE -> LEGEND. 

 

Select the order of column number and column header (text). If you don’t want to 
show one of them deselect the check box.  

Click preview to look at the printout: 

 

Select the print options for the legend in the lower part of the legend definition 
(before table, after table or no printout). The page number of the legend is 
automatically adapted.  

Export Spreadsheets and formulas 

Export spreadsheets 

You can export the spreadsheet table in ASCII format or to ESRI Shape files using 
FILE -> EXPORT. If you want to export only a part of the Spreadsheet you can also 
use Copy & paste to insert the table in another program (e.g. Excel).  

For the export to ESRI Shape files the coordinates of the receivers are 
automatically exported to the shp file and the visible columns are exported to the 
dbf file. The software proposes unique column headers that you can change: 
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When you export building tables to ESRI Shape files, you can select whether you 
want to export the outline of the buildings or one reference point per building in 
the center of gravity.  

The ASCII export only exports the visible columns. If you need the coordinates to 
be exported, please activate the columns in the TABLE SETTINGS.  

Export formulas 

You can document the contents of all table columns using FILE -> EXPORT FORMULAS. 
Title, Legend text, data source and the formulas for the calculation and for the cell 
layout are written to an ASCII file.   
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Calculation of the economic damage (Swiss cost 
benefit index) 

The Swiss cost benefit index for the calculation of the economic damage caused by 
noise distinguishes between planning and redevelopment. Redevelopment 
additionally distinguishes between complete redevelopment and not complete 
redevelopment. In SoundPLAN only the complete redevelopment is implemented.  

There are two approaches for planning situations. 

1. Calculation of grid noise maps and estimation of the costs with the area table. 

2. If you know the maximum area for the buildings and the size of the buildings, 
digitize them and calculate the costs on the basis of a facade noise map.  

Use always the second way for redevelopment. 

During the installation of the country specific files tick Germany (Switzerland) for 
the templates in order to install the prepared templates for the area table 
(calculation on the basis of a grid noise map) and receiver table (calculation on the 
basis of a facade noise map). You can also copy the three templates manually to 
the SoundPLAN x Globdata folder (1 - costs of noise.bft, 2 - costs of noise 
variants.bft, 3 - noise costs FNM.ntt).  

Estimate the cost using grid noise map and area table 

Digitize the areas in the Geo-Database using the object type area usage. Separate 
the areas according to sensibility class, number of floors and floor space index. 
Define the properties AREA USAGE (sensibility class), NUMBER OF FLOORS and FLOOR 

SPACE INDEX. 

 

You can calculate the grid noise map in the free field or with existing buildings. It is 
necessary that you calculate one grid noise map per floor. These grid maps must be 
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consecutively numbered from the ground to the highest floor. Define and calculate 
the calculation runs in the run table.  

 

Open the spreadsheet and select the file type area table (conflict map). Select one 
of the delivered templates or "new template" if you want to create your own table.  

We deliver two templates for the area table.  

1 - costs of noise - template for one variant 
2 - costs of noise - template for two variants 

Select the template and fill in the dialogue TABLE CONTENTS with the situation, 
which includes the area usages and the grid map(s) calculated for the ground floor.  

Select in the next dialogue whether you work on a planning situation or on 
redevelopment (according to your selection SoundPLAN uses the planning value or 
the alarm value and handles the division in the different noise classes), the region 
for the mean  annual rent costs per m² and if needed a correction factor on the 
gross floor area. 

 

Click OK, the table filled in and the total costs of noise are displayed in a statistic 
row.  
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Presettings 

Call TOOLS -> SWISS COSTS OF NOISE and open the presettings via the button on the 
lower left hand side. The presettings define the annual rent costs for the different 
regions, alarm value (AW), planning value (PW) and limit value (IGW) for each of 
the sensibility classes as well as the rent cost factor for the four noise classes. The 
calculation of the economic damage is done on the basis of these specifications.  

 

Description of the columns for the cost benefit index (area table) 

 

Column 2: Type = Area usage 

The area usage is defined in the Geo-Database; it is used for the determination of 
the sensibility class (see description for column 7). 

Column 4: NF = Number of floors  
Column 5: FSI = Floor space index 

The number of floors and the floor space index are defined in the properties of the 
area usage in the Geo-Database.  

Column 6: CF = Correction factor 

You can preset a value for all areas in the CBI dialogue. If needed, the correction 
factor can be changed in the table for each area separately. 

Column 7: SC = Sensibility class 

For this column the following formula is stored (change it if necessary): 
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case X2 of 
  "I": 1; 
  "II": 2; 
  "III": 3; 
  "IV": 4; 
  else: 2; 
end; 

According to this formula the first area usage in the library represents the 
sensibility 1, the second one the sensibility 2 and so on. The fifth or all following 
area usages are handled as sensibility class 2.  

The sensibility class is determined from the area usage (column 2). 

For the calculation example project we redefined the first four area usages in the 
SoundPLAN presettings to I to IV so that the types I - IV are automatically available. 

You can define your own usage types according to other criteria, for example 

R2 (residential area with two floor buildings) 

R3 (residential area with three floor buildings) 

Adjust the formula in column 7 and recalculate the table.  

The column SC is an integer column, the display in roman numbers is handled via 
the setting in the column layout  

Columns 8-12: Affected noise zones in m² 

Columns 13-17: Economic damage due to noise (costs of noise) 

The assigned grid noise maps are stored in the background for these columns. The 
calculation of the affected area and the costs is automatically done by the 
software; there are no parameters to change the calculation. 

The calculation is executed as follows:  

First the gross floor space (GFS) representing one grid cell is calculated: 

GFS = area of one grid cell * floor space index * correction factor / number of floors 
(GFS = grid area * FSI * CF / NF) 

Next the program determines for each floor and grid cell of which the center point 
is within the area, which time slice causes the decisive level exceedance (level 
difference to the limit value or planning value of the sensibility class). The level 
exceedance determines the noise class to which the gross floor space and the costs 
of this grid cell are added.  

The costs of a grid cell are calculated as follows: 

Costs = gross floor space of a grid cell * decisive limit level exceedance * rent factor 
of the noise class * costs per m².  
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Noise costs using facade noise map and receiver table 

Digitize the buildings and create the calculation run for the facade noise map. 

The procedure in the Spreadsheet is nearly the same as for the area table. Select 
the template 3 - noise costs FNM (file type receiver table). 

Select the facade noise map in the dialogue TABLE CONTENTS.  

Select in the next dialogue whether you work on a planning situation or on 
redevelopment (according to your selection SoundPLAN uses the planning value or 
the alarm value and handles the division in the different noise classes), the region 
for the mean annual rent costs per m² and if different the column for the gross 
floor space. 

 

Click OK, the table filled in and the total costs of noise are displayed in a statistic 
row. 

In addition to the fixed columns described in the section using the area table you 
will get the following columns: 

- Level above limit value or planning value 

- assigned noise zone 

- resulting costs 
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Description of the columns for the cost /benefit index (receiver 
table) 

 

Column 11: area usage  → see column 2 (area table) 
Column 13: Gross floor space (GFS): 

The corresponding facade length is calculated according to the building geometry 
for each receiver. This information is used to calculate the part of the building floor 
space which is used as gross floor space.  

Column 14+15: Assessment level day + night 

Column 16: CF → see column 6 (area table) 

Column 17: SC → see column 7 (area table) 

Column 18: Decisive level exceedance day or night referring to the limit value or 
planning value depending on the sensibility class (SC) 

Column 19: Noise class - results from the decisive level exceedance 

Column 20: economic damage due to noise (noise costs) 

The noise costs for one receiver are calculated as follows: 

Costs = Gross floor space * CF * decisive limit exceedance * rent factor of the noise 
class * costs per m².  

The columns 18-20 are calculated in one step, therefore you cannot change the 
values manually. 

Usage of the cost benefit index in other countries (e.g. 
action planning)  

The Swiss method to determine the noise related costs can be applied by analogy 
in other countries, e.g. in the scope of noise action planning. 
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The calculation would be done on the basis of a façade noise map. It should be 
considered that the Swiss regulations do not know the LDEN. Therefore, the 
assessment should use the time slices day and night. It is also necessary to adapt 
the annual rent per m² living space. The default sensibility class is II which 
represents more or less a residential area.   
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9  Wall Design 

Overview Wall Design 
Calculating and optimizing the dimensions of noise protection walls is a time-
consuming task. Designing the wall for one receiver is manageable if the source is 
just one line. Usually the permitted height is selected and the barrier length 
needed to shield the receiver to the proper noise level must be determined. 
Otherwise, you can specify the length of a noise screen and calculate the screen 
height needed to reach the proper noise level.  

 
Dimensioning a noise screen for a single receiver 

The task of optimizing becomes complicated when more than one receiver must be 
protected.  

In most cases you would begin dimensioning the noise screen for each one of the 
receivers, superimpose the screens, and check how much the noise control target 
was exceeded. You would then modify the screen by hand to optimize it at certain 
locations. Real optimization by hand (even with the help of a computer) is 
impossible!  
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Optimizing a noise screen by hand for multiple receivers 

Optimizing a noise screen means finding the screen with the smallest surface area 
shielding the receivers to the desired level. A second optimization is a minimization 
of costs. SoundPLAN provides these options plus even more.  

The optimal noise screen might be the least expensive solution, but it may also be 
the least aesthetic. The structure of noise protection walls should fit into the 
landscape. Beginning with the minimal solution, you can modify the noise screen 
design while keeping the noise control objective.  

SoundPLAN can optimize complicated areas with multiple sources (road, rail, 
industry) and receivers in areas having different requirements (residential or 
industrial). 

Wall Design's Internal Organization 

In order to better understand Wall Design's capabilities, examine the completed 
calculations. The following picture shows an example of a road with a parallel noise 
barrier which is to be dimensioned for one receiver.  

SoundPLAN's search rays intersect the barrier and the roads when scanning. The 
geometry for every cut is organized according to the distance from the receiver as 
seen in the flow chart following. Wall Design's goal is to calculate the screening 
influence for every intersection with the noise barrier and record the differences. 
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After the search ray intersects the screen element, the influence of a 0.0 screen is 
calculated. A defined increment is used to increase the height of the noise barrier a 
specified number of iterative steps. The element height and the number of 
elements are defined in the calculation properties. 

 
Flow chart of optimizing calculations 

Completely calculating the noise in one ray allows the influence of ground 
attenuation and screening to be evaluated and used later to optimize the noise 
barrier.  

As more than one search ray may pass over an element of the noise barrier, the 
values stored in the matrix must have different energies than the zero height 
barrier. When all contributions that passed over a single barrier section have been 
evaluated, the "noise footprint" of this barrier element for the receiver being 
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calculated has been recorded. SoundPLAN stores all energetic reductions in a 
matrix for every receiver and as wide as the total wall elements.  

Wall design loads this matrix and searches for the barrier elements yielding the 
highest reduction of sound energy per surface (or per cost). The barrier selection 
uses an iterative process.  

 
Selecting the barrier elements in an iterative process 

As documented in the flow chart, receivers are included in the barrier selection 
process only if their noise level exceeds the set limit. For all improperly shielded 
receivers, SoundPLAN searches for the element resulting in the highest reduction 
of noise energy (stored in the matrix) for all receivers. During this search 
SoundPLAN examines the next element to be added and evaluates the usage of the 
next elements.  

If the base of the noise screen was not intersected with the search ray, the first 
element has no protecting value. Only elements high enough to intercept the line 
of sight provide a positive reduction of noise per area. In this case the highest 
attenuation per square meter requires many more elements than just those 
breaking the line of sight.  
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Selection of barrier elements 

The noise reduction per square meter of wall surface (or wall surface * specific 
cost) is the main goal for selecting barrier elements. The element's efficiency can 
be seen in the diagram.  

 
Noise level reduction and increase of wall size 

As seen in the diagram, increasing the wall size beyond 2000 m² does not decrease 
the noise levels at a justifiable rate. Even if SoundPLAN manages to reach the set 
noise levels, the cost to performance ratio becomes increasingly worse. The 
decision maker must decide how much sound the noise screen shall shield, and at 
which point passive measures (improved windows) are the more cost effective 
solution. 

For clarity, the cost-performance diagram was shown only for one receiver. In a 
real situation, the diagram would contain many more lines, and for each receiver a 
characteristic cost to performance line. 
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Wall Design Performance 
Wall Design can perform accurately only if all the parts are present. Before the 
optimization can be run, several steps need to be completed.  

1. Define the wall's position as a regular screen in the Geo-Database. Copying 
and moving the coordinates sideways defines the position of the major road 
or rail, or the screen can be digitized. The wall height can be ignored 
because Wall Design will determine this. It is advisable to extend the 
potential wall beyond both sides of the perpendicular position of the 
receivers. If the wall segments are not needed, Wall Design will ignore them, 
and if they are necessary, the will be included in the pre-calculation. The 
wall elements should not be longer than 10% of the distance between the 
source line and the receiver. The wall has to be entered in separate Geo-File, 
otherwise the wall cannot be pre-calculated.  

2. Wall Design can optimize a noise control wall for minimum surface area or 
for minimum cost. Minimizing the cost requires price information for the 
noise control wall. SoundPLAN offers a cost matrix which you must 
configure to local conditions. Costs can be defined for walls and berms and 
can consist of land acquisition, foundation and building costs for different 
wall heights. Planting costs for berms are a separate factor. When digitizing 
the wall base line, different wall elements may have different cost. One part 
could be concrete, another part could have translucent material and yet 
another part could be constructed of lumber.  

3. A calculation run is necessary for Wall Design to obtain all information about 
the efficiency of wall sections. SoundPLAN dimensions all wall base lines 
check marked in the field OPTIMIZATION in the properties of the walls and 
berms in the Geo-Database. They have to be stored in a separate Geo-File. 
Other berms and walls may be present in the calculation. Sources can be 
from road, railway and industry.  

4. Use Wall Design for on line dimensioning and optimization of the noise 
screen. The noise screen element heights are dimensioned using the 
calculated data. The following tools are available: 

• Automatic calculation of the lowest wall height or the least cost. The 
selection can be all at once or step by step.  

• Definition of the minimum and maximum wall height so that the wall can 
aesthetically fit into the landscape.  

• View the optimized noise screen as a graphic in the top view and as a 2D 
projection or 3D view.  

• Generation of a cost performance diagram. This is part of the procedure 
for deciding when to stop dimensioning the wall if it does not meet the 
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objective. The selected wall can be transferred to the selection matrix for 
further studies.  

• Transfer of the wall to the Geo-Database as a normal screen for later use 
(calculation of noise maps, etc.). Please recalculate the result in any case.  

Using Wall Design 
Wall Design requires work in different SoundPLAN modules: 

Additional Properties in the Geo-Database objects 

Define the position of the base line(s) of walls and/or berms in a separate Geo-File 
in the Geo-Database. Activate the field OPTIMIZATION in the properties dialog.  

 

Additional properties and different elements are ignored for the Wall Design 
precalculation. The property reflection loss is also not taken into account, but the 
selection is kept after you stored the optimized wall back to the Geo-Database.  

In case of a berm please define the slope and the top width for noise protection, in 
order to correctly calculate the screening edge in the precalculation.  
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You don't have to enter a wall height because it is optimized in Wall Design. But 
existing heights e.g. from a retaining wall can be taken into account in the wall 
optimization.  

The sections of the wall base line should not be too wide. Depending on the 
geometry situation and the distance of the receivers from the source, the size of 
the sections can be different. The following table shows empirical values: 

Inner cities 5 to 10 meters 

Outside cities 20 to 40 meters 

Highways up to 100 meters 

Use the Geo-Tool DIVIDE SECTIONS to divide the wall base line into several sections. 
The elevation information will be interpolated.  

Precalculation in the Calculation Kernel 

In the next step execute a pre-calculation in the Calculation Kernel to obtain all 
information about the efficiency of the wall sections.  

Add a calculation run to the already existing or create a new run file. For details see 
also Chapter "Calculations". 

You can use Wall Design for single receivers as well as for Facade Noise Maps.  

Enter a run name, select the run type Wall Design from the selection list and select 
the data needed. 

Check the settings in the dialogues SETTINGS and STANDARDS and look at the Wall 
Design properties: 

 

The default setting for the height of each element is 0.5 meters and for the 
maximum number of elements used for the iteration it is 20 elements. 

These default settings can be modified according to your needs. 

Activate the field IGNORE WALL/BERM HEIGHTS IN DESIGN GEO-FILE if the wall that 
should be optimized has been assigned a wall / berm height in the Geo-File.  
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The checkbox CALCULATE REFECTIONS OF THE ASSIGNED FACADE AND IGNORE 

STANDARD DEPENDENT FAÇADE CORRECTIONS means that regardless of the terms in 
the standard the reflection at the façade is calculated (default: unchecked).  

Some standards suppress the reflection for the façade levels other use specially 
described corrections and yet others calculate the assigned façade.  

Start the calculation with . 

Optimization in Wall Design 

After the calculation run has been finished successfully, open Wall Design from the 
SoundPLAN Manager. Load the result of a designed (pre-calculated) screen file in 
the OPEN window.  

The Wall Design window will be displayed on the screen: 

 
Wall Design window 

The four tab index cards on the left hand side provide information on the 
calculation run, the receivers, the wall segments and the iteration history. On top 
of the window, information on the surface, length and costs are shown. 
Additionally, the used optimization criteria are displayed. 

The lower part of the graphic displays the site map, and the upper part the front 
elevation. Right click to change the DISPLAY TYPE (site map, front elevation, 3D) as 
well as the DRAW TYPE (wire frame, hidden lines or areas). 
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Depending on the display type, further functions are available via the right mouse 
button. 

    
Right mouse button menu for site map (left), front view (middle) and 3D map (right) 

Additional options: 

• OPTIONS -> SHOW ONLY BUILDINGS WITH RECEIVERS removes buildings without 
assigned receivers from the graphics. 

• It is possible to enter a stretch factor for the front elevation. 

• To speed up the optimization, the building process of the wall is no longer 
displayed (OPTIONS -> DISPLAY WALL BUILDING PROCESS). 

In the Wall Design graphics the screen can be zoomed to the current receiver 
location or the current wall element, depending on the current table on the left 
hand side. Set CENTER AUTOMATICALLY to refresh the screen section while going 
through the receiver or wall element list. 
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Wall design uses the SoundPLAN Graphics. The object types OPTIONS -> OBJECT 

TYPES control the objects representation and particularly the representation 
whether or not receivers exceed the limits.  

You can select the representation (color, size) for all receivers, for the highlighted 
receiver and for the wall base line, all wall elements and the highlighted wall 
segment.  

 

The graphics window in Wall Design contains all object types stored in the 
Situation. You can also select the objects you want to see. Open the object types 
and deselect show for the object types you don't need to see. 

Starting the optimization 

 All floors are shown, however only the decisive floor is by default activated for 
dimensioning. Via the selection list SET USED RECEIVERS under the tab receiver 
locations select other floors, the floor with maximum level found at a receiver or all 
floors of a receiver.  

 

As all floors are contained in the receiver table, the current level and how much the 
receiver exceeds the limit is always visible for all receivers, even for the receivers 
that are not activated for the optimization.  

In case the big number of receivers becomes too crowded, you can hide receivers 
not activated for the optimization with RECEIVERS -> SHOW ONLY SELECTED 

RECEIVERS.  

The optimization is started by clicking on  or via the OPTIMIZATION -> RUN <F9>. 

The criteria for the optimization, the time slice and possible corrections to the 
noise target level are requested before the start of the optimization.  
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The first criterion is  

• Level reduction 

• Level reduction per meter façade length 

• Level reduction per inhabitant 

As a second criterion select between "minimum wall surface" and "minimum cost" 
and select the time slice for the optimization.  

The target level is the level that should be reached after the optimization. You have 
the possibility to use the limit defined in the assessment during the precalculation, 
add /subtract a correction to the defined limit, add/subtract a correction to the 
calculated level, set a target level for all receivers or edit the target level.  

The wall is gradually built until all used receivers keep the limits or the number of 
wall elements is not sufficient to keep the target levels. In this case the following 
message is displayed: 

 

And still some of the used receivers are displayed in red. The level reduction is also 
calculated for the receivers not used for the optimization; these receivers are often 
still displayed in red. This message will normally show up for wall optimizations 
with Façade Noise Maps.  
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A step by step iteration with constant observation of the selection of the wall 

elements can be done by clicking  or via item SINGLE STEP <F7> from the 
OPTIMIZATION menu. If you choose the step by step approach, you can interrupt 
the building of the wall at any time with .  

Receiver locations 

The tab index card “receiver locations” gives detailed information on the receivers.  

 

If a reference axis of a road or railway has been defined in the road or railway 
properties of the Geo-Database, the kilometer post is shown for the exact location 
of a receiver. The next columns display the receiver height above ground, the 
number of floors and the area usage.  

The TARGET LEVEL is the level that should be kept after the optimization. If the area 
usage has been defined for the receivers in the Geo-Database and an assessment 
library element has been selected in the calculation run the target level is taken 
from the limits in the assessment library. If not, a target level can be set in Wall 
Design for all receivers by either using <F4> or selecting the item RECEIVERS -> SET 

TARGET VALUES.  

When starting Wall Design, a YES is placed in the first column for the decisive floor 
of all the receivers, which means that all the receivers are included in the 
optimization. Sometimes it is suitable to exclude a receiver from the optimization 
after the first calculation, e.g. if the limit cannot be kept and therefore passive 
measures (improved windows) have to be designed. Use the space bar in the first 
column to change the selection of the receivers used for the optimization. 

Wall segments 

 
Section Wall segments 

For your information this section shows the assigned km post and the base 
elevation of the wall.  
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Wall height, length and costs can only be added after the first optimization. When 
optimizing a wall, often a minimum or maximum height is pre-defined by the 
planning authorities. Those default heights can be entered via the items SET 

MINIMUM HEIGHTS or SET MAXIMUM HEIGHTS from the WALL menu.  

Hint: The maximum number of wall elements cannot be higher than defined in the 
Wall Design properties in the calculation run.  

After the first calculation the wall might look like that: 

 
Wall with gaps after the first optimization 

Some segments of the wall do not need to be built to keep the limits. Therefore, 
minimum and maximum heights (number of elements) can be set in the table itself. 
Modify the number of elements in the columns MIN and MAX but not in the column 
ELEMENTS, this column should be calculated. Please do not forget to optimize again 
after modifying minimum or maximum heights!  

Optimization History  

 
Optimization history 
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If the objective of dimensioning the noise screen to the set noise limits cannot be 
met, or if Wall Design requires an excessive amount of wall surface, the situation 
can be analyzed using the cost to performance diagram. 

The diagram shape is a representation of the Fresnel diagrams with attenuation 
and extra path length. If the noise screen is lengthened, the benefits per surface 
area decrease. This is also visible in the wall size to noise level diagrams. Wall 
Design, however, uses elements in the perpendicular position and elements along a 
stretch of receivers, the height is increased and the elements chosen shield the 
noise from the sides.  

The diagram can be plotted in different modes: 

The x-axis can map the surface area or the total cost, while the y-axis can map the 
absolute noise levels over the area of the noise screen (actual level), the noise 
reduction (level difference to the start level) or the levels exceeding the limits (level 
difference to the target level). For the optimization according to characteristics 
(façade length above target level, inhabitants above target level …) further 
diagrams help with the analysis of the best cost / benefit ratio.  

 

The navigation buttons  are used to move in the diagram to 
view every state of the wall – the wall elements built are 

displayed in the graphics, costs, length, surface area and so on are displayed in the 
table. 

The x-axis either shows the wall surface or the total costs. The y-axis either shows 
the absolute levels over the surface of the wall (current level), the level reduction 
(difference to the start level), or the level difference to the target level. When 
optimizing according to other characteristics, additional charts help to give answers 
on which iteration step still keeps the cost / efficiency relationship.  

 Cost table 

If the objective in Wall Design is to minimize the cost, SoundPLAN needs the cost 
definitions. Call WALL -> COST TABLE (F8). 
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Cost table in Wall Design 

The cost table is divided into costs applying to berms and costs applying to walls. 
The costs for berms are rough estimates because the volume and area are 
calculated with a simple model rather than with a digital ground model. 

 
Calculations of berm parameters 

 

Land acquisition Defines the cost per area that the wall or 
berm developer needs to acquire 

Volume Defines the cost per volume for berms. The 
material must be transported, compacted, 
etc. Sometimes there is a demand to 
deposit excavation material and the 
charges to dump that location allow the 
entry of a negative cost. 

Surface area Defines planting costs for the berm 

Base Startup costs and foundation costs 

Height < 1 m Cost of the wall if the wall height is less 
than 1 meter 
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Height 1- 3 m Cost of the wall if the wall height is 
between 1 and 3 meters 

Height 3- 5 m Cost of the wall if the wall height is 
between 3 and 5 meters 

Height > 5 m Cost of the wall if the wall is higher than 5 
meters 

Print wall table 

After the optimization has been finished, you can print the wall table with headers 
and footers from the SoundPLAN page layout. Select WALL -> PRINT TABLE.  

Go to the PREVIEW to show the wall table on screen. Click on PAGE LAYOUT to 
change the headers and footers, see Page layout. 

 Storing the Wall back in the Geo-Database 

After the optimization of the wall or berm has been finished, it can be stored in the 
Geo-Database for further calculations and for the display in the Graphics. Select 
FILE -> SAVE WALL or click the symbol button SAVE WALL.  

 
Dialog box for storing the designed wall in the Geo-Database 

The optimized wall and the original geometry situation will be stored in a new 
planning variant. The new Situation includes all Geo-Files from the original 
Situation used for the pre-calculation for Wall Design. The Geo-File with the wall 
base line is exchanged with a Geo-File with the optimized wall. Enter a name for 
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the new Situation and for the Geo-File with the optimized wall. You can also select 
an existing Situation or an existing Geo-File but make sure not to overwrite the 
original data. 

When saving back a berm with different wall heights to the Geo-Database the berm 
heights will be smoothened.  

Using Wall Design for areas 
For a wall optimization of Facade Noise Maps the program optimizes not just single 
receivers but entire sections of towns. Very likely you will receive a message that 
not all receivers with all the floors as calculated in the Facade Noise Map can be 
shielded and thus pressed below the target level. After processing of the cost 
parameters, it is possible to select the position in the noise protection histogram 
where the total cost, the sum of active and passive measures has a minimum.  

The curves in the diagram below show which iteration step has the best cost 
benefit ratio. The passive noise control was made more expensive with a weighting 
factor of 10:1 in the cost table.  

 

The weighting of receivers can be set either to be for the number of inhabitants 
above the limit (level reduction per inhabitants) or to the total length of the facade 
that is not properly shielded (level reduction per facade length). Receivers at 
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facades that are already in the iteration below the limit are disregarded in the 
iteration. All inhabitants of a building are assigned to the loudest facade. 

Another criterion assessing the performance of a noise control wall is the diagram 
"specific attenuation". 

Additional diagram types according to the Swiss cost index: 

1. The benefit of the noise protection wall   

2. The efficiency of the wall, i.e. the benefit/cost ratio 

3. The effectivity, indicating the percentage of how much the target value is 
reached in % 

4. The WTI (Wirtschaftlicher Tragbarkeits-Index= Economic feasibility index 
according to the Swiss (BAFU) EPD) 

5. The cost per solved case of conflict  

The topics 1-4 are based on the Swiss Cost Index (-> Swiss Environmental 
Protection Department = Schweizer Bundesamt für Umwelt BAFU), the WTI 
(Wirtschaftliche Tragbarkeit und Verhältnismäßigkeit von Lärmschutzmaßnahmen = 
Economic feasibility of noise protection construction), which you probably already 
know from the SoundPLAN Spreadsheet the fifth topic is based on a regulation of 
the German Federal Rail Authority. 

This study assumes that noise is responsible costs to the economy. By controlling 
the noise, the economic costs are reduced, thus noise control not only has costs 
associated but there also is an economic benefit to the society. 

In the diagram-selection you will find „base value above the target value“ instead 
of „inhabitants above target value“ in the diagram type „base value above the 
threshold value“. For this diagram type as well as for effectivity, the WTI and the 
costs per solved conflict, a selection list is available where you can set the base to 
be: 

o inhabitants 

o dwellings 

o receivers 

In addition, you can select for these diagram types if the evaluation is for the active 
time slice of for all time slice. 

Calculation of the economic (cost) damages due to noise 

The damage per receiver is calculated as follows: 

damage = (A * B) * Conf * RentF[nc] * cost_per_m² 

o A = square meters of entire floor divided by number of receivers 

calculated on that floor 

o B = Correction factor for A to adjust for non-inhabited areas such as 
staircases etc. 
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o Conf = conflict the damages are based upon 

o RentF= rent factor per noise class 

o Cost_per_m² = rent price per m² per year 

o The area A is automatically calculated from the geometry of the building. 
The correction factors and all other parameters are defined under 
options -> settings. 

The damages defining conflict is given by the excess of noise above a given 
threshold value for day or night and also depends on a sensitivity setting for the 
building. This sensitivity depends on the usage of the building. In order to keep the 
work defining parameters at bay, the program used the usage assigned to the 
building in the Geo-Database. A common sensitivity is assumed but threshold- and 
alarm-values can be defined. The pre-setting is for a value -5 for sensitivity step II 
for residential areas. 

The noise class is selected in accordance to the noise level (day/night) as follows: 

Noise class Evaluation noise level 

I > Alarm level 

II > Threshold value+5 

III > Threshold value 

The rental cost per m² per year are set to represent the average rental cost in 
Switzerland and must be adjusted to represent the true cost in your area. 

Benefit of noise control measures: The benefit of the noise control measures is 
defined as the reduction of the economic damages. 

The efficiency: Is defined as the ratio of cost to benefit. 

The effectiveness: In reference to the base „inhabitants“, „dwellings“ or 
„receivers“, the percentage of inhabitants properly shielded from noise is 
calculated. When all receivers are shielded to be below the noise threshold, the 
effectiveness will be 100%. 

The WTI (Wirtschaftlicher Tragbarkeits-Index = Economic Feasibility Index): The 
WTI is calculated as follows: 

WTI = Effectivity * Efficiency / 25 

WTI according to BAFU is evaluated in classes 

WTI Evaluation 

> 4.0 Very good 

> 2.0 Good 

>= 1.0 Sufficient 

< 1.0 Insufficient 

< 0.5 Bad 
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Cost per solved conflict case: 

In reference to the base „inhabitants“, „dwellings“ or „receivers“ the cost for each 
shielded receiver is presented. The default setting is for dwellings and for all time 
slots in accordance to the benefit/cost analysis from the „Hinweisen zur Erstellung 
Schalltechnischer Untersuchungen = Hints for conducting noise technical 
investigations“ of the German EBA (Eisenbahn-Bundesamt = Federal Railway 
Authority). 

Model restrictions of Wall Design 

Wall Design is set up to iterate the height of a noise protection wall. Every model 
has certain restrictions, and Wall Design is no exception.  

• If a search ray finds more than one wall section to be optimized, only the 
wall element closest to the source is iterated, and the second intersection of 
the wall will be set to a height of zero. 

 

• Wall Design calculates only the screening effect and the influence on the 
ground effect. It does not calculate the influence of the reflection on the 
other side of the road. If this is important, calculate and optimize the wall 
for the side where the screening is important and then transfer the 
coordinates to another wall object type on the other side. 

• The optimization is exact for vertical walls. A post calculation will deviate 
from the Wall Design results only if there were multiple intersections 
between the search ray and the screen. (This may happen when reflections 
are on the other side of the road.) 

• The optimization is not exact for berms. During the calculation, SoundPLAN 
intersects a wall element. Inside the calculation, the wall element increases 
in height. For a vertical wall, the coordinates of the top remain the same. 
For berms, the top moves away from the road. Eventually the cut of slanting 
intersections will get out of scope from the element originally intersected. If 
all wall elements have the same height, the reduction will be accounted for 
the wrong element, which leads to a systematic error. 

After optimizing a berm, it is mandatory to check the results with an extra 
calculation run! 
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Optimizing problem with berms 

After optimizing a berm, it is mandatory to check the results with an extra 
calculation run! 

In the picture, the first 5 iterations of the berms generate an intersection within the 
element credited for the final reductions. The next 8 iterative steps extrapolate 
where the wrong element is credited. The last iterations move the screen beyond 
the position of the building and no extra screening is found. In normal cases, the 
barrier is not as flat as in the example, but optimizing the barrier over the building 
does not make sense either. The problem of crediting the wrong element with a 
reduction is still serious and needs to be observed.  
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10  Graphics 

Overview Graphics 

 
Graphics sheet automatically created on the basis of one of the provided standard templates.  

SoundPLAN Graphics combines the geometry data and calculation results with 
supplemental elements such as north arrows, scale bars, legends, color scales and 
textboxes to form dynamic maps and drawings to be printed on printers and 
plotters or saved on disk for use in other forms of documentation. The individual 
elements are stored as SoundPLAN sheets so you can activate and edit them on 
screen anytime. A sheet represents a complete drawing with all data and settings 
shown as they will appear when printed.  
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Use templates with text variables to develop highly refined graphics and store 
them for future use in the same or other projects. If you develop your own 
templates for each of your standard paper/drawing formats and store them as 
templates, everything is stored except the files. In the future, you only need to 
select the template and activate the data files to efficiently create drawings of your 
company standard. The variables for example for project name, calculation name 
or date of creation provide additional convenience. The templates delivered with 
SoundPLAN can be used as a basis for creating your own styles and templates. 

Getting started 

The following section is a short overview of the procedures used to create new 
graphics. The functions themselves will be described later in more detail.  

• Open the graphics from the SoundPLAN Manager. Choose the format most 
suitable for your drawing from the list of templates.  

 

• The File Selection Manager will appear. Select the files to be included in the 
map, choosing from the pick lists of available geometry and result files. 

Click on a situation (or geo-files) and move the file(s) using drag and drop, by 
double clicking, or clicking the arrow symbol from the left box to the right 
box representing the map. Select the proper legend and decide if descriptive 
text attributes shall be generated automatically from the geo-data 
(kilometer, wall height…). The legend selection only becomes important 
when additional data are added or when using templates.  

From the list of result types, select the type of results you want to display 
and move the result file to the right side the same way as you did the 
situations. Many result files have data for many different time slots. You 
must select the time slot and confirm it with OK. After selecting all result 
files desired in the map, click the OK button to leave the file selection.  
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• Open the menu ELEMENT -> SHEET COMPONENTS (F6) to view the 
relationships of the sheet elements. 

• In “edit map” (double-click on the marked map or press the right mouse 
button and select EDIT CONTENT), adjust the scale and the rotation with the 
menu GEOMETRY VIEWPORT and the menu selections GEOMETRY PARAMETER 
(numerical entry of scale and rotation) and CHANGE GEOMETRY VIEWPORT 
(right mouse button ZOOM, ROTATE or MOVE). Click CHANGE GEOMETRY 

VIEWPORT to finalize the modifications. Click the OK button on the bottom 
right side of the screen to close the edit map mode.  

• Edit the content of the space holders in the form by double clicking on it or 
by right clicking on the space holder and selecting the EDIT CONTENT option. 
In order to activate an element, the element must be active.  

• The Map Object Types library controls the appearance of individual objects 
in the map. It also includes the settings of the calculation results. Activate 
the map and select the right mouse option MAP OBJECT TYPES. Move to the 
appropriate branch of the Object Setup. Here is where you determine if the 
object is to be drawn, set the drawing sequence, and control the pen colors, 
pen width, hatch patterns, etc. Additional controls linked to the Cartography 
module are available under the Cartography tab. There are also additional 
settings under 3D-Graphics for users licensed with this module.  

• Store the graphics and print it via the File menu.  

Interdependencies of the graphics elements 

The sketch shows the interdependencies of the elements of a SoundPLAN graphic: 

 

• SoundPLAN is delivered with a global color palette which is copied into 
every project and every sheet. Changes made to the global color palette do 
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not modify the appearance in current projects or existing sheets. This 
palette is only the template for future projects. 

• Every object has an entry in the global object type library that contains 
predefined drawing settings. When a new project is started, the global 
object type library is copied into the project. A local copy of the object type 
library is included with every map. Customizing the global object type library 
will only affect future projects. Customizing the projects object library will 
only affect new plans. Changes in the global or project object type libraries 
do not affect existing saved plans.  

• The objects in the geometry data and the result types in the map define the 
object types of a map. They influence both the legend and scale of the map. 

• The geometry view (position, zoom factor and rotation) controls the 
generation of the north arrow and scale bar. You can position these 
anywhere on the map. 

• Select situations and calculation results via the file selection manager. They 
appear in the map as file lists.  

Sheet Elements in the Graphics  
SoundPLAN is designed so you work on a sheet which is independent of printer 
capabilities and settings. You arrange and insert all the required elements on this 
sheet. The elements are layered hierarchically, meaning that every element has a 
parent element associated with it. The sheet is the highest layer; all other elements 
are associated with the sheet. 

The following example is a drawing you can view on screen and print on a printer. 
Below the drawing is the arrangement of the individual elements as seen on 
screen. 
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On the same layer in the sheet, you see a group box containing a map and a group 
box for the map’s descriptive field. The north arrow is inserted directly on the map. 
Within the descriptive box, you find a text box with the map header, color scale, 
legend and scale, and another group box for the company name. Within this group 
box, you see a bitmap and a text box for the company address.  

The elements of the sheet can be arranged in any order; whatever element is 
activated when a new element is requested will automatically become the parent 
element for the new element. The sheet is always the top of the hierarchy and can 
be present only once on the drawing. Parallel sheets or a sheet within a sheet are 
not possible.  

The following elements can be part of a sheet: 

• Map 

• Text box 

• Color scale  

• Legend 

• Scale bar 

• Graphics box (for jpegs...) 

• Text 

• Symbol 

• Spreadsheet box 

Each element has properties (background color, borderline color, etc.) and content 
(the text in a text box or the scale bar, etc.).  

If a new element is requested, this new element becomes the child element and 
inherits certain settings from the parent. When the parent element is moved, all its 
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children move with it. Child elements can only be moved within the space of the 
parent element.  

Experience the procedures yourself. On the menu bar, click the text box 
symbol and use the left mouse button to pull open a text box. Request 

another text box and pull it open inside the first text box. Now click on the frame of 
the first box to activate it and drag it to a new location. As you can see, the text box 
contained in the parent moves with it.  

Click the arrow on the top right side of the menu bar to deactivate the parent 
box. Now activate the child box and move it. As you can see, the child box 

only moves within the parent box.  

 

Now activate the outside box and zoom it by dragging the corner marks. The child 
box enlarges proportionally when the parent box is zoomed.  

You can undo the relationship of parent and child element by copying the element 
from the parent to the next ancestor. Here is the process. Cut the element from the 
parent box by activating the child box and then typing Ctrl+ X. Now click on the 
background and insert the element with Ctrl+ V. The parent/child relationship has 
ended. The elements are now siblings and can be moved independently. You can 
even move the former child box over the former parent.  

Additional elements can be oriented and anchored as parent elements. The child 
element is now fixed in its position in relationship with the parent. Further details 
are part of "Alignment", page 506.  

Create New Elements 

Some elements are automatically generated when the data for the map are loaded. 
For example, when geometry data are loaded, a legend is automatically generated 
from the object types contained in the situations and geo-files. Likewise, a color 
scale is generated for file types that require color scales. The value range of the 
result files is queried to find a sensible color progression for the scale.  

All other elements (and, if needed, a new legend or color scale) are user generated 
via the symbol buttons or via the menu ELEMENT -> CREATE. 
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 Hint: Except with the Cartography module, only one map and one graphics box 
can be on a sheet. Cartography has no limitation. The elements for symbol and 
spreadsheet are only available with the Cartography module.   

The cursor changes to a rectangle with a crosshair for “pulling open” a new 
element (text box, graphics box, color scale or legend). Position the cursor in 

the upper left corner. Press the left mouse button and pull the element to the 
approximate desired size. You can resize the box any time. Use adapt box to 
content to adjust the box size to the content size. 
 

For all other elements (scale bar, north arrow and symbol), click the 
appropriate symbol button and then click on the sheet where you want 

the element to appear. The cursor adapts to the element type.  

For more information about editing the properties and contents of the elements, 
go to the section, "Element Properties", and read the sections pertaining to the 
specific elements. 
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Activate Elements 

Only one element can be the active element at any given time. This 
active element can be edited. It is highlighted by “grab” points outlining 

it. Aligned elements (page 506) cannot be moved to all directions, therefore the 
stop symbol is displayed. 

When an element is active, only a parent or sibling element on the same hierarchy 
can be activated directly or via the “Sheet components (page 495)”.  
 

In order to activate inserted elements, the cursor must have the arrow 
format. To get the arrow format, click the arrow on the right frame of the 

screen, press <ESC>, or click on the gray frame around the drawing.  

For sheets with complex nested elements, it is best to activate an element directly. 
Do this via the "Sheet components", page 495, or via the keyboard by pressing the 
space bar until the desired element is activated. You will see the name of the 
element in the status line. Shift+ space bar activates the parent of the active 
element. 

To delete an element, activate it and press <delete>. 

Move and Zoom Elements 

When an element is activated, the corners and middle of each frame show “grab” 
points. Resize the element box by clicking the “grab” points while pressing the left 
mouse button. If the cursor is inside the element, this procedure will move the 
element. You can also move the element using the arrow keys. Press <Return> to 
confirm the new position. Under PARAMETERS -> OPTIONS in the EDIT tab, you can 
set the movement to millimeters or pixel.  

When the cursor is close to one of the “grab” points, it changes to a small double 
arrow. The element box can now be enlarged or reduced (zoomed). Press the left 
mouse button if you want to zoom the box and its content proportionally. If you 
want to keep the ratio of the sides of the box but do not want to zoom the content, 
press the <Ctrl>-key while pressing the left mouse button. If you want to change 
the widths and heights non-proportionally, press the <Shift> -key with the left 
mouse button. The following table is valid for all rectangular elements. 

Left mouse button Content is zoomed proportionally with box 

<Ctrl>+ left mouse button Only the box (not the content) is zoomed 

<Shift>+ left mouse button Height and width are zoomed independently; 

the content is not zoomed 

Use PARAMETER -> OPTIONS tab EDIT VISUALLY, to define if the frame and the 
distance between the inner frame and the outer line shall be zoomed 
proportionally with the box.  
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Move elements with the Ctrl-key pressed 

With Ctrl + left mouse button you can change the reference between boxes and 
their parent element. In the sheet components (F6) you can instantly see the new 
hierarchy. The sheet itself is exempted from this logic; you cannot move entire 
boxes from other places to this element. 

If a non-aligned color scale is moved out of the plan to a group box with the Ctrl-
key the reference between the scale and the data is maintained.  

Special Considerations for Text, North Arrow and Symbol 

Press Ctrl+ left mouse button to rotate texts continuously.  

The north arrow zooms with any of the “grab” points. If you want to rotate the 
north arrow, do this in the symbol properties, but be aware that the direction of 
the north arrow will coincide with the Y-axis of the loaded data.   

A symbol is zoomed using the “grab” points on the lines and is rotated with the 
“grab” points in the corners. Shift and Ctrl have no meaning for symbols.  

Cut, Paste and Copy Elements 

When an element is active, you can cut and copy it via the keyboard, menu or 
symbol buttons. When cutting an element and inserting it into an element of a 
different hierarchy, you are moving the element to a different place in the 
hierarchy tree.   

The displacement of the inserted element is defined under PARAMETER -> OPTIONS, 
tab EDIT VISUALLY.  

Do not panic when you cut a color scale included in a map to paste it into a map 
descriptive box and the map is redrawn without the noise map. The noise map 
requires the intervals and colors definitions and will reappear when the scale is 
reinserted into the map in a different hierarchy.  

Store and Insert Elements 

Single elements of a graphics sheet (for example, a formatted color scale) can be 
stored globally to be available for any project. To store the element, select the 
menu FILE -> STORE ELEMENT (or right mouse button) and navigate to the global 
folder. Elements stored this way can be inserted into any sheet via the menu FILE -> 

INSERT ELEMENT. If an element is active at the time of insertion, the new element 
will be inserted into the active element. If nothing is activated, the new element 
will be inserted into the sheet. 
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Central Editing Tools 

Color favorites 

The color favorites are used to store often used colors and color sequences / color 
scales. SoundPLAN is delivered with a default color matrix the user can amend or 
customize and save it as a file in the Globdata folder. You can save several color 
favorite files. One favorite matrix can contain up to 240 colors organized in 15 lines 
of 16 colors. The colors are defined as RGB values.  

RGB = Red-Green-Blue components of a color, each ranging 0 - 255. 

A click on a color field opens the color dialog. Activate the checkbox extended to 
define additional colors. In the Graphics the color dialog can also be opened via 
PARAMETER -> COLORS.  

 

The extended color dialog is automatically opened, if you click on a color field using 
a color not stored in the color favorites.   

The displayed colors are approximate values as the real representation of the 
colors depends on the screen resolution and the used printer.  

Define colors /compile scale colors 

Click on EXTENDED.  Enter the numerical value for the RGB components click on an 
existing color to modify it.  

Rotating the color wheel in a color field will proportionally vary all RGB 
components while rotating the mouse wheel in one of the components will only 
vary the individual component. 

With OK the color from the color field is assigned the object type or element. To 
save a color in the favorites, move it with Drag&Drop to the desired position.  



SoundPLAN Manual 8.1 
Graphics 

Central Editing Tools  Page •  493/793 

10 

You can compose color sequences for a colored scale the same way. Move the 
colors in the desired sequence to free (black) fields in the matrix.  

 

Interpolate colors 

 

To generate color gradients for scales or to detail color settings for objects, 
SoundPLAN interpolates colors between 2 given color values. Click on EXTENDED. 
Select the first color and place it into an empty black field. Select the second color 
and place it to the right of the first color, leaving as many black spaces as you want 
to have interpolated in between.  

Click on the pocket calculator symbol to fill the gap with interpolated colors. 
Color sequences can also be defined stretching across lines. 

For a gray scale, the first value cannot be black (0,0,0). The program would ignore 
this. Set a very dark gray for the first color, for example, 5,5,5. 

Hint: Color gradients can also be interpolated directly in the color scale, see “Color 
scale” on page 520. 

Set colors to black 

Click on the symbol „set black“. It remains active as long as you keep the left 
mouse button pressed. This allows you to quickly erase no longer desired 

color favorites with the left mouse button.  

Print and calibrate color values 

Use the PRINT button to send the color favorites to the printer. Colors are printed 
with the RGB values. Depending on screen and printer resolutions and the printer 
drivers, the colors can appear very different on paper than on screen. As the 
printed version is usually more important, it is wise to calibrate the colors for the 
printer.  

For single sheets you can make the entire palette brighter or darker in the sheet 
properties.  
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Some printers allow the calibration of colors to the screen; please refer to the 
printer handbook.  

Colors according to DIN 45682 

In your color favorites (graphics -> Parameter -> colors) you can have the program 
generate the standard palette for noise maps in accordance to the DIN. Click on the 
color field from where on you want to have the colors inserted. 

Ctrl+S inserts the 11 scale colors 

Ctrl+O amends the object colors with the colors not present yet. As the entire 
layout section was updated the global settings will already contain the needed 
color presets. If you want to insert all of the new DIN object colors, use the 
shortcut Ctrl+Shift+O.  

You can still manually generate the color scales. Some standard color scales are 
delivered with the global settings, they are selected when you choose the scales 
with the ”System\” in front of the scale name. 

Zoom 

Use the zoom function (zoom mode or mouse wheel) to enlarge the map on 
screen. The geometry view port is not modified. It is set independently in Edit Map. 

Click on the magnifying glass to activate the zoom mode. You can pull open 
an area (press the left mouse button while pulling open the frame) or click on 

the left mouse button until the step by step zoom reaches the desired 
magnification. The area to be zoomed is always the area around the cursor. To 
zoom out, click the right mouse button. Use Parameter -> Options to set the size of 
the zoom step in [%].  

Click on the magnifying glass again or click on the arrow in the top right corner to 
leave the zoom mode.  

It is also possible to zoom an element to maximum size on screen. Click on 
zoom element and then click with the left mouse button on the element.  

Use the overview symbol to set the zoom factor to view the entire sheet on 
screen.  

Graphics Sheet Manager + Sheet Components 

The sheet manager in the Graphics is a new addition to perform tasks on multiple 
sheets at the same time. For example, to change the scale colors for all sheets with 
grid noise maps it is not necessary to open each sheet that has a grid noise map in 
it, set the scale to the new colors by hand and then save it again. This operation 
and others can be performed with the sheet manager effectively. 
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The sheet manager and the sheet components are displayed on the left-hand side 
as a tree diagram. To open it select FILE -> SHEET MANAGER (F5) or FILE -> SHEET 

COMPONENTS (F6). The area where the sheet manager or the sheet components are 
visible can be varied with the window splitter. Sheet manager and sheet 
components are mutually exclusive, only one of them can be presented at a time. 

Via the sheet manager you can transfer elements, content and settings from one 
sheet to other sheets, it is also possible to print and export multiple sheets at the 
same time. With Drag&Drop sheets that are not loaded at the time can be opened 
very quickly. With the sheet components you can modify the content, properties 
and settings of an element and assign these to other elements of the same sheet. 

For example, if you decided that the background color of all your text boxes is no 
longer what you want, adjust it in one element and then transfer the new settings 
to all others without opening each individual box. 

Sheet components 

Under the menu FILE -> SHEET COMPONENTS or via <F6> the sheet component box is 
made visible/disappears. For the sheet components all structured components are 
placed into a tree structure indicating the hierarchy between the components (who 
inherits what from which parent…). 

 

The tree structure and the sheet itself are coupled, which means that by clicking on 
an element in the tree, it is active in the sheet and vice versa. 

On top of the tree there are 4 buttons: 
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 The buttons DELETE ELEMENT, EDIT ELEMENT CONTENTS and EDIT ELEMENT PROPERTIES are 
only active as long as an element in the tree or on the sheet is active. To take over 
content or properties from an element to another is only active if multiple 
elements in the tree are activated. 

Take-over element components 

With the pressed Ctrl key mark one or multiple elements in the tree which you 
want to assign the properties of other elements. Now click on the element of the 
tree from which you want to assign content or properties. Click on the arrow 
symbol and select what you want to take over. The selection of content, properties 
and actions depend on the selected element. 

  

On the left the take-over from a map, to the right for a text. 

Sheet manager 

Via the menu FILE -> SHEET MANAGER or with <F5> the sheet manager is 
activated/deactivated. For the sheet manager a tree structure is generated that 
lists all sheets. As sub nodes of the tree all elements contained in the sheets are 
visible. The currently opened sheet is displayed in red and without the sub nodes. 

By dragging a sheet from the tree to the graphics pane, you open the sheet. 
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On top of the tree several buttons are placed. 

 

In the preview window below the tree you see the active element. For sheets the 
preview bitmap is displayed and for elements the content and the child elements. 
As it is not possible to load all data for all sheets at the same time, for maps the file 
list is displayed. 

 

With this tool you can very quickly get an overview over all sheets, maps and the 
data contained in them. The tree area and the pre-view panel can be resized by 
dragging the divider to the desired position. 
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Except in the sheet itself you can use the right mouse button in the preview 
window to get to the properties and the content and for the plan into the file 
selection and the plan-object types. In the file selection you can only alter the 
settings of the data already loaded or swap data for a data type already present. 
This restriction is needed because for new data types new elements might become 
necessary that are not included in this frame work. It is for example not possible to 
generate a new scale here and place it somewhere on the sheet. 

 

In the symbol bar of the sheet tree you can duplicate multiple sheets by clicking on 
the symbol . This way you can save a sheet under a new name and then load it 
using the right mouse button into a map of the sheet -> FILE SELECTION to modify 
the time slot without loading the sheet. 

The preview bitmap in the sheet tree now is saved in a bigger size than before (400 
pixel for the longest side). For already existing sheets this bitmap is only updated to 
the new size after loading the sheet and saving it. You can modify the settings in 
PARAMETER -> BASE SETTINGS in the tab Sheet. 

Take-over element properties and contents to other sheets 

Depending on which element you have selected, you can take-over different 
attributes: 

• Sheet colors 

• Properties 

• Position and size (if possible) 

• File list 

• Content 

• Section layout (text attribute settings) 

• Geometry viewport 

• Object types 
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With the properties the receiver element will take on the layout of the donor 
element, for text boxes that would be the box color, line settings, for a plan it 
would be the frame parameters, however size, docking parameters and position of 
the boxes would remain unaltered. 

For text boxes, texts, scales, legends and graphics boxes “content” is clear, 
everything but the section layout is transferred as this item can be selected 
separately. 

For the map TAKE-OVER CONTENT means that the file selections are taken over, 
geometry viewport parameters and object types are activated separately. 

When taking a legend from one sheet into other sheets you can optionally update 
altered legend texts of the plan object types for derived object types. Manual 
changes to legend texts contained in the legend will not automatically overwritten. 

Procedure: 

With the pressed Ctrl key highlight one or multiple elements in the tree which you 
want to assign the properties of other elements. Finally click on the element in the 
loaded sheet. Click on the arrow symbol "arrow left" to transfer information to the 
elements highlighted in the tree. And vice versa click on the arrow symbol "arrow 
right" to transfer information to the loaded sheet. The selection of content, 
properties and actions depend on the selected element. 

When dragging an element onto the sheet, you can select if the element shall be 
taken-over into the drawing. 

If you only want to transfer (take-over) one or a few object types from map to map, 
open the map object types and mark the desired object types and press on TAKE-

OVER ELEMENT COMPONENTS or simply drag them in the tree to the destination. 

Print or export multiple or all sheets 

You can mark multiple sheets and jointly perform the actions print, export (as a 
bitmap, WMF or with the contained contour lines) or delete. 
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In the main branch, where the project name is the active element, all actions will 
apply to all sheets of the project. 

When printing multiple sheets please be aware that only sheets with the same 
sheet sizes can be printed jointly because the sheet settings for example the sheet 
sizes are the same for all sheets. If you print into a file or save the sheet as a PDF, 
SoundPLAN will request the file name for each document  

Export 

 

When exporting you first get to a selection where you select what you want to 
export. For the export of contour lines, you also must define for which file format 
you want to generate the export. The export files are written into a sub folder in 
the active project, the program will suggest a name which you can alter to suit your 
needs or select an existing folder. 

Hints: 

• Sheets where anything was altered are marked with bold type in the tree. 

• All actions in the tree are final; there is no “undo”! The actions before they 
are saved however are only existing within the tree and thus leaving the tree 
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and not saving it will act as an "undo" for all actions since it was saved last, 
not only the last change will be lost. 

• If you want to load a different sheet from the same project, simply click on it 
in the tree and drag it to the right side (Drag&Drop). 

By making modifications it can be that the preview-bitmap does not reflect the 
content of the sheet any more. Please regenerate the preview-bitmap by clicking 
on the paint-brush-symbol. 

Acceleration of the Screen Output 

When editing elements, dialog boxes and entry screens appear that you must close 
after setting the parameters. The area under these dialog boxes must be redrawn 
every time a box is closed. When you have a large amount of data in a grid noise  
map or many objects that contain hatch patterns, the redraw can take a lot of time.  

In order to save time, you can choose what needs to be redrawn every time a 
box is closed. REFRESH ALL redraws the entire map. ONLY GEOMETRY will omit 

the noise maps. ONLY SIMPLE GEOMETRY draws only the simple geometry but omits 
the hatch patterns, etc. SIMPLE GEOMETRY WITH RESULTS will also omit hatch 
patterns but will show the noise maps. NO REFRESH takes the least time redrawing 
because the area where boxes are closed remains white. After you have finished 
editing, it is wise to redraw the entire screen using REFRESH ALL.  

To save time redrawing, the symbol hints appear on the status line rather than next 
to the symbols.   

If you have extensive noise maps and are not interested in viewing the colored 
areas between the contour lines, you can prevent drawing the contour fills by 
pressing <ESC>.  

Sheet Templates 

To save time when you begin a new sheet, SoundPLAN generates templates to 
store all the sheet settings without the files. These templates can be stored in the 
global folder so every project can access them.   

Several templates in different formats (A4, A3, portrait, landscape) are present in 
SoundPLAN. These templates are examples how the various elements of the map 
can be placed on the sheet and how to use text variables (page 512).  

We assume you have a standard layout for your office’s plans, with the unique 
logo, colors, etc. of your company. Use our templates to help create your own 
company templates for the three standard formats, with predefined map 
description boxes, company logo, etc. Map folding schemes are regarded the same 
as color sequencing for noise maps. If you use different printers, it is wise to 
customize the templates for each printer, so the printable size is observed and the 
color sequence looks good on each particular printer. 
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Generate templates from existing graphics sheets for various sheet sizes and 
purposes and store them via FILE -> SAVE AS TEMPLATE in the GLOBDATA folder. 
When making the next map, select the appropriate template in the graphics file 
manager and select the desired graphics and result files to fill the template. The 
box RECALCULATE FORMAT in the file selection must be checked.  

 

Hint: If you want to compile the legend, scale, north arrow and a text box to form 
one block, leave some space in the box in case the object type description of the 
legend has more entries than the template and requires more room. Likewise, the 
north arrow might consume more room if the view port is rotated differently than 
in the template.  

Options for editing 

 

Under PARAMETER -> OPTIONS, select the STEP SIZE the elements are moved in the 
map. The STEP FACTOR determines how far elements are displaced from the original 
element when they are copied and pasted.  

Determine the ZOOM STEP SIZE per mouse click for zooming with the mouse. 

For Editing plans and boxes, select whether shadows, box frame lines, box frame 
width and map frames shall be zoomed with the parent element or not.   
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For lines and box frame lines, select a minimum line width below which the lines 
are no longer visible on a plotter and will therefore be omitted.  

Further setting is available under additional: 

 

• Number of „undo“ steps .  

• Geometry bitmaps may be excluded from loading if there is not enough 
memory. 

• Definition of ridges of roofs in the Geo-Database (absolute elevation above 
sea-level or height above building reference plane or height above the 
upper edge of the building walls). 

• The hints for the symbol buttons can either be displayed at the cursor or in 
the status bar. If you use "at cursor" the data of the map need to be 
redrawn. This might lead to annoying waiting times when large grid noise 
maps are loaded. 

• When the sheet tree is open, the file selection manager is not displayed by 
default opening the Graphics. You then open it clicking the new symbol.  

The tab index card data types contains a list of all data types that are covered by 
your license. If there are data types, you rarely use you can exclude them from the 
selection list in the file selection manager. Moreover, you sort the data types with 
drag & drop according to your preferences. 

Log book 

The Graphics records the actions while loading and working with the data.  

The log book is opened with the button in the symbol bar and displayed at the 
bottom of the screen. In order to provide you with information of possible 
warnings and errors even if the log book is closed, the text color changes to red 
when problems occur. 
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Element Properties 
The element properties (background color, borderline color, frame width, etc.) 
define the appearance of the element boxes. 

There are multiple ways to open the element properties: 

Click on the element and select PROPERTIES from the right mouse popup menu. 

Use the menu ELEMENTS -> SHEET COMPONENTS.  

Activate the element with the space bar on the keyboard and use Shift+ Ctrl+ 
Return. 

The sheet and map contain specific properties discussed below. The other element 
type properties vary only slightly, so they can be described together.  

There is a box labeled SHOW to the lower left that must be marked in order to show 
(print) this element. Normally the box is checked. However, there are some 
situations where you don’t want to show an element but still want it included in 
the map. For example, a scale in a 3D Grid noise map or a legend that does not fit 
into the 3D-map. 

When you want the element to reappear, open ELEMENTS -> SHEET COMPONENTS, 
click on the properties and check the box to show the item.  

Layout 

 

The BACKGROUND COLOR can be inherited from the parent element. This is 
especially useful if you want to place multiple elements in the parent element and 
want the background to be the same color. If you decide to change the background 



SoundPLAN Manual 8.1 
Graphics 

Element Properties  Page •  505/793 

10 

color, you only need to set the background on the parent element and the children 
will automatically change. You also have the option to set the background as 
transparent or assign a color from the color palette. 

The frame can be adjusted jointly or line by line. There are controls to 
activate/disable a line, and to define line width and color.  

 The Cartography module allows shadows behind the boxes. The shadow is half-
transparent.  

Base Settings for Elements 

Use PARAMETER -> BASE SETTINGS FOR ELEMENTS to define the general layout for all 
new elements in all projects. Each new box, legend and scale will use these default 
settings until the definitions are changed.  

 

Select base settings that will require the least amount of editing. You can always 
adjust the properties for each of the elements locally to suit your map. 

In the tab index card color scale, you define with which color from the color 
favorites the automatically created color scale is to begin and whether the intervals 
should be arranged in ascending or descending order by default. You can change 
the settings in the autoscaling of the color scale at any time. 

The preview window in the sheet tree is preset to 400 px for the longer side. For 
existing sheets, the size is not updated until the sheet has been loaded and saved. 
You can change the setting in the tab index card sheet. 
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Name, Size and Position 

 
Box-properties - name, position and size 

Each element can be assigned a NAME. The name created automatically for new 
elements is the element type and a number. The number is automatically 
incremented for new elements, so the name is unique.  

The element name is presented in the sheet components and when moving 
between element with the space bar. The name appears in the status line at the 
bottom of the screen.  

The POSITION of an element describes the relative position in [mm] of an element 
in relation to the parent. You can also see the size of the element. Use these fields 
to place the elements accurately. KEEP PROPORTIONS forces the box to zoom up and 
down proportionately, keeping the ratio of the sides constant.  

The text box and bitmap box can be rotated in increments of 90°. Select ROTATION 

from the selection list. Texts can be rotated any degree by pressing the <Ctrl> and 
the left mouse button. Moving the mouse will rotate the text. If you want to rotate 
multiple texts the same number of degrees, it is useful to enter the ANGLE in the 
element properties.  

Alignment 

In the following example, the address field is grouped within the combined text 
boxes. 
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A specific box to combine multiple texts and other boxes is not necessary because a 
regular text box with no text does this. In the example above, the group combine 
box contains a graphics box that is anchored on the left side. The additional text 
box is fitted into the group box and adjusts to the size of the text box. When the 
bitmap is enlarged, the texts will zoom with it. 

 When a text box is anchored to the top as a legend box, its height can only 
be modified by moving the bottom of the text box. All other measurements 

are determined by the size of the parent box. The text box size is fixed and cannot 
be moved. If the width of the legend box is changed, the width of the text box will 
automatically change. Therefore, the cursor within anchored boxes is no longer a 
cross but a symbol for “movement denied”. 

The following possibilities exist to anchor a child element within the parent box: 

• Top  

• Bottom  

• Right side 

• Left side 

• Fitted  

• fixed 

• Free (only text boxes) 

Fitted elements use the entire remaining space of a parent box. They are 
completely dependent in their location and size. As nothing remains of the parent 
box, it only functions as a container used to move the entire group of boxes. To 
activate the group box, navigate to the correct box using the space bar or select 
ELEMENTS -> SHEET COMPONENTS.   

Please remember when the parent box is activated, the other elements can no 
longer be activated automatically. Only the parent box can be moved or edited. 
Click the arrow symbol on the right side of the screen or press Esc to activate the 
correct element or use the space bar to move through the list of elements.  

The sequence of anchoring and fitting boxes inside the parent box is crucial. The 
first box will use the remaining width of the parent box. The sizes of the next boxes 
will use the remaining space. Please observe the following samples. 
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Caution: If you mix boxes that are anchored top/bottom and left/right in the parent 
box and then delete a box, the entire arrangement may no longer work. For 
complex boxes, it might be sensible to sub-group items and place another group 
box rather than place each individual element separately.  

Use CUT and PASTE to move existing boxes (legends and color scales that were 
created automatically on the sheet) into a group box. To do this, activate the box to 
be moved, click the symbol CUT (scissors), activate the parent box where you want 
to insert the element and click the symbol to INSERT.  

Edge 

Use the Edge tab index card to state the distance between the frame and the 
content of the box. The edge can be set for all sides or for individual sides. You can 
also set the increments of the edge distance to 0.1, 0.5 or 1 [mm].  

If increasing the edge of the box causes the text to no longer fit the box, the text is 
truncated. It is the user’s job to resize the text to fit the box.  

 

Specialties for Sheet Properties 

When a sheet is stored, the file name is stored as the description and as the name 
of the element (sheet). 

The folding marks are calculated according to a German DIN norm. Select the size 
the sheet should be folded to and the width of the stapling margin. You can also 
change the layout of the folding marks.   

Click the paintbrush symbol to make the folding marks visible in the sheet.  
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Specialties of the Map Properties 

Use NAME, POSITION AND SIZE to designate if child boxes inside the map shall be 
attached to the inner frame of the map. This is especially useful if your map has a 
double frame with the coordinate crosses in it. 

Frame Properties 

The map can have specialized frame properties instead of edge properties.  

 

A map can be enclosed with a double frame which may contain coordinate cross 
marks. The map content moves inwards due to the size of the frame. The default 
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frame setting is 3 mm wide with a gray background. If you only want to see the 
outer frame, set the frame width to 0 mm and deactivate the inner frame lines. 
Color and width of the outer frame lines are changed under the tab LAYOUT.  

Choose if you want the inner frame lines and pick the color and thickness.  

SoundPLAN pre-selects the spacing of the coordinate grid inside the frame 
according to the scale selected for the map. Use the field COORDINATE AXIS - GRID 

SIZE IN [M] to change the settings. Aside from the grid in the frame, this value also 
controls the coordinate raster reference. 

The RASTER REFERENCE MARKS on the map can be activated or suppressed. COMBINE 

REFERENCE MARKS connects the marks creating a regular grid pattern over the 
entire map. When this is active, the size settings for the marks are ignored. Other 
controls are for line thickness and color.  

If you have activated the raster reference marks but do not see them on screen, 
the spacing of the marks is probably too big. 

The coordinate text in the frame in the double frame can be enabled or 
suppressed. Other controls are for text size and color. 

The coordinate text in the frame of the sheet now can be customized to place the 
text parallel to the edges of the sheet. 

 

Select the map property and under the tab frame select the box FIT TO FRAME. 

Professional plan presentation 
Expressive and professional plan presentation is included in the SoundPLAN 
Graphics if you use the individual design features of the elements. Color scales and 
legends are automatically generated with the data with default settings. Text boxes 
host descriptions or are used to group several elements. Length scale, graphics 
boxes and the north arrow complete the element boxes. The content of the 
element boxes is opened with a double click on the box or via the RIGHT MOUSE 

BUTTON -> EDIT CONTENTS.  

There is no need to export the results to special graphics software.  
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Common features for text boxes, legends and color scales 

Within „Edit content“ of a text box, color scale or legend it is possible to activate 
the properties for the element (edge lines, background color, alignment, frame 
width …). 

 

After closing the properties again, you will get back to „edit content“. 

 Section layout 

 In the layout you can define two formats for two layouts; one for the layout of the 
STANDARDTEXT and for the TITEL. You can see how changes of font, size, spacing and 
justification influence the result.  

When entering a title, <return> starts a new line and <Ctrl + return> starts a new 
paragraph. 

Automatic word wrapping is not possible; please enter the line breaks manually to 
fit the text to the box.  

Use the red + button to add own section layouts. 

      

With "-" the own additions can be deleted. In case the format to be deleted is still 
in use in a text, it will be purged from the text, i.e. the text will be presented with 
the previous section layout. 

 Subscript and superscript texts 

In text boxes, legends, scales and with general texts in the graphics as well as for 
headers in the Spreadsheet it is possible to have texts with the attribute subscript. 
Write the text like normal, mark the spot that needs to be turned into subscript 
and click on the symbol SUBSCRIPT. As you still process the text, control characters 
are marking the subscript part. 
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R’w,res for example will be displayed as "R'@\l+w, res@\l-". As soon as you finish 
editing the text, the subscript will be effective. 

In case you need other text attributes, e.g. to write a word in a paragraph in bold, 
you can manually insert them: 

@\l+text@\l-  = subscript 

@\h+text@\h-  = superscript 

@\i+text@\i-  = italic 

@\b+text@\b-  = bold 

Text variables 

For text boxes, the color scale and text, you can 
insert variables that automatically adapt text to 

the sheet content. Variables advantages include quick and error free generation of 
maps and the constant update of the version number and sheet date to the status 
when the map was last edited. 

If you want to generate a sheet with a grid noise map for time slot day and another 
sheet with a grid noise map for time slot night, you can insert the variable <ID time 
slot> in the scale. If you save the sheet under a different name, open the file 
selection again and select the time slot for night and the header for the scale is 
automatically set to night.  

If you use the text variables in your templates, it is even faster to get the 
information current. 

 

I 
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n the box content click on TEXT VARIABLES and select the variable from the list: 

Variable name Origin 

Project title  Project-info 

Project No. Project-info 

Project engineer  Project-info 

Customer Project-info 

Project path Location of the project or project path name 

Company name License file 

Version-No. SoundPLAN Info 

Version date SoundPLAN Info 

Sheet name Graphics 

Sheet file date Graphics 

Date Current computer date 

Map name Graphics 

Map section texts Texts from the free attributes of the object type “map 
section” (GeoDB – Property Explorer) 

Length scale Map length scale. If the length scale is 1:500, the result 
of the variable is 500  

Situation description First row of the description of the Situation (Geo-
Database) 

Run title Result file of the run or description of the formula of a 
file operation 

Run No. Result number of the calculation run 

Scale unit Loaded data  

ID time slice Abbreviation of the time slice in the result file 

Time slice name Name of the time slice in the result file 

Frequency [Hz]/Group Frequency or group (Grid Noise Map, group also 
Façade Noise Map) 

Frequency or frequency band (Meshed Map) 

Displayed floor File selection manager (Façade Noise Map) 

Height / Floor Calculation parameter (Grid Noise Map/Meshed Map) 

 

As soon as you leave a line, the variable is processed so you see the variable 
content rather than the variable name.  
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You also can concatenate multiple variables, for example <Project path>\<sheet 

name>.  

Free Text boxes 

For text boxes, additional properties can be defined under the tab „name, position 
and size “. The ALIGNMENT can be „free“. This allows you to place information on 
the frame (for example, the version number of the sheet). 

Hint: SoundPLAN does not check for „free“ text boxes if they are within the 
printable area of the sheet; this is the user’s responsibility. 

Switch the alignment of the text box to „fixed“ when you are satisfied with the 
position of the variable on the sheet border. 

Multiple files or maps on a single sheet and the file operations 

If multiple results or situations are loaded into a plan, the variables for RUN TITLE, 
SITUATION DESCRIPTION, ID TIME SLICE and NAME TIME SLICE are always taken from 
the result file or situation found first in the file selection list.  

When multiple map are on the sheet, the variables are from the first map that was 
placed on the sheet (top position in the sheet components list). 

For file operations, the variable for run title will display the formulas found in the 
field description of the file operations. 

 

Deactivate DESCRIBE AUTOMATICALLY if you want to write your own description for 
the run title instead of the formula.  
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Connection lines  

For text boxes, texts and graphic boxes in the box settings you can request a line 
tying the box to the location it describes. Optionally you can make the end of the 
line appear as an arrow.  

   

When the box is selected, you can grab the connection line and move it, grab either 
the beginning or the end of the line. The default position of the start point of the 
line is the middle of the box. When the entire box is moved, the line is adapting. 
You can change the position of the start point, for example to one of the corners. 

 

Text boxes 

Text boxes are available for entering descriptions on the map. They function as 
containers for nested boxes with legends, etc..  

 
Edit text box 

After requesting and sizing a text box, double click on it or choose EDIT 

CONTENT from the right mouse menu. An entry screen with a text editor 
opens. You can write and format your text in this editor.  
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Use the symbol buttons to insert lines  or delete lines . The text editor does not 
offer the comfort of flow text, so you must request new lines with <return> and 
start new paragraphs with <Ctrl+Enter>. Within a paragraph (or section) the layout 
must be the same.  

Use ADAPT BOX TO CONTENT to adjust the size of the text box to the size of its 
content. With nested elements, any adjustment may mean you need to refit boxes 
within the parent box. If the option to adjust the box to the content is not used and 
the content has increased, the excess content will be truncated.  

Use the ZOOM FACTOR (Zf) to increase the size of the legend for editing. 

Section layout, subscripted texts and text variables are described in "Professional 
plan presentation" on page 510.  

The entire text in text boxes can be centered horizontally and vertically even if the 
text contains complex paragraph layout. 

In the parameters to set the properties of boxes the tab edge contains the 
parameter to center the content, in this case the frame width will be ignored.  

 

When enlarging shrinking the text box, the text font is adjusted accordingly. 

 

When you use nested text boxes, please observe that the text boxes are not 
checking the visibility, if there is a free space it may be sensible to fill these areas 
with empty text boxes that are „fitted” to the gap. 

Legend 

SoundPLAN creates the legend from the object types present in the data and the 
drawing settings from the object type setup. 
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Only object types and section headers in the object type setup that have the 
explicit OK to be included in the legend as shown in USE IN LEGEND. The 
automatically generated legend consists of all activated section headers and all 
loaded and activated object types. The sequence in the legend is the same as in the 
object type setup.  

The legend contains the object type and the legend text. How an object type is 
presented in the legend depends on the current layout setting of the object type 
setup. If you change the color of an object type, the color in the legend is 
automatically adjusted.  

Activating / deactivating the legend text in the plan object types will insert/delete 
them in the legend immediately. 
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Use the symbol button  to insert text lines for additional segmentation and  to 
delete text or data lines.  

Data lines are organized as a table. The width of the columns can be adjusted by 
left clicking the column separator and moving the slider to the desired position.  

 

For line and area type objects, the width of the legend can be adjusted by 
modifying the first column.  

The legend definition of area-type objects distinguishes between areas, buildings 
and bands. Buildings are shown as a rectangle with the ratio of the sides of 1.8 : 1.  
For elongated areas (bands), for example the road surface or the tilt of a wall, the 
symbol uses the entire width but with diminished height. All other areas use the 
total space. 

Sub objects (for example in tunnels or the meddle divider), for which no extra data 
are available, are not written into the legend. 

When using templates, the legend often contains elements that are not 
present in the sheet. You now find a button to mark all object types in the 

legend that do not visible objects in the sheet.  

With Ctrl + left click on a legend entry the entry is marked / respective unmarked. 
This is useful for example if the templates contain a noise protection wall but the 
current sheet does not have a noise protection wall in the visible area.  

All marked legend entries can then be deleted commonly with the DELETE 

BUTTON. 

ADAPT BOX TO CONTENT resized the box around the legend to accommodate the 
legend. With nested box constructions, this means that other elements may have 
to be moved. If you do not activate this switch, the legend box will remain the 
same size, which may cause the content of the legend to be truncated.  

Use the ZOOM FACTOR (Zf) to increase the size of the legend for editing.  

Section layout, subscripted texts and text variables are described in "Professional 
plan presentation (page 510)".  

Change the positioning of the layout entries 

The legend entries sequence is determined by the sequence of loading of the geo-
files. Result types are sequenced according to the sequence of the files loaded. Use 
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the symbol buttons for cut, copy and insert or use the shortcuts (Ctrl+ X, Ctrl+ C, 
Ctrl+ V) to change the sequencing. The legend entries are always inserted above 
the cursor position.  

Insert additional legend entries 

If data are loaded with no entry in the legend, for example because the box "use in 
legend" was not clicked, you can still insert this in the legend.  

Make sure the desired object type in the object type settings is checked for 
insertion in the legend. Open a new legend box. The content is initially empty 

and is filled when you double click the legend box or select EDIT CONTENT from the 
right click mouse menu. 

Mark the object type you want to insert, press Ctrl+ C or the symbol button COPY.  

Double click the existing legend and position the cursor below where you want to 
insert the entry and paste in the line with Ctrl + V or use the symbol button INSERT. 
This possibility is especially useful to insert a single object type into a legend.  

Open the file selection and click on the situation with the right mouse button to 
show the parameter selection of the geometry data.  

Activate the menu entry COMPLETE LEGEND WITH ALL DATA FOUND IN MAP and click 
OK. If needed, you can always delete undesired entries from the legend.  

 

The second way of amending the legend is more useful if many object types were 
missing in the legend.  

 Presentation of total objects in the legend  

[Module Cartography] For object types that consist of multiple sub-objects, for 
example road or noise protection wall, the entire object type is presented in the 
legend when the main object type is activated for presentation and all the sub-
object types are not activated for the presentation in the legend.  
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Color scale 

Color scales are used for all area type displays and the Facade Noise Map. If you 
work without a template, the color scale is usually generated when loading the 
data. It is created by searching for the lowest and highest values and suggesting a 
scale with steps between the values.  

You can save color scales separately in the Globdata folder (right mouse button –> 
SAVE ELEMENT) and open them from other projects via the file selection or via 
INSERT ELEMENT. 

 

The basis for the color scale is the color favorite matrix in which the colors are 
defined and grouped together to color scales.  
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The start color defined under PARAMETER -> BASE SETTINGS is used as the beginning 
of the color sequence.  

The scale intervals are generated as a table. You can enlarge columns by left 
clicking the column header after the cursor is displayed as the splitter cursor. Use 
the splitter cursor with the left mouse button pressed to change the column width 
to the desired size.  

 

You can also insert data  and text  lines in the scale to mark additional 
intervals and include comments in the scale. This could be done to indicate from 
which level the noise limit has been exceeded. Use the symbol ‘delete line’ to 

delete  both text and data lines.  

You can interpolate colors between two color fields for example to quickly 
generate a difference scale.  

Select the colors between which you want to interpolate, select the color lines in 
between and set them with the symbol button  to black.  

 

Now click on the symbol for the calculator. 
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When the number of columns in a scale or the width of the scale is increased, use 
ADAPT BOX TO CONTENT to resize the box around the scale. With nested elements, 
however, this may force you to rearrange some of the elements or to resize the 
scale again. If you do not click „adapt,” the box will remain its original size. If the 
content is bigger than the box, the remaining part is truncated.  

Use ZOOMFAKTOR (Zf) to enlarge the scale for editing.  

Section layout, subscripted texts and text variables are described in "Professional 
plan presentation" on page 510.  

Base settings for the color scale 

 

Scale colors are defined in PARAMETER -> BASE SETTINGS as well as the selection if 
the values shall be ascending or descending. Both settings can be edited any time. 

 Automatic scaling 

Automatic scaling creates a new scale of up to 16 intervals. Click on  AUTOMATIC 

SCALING.  
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For automatic scaling, select the MINIMUM VALUE IN THE SCALE, the INCREMENT and 
the NUMBER OF INTERVALS. ASCENDING sets the first value of the scale as the highest 
or lowest value.  

The automatic scaling procedure calculates the highest value of the scale according 
to the size and the number of intervals. 

In addition, define the MEASUREMENT and UNIT (the scale is used for all grid based 
maps) and the NUMBER OF DECIMALS. If you select a decimal number as the 
increment size, the number of decimals is automatically adjusted.  

The color favorites are used for the COLOR SELECTION. A line in the palette has 16 
color fields so you can administer color scales with ease. SoundPLAN is delivered 
with a line of palette entries. At any given time you can define your own scales with 
PARAMETER -> COLORS, see “Color favorites (page 492)”.  

If SoundPLAN defines the colors, the scale is generated using consecutive colors 
beginning with a user entered start color. If you deactivate SET, your modified 
colors are not overwritten, and additional intervals remain blank. ASCENDING 
means colors are inserted to the right or to the left of the clicked color field.  

For the smallest value and the increment size, 3 digits after the decimal are 
presented. When leaving the screen, this is automatically adjusted to the 
requirements. If it is smaller than the number entered, the defined number of 
digits is used. 

The color scale for auto scaling is only rescaled when the parameters fed into the 
scaling make this a requirement. For example, if you change the number of digits 
displayed in the scale box, this would not make a complete reset necessary which 
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in turn would reset any of your custom color definitions. With the checkbox 

RESCALE you can force a full re-scaling. 

Designing the scale 

It is possible to have a scale generated automatically and customize it later  

You are not bound to restrictive interval sizes. You can assign the left value field 
any value and the right-side value will adjust to it. This allows you to create 
"speaking" scales. For example, use green colors up to the target value, yellow 
colors to the noise limit, and red and purple colors to highlight the problems.  

Single scale colors can be changed by clicking the color field and selecting a new 
color from the palette.  

For different display possibilities, the graphics offer the following scale types for 
your selection.  

 

The Grid Noise Map is a nice example. If you designate the space between contour 
lines be filled with color, the color will indicate, for example, that the noise level is 
between 55 und 60 dB(A). Or you can omit the color fill and color the noise 
contours themselves. The color is the indication of the value (55 or of 60 dB(A) in 
our example). 
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SCALE TYPE defines if the color shall represent an interval (the first 8 scale types) or 
if the color shall represent a discrete value.  

Other parameters define if the interval boundaries shall be part of the interval itself 
and which column shall be presented in what sequence. If you are still not satisfied 
with the scale labeling, you can use the suggested scale description and customize 
it. The description can be any length and can cover multiple lines. In this mode, 
however, you can no longer use the auto scaling nor can you insert or delete lines 
in the scale, so this option should be set only when scale type and intervals are 
already satisfactory. If you have to modify these parameters later, simply 
deactivate the click box COMMENT COLUMN.  

(The lowest interval can be truncated if, for example, you do not want to show 
areas smaller than 50 dB(A). For area type maps, the contour areas of the lowest 
value will be left blank. For Facade Noise Maps, you can select if the building point 
shall be drawn in the color selected in the object setup or if it shall be omitted. 

 

If you use the lowest interval, you can convert the interval from an open interval of 
the type >= into a closed one of the type =. This may be useful for conflict maps 
that always would show, for example, <= 3. A closed interval would show 0 < color 
<= 3. 

Please be advised that the scale type is only the display setting for the scale and 
has no influence on the presentation of the results. The switch „use lowest 
interval” modifies the drawing of the map itself. 

To add to the flexibility of the display of the scale, you can further customize 
the scale in the SCALE LAYOUT:  
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• line height (not smaller than the indicated letter size) 

• height (or thickness, for contour lines) of the color field 

• left and right margin 

• a line shall be drawn around the color rectangle and line width and color 

• the scale interval numbers in Arabic or Roman numerals 

• the color of the scale interval number 

You can set the text color separately for bright and dark color intervals. 
Define the gray value (0-255) that separates bright from dark colors.  

This setting is also used for grid point values and texts of the facade noise 
map receivers. 

  

• the interval-layout (see below) 
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Scale with color brightness and hatch patterns 

In addition to having solid colored surfaces, it is possible to display the areas with 
hatch patterns and color brightness. 

     

Double click on the scale to edit the content, then click on the symbol button  
scale layout, activate WITH HATCHES / BRIGHTENING and click DEFINE ALL. The screen 
display with brightened or hatched colors will take considerably longer to update. 

 

As the contour lines and the scale colors in the facade receiver points are not 
brightened, you have another possibility to customize your graphics. 

Interval - Layout 

Click on the hatch field to customize the interval-layout. 
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You can also combine the fill color with the hatch and brighten the colors by a 
certain margin. 

For the hatch the standard hatch types are available. Define spacing, and color and 
width of the hatch lines. 

To speed up the definition you can select the border line to coincide with the hatch 
line style or define a different border line. 

North arrow 

When a north arrow is inserted, it is positioned with a predefined size. Grab the 
north arrow by the positioning marks to resize it. 

Normally the north arrow is automatically rotated to point north. You only have to 
manually rotate the north arrow to point it north if the bitmap used for digitizing 
was not oriented towards true north. If the need arises, open the PROPERTIES via 
the right mouse menu. 

 

Define color and line parameters in the layout settings. Use SYMBOL to select a 
symbol for the north arrow and to select colors for borders and fills. 
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Graphics box  

Use the graphics boxes to include company logos or additional information (map 
description, photos of a machinery, receiver locations etc.) from a graphic file or a 
pdf file in the Graphics. The SoundPLAN Graphics offers at least one graphics box 
for your company logo. Several graphics boxes can only be included if Cartography 
is licensed. 

The pdf file is first converted to a bitmap, see “PDF as background graphics” in the 
chapter Geo-Database. 

Click on the symbol GRAPHICS BOX and pull a frame on the map. Select whether the 
graphics you want to include is a Windows Metafile or a pixel graphics (bmp, gif, 
jpg, png, tif).  

 

You can edit the graphics with a double click or right mouse button -> EDIT 

CONTENTS. Via the menu BITMAP it is possible to adjust the graphics (for example 
rotate, brighten or convert to gray scale).  

Pulling open a frame within the graphics allows cutting the graphics with the 
scissor symbol. You can store the changed graphics under a new file name.  

Brightness, contrast, clarity and color components of bitmap files can now be post 
processed in a graphics box.  
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Adjust bitmaps in graphics boxes with alignment (left, right, top and bottom):  

As soon as the settings for alignment are selected, the mark FIT GRAPHICS IN THE 

BOX becomes active. 

For the alignment to/bottom the picture is located centrally in the parent element. 
For the alignment left/right the picture is centered vertically.  

 

When a parent box is enlarged, the picture will remain centered with the existing 
scale, if the box is shrunk in size, the picture will be scaled down to fit the new 
space if it would exceed the size of the parent box. 

With shrinking/enlarging the graphics box the ratio of X/Y will not change, if 
needed the picture is scaled down to make it fit the box. 

Scale bar 

The scale is generated automatically from the min/max coordinates and the sizes of 
the sheet. Changes in the viewport or manually resetting the view, changes the 
scale factor. 

 

You can choose if you want to present the scale as the scale factor or as the scale 
bar or both. 
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Use FONT to select the text attribute for the distance scale text and for labeling the 
scale bar. Delete the text SCALE 1: if you do not want the text. Use SHOW SCALE 

VALUE to insert the numeric scale value defined in the geometry parameters. The 
check box USE THOUSANDS SEPARATOR groups scale values >= 1,000 to groups of 
three figures and inserts a comma (or a point if the decimal separator is a comma). 
The SPACE between the scale text and the scale bar is used to separate the 
components from each other.  

For the SCALE BAR, select for metric scales the unit [m] or [km], the NUMBER OF 

SECTIONS and the SECTION LENGTH in the set unit size. The first section is presented 
in two colors if the switch DIVIDE FIRST SECTION IN TWO PARTS is clicked. To further 
customize the scale bar, select the WIDTH OF THE BAR and the color of the 
segments.  

Additionally, request an EDGE around the bar to frame the white. Check SHOW to 
draw the edge; as usual, color and line width is your choice. 

Use ADAPT BOX TO CONTENT to adjust the size of the text box to the size of its 
content. With nested elements, any adjustment may mean you need to refit boxes 
within the parent box. If the option to adjust the box to the content is not used and 
the content has increased, the excess content will be truncated. 

The Map 
There are several steps in creating a map. The first step is selecting the data in the 
file manager. Use EDIT MAP to select the geometry view port. Customize the 
appearance of the objects in the Map-Object-types (right mouse button) and 
customize how each object type is drawn. Set the properties for the map and other 
elements and customize the graphics objects in the object type setup. You can edit 
this information anytime during a project.  

Graphics-File-Selection-Manager 

When you open the graphics, the Graphics-File-Selection-Manager opens so you 
can select a template for a new sheet, select files from the current project or open 
any of the recently processed sheets. 
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The TEMPLATE-SELECTION contains the model plots delivered with SoundPLAN. The 
SoundPLAN system folders contain multi-lingual templates. The GLOBDATA folder 
(which is located under ..\My Documents\SoundPLAN\) hosts user generated 
templates. The OPEN FILE SELECTION is the default setting for templates with a single 
map on the sheet and opens the File Selection Manager for situations and result 
files when you click the NEW button. If multiple maps are on the sheet, SoundPLAN 
cannot determine which map is to be used, so the OPEN FILE SELECTION is 
deactivated. You must open the sheet, mark the map and then activate the File 
Selection Manager via the right mouse button menu.   

If you click the button SAVE AS DEFAULT, the next time you open the graphics this 
template will be suggested as the standard.  

The SHEET PROPERTIES and the box INSERT MAP are only active when you open an 
empty sheet. Open the new sheet, open the SHEET PROPERTIES and define the sheet 
size and orientation. If the box INSERT MAP is active, the new map will be 
maximized to use the entire space on the sheet.  

To leave the graphics file selection manager, click NEW, which opens the file 
selection or moves to the main graphics level, or OPEN, which loads an existing 
sheet of the current project, or select one of the graphics sheets processed 
recently.  

File Selection 

The File Selection determines which data will be used in the map.  

When generating a new map, you will usually use the File Selection after choosing 
the templates or forms.  
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From the graphics main level, activate the map, right click and select FILE SELECTION. 
If the sheet does not contain a map, the box in the Graphics-File-Selection-Manager 
for generating a map was deactivated. Request a new map with the symbol INSERT 

MAP. 

The FILE TYPE “situation” is the default setting. Other types must be requested. All 
existing situations are listed on the left side. The top box contains the file name and 
description. The bottom has a bitmap depicting the data in the situation and the 
geo-files that make up the situation. Activate situations with the mouse (use the 
shift and Ctrl keys to mark multiple situations) and move the files to the right side, 
creating a list of files that will be included in the map. To move the files, double 
click the file, mark a file and use the arrow symbol between the file boxes or “Drag 
& Drop.” 

 
File Selection 

For the geometry data, SoundPLAN creates a legend of all object types contained in 
the situations and geo-files. Confirm the request to generate the legend. If you 
used a template for the sheet, the legend was taken from the template and may 
need editing.   

Use RECALCULATE FORMAT to define if the geometry view port that was the basis of 
the template shall be used or if the scale and view shall be recalculated from the 
geometry in the situation. The field RECALCULATE FORMAT is shown at the bottom of 
the main screen when you open a template. This enables you to view the geometry 
even if the template was based on a different part of the coordinate system. 

After selecting all situations, proceed with other file types. Use the arrow symbol to 
move a file into the map. The program only copies the file name and removes it 
from the list of available files on the left.  
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File types are only displayed, if compatible data are available. Nevertheless, there 
might be a lot of file types, because one result type can be used in several Graphics 
file types. E.g. a simple single point result can be loaded as facade noise map, level 
tables, level chart or used in the FNM operations.  

Click on the wheel symbol in front of the file selection to find a list with all file 
types corresponding to the modules in your license (or PARAMETERS -> 

OPTIONS). File types not calculated in this project are displayed in italic. Here you 
can switch on and off file types and change the display order. Drag the file type 
with the mouse to the desired position. 

These settings are project specific, but you can store them globally. After you 
pressed the button save globally the settings are used in all other projects, too. It is 
therefore sensible to consider a general setting with the file types you normally use 
and save it globally before you make special changes for the current project.  

Some of the file types require additional parameters. These are requested when 
the data are loaded. The parameter description is included in the description of the 
file types.  

For grid noise maps, for example, you are asked which time slot shall be presented 
and which scale shall be used. Scales already contained in the sheet can be 
activated here. 
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Use the double arrow to edit the scale or accept the automatic settings. To edit the 
scale later, right click on it and select the option EDIT CONTENT. More information 
about scales is described in the section "Color palette".  

Leave the parameter entry with OK and click OK again to return to the main 
graphics screen. 

Edit the Content of a Map 

 

Double-clicking the map (or using the right mouse button -> EDIT CONTENTS) opens 
the Edit Map facility. The black line framing the loaded data indicates the section of 
data to be printed. The view port depends on the measurements of the map (width 
and height) and thus cannot be modified here. You can modify the part of the 
geometry that shall be visible in the printed map. The currently selected scale 
factor is seen in the status line at the bottom of the screen.   
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Functions in Edit Map: 

• Define the view port (world coordinates of the geometry at the center of the 
map, rotation around the center and scale factor) via numerical definition 
(geometry parameter) or with the mouse (change geometry view port).  

• Show cross-section display and 3D-view. Even without a license for the 
Cross-Sectional Map and 3D modules, the cross-section through the terrain 
and the 3D-wire frame models can be started. 

• Store the map view as a geo-file. 

• Generate your own geo-referenced bitmap from the loaded data (i.e. as a 
reference map for the tiling or to check the contour lines of a DGM). Load 
the desired data into the Graphics, open edit map and store the map data 
with EDIT -> CREATE GEO-REFERENCED BITMAP (or the symbol button) in one of 
the available graphics formats. 

• Customize the map-object types via PARAMETER -> MAP-OBJECT TYPES 

Functions dependent on the data and the license for certain operations: 

• Edit grid values. 

• Export of contour lines and grid values.  

• Position level tables and receiver flags. 

• Move contour line texts. 

• Store the map view of one or multiple (loaded) bitmaps in a new file. For 
example, to crop a large geometry bitmap or to compile one bitmap from 
multiple, single bitmaps. 

When the Situations and results are loaded, SoundPLAN automatically calculates 
the world coordinates of the center of the view port and defines the scale factor. 
The scale is calculated to maximize the view of the geometry with north being the 
y-axis of the coordinate system.  

Elements positioned in the map are not displayed in "Edit map content". For your 
information activate the elements with PARAMETERS -> SHOW CHILD BOXES.   
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 Geometry parameter 

 The most common practice is to print the map with a fixed rounded scale factor 
rather than maximizing the scale. Open the geometry parameter with the symbol 
GEOMETRY PARAMETER or via GEOMETRY VIEWPORT -> Use GEOMETRY PARAMETER to 
enter the numerical values for the scale factor. If desired, also enter the rotation 
around the middle. If you know the world coordinates of the center of the view 
port (this is the best way to make sure the view is the same as in another map), you 
can enter them here.  

 

 A map can be defined as OVERVIEW MAP. Then the frame of the large-scale detail 
map is displayed along with the geometry in the overview map.  

 

Additionally, for very large sale investigation areas it is possible to scale the 
overview map and center the displayed map section in the overview (deactivate 
FIXED MAP VIEWPORT).  

In the map object types select how to format the frame. The object type CURRENT 

MAP SECTION IN OVERVIEW MAP determines how the frame section shall be 
highlighted in the overview map.  
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 Change viewport graphically 

The viewport can be changed graphically. First, use the symbol button 
OVERVIEW to zoom to maximum size. This presents the entire data on screen 

with a black line framing the printed part of the view port.    

To graphically edit the viewport, click the symbol button or select CHANGE 

GEOMETRY VIEPORT from the GEOMETRY VIEWPORT menu.  

Now you can move, zoom and rotate the black frame representing the view port. 
Use the right mouse button to request a menu to change the functionality of the 
mouse. Aside from these options, secondary options use the shift and Ctrl keys. The 
following options are available: 
 

 move – keep left mouse button pressed and move. 

 
zoom - <Shift>- keep left mouse button pressed. Move up=zoom out, 
move down=zoom in.  

 rotate - <Ctrl>- keep left mouse button pressed and move. 

Selection via the right mouse button: 

 

The symbol button remains pressed until the changes to the view port are made 
permanent by clicking it a second time. 

Site View, Cross Section or 3D-View 

Use Edit Map to edit the top view, geometry cross section and wire frame 3D 
model regardless of the license situation with 3D and Cross-Sectional Map. 

Site View Content 

When data is loaded into a map, the default view is the top view (except for Cross-
sectional Noise Map).  

For the site view, you can also generate the following standard settings. To 
edit the settings, open PARAMETER -> SITE MAP SETTINGS, or open it via the 

symbol “settings” (wheel symbol) in the object types.  
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The MINIMUM LINE WIDTH defines the pen thicknesses. Line widths, which for a 
selected scale factor would be smaller than the set minimum size, will be drawn 
with the minimum line width. The MINIMUM TEXT SIZE ensures texts will be 
suppressed when their size falls below the minimum text size when the scale factor 
is increased causing the geo-texts to scale down.  

For displaying texts, choose if texts that are clipped at the border of the map shall 
be totally suppressed, or if clipped texts shall be printed. If you only want complete 
texts to be printed, click the box.  

USE REFERENCE SCALE AS FACTOR FOR LINE WIDTH, HATCH DISTANCES... adjusts the 
spacing of the line width and distance of the hatch lines when the scale of the map 
is increased or decreased (see "Reference Scale" on page 545). If you deactivate 
this setting, the objects are always drawn with the same hatch regardless of the 
ratio of the map scale and hatch reference scale.  

DRAW LINES AND AREA HATCHES AFTER GEO-BITMAP / CONTOUR MAPS shows the 
hatches and lines but not a selected background color without changing the layout 
setting in the object types.  

Geometry Cross Section  

 

A predefined cross section can be presented on screen and can be printed. Choose 
VIEW -> CROSS SECTION -> NEW and mark the cut line with the cursor.  
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For the cross section, you can adjust the following settings under PARAMETER -> 
CROSS SECTION SETTINGS:  

 

The RELIEF HEIGHT [M] is the vertical height of the ground. It is derived from the 
geometry data. Sometimes flat situations look better if the relief height is 
artificially increased. For grid noise maps, it is possible that the ground doesn’t 
cover the lowest row of grid points. Increasing the relief height helps in this 
situation.  

If point objects are contained in the cross section cutting line, the parameter 
MAXIMUM POINT DISTANCE FROM CROSS SECTION defines the distance in [m] from 
the cutting line where the point object is displayed (as a projection).   

The VERTICAL EXAGGERATION FACTOR controls the ratio of the vertical to the 
horizontal scales (stretch of the height). 

When processing a vertical grid noise map, you cannot generate a new cross 
section. You can, however, toggle between the cross-section display and the site 
view and you can modify the cross-section parameters. 

3D-Wire Frame Model 

Even without a license for 3D Graphics, you can create a rudimentary view of your 
data as a 3D wire frame model.  

Double click on the map or press the right mouse button -> EDIT CONTENT, and VIEW 

-> WIRE FRAME MODEL. You can move freely in the entire study area. Use the right 
mouse button to open a menu with the following movement options: 
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“Move” is active by default. The modes used the most, such as “change distance” 
and “rotate + tilt,” are also available using the left mouse button + the Shift key and 
Ctrl key. The mouse cursor shows the active mode. See also "3D Graphics" on page 
619. 

 

The red, blue and green lines indicate the x, y, and z axis and their intersection with 
the scene. The scene rotates around the green line (z-axis). The intersection of the 
coordinate lines is the center for changes in the distance. 

Choose the borderline color and whether to draw an object as a 3D-wire frame 
model under the tab 3D in the map object types.  

Show Child Boxes 

You can show the child boxes related to the map (text boxes, scales…) within EDIT 

MAP. Activate PARAMETERS -> SHOW CHILD BOXES to accurately move and zoom the 
view port to fit on the map with the child boxes. The child boxes cannot be 
modified here. To modify them, you must return to the graphics main menu. 

Update Results and Geometry 

After you have recalculated results or have changed the geometry files you can 
update the map data without opening the file selection manager: FILE -> UPDATE 

MAP DATA or Ctrl+ R. 

For huge amounts of data, it can take a while to reload all data for the entire sheet, 
therefore with Alt+ R you can force the program to only reload the data that have 
changed. 
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Changes in the loading settings are done in the file selection manager. Right click 
on one of the files in the map and change the desired setting, e.g. time slice or text 
attributes.  

Object Type File 

The object type file contains the entire layout information for all objects to be 
drawn (geometry-object types such as buildings and roads, result types such as grid 
noise map and façade noise map, and external data such as geometry bitmaps). 
Layouts for all object types are included in SoundPLAN, but you can customize and 
store them as your own company layouts. The object types defined in the projects 
object type file are not only used in the graphics but also control the on-screen 
appearance of the data in the modules Wall Design and Expert System for Industrial 
Noise. 

 

The layout possibilities for the various object types are described in the following 
sections. 

Administration and Access of the Object Types 

When you install SoundPLAN, a global object type file is automatically installed with 
the file name: objects.got. This file is duplicated as the project-object types for each 
new project and is stored in the project.  

For each map you create, the project object types of all objects in the map are 
included as the map-object types. If you include additional data later on, the object 
map-types are supplemented to contain layout information for all object types. All 
object type files can be edited individually.   
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The advantages of this structure are as follows: 

• Modifications delivered with new versions of SoundPLAN do not influence 
the layout of existing projects and maps. 

• If a client wishes to have a special layout for their particular project, the 
settings made for this client do not automatically become the default setting 
for all projects.   

• Layout changes and options, you want to make permanent can be moved to 
the global object types using Drag & Drop.  

• As the map-object types only contain the objects found in the map, the map 
object types are probably smaller than the global or project variant. 

Hint: Changes in an existing map must be made in the map-object types. Changing 
the project-object type setup or the global-object type setup here has no influence. 

Some object types belong to certain SoundPLAN modules, so they are only included 
in the object type file if you have a license for the particular module. For example, 
the object types for point, line and area sources are not available if you do not have 
a license for Industrial Noise Propagation.  

Open the map-object types in the current map via the right mouse button menu or 
via "Map Object Types" in the PARAMETER -> MAP OBJECT TYPES menu. The project-
object types you can process in the main graphics level under PARAMETER -> OBJECT 
TYPES IN PROJECT.  

In the Geo-Database open the project object types with a click on the symbol EDIT 

OBJECT TYPE when you select an graphics object type via EDIT -> GRAPHICS OBJECT 

TYPE.  

Transfer the layout to other object type files, maps and sheets 

If you have customized the layout of a map’s object types and want to use it for the 
entire project or for all projects, you can move the customized object types from 
the map-object types to the project-object types or to the global object types. To 
do this, open the map-object types with the right mouse button. 

If you want to transfer from or to another object type file open the project 
object types, the global object types or the project object types from another 

project with the open button.  

When you have opened two object type files open, you can use Drag&Drop or 
the button TAKE OVER LAYOUT to copy the layout of a selected (one or 

multiple) object type to a secondary object type file. The layout is only copied if the 
type is already present in the secondary layout type file. If you want to copy the 
layout even for layout types that do not have an equivalent in the secondary layout 
type file, you need to hold the shift key while dragging the layout types to the 
second file. In this case the new types will be generated in the secondary layout 
type file. 
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If only a single object type file is opened, the layout of marked object types will be 
transferred to the object type file of the next higher hierarchy (from plan to project 
or from project to the global settings).  

Transferring the layout of object types to other sheets in the project: Open the 
sheet tree (F6). Open the plan object type file that you want to use as the master, 
click on individual object types or entire branches (using the shift and Ctrl keys) to 
mark them. Now click on all sheets in the sheet tree that you want to transfer the 
layout to.  

 
The layout of the object type road and all object types in the branch „Environment“ are to be 
transferred to the marked sheets on the left 

With the button TAKE OVER IN SHEET TREE, the layout is transferred to the 
object types of the sheets if the object type is included in the particular sheet.  

In the map object types all objects not used or not included in the legend will be 
displayed gray and cursive.  

 

With this red DELETE CROSS these obsolete object types can be deleted from 
the plan object types (except for sub-objects such as middle dividers and 

bridges). 
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Reference Scale 

Use the reference scale to assign sizes in [mm] to items referenced in the map 
layout. This reference scale ensures hatch patterns have the correct size and lines 
have the correct thickness. When the map is enlarged to the world-scale factor, 
lines, texts and patterns are scaled down. When the world-scale is reduced, lines, 
texts and patterns are enlarged. 

The reference scale can also be used to increase or decrease all line thicknesses, 
patterns and hatches.   

If you want the entries in [mm] maintained even when they are scaled up or down, 
deactivate the reference scale in the object types clicking on the settings wheel and 
removing the check from the box USE REFERENCE SCALE AS FACTOR FOR LINE WIDTH, 
HATCH DISTANCE… 

Site map / geometry data 
After moving a situation or a geo-file to the right side of the file selection box, you 
must decide if the new geometry object types should be hosted in a new legend or 
if the existing map legend should be used and amended.  

An existing legend will only be present if you are developing the current map from 
a template or if you are reloading data. The options are only relevant for these two 
situations. If this is not the case, do not change the default settings. 

 

The option ONLY AMEND OBJECT TYPES THAT ARE NOT ALREADY CONTAINED IN THE 

MAP causes only object types to be included that are now in the map but were not 
in the map prior to reloading (in other words, the newly created ones). A new plan 
will not insert a legend if the check box „amend“ is deactivated or if no object type 
has the box „Show in legend“ clicked. 

AMEND LEGEND WITH ALL OBJECT TYPES FOUND IN THE MAP causes the graphics to poll 
the entire geometry for object types not already contained in the legend. Old and 
new object types will be included. 

 Users with a license for the Cartography module can load properties as text into 
the map.  
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If you want to display properties of objects as text for example, stationing a 
reference kilometer of a noise protection wall load these by double clicking, using 
Drag & Drop or by clicking the arrow between the file windows. The properties as 
text are formatted via the object types. See "  Display properties as text ” (page 
617)". 

The attributes are displayed separately for all object types in the project, therefore 
you can load other attributes for own generated object types.  

The loaded geometry data are customized with the map-object types. SoundPLAN 
delivers a basic layout for all standard objects. You can use these or adapt them to 
your company drawing style. All object types you enter in the Geo-Database have a 
corresponding entry in the object type file. The map object types are only a subset 
of the project-object types. As the settings in this class of object types are very 
similar, we will describe only the difference between a point, line and area type 
object type, the geometry-text and a composite object. Settings made with the 
Cartography module have their own tabs. The tab 3D graphics is always present as 
it is possible to control the object layout for the wire frame model.   

The base settings of each object type determine if the object shall be drawn in the 
site map and the cross-sectional map, and what name the object type will have in 
the legend. Defining the drawing sequence determines the “stacking order” of 
objects in the map. The larger the number in the DRAWING SEQUENCE field, the later 
the object will be drawn. The larger number will never be overwritten.  
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Point Type Object Types 

.  

You control the layout of point type objects via the base settings. If you have the 
Cartography module, the screen looks a little bit different; the selection of the 
point symbol is under the Tab Cartography. Enter the object size in [mm] or [m]. If 
the size is [mm], the symbol is drawn in [mm] regardless of the scale of the 
drawing. If [m] is chosen, the symbol will always have the same ratio with other 
objects, but it will zoom up and down. To determine the size, an imaginary 
rectangle is drawn around the symbol. The longest side of this rectangle defines the 
symbol size. 

Click SYMBOL to select a different symbol. Customize it further by selecting the 
color for the entire symbol. 

 In the tab Cartography you can customize point type objects even more by 
combining multiple point type objects and including texts and bitmaps. Depending 
on the drawing element (symbol, text, bitmap), additional layout controls are 
available. 
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In this example, two signs and a text were combined to form the parking lot 
symbol. In the preview under "site map" you will see the part of the symbol 
highlighted in the tree, and to the right you see the entire symbol.  

 Symbol definition 

Click the asterisk to insert a symbol and select a symbol from the symbol 
selection matrix. 

 

In the selection list, choose if you want to see all the symbols or only the symbols 
of a selection list. SoundPLAN provides a symbol library which you can amend with 
your own symbols created in the symbol editor. See "SoundPLAN Symbols," for 
details.  

Symbols can be comprised of lines and/or areas. FILL COLOR, BORDER COLOR, LINE 

COLOR and LINE WIDTH are the tools used to create symbols. A check box defines 
what is to be drawn and what is not to be drawn. Use the double arrow behind the 
line color fields to correct line connections and line ends. 

For each symbol, enter the SIZE, the DISPLACEMENT in x- and y- direction and the 
RATIO between width and height. Symbols can have different appearances without 
creating separate symbols.  

Unsymmetrical symbols can be rotated by defining the ANGLE. If the symbol should 
have a fixed orientation in the world-coordinate system (i.e., a north arrow), the 
symbol must be rotated when the entire map is rotated. To ensure this happens, 
click the box ADJUST TO ROTATION.  
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Texts can also be used to create composite symbols such as the parking lot 
symbol or a symbol depicting the area usage. 

Assign the size in [mm] or in [m] to the text and select a font. The box ADJUST TO 

ROTATION forces a symbol to be drawn with a fixed direction referenced to the 
axis’s of the world coordinate system. When the map is rotated, the symbol moves 
with it. This is useful for the north arrow.  

Symbols available as graphics (as files of the type *.bmp, *.jpg, *.gif, *.tif, 
*.png, *.wmf , *.emf…) can be integrated into symbols for point type objects. 

Select if the graphics is available in bitmap format or as a Windows metafile, and 
then choose the file. 

If the file you selected is not present in the current project, SoundPLAN asks if it 
should copy the file, move it to the project or only generate a link to the file.  

Enter the SIZE and click the TRANSPARENT box if you do not want to have the 
background shown.   

To delete individual symbol components of composite symbols, highlight 
them and click the X-button.  

Line Type Object Types 

 

Enter the line thickness and color.  

 Line definition 

In the Cartography module under the tab base settings, you can request the 
appearance of line type objects. They can be drawn by simply connecting the 
coordinates or smoothed using an exact or smooth Bezier line. The exact Bezier line 
will pass through the entered coordinates whereas the coordinates in the smooth 
Bezier line are subject to an interpolation.  
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Left shows "no Bezier," the middle, "exact Bezier," and the right, "smooth Bezier." 

Under the Cartography tab, you can further customize lines by sandwiching 
multiple lines or generating chains of lines and symbols. When Cartography settings 
are present, line thickness and color are not part of the base settings.  

 

Customize the layout of lines, selecting from different LINE TYPES (solid, dashed, 
pointed or dash point…).  

LINE POSITION: The line can be drawn directly on the digitized line and also 
bordering to the left/right or in a defined spacing. The border of areas can be set to 
be outside the area or included in the area. Special effects are possible when you 
define a second (border) line with different colors, line width, type and position 
(example on the left below). For area borders of adjacent areas, the quality 
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improves when the lines are remaining completely inside the area (example on the 
right below). 

       

 

Enter the line thickness and color, and for non-solid lines, the PATTERN SIZE (pattern 
length includes the space between the line elements) and the PATTERN RATIO.  

 

For dash point lines, the points are always placed in the middle of the space 
between the patterns.  

For LINE CONNECTIONS and the END OF THE LINE, select from the options shown. 

A line object can be comprised of multiple lines. To show a railway, for 
example, use a thick black line and place a thinner, dashed white line on top. 

 

Hint: Lines are drawn in the sequence listed in the “components of the objects” 
box. If you need to change the sequence, simply Drag & Drop the components 
where you need them. 
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Use the symbol chains to display an unlimited number and type of symbols 
along the line. The line itself does not have to be displayed. 

 

The symbol chains must contain at least one symbol. In the symbol chain shown 
above, for example, two symbols represent the line; one is the arrow depicting the 
migration and the other is a toad depicting the subject of the migration. See 
“Symbol definition,” and “Line definition”. 

Select the symbol spacing in the symbol chain of the object component chain.  

 

You have 3 possibilities to position the symbols along the line: 

• in a defined distance  

• at the coordinates of the line  

• with 2 symbols per line section 

With all 3 possibilities it is possible to customize the symbols along the line. 

For the option ALIGN SYMBOLS EQUIDISTANT define the spacing DISTANCE BETWEEN 

SYMBOLS and a DISPLACEMENT. Both values are entered as a factor referring to the 
symbol size.  

For the option SYMBOLS AT THE COORDINATES you can define the position of the 
symbol using the distance of the symbols from the line point or the line 
segmenting. If you divide the line segments in two parts, the symbol is displayed in 
the middle of the line segment; with four parts after a quarter of the line segment. 
If the distance to the line point is 0, you can determine, whether you want to 
display a symbol at the last a line coordinate.  

With the option of having TWO SYMBOLS AT THE LINE ENDS, at the beginning of the 
line and at the end of the line each a symbol is displayed. With a line segmentation 
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of 4 the symbols are displaced ¼ of the line ends. The sine segmentation 0 positions 
the symbols directly at the line ends.  

Use ADJUST SYMBOL TO LINE to select if the symbols are rotated to conform to the 
direction of the line or if the symbols are always oriented in a fixed direction.  

 

SYMBOL AT LAST POINT displays a symbol at the last line point, even if the entered 
distance cannot be kept.  

For all line types, you can insert a 3D wall that is only visible in the 3D-
graphics (including the wire frame variant), so that a line can be placed at a 

user selected height. Ensure that this object type is also marked for printing under 
the tab 3D-graphics.  

To delete individual symbol components of composite symbols, highlight 
them and click the X-button.   

Area Object Types 

For area type objects, define fill color, borderline and hatch separately from each 
other. 
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Hatch Patterns 

To select a hatch pattern, click on the double arrow and select one from the 
pattern list. Click OK to confirm the selection.  

 

When the box FIT TO FIRST EDGE is marked, the pattern will be oriented on a line 
going through these first two coordinates.  

 Area Definition 

Cartography allows you to define your own hatch patterns and fill areas using 
customized symbol fills. 

Standard hatches with fill color and border color are best defined in the base 
settings. When you define more complex definitions under the tab Cartography, 
the controls in the base settings are deactivated for this object.  

 

In addition to the standard hatches, you can also generate composite 
hatches. This can be a useful tool if you want to display hatches with 

different colors. Define the line type (see "  Line definition," page 549), the 
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parameters for angle, spacing, displacement (sideways offset) and the 
displacement (offset of the beginning of the line). 

 

Use DISPLACE to generate a pattern of dashed and other non-solid lines: 

Displace = 0,0   Displace = 0,5 

      

Use the pattern definition  to assign any shape and any number of symbols to 
fill the shape. The shape can also have a background fill color. 

The pattern must contain at least one symbol. In the example above, the fill of the 
area used symbols for conifer and deciduous trees. You define the fill pattern. See 
“  Symbol definition,” page 548. 

To define the symbol spacing, click on the pattern in the component list. 

 

For the POINT SIZE, first enter the size from the symbol definition. This field may 
have to be customized if you have chains comprised of multiple symbols. For 
multiple symbols, the point size is the pattern size (i.e. the size of all symbols 
together).  

DISTANCE and DISPLACEMENT of the symbols are defined in [mm].  

Use DISPLACE to offset individual symbol chains. 

Use the X in the symbol bar to delete individual object components of object 
definitions.  
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Object Type Geometry Text 

 

The layout of geometry texts was defined in the Geo-Database. All settings from 
the Geo-Database (color, text type and font) are used in the texts of the graphics. 
Only the size can change. Enter the size as a FACTOR OF GEODB SIZE.  

Text backgrounds can be completely clipped as in the left picture, so the 
background is white, or the clipping can be confined to lines and symbols as in the 
right picture.  

  

Select the options in the settings with the wheel symbol in the object types.  

Hint: If texts included in the geometry data are not displayed, check the site map 
settings in the object types with the wheel symbol. Texts smaller than the 
minimum text size are suppressed, so check the minimum text size and make 
changes as needed. 

If you do not have Cartography, the general layout for the object type text is 
derived from the Geo-Database. 

 Cartography has the option to control the size of the text in [m] (of the drawing) 
or in [mm] (of world coordinates). You can also generate your own text object 
types and format them in the graphics. After defining your own text object type, 
assign it to the object in the Geo-Database.  

For the display of geometry texts, you can select if you want to enter the font and 
position of the text reference marker like in the Geo-Database. 

You can also highlight texts and assign a background color.  
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Use TEXT CLIPPING to clip the text background from the geometry. One of the text 
clipping options in SETTINGS -> SITE MAP must be activated.  

The box DISPLAY FRAME creates a frame around the text with the frame color and 
width of your choice. The frame width can be defined for all four individual sides as 
a factor of the text size or in [mm].  

Composite Object Types 

Some object types consist of multiple sub-object types (i.e. roads, railways or noise 
protection walls). The layouts of all sub-object types are defined independently of 
each other. The user also determines which sub-object type will be displayed in the 
map and included in the legend.  

 

Each object type (with all sub-object types) is printed in the same output sequence; 
the only distinction is the order the object is read from the file. Files read first will 
be printed first, which allows you to control the drawing sequence of objects within 
the same object type. For example, you can use the sequence of loading and 
drawing to influence how the intersection is drawn and which road is drawn last. If 
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you want to print a bridge with the noise protection walls attached to the sides as 
in the picture below to the right, store both objects in separate Geo-Files and load 
them in the correct sequence.  

   

In the picture to the left, road 1 was loaded first, with the result that the road 
intersects the bridge, but the road is actually underneath the bridge. In the picture 
to the right, road 2 was loaded first and the output is correct. 

DIN 45682 – Thematic maps for noise protection 
assessment (Germany) 

 

The presentation of the bridge abutment was added for the presentation according 
to DIN 45682. Depending on the width of the bridge the bridge abutments are 
entered as a new sub-object for bridges in roads and railway tracks. In the legend 
the bridge is presented in combination with the bridge abutment and the noise 
protection wall on the bridge. For tunnel openings and the location of traffic signals 
new objects are inserted. The traffic light still must be positioned by hand on the 
map.  

To help with the layout definitions, the object type setup has a “DIN” button 
to set the object types to be conform with the DIN 45682. In the sheet object 

types only the object types present in the sheet will be converted. 

Presentation of Area-type Results 
Area-type data types are: 

• Grid Noise Map 

• Meshed Noise Map 

• Cross-sectional Grid Noise Map  
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• DGM (Digital Ground (or terrain) Model) 

• Measurement Map 

• Grid Operations (for example: Difference map) 

• Triangle Operations (for example: Difference map) 

• Area Maps (Conflict Map) 

• Contour Map Aircraft Noise 

Select the needed FILE TYPE in the file selection. Depending on the type of results 
selected, additional information may be requested at loading time.  

Result requests for area-type calculations 

The calculation results are calculated simultaneously for all time slices and all air 
pollution components and are hosted in the same file. Therefore, the program 
requires information concerning which time slice or pollution component you want 
to depict in the map and which color scale to use.  

For a new sheet, you can select between a new color scale, which is generated 
from the value range in the result, scales delivered with the software (e.g. colored 
scales according to EU, French or US requirements) or your own scales, stored in 
the Globdata folder.  When you are working with a template the scale scales stored 
in the template is select as a default.  

As an alternative, you can present the terrain elevations of the model that was the 
basis of the noise simulation via a color scale. In this case, select a new color scale 
in order to represent the value range correctly. The general data entry for scale 
related parameters is similar, but details vary.  

 
Parameters for loading area type results – Grid Noise Map shown 

Click the double arrow to process the scale at this location or accept the values of 
the automatically generated scale and customize it later using "Edit content" via 
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the right mouse button. Editing scales is described in section “Color scale (page 
520)”. 

Press OK to confirm the selection. Click OK again to leave the file selection. If you 
want to modify loaded data (time slot, pollutant or scale), open the file selection 
again and right click the result file selection. The time slice, pollutant and scale 
selection will open.  

The EU area evaluation is described on page 604 [NMP Toolbox]. 

Change loaded data 

If you want to change the loaded data (time slice, result, or color scale) call the file 
selection manager again and click on the result file with the right mouse button. 
The result request will be opened. 

Show results for individual groups or frequencies 

For Grid Noise Maps, select from the selection list, whether you want to display the 
sum level or an individual frequency or group.  

For Meshed Noise Maps calculated frequency by frequency, you can select an 
individual frequency or a frequency band in addition to the sum level. The detailed 
result tables must have been stored in the calculation run settings.  

 

Load DGM 

For DGMs, you can optionally clip triangles out of a selected area or calculation 
area, e.g. to filter border triangles that are very narrow and do not represent the 
geometry. Select a Geo-File containing the area.  



SoundPLAN Manual 8.1 
Graphics 

Presentation of Area-type Results  Page •  561/793 

10 

 

Unfiltered: 

 

Edge triangles filtered using a selected area:  

 

Difference Grid Maps 

Difference maps and other mathematical calculations are created using the file 
type Grid Operations. (see "File Operations (page 605)"). 

Object types for area-type results 

The layout of area type results can be customized using the settings found in the 
object type file. Each file type has a primary object type. 
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SHOW CONTOUR LINES is always active unless you want to display the grid or the 
triangles. If it is deactivated, neither the main interval nor the mid interval nor 
additional intervals will produce contour lines or fills. The contour lines can be 
drawn at different positions, see "  Line definition" (page 549). 

The FILTER VALUE defines the bandwidth where the contour points are interpolated, 
resulting in a smoothing of the contour lines.    

  

The comparison above shows that a filter bandwidth of 1 meter is not correct, 
while the result with a filter bandwidth of 0.1 meters is almost the same as the 
unfiltered contours. In order to not falsify the results, the filter width is limited to 
1/10 of the grid size. 

For the display of the noise contour lines it is possible to DELETE CONTOUR AREAS 

SMALLER THAN X [M²] in order to omit not relevant small color changes.  

BEZIER TYPE determines the display quality of the contour lines. The difference 
between the exact and the smooth Bezier curve is that the contour lines move 
through the base points for the exact Bezier and the base points for the smooth 
Bezier curves are interpolated.  
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Although the exact Bezier curve moves through the base points, the curve may be 
subject to big fluctuations causing the smoothed Bezier curve to describe the 
nature of the contour line more correctly. If the quality is insufficient, reduce the 
grid spacing!  

The OUTPUT SEQUENCE for contour lines can be set independently from the main 
object type. Additionally, the optional contour line texts can be set so they are 
always printed on top of all other objects. Forcing the contour line labels to be 
printed over the other objects means you do not have to reset the output 
sequence.  

The EDGE LINE (border of the calculation area) is not a contour line, so you can 
choose if you want to display it and choose which line color and width it should 
have. 

If you want to display the grid (only grid noise), activate SHOW GRIDS and deactivate 
the SHOW CONTOUR LINES. You can have the color of the grid cells interpolated 
between the scale colors by checking the box with the label FLUID SCALE. 

The values of the base grid/triangulation can be presented by marking VALUES AS 

TEXT. This is not a sensible presentation option, but it can be very helpful to check 
the model results. With the checkbox in front of the font, you can force the 
program to automatically fit the font size to the size of the grid cell. 
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Edit Map includes an option to edit the grid values. Select EDIT GRID VALUES from 
the selection list.  

 

The entered corrections will be lost with a new calculation or if the grid file is not 
stored. 

Definition of Intervals 

 

FILL CONTOUR AREAS fills the areas between the contour lines with the scale color. 
You determine if the contour lines themselves are printed and in which color and 
with which line width. Users with Cartography can also select the line type (solid, 
dashed, dotted ...). 

The sub-objects for the main, mid and additional intervals determine if only the 
intervals present in the scale will be shown or these plus other intervals. The mid 
interval splits the base intervals in half. The additional interval generates an 
interval for each dB value, but different spacing is possible. FILL CONTOUR AREAS for 
mid and additional intervals (enter STEP SIZE IN SCALE UNIT for the additional 
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intervals) interpolates the color between the colors of the scale. This allows you to 
generate a color sequence showing each dB step in a consistent fashion.  

 

 

With extra intervals (example in 3D) 

 

Without extra intervals (example in 3D) 

If the contour lines are output in scale color, you can request that the colors are 
not the fill scale colors, but rather the colors of discrete values. See "Designing the 
scale (page 524)".  

The settings for mean and additional intervals are used for the contour line export 
as the distance between the contour lines. 

If a DGM in the graphic is supposed to be shown with elevation contours, you now 
can use Main, Middle and intermediate intervals that are also depicted in the 
legend. 
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Label Contour Lines 

 

Activate the labels for the contour values for area type results in the sub-object 
types.  

Activate the SHOW button and select the DISTANCE between the text labels.  

 

With the switch ALIGN TO CONTOUR LINE the text labels can be either aligned with 
the contour line or aligned with the sheet. 

Via the DISPLACEMENT of the text by 1/2, 1/3 or 1/4 of the text label spacing, it is 
possible to avoid congestion of labels.  

Optionally set the text background or text frame in scale color: 

           

 Under the Cartography tab, further customize the objects of the contour line 
text labels (contour line, text, text background).  
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Generate a main and secondary text to the contour line labels. Use ALWAYS ALLIGN 

TO TOP to select how the text should be position on the contour lines. When it is 
marked, the graphic will look like the picture to the left. 

 

  

If the check box on the right side of the decimal-values is active, decimals are only 
printed if needed. For example, using a color scale with intervals of 2.5 dB, the 47.5 
dB contour will have the digit after the decimal, the 50 dB contour will not.  

The contour label texts themselves can be processed further in "Edit map content." 
Select MOVE CONTOUR LINE TEXTS from the selection list.  

When the cursor nears a contour line text, its shape changes from + to an arrow. 
Use the arrow to move the text with the left mouse button or delete it. Use the 
right mouse button to generate additional contour line labels at different locations. 

The texts are inserted horizontally and maintain the existing angle when moved. 
Use Ctrl + left mouse button to rotate the texts to a different angle.  

Hint: SoundPLAN remembers the position of contour line texts edited manually. 
Therefore, the program asks if you want to retain the text position when you 
modify the contour line spacing.  

Limit Contour Lines 

For the area type presentation, it is possible to draw the noise limit contour line 
independent of the scale. Simply activate the result-object-type in the sub-object 
LIMIT LINE and define the color, width and value of the limit line.  
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Just as with the scale dependent contour lines, the noise limits can be assigned text 
labels indicating the dB value. 

 The Cartography module allows you to duplicate object types and sub-object-
types creating multiple noise limit lines in the same map.  

Drawing Grid Maps and Meshed Maps in geometry 
bitmap 

You have the option to calculate the color value of Grid maps and Meshed Maps 
pixel by pixel in an already loaded bitmap. The prerequisite for this is that the 
geometry bitmap is exceeding the size of the calculation area, as this procedure 
would clip the grid or meshed map with the bitmap. 

In the object type of grid and meshed maps you can find 2 options to calculate the 
color values of pixels: 

• transparent 

• shaded 

 

For TRANSPARENT all pixels are calculated in a way that take the color of the 
SoundPLAN result map and add a bit of white color before adding the color value of 
the bitmap. This way the noise map is a bit pastel and the bitmap is bolder. The 
resulting map seems transparent. The best results seem to be attained if the 
contour lines are output with a higher sequence number than the noise map.  

 

For SHADED the colors of the resulting noise map are presented darker than the 
original. 
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For both settings you can also select if the color component of the bitmap is to be 
used directly or first converted into a gray scale value.  

Resulting map and geometry bitmap are only processed when necessary for 
example for the first drawing or when the settings or scale of the noise map are 
altered. This accelerates the output, especially for big grid maps. If for whatever 
reason the maps were altered but the changes are not shown, use the refresh 
button to force a re-processing of the map. 

TRANSPARENT is a good option for full covering darker bitmaps such as aerial 
photography. SHADED is well suited for more symbolic maps that contain in 
addition to lines only pastel tones (e.g. light gray for constructed areas or light 
green for forest and meadow). As another option it is also possible to BRIGHTEN the 
bitmap or increase the CONTRAST, this is done with two sliders in the geometry 
bitmap object settings.  

 

 
Transparent presentation of the contour areas –contour lines are drawn with a higher order 
on top of the areas 
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Shaded presentation of the contour areas 

 Presentation of DGM with continuous color flow / 
elevation lines 

[Module Cartography] For the DGM display, a color gradient can be defined in 2D 
and in 3D. This applies to both the Geo-Database and the Graphics. 

 

Call the map object types via right mouse button -> MAP OBJECT TYPES. Click on the 
object type “Digital Ground Model” -> sub object type “Triangles”. In the tab base 
settings, you can define a second color for the lowest interval.  

 

Check mark USE INTERVAL SIZE and define the interval size in meter. SoundPLAN 
calculates the number of intervals on the basis of the lowest and highest elevation 
and interpolates the colors.  
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You can choose the same setting for 3D in the tab index card 3D-Graphics. Interval 
size and the lower interval color are coupled between 2D and 3D view.  

Additionally, you can display the DGM AS ELEVATION LINES. You will find this setting 
in the main object type „Digital ground model“, tab index card Base settings.  

 

Define the step size in the sub object type „Additional intervals“. The step size 10 
displays an elevation line every 10 m in the layout of the contour line in the 
additional intervals. An elevation line in the layout of the contour line in the main 
interval is displayed all 10 times of the step size (here every 100 m). The contour 
line of the mid interval can also be displayed in a separate layout. 

 

 Measurement map 

Measurement values present as an ASCII text file (file extension *.txt) can be 
displayed as measurement map. Cartesian coordinates as well as polar data can be 
processed.    

Select the file type MEASUREMENT MAP and activate the ASCII file. SoundPLAN 
reads part of the file and shows the structure of the file in a screen so you can 
define the import filter and declare which column shall have which meaning: 
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Enter the number of header lines. If there aren’t any, set the value to 0. 

The individual columns are listed one below the other. Activate the column and use 
the double arrow to connect it to one of the data slots in the SoundPLAN 
measurement array. You could also enter the column number in the measurement 
array as an alternative. Column number 0 means that this value is not present. 

For point data, assign at least the fields X POSITION, FIRST VALUE and LAST VALUE.  

SoundPLAN needs different values for data present in the polar system. For this, 
assign at least the fields ANGLE POSITION, DISTANCE POSITION and FIRST VALUE and 
LAST VALUE. Additionally, you can enter the coordinates of the center. In order to 
decipher the coordinate transformation, SoundPLAN needs to know the direction 
of the zero angle and if the angles are rotating around the center in a 
mathematically correct (counter clockwise) direction. For SoundPLAN, the direction 
of 0° is equivalent with the positive X-axis, or east. In case the definition of 0° in 
your data differs from this definition, enter the angular difference. For example, 
enter 90° if the coordinate system is mathematically positive and 0° points north. 
For the negative Y-axis, enter the offset as –90°. 

Target File 

SoundPLAN automatically creates a *.PLI and a *.TRX file with the file name taken 
from the import file. The *.PLI file contains the point list and the assigned values. 
The *.TRX file contains the triangulation of the measurement data. Open the PLI 
file, if you want to re-open the measurement file or need to do mathematical 
operations with the measurement data.  
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Contour Line and Grid Value Export 

Grid values and/or contour lines in the area type presentation can be exported to 
various file formats:  

• ASCII (grid values and contours) 

• DXF (grid values and contours) 

• ESRI ArcView Shapefile (grid values and contours) 

• CARD/1 (contours) 

• Contour lines as kml 

• SoundPLAN Geo-File – elevation lines / poly-lines (contours) 

Some of the export options are only present if that particular export type is 
licensed. 

To subdivide the contour lines in smaller sections than defined in the color scale 
settings, enter the desired distance in the map object types for the ADDITIONAL 

INTERVALS.  

Open Edit Map (double click on the map or right click -> EDIT CONTENTS) and then 
open the export menu via EDIT -> EXPORT OF GRID VALUES or EDIT -> EXPORT OF 

CONTOUR LINES. 

Enter the path, the export type and the file name. Depending on the export type 
and file type, different export settings are displayed and requested.  

  

Example: Export settings in ASCII-export 

When exporting grids to DXF-files, the exported values always represent the time 
slice selected for the map display. For ASCII and SHP export, you can choose to 
either export the displayed values or the values of all time slices. When you select 
EXPORT ALL VALUES OF THE GRID FILE, you can also export the elevation of the 
receivers (EXPORT GROUND ELEVATION). For the ASCII export, also enter the column 
separator character.  
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For contour line export, the filter value and Bezier type is requested. This setting 
will greatly influence the size of the export file. The smooth Bezier type will greatly 
inflate the number of exported points. Additionally, the parameter STEP SIZE in [m] 
will further influence the number of exported points. 

Contour lines can be exported as areas or individual lines. Exporting to SoundPLAN 
elevation lines or poly lines using the setting "area" is not sensible. 

For the export of grids and contour lines you can transform the data into another 
coordinate / reference system, see "Transformation between coordinate systems 
(page 175)". 

 

 Export of contour lines as kml: [Cartography module]. In Edit Map open EDIT -> 

CONTOUR LINE EXPORT. The transparency [%] can be added as an additional 
parameter when exporting contour bands to your kml Viewer. Additionally, select if 
you also want to export the border lines and the border line width. 

 

For the presentation of contour lines in a kml viewer only the contour type BAND is 
sensible. 
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In the kml viewer the appropriate interval is presented in a brighter color when you 
move the mouse over the contour line. With a mouse click in a contour line band, 
the interval of dB is shown.  

  

Export triangles 

For DGMs and Meshed Noise Maps the points of the triangulation (TRIANGLE 

POINTS) can be exported. Moreover, you can export the results AS GRID. Enter the 
grid size for this option. The values of the grid points are interpolated from the 
triangle points of the triangulation.   

DGMs can additionally be exported in the ITF-format. ITF (Intermediate TIN 
Format) is an exchange format for DGMs, described in the internet.  

Presentation of the Facade Noise Map 
The following results can be presented as a Facade Noise Map with the Facade 
Noise Map license: 

• Calculation type Facade Noise Map 

• Calculation type Single Receivers 

• Spreadsheet (receiver tables) 

Result Requests in the Facade Noise Map 

After selecting one of the results, additional parameters are requested for display 
and layout: 
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Select the time slice to be displayed (day, night ...) and choose for which floors the 
Façade Noise Map shall be drawn. You can select a particular floor, the maximum / 
minimum level per receiver or the top floor of each building. These settings are 
valid in the site map; in the 3D-view all floors are presented.  

The noise assessment used in the calculation is needed in order to display receivers 
with conflicts (depending on the setting in the object-type Facade Noise Map) and 
for the conflict map of receivers with limits violations. In the field CONFLICT FROM, 
select the threshold noise level from which all receivers are to be counted as 
conflict receivers. For example, a value of -5 dB will count receivers as having a 
conflict even if the noise level is 5 dB below the noise limit.  

In “load options,” select if receivers representing a section of the facade smaller 
than xx meters shall be loaded. Suppressing very small facade sections will increase 
the readability of the map. If the calculation settings enabled multiple receivers per 
façade, it is possible to suppress all but the receiver with the highest noise level per 
facade (LOAD ONLY THE POINT WITH THE HIGHEST LEVEL PER FAÇADE).   

Use the double arrow to process the scale at this time or accept the default 
settings and customize the scale later by requesting “edit content” via the right 
mouse menu. Customizing scales is described on page 492.  

Click OK to return to the graphics display. 
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Load Spreadsheet as Facade Noise Map 

 

When a Spreadsheet is loaded as a Facade Noise Map, three additional parameters 
can be entered. A column with Boolean values can be loaded as BOOLEAN COLUMN 

FOR IDENTIFICATION AS CONFLICT POINT. This column will be used instead of the 
noise level to determine if a receiver has a conflict. The conflict can also be made 
dependent on a column of the spreadsheet containing the information of 
“significant increase” of noise levels. Use the TEXT COLUMN FOR OWN TEXTS IN THE 

FAÇADE POINTS to insert your own text for the facade points. All text columns 
present in the Spreadsheet are offered as an option. In the object type Facade 
Noise Map, select the text "selected column from spreadsheet". You can also assign 
own texts to the building reference points (TEXT COLUMN FOR TEXT IN THE BUILDING 

REFERENCE POINTS). 

The load options are omitted because potential filters (receivers on facades smaller 
than x meters) are already executed in the Spreadsheet.   

Show results for individual groups 

For Façade Noise Maps select from the selection list, whether you want to display 
the sum level or an individual group. For a Spreadsheet receiver table, select the 
appropriate column from the level column selection list.  

Difference Facade Noise Maps 

Difference maps and other mathematical calculations are created using the file 
type Façade Noise Map Operations. (see "File Operations (page 605)"). 
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Object Type Facade Noise Map 

 

Various options are available for the Facade Noise Map layout. The default setting 
displays all receivers as hexagons filled with a color from the color scale. Receivers 
exceeding the noise limit have a black border. You can customize these setting to 
suit your needs.  

In order to use the same values in the table type printout as in the graphics, the 
noise values can be rounded the same way: 

normal 
round up 
truncate 
RLS-90  

The rounding is always done for the decimal position requested.  

In addition to, or instead of the color coding, the values can be presented as a text 
for example to get a reference between spreadsheet and graphics:  

• Level value 

• Conflict value 

• Scale interval number (for example, for noise level zones) 

• Serial number (automatically generated at run time) 

• Object number (defined in the Geo-Database) 

• Facade identifier (only for calculation type Facade Noise Map) 

• Selected column from the Spreadsheet  
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The following options are also available:  

USE SCALE COLORS defines if symbols on the facade are to be drawn in scale color as 
shown in the left example, or in a color of a Facade Sub Object (Facade Receiver, 
Conflict-Facade Receiver, Free Field Receiver and Conflict-Free Field Receiver) as 
shown in the middle example. The last example shows Façade Receivers in the 3D-
Graphics. 

   

If you selected a “closed” scale type (the lowest interval is not used), you can 
prevent the receiver symbols below the lower end of the scale from being drawn.  

FILL BUILDINGS IN SCALE COLOR fills buildings with the color representing the highest 
noise level found on the facade of this building. This display variant is especially 
helpful for zoom factors where the individual façade points are no longer visible. In 
3D-Graphics the buildings are also filled in the scale color instead of the color 
assigned to the object type buildings.  

  

If you want to show the buildings in scale color, you can additionally search for 
conflicts amongst all floors of the building and for all time slots.  

 

It can also be useful to have FACADES FILLED IN SCALE COLOR if you want to show 
individual facades of floors exceeding the noise limits.  
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The layout of the color bars (width and distance from the facade) is determined by 
the sub-type "Facade with noise level exceeded." As there is a display conflict 
between the modes "Show facades with scale color" and "Show only facades with 
conflict," only one of the settings can be active at a time. Deactivate one before 
selecting the other. 

Hint: if facades or buildings are not filled with the scale color even if selected in 
the object types use Reset building IDs (page 355) in the Calculation Kernel.   

The receivers are separated into FACADE POINTS, CONFLICT-FACADE POINTS, FREE 

FIELD POINTS and CONFLICT-FREE FIELD POINTS so you can give the different receivers 
a different layout. In the sub object types for the facade and free field points you 
define: 

• Show yes/no  

• Symbol and symbol size 

• Fill color, if not determined by the scale color 

• Show border line and border color  

If you select FACADE WITH CONFLICT, all facades and floors with a conflict in the 
assigned time slot will be highlighted by a bar using your choice of color, line 
thickness and spacing. Under the Cartography tab, customize line joints and line 
endings. You can also extend the conflict facade to cover all floors and all time 
slots. 

 

The sub-object type START MARKER (via a small arrow) shows the entry direction of 
the corners of the building and marks the first corner. This reference makes it 
easier to understand the tabular form of the grid noise map. The receiver names 
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are generated sequentially in the data entry direction starting with the first 
receiver, “A.” 

 

Create difference maps and other arithmetic operations using the file type "Façade 
Noise Map Operations", see "File Operations" on page 605. 

For the presentation you can present the object number of the processed building 
as a building reference in addition to the receiver points.   

     

In the map object types of the Facade Noise Map activate the sub-object-type 
BUILDING REFERENCE POINT.  

 

Select the position of the reference point: 
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For the selections, where the anchor point is positioned at the WALL CORNER, you 
can enter a DISPLACEMENT ALONG THE FAÇADE in [mm]. If the movement of an 
anchor point is longer than half the length of the facade, the anchor point will be 
placed in the middle of the façade. 

With the selection WITHIN BUILDING the connection line will only be drawn if the 
reference point lays outside the building. The angle in this mode is to be entered 
counter clockwise with the x-axis being the zero angle. For the other options the 
angle is measured between the connection line and the facade. 

Moving the anchor point along the facade or the distance between anchor point 
and reference point or a change in the angle are all not directly effecting the 
manual selections. To reset all the Facade Noise Map needs to be removed from 
the file selection of the map. 

Manuel moves: 

The selected mode has only limited influence upon the manual customization of 
anchor and reference points. 

For the selection WITHIN BUILDINGS an anchor point can be moved freely within the 
building. The reference point remains in place. 

All other modes are only default settings. If all facades are calculated, the anchor 
point can be only moved along the perimeter of the building (this is so the anchor 
point for the selection LOUDEST/QUIETEST FACADE/FACADE RECEIVER can be moved 
to a different part of the facade!). 

The reference point always is moved too. When you move to the starting point of 
the next facade element, the location of the reference point is calculated 
depending on the selected angle. The preset distance is used. 

Always position the anchor point correctly before moving the reference point to its 
final location.  

The building corner can be marked with an ARROW. The building reference point 
can be drawn in different ways depending on the sub object type for buildings with 
/ without noise limit violation.   

Hint: A building is marked with the conflict building reference point as soon as the 
limit is exceeded in one time slice or one floor. Activate ALL TIME SLICES and ALL 

FLOORS in the sub object type "façade with conflict" so that the building reference 
point and the labeling as conflict facade correspond.  
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Via the delivered template "Spreadsheet with building reference.ntt" for the 
spreadsheet you can connect the graphical presentation to the receivers in the 
table.  

 

Presentation as Level Tables, RLS-90 Symbols, Planning 
Guideline Austria 

The following calculation results can be displayed as level tables, RLS-90 symbols or 
Austrian planning guideline: 

• Single point receivers 

• Façade Noise Map 

• Spreadsheet tables (receiver tables) 

File selection of level tables / RLS-90 symbols 

After selecting the calculation results, additional parameters are requested for 
layout and display details. 
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Select the layout from the layout list. The layout can be customized later in the 
object type level tables/RLS-90 symbols. 

 
From left to right: Level tables, RLS-90 symbols, noise control measures Austria 

In the map, you can attach the level tables and the RLS-90 symbols directly to the 
facades, or they can be located in a RESULT BOX where a reference point is placed at 
the facade or in a defined space in front of it. The result box is then detached from 
the facade.  

To make the map more readable, use LOAD OPTIONS to reduce the number of result 
points presented so the information won’t overlap. This is especially useful for 
Façade Noise Maps in order to have readable texts without manually adjusting 
them in "Edit Map Contents".  

The symbols of the result presentation are included in the symbol explanation. A 
new legend can be used to house the explanations, but it is also possible to include 
them in the existing legend.  
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Load spreadsheet as a level table/RLS-90 symbols 

 

When you load a SoundPLAN spreadsheet as a level table/RLS-90 symbol, 
additional parameters are required. Enter the first level column and the first noise 
limit column. The spreadsheet can contain multiple sets of answers, so carefully 
choose the variant you want displayed.  

For example, if a façade shall be colored to show the noise limit exceeded or 
possible subsidies for noise control windows, you can substitute the columns of the 
noise limit with Boolean columns from the spreadsheet (true = color marking). 
Check mark use and select the first Boolean column. There must be as many 
successive level columns as time slices used in the calculation. If there are not as 
many, only the time slices with a corresponding reference column can be 
presented.  

Use the TEXT COLUMN FOR OWN TEXTS IN THE FAÇADE POINTS to amend the reference 
points with a user defined text. All text columns are presented. In the object type 
level tables/RLS-90 symbols, select the key for the reference point with 
“Identification with the selected column of the spreadsheet". 

The load operations are obsolete here because the filter (receivers on facades 
smaller than x…) has already been defined in the spreadsheet.   
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Object Type Level Table/RLS-90 Symbols 

 

Because there are so many options available, the layout can have so many different 
variations that it is not practical to discuss all the options and combinations. 
Modifications in the definition of the object type can always be seen in the preview 
picture. Use trial and error to determine what best fits your needs.  

The REFERENCE POINTS are the link between the graphics and the table, respectively 
the result box of the graphics. The layout of the reference points is divided into the 
sub-types facade point, free field point, conflict faced point, and conflict free field 
point.  

You can display all reference points or only those showing the noise level 
violations.    

The reference is identified via a KEY entered as a text for each reference point.  

• continuous number (generated automatically during calculations) 

• object number (defined in the Geo-Database) 

• house number and facade marking  

• selected text columns of the spreadsheet  

If the results shall be presented directly in the map or the line between results and 
result box is desired, the line between FACADE AND RECEIVER determines the line 
between the reference point and the results.  

Under the tab “results,” select if you want to display all results or only those with 
conflicts (noise limit violations). In order to maintain compatibility between the 
documentation and the graphics, it is possible to round the results the same way: 
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• normal 

• rounded up 

• truncated 

• RLS-90  

Rounding is always done to the number of decimal slots selected. 

The reference points are divided into FACADE NOISE LEVELS, CONFLICT-FACADE 

POINTS, FREE FIELD POINTS and CONFLICT-FREE FIELD POINTS so you can customize the 
layout for different points and treat them individually. In the sub object types for 
the facade and the free field points, you select: 

• draw yes/no  

• drawing symbol and symbol size 

• fill color 

• border lines draw/suppress and if selected the border color 

Use the sub-type FACADES WITH CONFLICT to highlight the facades with a special 
color when the noise level of the receiver exceeds the noise limit defined for that 
type receiver. Use the file type "façade noise map" to limit the façade marker to 
display only a single time slot and a single selected floor.  

Define the bar color and width, and if needed, the displacement between the bar 
and the façade. Under the Cartography tab, line connections and endings can be 
further configured. 

 

The sub-object types level tables and RLS-90 symbols are split into the tabs for 
layout and content + fonts. These sub-object types are easily distinguished due to 
their different components.  

The MINIMUM NUMBER OF FLOORS in the level table displays the number of floors 
selected in “set floors” even if the building has fewer floors. This setting is only 
sensible for keeping an entire row of result tables the same shape. 
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For RLS-90 symbols, the top unit shows which floor exceeds the limit, and the 
bottom units show the highest level at the receiver during the day and night. If the 
top unit is empty, no level violations were found at the receiver.  

Activate the boxes under the tab Content and fonts to select the content. The level 
with noise level violation cannot be deactivated. Use the double arrow to open the 
text layout and configure the fonts.  

Modifications in the settings are immediately visible in the preview picture.  

Level Tables / RLS-90 Symbols in a Result Box 

  

When loading, determine if the results shall be presented in a result box. If 
so, only the facade will show the reference point. To show only selected 

receiver positions in the box, delete the appropriate lines in the table (double click 
or use the right mouse button ->EDIT content) using delete line. 

Reference point and results are referenced with the key you selected in the main 
object type. Choosing "Identification via house number and facade marker" 
amends the reference point with the facade identifier and the result box with the 
house number and facade identifier. The switch side by side determines if house 
number and facade identification shall be drawn side by side or below each other 
in the reference point. Depending on the selection, you may have to customize the 
symbol for the reference point (change height ratio to width or select a different 
symbol) under the cartography tab. 

Layout Result Box 

Use the cog wheel to define the spacing and relative positioning, and to 
determine if the header shall be generated from the street name or the 

receiver name. If the reference point or the results in the box are too large or too 
small, correct the box with a factor the size selected in the object types.  
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Headers generated from street or receiver names are always inserted in front of 
the first receiver for which the reference fits. The header lines structure the result 
box. 

Select STORE AS STANDARD if you always want this layout. 

Move Results 

Use “Edit map content,” to move the results to a new location. Activate MOVE 

TABLES "RESULT FILE".RES. 

When the cursor nears one of the results, it changes from a + to an arrow. Use the 
arrow cursor with the left mouse button pressed to move the table or symbol. 

 

SoundPLAN remembers the new position. If you load another result file in the same 
map, you can decide if you want to keep the result positioning from file xxx. 

Planning Guideline Austria 

According to the “Planungsleitfaden” (planning guideline) for noise control, the 
excessive noise limit must be mapped for the time slot night. For the display, the 
assessment standard expects two time slices (Lden and Lnight) of which 
SoundPLAN automatically selects the second one. 
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Load the status quo of the current situation (either as single receivers or as a 
Facade Noise Map) for the time slot LrN and have the program display only the 
facades currently exceeding the noise limit (map-object types -> Façade Noise Map 
-> activate facades with noise limit violation and select the appropriate time slice.) 

For the border contour line to show, the appropriate grid noise map must be 
loaded. In the map-object types /object type Grid Noise Map, deactivate the main 
interval and activate the border contour line.   

To present the noise immission map for the prognosis, load the single receivers or 
the Facade Noise Map via the file type LEVEL TABLES / RLS 90 SYMBOLS. Select NOISE 

CONTROL MEASURES (AUSTRIA) from the options. Customize the presentation layout 
as usual in the object types.  

 

For the two bars, the color, width and spacing to the facade is defined in sub-object 
types "Beam 50-55 dB" and "Beam >55 dB". 
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For the prognosis noise map, the object type Grid Noise Map must have the border 
contour line activated and the value and color must be set. 

 Presentation as Receiver flags 
Use small flags at the receiver points to present any content of a receiver table 
(Spreadsheet) in a map. In contrary to the level tables, that only present the level 
values per receiver, you can flexibly display all desired information.  

The below extract from the spreadsheet and the resulting receiver flag explain the 
relationship: 

 

 

The receiver flags are connected with a reference line to the receiver point in the 
map. With Boolean (logical) columns generated in the spreadsheet you define 
which receiver points shall be represented with receiver flags and which points and 
facades shall be marked as conflicts (columns 25 and 26 in the table above). Apart 
from the any column you can also display structured rows you have defined in the 
spreadsheet. 

The columns and headers are stored separately in so called column combinations in 
the table so that the tabular format and the graphical display as receiver flag can 
come from the same spreadsheet with completely different layout and contents.  
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 Column combinations and file type selection 

Select the file type RECEIVER FLAGS in the Graphics file selection manager, you will 
see a dialog for the selection of the columns to be displayed. 

 

Select the column that contains the TEXT IN REFERENCE POINTS. This can be a text or 
integer column from the spreadsheet. Whether the text is shown in the Graphics 
however depends on your definitions for the receiver flags in the object types. 
Select the Boolean columns for marking it as a CONFLICT POINT and for marking 
POINTS TO B DISPLAYED IN THE GRAPHICS (both columns can be the same). 
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In the table above, Boolean columns have been generated for the selection of the 
conflict and for the display in the graphics. This way you can for example present a 
level table for the loudest receiver on a building and mark additional ones that 
generate conflict receivers and conflict facades.  

Choose the HEADER TYPE for the column combination. You can select to use the 
column headers from the SoundPLAN Spreadsheet or define your own short title. 

If STRUCTURE LINES (block beginning and/or block end) are contained in the 
spreadsheet, you can select if you want to display them in the small tables.   

SELECT COLUMNS: Now select the columns that shall be visible. By default, all 
columns visible in the spreadsheet are marked visible here. If desired enter a short 
header if you want to have a different text (one line) than the header from the 
spreadsheet, which can have multiple lines. 

Is there a column missing, you want to display? Then switch to SHOW ALL COLUMNS. 
SHOW ONLY SELECTED COLUMNS gives you a better overview if there are columns 
already selected. 

Further compilations of this table you can generate by clicking on the + sign next to 
the column combination name. The name must be unique. Column combinations 
no longer in use are deleted with the - sign. With >> change the name of the 
column combination. If you change a name to a column combination that is already 
in use in a sheet, the connection to this column combination will be lost however! 

 



 SoundPLAN Manual 8.1 
 Graphics 

Page • 594/793 Presentation as Receiver flags 

10 

 Result request for receiver flags in the file selection 

After selecting the spreadsheet and defining the column combination, additional 
parameters for the presentation are requested:  

 

Define the DISTANCE BETWEEN THE RECEIVER AND THE REFERENCE POINT and the 
DISTANCE BETWEEN THE REFERENCE POINT AND THE MIDDLE OF THE TABLE. The 
reference points can later be moved in “Edit map”.    

 

Both distances “facade - reference point” and “reference point - receiver flag” are 
connected with a line, the layout of the line can be further defined in the map 
object types. 

The type of header and whether structure lines are used or not, is taken from the 
column combinations but can be modified in the current sheet.  

OPTIMIZE COLUMN ZIZES fits the width of the columns to the longest text present. 
Structure lines are not used in the calculation of the table width, if they are longer 
than the table allows, they are truncated. 

 Object type receiver flags 

The layout of the receiver flags is set in the object setup under the tabs „general“ 
and „table layout“.  
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As the test size from the spreadsheet may be too big for the display in the graphics, 
you have a SIZE FACTOR to your disposal to scale the texts up and down without 
having to redo the table itself.  

If you only want to use the receiver flags to mark individual receivers specially, you 
can deactivate the receiver flags with the switch SHOW TABLES.  

Use the switch ONLY SHOW TABLES THAT ARE MARKED IN THE BOOLAN „PRESENT“ 

COLUMN, in order to show the receiver flags for all receivers contained in the 
spreadsheet. 

With SHOW ONLY FLOORS WITH CONFLICT you can set to print only table lines with a 
conflict or for all floors as soon as that location on the building shows a conflict in 
any of the floors.  

 

A checkmark in front of SHOW TEXTS IN REFERENCE POINT prints the text from the 
column you have defined in the column combinations. Font and color and size are 
also defined here. 

Define the WIDTH and COLOR of the connection line between the facade and the 
table. In case the reference point was moved from the façade, both parts are 
displayed the same way. 

Under the tab Table layout select background colors for the headers, the structure 
and data lines. They are administered independently from the spreadsheet.  
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Click on the checkbox in front of the line types in order to make a selection of 
colors valid. The color then can be different in the graphics from the colors in the 
spreadsheet. If the checkbox is unchecked, the colors from the spreadsheet are 
used. Structure lines can either be placed under the header from the spreadsheet 
or the column combination or on top. 

Often the lines between the time slice columns are switched off in the 
Spreadsheet. Therefore, you can define the TABLE LINES in the object types. You can 
select, whether you want to keep the settings from the Spreadsheet (then only 
lines between rows can be additionally displayed), display lines from the object 
type definition additionally to the settings from the Spreadsheet or completely 
ignore the settings from the Spreadsheet and only use the line color and line width 
defined in the object types.  

The TABLE EDGE LINES are always taken from the definition in the object types.  

 Move the receiver flags 

Individual tables can be moved under "Edit Plan". Activate MOVE TABLE "RESULT 

FILE".*.  

When the cursor moves on to a table, the cross of the cursor changes into the 
movement arrow. With the left mouse button pressed, move the table or the 
symbol. 

 

SoundPLAN remembers the position you have moved results to. When you load 
another result file into your plan, you can force the program to use the same 
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position as was used in the result file xxx. First select the spreadsheet to be loaded 
(the original table must be still part of the plan), then mark the USE THE POSITION 

FROM FILE xxx and then take the original table out of the plan. 

The anchor position of the line connecting the facade receivers to the receiver flags 
will not be moved if you press the Ctrl key when moving the table.  

Presentation as Level Chart 
Level charts can be presented in the graphics when the calculation run is set for the 
generation of level charts. Otherwise the data for the level charts are not stored. It 
is possible to store level charts for: 

• Single receivers 

• Façade Noise Maps 

Because SoundPLAN stores all the level charts of an entire calculation run, the files 
can become very large, especially for Façade Noise Maps. It is therefore wise to 
only activate the storage when you intend to use the data later in the graphics. 

Parameters for the Level Chart 

 

Select the time slot and the floor for which you want to present the level chart. 
HIGHEST LEVEL queries all receivers and shows the floor with the highest noise level 
for each receiver location. 

Level charts can be presented as a ray diagram or as a circumference line.  
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You can even load the same level chart diagram file twice, perhaps to present the 
nighttime levels as a ray diagram and the daytime levels as an outline. 

Object type Level Charts 

 

The level values can be drawn in the middle of the diagram. To do this, activate the 
text and format it. The level can be displayed for the current time slice or for all 
time slices found in the result file.  

The size of the level charts is defined by the parameter SIZE IN [MM] FOR 10 DB. 

In the sub-object types total noise level, reflected noise and outline are customized 
with line colors and pen width.  

Additionally, in the sub-object type "Dimensioning" you can activate the scale rings 
and the dB scale.  

Presentation of Geometry bitmaps 
Background graphics that were calibrated in the Geo-Database to be used as 
digitizing background can be sandwiched with other data in the SoundPLAN 
graphics. In the file selection, only files geo-referenced by the Geo-Database are 
shown (*.grf). For this purpose, you can find geo-reference files in the project 
folder that contain the transformation information. The filename is the same as the 
graphics itself. 
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Geometry bitmaps in the Graphics 

Object type Geometry-bitmap 

The format options for geometry bitmaps are located in the object type setup in 
the branch external data -> geometry-bitmap. 

 

In the object type definitions, you can select if the bitmap shall be drawn solid or 
transparent (normal or additive). Use the additive setting to combine bitmaps with 
other area bound output. In this case the color values from the bitmap and the 
existing background colors are added. The "normal" output only shows the bitmap 
as a solid area. In the solid display, colors brighter than a user defined threshold 
value will default to white and be output 100% transparent. In these places the 
background is visible.  
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A mode for a fast re-draw was implemented that allows much higher rates of re-
drawing, especially for black and white bitmaps, however with this fast-redraw 
mode the quality on screen in some resolutions is a bit reduced. This only affects 
the screen, not printed output. 

Drawing any bitmap on screen the bitmap first needs to be converted into the 
pixel-matrix of the screen and then it is drawn. As most bitmaps have a higher 
resolution than the screen, often multiple pixels from the bitmap are presented 
with only a single pixel on screen. The fast re-draw does not calculate an average of 
all the pixels from the bitmap that should be presented as a single pixel on screen 
but rather has each one of them draw the pixel, which means that the last bitmap 
pixel to be drawn is what you see in the end. This may result in the picture looking 
like having less detail. The slower mode averages the bitmap pixels resulting in a 
better picture quality. In the addition mode multiple draws will result in black, in 
the normal draw mode will yield gray. 

   

Transparent Geometry Bitmaps 

What does transparent mean? A single color from the palette (in general, white, 
RGB = 255 / 255 / 255) is drawn with the transparent attribute. None of the pixels 
with this color attribute are drawn.  

When is transparency necessary? 

• When you are using two overlapping bitmaps (aerial photography) and want 
to rotate them, OpenGL has some problems with displaying them. Why? – 
Bitmaps cannot be rotated. The only way is to rotate a bitmap externally 
and to generate a joint bitmap which contains the original bitmap pixels 
rotated into their new position. As the joint bitmap is bigger than the 
original, some part of the bitmap remains white and parts of the bitmap 
positioned second hide parts of the first bitmap. Only after the white parts 
of the bitmap are made transparent, everything shows. 



SoundPLAN Manual 8.1 
Graphics 

Inhabitant and Area Statistics in the Graphics  Page •  601/793 

10 

• If you have diagrams (for example, a wind diagram to be placed on a grid 
noise map without the white background of the diagram). 

There is a small glitch in the way the data are printed by OpenGL. The printer 
cannot cope with transparency and will most likely produce a black area instead of 
the transparent area. Therefore, the entire map must PRINT AS BITMAP. The setting 
for this is in the print preview. 

When is it correct to treat transparent bitmaps as „normal“, and when is 
„additive“ preferred? 

"Normal" should always be used when the bitmap is a background graphic and 
other line and area elements are placed on top but show completely. In this case 
the output sequence for the bitmap must print it first. 

As soon as you want to combine Grid Noise Maps and a grayscale bitmap, the 
bitmap should be drawn as "additive" on top of the Grid Noise Map. Here the 
question is if your printer can print this directly or not. White pixels allow the color 
of the Grid Noise Map to show unaltered, black ones hide them completely, and 
gray pixels make a darker shade of the color. 

Store viewports of geometry bitmaps 

The view of a single or multiple bitmaps can be stored in a geo-referenced fashion 
under a new name. This is especially advisable for very large bitmaps where only a 
small section is required in the map, for rotated bitmaps, or if multiple bitmaps are 
contained in the map. Because the new bitmap is already present in the correct 
size and rotation, the loading time is greatly reduced. It is advisable to store the 
bitmap only when the final map section has been selected. In “Edit map”, open the 
menu item FILE -> STORE GEOMETRY BITMAP and enter the picture file format, 
resolution and color depth. In the map itself, the old bitmap will be replaced with 
the one just stored. 

Inhabitant and Area Statistics in the Graphics 
[Noise Mapping Toolbox] Inhabitant and/or area statistics can be presented in 
graphical form for the following calculation types: 

• Facade Noise Map (Building assessment) 

• Meshed Noise Map (Area assessment) 

• Grid Noise Map (Area assessment) 

The definition for both assessment types originally comes from annex VI of the 
European Environmental Noise Directive (END), however, it can be used as well for 
other purposes than stated in the END.   



 SoundPLAN Manual 8.1 
 Graphics 

Page • 602/793 Inhabitant and Area Statistics in the Graphics 

10 

Inhabitants Statistics 

For the facade assessment, the results must be loaded in the file manager for the 
data type EU Buildings (Annex VI). If you select a new color scale, the new scale will 
automatically be created in the colors and according to the scale of the annex VI 
with the preset intervals and with the extra columns for the display of inhabitants 
affected in the various intervals. But you can change the colored scale to any 
number of intervals and scale type.  

 

For the assessment of the quiet facade with the building assessment, additional 
receivers are inserted 2 meters in front of the facade. The results are then 
compared to the results of the noisiest facade and if the difference is greater than 
20 dB the facade is marked as being an especially quiet facade and the number of 
inhabitants assigned to the facade are then added to the number of residents living 
with an especially quiet facade.  

The attribute "with noise control" is processed if the building has been marked as 
having noise control windows and other noise control measures (ADDITIONAL tab in 
the building properties). 

You can activate/deactivate the additional columns of the building 
assessment in the scale layout. The columns are only presented when the 

assessment has been completed. 
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File selection for the inhabitant statistics 

 

Select the time slot and the floor for which you want to present the level chart. 
MAXIMUM LEVEL queries all receivers and shows the floor with the highest noise 
level for each receiver location. 

Select whether the all inhabitants shall be assigned to the loudest value at the 
building or the inhabitants shall be split up to the levels at each façade.  

Hint: Reload the results (open the file selection manager and right click on the 
result file) after you changed the intervals in the colored scale, in order to update 
the additional columns. 

Object type EU buildings (Annex VI) 
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In the sub-object types for the loudest facade and quietest facade define the width 
and color of the bar and the distance to the facade. 

If buildings with special noise control measures are present, the outline of the 
building will be colored according to your color and line width selection. 

Area Type Statistics 

For the area type assessment of grid noise maps and meshed noise maps the area 
sizes per scale interval is plotted out by the program to find how many square 
meters are in each scale interval. It is also possible to find the number of square 
meters above a threshold noise level and to document the number of residential 
buildings and inhabitants in a scale interval or above the threshold value. 

Activate the area assessment in the file selection by checking the box CREATE EU 

AREA EVALUATION for grid noise maps and meshed noise maps. 

 

By default, the area assessment will deliver statistical answers for the threshold 
values over 55 dB(A), over 65 dB(A) and over 75 dB(A). In additional columns the 
total area, the total number of buildings and the total number of residents above 
the thresholds are listed. This means too that the interval above 65 dB(A) contains 
the values for the interval 75 dB(A) etc.. 

 

Only activate the check box CALCULATE THE ISO AREAS WITH STEP SIZE [M] if results or 
the scale intervals have changed. Via the step size you control the size of the grid 
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that is the basis of the plotting of the areas. The default setting is 1 m. The smaller 
the number, the more accurate the results but the higher the calculation time for 
the plotting. 

Out of the contour lines of the scale intervals SoundPLAN creates a grid structure in 
the defined step size. Next each grid point is checked for its value and the grid area 
is added to the appropriate interval, except the grid point is within a building. 

Afterwards the building area is added to the interval of the highest level at the 
building and the building as well as the residents is entered into the appropriate 
scale interval. 

Caution: The levels include all reflections.  

The area evaluation is only created if you select a NEW COLOR SCALE. The new scale 
will be generated for the intervals over 55, 65 and 75 dB(A) by default. Edit the 
scale with the double arrow button if you want to generate the evaluation for more 
or other intervals or another scale type. If you change the intervals in colored scale 
editing in the Graphics, it is necessary to update the evaluation in the file selection 
manager. Activate the click box CALCULATE THE ISO AREAS. 

The area evaluation is coupled to the scale type. With the first four scale types 
(which represent intervals) area size, residential buildings and inhabitants are 
calculated for the set intervals. With the next four scale types (which represent 
thresholds) area size, residential buildings and inhabitants are calculated above 
these thresholds.  

The additional columns of the area assessment you can activate/deactivate in 
the scale layout. The selection is not shown until the assessment has been 

carried out. 

 

File Operations 
Some of the calculation results can be used for calculation operations on a file 
basis. Depending on the file type, there are 3 different file operation types that can 
be defined as an object type or in the file selection: 

• Facade Noise Map operations 

• Triangulated Map operations (Meshed Noise Map, Measurement values 
point lists) 

• Grid Map based operations 

For the building-, triangle and grid-based maps, select from the following options: 
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• add  

• subtract (difference map) 

• add as level 

• subtract as level 

• select smallest value from receivers of 2 maps 

• select the highest value from receivers of 2 maps 

In addition, you can add a constant or a base noise level to a map. 

Procedure for the file operations 

In the file selection, select the operations type with the double arrow normally 
used to select files. 

 

The basic procedure is the same for all file operations: Select the base file, then the 
operation to be performed and then the operand file. To add a constant to a noise 
level, a second operand file is not required.  

 

Internally, SoundPLAN generates a formula similar to the ones used in the 
SoundPLAN spreadsheet. The formula is stored with the drawing and will re-
execute when you decide to load different files into the same sheet or if you store 
the drawing as a template.   

The parameters or the operation itself can be modified later. Right click on the file 
“formula” in the file selection to open the entry screen for file operations. To 
change the time slot, for example, right click on the base file and the operations 
file.  
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Extended formula entry 

 

Activate EXTENDED to open the extended formula entry. Enter your formulas (for 
example, for weighing different noise source types). You don’t need to open the 
Spreadsheet from the SoundPLAN Manager to change the formulas there. This 
formula interpreter is the same as in the Spreadsheet. Please read the section 
"Calculating using Formulas (page 425)" in the Spreadsheet chapter.  

Mark a file on the left side. Use the arrow symbol or double click on the file to open 
a specific parameter window. Click OK to insert the file with the selected 
parameters (e.g. time slice, group or frequency) and correct syntax at the cursor 
position into the formula.  

The OPERATORS are in the upper block. Aside from the basic arithmetic symbols, 
use (^) to raise a value to the power of or use (++) to add energetically and (--) to 
subtract energetically. The comma as separator is used for additional parameters.  

The NUMBER BLOCK contains the decimal separator and the semicolon to mark the 
end of the formula. Click on the button in order to move the content into the 
formula.  

In the selection list FUNCTIONS, select the function of choice. With the arrow to the 
right-hand side of the pick list, add the function to the formula. Brackets are added 
and the cursor is positioned between them to enter required parameters or taking 
over the results with a double click.  

Specialty of grid-operations 

You can unite several adjoining grid maps. Check mark EXTENDED               and link them 
with the operator &.  

For grid points in the overlapping areas, select how the grid values shall be 
processed: 

• use the last value loaded 

• generate an average value of all values 
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• use the lease favorite value (highest level) 

• use the most favorite value (lowest level) 

• add the values as levels 

If you process grid operations for grid maps with different grid sizes, the finest grid 
must be polled as BASE FILE (for the enhanced formula entry as first file in the 
formula). The less detailed grid map is polled as FILE FOR OPERATION. The coarser 
grid is interpolated at loading time to yield the finer grid. The result map will also 
only contain receiver points contained in the base file. Receivers that would 
enlarge the base area are discarded. 

Arithmetic with Meshed Maps and measurement data 

It is also possible to use the triangulated data from meshed noise maps and 
measurements as an operand file. Here again the base files determine the grid of 
the result files. The value at the grid point is interpolated within the triangles of the 
operand file.  

In order to best represent a meshed noise map, the grid spacing for the base file 
should be much finer than the triangulation distance. To facilitate this, a grid 
spacing of the base file is displayed to allow the user to manually select a finer 
spacing for the conversion of the triangulated file. 

Specialty of the Facade Noise Map operations 

In order to avoid time intensive searches for receivers, the receivers in both files 
should be the same. To achieve this, both calculations should contain the same 
buildings and the resolution of the Facade Noise Map defined in the calculation 
settings should be the same.  

Select the time slot so the results for different propagation conditions or different 
assessments can be compared with each other. 

After leaving the file selection, select the floor to be presented. SoundPLAN carries 
out the operations for all floors and presents the selected floor. If you selected the 
operation „subtract“ and the view option „highest value,“ the results are obtained 
by subtracting the values floor by floor and then finding the highest value. 

Specialty of operations on triangulated results 

Triangulated operations can be carried out with the Meshed Noise Map or with 
measurement point lists. If the Meshed Noise Map constitutes the base map, the 
operand map can be a Meshed Noise Map or a measurement point list (in order to 
calibrate a noise map for a background noise level). In case the base map is a 
measurement point list, the operand can only be a measurement point list. 

If a Meshed Noise Map is the base map, the calculation area of the base map is also 
the calculation area for the result file. This means that the calculation areas do not 
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need to be identical, but also means the calculation area is not expanded beyond 
the area of the base file. As the calculation area is not truncated, this means 
difference maps for Meshed Noise Maps only make sense for identical calculation 
areas.  

As measurement point lists are not associated with calculation areas, you must 
define if the operation shall be carried out for the entire area or for the area 
defined by the points contained in both files. 

The structure of base and operation files should be identical. Both maps should 
contain the same time slots. Measurement point lists need to have the same 
information in the same columns of the file. SoundPLAN does not check if the 
content of the columns fit together; this is the responsibility of the user. 
SoundPLAN only checks that the columns are compatible with each other.   

Operations with files containing different points in them 

If base and operation files are the same file type, either Meshed Noise Maps or 
measurement point lists, SoundPLAN proceeds as follows: 

• First the points are synchronized. This means points contained on the base 
file that are not in the operations file are inserted in the operations file. In 
the process, the triangle where the point is located is searched and values of 
all columns are derived by linear interpolation. 

• Next, a copy of the base file is generated. The operation is carried out for all 
points and all value or level columns. If a column in one file is a value 
column but the other file contains a different type in this place, no 
operation is invoked for this column.  

• After carrying out the operation, a new triangulation is made. For Meshed 
Noise Maps, the calculation area is regarded. For measurement point lists, a 
new hull around all points is generated. 

If the base file is a Meshed Noise Map and the operations file is a measurement 
point list, steps 1 and 3 are omitted. The program will locate the receiver positions 
of the Meshed Noise Map in the measurement point list, interpolate the value with 
a linear interpolation and then process the result. 

 Highlight the calculation area 
The calculation area has been amended with a new Cartography attribute to 
highlight the calculation area. 
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In the map object types for the calculation area open the tab Cartography and 
select the tab background. 

 

You have multiple options of highlighting the calculation area (see also “Effects for 
the calculation area (page 663)”): 

• Put a SHADOW to the right and bottom or all around it. 

• Do not draw objects and/or results outside the calculation area 

• Select a background color that will be drawn outside the calculation area 
Make the colors or the gray scale a bit brighter 

• Use a 3D-effect that raises the data within the calculation area. 

Just experiment what option you like best! 
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 Emphasize Graphically Using Symbols 
Use the element "Symbol"  to draw arrows or other symbols on a map. You can 
define a line or arrow for text boxes and graphics boxes in the box properties in the 
tab index card Line, see “Connection lines (page 515)”. 

 

Click the symbol button and then click on the map about where you want to 
insert the symbol. A symbol will be displayed. Double click on the symbol to 

edit attributes and select a different symbol. Aside from the default symbols, you 
can also create your own library of user defined symbols. 

 

Move symbol, rotate and zoom 

In the symbol settings, define the size, position, angle, line width and the ratio of 
height to width. Grab the middle of the symbol box to move it to a new location. 
Click of the grab points of the symbol frame with the mouse to stretch the symbol. 
To rotate the symbol, click on one of the corners, and to zoom, click on one of the 
middle markers. Move the symbol with the left mouse button pressed while 
moving the mouse on the canvas.  

The old position of the symbol remains valid until you release the mouse button.  

Symbols are rotated and zoomed around the middle marker of the symbol: 
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 SoundPLAN Symbols 

 Administration of symbols 

SoundPLAN is delivered with a small symbol library named „Symbols.sym“. The file 
is installed in the system folder and will remain there for future extension of the 
symbol library.   

You can create your own symbols in the symbol editor. All symbols are accessible, 
both the SoundPLAN default symbols and the user created ones, so you can use 
both sets jointly.  

User generated symbols are stored in the project under the name „User.sym“. To 
store the symbols so that they become accessible in other projects, store the file 
"User.sym" via the menu FILE -> SAVE in the Globdata-folder.  If you change to 
another project that does not already contain a User.sym file, the file from the 
Globdata folder will be copied into the project. If the file already exists, it will not 
be overwritten but amended with the new symbols. Otherwise projects received 
from outside bureaus would have the symbol file overwritten or if your global 
symbol file was shorter, the graphics would attempt to load a symbol from an 
empty place.  

 The symbol editor 

Open the symbol editor from the OBJECT TYPES via EXTRA -> SYMBOL EDITOR.  

 



SoundPLAN Manual 8.1 
Graphics 

SoundPLAN Symbols  Page •  613/793 

10 

The symbol editor is a tree structure containing all symbols (the SoundPLAN 
symbols and the user created ones) in the GlobData folder. By default, the 
SoundPLAN symbols are named „SP-Symbol” with the symbol-ID trailing. 

SP-symbols cannot be altered, but they can be used as the basis of your own 
creations. 

The symbols you generate are called „user symbol“. These symbols depict the 
symbol ID as well. You can alter the symbol name; however, the name has little 
meaning for the drawing. The drawing references the symbol by the symbol ID. 

The symbols are organized according to function groups. In each group you can 
amend the symbols and generate new ones and even generate new function 
groups. You can delete you own symbols and user created branches of the symbol 
tree. 

To the right of the symbol tree is the symbol editor. Between the symbol tree and 
the symbol editor you see three buttons. The upmost button moves the symbol 
from the symbol tree to the symbol editor. The two lower buttons move the 
symbol in the symbol editor to the currently active location of the symbol tree, 
either to the global or to the project symbols. If the symbol is a SoundPLAN symbol, 
a copy of the symbol is created as a user generated symbol. If the symbol was user 
created and is already present, the program asks permission to overwrite the 
symbol. If permission is denied, the symbol is inserted as a new user created 
symbol. To include it, first generate a new symbol in the branch of the symbol 
library you want to place the symbol, and then move the symbol from the drawing 
canvas to the symbol tree.  

 Requesting new symbols 

A symbol can be generated from multiple symbol elements: 

• Lines 

• Areas 

• Rectangles 

• Ellipses 

Click on the particular symbol to open it for drawing.  
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For lines and areas, mark the first point with the mouse, then move to the next 
point with the mouse and enter it. Do this until you close the symbol with a double 
click. Areas are automatically closed.  

Ellipses, rectangles and regular polygons are entered by pulling the box around it 
open. For regular polygons, also enter the number of points in the polygon. 

 

You can generate squares, circles and regular polygons if you select the object and 
pull open it with the Ctrl-key pressed. If you keep the Shift-key pressed, the start 
position is used as the center of the new object. 

A marked symbol part is proportionally enlarged / downsized if you select the black 
squares in the corners (except if you press the Shift-key). The black squares in the 
middle change the symbol part only in one direction. 

With the move mode active, symbol parts can be rotated around the center if you 
keep the Ctrl-key pressed or enlarged / downsized if you keep the Shift-key 
pressed.  

Replace symbols: A global symbol can be taken over in the project symbol 
collection as well as a project symbol into the global collection. Load the symbol to 
the editor. If this symbol is not yet part of the global or project symbols the button 
PROJECT or GLOBAL becomes active.  

For newly generated or changed symbols both buttons are active. 

 Symbol layout 

The symbol components can be assigned attributes such as line colors, line width 
and for area type symbols the border and fill colors. This flexibility allows the 
generation of very complex multicolored symbols. As a color of its own, you can 
assign „no color“ to area type objects for the border or fill.  
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You can assign symbols to be drawn in the colors defined in the symbol generator 
or you can assign the color via the object setup for the object type. In order to 
distinguish both color definitions, the switch LAYOUT FIX in the symbol definition 
must be set appropriately for each element. If the box is checked, the symbol is 
drawn with the settings of the symbol lib. If not, the color setting of the object 
setup is used. 

Please look at the symbol for the traffic light:  

The symbol consists of a rectangle with 3 circles of different colors. The circles are 
assigned the colors red, yellow and green. The frame is disabled. Both are marked 
with the setting „Layout fix“. For the rectangle, the default settings were left intact, 
i. e. the border is dark gray and the fill is light gray. You can modify the fill and 
border colors and leave the lights untouched. If the lights were not set „Layout fix“, 
they too would be drawn in the new fill color. 

 Entry grid 

In the editor you see a green frame which indicates the normal size of the symbol. 
The lower left coordinate is (-500/-500), the upper right one is (500/500). The 
middle coordinate (0/0) is the pivot point around which all rotating and stretching 
actions revolve. 

For a point type object type consisting only of a symbol, the (0/0) coordinate is 
located at the exact location of the world coordinate assigned to the object in the 
Geo-Database. 

The editor contains a visible and an invisible coordinate grid. The grid size functions 
as an orientation and the pixel size constitutes an entry aid as points can only be 
placed in the fixed grid of the pixel grid. Both grid spacing can be adjusted in the 
options menu. 
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 Spreadsheets in the graphics 
Spreadsheets and parts of spreadsheets can be presented in a table box. 

  

Pull open a table box and double click to edit content (or use the menu item 
edit content). Select the desired table in the "file open" dialog and set the file 

filter to show the desired type of table (level-, measurement value or area table).  

 

The next part of the file open dialog shows the selected file along with two buttons. 
Use SELECT to choose a different table. Use EDIT to open the spreadsheet from the 
graphics so you can customize the table, select different columns, and so on. 

Near the bottom you can choose if the entire table shall be shown in the box or 
only the part of the table that fits the definition of the filter. Any integer number 
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column can function as the filter. In a level table, the definition, for example, fits 
for the object number (i.e. to present the spreadsheet only for a single building) 
and the building number. It is also possible to generate an integer column of your 
own (TABLE -> ADD COLUMN -> VALUE AS INTEGER VALUE). 

The filter column can be deactivated from showing in the box, for example, if the 
content is also part of a structured table. Likewise, a filter column of the 
spreadsheet can be temporarily activated. 

The lines selected by the filter to be presented in the box do not have to be located 
in adjacent positions.  If a start of structure line is in front of the filtered line or an 
end of structure line is found after the filtered line, they are included in the box. 

 Display properties as text  

        

The types of available property labels to be included as text labels are shown when 
the files are loaded. Double clicking the attribute or using the arrows causes the 
labels to be included in the map. The following attributes can be printed on the 
map: 

• Receiver names and numbers 

• Number and name of point, line and area sources as well as parking lots and 
wind turbines 

• Number and name of sources of an industrial building 

• Number and name of receivers in an industrial building 

• Road and railway kilometer marks if the road or railway line is defined as the 
reference axis 

• Section name of a road 

• Wall height for noise control walls and berms where the height of the wall 
changes 

• Reference kilometer of the reference axis of noise control walls and berms 
for the beginning and end of the wall or berm and where the wall height 
changes. 

• Name of measurement points 

• Name of usage areas  
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• Photo location 

• Name of map sections 

The display definition is set in the object type setup under the cartography tab. 
Select the map-object type for the sub-object.  

 

Sub object types are always inserted; the attribute labels, however, are only 
displayed when you have selected them in the file selection.  

The preview picture shows how modifications on the definition will change the 
appearance of the attribute labels. 

 



SoundPLAN Manual 8.1 
Graphics 

Printing  Page •  619/793 

10 

For duplicate object types, for example to distinguish between existing and 
planned noise control walls, the text attributes are defined and administered 
separately. If you want to draw text labels describing the height of the wall, etc., 
you must load the text attribute labels for both attribute types in the load 
procedure of the graphics file manager. 

The text properties receiver name, source name and photo position can now be 
moved and rotated (this is not yet possible for the attributes along other objects 
such as the stationing and the height of walls). 

Open "Edit Map" and select the MOVE PROPERTY TEXTS from the selection list. As 
soon as you move the cursor over a text, the cursor changes into a movement 
cursor with which you can grab the text and move it to a new position. Rotate the 
text with the Control key and mouse movement.   

Texts moved manually can no longer be placed with the object type placement 
settings. If you modify the object type, the position calculation no longer functions 
correctly and some of the texts will be miss-placed. As a consequence, it is 
recommended to manually move the texts only after the layout placement is 
finished.  

Hint: Movements of texts cannot be transferred to other situations even if they 
contain the same geo-files (and thus the same texts).  

Printing 
For printing and plotting your sheets, SoundPLAN uses the infra-structure Windows 
supplies.  

When editing the sheet, the preparations are totally independent of the printer. 
After you invoke FILE -> PRINT or press the print symbol button, select which printer 
shall be used. The printer selected in the settings of the SoundPLAN Manager under 
Program/Printer for graphics is the default. 

Enter the page margins of the printer in the sheet properties, tab index card 
"edge". It is also possible to generate a new sheet, select the sheet size and the 
desired printer and then view the sheet FILE -> PRINT PREVIEW. The active drawing 
area is requested from the printer driver and displayed. If it does not fit, you see 
the message: 

  

In case the paper format for the sheet and the printer do not match and the sheet 
is too big, the message "sheet too big for selected paper size is displayed“.  
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At the same time the print preview shows the preview of the sheet and the non-
printable border frame. 

 

If the borders around it are exceeding the printable area, the printed part will be 
centered on the sheet. The non-printable area is hatched with red lines in the print 
preview. 

You also have the option to change the printer here or to change the printer 
settings. Click on the symbol in the upper left-hand corner to CHANGE PRINTER 

SETTINGS.  

Enter the desired sheet border in ELEMENT -> SHEET PROPERTIES, tab edge.  

You can view the sheet with or without the frame to maximize the active viewing 
area on screen. With VIEW -> WITHOUT SHEET FRAME (CTRL+ E) the frame is 
activated/deactivated. 

After defining the sheet frame, it is no longer possible to move the child elements 
beyond the sheet frame. 

You can activate the checkbox FIT ONLY FOR HTIS PRINTOUT to leave the sheet frame 
untouched but to have the content fitted correctly to the sheet. Additionally, you 
can disable the presentation of more complex content in the preview (speeding up 
the generation of the preview) if you uncheck the checkbox SHOW GEOMETRIE AND 

RESULTS. 
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Print plan as a bitmap 

PRINT PLANS AS BITMAP is automatically activated when there is a transparent 
geometry bitmap. In this case, the setting cannot be deactivated. As the bitmap 
size depends on the printer’s resolution, the bitmap can get very big quickly and 
exceed the available memory. To avoid an overrun, the program segments big 
plans and the bitmaps are sent to the printer separately. 

If parts of the bitmap are missing, the size of the original bitmap probably exceeded 
the max size. In the SoundPLAN Manager you can define the max size in the 
settings -> system -> MAX BITMAP SIZE IN PIXELN. If decreasing the bitmap size 
doesn’t solve the problem, generate a PDF file first and print this file externally. 

Export of sheets or elements 
The sheet or individual elements of the sheet can be copied to a file or the 
clipboard and can be entered in other applications such as a word document. 

Call FILE -> COPY TO CLIPBOARD or Shift+Ctrl+C and select the type of bitmap or 
metafile. For bitmaps, select the color depth and resolution. With Ctrl+ V, the 
graphics is inserted in the target application. (Ctrl+ C in the Graphics is used to copy 
the elements within the SoundPLAN graphics.) 

Invoke FILE -> SAVE AS GRAPHICS FILE. If an element (not the entire sheet) is active, 
select if you want to export only the active element or the entire sheet.  

Enter a file name and select the graphics format; Metafile (*.wmf, *.emf) or bitmap 
(*.bmp, *.tif, *.jpg, *.png) via the filter selection list. By default, the graphics is 
stored in the project, but you can customize the path.  

Metafiles are scalable vector graphics, so the quality of the graphics is better if you 
use a different resolution in the target application.  

Graphics formats 

The graphics format PNG is a sensible choice for the export of SoundPLAN sheets. 
Depending on the number of colors, PNG can have a significant compression with 
almost no loss in quality.  

As SoundPLAN graphics and the 3D-graphics use relatively few colors, the PNG 
format is very well suited for exporting these graphics to: 
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Size as a 24 bit - bitmap: 8,1 MB (uncompressed TIF is similar in size) 

 

Size as a 24 bit - PNG: 98 kB 

Settings for the Export of Graphics 

For the export of graphics and diagrams from the Result Table, the Expert System 
for Industrial Noise and the Graphics you can define additional options for the 
graphics formats. 

For BMP, PNG and TIF you can define the resolution in [dpi] and the color 
resolution when selecting the topic OPTIONS. 

 

If graphics are to be exported in the JPG-format, you can choose between 3 JPEG-
COMPRRESSION TYPES: YUV 4:1:1 (low resolution), YUV 4:2:2 (mean resolution) and 
YUV 4:4:4 (high resolution). For the compression type 4:1:1 the program stores the 
data as 4x1x1 bytes instead the shown 4x4x4 bytes. 
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With the switch compression quality, you can select the magnitude of the file 
compression. The higher the compression, the smaller the file and the bigger the 
quality loss of the picture. 
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11  3D Graphics 

3D-Graphics is organized in two modules. With the 3D-Graphics module you can 
view your project in 3D and move inside the data set using the mouse and cursor 
movements. The 3D Animations module allows you to use drive along roads, 
railways or a user defined track. The scenes can be stored as an AVI file so can play 
it back on any PC. 3D-Animation also includes a 3D train pass-by and the 
visualization of the level-time histogram. 

It is possible to enhance the scene with trees, roofs and (  with Cartography) 
additional 3D properties for points, lines and walls.   

Load the data as usual and call Edit Map by double clicking on the map or using the 
menu. Select VIEW -> 3D-MODEL. Depending on the graphics card and the amount of 
data, the 3D picture can appear almost instantly, or it can take a short time to 
process the data and display the picture. 

Basic principles 
The 3D-graphics uses the graphics 3D-standard OpenGL. As soon as the 3D-graphics 
is triggered, the objects are converted into OpenGL objects.  

Unfortunately, OpenGL only draws on screen and does not have its own printer 
driver. Because of this, when you click the OK button to leave 3D graphics, a bitmap 
is generated for the selected viewport. The bitmap generated here can have a 
different resolution than the screen resolution. Higher resolutions are desired if the 
bitmap is to be printed in bigger format. Bitmap here stands for a map delivered in 
individual pixels. The scene can be stored as *.bmp, *.jpg, *.png and *.tif. The 
bitmap is stored in the sheet rather than as a separate file. Depending on the 
graphics format, this storage principle can make the files for the 3D-graphics very 
big. Modifications invoked by changes in the object type settings are not instantly 
effective in the bitmap bound into the drawing. They only become effective when 
the user regenerates the bitmap by opening it with a double click on the map.  
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The speed of redrawing and manipulating 3D-Graphics depends very much on the 
speed of the graphics card. So it is wise to pay attention to the graphics processor. 
Please contact SoundPLAN if you would like a recommendation.  

Display options, views and movements   

The 3D-view can show the model as a solid model or as a wire frame with or 
without hidden line removal. Select the display type from the list.  

 

Normally the solid model is sufficient. However, for very big models, the faster 
display may prove helpful to format the drawing in the 3D wire frame model and 
activate the solid model after the formatting is finished. View parameters are the 
same in all display types.  

In the list next to the display, select what you want to manipulate with cursor 
movements. 

 

SCENE lets you move within the 3D-model. LIGHT lets you tilt and rotate the light 
source. VIEW is only active in conjunction with the module 3D-Graphics Animation 
(see below). 

In menu accessible by right clicking, there is the menu topic OVERVIEW, with which 
you can recall the view of the last saved scene (in case you got lost in 3D space).  

Movements in 3D-Graphics 

The various movement modes are selected via the right mouse button, the cursor 
keys and the mouse. All movements are relative to the 0/0/0 location of the 
coordinate system. The coordinate axis is displayed by default, but it can be 
deactivated in the menu PARAMETER -> 3D SETTINGS. The coordinate axis and the 
frame around the drawing are not displayed in the final bitmap. 

The step size of the movement is controlled using the slider to the right of the 
frame. 

The various movement modes are selected via the right mouse button, the cursor 
keys and the mouse. All movements are relative to the 0/0/0 location of the 
coordinate system. The coordinate axis is displayed by default, but it can be 
deactivated in the menu PARAMETER -> 3D SETTINGS. The coordinate axis and the 
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frame around the drawing are not displayed in the final bitmap. The step size of the 
movement is controlled using the slider to the right of the frame. 

 

Step sizes are dependent on the size of the data model, the types of objects 
present in the map (facade points of the Facade Noise Map, for example, will slow 
the graphics considerably) and the type of graphics card installed in the PC.   

The cursor changes appearance depending on the movement type. The most 
common movements are available via mouse and arrow keys. A right click on the 
canvas opens a menu with all available movements. 

 

 

 
Left mouse button + movement (or via the arrow keys): 
Move the world (move in all directions in the model) 

 
Left mouse button + shift or page up/down pull mouse wheel:  
Change distance to the middle of the world (change distance) 

 

Left mouse button + Ctrl or Ctrl + arrow keys:  
Rotate and tilt the world or light 

 

Left mouse button + Alt or shift + arrow keys: 
Move height 

For the movement in the 3D-graphics you can select how the mouse and its 
functions shall be interpreted. For example what is the reaction to rotating the 
mouse wheel forward: zoom in or zoom out? With Ctrl+ M you can customize the 
movements how you see best fit. The same settings are used also in the other 
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places where the 3D-graphics is active – Wall Design, the Expert System and the 
Geo-Database. 

You can also use the right mouse button to rotate and tilt the model and change 
the distance. Left and right movements combine the movements. Use the zoom 
command to change the focus length of the view. Caution! This will change the 
perspective of the model.  

Some modifications are not instantly visible; they require a redraw triggered 
by the REDRAW button to the right of the screen. The redraw not only 

refreshes the screen but forces Open-GL to re-render the model. As the rendering 
requires considerable calculation time, this command is not directly triggered but 
must be started by the user. If the changes you made to the model are not visible 
immediately, it is advisable to click REDRAW.  

Geometry parameters of the scene 

Use GEOMETRY VIEWPORT -> GEOMETRY PARAMETER to open a dialog that depicts all 
view parameters of the scene.  

 

The NEAREST CLIPPING PLANE is defined in the system settings of the SoundPLAN 
Manager (options -> settings, under program -> system). As different viewports 
might correct display problems, it is also possible to override the system settings 
locally by hand. 

Even good graphics cards sometimes have difficulties displaying the nearest 
clipping plane if this clipping plane is only 0.1 meters away from the object. This 
inaccuracy leads to display problems at the edges of objects.  

Try setting the minimum distance for the nearest clipping plane to 5 meters and to 
0.1 meters and check the results in the 3D-Graphics. 
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Example: Clipping plane 0.1 m  Example: Clipping plane 5 m 

3D-settings 

 

Additional settings are found under PARAMETER -> 3D-SETTINGS: 

• Perspective or orthogonal projection 

• Rotate and tilt the light along with the world 

• For display type "hidden lines": Draw lines in black or in object color, line 
width and fill color 

• Background color for scene 

• Produce a map frame: The view selected in 3D-model is shown on screen 
allowing a more exact positioning of the view  

• Display coordinate axis: Helps with navigation in 3D-graphics as the 0/0/0 
position is the pivot point for rotation  

• You can set the effects fog and ambient light in the tab index card effects, 
see "Effects" on page 631. 
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3D-Graphics model data check 
The 3D-data model check allows you to see errors in the model.   

 

The elevation errors in the example above were extreme. However, for the noise 
propagation, the 3rd dimension is crucial and the model data should always be 
reviewed with a critical eye in the 3D model check. A verification of the 3D model 
quality is a corner stone of quality assessment.  

The following data types are displayed: 

• Road and railway bands with emission lines and signal addition 

• Point, line and area sources 

• Buildings without roofs 

• Walls and berms 

• Mitigation areas 

• Elevation lines, elevation points  

• Receivers with all floors 

• General points, lines and areas 

• Digital Ground Model 

• Grid Noise and Grid Air Pollution maps 

• Facade Noise Maps 

• Meshed Noise Maps 

• Cross-sectional Noise Maps 

• File operations 
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Effects 

With the fog effect you can now simulate distances from the viewer. 

 

Open PARAMETER -> 3D-SETTINGS, (the 3D model must already be loaded via VIEW -> 

3D MODEL). 

 

Select from the pick list the fog type of choice „linear“, „exponential“ or „steep-
exponential“ and the „color", that causes the fog effect. The fog effect can be fitted 
dynamically to the middle of the scene, but you also can define the distances.  

With the switch APPLY you immediately can see how the settings influence the 
scene. Try for yourself what you like best.  

Light effect 
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AMBIENT-LIGHT is light where the source is not recognizable. It stems from multiple 
reflections on walls and other surfaces. 

"DIFFUSE"-LIGHT allows the detection of the light source. The angle to the light 
source determines how bright an object is.   

Changes in the ambient and diffuse light are immediately effective in the scene. 
Press ABORT to keep the original settings. 

3D tab in the object type setup 

For the geometry and result object types, you may configure the appearance of the 
3D-objects independent of the top view graphics settings.  

Point object types 

 

Point objects in 3D-graphics are presented in the x, y and z plane. For object 
positions on the terrain, you can choose between the bottom and the middle of the 
symbol.  

 Cartography includes additional options and possibilities. Under the Cartography 
tab, switch to the 3D-symbols.  

 

You can display the points as planes, rotation symmetric solids or as 
cylinders/cones. For trees there is an additional parameter. Select the VIEW TYPE 
from the selection list.  
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From left to right: 2 xz planes, 10 xz planes, rotation symmetric body with 18 steps 
of rotation, cylinder. 

For 3D-graphics, rotation symmetrical objects are best suited.  

Line object types 

For line type object types in 3D-graphics, the line width is interpreted as the height 
of the object. For noise control walls, the height defined in the Geo-Database is 
used to set the height of the wall. For changes in the wall height, the property 
"constant wall element" is evaluated.  

 

 With Cartography, a 3D-wall is inserted to simulate the appearance of the noise 
control wall. (The 3D wall can be inserted in all line type objects, not only in the 
noise protection wall.) 

 

Use the TRANSPARENCY setting, in order to present buildings behind a noise 
protection wall made of transparent material. 

When the posts are activated, a round post is generated at the location of every 
coordinate. If the posts are generated a little bit wider and higher than the wall, the 
construction is more vivid.  
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Area object types  

 

In order to present sources within an industrial building or a bitmap underneath an 
area source, you can assign the TRANSPARENCY in [%] in the section for 3D Graphics. 

For areas in the 3D-graphics, it is possible to assign different color schemes than in 
the top view. The border line of the area can be drawn with the set line width and 
color, which is especially interesting if you assign a transparency. 

All objects with vertical components (buildings, industrial buildings, bridges, 
mitigation areas) can have different colors for the top surface and the sides.  

    

Bridge thickness is taken over from the settings in the Geo-Database. The bridge 
edges are defined via the noise control wall built into the bridge object.  
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Buildings have an additional option to assign a color for slanted roofs (page 639).  

 

In addition, the check box SHOW PEDESTRAL extends facades that are floating above 
the DGM to the terrain. The DGM must be loaded in the Graphics. With the check 
box SHOW FLOOR LINES the lines between the floors are drawn in the color of the 
edge lines.  

 

Digital Ground Model (3D) 

The Digital Ground Model can be loaded without or with (  Cartography) a color 
elevation scale. Without a color scale the triangles are drawn in a single color. 
When SHADED is activated, the 3D character is much more vivid.   

Also see “Presentation of the DGM with continuous color flow and elevation lines” 

Grid Noise Map (3D) 

When Grid Noise Maps are drawn in 3D, the settings in the main object type of the 
Grid Noise and Grid Air Pollution Map are relevant. The map is drawn in the 
elevation where the receivers of the grid maps are calculated. In the 3D-tab, the 
button USE GROUND ELEVATIONS can be activated to project the noise map onto the 
ground. If the ground is displayed with the noise map, the program has difficulties 
in the drawing sequence with 2 objects of the same location. Therefore, it is 
advisable to add a negative value to the ground elevation.  
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Changes become active only when the paintbrush button is clicked, which renders 
the scene again. 

Façade Noise Map (3D) 

Facade Noise Maps are especially suited for displaying in 3D because the noise 
levels of all floors are shown. Variations of the layout and general configuration are 
described in the section "Object Type Facade Noise Map" (page 578).  

Drawing the Facade Noise Map on screen is very demanding of the processor, so 
please be patient with the speed of movements in the 3D-Graphics. A faster option 
is to color the entire façade according to the level rather than drawing single 
receiver locations. The 3D-settings for facade points are the same as for the 3D-
Point object types (page 632).  

Noise levels, conflict values or scale interval numbers of a Facade Noise Map can 
now be presented in the 3D-Graphics as a facade mark.  

  

The output as text means that the facade noise symbol no longer can be presented 
as a 3D symbol but that it always will be presented as a 2D symbol. For the 3D 
environment the program needs to know how far this flat symbol shall be placed in 
front of the face of the building. The default value for MOVE FORWARD is set to 1 m. 
Additionally the text SIZE in [m] can be set. The text color will be inverted if the 
contrast to the scale colors make this necessary. 
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In connection with the settings for „half-transparent“ for the building the labels 
deliver a very informative presentation. 

Cross Sectional Noise Map (3D) 

Cross sectional noise maps are very well suited to present the functionality of a 
noise map.  

 

Cross sectional noise maps can also be presented in 3D together with a digital 
ground model or a grid noise map. 

Geo-referenced bitmaps in 3D-Graphics 

Geo-referenced bitmaps can now be used in 3D Graphics with some restrictions: 

o Only a single bitmap can be present at any time for the 3D display. 

o The bitmap is only projected to a DGM, Grid Noise Map or Meshed Noise 
Map, but not to objects such as roofs and roads.  

o The border of the bitmap shows some distortion, so make the area 
bigger than the area upon which the bitmap is projected.  

 

The 3D-Graphics (OpenGL) can only use bitmaps with sizes that are a multitude of 2 
(1024, 2048, 4096, …). SoundPLAN automatically enlarges the bitmap to the next 
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size so that, for example, a bitmap of the size 1025 x 1025 pixels will become a 
bitmap of the size 2048 x 2048, in this case almost 4 times the size! The enlarged 
area is preset in white so that it will not be visible on screen.  

In the map object types, the bitmap must be enabled in the 3D-graphics section. If 
you activate the bitmap after you open the 3D-graphics in EDIT MAP, the bitmap 
must be rendered before it is visible. To do this, click on the button for new 
rendering (paintbrush symbol).  

Hint: If you have a very large grid map and want to project a bitmap onto it, it is 
advisable to first select the proper view port of the 3D-graphics and then load the 
bitmap. The usual method with the bitmap preloaded will slow down the screen 
movement considerably. 

3D-Graphics Animation 
The 3D-Graphics Animation contains the following extra features (see graphics 
sheets 07-1 and 07-2 in the example project “Wincity”): 

• Trees: 3 types of trees are delivered with the standard object setup -
deciduous trees, conifer trees and shrubs.  Cartography allows you to 
generate any shape of tree. 

• Presentation of slanted roof forms in 3D.   

• Movement mode "View" with the view from any one of the receivers 
contained in the situation. 

• Animation along an animation track (each road, railway or a user defined 
animation track, e.g. the flight to a scene) and generation of an AVI movie 
file of a simulated pass along the animation track. 

• Calculation of a train pass-by, display of the level-time histogram at any 
point of the calculation area and animation of the 2D and 3D train pass-by 
from different viewports. 

View display  

When you activate the view-mode, the center of the loaded scene becomes the 
camera position. The movement STROLING AROUND is active in this display mode.  

Mouse movements back and forward with the left mouse button pressed move you 
backward and forward. With mouse movements left and right you rotate left and 
right.  

An additional movement mode is GLANCE AROUND.  

By moving the mouse left/right your view rotates left/right. (Ctrl+ arrow keys 
right/left) or mouse movement back and forward will move your view up and down 
relative to the horizon (Ctrl+ arrow keys up/down). 
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View settings 

For the view settings, you can find an extra configuration sheet under PARAMETER -

> 3D-SETTINGS: 

 

Define if the Grid Noise Map and the triangulation of measurement locations shall 
be used for the automatic elevation modeling and if SoundPLAN should assess the 
camera position relative to the terrain.  

Activate the ground slope if you do not always want to look strictly horizontal in 
the movement mode STROLE AROUND and GLANCE AROUND. If the box is checked, 
the view will follow the terrain. Define the distance between the camera position 
and the second point used in the slope calculation. 

As it is very confusing for the viewer to move through solid walls and find himself 
inside a building, you can set a switch to disable the movement through solid walls. 
If the switch is set, it is impossible to move into buildings. If it is not set, there are 
no restrictions. 

Both the automatic tilting of the view while on the move and making sure you are 
not vanishing inside buildings take a lot of computation power and will limit the 
speed of movement in the model. 

3D View direction  

In this mode, all receivers contained in the situations and geo-files are polled and 
the views from each „window” are recreated. By jumping from receiver to receiver, 
the 3D view direction is set to be perpendicular to the façade direction away from 
the building. With selecting a particular building, the view mode is set to LOOK 
AROUND. 

Roofs 

Define the ridges on the roofs as a noise control wall and assign the graphics object 
type "ridge" to the object. This way the roof can function in the calculation as a 
barrier and the program can generate 3D roof structures from it. The third 
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dimension of the top of the roof ridge needs to be set to absolute elevation above 
sea level. If you can import the geometry of the ridges with a different definition, 
the graphics has an adjustment of the definition available for this case under 
PARAMETER -> OPTIONS. This definition is valid not only locally but as a general 
setup for all projects. The roof ridge lines must be stored in the same situation as 
the buildings themselves. 

How does the 3D graphics work? First, all ridges belonging to a building are polled 
(all ridges whose mid-point is inside a building). These lines are shortened and 
lengthened to end directly at the side of the building (if they are more than 0.1 
meters from the edge they are not extended).  Afterwards the ridges are 
triangulated and presented in 3D. If the roof does not look as planned, additional 
ridge lines may be needed to define the surfaces. The new lines must also be given 
the graphics object type of the ridge lines. 

Drive or fly along an animation track 

The animation can be carried out online in EDIT MAP or can generate an AVI file to 
be displayed by any multimedia player.  

In Edit Map, select the animation track under PARAMETER -> 3D-SETTINGS in the tab 
index card track animation. Tracks can be a user defined camera track or any road 
or railway alignment.  

 

The parameters at the top of the form define the position of the „driver.”  The 
DISTANCE FROM TRACK AXIS is the vertical offset (if set to 0 the driver drives in the 
middle of the road) and uses positive values to move to the right and negative 
values to move to the left.  

The lower half of the entry window defines the parameters of the film generation, 
such as the number of frames per second. The speed is regulated by entering the 
driving speed on the road or by defining the spacing between the pictures.  
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If the spacing between pictures is small, the film gets smoother but the size of the 
AVI file increases.  

In order to have the film as smooth as possible, it is necessary to smooth the 
animation track in the Geo-Database. For this purpose the geo-tools “Smooth 
elevations (page 171)" and "Create segments of constant length (page 161)" are 
available.  

The animation is controlled using the recorder keys.  

 

The green arrow is used to start the on-line animation. When the animation is 
running, use the red block as the pause key and the red dot as the stop key. When 
the pause key has been pressed, it is possible to look around or move around at the 
location where the animation stopped. When the stop key is pressed, the 
viewpoint returns to the overview. Use the blue arrows to move along the 
animation path between start and stop.   

Create AVI file  

Press the record key to generate an AVI file from the animation. By 
default, the animation starts with the frame you selected with the green 

arrow.  

 

The AVI file is stored in the project folder. For your information the expected size of 
the AVI file is shown. If the file exceeds your space, reduce the number of frames or 
the size of the movie. When the AVI file is generated, the file is uncompressed, so 
the files can easily become multiple gigabytes. The internet is a good source for you 
to choose compression programs. Please also be aware to use a common CODEC 
because this driver must not only be present on the PC generating the compressed 
AVI but also on the PC playing it back.  
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2D and 3D animated noise map 

For the time being, the animated noise map is only available for railway noise. The 
railway must be entered using a standard that utilizes the maximum noise level.  

The following conditions must be fulfilled for an animated noise map: 

• In the railway properties (emission calculation railway) provisions for the 
maximum noise level must be made; trains must be selected that constitute 
the maximum noise level.  

• In the calculations, the calculation run for the maximum noise level must 
have an assessment that enables the maximum noise level. Storage for the 
maximum noise level must be enabled under the tab „assessment.”  

• Under the section RESULTS in the tab index card grid noise map, the 
ANIMATED NOISE MAP (TRAIN PASS-BY) box must be checked.  

The calculation of the level-time-histogram needs to calculate all grid points; 
therefore, the interpolation is deactivated. The position of the train is stored every 
0.125 seconds.  

During the calculation, the animated noise map generates very big files. Moreover, 
the calculation time increases, because the interpolation of the results is disabled.  

Load the calculated grid noise map along with the geometry data in the file 
selection manager of the graphics. Double clicking on the map opens the “edit 
map” section. Here you must load the level-time file containing the charts of the 
noise level over time. Select LOAD LEVEL TIME HISTORY from the selection list and 
click on the check box ACTIVATED. The animation control bar is displayed. 

 

With the check box CENTERED the geometry moves with the train pass-by. Start the 
on-line animation with the green arrow. While the animation is in progress, the 
stop and pause buttons are active. After the animation is run, you can move the 
slider to visualize a particular time of the animated noise map.  

If you left click on the noise map, the program opens a box with the level-time 
histogram.  

Clicking the red recorder button on the animation controls saves the animation as 
an AVI file, see "Create AVI file (page 641)".  

Caution: Depending on the operating system, the size of the AVI files are restricted 
to 2 respective 4 GB. This size can be reached easily with high resolution animated 
maps of some kilometers of train tracks in urban area. 

When the level time charts are loaded, a left click on the map will open the chart 
for the area where you are clicking.  
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Grid operations with animations  

The animations are also calculated for grid operations. This way you can for 
example display two train pass-bys with a displace in time or two train pass-bys in 
different directions.  

If one of the animations should begin later, enter this in the extended formula 
entry with the parameter:   

GMN53:1:100 ++ GMN54:1; 

The animation 53 starts 100 time steps (~125 seconds) later than animation 54. 

 

3D Train Animation 

 

A Grid Noise Map with the activated option „Animated Grid Map (moving train)“ 
must be calculated.  

Load the grid map and the geometry into the Graphics. 
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To present the train in 3D the train axis must be marked as reference line in the 
Geo-Database. 

For the presentation of the train, the sub-object-type „Emission line“ of the train 
object is used. In the top view the train is presented as a line, in 3D as a solid figure. 

For the color and thickness of the train, the normal line display is used. In order for 
the train not to be covered by the emission line, the emission line itself must be 
deactivated.  

The length of the train and the length of the rail cars are defined in the tab index 
card Cartography: 

-  PATTERN SIZE  = length of the train  
-  PATTERN RATIO  = approximate length of a rail car 

In 3D the width and height of the train cannot be altered, the train body starts 30 
cm above the railhead and is 2.5 meters wide and 2.8 meters tall. 

Presentation in 3D 

In order to present the train-animation in 3D, the data must be loaded while the 
Edit-Map facility is operating in 2-D. After loading the data, switch to the 3-D mode. 
Please make sure that the object types for the grid noise map has the switch USE 

GROUND ELEVATIONS set in the tab 3D of the object settings. 

In the settings for 3D there is a new tab for the train animation, select one of the 4 
different way of presentation: 

• Keep the current view 

• Move with the train and look at the noise map from a position on the train 
in a defined angle. 

• Move with the train and look towards the center of the of the animation 
world 

• Look from the center of the animation towards the train. 

Depending on the animation setting, select the position relative to the animation 
track (distance to the front of the train, height above the train) and the view angle. 
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12  Noise mapping projects 
and strategic noise maps 

This chapter deals with the handling of large projects in the field of noise impact 
analyzes, conflict maps and summed-up conflict maps and the creation of strategic 
noise maps according to the EU Environmental Noise Directive. 

In order to cope with such projects, additional tools have been integrated into 
SoundPLAN in different modules, which are described here together. Individual 
components of the processing of large amounts of data, such as the evaluation of 
elevation grids, are already described in the corresponding chapters, here it is only 
referred to. Therefore, in this chapter we must assume that you are familiar with 
how SoundPLAN works. 

The following topics are covered in detail: 

• Tile system - Divide the study area into tiles of the same size 

• Implementation of the EU Environmental Noise Directive 

• Conflict maps and summed-up conflict plans 

• Process elevation points for a tile DGM 

Tiling projects 
In order to process big noise studies without losing the overview and keeping the 
loading times, calculation and graphics preparations times as short as possible, the 
entire project can be sectioned into equally sized tiles. The basis of the tiles is a 
geo-referenced background graphics. The x- and y-size of the tiles can be different 
from each other.  
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The tiling manager 

Preparing the tile project: generating the background graphics 

First you need a geo-referenced background bitmap. The best way to get this 
graphics is to generate it directly in SoundPLAN with large-scale data that cover the 
geographical scope of the project (e.g. the main roads and districts). Small-scale 
information or an aerial photo is unsuitable.  

Examples: 

 
Left image: small-scale information, right image: only a few large-scale information in 
different gray shades  

Hint: Please keep in mind that the graphics for the background of the tiling needs 
to be opened each time the tiling manager or the navigator is opened. Depending 
on the size of the used geo-referenced bitmap and the throughput of the PC this 
can amount to considerable time. For this reason, the background image is 
converted to gray-scales for the tile manager. 

Store the situation and load it in the graphics. Invoke "edit map" and store 
the data via EDIT -> CREATE GEOREFERENCED BITMAP in one of the available 

data formats. The background graphics generated this way is used in Geo-
Database, Calculation core and the graphics to graphically select the area for which 
data need to be loaded. The background graphics is always presented by the tiling 
manager in gray tones to allow other content which is in color to be superimposed 
on it. 

Setting up the tiling system 

Open the Geo-Database and open the situation manager with VIEW TOOLS -> 

TILES, or with the symbol button TILING MANAGER. 
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Overview of the symbols in the tiling manager: 

 

Define a new tile system with and select the size for the tiles in [meters]. 
Depending on the project size enter the size for the tiles in x-direction and y-
direction individually in a value scope of 500 meters to 10 km. Because of the 
nowadays screen dimensions rectangular tiles advisable. It might be sensible to use 
different tile sizes for dealing with roads or buildings.  

As soon as the tile size is determined, select the background graphics. Only geo-
reference files with the extension *.grf are presented. The tiles are superimposed 
on the bitmap and the tiling system is completely defined. 

Open FILE -> OPEN BITMAP, if you want to select a new background graphics for 
tiling.  

You have the possibility to zoom within the tile manager. Click on the symbol 
button ZOOM or use the mouse wheel. 

Working with tiled projects 

When loading data, the tile manager opens up to let you select for which 
geographical region you need the data. The default only entire tiles are loaded. If 
you want to activate an area free of the constraints of the tile borders, deactivate 
the button ‚tile“. In the calculation core it is only possible to select complete tiles.  

 Select complete tile 

 Select free range 
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Click on the button CANCEL SELECTION  to cancel the selection of the area 
marked in red.  

Each tile has a unique tile-ID (A0, A1, … depending on the location in the tile 
system), this should help with checking individual tiles in different parts of the 
program. The logbook will always write entries with the reference to the tile, if you 
are opening the tile manager and move the cursor over a tile, the status line will 
show the tile-ID. A0 is the lower left tile (horizontal axis (A, B, C, D, …), vertical axis 
(1, 2, 3, 4, …)).  
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Document the project status tile by tile 

For each tile you can document the status of the project:  

 

Open the tiling manager (either in the situation manager or via the tiling 
navigator) and press the symbol button EDIT. In this mode you can enter the 

status for the activated tiles. Aside from the status you can also enter the name of 
the operator and write comments pertaining the status of the project or what 
needs to be done or where problems were found with the data. 

The project statuses to be assigned tile by tile are: 

• undefined (no color) 

• currently edited (yellow) 

• calculating (blue) 

• contains errors (red) 

• done (green) 

By right clicking (on a tile or activating an area), the tiling log book is opened. It 
contains all entries for each of the tiles. 
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This information is stored in the situation file. If the calculations or graphics are 
using only a single situation, the log book is presented here as well. You can then 
define the project status for example to mark the area as having errors. This way 
you can find it in the tiling manager right away. 

Tiling navigator 

In the Geo-Database and in the Graphics under VIEW -> NAVIGATOR the tiling 
navigator is opened where you can easily change the geographical area for which 
the data are loaded.  

Aside from the navigator buttons with which you can quickly change the area, a 
little overview window is presented. You can move the navigator any place on the 
screen even move it outside of the drawing area.  

  

When you move with the navigator arrow into an area from which no data have 
been loaded, the Geo-Files for the area are loaded instantly which may result in a 
little delay. 
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Via the symbol tiling navigator in the middle of the arrows you open the full tile 
manager to choose a different area or to enter the project status for the tiles. 

You can move the overview window out of the navigator and zoom it at will. Left 
click on the double line on top of the overview picture and move the graphics 
window. If you want to recombine the windows, move it with the left mouse 
button to the navigation window until you see a gray double line on the right side 
of the arrow keys. 

Tiling projects in the Geo-Database 

When a situation is loaded in the situation manager where a Geo-File contained in 
the situation is completely outside of the area selected in the tiling manager, the 
Geo-File is not loaded. 

As the program need to load entire Geo-Files when the file is opened for editing, it 
is advisable to structure the Geo-Files in such a manner that the data are stored 
borough by borough with each section of town represented by a different Geo-File. 
It is also advisable to contain the data of variants and noise types in separate 
situations, this way the tiling manager can keep track of the project status. For the 
calculation and the graphics, it is also possible to load individual Geo-Files in 
addition to situations. 

The tile manager opens up to let you select the region of your project you want to 
process as soon as a project has been organized with tiles. The region is selected 
before the situation manager starts. Keep the left mouse button pressed to select 
the region or directly select the tiles you want to load for processing. By clicking the 
OK button, the data are loaded.  

Import data in tiles 

The Shape-file and ASCII import is accessible in the Geo-Database Situation 
Manager under the menu topic TOOLS, so you can distribute the data to different 
files in a tiled environment.  

 

Select the geo-referenced bitmap in the tiling manager and select the area for 
which you want to import the data.  
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Enter a text which will be used as the prefix in front of the coordinate area. The 
text and the coordinate range will be used for naming the Geo-Files.   

The text “building_“ will generate Geo-Files with the names  

building_X30Y25 
building_X30Y26 
building_X31Y26 
.... 

For the sake of the file names, the kilometers are truncated. In case you plan to 
read and distribute data from multiple imported files for the same tiles using the 
same prefix, the new files will be amended with a successive number (1)..(n).  

The standard settings of the objects cannot be set at this location. The screen for 
defining the settings cannot be started from outside the edit facilities of the Geo-
Database. Please define these standard settings with property functions at a later 
stage. 

Calculate tiled projects 

Tiles help in the structured processing of a project, but they are not meant to be a 
replacement for calculation area. Results for grid noise maps, meshed noise maps 
and facade noise maps are only generated within the calculation area.  

For the calculations a tile size of 2 x 2 km has proved itself as it delivers an optimal 
relationship between loading and calculation time and yields data size that are still 
manageable.  

The calculation core needs information beyond the tiles where it is requested to 
produce results. For this reason, data within the maximal search radius around the 
selected tiles will be loaded.  

If the project is set up for tiles, the tab General in the calculation properties box 
allows the project to be calculated tile by tile- even tiled and distributed to multiple 
PCs in a network. Distributed Computing processes each tile the same as a non-
tiled environment, thus the speed advantage remains even if there is only a single 
tile. 

 

Activate CALCULATE TILES and click the button TILES to select the tiles to be 
processed. The status of the tiles as defined in the Geo-Database, are presented in 
color, so you can see which tile needs to be calculated and which is not done with 
data entry. Unfortunately, this service is only available is you use a single situation 
to manage your data.  

Select all tiles with Ctrl+A or pull open a frame around the desired tiles (selection of 
not continuous tiles with additionally pressed Ctrl-key).  
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A dialog opens that shows the status of the selected tiles. 

 

For a partly calculated calculation run you can this way mark all tiles with Ctrl+A 
and then use the dialog to pass over all tiles already done with the calculation.  

Under VIEW -> TILES you can see the status of the tiles. Depending on their status 
they are differently colored: 

 

Completely calculated tiles are displayed in green, currently calculated in red. 
Additionally you can see if a tile was not calculated because there were no 
receivers in the tile or because no sources were found in the defined search radius. 
If there is more than one "red" tile visible it is quickly identified that there are tiles 
with errors as they were started but did not finish their calculation.  
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There is an additional overview window under VIEW -> OVERVIEW OF THE TILE 

CALCULATION RESULTS to step through all already calculated results with the arrow 
keys or a click on an individual tab. This is possible even if multiple run files from 
different projects are open.  

Hint: Because the calculation stops at the end of a tile the overview window closes 
automatically after a certain time.  

Tiling projects in the graphics 

In the graphics use the tiling manager to select the region for which you want to 
load the data. After the selection of the region proceed to the selection of the files.  

If you click OK without selecting a region, all data will be loaded. 

The selected region is automatically fitted into the scope of the visible frame with 
the maximum zoom factor. 

 

Use the navigator arrows (VIEW -> NAVIGATOR) to go to the next scope and the tile 
manager (symbol in the middle of the navigator area or EDIT MAP AREA in the file 
selection) to select another scope.  

Preprocess elevation data for the Calculation Kernel 
If you need to filter elevation points for very big areas, the amount of data is too 
big to open these elevation points as a Geo-File in the Geo-Database. Therefore, 
there is a separate import interface in the Geo-Database for preprocessing these 
data under FILE -> IMPORT -> PREPROCESSING ELEVATION DATA. 

The data are filtered the same way as described in the chapter Geo-Database, 
section filter and import elevation data (page 114). 

Move files outside of areas / corridors to a sub-folder  

With this task you can move all elevation files located outside of selected areas or 
line corridors to a sub-folder. Entire files will be moved, not only the part that is 
located within the selected area. The sub-folder is generated in the normal project 
folder. 



SoundPLAN Manual 8.1 
Noise mapping projects and strategic noise maps 

Preprocess elevation data for the Calculation Kernel  Page •  655/793 

12 
Filter points in outlying areas with increased tolerance 

Often the area of a community consists of areas with buildings and outlying areas 
with fields, forests and meadows. As in the non-built up areas the accuracy is not 
quite as important as between buildings, a bigger tolerance can be chosen here.  

 

As soon as you select this task, a dialog opens to select the Geo-File. Select the 
Geo-File with the area(s) and/or lines (e.g. roads / railways) outside of which the 
coarser filter value shall be used. The line corridor width is only valid for line type 
objects. Determine the FACTOR FOR COARSER FILTER VALUE in the elevation filter.  

Clip elevations at areas (e.g. buildings/roads) 

This task provides elevations within areas or line corridors without filtering them. It 
can be helpful for example to use elevations of the roofs of buildings for the 
building height or elevations in road bands to determine the road elevation with a 
separate DGM.  

  

The amount of data of these elevations is often not too big, so that you could store 
them with the task SAVE ELEVATIONS TO directly to a Geo-File.  

Save elevations to 

The filtered elevations are in most cases saved to the sub-folder ElevData. The files 
in this sub-folder are directly assigned for the tile DGM calculation in the 
calculation kernel, if needed together with additional elevation points or elevation 
lines in the project.  The elevation data are always stored in tiles of 10 x 10 km.  
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In addition, you can save the data as Geo-Files which are not automatically loaded 
to the Geo-Database.  

The filtered data can also be stored as ASCII files, for example to use them in 
another system. 

Combine elevation data from different sources 

It might happen, that you get elevation data from different sources in different 
accuracy for one project. In this case you determine when storing the data what 
should happen in overlapping areas. 

 

You can either update the data completely (DELETE EXISTING FILES), delete existing 
data in overlapping areas (REPLACE EXISTING ELEVATIONS IN OVERLAPPING AREAS) 
before new (more accurate) data are imported or ignore the new data in 
overlapping areas if the existing elevation data are better (IMPORT ELEVATIONS ONLY 

OUTSIDE OF OVERLAPPING AREAS). 

Save file frames to a Geo-File 

With this task the frames of all elevation files are stored as general areas in a Geo-
File. In addition, the file name is written in the center of the area as a Geotext. This 
is very helpful, if you want to get an overview of the scope of the delivered 
elevation data.  
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Map section, overview map and sheet tools 

Generate Map Sections 

Map sections are very helpful if you want to present multiple sheets with the same 
content but varying sections (viewports), i.e. if you have a single Grid Noise Map 
and want to divide the presentation into many sections like a world atlas. You can 
automate the generation of multiple sheets with ease and thus can present your 
findings with a high resolution on multiple pages.  
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You can generate the map sections manually from the Geo-Database or automated 
directly from the Graphics. Map sections are always rectangles. In the Graphics you 
can -like in previous versions- process the map viewport in Edit Map. For licenses 
without the Cartography module the map section is saved as a general area and the 
sheet name as a Geotext. When the Cartography module is present the section is 
saved as a new object type, the map section and is to be saved under user defined 
names. 

 

To generate the map sections in the Graphics, you need a “template sheet” with a 
plan which has the desired size and scale.  

The current map viewport can be saved as a Geo file via EDIT MAP/GEOMETRY 
VIEWPORT -> SAVE CURRENT MAP SECTION AS GEO FILE.    

A typical application for this procedure is to create multiple map section frames 
along the route of a planned road or railway. Load the Geo file with the map 
section into the situation along with the base data you want to present and 
duplicate the map section and rotate and move it in plane. To duplicate the map 
section mark it and move the cursor to the purple route in the middle of the object 
and with the ALT + left mouse button move a copy of the object to a new location. 
You can rotate the new map section with Ctrl +left mouse button movement.  All 
new map sections need to be hosted in the same Geo. 

 

As an alternative to the manual generation of map sections in the Geo-Database 
you sometimes want to generate a grid of plans covering the entity of the entire 
map. Create your “template sheet”, load it in the Graphics (inclusive of the 
calculation area) and via Edit map GEOMETRY VIEWPORT -> CREATE MAP SECTIONS 

FOR ENTIRE CALCULATION AREA create a grid of map sections to display the entire 
calculation area in the desired resolution.   
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You can decide to generate map sections covering a rectangle around the 
calculation are or only the sections that contain part of the calculation area.  

The map sections are automatically named according to your settings: 

• Continuously numbered 

• Rows as letters, columns as numbers 

• Columns as letters, rows as numbers 

• Middle coordinates X/Y in [km] 

• X/Y of the top left corner in [km] 

The two last options are only available when the middle coordinates are set to 
kilometers and the map has the size of multiple kilometers so that the maps are 
not overlapping.  

Example: The scale factor is set to 1:10.000 and the map shall have the dimension 
of 200 x 200 mm. If the map shall feature a frame of 5 mm, the map size must be 
set to 210 x 210 mm. 

You can format the section name for example to insert an additional identifier or a 
separator between the variables for example to display the default section name 
X3530Y5422 as X3530/Y5422. 

The section names can be included as a text into the plan with the function “Show 
attributes as text” of the file selection manager. Include the parameter Tools/Map 
section/Name as the text. The file containing the map section however must have 
been loaded once in the Geo-Database. 
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Overview map  

In the overview map all map sections found in the Geo-File are displayed along with 
the geometry.  

 

A plan is marked as overview map in "Edit Map", GEOMETRY VIEWPORT -> GEOMETRY 

PARAMETER.  

 

Additionally, for very large sale investigation areas it is possible to scale the 
overview map and center the displayed map section in the overview.  

In the map object types select how to format the map sections and -if loaded- the 
map section names. The object type CURRENT MAP SECTION IN OVERVIEW MAP 
determines how the currently displayed map section shall be highlighted in the 
overview map. 
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In accordance to the map section of the overview the data are loaded in the main 
plan. The coordinates in the middle of the section rectangle are calculated and set 
as the middle coordinates for the viewport. Select the desired map section from 
the pop-up-menu (right mouse button) or with Alt + Left click. With FILE -> MAP 

SECTION or F7 the map sections are listed on the left hand side of the screen and 
can be loaded from there with Drag&Drop.  

The TEXT VARIABLE „Map name“ is filled with the map section name as soon as a 
map section is selected or defined from the sheet tools. 

The TEXT VARIABLE „Map section-text“ can contain additional free text attributes 
that you can assign with the Property Explorer of the Geo-Database. 

Sheet-Tools 

With a sheet that contains map sections or areas (usage areas) it is possible to 
automate the generation of sheets, print the sheets or create bitmaps for the 
sheets. If a Grid Noise Map is loaded the grid noise map sections can be exported 
to the ESRI-ASCII-Grids or as a contour map.  

The map section or the area names are used as the text variable „ Plan name“, and 
for the sheet and the export file name. 

Load or activate the map section / areas via FILE -> MAP SECTION or <F7>.  

Select the Geo file with the map section / areas. If an overview map with the 
selected map section visible is contained in the sheet, it is automatically set to 

show the loaded section. With the cog wheel select a different Geo-File and go to 
the settings. 

Modifying the map section / areas only changes the middle coordinates of the plan.  

Settings for the processing of the map section / areas  

 

CALCULATE ROTATION: is only sensible for maps that are not set up to be parallel to 
the coordinate axis, i.e. sections along a road or railway line. The rotation is 
measured from the first line of the section rectangle. 
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CALCULATE MAP SCALE: the map section or respectively the Min/Max-rectangle of 
the area is fitted to the map with regarding the parameter DISTANCE TO THE FRAME. 
Printing the scale bar gives a better understanding then using the scale factor 
numbers. 

LOAD RESULTS ONLY IN THE MAP SECTION AREA: is only sensible for areas as otherwise 
the data are loaded for the section anyway.  

USE OBJECT TYPE „CALCULATION AREA“: it only sensible for areas. Via the area the 
„background“ definition in the tab Cartography the plan outside the calculation can 
be masked. 

With OK list all map sections / areas on the left the same way as the sheet tree is 
listed. Select a desired map section and load it using the arrow to the right or with 
Drag & Drop. 

To trigger the sheet tools, mark the map sections or select all with <Ctrl+A> and 
click on the symbol button SAVE UNDER. 

  

Select the desired action; it is also possible to run them parallel to save time.  

 

The SETTINGS have been already explained in the chapter for the definition of the 
map sections.  
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CREATE SHEETS generates an SGS file for the map sections / areas with the name of 
the section / area so that you can post process the sheets individually.  

PRINT SHEETS prints all marked sheets. The sub folder indicated here is only relevant 
if you want to create plot files, i.e. reroute the plotting stream into a file. If you 
want to create a PDF file, you need to also observe the settings of the printer 
driver. Often you can define a sub folder and use the file name created 
automatically by SoundPLAN (from the sheet name).  

EXPORT GRID VALUES exports the grid values in ASCII or GeoTiff format. You can 
define if levels on buildings are regarded as sufficient levels and how many digits 
after the decimal shall be used. 

EXPORT CONTOUR LINES TO SHAPE FILES exports the results of a Grid Noise Map for 
the selected map section / area as an ESRI Shape files (details can be found in the 
chapter Graphics, Export of contour lines). 

EXPORT SHEETS AS A BITMAP exports the entire sheet as a bmp, jpg, tif or png. 
Resolution and compression parameters are definable. 

EXPORT PLAN AS BITMAPS only exports the main plan including its frame. If you only 
are interested in the plans, set the frame size to 0 in the plan settings. 

The file name is important for the execution of the sheet tools:  The file name must 
contain a “%” as the place holder, the “%” in the file name will be replaced with the 
map section name. 

Effects for the calculation area 

When working with areas set in the sheet tools the option USE OBJECT TYPE 

CALCULATION AREA, to allow the following options.  

 

In the object type calculation area, tab Cartography define the method to clip the 
background outside the area or have only the basic geometry printed.  
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Left picture: no effect (with area border), right picture: do not display results 

    

Left picture: Do not display objects, right picture: additionally, with background 
color 

When the area outside the calculation area / area is not to be displayed, the area 
within the section rectangle between the calculation area and the frame is filled 
with white or another background color. 

When masking with color intensity settings or converting into gray scales, first the 
entire plan is plotted. After this a windows function defines the entire „clipping 
area“. For screen and bitmap output this procedure is working well but most 
printer drivers cannot cope with this procedure. Additionally, print files and PDF 
files are becoming so big that it is advisable to first generate a bitmap when 
working with masking.  

Processing Noise Mapping Results according to the EU 
Directive 

The transfer of the EU Environmental Noise Guideline into national law gave a lot 
of the reporting requirements a local component where details of the statistics of 
exposed inhabitants, exposed areas and special buildings (schools, hospitals ...) are 
defined. Please acquire the information about the procedures locally in your 
country SoundPLAN may not know all details to be a reliable source here. 
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Schools, hospitals, kindergartens 

Schools and hospitals (in some countries kindergartens too) must be accounted for 
and their numbers have to be assigned the individual noise zones. 

In the Geo-Database always enter the usage type (school, hospital, kindergarten) 
for each building in the Property Explorer.  

Special buildings are treated as normal buildings, which means that if inhabitants 
are assigned (for example for the care taker family) the inhabitants are accounted 
for the normal way. 

Marking buildings as special buildings does not have to be done before the noise 
map is calculated as the information is directly taken from the geometry data. 

Building clusters 

A special building can be comprised of multiple single buildings. As soon as the field 
PROPERTY NUMBER contains the same text for multiple buildings, the cluster of 
buildings in the final processing for the statistics will be treated as one building 
cluster. 

When defined as a building cluster, the statistics for the „loudest level“ and the 
„energy mean value“ are derived and accounted for the entire building cluster (see 
Settings for the EU-Statistics, page 669.). 

Subdividing multiple areas 

You can divide your investigation area into multiple areas (community, borrow) and 
generate a joint statistics with entries area by area. The borders of the areas must 
be contained in the data as „area usages“. In the tabular results the object name is 
presented, the number of inhabitants and the area usage are irrelevant here 

Area and inhabitant statistics in the SoundPLAN Spreadsheet (area table) are based 
on the area usage and assign area size, number of inhabitants, number of dwellings 
and special buildings. 

The areas are even accounted in the statistics if they have been generated after the 
calculation of the noise map. 

Calculation 

Calculation of the façade noise level 

If you set the calculation of the facade noise levels (Facade Noise Map) to VBEB 
(Germany) in the calculation settings for RECEIVERS ACCORDING TO VBEB receivers, 
then are generated in accordance to the rules of VBEB: 
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• Facades longer that 5 meters are divided into smaller segments for which a 
single receiver is calculated. 

• Facades with a length between 2.5 meters and 5 m are represented by a 
single receiver 

• Smaller facades are ignored except if multiple subsequent facade segments 
reach the combined length of more than 5 meters. In this case the combined 
façade is then treated as a façade longer than 5 meters and if needed 
subdivided into 5 meter sections. 

This procedure is advisable for non-German areas as it generates a sensible 
distribution of inhabitants and dwelling units as long as the accounting does not 
required setting the loudest level as default for the entire building. 

The EU Noise Mapping leaves the member states some freedom, for example has 
Austria chosen to set receivers along a facade at a spacing of 3 meters, select the 
setting RECEIVERS SPACED with a distance of 3 meters. 

Hint: As soon as at least one facade has been activated in the Geo-Database for the 
calculation with the Facade Noise Map, all receivers for that building are switched 
to be calculated in accordance to VBEB.  For the calculation of the façade noise 
levels in Austria, all facades must be activated. 

Calculation of noise contours 

For the calculation of noise contours (Grid Noise Map) in Austria for example a grid 
spacing of 5x5 meters is required, in Germany the standard is a 10x10 grid. 
Additional settings are not required. 

Hints for the calculation of very large areas 

For the calculation of facade noise levels and grid noise maps for very large 
calculation areas it is paramount to analyze the ratio of invested calculation time 
and accuracy up front. This for example can be accomplished with a statistics 
calculation run, see „Statistical accuracy“ on page 378. 

The following recommendations for the calculation parameters in the calculation 
core should be checked in any case and possibly should be coordinated with your 
client. 
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Filter the elevation data for the DGM sensible during the import in the Geo-
Database. If the DGM is too dense, the calculation and loading time increases 
significantly. 

The reflection order has a considerable influence on the calculation time. If 
possible, reduce the refection order to 1 and use in city environment the Geo-Tool 
„Estimate multiple reflections (page 177)" to account multiple reflections in street 
canyons at the side of the emissions. 

Restrict the search radius to between 2000 meters and 4000 m depending on the 
question of how far prominent noise sources can be heard. 

The allowed tolerance can be set to 0.5 - 0.8 (total result) for large projects. 

If necessary, reduce the refection distance around source and receiver.  

For grid noise map calculations, the interpolation can interpolate much more if you 
change the difference (Interpolation during the Grid Noise Map Calculation (page 
347)) to 0.5.  

Post processing in the SoundPLAN Spreadsheet (area 
table) 

The post processing of the EU statistics has been implemented in SoundPLAN 
flexible enough that the same procedures in SoundPLAN can be used throughout 
the entire EU with their diverging national implementation of the EU Directive. As 
there are big differences in the national ways, you first of all need to settle what 
data is required for your country and how the data shall be processed (for example 
the accounting of the quiet façade or the distribution of the number of inhabitants 
amongst the façade receivers). As soon as the table with all settings, title texts and 
other settings is fulfilling your needs, you are best advised to save the table as your 
template for the noise mapping project. 

The accounting can be accomplished for the entire calculation area or it can be 
based on individual usage areas. For that reason, the EU statistics are integrated 
into the area table. 

Normally the area table only processes „area usages “. In case the selected Geo-File 
or Situation does not contain any area usages, the EU-statistics is then applied for 
the entire calculation area. 

Which EU-Statistics are available? 

• Inhabitant statistics: Accounting on the basis of façade noise levels (from 
Façade Noise Maps) 

• Area statistics: Accounting of the noise in outside areas (Grid Noise Map, 
Meshed Noise Map) 

Open the Spreadsheet and in the file manager select the FILE TYPE „Area table 
(conflict map)“. 
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In the initial selection select the Geo-File or Situation in which area usages and 
calculation area are contained. 

The data for the statistics (buildings, dwellings, residents) are taken from the 
Situation that was used during the calculation of the Facade Noise Map or Grid 
Noise Map. The request to enter a situation for the area table only will affect the 
area definition by loading the areas from either the same situation or from a 
secondary situation where mistakes in the areas have been corrected. 

With the switch COLUMNS you can deactivate the columns for „inhabitants" and 
„size“, that are irrelevant for the statistics, before the file is loaded.  

Via FILE -> ADD ADDITIONAL COLUMNS select the desired EU statistics. 

 

After selecting the proper result file (depending on the selected statistics a Facade 
Noise Map for the building statistics or the Grid Noise Map or Meshed Noise Map 
for the area statistics), you get to the dialog where you define how and with which 
time slices the EU-statistics shall be evaluated (see “Settings for the EU-statistics” 
on page 669). 

Afterwards select which data and which time slices you want to use. 
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The EU-statistics will be calculated separately for each area. When more than one 
area is present, the program automatically will generate a sum line that sums up 
the data of the areas. 

Hint: 

• The calculation depending on the size of the areas and the requested task 
can take several minutes or even longer! 

• The buildings needed for the statistics are automatically loaded from the 
data of the run file that is kept with the results. 

• One area table can only contain a single EU-statistics. The area table thus 
cannot contain both the building- and the area- statistics, neither is it 
possible to have a comparison of variants in the area table. 

Settings for the EU-statistics 

Because of the diverging requirements for the EU-statistics, some clarifications 
need to be made: 

 

Level ranges 

First you need to decide if the results are accrued for an interval (for example levels 
between 50 and 60) or if the level is understood as a threshold value (i.e. >50 
includes values above 50 and values above 60). 
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This selection can be changed at a later time via OPTIONS -> DOCUMENT SETTINGS -> 

CURRENT DOCUMENT, for other changes the statistics must be regenerated with FILE -> 

REBUILD TABLE! 

Statistics of exposed residents 

Assignment of residents to dwellings: 

ASSIGN ALL INHABITANTS AND DWELLINGS TO LOUDEST VALUE accounts all residents 
and dwelling by using the loudest on the building occurring noise level interval for 
all residents and dwelling. 

When you choose the setting ASSIGN INHABITANTS AND DWELLINGS ACCORDING TO 

THE LEVEL ON THE FACADE SECTION, there are 2 different ways to proceed: 

• When the facade receivers were generated according to VBEB (Germany), all 
inhabitants are distributed equally amongst the facade receivers, likewise 
the dwellings. 

• For all other settings in the calculation of the Facade Noise Map, the 
inhabitants and dwellings are distributed according to the facade length 
representing each individual receiver. 

If the Façade Noise Map was calculated floor by floor also in the statistics the 
inhabitants and dwellings are floor by floor assigned to the corresponding level 
interval. 

Assessment of the quiet facade 

Like in many places in the execution of the END, here too there are many national 
ways of determining what the quiet facade shall be, here some possibilities: 

The relevant receivers for the assessment of the quiet facade can be located on the 
facade or 2 meters in front of it. The additional receivers 2 meters in front of the 
façade are calculated when you request ADDITIONAL RECEIVERS 2 METERS IN FRONT 

OF THE FACADE in the RUN SETTINGS under the tab Façade Noise Map (Caution the 
calculation time will double!). In case the 2 m receivers were calculated, they will 
be used to assess the quiet facade, otherwise this is done directly with the 
receivers on the façade itself. 

To assess the quiet facade, the loudest noise level found on the building or per 
floor is determined and compared with other receivers on the facades (or 2 meters 
in front). If the difference between the maximum and the assessed receiver 
exceeds 20 dB, the inhabitants and dwellings associated with the receiver are 
accounted for as being on a quiet facade. 

As long as a maximum acceptable noise level has been set for the quiet facade, this 
is also checked. Only receivers below the threshold level that make the 20 dB 
difference criterion make the grade to be accounted for in the table of the quiet 
façade. 
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To set the threshold, check the box USE MAXIMAL VALUE FOR QUIET FACADE. 

Caution: 

• The assessment assumes that the first time slice in the assessment library is 
the Lden. The first threshold value always assumes that is meant for the 
Lden for all other time slots the second threshold value is used. 

• In Austria the level must be 5dB below the threshold value, i.e. if the 
threshold value is 50 dB the value set in SoundPLAN must be 45 dB. 

Assessment of hospitals, schools and kindergartens: 

If inhabitants and dwellings have been assigned to these buildings, those figures 
will be used in the accounting. 

For the assessment of special buildings, the property number is used to determine 
which structures belong to the same building complex and then the accounting is 
dome treating the building complex as a single entity. 

Example inhabitant statistics: 
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Area statistics 

The area size for the individual noise level intervals by internally rastering the 
contour map and accounting the level found in the middle of each grid cell to the 
interval it falls in. The areas within buildings are ignored, that means that in a 
situation where all levels are above 50 dB and also the buildings are exposed to 
high noise levels, the area accounted for as being above 50 dB is smaller than the 
entire area itself, in fact it will be the area minus the cumulative size of all 
buildings. 

The settings and the processing of all other values is the same as in the inhabitant 
statistics, the only difference is that checkpoints along the facades must be 
generated first. These checkpoints are generated in accordance to the procedures 
from VBEB (see „Calculation of Façade Noise Levels”). 

Example area statistics: 

 

Variant comparisons using the statistics 

You can import multiple variants of an inhabitant or area statistics into a single area 
table to create variant comparisons according to the affected inhabitants or area.  

 



SoundPLAN Manual 8.1 
Noise mapping projects and strategic noise maps 

Processing Noise Mapping Results according to the EU Directive  Page •  673/793 

12 
To interconnect multiple statistics, select the column type TABELLE -> ADD COLUMN -
> INTERVALS. To compare the effectiveness of different noise control measures, the 
difference between the intervals is not a good decision criterion by itself. In 
addition, it is recommended to calculate the sum of the noise effected persons for 
each variant. Enter the formula SUMXstatisticsscolumn (no blanks permitted) in a 
value column. 

EU-Statistics in the Graphics 

The graphical representation of area and inhabitant statistics is not part of the EU 
Directive but an additional feature in SoundPLAN. The building statistics is selected 
in the graphics via the data type EU BUILDINGS (ANNEX VI). 

Settings and calculations are the same as in the area table except that in the area 
statistics you must define the intervals separately, in the graphics this is done via 
the scale. 

The difference may be in what data are used: in the area table the accounting is 
done on the basis of areas or the entire calculation area and in the Graphics it is 
always representing all data loaded. 

The area statistics may show a little variance between the area table and the 
graphics as the area table accounts only grid cells where the center is in the 
calculation area, the graphics accounts for all loaded grid points. 

With a 10 x10 m grid for the calculation, some of the scan points will be outside the 
calculation area but will also be added to the area size. 

Peculiarity in the presentation of the areas 

• For the calculation of the area sizes for each noise level interval (respectively 
above a threshold value) the contour map is always rasterized in a 1x1 m 
raster. 

• The receivers for the assignment of inhabitants, dwellings and special usage 
buildings to the noise level intervals is always done in accordance to VBEB 
(see „Calculation of Facade Noise Levels“), except when all values are set 
only to the highest level found on the entire building. 

Peculiarity of the Facade Noise Map 

If the Facade Noise Map was computed only on a single elevation (most often in a 
height of 4 meters above ground), there is no difference in the statistics of the area 
table and the graphics. 

If multiple floors were calculated, for example in the framework of an action plan, 
the floors are treated as separate entities as if each were a separate building. This 
means that inhabitants and dwellings are equally distributed amongst all floors and 
per floor the questions of the quiet façade is evaluated separately. 
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In the area table the statistics is always calculated for all floors. In the graphics 
select the floor for which you want to display the statistics. The statistics is then 
computed only for the selected floor, including the selection of the loudest façade 
and the quiet façade. 

In addition, you have the option via the floor selection to set it to all floors. Here 
the loudest façade and quiet façade are evaluated jointly for all floors of the 
building and thus the results should be the same as in the area table (provided you 
have calculated the same content and loaded it). 

According to the selected scale, the building itself is filled with the color of the 
loudest noise level found on the building; the façade where this level occurred is 
marked. For the quiet façade the values with the loudest floor are used, therefore 
it can occur that a building in the statistics is set to have a quiet faced but in the 
Graphics it is not indicated as the loudest floor in the position where the quiet 
façade exists, may be above the noise threshold. 

CAUTION: For the calculation of the statistics (regardless if area table or in the 
graphics) the data are used that were used in the calculation run, the situation 
requested in the area table is not used here; neither is the geometry loaded in the 
graphics relevant here. If you rename or delete Geo-Files or Situations after the 
calculation run was done, this will result in a change in the statistics as the result 
files keep a copy of the file names rather than a copy of all data. 

This procedure still allows you to start calculating the noise maps before you have 
entered all data for the inhabitants or have sorted out the special usage buildings. 
Or it might be that you get more accurate information on the number of residents; 
you can add the information and just recalculate the statistics. 

Conflict map / Summed-up conflict map 

Conflict map 

Conflict maps show limit violations for each of the area usages of one noise type. 
The limit violations sharply change at the area usage boundaries. 

The basis of the graphical representation is an automatically created Spreadsheet 
of the file type area table.  
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How to generate conflict maps 

Go to the file selection manager in the Graphics. Load the geometry and select the 
file type "Area table (Conflict map)". Click on the double arrow to define the 
content of the conflict map 

.  

Select first a Situation or a Geo-File which includes the noise zones / area usages 
and assign it with a double click or the arrow. The file is automatically assigned to 
the upper part of the dialog. Then select the file type Grid Noise Map or Meshed 
Noise Map from the file type selection list. Choose the result file and the time slice 
you want to display. The default assessment is the assessment used in the 
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calculation run. If necessary, you can select another assessment from the selection 
list. Click OK. 

Now you are asked for the column of the automatically created area table you 
want to display in the Graphics.  

 

The pre-settings are suitable for the graphical representation of the conflict map: 
The value you loaded in the conflict map definition (column of the area table), the 
display kind (calculated value (conflict)) and "show values above 0" or with a 
correction.  

Click OK to view the conflict map on the screen.  

You can view the area table that is the basis of the conflict map with a right click -> 
CONFLICT /AREA MAP and process it to prepare summed-up conflict maps. 

Procedure for summed-up conflict maps 

Generate a “normal” conflict map in the Graphics. Click right to open the area table 
(right mouse menu -> CONFLICT /AREA MAP).  

 

Automatically created area table 

The area table is another type of the Spreadsheet. Instead of the receiver points, 
the area table is built up according to the usage areas defined in the Geo-Database. 
You see the names of the noise zones in the first column, the area usage type in the 
second, the zone size, the number of inhabitants if defined in the fourth column, 
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the limit level per zone in the fifth column and the average noise level day minus 
the limit level in the last column (formula GV0-x5;).  

How to interpret this formula? 

SoundPLAN creates a copy of the grid map for each area covering just the 
boundaries of the grid map. This copy is filled with the values according to the 
formula: Use Grid Value from the grid map which is assigned to this column (0) and 
subtract the value in column 5 (limit value).  

Please see chapter Spreadsheet (page 407) for details. 

To add grid values of another Grid Noise Map for a summed-up conflict map, go to 
FILE -> ADD RESULTS. Load another calculation result file, select in the next dialog the 
time slice and if necessary, another assessment (e.g. if you used another 
assessment for industry noise) and import the data into new columns. Click OK. 

Now you can sum up and weigh the results in a new grid column. 

Enter a new grid column (TABLE -> INSERT GRID COLUMN) for the summed-up 
conflicts. 

Go to TABLE -> TABLE SETTINGS and enter the formula for the summed-up conflict. 
The following example adds the single conflicts of both grid maps: 

GV6 ++GV8;  Please read section "formula editor (page 426)" for details. 

Leave the table settings and click yes to recalculate all columns.  

The area table shows the average value of all grid columns. Therefore, a conflict 
may occur in a part of the grid cells even if the average is < 0.  

Hint: This formula for summed-up conflict adds all grid points. I.e. there might be 
grid points that do not have a single conflict but a summed-up conflict. 

If only grid points with a single conflict should be taken into account, us CV (conflict 
value) instead if GV: 

CV6 ++CV8; 

Example: 

Conflict value of the grid point in column 6: -0,1 

Conflict value of the grid point in column 6: +0,5 

The formula "GV6 ++ GV;" adds both levels. 

The formula "CV6 ++ CV8;" ignores the "-0,1" and returns the result of column 8. 

Go back to the Graphics with FILE -> RETURN TO GRAPHICS and save the table under a 
new name.  

To change the displayed values (time slice, noise type, summed up conflicts) in the 
conflict map, go to the file selection manager, right click on the file *.bfl and select 
column 7 from the selection list.  
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Annoyance Analysis 

A Facade Noise Map is necessary for creating annoyance analyses and other 
implementation of the EU Directive on Environmental Noise.  

Supplementary Necessary Information 

For an annoyance analysis, add additional information to the building properties 
(e.g. number of occupants, employees or pupils per building, or the zone type) and 
import them to the SoundPLAN spreadsheet for analysis. 

In most cases, you won't know the occupants per building, but you can also use the 
number of occupants per area or calculate them in the SoundPLAN spreadsheet 
using the floor area. 

Define the usage areas in building blocks, in order to prepare the graphical display 
of affected people per hectare. 

It would be useful to select the buildings where no one lives or works, store them 
in separate Geo-Files and assign 'auxiliary buildings' in the building properties. In 
this way, these buildings won't be taken into account in a Facade Noise Map 
calculation. 

Working on an Annoyance Analysis in SoundPLAN 

Load the results file and exclude unnecessary columns in the TABLE SETTINGS. 

Call FILE -> ADD ADDITIONAL COLUMNS -> COLUMNS WITH ADDITIONAL INFORMATION, 
select a situation that includes the buildings and choose the information that shall 
be added. 

Then create a new value column and interpret the information using formulas. 

Example: 

"Building area x number of floors" has been loaded in column 25. Assuming that all 
buildings are residential buildings and there is one inhabitant per 40 m² floor area, 
create a value column and enter the formula "x25/40;" to obtain the number of 
occupants per building. 

If you want to determine the number of affected people over an Lden of 65 dB(A), 
add another value column and calculate the affected inhabitants per building with 
the formula  

IF "Column Lden" > 65  
   THEN "column number of occupants per building"  
   ELSE 0; 

to calculate the number of occupants per building. 

Use TABLE -> TABLE STATISTICS to show the affected people for the whole area. 
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For the graphical result check and presentation, the magnitude of the conflict 
should be mapped in the Graphics using a colored scale. Within the SoundPLAN 
spreadsheet create a new area table (FILE -> FILE TYPE -> AREA TABLE) with the 
building blocks that were previously prepared in the Geo-Database. Select FILE -> 

NEW and load the Situation or Geo-File containing the building blocks as area 
usages. Then load the column with the affected occupants per building from the 
original SoundPLAN spreadsheet (which is a table referenced to a point list): 

FILE -> ADD ADDITIONAL COLUMNS ->COLUMN FROM RECEIVER TABLE and select the 
Spreadsheet and appropriate column. 

Use the column operation to select how to insert the contents of the column in the 
area table: 

 

Select if only values > 0 should be loaded. 

In order to obtain a convincing statement of the annoyance, the affected people 
per building block must be standardized to a specific reference size (e.g., to 
affected people per km²). 

Create another value column and enter the appropriate formula: 

"Column affected people" / "Column size of the building block in m²" * 1000000; 

Call the Graphics, load the situation and select the file type AREA MAP (CONFLICT 

MAP) in the file selection manager. 
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Select the column you want displayed. Additional selections are possible. 

The result "affected people per km²" might appear as: 

 

Total noise assessment according to VDI 3722-2 
The German VDI 3722-2 is mainly a systematic compilation of already accepted 
concepts, papers and reports. This new standard is offering a procedure to 
calculate annoyance and sleep disturbance when more than a single noise type is 
the culprit. This paper is still somewhat limited as it only regards the transportation 
noise sources (road, railway and aircraft) and disregards the industrial noise. The 
basis of the new standard are the dose response curves for annoyance and for 
sleep disturbance from the "Position Paper on dose response relationships 
between transportation noise and annoyance (page 369)".  
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General procedures: 

• Calculation of Grid Noise Maps and Facade Noise Maps for each of the 
noise types (road, railway, aircraft).  

• Calculation of the percentage of the annoyed or sleep disturbed persons 
as annoyed, highly annoyed, sleep disturbed and highly sleep disturbed 
(% A,% HA, % SD, % HSD) and the number of affected persons, each for 
the transportation noise sources of road noise, railway noise and aircraft 
noise. 

• Backwards calculation of the re-normed substitute noise levels (L*r, TAN, 
L*r, N) on the basis of the numbers of affected persons for railway and 
for aircraft noise. 

• Estimation of the „sum level“ (effect based substitution level, L A, ES) for 
all traffic noise sources. 

• Definition of a noise indicator for the geographic presentation (hotspots) 
and to facilitate a ranking. 

 
Flow chart 

Formulas for the implementation of the VDI 3722-2 

For the implementation of the VDI 3722-2 file operations and the SoundPLAN 
Spreadsheet are fitted with a new set of formulas.  

The formulas are using the following keywords: 

A=Annoyed, HA=Highly annoyed, SD=Sleep disturbed, HSD=Highly sleep disturbed,  

STR=Street, RAI=Railway, AIR= Aircraft, TOT=total, MOD=modified (modified 
formulas), TOTMOD=total modified. 
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(x) either refers to the column of the Spreadsheet or the Grid Noise Map / Grid 
Noise Map Operation and the time slice.    

VDI3722_HAstreet(x7) - Spreadsheet 

VDI3722_HAstreet (RKL600:1) – Grid operation in the Calculation Kernel or the 
Graphics (the number after the colon refers to the time slice). The re-normed 
substitution level results from a grid operation. The result is therefore indicated in 
the formula with RKO. 

% Annoyed / % Highly annoyed / % Sleep disturbed / %Highly sleep disturbed 

VDI3722_Astreet(x) VDI3722_HAstreet(x) VDI3722_SDstreet(x) VDI3722_HSDstreet(x) 

VDI3722_Arail(x) VDI3722_HArail(x) VDI3722_SDrail(x) VDI3722_HSDrail(x) 

VDI3722_Aair(x) VDI3722_HAair(x) VDI3722_SDair(x) VDI3722_HSDair(x) 

VDI3722_Atot(x1,x2,x3) VDI3722_HAtot(x1,x2,x3) VDI3722_SDtot(x1,x2,x3) VDI3722_HSDtot(x1,x2,x3) 

VDI3722_A_totmod(x1,x2,
x3) 

VDI3722_HA_totmod(x1,x2,
x3) 

VDI3722_SD_totmod(x1,x2,
x3) 

VDI3722_HSD_totmod(x1,x2,
x3) 

Backwards calculation of the Re-normed Substitute Level 

VDI3722_RE_A(x) VDI3722_RE_HA(x) VDI3722_RE_SD(x) VDI3722_RE_HSD(x) 

VDI3722_RE_Amod(x) VDI3722_RE_HAmod(x) VDI3722_RE_SDmod(x) VDI3722_RE_HSDmod(x) 

Effect Related Substitution Level 

VDI3722_ES_A(x1,x2,x3) VDI3722_ES_HA(x1,x2,x3) VDI3722_ES_SD(x1,x2,x3) VDI3722_ES_HSD(x1,x2,x3) 

VDI3722_ES_Amod(x1,x2,
x3) 

VDI3722_ES_HAmod(x1,x2,
x3) 

VDI3722_ES_SDmod(x1,x2,x
3) 

VDI3722_ES_HSDmod(x1,x
2,x3) 

For formulas adding up the total noise and for the calculation of the effect related 
substitution level, three levels (x1, x2, x3) must be entered in the formula.  

x1 - Road noise 

x2 - Railway noise 

x3 – Aircraft noise  

If a noise type is missing, enter 0 for the missing noise type.  

Example: VDI3722_A_totmod(RRKL101:1,RRKL102:1,0) 

Depending on which noise type you have to evaluate and how the tasks are 
defined, you only need to define a subset of the grid noise map operations or 
define only a portion of time slices for the grid operations. If the re-normed 
substitution level is not required, it is not needed to have this result calculated as a 
separate step.  
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Modified formulas 

We suggest using the modified formulas in SoundPLAN because the formulas of 
VDI3722-2 are only valid for the value range defined in the standard. As part of the 
generation of a test case the formulas were modified for the edge zones. 

According to VDI 3722-2 the formulas are valid for the determination of %A for 
road and railways in the zone of 37 dB ≤ L,r,TN ≤ 75 dB and for aircraft noise in the 
zone  37 dB ≤ L,r,TN ≤ 65 dB. For the percentage of highly annoyed persons the 
lower border is 42 dB. The value range in the nighttime to determine %SD and 
%HSD is 40 dB ≤ L,r,N ≤ 65 dB for all three noise types.  

The modified formulas linear interpolate in the lower value ranges between 0 and 
the lowest defined value, in the value ranges above the definition the values are 
extrapolated.  

Calculation with the file operations in the calculation 
kernel 

Go to the Calculation Kernel and select as CALCULATION TYPE Tools - grid operations 
or FNM operations. Enter the desired time slices.  

To enter and later edit the formulas click on the edit symbol and activate the 
check box EXTENDED.    

 

% Highly annoyed road (formula for row 1) 

 

% Highly annoyed total with modified formulas (formula for row 4) 

 

Hotspots with Total Annoyance or Total Sleep Disturbance 

For the presentation of the Total Annoyance/Sleep Disturbance you need a 
Spreadsheet in the form of the receiver table with which to calculate the total 

 



 SoundPLAN Manual 8.1 
 Noise mapping projects and strategic noise maps 

Page • 684/793 Total noise assessment according to VDI 3722-2 

12 
annoyance/ sleep disturbance from the number of affected persons, the 
population number per receiver and the annoyance factors Nj.  

Calculate a separate Facade Noise Map for road, railway and aircraft noise.  

Generate a Spreadsheet (receiver table) and load the results of the Facade Noise 
Map. Calculate the annoyance and load additional columns with the number of 
inhabitants per facade and floor or the number of inhabitants per receiver. With 
the formula "Annoyance x number of inhabitants " you can calculate the 
annoyance factor Nj. 

 
Example table 

Go to the Calculation Kernel and select the CALCULATION TYPE "Tools - Hotspots". In 
the tab "General" click on the double arrow next to DATA and enter the Situation 
with the buildings and inhabitants, a calculation area and the Spreadsheet. For the 
presentation in 3D you also need a DGM. 

Select the columns of the Spreadsheet that shall be used to calculate the Hotspots.  

 

For this type of hotspot calculation, it is important to use the calculation method 
WITHIN THE GRID, which corresponds to a summation per grid cell. 
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Load the results of the hotspot calculation as a file type GENERAL GRID MAP for the 
presentation in the Graphics. Deactivate the contour lines in the plan object types 
and activate the grid presentation.  

 

Level statistics in the Spreadsheet 

In an Area Table you can read in the content of the receiver table as level statistics 
or a limit value via fixed intervals. Open a Receiver Table with FILE -> ADDITIONAL 

COLUMNS -> ADD LEVEL STATISTICS and select which column shall be processed. 
Additionally, you also need to have a LEVEL COLUMN, that will be the source of 
information for the column operations.   

 

You can insert multiple level statistics in sequence into the area table.  
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Process receivers with non-identical positions 

For the assessment of the total noise, the individual assessments for each noise 
type often are done in accordance to different standards and guidelines that place 
the receivers in slightly different positions. In the end the noise levels for each 
source type must be accrued to the total noise. So far, the SoundPLAN Spreadsheet 
could not add these contributions as the rece3ivers did not have identical positions.  

Now you can clarify how receivers are treated. The document settings allow for the 
possibility of using the location with (x / y/ z) coordinates and additionally can 
choose the following options:  

• x / y / floor 

• Object number / floor 

Before generating new result columns, select the option #3 “object number/floor” 
as the receivers differ in their coordinates. It is self-evident that receivers belonging 
to one another must share the same object number and thy must be unique. 

Preparation in the Geo-Database: 

Single receivers: The best option is to host the different receivers in different Geo-
Files. To do this, generate the original receiver, save it in a Geo-File, with the 
Situation Manager copy the Geo-File and open it in another situation (make sure 
that the original receivers Geo-File is not part of this situation). In “GEO-TOOLS -> 

REASSIGN RECEIVERS TO BUILDINGS” there is a new option to “change distance”. This 
option is only active when the option “use existing building reference” is active. 

If you also want to change the height of the first floor, you can do so in the 
Property Explorer. 

Facade Noise Map calculation: The buildings must have unique object numbers. If 
only the distance to the facade is changing, no additional action is required. If the 
height of the first floor changes, you need to duplicate these buildings and correct 
the first floor height in the property explorer. Again, make sure that both buildings 
have the same object numbers. 
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13  Aircraft Noise 

The emission for aircraft noise can be found in two different types, analytical flight 
path can be defined with headings, turn to instructions like the air traffic controller 
would give to the pilots or these paths can be generated in the form of backbones 
from recorded flights. The second type is the simulation of single or multiple 
recorded tracks. The “radar tracks” can be from the primary radar for the x/y part 
of the track and from the secondary radar response of an aircraft’s transponder or 
the data can be recorded directly from the ADSB broadcast that ADSB equipped 
aircraft are sending. As the origin of the recorded data is different, so is the format 
used to record the data. Flight tracks are usually generated in close cooperation 
with the airport and air traffic control, in a generalized form, they need to 
represent the existing traffic or the proposed or studied traffic conditions. The 
flight tracks can be used to analyze the existing traffic/ noise situation or can be 
used for a prognosis. Comparison between the scenarios can indicate advantages 
and disadvantages of planning scenarios. Radar tracks as they are based on actual 
flights can only be used for existing situations, a prognosis is not possible unless the 
flights are generalized into backbones and the aircraft numbers are the variable to 
change. The simulation with radar tracks in general has the advantage that it 
represents the existing situation very well with minimal amount of data entry and 
definition.  

For most aircraft noise simulations, a DGM is required to define the location of the 
receivers on the ground, for the project a suitable project coordinate system should 
be defined. 
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Radar tracks and backbones 

The calculation of aircraft noise based on flight tracks is available for all calculation 
standards that SoundPLAN has implemented. The direct simulation with recorded 
radar tracks is only offered for the standards: AzB 2008, ECAC Doc 29, 3rd edition, 
4th edition and CNOSSOS. 

 Airport 
Select the symbol for the airport to define the airport reference point. All other 
data are relative to this coordinate. The aircraft noise definition box appears and 
automatically will open the tab for airport data. Enter the airports ICAO-code and if 
needed correct the project coordinates for the airport reference point.  

The airport elevation for calculations in accordance to the AzB 2008 and the DIN 
45684-2012 only have informative character and will not be used in the calculation 
as runways fro take off and landings are automatically placed on top of the DGM.  
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The airport usage for civil / military is only available for the AzB 2008, for other 
standards this is irrelevant. 

For the definition in accordance to ECAC the environmental parameters of relative 
moisture of the air, temperature and air pressure need to be defined. These 
parameters are used to calculate the flight profiles and are needed for the 
calculation of the backbones and for the import of recorded radar tracks. Changing 
these parameters will not influence radar tracks already imported.  

 

Under the tab general define the general airport information and the emission time 
slices that can differ for aircraft noise from the settings made in the SoundPLAN 
Manager.  

 

You can define up to 24 time slices, i.e. one time slice for every hour of the day. An 
X for the respective hour for START TIME OF THE TIME SLICE marks the beginning of 
the time slice. The time slices are listed in the table below. Enter the respective 
DESCRIPTOR. 

Be sure to only have one airport reference point in a situation as all other 
objects are defined relative to this airport reference point and are automatically 

geometrically defined to the airport reference point. If multiple airport reference 
points were found in a situation there is an ambiguous relationship which will lead 
to errors. 

! 
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 Runway for starts and landings 

 

Runways for take-off and landings can be either digitized graphically with the 
runway reference point or via the aircraft noise definition screen with the tab 
runways/ traffic history. 

 

Additional runways can be generated via the list on the left, can be copied or 
deleted. In SoundPLAN each runway is associated with two directions of departure 
and approach, therefore with 4 different operational configurations In the 
presented example there is start and approach for the directions 09 (to the east = 
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90 degrees) or respective for the direction 27 towards the west with 270 degrees. 
Runways are always referenced by the rounded compass heading divided by 10, so 
landing on runway 27 means that the aircraft is heading west for landing. 

 

 

For the definition and also the calculation, the runway direction and the relative 
position of the runway reference point to the airport reference point is important 
as is the relative position of the runway reference point to the start point and the 
threshold position. 

The definition of the start point and the landing threshold (and later on also the 
flight tracks) is always in the reference system σ. If a starting point for a start 
direction is in front of the runway reference point (this is normally the case), the 
starting point usually is a negative distance. For the modeling of landing aircraft it is 
very difficult to describe the track in a way that the landing aircraft would actually 
land on the runway and at the correct spot. For this reason, the data entry of 
landing aircraft is the opposite direction than the aircraft movement. So the 
modeling starts with the touch down point and then describes the path the aircraft 
has taken to get to this position. For the landing, the touch down point usually is in 
front of the runway reference point and therefore the distance is positive. 

For an airport in accordance to AzB 2008 it is necessary to define the traffic 
statistics of the last years for each direction and each emission time slice in the tab 
traffic history. 
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 Tracks and  APU 
The flight tracks are defined in tabular form. Depending on the standard various 
track types are available. 
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For the calculation of aircraft noise from recorded radar tracks only approach and 
departure can be regarded. Pattern flight and APU usage cannot be derived from 
the radar data and thus cannot be simulated with imported data. 

 

With the list on the left in the under the tab Track, APU name additional flight 
tracks can be generated or copied and deleted. After selecting the appropriate 
track type, the data entry adapts to the required format for the type of operation. 
The track type presented above is an example for the takeoff of a fixed wing 
aircraft in accordance to AzB 2008.  

The definition of the flight track is done with a series of straight segments and 
standard turns to left and right that start where the last segment ended and end 
with the new heading of the aircraft. Please remember that for the approaches the 
definition is done in the reverse order of the actual flight. Changes in the corridor 
width are updated with VIEW -> REFRESH or Ctrl+ R.  

By changing the operations direction (LANDING DIRECTION) the track reverses: 

If you change the display of the flight track to print the tracks „with properties“, the 
corridor edges are presented in the Geo-Database.  
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Left landing direction 09, right landing direction 27 

Corridor width and source lines 

The noise emission of a single flight track is distributed within the selected corridor 
width. The number of source lines used in this distribution depends on the 
standard used.  

AzB 2008  15 parallel emission lines 

DIN 45684 5-15 parallel emission lines 

ECAC Doc 29, 2nd Edition 7 parallel emission lines 

ECAC Doc 29, 3rd Edition 7 up to 13 parallel emission lines 

 
Exemplary presentation of a flight track with 3 partial corridors 
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Special case: helicopter landing pad 

For a helicopter landing pad (the typical application of the DIN 45684) for 
systematic reasons a runway is needed. Typically only a single auxiliary runway is 
used (direction of the runway is unimportant). Takeoff and landing are performed 
on the runway reference point. 

Like always the start point and the threshold/touch down point and also the 
emission lines are automatically set on top of the DGM. 

As a specialty for helicopter noise, the buildings are regarded. This way for a 
helipad on top of a building, the start and landing point are set to the top of the 
building and the flight track can start/end on the roof of the building underneath. 

 

Track and traffic data 
For each of the flight tracks there needs to be a tab for the entry of the traffic data 
to define how many aircraft are flying on this particular takeoff or landing track.  
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The classification of the different aircraft depends on the standard selected for the 
aircraft noise simulation. In the columns for the individual time slices (for the 
definition) the number of flight operations needs to be defined for each aircraft 
class for each assessment time slice. The time frame for the noise assessment by 
default is set to 180 days (according to AzB the 6 months of the year with the most 
traffic) but this definition can be changed to any other time frame. Other common 
settings will evaluate the aircraft noise for the entire year (365 days), or for 180 
days or 1 day or 52 days (all Sundays of the year). These settings need to be made 
in agreement with the national or other responsible authorities or need to be set to 
reflect the need of the study to be undertaken 

Via the button QSI-IMPORT in the tab traffic data all traffic data for all present 
tracks need to be imported. For the import of ta complete model, please refer to 
„QSI Import / Export“ page 701. 

In case aircraft classes you need are missing or need to be amended, use the direct 
access via the button CLASSES in the library. 

Aircraft class library  

In the system library all aircraft classes are present that are needed (and 
documented) in the standards implemented in SoundPLAN. The project and the 
global library can be amended at will. 

In general, all aircraft classes of an airport are imported via the QSI interface or are 
via the radar tracks. In this case the library is used mostly to check the data 
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imported from outside sources or to assign individual aircraft classes. Only for very 
small airports or helicopter landing pads with very few relevant aircraft you will 
want to assemble the data in the library.  

In the aircraft noise entry screen, click on the button CLASSES. If no aircraft have 
been defined in the project yet, first the project library is generated. In the next 
step the system library is filtered for the aircraft classes required in the selected 
calculation standard. An empty project library is opened, now select the aircraft 
classes in the system library and copy them with the button >> PROJECT into the 
project library.  

 

Under the tab profile you find the entry for the emission level including the 
directivity and additionally the speed profile, elevation profile and the additional 
level depending on the distance σ‘ (σ‘=0 at the starting point and the threshold). 
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For a better control of the entered data, diagrams are visualizing the data. You can 
switch the diagrams between ON (Octave levels), LWN (sound power) and RN 
(directivity factor).  

 
Diagram directivity of an aircraft class in accordance to AzB 2008 

Aircraft classes ECAC 

For ECAC Doc 29, 3rd edition the aircraft classes as supplied by Eurocontrol are 
available in the library under AIRCRAFT CLASSES -> AIRPLANE DATA (ECAC). Via the 
import interface it is also possible to import the data from INM (US Department of 
Transport software) directly into this library.  

Open the aircraft data via AIRCRAFT CLASSES -> AIRPLANE DATA (ECAC).  

The entry for an aircraft consists of the following entries: 

 

The individual definitions are interlinked and contain all information for various 
flight profiles. As an example, the Boeing 737-300 contains 1 approach profile and 
12 different departure profiles. Each one of these profiles a has a different 
description of the flight segments (see the lower table). 
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For the calculation model in accordance to ECAC 29/3rd edition you need to 
assemble the required aircraft classes and flight profiles in the library AIRCRAFT 

CASSES -> AIRCRAFTS (ECAC). The element name is automatically generated from the 
aircraft name, the flight profile and the aircraft weight.  

 

Only the aircraft classes (with profile) assembled here are available to the 
calculation model. 

Import of the aircraft class databases (ECAC and INM) 

Open the aircraft class library with AIRCRAFT CLASSES -> AIRPLANE DATA (ECAC).  

Via FILE -> IMPORT you can select on the right side if you want to import ECAC data 
(*.csv ) or INM data (*.dbf).  
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Flight track computer 

With the flight track computer, it is very easy to control (and extrapolate the 
numbers for the future) the number of flight operations. Various possibilities exist, 
for example to multiply all flight operations for all tracks and classes with a 
constant factor. After triggering the calculation you must confirm to keep the 
manipulations with an „OK“. 

 

Work in the Geo-Database  
It is sensible to use the capabilities of the Geo-Database with its Geo-Files for 
structuring the model. The following minimum structure is a typical example for 
structuring a calculation in accordance to the AzB 2008 for a big airport (also see 
the example project on the program DVD): 

 

The Geo-file „DES – Runways“ contains the airport reference point and the runways 
for start and landings. 

 

The Geo-files DES-APUs, DES-Helicopter, DES-Prop and jet aircraft and DES-Taxiing 
contain the individual flight tracks.  
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Example: DES-Taxiing 

With the organization of the individual route types in individual Geo-files it is much 
easier later on to select, display and process particular operations. 

QSI Import / Export 

For the AzB 2008 and the VBUF, it is possible to import and export entire airports in 
the QSI format. The entire calculation model of an airport including additional data 
such as buildings, receivers are written to the export files. When importing the 
data, make sure that you have set the standard for the aircraft noise model (in the 
settings of the SoundPLAN Manager) to the same standard that was used exporting 
the data to QSI.  

It is sensible to generate a DGM and assign it to a situation before you import as all 
data are referenced to this DGM.  

Start the import with FILE -> IMPORT -> QSI and select the qsi-file.  A complete model 
can be exported with FILE -> EXPORT -> QSI.  

Calculating aircraft noise 
First define/select the noise descriptors you need in the assessment library. For 
aircraft noise it is common to use: 

Leq averaged for the defined time slices 

Lmax aircraft noise Absolute max level for a selected time slice 

NAT aircraft noise Number of noise events exceeding a user defined threshold 
value in a selected time slice 

Threshold by NAT 
aircraft noise 

(or inverse NAT-criterion). The threshold value is documented 
that led to a selected number of events exceeding the 
threshold value for a selected time slice. 

Awakening due to 
aircraft noise 

The awakening reaction in accordance to a German DLR study 
for a selected time slice (ZfL (2005) Nr. 4 - Juli, Markus Basner, 
Ullrich Isermann, Alexander Samel) 
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For the noise assessment type „NAT aircraft noise“ in addition to the time slice the 
threshold value and a Rw value for the building shell needs to be defined. For the 
awakening reaction, the Rw value of the building is required. 

In the calculation core under the tab general in the left pick list select the category 
AIRCRAFT NOISE and in the right pick list select the CALCULATION TYPE.   

 

For aircraft noise you can calculate single receivers, Façade Noise Maps, Grid Noise 
Maps and Cross-sectional Noise Maps.  

Enter the situation(s) and the Geo-Files for the calculation and assign a DGM.  

In the tab for assessment select the desired noise assessment from the assessment 
library and tell the program which of the noise descriptors you want to use. 
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In the tab Aircraft Noise select the standard for which the aircraft noise is to be 
calculated. (the default is set in the SoundPLAN Manager under the standards 
section). 

For single receivers and Facade Noise Maps it is also possible to save a Lmax 
statistics. Check the box for MAX LEVEL STATISTIC (SUM), if you are only interested in 
the resulting distribution off the maximum noise level.   

 

If you request the detail result tables, additionally for each aircraft class the 
detailed max level statistics will be stored. Please observe that the statistics is using 
the emission time slices from the airport definition and that the file size of the 
stored data can be very large. Such a statistics practically therefore is only usable 
for selected single receivers. 

Under the tab for the respective calculation types you set the parameters used in 
the calculation. These parameters are the grid spacing and interpolation controls 
for the Grid Noise Map and Cross-Sectional Noise Map and the settings for the 
Façade Noise Map. To save calculation time you can opt to calculate only a single 
receiver per façade, a setting that is sufficient for most aircraft noise studies.  

 

For the calculation with radar tracks additional parameters need to be defined 
under the tab radar tracks, see page 717. 
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Document aircraft noise with the Result Tables 

In the ANC-table (detail table) the level contributions of a flight track or a radar 
track are documented for the time slices calculated. For a calculation in accordance 
to AzB 2008 additionally the „alpha“- and „gamma“-values are saved for each flight 
track. These values document the utilization of the flight track in years past. 

The detail tables for „maximum noise level statistics“ and „diagrams“ are closely 
connected. In the tab „diagrams“ the distribution or the sum frequency function of 
the maximum noise level is presented for the selected receiver. 

 

The content of the diagrams is governed by the settings in the table „max level 
statistics“. With a right click on the table the following options can be selected: 

The selection of individual time slices or all time slices: 

 

The choice to present the max level statistics for all aircraft classes or only to 
display the sum of the classes: 
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Left max level statistics –only the sum, right side statistics but differentiated for each aircraft 
class 

The definition of the scaling:  

 

With this scaling the interval borders and interval sizes can be set. The smallest 
interval step is 1 dB. Most commonly 1 dB and 5 dB steps are used. The time 
reference is usually set to present the results per day. 

Presentation of the aircraft noise protection zones in 
the Graphics 

The aircraft noise protection zones in accordance to the German law can be 
generated automatically. In the file selection select the data type LIMIT MAP and 
assign the calculated Grid Noise Map to the plan. 

 

In the settings for the noise limit map, select the type of airport and the time slices 
and noise limits. 
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Depending on the airport type the aircraft noise protection zones are automatically 
defined. For the time slice night additionally, the encasing area is generated from 
the Leq and NAT values of the Grid Noise Map. 

 

For the correct display in accordance to the German aircraft noise law, it needs to 
observe that the line positions in the object type limit map is set to DRAW THE LINE 

OUTSIDE AREA EDGE. 
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Work with radar tracks 

SoundPLAN can import radar tracks recorded in one of the three data formats 
(Stanly, Fanomos and Topsonic). During the import each radar track is assigned an 
aircraft class from the database of aircraft classes. The aircraft class is dependent 
on the desired calculation standard as it is selected in the SoundPLAN Manager. 
During the import into a special database, SoundPLAN performs various checks and 
sometimes needs to adjust the given data to be usable for the aircraft noise 
calculation. Radar tracks not suitable for the calculation (for example pattern 
flights) are automatically discarded. After a successful import it is possible to 
calculate any of the descriptors (Leq, NAT, Lmax or max level statistics) for single 
receivers and horizontal and vertical noise maps for any time slice defined in the 
assessment library. The results are identical to the noise calculations based on 
conventional back bones. 

Library – airplane data (general) 

The library „airplane data (general)“ contains information about the correct 
assignment of the „aircraft type“ (AC-type) from the radar tracks to the emission 
library (aircraft data) of AzB 2008 and ECAC Doc 29, 3rd Edition. Invoke LIBRARIES -> 

AIRCRAFT CLASSES -> AIRPLANE DATA (GENERAL).  

 
Exemplary presentation of the definitions fora Boeing 737-400.  

The element name „B734“ is used during the import as a database key and 
therefore needs to be the same as is stored in the radar tracks as the „aircraft 
type“. Some attributes from the settings such as producer, model, description and 
maximal takeoff weight are informative and are not evaluated during import. For 
the import and correct assignment, the two last pick lists are the most important. 
Via the selection of the AzB or the ECAC class the import automatically assigns the 
emission to the radar tracks. The database delivered with SoundPLAN can be 
amended at will.  
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Preparation of the import 

Before we can import radar tracks, we must have the airport defined with its 
runways and need to have made a DGM and assigned it to the Situation.  

Step 1: Import of radar tracks into a database 

Start the import of radar track data via FILE -> IMPORT -> RADAR TRACKS -> AIRPORT-

DATABASE SYSTEM.  

Define the settings for the import of radar data and what data to import.  

 

Via IMPORT TYP select the data format of the radar tracks. 
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The radar tracks to be imported are saved in the SoundPLAN database format 
(*.abs). The NAME OF THE DATABASE can be assigned at will or can be taken from a 
list of already existing databases. The database is saved to a sub folder of the 
project under the name „RTDatabaseFiles“. 

With the folder symbol select any number of files (radar tracks) for import. 
The organization of the data is up to the user. For small airports it may be 

advisable to save a complete year in a single database file. With this the project will 
be very compact as only a few databases need to be created. For a very big airport 
with many flight operations it may be sensible to split the data and create a 
separate database for each month. This decision will not restrict future 
possibilities, it only changes the database management and helps with a clearer 
data handling.  

COORDINATE ADJUSTMENT: In general, the radar tracks must be available in the 
same coordinate system and reference system as the rest of the data from the 
project. During the import however, it is possible to shift the data in x or y 
direction.  

When importing Fanomos-data, it is possible to have an ELEVATION CORRECTION (to 
adjust a difference between the ground and the position of the radar data 
receiver).  

For the import of Fanomos- and Topsonic-data the time information needs to be 
transformed for (UTC) to the local time system as otherwise it would be impossible 
to correctly perform the noise assessment. For this correction, the correct 
relationship of the local airport time to UTC needs to be set and the beginning and 
the end of the summer time needs to be defined. Summer time differs every year 
and must be individually defined. The screenshot shows the correct settings for 
Germany for the year 2012. 

If you choose an already existing database for the import you can either AMEND the 
data and thus expand the database step by step (for example by importing month 
by month   or you can opt to OVERWRITE the already existing database.  

Data check after the import 

After all tracks are imported, there is very efficient way to get an overview or 
detailed information of all data. 
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Under the tab Meta you find the general information for the import settings. 

 

Via the tab tracks you can obtain an overview of all imported tracks. 

 

In the top section of the window all imported flight tracks are shown. Amongst 
others you can find the information of the “aircraft call sign”, time, assigned 
runway for take-off and landing, track type, „aircraft type“ and the aircraft class 
representing this particular aircraft for the standard selected (according to AzB or 
ECAC). Each individual track can be selected with a mouse click that will present 
detailed information in the lower part of the window for the selected flight track.   

In the tab Logbook all problems and errors found in the imported track data are 
documented.  

In the tab coordinates all imported coordinates used in the calculation are 
presented. Additionally a small graphical display will provide an overview of the 
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track and the track parameters such as speed, elevation, additional level (AzB) 
respective the thrust of the engines via sigma‘ for ECAC). 

In the tab statistics you can get a quick overview of the quality of the imported 
data. 

 

 

For this statistics there are 2 different views, either sort the data in accordance to 
the „aircraft type“ or sort it according to AzB respective ECAC classes. In the first 
line of the table there always is the synopsis of the data and its statistics. All tracks 
containing errors (column error-code =2 [%]) are not used for the noise simulation. 
If you have entries marked as such, the reason can be one of the following: 

• Geometry was found to contain severe errors, for example if the track 
contains only a single coordinate or the flight time represented by the track 
exceeds one hour. 

• The track is a pattern flight or is another track type not processed by ECAC 
(for example Taxiing for ECAC) 

• The speed as calculated from the time stamps of the recorded coordinates 
would yield a speed that is out of the possible range 

• The radar data are incomplete (for example no runway assigned to an 
aircraft or no „aircraft type“)  

• No reference exists between the „aircraft type“ to any aircraft class in the 
SoundPLAN library. Without this reference no calculation is possible 

• Takeoff and landing time is undefined or cannot be identified.  
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Info: To check the data of already imported databases, you can open this database 
later on or re-import the data. For this procedure follow the import described 
above. 

Automatic correction of imported data / preparing the import data 

Radar track data can vary in their quality and accuracy, depending largely on the 
type of radar track storage format. It is therefore important that the program is 
adjusting some of the data with several geometrical tools: 

Radar tracks in the formats Topsonic- and Fanomos are recoding the flight tracks in 
very short time intervals, therefore the tracks are represented with a very large 
number of coordinates. For Stanly-data the tracks are recorded only with one 
sample every 60 seconds. Especially for curves of the track this lack of resolution 
leads to flight tracks that do not look realistic. SoundPLAN approximates the flight 
track with spline, which generates a more realistic flight track. The graphics below 
shows the approximation, the green line identifies the flight track in the corrected 
version, the red line shows the track as it was recorded by Stanley.  

 
Original Stanly-data (red line) and the line approximated by SoundPLAN (green line). 

With radar tracks it can happen that the first coordinate or the last coordinate of a 
radar track is a big distance away from the runway. For an assumed speed of 80 
m/s the maximal distance can be up to 4.700 m for Stanley data with their 
recording every 60 seconds. Other common problems arise from parallel runways 
or a radar echo. To solve these problems, the program will automatically delete all 
imported coordinates that are closer than 3 km to the runway reference point and 
replace the rest of the track with coordinates interpolated for the last part of 
takeoff or landing. The new track coordinates are inserted in the area between 
σ`=3000 m and the starting point or respective the landing threshold. With this 
correction, the flight track is automatically starting or ending on the correct 
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runway. The following graphics are illustrating this correction. The red lines show 
the radar tracks and the green lines represent the flight track generated by 
SoundPLAN.  

 
The radar track (red) ends before reaching the airports runway. After deleting the last 
coordinates of the radar track and inserting the coordinates for short final, the flight track 
(green) ends directly on the runway.  

 
Sometimes a radar echo is creating unrealistic tracks when the aircraft is close to the grounds 
or on the ground. These unrealistic tracks are corrected by SoundPLAN (green).  

When the appropriate elevation flight profile is assigned to the flight track via the 
SoundPLAN database, the coordinates of the radar tracks are augmented by the 
data from the elevation profile. The coordinates can be thinned out using a user 
defined corridor width. The band width is preset to 100 meters but can be adjusted 
in the import dialog to other values. Interval by interval coordinates are eliminated 
within the bandwidth set up between the first and last coordinate of the flight 
tracks coordinate list. The program only eliminates coordinates that originated 
from the radar track, coordinates from the flight profile are marking changes in the 
throttle setting and therefore must remain.     

ECAC-radar import – selection of the procedural profile 

In the ANP-database from Eurocontrol which is the basis in SoundPLAN, the 
procedural elevation points are defined for each aircraft type, additionally the 
database also contains fixed elevations that the aircraft will pass through without 
changing the power or flap settings. Procedural profiles use atmospheric conditions 
and the takeoff weight of the aircraft to set the sequence of flight procedures. With 
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this systematic the procedures in SoundPLAN remain flexible. Fixed elevation 
profiles, similar to the elevation profiles of the AzB, are not flexible, they only 
depend on the distance of the aircraft to the runway reference point.  

For the calculation with radar tracks the position of the radar tracks are 
coordinates without information of the throttle and flap settings. As this 
information is needed for the calculation of the aircrafts noise emissions the 
missing data need to be inserted from the procedural profiles. To facilitate this, the 
program will select procedural profiles that fit the aircrafts current climb/ descend 
rate. The procedural profile is checked in intervals of σ'=100 m, the absolute 
deviations between the radar profile and the procedural profile are tallied. The 
procedural profile with the smallest deviation is selected for the calculation. The 
following graphics shows the selection of the procedural profile.  

 
Selection of the best fitting procedural profile in the SoundPLAN import. The red line indicates 
the original radar profile, the green line represents the best fit with one of the ECAC profiles. 
The gray profiles are other profiles available according to ECAC Doc 29 3rd edition.  

Step 2: Generation of Geo-Files with radar tracks 

The import of radar data from the already generated database into Geo-Files is 
done in the Geo-Database via FILE -> IMPORT -> RADAR TRACKS -> GENERATE GEO-FILES 

FROM DATABASE.  

In the tab general select the database that contain the radar data to be imported 
into the Geo-File.  
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Additionally, you can specify the elevation or speed (radar data or classes). By 
default (be careful if you alter this) z and v are taken from the radar tracks and are 
not taken from the aircraft class definition. 

Additional selection possibilities: 

 

In the tab Filter (standard) you can set the standard filter of time frame, the 
selection of special days and hours. For information purposes the number of days 
used is also displayed. 

 

In the tab Filter (extended) additional filters can be applied to select the flight 
operations. 
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In the tab SQL you find the filter definition that was automatically generated for the 
SQL database query. The user can change and re-define this query. 

 

With the button TEST QUERRY the SQL-query is carried out and returns the number 
of tracks that fit the SQL filter. This test only has informative character. 

 
Display of a radar track Geo-File in the Geo-Database 
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A Geo-File generated with an SQL-query can be re-generated later on with 
different filter settings. Use the symbol button "Filter" to re-define the SQL 

filter settings. This symbol is only visible if a Geo-File with radar tracks is the 
current Geo-File.  

Additional settings in the calculation core 

In general, the calculation settings for the manual track definition and the 
definitions with imported radar tracks are the same. The calculation with radar 
tracks has a single tab with some more definitions. 

 

As the selection of the SURVEY PERIOD is very flexible and as data can be contained 
in more than one Geo-File, this setting must be made manually.  

To accelerate the calculation, it is possible to define a maximum SEARCH RADIUS in 
meter. Depending of the number and geographical distribution of the radar tracks 
sometimes it is possible to reduce the influence radius of the aircraft in the 
calculation.  

To improve the fitting between measured values and the simulation, it is possible 
to define a „THRESHOLD LEVEL“ that suppresses all track sections with a level lower 
than the threshold level. For noise monitoring stations this technique is used to 
mask out background noise. 
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14  Tools Industry Noise 

Tools Industry Noise is a module to consider special tasks in the field of industry 
noise. Apart from the analysis tool Expert System for Industrial Noise it contains 
additional features, on the one hand the calculation of the sound power from 
measured data on the other hand the definition of the emission of point-, line- and 
area sources via formulas.  

Expert System for Industrial Noise 

Overview 

The Expert System for Industrial Noise is an analysis tool to develop noise control 
concepts for industrial complexes that often have very many individual sources and 
for each source may have different spectra, time histograms and solutions. As this 
program module has multiple windows it is possible to view different aspects of the 
same facility at the same time from different angles. With sort functions it is 
possible to very quickly figure out which are the problem receivers and to locate 
the main sources causing the problems and to simulate noise control options to see 
which combination of noise control measures has the best ratio of cost to 
performance. 

In the following chapter read a short synopsis about the generation of noise control 
with the module Expert System for Industrial Noise. The functions used are 
described in detail in the next section: 

• In the Calculation Core a noise calculation must be already carried out with 
the "tables for Expert Industry" stored before the Expert System for 
Industrial Noise is of any use.  

• Open the module for the Expert System from the SoundPLAN Manager 

• With FILE -> NEW read all result files from the single receiver calculation 
(with tables for Expert Industry enabled at the calculation) into the Expert 
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System. (FILE -> OPEN opens an already prepared and stored noise control 
concept.) 

• Initially the screen contains 3 windows: The top two windows, the receiver 
list and the source contribution list are always visible. In the third window 
you can select different views to your data by clicking on different tabs. For 
the receiver list you can select different time slots (EDIT -> TIME SLICES, in 
brackets the assessment standard used in the calculation is visible) and 
change the sort criteria. (EDIT -> SORT RECEIVERS ACCORDING TO). For the 
source contribution select if individual sources, groups or both shall be 
displayed (right click -> VIEW SOURCES).  

• With the right mouse button additional detail windows can be generated or 
closed. 

• In the additional detail windows select the content via the tabs on top of 
each window: 

o Top view or 3D- view show all sources and receivers highlighting the 
receiver marked in the receiver list (active receiver) in the top left 
window and highlighting the source marked in the source list (active 
source) in the top right-hand window.  

o Day histogram of the noise level at the receiver 

Day histogram of the sources 
Day histogram of source contributions to the receiver  

o Sound pressure spectrum at the receiver 
Spectrum of the source  
Spectrum of the source contribution 

o Sorted source contribution diagram (lowest contributions on the right 
edge of the diagram with each contribution sorted so the magnitude is 
rising to the left) 

o List of noise control measures 

o Ranking of the noise control measures 
Noise control cost/performance diagram 

• The layout of the diagrams (diagram type, colors, title of the axis) can be 
customized via OPTIONS -> DIAGRAM SETTINGS or via a right click on the 
diagram. 

• To generate a noise control concept, noise control options are assigned to 
the sources in the noise control measures list: left click on a source in the 
source list (top right hand window) to put the focus on a particular source 
and right click in the noise control measure list (or enter it via MEASURES -> 
ADD MEASURES FOR "NAME OF SOURCE") to add a new noise control measure 
for the highlighted source. It is possible to define multiple measures for each 
source. The noise control measure is either inserted from the noise control 
measures library when the measure is defined as a level difference over 
frequency or directly if the measure is a single figure reduction of noise 
levels. By right clicking on the noise control measure list and selecting the 
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option GENERATE NEW LIBRARY ELEMENTMENT you open the library to 
generate a new frequency dependant noise control measure (difference and 
cost).  

• Generate noise control measures in the noise control measure library: Enter 
the element name and under the tab VALUES difference spectrum and under 
the tab CHARACTERISTICS assign the costs to the measure.  

• Single figure broad band reductions in noise levels can be directly assigned 
to the measure list in the Expert System without using the library. From the 
entry selection use the OWN VALUES (SINGLE VALUE) and enter the values in 
the fields MITIGATION and COST. Overwrite the text in the selection list.  

• Each source can be assigned multiple noise control measures. The measures 
are either alternative or additive (see index).  

• Multiple sources in the source list can be jointly activated and assigned a 
joint noise control measure from the library or single value mitigation.  

• By right clicking on the source list and selecting the option VIEW -> SOURCES 

AND GROUPS you can assign a group of sources the same noise control 
measure. 

• Optimizing: In the noise control measure list each measure needs to be set 
to one of the following options in the column “Active“: Yes, No or Opti. YES 
means that the mitigation will be used in any case and the influence of noise 
control measure will be accounted for the particular source and all 
receivers. NO likewise means that the measure will not be used for noise 
control of the source and OPTI allows the program to evaluate if it has a 
beneficial ratio of price to performance and will use it if this is the case and 
not if there are no sufficient benefits or the measure is not needed to attain 
the goal. With the setting for OPTI the influence of the noise control 
measure is not accounted right away, this is done by triggering the menu 
option MEASURES -> OPTIMIZATION.  The program then polls all combinations 
and ranks the source modification measures according to the ration of price 
to performance and uses all measures until the noise control goal is met. If 
you want all new measures to have the default setting to optimize it, click 
on the menu option OPTIONS -> ADD MESURES AS „OPTI“. By activating 
multiple measures at the same time (shift click) the status for multiple 
measures can be changes simultaneously.  

• With the column INDEX you can define how multiple measures for the same 
source are handled. For example, there are the options of silencer A or 
silencer B for the same source. Both options are used as alternatives to each 
other, therefore the index for one measure needs to be different from the 
index of the other option. If the index number would be the same both 
measures could be used at the same time.  

• After running the optimization, you can manually fine tune the noise control 
concept. The measures recommended by the program are printed in the 
noise control measure list on a white background; measures not needed are 
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printed on a gray background. Under the tab labeled „Attenuation“ select 
the left side tab „Attenuation/cost plot“ to see from which source 
modification on the relationship of cost/benefit becomes unproductive. On 
the diagram click on the source modification position from where on all 
further modifications should not be used any more. In the table under the 
tab “Measure range” you can check the results of this limitation but can also 
change the status of individual entries into “Yes” or “No”. After this setting 
you can redo the optimization under the constraints given.  

• The noise attenuation concept now needs to be stored and is available to be 
included in any calculation run involving industrial noise sources. To include 
the attenuation concept in a calculation, open the calculation run and select 
the mitigation file in the section with the label DATA as the file type EXPERT 

INDUSTRY ATTENUATION FILES (*.ATN). If the purpose of the calculation is to 
generate feed data for the documentation, the results can be directly stored 
back into the result database by using the Expert’s menu with the option 
FILE -> SAVE TO RESULT NO. XXX.   

• With FILE -> PRINTDRUCKEN you can print a table of the MEASURES USED, the 
RECEIVER LIST or the details of the CURRENT RECEIVER.  The header and 
footers of the pages are customized in the section PAGE LAYOUT of the print 
menu.  

Concept of the Expert System for Industry Noise  

Before the Expert System can be opened, the data first must be generated in the 
Calculation Core. Start a SINGLE POINT SOUND calculation with the TABLES FOR 

EXPERT INDUSTRY in the tab SPS enabled. This setting will store the intermediate and 
final results needed by the Expert System.  

 
Relationship of the individual graphics and tables amongst each other. 
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The graphics show that the result data can be assembled in various forms and 
formats. Depending of project size, scope and advancement of the study it may be 
advisable to rearrange the detail windows depicting different content. The typical 
steps in the Expert System are:  

• Check input data (sources, receivers, geometry) 

• Gain an overview over which sources have a prominent influence upon the 
receivers. 

• Generate the concept of noise control measures 

• Post process the optimized noise control measures 

The tables of the receiver list and the source list are always visible. Under PREVIEW -

> SWITCH ALIGNMENT the alignment of source and receiver list can be toggled from 
side by side to sequential. Detail windows, which you can request by right clicking 
on a table or diagram (but not on graphics), you can place in the same row or in 
separate rows below each other.  

Receivers by default are sorted by the magnitude of the excess of noise (E w/a A). 
With EDIT –> SORT RECEIVERS BY the sort criteria can be changed. 

Sort criteria 

Point number (number of the receiver) 
Name 
Lr w/o A (Assessed noise level without noise control measures) 
E w/o A  (Excess of the noise limit without noise control) 
Lr w A (Assessed noise level with noise control measures) 
E w A (Excess with noise control measures) 
Attenuation  (Magnitude of the noise control measure) 

Source contributions are always ranked in accordance to their contribution at the 
receiver highlighted in the receiver list. You can search for a source in this list with 
Ctrl+F. 

If groups have been assigned to the sources, it is possible not only to assign 
attenuations to individual sources but also to the group itself. Switch the display in 
the source contribution list in PREVIEW (or via right clicking): 

Sources 
Groups and sources 
Groups 

In additional detail windows select different views to the data for a selected 
receiver or source. 

Detail window 

You can add multiple detail windows side by side or below each other. On any 
window (except the 3D or top view graphics, where you need to click on the tabs) 
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right click on the window and then -> ADD DETAIL WINDOW. In the following dialog 
select where the new window shall be inserted.  

  

When no longer needed close the additional windows again by right clicking and 
selecting -> REMOVE DETAIL WINDOW.  

You can modify the width of the detail windows and the height of the rows 
by positioning the cursor on the border between the windows and as soon as 

the cursor changes the shape to  a splitter  move the border to its new position. 

Graphics window 

You can display the geometry data in a top view as a frontal projection or as a 3D 
projection. To switch between the display modes right click on the graphics picture 
and in the select the VIEW TYPE. If the view type is “front view” or “3D map” there is 
an additional choice to define the DRAW TYPE with the choices “Wire frame”, 
“Hidden line” and “Hidden surface”.  The graphics settings and selection of the 
movements (move, zoom, rotate, move height) are also controlled via right clicking 
on the picture and selecting the menu choices, the movements are invoked by 
moving the mouse while holding down the left mouse button. 

 

In the graphics the selected receiver and the selected source are highlighted. 
Colors, sizes and line thicknesses are controlled from the menu point OPTIONS-> 

OBJECT TYPES. 

Day histogram 

In the diagram type for the day histogram there are 3 tabs on the left side of the 
diagram allowing the display to switch between the day histogram at the receiver 
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(receiver) or to view the day histogram of the sound power (source) or the 
contributions at the receiver.  

 

Spectrum 

With the 3 tabs on the left side of the spectrum diagram you can select the view to 
represent the spectral information at the receiver caused by all sources (receiver) 
or the sound power spectrum of the highlighted source (source) or the contribution 
of the highlighted sources at the receiver.  

 

Contribution Level Sum 

For a quick overview of potential noise control measures the diagram with the 
progressive addition of the sources is very helpful. 
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The vertical blue line depicts the noise limit for the selected time slot. The diagram 
is generated by ranking the source contributions and from the right-hand side of 
the diagram starting with the lowest contribution to the source. As the source 
contributions are ranked each additional source is added to the left of all smaller 
contributions the new data point in the diagram is always representing all 
contributions from the new source contribution on. The diagram shows how much 
the level is rising if the new source is being considered. In this display it is quickly 
visible that noise control must start with controlling the sources above the noise 
limit and sources that are very close to it.  If the diagram is very flat the noise at the 
receiver is caused by many independent sources, if the rise is steep, only a few 
sources are responsible. The red line represents the situation without and the 
green with noise control measures in place.   

For measures and attenuations see the chapter „Preparation of a noise control 
concept“ (page 729). 

On any of the charts you can right click and select the option COPY CHART TO 

CLIPBOARD to copy the diagram into other software packages such as WORD.  

Diagram properties 

The properties of the diagrams can be set individually for each of the diagram 
types, the program can display different content in different formats and 
configurations. It makes sense to display multiple sources in the source 
contributions but in the attenuation diagram it is wise to only view it for a receiver 
at the time for the selected receiver only.  

The diagram properties are opened by right clicking on the diagram to be edited 
and selecting the option CHART PROPERTIES. Another access is via the options menu 
and the selection of chart properties there.  
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Diagram properties with general settings 

All settings under the tab GENERAL are valid for all diagram types. Here the text 
fonts for the diagram header, legends, axis title and axis labels are set. To set the 
parameters click on the button boxes and configure them. In addition, you can set 
the colors for the background of the normal diagrams and the background, bottom 
and sides for the 3D diagrams.  

Up to 10 elements can be displayed in the diagrams (10 sound power spectra, day 
histograms at 10 receiver locations ...) therefore there are 10 boxes where you can 
individually select the colors from the SoundPLAN palette.  The color and thickness 
of the border line for the selected time slot is set on this control box. The content 
and appearance of the diagrams is set individually for each diagram type.  

In the second tab the diagram properties for each individual 
diagram is set. To navigate from diagram type to diagram type use 

the navigation buttons in the lower left hand of the diagram properties box.    
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Diagram properties for individual diagrams 

The diagram-properties for each diagram is split into 3 sections: Title and scale, 
Elements and Style. 

Under the tab TITELE AND SCALE find the diagram headers and the titles of the axis. 
The Y-AXIS can either be scaled automatically according to the data or if the box 
„automatic“ is not clicked be scaled according to the MINIMUM and MAXIMUM 
values to be user defined.  

Specialties for some diagrams: For the CONTRIUTION PLOT you can define for the X-

AXIS if you want to display all sources or only the N loudest sources. As the sources 
are sorted according to their contribution at the receiver the degree of detail will 
increase when the number of sources is limited. 

Under the tab ELEMENTS: The NUMBER OF SERIES indicates how many sources or 
receivers are displayed in the chart as a line, bar or 3D graph. Up to 10 series can 
be displayed at the same time. For noise level contribution charts the level sum 
without and with noise control are always displayed on the same chart therefore 
the selection of the number of series is not available for this diagram type.  

The lower part of the tab ELEMENTS configures the appearance of the element 
names and the general layout of the legend.  

Select the element name from the following possibilities: 

NO ELEMENT NAMES – The element names are not displayed in the diagram 

ELEMENT NAME IN TITLE AS LIST – The element names are printed on the diagram as 
a table  

ELEMENT NAME IN ONE TITLE ROW – All element names are all placed in the title row 
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ELEMENT NAMES IN LEGEND – Places the element names into the legend. To 
recognize the elements color coding is used. For this option additional settings are 
for the placement of the legend, background color, frames and shadows.  

For the STYLE of the diagrams the following chart styles are to your disposal: 

Bar diagram 

Line diagram 
Line diagram with steps 

Area diagram 
Area diagram with steps 

All diagram types can be drawn as regular 2D diagrams or as 3D-diagrams.  

The LINE THICKNESS is only valid for line diagrams relevant: For 2D-diagrams the 
parameter LINEN THICKNESS sets the thickness of the element line, for 3D-diagrams 
this parameter controls the thickness of the border line.  

In addition you can specially highlight the data points with the SHOW POINTS  option 
(not available for bar graphs).  

Preparation of a noise control concept 

First all data is analyzed using the tables and diagrams and the noise control 
potential of prominent sources at critical receivers is evaluated.   

Before you start with the noise control concept in the Expert System, define the 
noise mitigation potential inside the factory buildings by evaluating absorptive 
material at the ceilings, design needed noise control walls and evaluate the timing 
of the sources and check if sources can be shifted from the costly night time into 
daytime. After all these factors are exploited rerun the calculation.  

In the Expert System the first step is to assign noise control measures and costs to 
the sources with sufficient control potential. The optimization itself can only rank 
the noise control measures to find which combination will control the noise for the 
lowest price possible.  

Optionally you can set the program in OPTIONS -> DO OPTIMIZATION WITHOUT COSTS 

to only evaluate the noise control potential without taking the cost into account.  

Noise control measures can be set to a status as YES-> use this measure or NO -> do 
not use this measure or OPTI -> to leave it up to the optimization to choose if the 
noise control benefits are greater than the costs.  

Often the exact costs connected to a noise control measure are not known at this 
stage. If this is the case it is possible to substitute the cost with a point system 
where low costs are set to 1, middle costs are associated with 5 and high costs are 
represented by the figure 20. A noise control calculation with these figures will not 
yield the total costs but nonetheless will show the tendency in the optimization.  
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Assign noise mitigations 

In the detail window select the tab measures. In the level contribution table select 
a group or source that shall be assigned a noise control measure (the source will be 
highlighted with a white background) and add a noise control measure in the table 
of measures by right clicking or by invoking the process through the menu 
MEASURES. The sub menu allows to ADD A MEASURE TO SOURCE “XXX”.  

 
Add a measure for a single source or group 

The field with the header „name“  shows „Own entry (single value)“. If you want to 
work with broad band values without using the noise attenuation library, you can 
type the name of the measure here and enter the magnitude of the attenuation in 
the next field and the cost of the measure in the last one.  

 

Attenuations from the library 

Open the library from the menu with EDIT -> LIBRARY or in the detail window 
„measures“ by right clicking and selecting -> NEW LIBRARY ELEMENT. You can find 
the details of how to work with the library in the chapter Library. Check the system 
library if there are elements that fit your needs; if there are elements already in the 
system library, copy them to the project lib. The attenuations are given in octaves, 
the costs are added under the tab characteristics in the top most left position: 

 
Entry of the cost in the attenuation library 

Pick the measure in the Expert system in the window measure from the lib list.  

Assign multiple sources to the same noise control measure 

Mark multiple sources or groups with the mouse or by using the shift + arrow keys. 
The selected sources or groups are showing on a white background when marked. 
By right clicking in the detail window “Measures” select the option ADD MEASURE 

TO SOURCES: NO. – NO.. In the following window the measures are predefined.  



SoundPLAN Manual 8.1 
Tools Industry Noise 

Expert System for Industrial Noise  Page •  731/793 

14 
 

Predefine measures assigned to multiple sources 

Enter the dialog if you want to have the same measures for multiple sources or skip 
this phase by clicking on the OK button. If you skip the definitions here, you still can 
assign the measure manually or select the library elements. 

The Optimization 

With the optimization routines the noise control concept can be optimized even if 
the measures are not beneficial for all the receivers. The program will select the 
most suitable combination of noise control measures.  

The Optimization Algorithm: In the first step the program looks for the receiver 
with the highest violation of the noise limit. In the next step the program evaluates 
the ratio of cost to benefit for all source modifications (if the option -> opti is active 
for the measure) to find the best ratio of cost to performance (or just the 
attenuation if the optimization was run disregarding the cost). After the noise 
control measure was selected the noise level of the source is subtracted from the 
noise level of all receivers. If the noise levels at one or multiple receivers are still 
above the limit, the optimization procedure is carried out again. The optimization 
only stops if all receivers are below the limit or no further unused noise control 
measure is available. 

When you want to carry out the optimization the measures need to have the status 
"OPTI". Select OPTIONS -> ADD MEASURES AS „OPTI“ so that you do not need to 
modify the status manually. 
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In this case the measures and costs are not accounted for immediately but only in 
the process of the optimization. The difference due to noise control measures is 
accounted for in the noise level at the receiver and at the contribution table. If 
there are measures that have been determined to be undertaken in any case, it 
may be beneficial to switch the status from „OPTI“ to „YES“.  

Meaning of the status of "Active" 

In the noise control Measure list the source modifications assigned to sources can 
have any of 3 states in the column „Active“: Yes, Opti and No. YES means that the 
measure will be used in any case, the measure is instantly accounted for in the 
contribution list etc.. If OPTI is selected, the differences are not accounted for until 
the OPTIMIZATION has determined that the measure has a beneficial ratio of cost to 
performance. With NO the measure will not be used at all (this only becomes 
relevant when the optimization has been run and certain measures that the 
program might select shall be blocked from being used). 

If measures have been entered with the status "Yes" and shall be modified later on 
into "Opti", mark the column with the shift and arrow keys and change the status 
of the last entry by clicking on the field and selecting the option for „opti“. 

 
Change the status of multiple measures simultaneously 

Limitation of the optimization algorithm: The algorithm used in the optimization is 
non-recursive. When the most suitable measure was found (example: Measure A, 5 
dB attenuation, $1000 cost), it is added to the measure list. If the noise limit is 
violated at one or multiple receivers, the next measure (example: Measure B, 15 dB 
attenuation, $4000 cost) is requested and entered in the measure list. The ratio of 
cost to benefit for the measure 2 is worse than for measure 1. If measure 2 alone 
would have been sufficient, the program would not realize, the optimization is not 
recursive and does not reevaluate that measure 1 is obsolete. If multiple receivers 
and multiple sources with multiple modifications are in the optimization, it is not 
very likely that the outcome would be different from a recursive procedure.  
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Mutually exclusive measures 

Each noise source can be assigned multiple noise control measures that can be 
either in addition to each other of exclude each other. The „Index“ column is 
defining the status of noise control measures for the same source.  

Meaning of „Index“: For a source only measures having the same index can be used 
simultaneously, measures with different index numbers are mutually exclusive. 
Exception: Index 0 can be combined with another index. 

Alternative measures: If you have multiple different fan types to choose from you 
ultimately want to have only one selected, so the measures are mutually exclusive. 
Fan a can have the index 1, fan B the index 2... If the optimization finds fan B to 
have the best ratio of cost to performance all other fans are discarded. If a silencer 
is considered for any of the fans the index should be set to 0 to be compatible with 
any of the measures. 

Additive Measures: Noise control measures that can be used in addition to each 
other share the same index number. Example: The noise control for a piece of 
equipment can comprise of multiple independent measures (swap bearings, reduce 
RPM, building an enclosure around the machine).  

Measures that are connected must be defined as one measure. A silencer that only 
fit one of the new fans must be defined as a combination package, if it fits multiple 
source modifications it could be split and the index should be 0 then. 

In order to have the measure used in the optimization the status must be set to 
Opti. Select MEASURES -> OPTIMIZATION to start the optimization run. After the Opti 
calculation click on the tab Attenuation (if needed add a new detail window).  

 



 SoundPLAN Manual 8.1 
 Tools Industry Noise 

Page • 734/793 Expert System for Industrial Noise 

14 
 

Attenuation-/cost diagram and ranking of the measures 

Under the tab Attenuation click on the left side tab “Attenuation plot” to view the 
attenuation / cost diagram. The vertical line shows to which noise control measure 
the noise control options need to be considered. Under the tab “Measure range” 
the list of measures is ranked according to the effectiveness of the source 
modification and the cost of it. Measures with a gray background are not needed.   

After the optimization measures not used because of index number conflicts are 
displayed with cursive text.  

 

The optimization is a tool, the decision which measure to use however is yours. 
Therefore, the optimization status is not switched after the optimization. You can 
change the status of individual source modifications by hand from opti to “Yes” or 
“No“. Sometimes you run the optimization for one time slice, determine what 
source modifications are required there, set these to “Yes” and then run the 
optimization for another time slice with some measures already predetermined 
and others open for further optimization.  

Print and reuse the noise control concept 

For the documentation of the noise control concept you can print the following 
tables: 

• Receiver list 

• List of used noise control measures 

• Contribution of the sources at selected receivers 

Select the table of your choice after invoking the menu FILE -> PRINT. In the preview 
review the layout of the table. The normal SoundPLAN page format is used, with 
PAGE LAYOUT in the print menu customize the layout of your printout. Details about 
the page layout can be found in the chapter about the result tables.   

By right clicking on one of the detail windows you also can select the option COPY 

USED MEASURES TO CLIPBOARD to move your data into other programs and format 
the printout there 
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Hint: Only measures containing the „yes“ status are printed and moved to the 
clipboard, measures containing „opti“ or „no“ are ignored.   

Using the noise control concept in additional calculations 

Save the noise control concept via FILE -> SAVE or SAVE AS as an attenuation file 
(xxx.atn). By including this file in the list of files of a calculation run, the 
attenuations of the noise control concept are included in the calculation.  

Enter the attenuation file in the calculation run properties in addition to the 
situations and geo files. To include the attenuation file click on the >> in the „data“ 
entry field and select the attenuation file from the list of attenuation files. With the 
> key you include the attenuation file (*.atn) in the list of files assigned to the 
current calculation run.  

 

The results can be processed as usual, the Documentation, Spreadsheet and 
Graphics always will show the noise levels as defined in the Geo-Database reduced 
by the attenuations defined in the noise control concept of the Expert System for 
Industrial Noise.  

Store the noise control concept into existing result tables  

With the menu FILE -> SAVE TO RESULTX NO.  XXX the noise control concept is directly 
stored back into the result files. When the result files are opened in the 
documentation the selected source modifications are accounted for.  

Caution: A new calculation run will overwrite the results in the result files, so if the 
noise control concept shall be accounted for it must be added to the calculation as 
a *.atn file! 

Calculate sound power from measured data 
First import the spectrum measured at a measurement point into the emission 
library with file -> Import.  

Digitize or import the location (x,y) and height (z) of the measurement points. 
There is no upper restriction of the measurement points, but as a minimum, 

you need at least as many measurement points as you have “unknown” sources 
that you want to evaluate. Select the object type measurement point from the 
Geo-Databases tool tab.  
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In Total noise assign the library element from the emission library that contains the 
measured spectrum of the respective measurement point. For the assessment of 
the cumulative error, the uncertainty is entered into the field Standard deviation. 
Additionally you can enter a background noise level with corresponding standard 
deviation. 

Digitalize the sources for which the sound power shall be assessed from the 
measurement locations. Open the emission library and enter a new emission 
element. Under the tab values select the option Calculate emission from 
Measurement points. Like normal you can enter Height above ground and 
directivity. 
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The fact that the sound power is calculated from measurement points is made 
visual with the symbol measurement point in the Graphics. The day history does 
not apply to these sources. 

If multiple sources entered in the Geo-Database refer to the same library element 
that has the property „Calculate emission from measurement points“, the sources 
are considered the same and will have the same sound power over frequency. 

Additionally you can enter other sources with known sound power, day histories 
entered for these sources are ignored. The influence of the “known” sources is 
applied to the measured noise levels at the measurement location.    

Start the calculation of the sound power spectra with Tools -> Calculate source 
emissions from measurement points. After the calculation a dialog opens with a 
full documentation of the results.  

In the tab measurement points all measurement points with their measured 
spectra (Lp,meas), the extrapolated emission spectra (Lp,prog) and the difference 
between the measurements and the prognosis are listed. 

 

Under the tab sources the emission spectrum is listed along with the uncertainty to 
all emission spectra. Sources with a known sound power are presented on a yellow 
background.  
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If a frequency cannot be evaluated, the table will contain the value -1000 dB and 
no bar will be presented in the graphics.  

If entered, the graphics will present the uncertainty in addition to the evaluated 
spectrum as a purple bar.  

Click on save emissions to sources, to save all sources that have the column save 
enabled. When doing so, the emission spectra in the library will be updated. If you 
have assigned day histories to the sources that were ignored in the phase 
determining the sound power, they will be activated for the normal propagation 
calculations that you can now undertake with both the pre-set sources and the 
sources calculated from measurement points. The column save is automatically 
activated if the mean dLw is smaller than 5 dB. If this value is exceeded, you as the 
user can still activate the sources at will. 

With the button settings you can check the calculation parameters and if 
needed adjust for the next calculation.  

Define emissions via formulas 
It is possible to calculate the sound power of a point, line or area source with 
formulas from technical parameters. With these tools it is for example possible to 
calculate the internal noise level of a pipe consisting of compressors, silencers and 
regular pipe elements. The internal sound power and also the emitting noise can be 
calculated with formulas. This way it is possible to simulate the decay of the noise 
levels in a pipe with a disturbance onwards. The emission of a single line source 
changes as a function of the distance from the beginning of the line. 

The formulas are entered in the emission library, the technical parameters are 
defined and set to default values. These values can be overwritten in the entry of 
the sources in the Geo-Database so that a general formula becomes specific to this 
case only with the entry of the source properties.  

Definition of Formulas in the Emission library 

Under the tab value as usual select the type of spectrum (octave or third octave), 
the frequency range, the filter (dB, dB(A)..dB(D)) and the reference (Lw/unit, 
Lw/m,m²). 

As a next step, select from the lower selection list SUM BY FORMULA or SPECTRUM 

BY FORMULA.  
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For the data entry type „SUM BY FORMULA“ under the tab value a spectral 
distribution of the reference spectrum is needed that is then scaled up or down to 
fit the total sound power Lw that is calculated with parameters and formulas.  

For the data entry type „SPECTRUM BY FORMULA“ each value of the sound power 
spectrum (lwf) of the octave/third octave band is set with formulas and 
parameters. 

After the selection of „spectrum by formula“ or „sum by formula“ the library has a  
new tab Formula where the parameters and formulas are entered. 

Variables in the Formulas 

A formula needs at least one variable but can contain multiple variables. There are 
three types of variables: Input variables, Output variables and Local variables. 

The value of an input variable can either be assigned directly to the input variable 
or can be connected to an output variable of another source. With the connected 
input/output variables it is possible to pass data from one source object to another 
source object. This is useful for example for pipes where the internal sound power 
is passed along the pipe from object to object. 

Output variables are values calculated by a formula and are passed on to the 
outside either as the sound power for a calculation or as input data for another 
source object.  

Local variables are only used internally within a formula for example to break up a 
single formula that otherwise would become too complicated. These variables are 
not made available to the outside world.   

For each variable type there are several pre-defined variables that contain 
information that was defined in other places. 

The following pre-defined variables are available: 

For input variables: 

- Length of the line source 

- Area of an area source 

- Distance from the beginning of the source object (distance from start) 

- Distance to the end of the source object (distance from end) 

For output variables  

- for „SUM BY FORMULA“ the total sound power Lw 

- for „SPECTRUM BY FORMULA“ the sound power for each third octave / 

octave band Lwf 

For local variables: 

- for „SPECTRUM BY FORMULA“ the frequency f 
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Variables have  

• A NAME how they appear in the formula 

• A UNIT (except for local variables) 

• A TYPE: 

o Float: real numbers with a decimal  

o Integer: numbers without a decimal 

o Emisspectrum: an emission spectrum ((frequency range depends on the 
settings in the tab „value“) 

o Transspectrum: a transmission spectrum (frequency range depends on 

the settings in the tab „value“) 

o Difspectrum: a difference spectrum (frequency range depends on the 
settings in the tab „value“) 

• A VALUE (or multiple values for local spectrum variables) 

• A DESCRIPTION for the documentation (except for local variables) 

The formula interpreter can handle multiple lines of formulas but each 
formula must have a „;“ at the end of the formula. A value is assigned to a 
variable with the operator „:=“. 

Data entry example 1 

The sound power of a fan depends on the flow rate Q [m³/s] and the pressure 
difference P [Pa]: 

Lw = 10*log(Q) + 20*log(P) + 40 

Entry in the emission library 

Request a new library element in the emission library and give it the name "Fan". 
Under the tab value set the boundary parameters. Select the data entry type SUM 

BY FORMULA. 

Open the tab Formula.  

 

Add the new input variables Q and P by clicking on the field ADD USER VARIABLES in 
the tab input variables. Define the names, the units, types (here float) and default 
value and the description. As the variable is also accessible in the source definition, 
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the default value is not this important, the value will be set in the source definition 
of the Geo-Database when the source is entered. 

Open the tab Output variable; the pre-define output variable Lw is automatically 
set. 

 

Now enter the formula in the field FORMULA: 

Lw := 10*log(Q) + 20*log(P) + 40; 

Log is a pre-defined function (logarithm to the basis of 10). For a list of all available 
functions look at "Table of the formula commands" in the chapter "Spreadsheet".  

Click on the button CALCULATE, as a result you will find that the tab Output variable 
now has the value of the calculate Lw in the slot labeled Lw.  

In this case the variable Q has a default value of 10 and P the default of 1000.  

From the formulas and parameters we see:  

Lw = 10*log(Q) + 20*log(P) + 40 = 10 + 60 + 40 = 110 

If the formula contains an error, the cursor will jump to the place in the formula 
where the error was found and will issue an error message.  

Definition of the point source 

Enter a new point source in the Geo-Database and assign the source the library 
element „fan“.  As soon as you enter a spectrum with a formula, the source 
properties will open a new tab with the label Formula. 

 

The input variables defined in the library element are presented but the values can 
be customized for the very case your source definition is describing, for example to 
adjust the volume stream of the fan.  
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The search distance for sources in the vicinity and the settings to concatenate input 
and output variables of multiple source objects are irrelevant for this example as 
the fan only consists of a single source object.  

In the lower part all output variables with their calculated values are presented.  

If you change the value of the input variable Q from the default value of 10 to 100, 
the output of the Lw changes from 110 dB to 120 dB. 

Source entry example 2 

Now let's review a more complex example: A line source with variable sound power 
where the sound power along a pipe decays. 

Entries in the Emission library 

Enter a new library element "Variable Lw" in the emission library and under the tab 
value define the boundary conditions: The emission spectrum is defined as Lw/m 
with the entry type SPECTRUM BY FORMULA. The frequency range is set to 63Hz-
8kHz in dB(A). 

Define the following variables: 

 

Own input variables: 

Name = IN1; Unit = dB; Type = Emisspectrum; Default value = 90; 

Description = Input spectrum 

Predefined variables Input variables: 

Name = D_s; default value = 0 

Name = L; default value = 100 

 

Predefined output variables: 

Lwf: spectral emission level;  
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Own output variables: 

Name = OUT1; Unit = dB; Type = Emisspectrum; Description = Emission 
spectrum at the end of the line source 

 

Own local variables: 

Name = Alpha; Type = Difspectrum; Default value = 0,1 in each frequency 
band 

Enter as a formula 

Lwf:= IN1 - alpha * D_s; 

OUT1:= IN1 - alpha * L; 

The formula above will result in a continual decay of the sound power per meter 
from the beginning of the line source. At the beginning of the source D_s=0, 
therefore Lwf = IN1. At the end of the line source D_s=L therefore Lwf = OUT1. 

With the default values we get for OUT1: 

OUT1 = IN1 - alpha * L = 90 – 0.1 * 100 = 80 

The formulas are evaluated for each frequency. The shown values for Lwf and 
OUT1 in the library are the values for the highest frequency. 

Definition of the line sources 

In the Geo-Database we now define two line sources "pipe 1" and "pipe 2". The last 
coordinate of pipe 1 is identical with the first coordinate of pipe 2. Both sources are 
assigned the emission spectrum "Variable Lw". 

 

In the tab Formula the variable IN1 is entered for both sources from the library 
definition.  

In the footer you will see an error message as the program expects a link: 
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This link first must be defined. 

For the source "pipe 1" the input variable IN1 is set as a link to the emission 
spectrum of the library. For this the column link type must be set to „Library “.  
Now you can select any emission spectrum that was not defined as a spectrum by 
formula. 

If IN1 would be a transmission spectrum (Transspectrum) rather than the emission 
spectrum, all elements from the transmission library would be shown instead of 
the emission spectra. 

 

As soon as the link is established the entry in the column "value" is ignored.  

For "pipe 2" the variable for IN1 is set to the emission spectrum OUT1 from the last 
source. To do so the column link type is set to „source“. Now you can choose from 
all output variables of the correct type for all sources that are presented in the 
window SOURCES IN THE VICINITY. If the source you want to connect to is not found 
in the list, you may need to increase the SEARCH RANGE, however in our example 
we set the end coordinate of pipe 1 to identical coordinates as the beginning of 
pipe 2 and therefore will not have problems finding the connection between the 
pipes. 

 

For pipe 2 the variable IN1 in the link is set to pipe 1.OUT1, therefore the pipe 2 is 
taking over the emission spectrum with the value of Lwf at the end of Q1. 

For the calculation the sources pipe 1 and pipe 2 are automatically sub divided into 
smaller sections that are small enough that the difference of the Lw between the 
beginning and the end of a sub source are less than 1 dB. 
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Result in a grid noise calculation:  

 

Noise at Workplace 
Noise at Workplace is a powerful tool to assess and document the noise dosage of 
workers exposed at different stations/locations to varying noise levels. The 
graphical presentation of the situation helps with the assignment of work stations 
to workers. Each worker can be assigned multiple work stations, they can be in the 
same industrial building or a different industrial building or outside of the building. 
The duration of the work at different stations is set individually for each worker.  

Noise at Workplace at the moment is part of the industrial noise module but 
SoundPLAN reserves the right to at a later stage when additional tools for noise at 
work are developed, convert this module into a separate module with its own 
price. During the life time of SoundPLAN 8.1 Noise at Work will for sure remain part 
of industry noise.  

To prepare the assessment of the noise exposure for workers, the sound pressure 
level for all work stations must be calculated. Each work station is represented by a 
receiver.  
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For work stations outside please calculate the single receivers for environmental 
noise outside, for work stations in a factory building an Indoor Single Point 
calculation is required.  

After the pre-calculation for the work station, start Noise at Workplace from the 
SoundPLAN Manager EXECUTE -> NOISE AT WORKPLACE.  

 

In the tab selected calculation results at work stations the left side hosts all single 
point receivers for inside and outside. Using a double click or the blue arrow, 
transfer the required calculation runs to the right side. 

Click on the second tab to add workers and assign them to work stations.  

 

The top left offers a red + to add additional workers. With a click „worker01“ is 
highlighted in blue, you can now assign a new name to this worker.  

In the lower list the work stations (activity, job) from the assigned calculation 
results are listed. Assign the activities over the course of the work day to the 
workers at the various work stations. Individual activities are assigned with a 
double click or the blue double arrow, multiple activities require marking them 
with the Shift key for individual and the Ctrl key for consecutive activities. 

The graphics on the right show all work stations assigned to the worker in green, 
work stations not assigned to the highlighted worker are presented in yellow. With 
a double click on a work station you can also assign this work station to the active 
worker. 
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The Assessment of the noise dosage is done under the tab assign duration and get 
noise exposure levels.  

 

The table on the bottom contains a list of all work stations assigned to individual 
workers along with the sound pressure levels found at these work stations. For 
each worker the proportional work time is listed for each work station for each 
hour.  

Set the DURATION to min/h or %. Additionally, assign a noise reduction for example 
to accommodate work stations where hearing protection is required.  

The DURATION describes the length of the averaging time which is part of the 
assessment of the noise exposure limit. The allowable LIMIT is the constant noise 
level equivalent over a period of an 8-hour shift. Most standards foresee a noise 
limits between 80 and 90 dB(A) for the duration of 8 hours. If the noise dosage is 
exceeding the limit, the duration must be reduced, or noise protection must be 
used to avoid violating the noise dosage limit. The HALVING PARAMETER is the value 
in dB, used for doubling the noise level / noise exposure time. In the literature the 
most common value for this parameter is 3 dB. If the USA OSHA deviated from this 
rule and set this parameter to 5 dB.  

From this parameter and the work time at various work stations the table 
calculates the noise exposition level Lex and the noise dosage for each worker.  

Both tables can be copied using the left mouse button into the clipboard to be 
inserted in your documents and presentations. 
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15  BA-Outside 

The scope of the module Building Acoustics-Outside 
BA-Outside assesses the required valued sound reduction index R’w of the outside 
shell of a building subjected to noise from outside sources in accordance to the EN 
12354 and other standards.  

 

EN 12354 calculates the required sound reduction index on the basis of different 
room types from the room assessment library and traffic routes from the outside 
level. Depending on the use of the room, the day or night assessment level is 
decisive.  

The correction summand L2,nT is understood as the maximum permissible internal 
level in order to enable the guidelines to be implemented on more than one 
external wall. The total level L2,nT is the energetic sum of the partial levels L2,nTi 
of all facades. The partial level L2,nTi of a façade is obtained by the energetic 
summation of all partial levels L2,nTij of the components of this façade.  
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General overview 

The formulas to calculate the indoor noise levels for known outside levels and R’w 
are relatively simple and can easily be accomplished in an Excel spreadsheet. The 
problem is that you need to feed it with the noise levels outside and are left 
without any sensible documentation. If the number of buildings for which the 
assessment of the façades shall be done is large, it is much more efficient to use a 
program module such as BA-Outside. As this module helps document the buildings 
/ dwellings / rooms in text and graphically, this BA-Outside module is the program 
of choice for small and big projects alike.  

BA-Outside offers the following possibilities: 

• A hierarchically structured presentation with the object types building, floor, 
Dwelling and Room with specific data for each layer. 

• SoundPLAN-results of the outside noise calculation can - in case they are 
present - be used for the noise assessment of the BA-Outside. In this case 
the buildings used in the calculation are created for BA-Outside together 
with the information road name, house number and limit. The noise levels 
from a Façade Noise Map are later on assigned to each façade of the 
building. 

• A room can be exposed to the outside via one or multiple façades. For the 
room the inside noise level is calculated that is presented in red color as 
soon as the noise limit has been exceeded. 

• The elements making up the façade are made up of the size in square 
meters and the valued sound reduction index R’w. Inserted façade elements 
are automatically accounted for in the tally remaining wall area with the 
exception of the openings of the forced ventilation pipes where the pipe 
diameter is neglected.  

The sound reduction index is set manually or is taken from the SoundPLAN 
transmission library or via a façade element calculator. For each element it 
is possible to host values describing the current status as well as values after 
possible improvements to the situation.  

• On all object layers, you can enter and save comments and graphics. 
Graphics are either pixel graphics (bmp, jpg, png, tif), a pdf file or simple 
drawings and texts created with a built-in tool (or both). If present 
SoundPLAN model data can also be used. 

• The result printout is either for a selected element or the entire BA-Outside 
project. Customize the scope of the printout with options menus, select to 
include comments and pictures. 

• When selecting the noise improvement measure list, only the elements are 
printed that during the BA-Outside process had been changed. 
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Generation of a new room book  
Start a new project or select an existing project and start BA Façade with the 
symbol button BA-Outside in the main menu area of the SoundPLAN Manager. 

With FILE -> NEW or via the symbol NEW you get to the dialog to start a new 
room book. 

  

Select the standard you want to use for the calculation. EN 12354 additionally 
requires a room assessment library. Click on the library symbol to select it. Select 
the default spectrum adaption term (or for other standards the traffic route).  

With the BUILDING TYPE you define which hierarchical steps you want to include as 
a default into the tree structure of the room book and for the import of SoundPLAN 
data. 

• Only buildings 

• Building - dwelling (= apartment or flat) 

• Buildings - dwelling - room 

• Buildings - floor - dwelling - room  

 



 SoundPLAN Manual 8.1 
 BA-Outside 

Page • 752/793 Generation of a new room book 

15 

Regardless of the building type you selected at the beginning, you can always add 
floors, dwellings and rooms to individual buildings, just as your work requires. 

Which building type to select as the pre-set for BA-Outside depends on the scope 
of the investigation, the national (and local) legislative framework and the structure 
of the borough to be investigated. If the area is predominantly built up with multi-
family residential buildings then the structure "building, floor, dwelling, room" is 
suggested, if is structured with a mixed of single family and multi-family buildings, 
it may be better to activate the setting for “only buildings”.  

You can determine a pre-selection whether the columns “library element” (sensible 
for EN 12354), “cost” or “cost calculation” shall be displayed later in the list of 
components. 

Click on NEW to start a new room book with one building. The building will be 
presented with the building tree structure in accordance to the selection of the 
building type. On the right side various tabs are located for the administration of 
the data. Starting with the active object all tabs belonging to a higher hierarchy are 
displayed.  

 

If the dwelling is the active tab, the tabs for individual rooms are not presented. For 
multi-family buildings showing all tabs would visibly overload the structure.  

Importing of SoundPLAN calculation results  

Click on IMPORT SOUNDPLAN RESULTS to import data from an entire calculation area 
– receivers are imported along with the road name and house number. If the 
building type with multiple floors is selected, the number of floors present in the 
building properties will be used to generate the correct number of floors in BA-
Outside. In the import dialog you can define the additional parameters:  
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Normally you should only import buildings where the noise limits at least in one of 
the time slices or for one of the floors are exceeded (ONLY IMPORT WITH CONFLICT). 

With the ROUNDING TYPE the noise levels are rounded at import time in accordance 
to your settings. 

The FLOOR THICKNESS is used in combination with the height of the floor to 
calculate the mean inside room height, which is important for the noise level 
inside.  

In the field address you can pre-set the defaults for zip code and city of the 
buildings so that along with the road name and house number every building 
contains a complete postal address. 

After importing the SoundPLAN results the receivers will be presented in the tree. 
Road name and house number are entered as the building name in the address 
database in the appropriate fields.  
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Via FILE -> UPDATE SOUNDPLAN RESULTS you can update the outside facade noise levels if 
you have made a new outside noise calculation.  

Add graphics and symbols 
Each element a graphic or pdf file can be assigned to document the project. 
You can take for example a picture of the outside or the building and assign it 

to the building, you may want to assign a drawing of the floor plan to a floor or a 
dwelling or a construction drawing to show the construction of the roof to the top 
floor. These graphics can be incorporated in the printout. 

Load the graphics by clicking on the symbol LOAD GRAPHICS. If the graphics file is 
not located in the project, the program will copy it there.  

The pdf file is first converted to a bitmap, see “PDF as background graphics” in the 
chapter Geo-Database. 

Fit the graphics to SoundPLAN data 

If you work with SoundPLAN geometry data, you can adjust size and position of the 
floor plan to the graphics.  

Click on the symbol GRAPHICS/BITMAP/FIT TO SOUNDPLAN DATA, the cursor 
will change its appearance to a little cross. Click on a corner of the building 

and pull it with the with the mouse button pressed onto the appropriate corner in 
the bitmap (picture on the left). Now grab a second corner of the building. With the 
mouse button pressed fit the data to the bitmap (moving the mouse left/right will 
rotate the geometry, moving up/down will zoom in/out). As soon as you release 
the mouse button the cursor will again change into a hand.  
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Inserted graphics can be placed easily for multiple rooms (for example for multiple 
floors with the same floor plan):  

Via GRAPHICS -> ASSIGN IMAGE DETAIL TO CHILD ELEMENTS you can for example transfer the 
graphics viewport of a dwelling to all rooms.  

In the selection mode (arrow symbol) the graphics can be transferred with 
Drag&Drop to another element of the current object.  

In order to prevent accidental zooming, the mouse wheel in the selection mode is 
deactivated.  

With GRAPHICS -> BITMAP -> DELETE or the symbol DELETE GRAPHICS the bitmap can 
be deleted. 

Add object symbols 

In BA-Outside you can add simple drawing objects for example to highlight a 
specific room. The following drawing objects are to your disposal: 

  

• Point – click on the position you want to set the point 

• Line – click on the start of the line and then on the end of the line  

• Poly-line – enter successive the points of the polyline, finish with a double 
click 

• Rectangle – pull open with the mouse button depressed 

• Non-right angle “rectangle” (trapezoid) – click on the first point, then the 
second point and then pull open the trapezoid with the mouse button 
pressed 

• Polygon – click on successive points of the polygon, end with a double click 

• Text – click on the position and enter the text in the edit field 

How the individual drawing elements are entered is commented in the status line. 

Enter the edit mode (arrow cursor), if you want to edit/correct an object 
afterwards. As soon as the cursor moves over a drawing object, the appearance of 
the cursor changes into a black arrow. With this cursor you can click on the object. 
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On the 4 corner points you can rotate the object, with the middle markers you can 
enlarge or shrink the object (not valid for texts). 

When a drawing object is activated, you can use the right mouse button to 
duplicate it or delete it.  

Layout types 

The drawing objects are formatted with the layout types for point, lines, areas and 
general texts. Open GRAPHICS -> LAYOUT TYPES, to change the layout.  

 

Under the tab Cartography you can define additional parameters for example to 
select a different symbol for a point or to set a color for the border of the drawing. 
A pre-view of the layout is visible on the right side.  

In order to display drawing objects with different attributes, duplicate the points, 
lines areas and texts and customize their layout.  

Upon leaving the layout definition use the right mouse button to assign the layout 
to the activated object -> CHANGE LAYOUT TYPE. 

When you work with SoundPLAN data, you can assign the layout to receivers that 
have been taken into BA Facade from the SoundPLAN calculation. This way you can 
recognize receivers that are already processed. 

When working with SoundPLAN data, use the project object types to customize the 
layout of the data or to suppress the drawing of some objects. 

Take over the graphics 

A floor plan (with or without additional drawing objects), that has been 
assigned to an dwelling can be transferred to a room. Open the room and 

click on the symbol COPY GRAPHICS. Afterwards you can use the right mouse button 
in the edit mode (hand cursor) to zoom out the room.  
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Edit your data 
After the rough structure is defined, respectively the receivers for the calculation 
have been imported, additional elements are added. For the various tabs (buildings 
and dwellings) numerical and textual information can be augmented with graphics 
depicting floor plans and other information.  

 
Building, floor, dwelling, room, facade, component 

Duplicate and move elements  

The program allows duplicating elements, so it might be advantageous to first 
enter an element and completely define it and then duplicate the entire branch.  

Click on the symbol DUPLICATE ELEMENT on the branch that you want to re-
use. All elements in the hierarchy below this base element are also 

duplicated. When you duplicate dwelling 1 to become dwelling 1 and 2, all rooms 
and façades belonging to dwelling 1 are duplicated. In case dwelling 2 is located in 
a different building as dwelling 1 (if you have multiple, identical dwelling buildings) 
mark the dwelling and use the mouse to drag it to the new building you want to 
assign it to. 

 Buildings 

The room book must contain at least one building (rooms can only be generated 
when a building already exists, therefore buildings are required). Depending on the 
scope of investigation and the type of building, floors and dwellings may require 
further structuring.   
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The room height is a default setting for all elements below in the hierarchy. If the 
room height is the same as the room height in the “higher” element, take it from 
the “higher” element by checking the box for taking the room height form the 
“higher” position in the hierarchy. The administrator can also be taken over from 
the „higher“ position. If you want to enter a new administrator in the address 
database, click on the double arrow. 

Noise limits on the outside of building are a first hurdle a building must pass in 
checking the eligibility of the owner to get compensation for excessive noise levels 
outside. 

Address database 

Via the double arrow you get to the address database to enter address and name 
of the person responsible for the dwelling (administrator, owner or management 
company…). You can later export to Excel and use it there for further full flexible 
documentation. 

The buildings address is the default for additional counterparts entered for this 
building.  

 Floor 

A floor can only be inserted in the hierarchy below the building. This element is 
only used to structure the data, aside from the floor height it does not contain any 
data of its own required in the calculation. A floor can have additional textual and 
graphical information. 
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 Dwelling 

Dwellings can be generated directly below the building or as part of the floor. A 
dwelling can contain multiple rooms and floors.  

 

The first field of the dwelling definition hosts the description of the dwelling.  

 Room 

The room itself is the core of interest for BA-Outside.  

 

The room height from the higher element is taken as the pre-set for the height of 
the room. Together with the room geometry it also used for the calculation of the 
absorption area. To take this value, check the appropriate box. Changing the room 
height at a later time will not change the height of the facade element but the 
room absorption.  

The surface area of a room - which is important for the noise calculation - can be 
calculated from width and depth of the room or can be directly entered after a 
double click on the gray field AREA. 

The room usage For EN 12354 comes from the room assessment library with the 
corresponding required indoor level L2,nT. The room assessment library is selected 
when defining a new room book. It is possible to change it under ROOM BOOK -> 

SETTINGS with a click on the library symbol. This is only sensible in very rare cases as 
the assignment of existing room types gets lost! 

For the German standards 24. BImSchV and VDI 2719 a parameter D (required 
interior level) is set according to room usage. The other standards need the room 
usage to determine the required resulting sound reduction index R’w.  
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For the simulation of the indoor noise level you need to define one or multiple 
facades as the boundaries of the room. If you work directly with SoundPLAN 
results, click on the receivers in the list to insert a facade and take over the noise 
level from the outside.  

 

Select the floor and click on NEW FACADE to generate a new facade. Taking levels 
from other facades can only be done if the receiver already contains a façade. This 
procedure has the advantage that outdoor calculations can update the values while 
maintaining the object tree of building components. 

 Façade(s) 

  

You can assign several facades to each room. The label on the tab is taken from the 
field “façade”. Behind the name in brackets you can see the partial noise level 
associated with this façade. Each façade can be assigned a comment.  

Directly below the box for the facade description the dimensions of the facade are 
entered. With a double click on the gray field AREA the size of the facade can be 
entered directly. The labels for WIDTH and HEIGHT assume the standard case of 
vertical walls. By directly entering the area it is possible to accommodate the bigger 
sizes of slanting roofs and to add the area for a flat roof. If flat or slanted roofs 
need to be modeled the outside levels need to be calculated and set for this case. 

The sound reduction index R’w can be adjusted with a spectrum adaption term C or 
C,tr. If the assessment level is printed on gray background, the value came from a 
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SoundPLAN calculation. With a right click the reference to the calculation can be 
deleted if needed.  

In the field CORRECTION BY CONSULTANT you can further correct the noise level on 
the outside of the building. The resulting total noise level is presented in the field 
below the size of the façade area.  

Select if necessary, the facade correction of the EN 12354. 

 

 Components 

The COMPONENT TABLE is set up with separate entries to cover the existing and the 
improved status of the facade. The first line always hosts the main element, the 
wall. The properties for count and area of the main element cannot be edited, the 
value is calculated from the total façade area minus all other inserted façade 
components without an area. The area of a component is always taken into 
account for the size tally except if the FAN checkmark is set in the second to last 
column of the table.  

Additional components can be added via the symbol COMPONENT or CTRL+’+’  
obsolete components can be deleted with the symbol DELETE or  CTRL+’-’ (the 
component must be activated (blue background)). 
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Click on the symbol DUPLICATE ELEMENT, if you need an additional element of the 
same type. 

The display for the summation L2,nTij (EN 12354) or Dij (other standards) of each 
component cannot be modified, this value is calculated.  

The properties for a planned component can only be edited after you deleted the 
checkmark in the column „=“. Only then is it possible to enter values in the column 
“cost”.  

The different components are optimized in the component list. The area is 
calculated from width and height or can be directly entered.  

The component properties can either be defined using R’w (sound reduction index) 
or Dn,e (normalized level difference). 

For the calculation of the weighted sound reduction index, you have 3 options to 
your disposal.   

 

OWN ENTRY, if you know the value or if you want to find the required sound 
reduction value by turning the mouse wheel, the option CALCULATED BY DIN 4109 for 
massive walls if the wall composition and the DIN is known or via the 
TRANSMISSION LOSS LIBRARY.  

If you select from library the system library and an empty project library are 
opened. Select the desired element in the system library and copy it via the button 
> PROJECT or the button ACCEPT to the project library. The selection of a group and 
the free text search help to find the desired element in the extensive system 
library. The name of the selected element is shown in the component list if you 
activate the column “library element” with a right mouse click on the table header 
(Ctrl+L).  

 

The cost for the planned changes can be entered in various ways:  

• The cost per component is fixed and does not depend on count or area.  

• The cost per count is calculated from the individual cost  
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• The count cost related to area is calculated as a multiplication of cost per 
square meter times the area.  

Activate the columns for cost (Ctrl+K) and for cost calculations (Ctrl+Shift+K) or 
with a right click on the table header.  

An example for the cost calculation would be retro-fitting windows with improved 
rubber seals. The insertion loss improves, the cost is calculated as cost per meter of 
length of the rubber seal. In an additional line (inserted with CTRL+ ‘+’) the rubber 
seal is entered. The meters of length of the seal are entered in the column for the 
area. The noise reduction index R'w is set to 130 dB to make sure this component is 
not influencing the noise calculation. The count in the existent side of the table is 
set to 0.  

Wall calculator 
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The wall calculator can be opened from the menu TOOLS-> WALL CALCULATOR or 
with a right click on the filed R’w in the component list. The calculation is carried 
out in accordance to DIN 4109, in the version from November 1989. The wall 
calculator is a tool to quickly assess massive components.  

 Gardens, balconies and terraces (not available for EN 
12354) 

A compensation in accordance to the German Traffic Noise Guideline 97 can be 
calculated with this tool. With this it is possible to calculate the compensation 
amounts for garden areas and terraces depending on the magnitude of the noise 
level and the noise limit that applies for the area.  

Print room book 
Via FILE -> PRINT the results of the calculations are printed. Define how much in 
depth you want your printed documentation.  
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You can choose from various fixed formatted printouts: 

• Information concerning the building and dwellings with the façade 
calculations. If desired graphics and comments can be printed (INTERIOR 

LEVEL CALCULATIONS).  

• List for improved components (MEASURES LIST). Choose whether you want to 
include the costs for the measures in the table.  

• Not available for EN 12354: Calculation of the compensation amounts for 
outside areas (gardens, terraces and balconies) (COMPENSATION 

CALCULATION OUTSIDE) 

The selected printout either can print the data for all objects in the room book 
(ENTIRE PROJECT), the CURRENT BUILDING or the CURRENT SELECTION a selected 
element. Aside from this the buildings-, floor- and dwelling pages can be 
suppressed.  

With additional options you can define if the pictures that were created within BA 
Facade, assigned bitmaps and comments are printed.  

      

The printout is fixed in its formatting, headers and footers can be defined in the 
page layout FILE -> PAGE LAYOUT. 
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 Page Layout 

The page layout in SoundPLAN not only includes the paper size and the frames, but 
also the contents and layout of the headers and footers so that all enclosures of an 
investigation report look the same.  

Open the page layout with TABLE -> PAGE LAYOUT. 

Define the format of the page in the tab index card "page format". 

 

The different parts of the printout 

 

Define the print sheet size and the margins. The line widths and the colors of the 
frames and the separator lines can be defined for each section separately.  

The header and footer sections have three partitions: Left, middle, right. Texts or 
logos in the left partition are left aligned, in the middle partition centered and in 
the right partition right aligned. 
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A graphics can be inserted in the header as well as the footer, for example your 
company logo or the logo of the customer. Click on the gray field to select the 
graphics file. Define the position (left, middle, right partition) the height and the 
width of the graphics. When you check the logo justification button ("STRETCH"), 
the logo is fitted into the allocated space. The print preview however will decrease 
its speed because of it and therefore it is advisable to select a logo of proper size.  

Format the content and the size of the page frame in the tab index card "header 
and footer texts". The texts can be text variables, automatically updated with 
information stored in the project or own texts.  

 

Page header and page footer are printed on all pages of the table as well as for the 
legend. To format the texts, highlight the text or text variable and click on the 
button FONT. Define the width of the left and right partition and the height of the 
frame. The three sections can be partitioned with vertical SEPARATOR LINES.  

For the entry the following TEXT VARIABLES are prepared for you and will 
automatically be updated in case the information changes. Click the cursor to the 
partition where the text should be displayed and select the variable to be 
displayed: 
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In the tab index card "print options" you can select the first page number for the 
printout. Additionally, the table font and size and the colors for the column headers 
and heading lines are defined.  

Click on the button PREVIEW to check the page layout. 
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16  Noise Allotment 

Introduction 
This module offers the following new options in managing the noise emissions of 
multiple noisy facilities within an area (such as an industrial park with multiple 
plants under multiple different ownership). The program helps set noise generation 
limits for various facilities within the area to make sure the overall noise limit is not 
violating the laws and the individual areas are minimized in their restrictions: 

• The noise background preload from existing industrial facilities can be taken 
into account: 

o In detail: The preload can be defined for each individual receiver or as 
results from a calculation run. 

or 

o In general: Reduction of the design noise threshold by a fixed margin, for 
example 6 dB(A). The margin can be set individually for each receiver. 

• Marking partial sources with colors in accordance to the limit violation they 
cause at the receiver, it is easy to see which of the sources need to be 
mitigated further during the interactive dimensioning process. 

• Additional noise allotments: 

• By increasing the emissions rate for individual directions, it is possible to 
further maximize the emission rates. The definition of the directions for an 
increase of the noise allotment is done quickly with the mouse. 

• The results of the allotment simulation can be printed or via the clipboard 
moved to programs such as Word. Fixed user defined text formulations are 
available. 
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Working on a noise allotment in SoundPLAN 

Preparations  

In the Geo-Database enter the areas representing the sections of the industrial 
area as area sources without defining the sound power and model the receivers in 
the surrounding buildings.  As in this stage of the planning process the geometry 
such as buildings within the industrial area is unknown, therefore the allotment 
uses only the 2D spreading to optimize the distribution of sources in the entire 
area, as such the definition of areas and receivers is sufficient to generate the 
allotment calculation. 

When the location of buildings is known, you can use this information in order to 
adjust the directionality of the sources for additional contingents or to improve the 
graphical presentation. 

After the definitions open the Calculation core and carry out a pre-calculation. 

 

Select the category "Outdoor Noise" and the calculation type "Noise Allotment". 
This calculation in accordance with the DIN 45691 regards only the horizontal 
distance of the spreading into a full 3D sphere. 

Start the Allotment 

Open the Allotment in the SoundPLAN Manager. 

Select FILE -> NEW and load the results of the pre-calculation done in the Calculation 
Core (file name RNATxxxx.res) via the symbol button OPEN. 
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Depending on the selected ASSESSMENT, the assessment time slices may change.  

An existing PRELOAD NOISE can be determined in a SoundPLAN calculation for single 
receivers or be entered manually for all receivers. For the allotment it is possible to 
alter the defined base level. The allotment can also be defined as an offset to the 
noise limit (example -10). 

Selection to determine the additional noise contingents 

You can select how the additional contingents shall be generated: 

• With SECTORS (A.2 according to DIN 45691) 

• By area (via the AREA USAGES) 

• NO additional contingents 

For the determination of additional contingents via the method by area, at first the 
areas need to be defined in the Geo-Database as usage areas. All usage areas to be 
used in the Allotment must be located in the same Geo-File, which is then assigned 
to the Allotment. 
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The additional contingents are assigned to the areas instead of the sectors. If 
multiple receivers are located in an area, the program will use the lowest additional 
contingent. 

According to DIN 45691 the TARGET VALUES shall be considered as integer rounded 
values. You can deactivate the check box if needed.  

SoundPLAN suggests the distribution of the emission allotments L(EK) to the part 
areas. This can be calculated with equal values or energetically optimized 

Click OK to open the table in the tab index card emission Allotment according to 
your settings.  

Carry out the Allotment 

 

In the top section the receivers are displayed with their noise limits and if 
applicable the base level that needs to be taken into account. The plan value then 
shows the magnitude of the remaining noise levels under the constraints of the 
background base level. 

In the lower section the industrial areas are listed that were defined in the Geo-
Database together with the resulting assessed noise level and the remaining level 
contingent for each receiver. 

Enter the emission allotments for each industrial area. Keep the shift key pressed 
and click on multiple adjacent areas to jointly assign their source contingents. As 
soon as the plant value is exceeding, the partial noise level that causes the excess 
and the receivers that show the problem are marked in red. 
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Change the emission allotments of individual partial areas until the part value is not 
exceeded anywhere. 

Using the POCKET CALCULATOR, you can reset changed emission allotments to the 
default setting. The emission allotment of certain subareas can be excluded from 
the optimization with the checkmark OPTIMIZE L{EK} OF THIS PART AREA, for 
example, if an emission allotment has already been set. The corresponding part 
areas are shown in bold. 

Assign additional emission allotments for all time slices used in the noise 
assessment. 

Settings 

 

By default, the receivers are displayed with the name you have entered in the Geo-
Database. If these texts are too long, you can also choose the object number for 
the display instead of the name. Go to OPTIONS -> SETTINGS to select the display 
style. If there are several receivers in a sector, you can hide the receivers that are 
not included in the noise allotment wit ONLY DECISIVE. 

To make the tables fit the screen or printout if many receivers or many part areas 
are present, you can specify the COLUMN SIZES in pixel for receivers. part areas, and 
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emission allotment. In addition, you have the option to let the software 
automatically determine the column width for the receiver description. The 
entered column width is considered as the minimum width in this setting. 

For the SORTING you can select in which order they should be arranged in the table 
- alphabetically by the object name or by the object number. Receivers can also be 
sorted according to the order of the sectors. 

The COLOR FOR TABLE HEADERS can be selected for display and printing. If necessary, 
the ALLOTMENT NAMES of the emission and additional allotments for each time slice 
can be changed. 

Deactivate receivers 

Individual receivers can be excluded, if there are too many receivers in the 
allotment table. 

 

Open OPTIONS -> SETTINGS and click on the tab index card Receivers.  

Update results 

After you recalculated the pre-calculation or the preload and get back to the 
allotment, you are asked whether you want to update the results. Manually 
updating the results is possible with fILE -> UPDATE RESULTS or Ctrl+ R. 

 

If you select REBUILD, the results of the pre-calculation and, if present, the 
calculated preload are reloaded. All manual changes get lost. With UPDATE you can 
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reload the pre-calculation and / or the preload from the results. Manual changes to 
preload, emission allotments and settings are retained. 

 Additional allotments 

 

The reference point is placed in the center of the partial areas and the directional 
sectors for the additional contingents are split up for each receiver. For the 
arrangement in the land-use plan, you can set the coordinates of the reference 
point to even numbers. In order not to accidently move the reference point, you 
can fix it with the checkbox FIX REFERENCE POINT. 

The angle segments can be changed, because they represent the different usage 
areas in the project. The angle segments can only be adapted until the position or 
the next receiver. In case this should be necessary, please delete the receiver first 
(at the moment this is only possible in the Geo-Database). 

Additional information you could have entered in the Geo-Database (buildings, 
areas) is shown in the graphical representation in the tab "additional contingents". 

Background bitmap 

For a better orientation you can place a georeferenced bitmap in the background. 
The existing georeferenced bitmaps are present in the selection list on the top left 
of the screen.  

Object types 

You can change the representation of the single objects as usual with OPTIONS -> 

OBJECT TYPES. New object types have been inserted for the noise allotment. 
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Calculation of Grid Noise Maps 

Once the Noise Allotment is finished you can calculate a Grid Noise Map using the 
allotment results. In order to simplify the handling, the grid noise map is saved 
under the same number as the pre-calculation and the allotment.  

The calculation is started in the program section for „Noise Allotment“ under the 
tab Calculate Grid Noise Map“. Click on the green arrow to start the calculation. 
Like in the calculation core the logbook contains vital information about your 
calculations. It is not necessary to change into the Calculation core to start the 
calculations, however in the Noise Allotment the noise map is not graphically 
displayed while it is calculating. 

The calculation is done in accordance to DIN 45691 with free field propagation 
without ground interaction. The calculation times accordingly are extremely short.  

Display of the Noise Allotment in the Graphics 

As usual, load the noise allotment from the file selection of the graphics, the file 
type is „Noise Allotment “. And additionally, if desired, the Grid Noise Map in the 
file selection manager. 
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Further processing of the results 

You can print the documentation of the Noise Allotment or copy the graphics of the 
additional contingents and sector lines into the clipboard and paste it in your 
report. Likewise, you can transport the data about the receivers, industrial areas 
and additional allotments. 

To print the data via SoundPLAN as an annex, select FILE -> PRINT. Headers and 
footers can be formatted under FILE -> PAGE LAYOUT. 

You have additional formatting possibilities in the OPTIONS -> SETTINGS, tab index 
card “Printout”: 
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17  Annex 

Files, created by SoundPLAN 
This overview lists the file types, SoundPLAN creates during the project work. The R 
in the beginning of a file name stands for files generated in the run kernel during 
the calculation. The extension RES indicates a file in which all information for a 
calculation run (result) are stored.  

Files in the project folder 
Project 

project.sp Project settins 

colors.sgc Color favorites 

objects.got Project-Object types 

symbols.sym Symbols delivered with SoundPLAN 

user.sym User defined symbols  

*.grf Geo-reference of background bitmaps 

*.~gr Backup file of the geo-reference 

project.vpt  

project.tsd Definition of the tile system  

calc.tsd Definition of the calculation tile system 

CurrentShpDef.sfd  

Geometry 

*.geo Geo-File 

*.~ge Backup of Geo-File 

*.sit Situation 

*.~si Backup of Situation 

objdos.bin 

geofiles.dat List of the objects in a project, with object ID  
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geofiles.rpt 

Results 

RSPSxxxx.res Single point calculation 

RGLKxxxx.res Façade noise map calculation 

RRECxxxx.res Calculation results of all receiver caluclations (SPS, FNM, …) 

RRLKxxxx.res Grid noise map calculation  

RSLKxxx.res Cross section map 

RRLKxxxx.gm Calculation results grid noise map / cross section map 

RCNMxxxx.res Meshed noise map 

RWNDxxxx.res  Single point wall design precaluclaton 

RWNFxxxx.res Façade noise map wall design precaluclaton 

RDESxxxx.dat Data of the wall design precalculation 

RHOTxxxx.res Hallout calculation  

RHRKxxxx.res Indoor grid map 

RHSPxxxx.res Indoor single point calculation 

RSAKxxxx.res Indoor noise propagation curve 

RSLHxxxx.res Indoor cross section map 

RANSxxxx.res Aircraft noise single points 

RANFxxxx.res Aircraft noise facade noise map 

RANGxxxx.res Aircraft noise grid noise map 

RANIxxxx.res Aircraft noise contour lines 

RRHSxxxx.res Hotspots 

RRILxxxx.res Grid import of external grid maps 

RNATxxxx.res Noise allotment 

RNATxxxx.nat Result of a noise allotment 

RDGMxxxx.res Digital ground modell 

RDGMxxxx.dgm Contents digital ground model 

RPDGxxxx.abs Level charts and level time histograms 

RRLKxxxx.lt Result of an animated noise map 

REXPxxxx.abs Data for Expert Industry 

 *.log Log book of the calculation run 

Sources 

RROAxxxx.abs Road emission 

RRADxxxx.abs Train table railway 

RRAIxxxx.abs Track related corrections railway 

RSCRxxxx.abs Source table 

RS24xxxs.abs Source day histogram 

RSFQxxxx.abs Source spectrum 

RCFQxxxx.abs Spectra of the contribution levels 
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RCONxxxx.abs Contribution levels 

RFRQxxxx.abs Frequencies 

RGRPxxxx.abs Group table 

RMNDxxxx.abs Attenuation table 

RMPAxxxx.abs Mean propagation 

Other files 

*.runx Run file 

*.~run Backup of run file 

*.sgs Graphics sheet 

*.~sg Backup of graphics sheet 

*.baf File for BA Outside 

*.lgs File for long straight road (RLS-90) 

*.atn Attenuations (Expert Industry) 

*.ntd Receiver table (Spreadsheet) 

*.bfl Area table (Spreadsheet) 

*.bld Building table (Spreadsheet) 

*.fmt Format file for the page layout 

RWNDxxxx.set Settings for wall design single points 

RWNFxxx.set Settings for wall design facade noise map 

*.pli Measurement values imported to the graphics 

RROPxxxx.gm Stored result of a grid noise map operation 

RRECxxxx.trx Iteration steps of meshed noise maps 

DBTrackxxxx.trk Animation track railway 

TempWork.abs Temporary file if the GeoDB is open 

*.elg Binary stored elevation data in grid structure  

*.elv Binary stored elevation data as point clouds 

FileInfo.bin Information about the original elevation points  

FilterLogBook.log Log book of the elevation filter  

FResInfo.bin Information about the filtered elevation points 

ElevInfo.bin  

Files in the Globdata folder 
project.sp Project settings for new projects 

project.bak Backup copy project settings if the country settings have 

been changed 

ASCII2GeoDB.abs Column assignment for the ASCII Import 

Dbase22GeoDB.abs Column assignment for the ESCRI Shape Import 

GeoDBObjExt_.abs Settings for the display of the object properties for 
Property Explorer, object info and shape export 
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GeoDLL.abs Coordinate and reference systems 

*.ntt Template receiver table (Spreadsheet) 

*.bft Template area table (Spreadsheet) 

*.fmt Format file for the page layout (Results table and 
Spreadsheet as well as noise allotment, emission 
documentation road / railway, long straight road, BA 
Outside) 

TAB_LAYOUT.fmt Format file result table which is used for new tables  

*.sgt Template graphics sheet 

*.sge Single elements of a graphics sheet (old: sgb) 

*.scc Color scale 

*.sgc Color favorites 

PCList.vrl List of the network PCs used for distributed computing 

DUPCList.vrl List of the network PCs used for „distribute updates“ 

*.log Calculation log book 

SERVER*.txt Protocol distributed computing (Server) 

CLIENT*.txt Protocol distributed computing (Client) 

Picdoc.fpd Photo documentation 

RBLayout.lot Layout types BA Outside 

ExpInd.set Window assignment (detail windows) Expert Industry 

File Names of the Libraries 

General 

Absor.abs Absorption library 

Assess.abs Assessment library (Assessments) 

Gebiete.abs Assessment library (additions for area usage) 

Zbdef.abs Assessment library (definition of time slices) 

Atten.abs Attenuation library 

Attengrp.abs Groups for attenuation library 

Emis.abs Emission library 

Emisgrp.abs Groups for emission library 

Riwi3d.abs 3D directivity library 

Riwi.abs 2D directivity library 

Time.abs Day histogram library 

Traffic.abs Road day histogram library 

Trans.abs Transmission library 

Transgrp.abs Groups for transmission library 
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Standard dependent 

Aircrafts.abs Aircraft classes (only system library) 

MeteoStat.abs Meteorological station (air pollution) 

N2ktraf.abs Road day histograms for Nord2000 

N2kvehicles.abs Vehicle categories road emission Nord2000  

N2kWeather.abs Weather statistics Nord2000 

N2kwind.abs Meteorological parameters Nord2000 

Nmpbmet.abs Meteorology NMPB96 

Nor2kRoad.abs Vehicle categories road emission Nord2000 old 

Roadsurf.abs Road surfaces Nord2000 

Stoffe.abs Library of air pollutants 

Tcrn.abs Train table CRN  

Thurail.abs Train table Hungarian rail 

Tjaprail.abs Train table Japanese rail 

Tn2krail.abs Train table Nord2000 

Tnmt.abs Train table NMT 

Tnmveh.abs Vehicle categories road emission TNM 

Toeal30.abs Train table ÖNorm 305011 part 1 

TOeAL30TT.abs Train table ÖNorm 305011 part 2 

Trmr2002.abs Train table RMR 2002 

Ts03.abs Train table Schall 03 1991 

Tsemibel.abs Train table Semibel 

TSFRA2005.abs Train table FRA 2005 

TSS03_2006.abs Train table Schall 03 2006 

Tssncf.abs Train table NFS 31-133 

Tsvbusch.abs Train table VBUSch 

Ttrapid.abs Train table Transrapid 

VehCatFRA2005.abs Waggon categories FRA 2005 

VehCatS03_2006.abs Waggon categories Schall 03 2006 

Wind.abs Wind statistics for ISO 9613 (Germany) 

Implemented standards 
A list of the guidelines implemented and tested in SoundPLAN is provided on the 
DVD and can be found in the online help.  

SoundPLAN is a standard-based software. Each standard implemented in 
SoundPLAN undergoes an extensive testing process to ensure the correct 
implementation of the formulas in SoundPLAN and the consistent quality of the 
calculation results. If available, the test tasks of the guideline manufacturers are 
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used. If there are no official test items, SoundPLAN GmbH or a SoundPLAN 
distributor creates test cases to check the correct implementation of the guideline. 
With each update, all official and own test tasks are automatically checked. An 
update is only made available on the Internet if there are no justified changes in 
the calculation results compared with the previous update. 

Coordinate and reference systems worldwide 
The coordinate and reference systems of the different countries are implemented 
in SoundPLAN using the file GeoDLL.abs developed by Killetsoft including a large 
number of worldwide coordinate and reference systems. In order to keep the 
coordinate system selection list manageable, the systems are preselected with the 
coordinate systems in different countries and displayed according to your country 
settings. Select additional systems or deselect not needed systems in the 
SoundPLAN Manager via OPTIONS -> SETTINGS, branch Global, items COORDINATE 

SYSTEMS and REFERENCE SYSTEMS. After activating the needed systems, they are 
displayed in the selection list.  

  

http://www.killetsoft.de 

 

http://www.killetsoft.de/
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3 

3D wire model 82 
3D-Graphics 625 

A 

Absorption library 
Values 302 

Absorption Library 299 
Acceleration of Grid Noise Map calculations: 

349 
Activate object 144 
Add colums 

Spreadsheet 418 
Add result columns 

Spreadsheet 419 
Add results 

Spreadsheet 420 
Adjust sharp elevation steps 172 
Alignment Elements 506 
Animation 

3D-Graphics 638 
Animation track 290 
ArcView 

Grid/Contour line export 573 
Import 101 

Area 287 
Area evaluation 601 
Area usage 279 

Assign to buildings 261 
ASCII 

elevation data 114 
Grid/Contour line export 573 
point source import 111 

ASCII Geometry export 109 
ASCII interface 

Import 107 
Assessment 

Maximum noise levels 313 
Assessment 339 
Assessment library 312 
Assessment Library 

Create 312 
Assign texts to buildings 167 
Assigning Sources to Buildings 223 
Assignment of  Situations and Geo-Files in the 

run file 321 
Assignment table 

ASCII-Interface 108 
Attenuation library 

Values 304 
Attenuation Library 299 
Attribute labels (Graphics 617 
Automatic Scaling 522 

B 

Backup copy 
Library 299 

Base settings 
Boxes 505 
Colored scale 522 

Batch run 325 
Berms 271 
Bitmap 

load 92 
Bitmaps in the Graphics 598 
Box properties 504 
Bridge detection 173 
Building evaluation 601 
Buildings 257 

Connecting receivers 281 

C 

Calculate 
Spreadsheet 425 
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Calculate and highlight 
Spreadsheet 441 

Calculate calculation runs successively 325 
Calculate elevation for objects without 

elevation 153 
Calculate right angles 164 
Calculation 317 

assignment of Situations and Geo-Files 321 
Distributed computing 373 

Calculation acc. to Sound Particle Model with 
Diffraction (SPD) 360 

Calculation acc. to VDI 3760 358 
Calculation Area 285 
Calculation logbook 325 
Calculation run properties 318 
Calculation run settings 327 
Calculation settings for noise calculations 330 
Calculation statistics 327 
Calculation types 

Cross-sectional Noise Map 350 
Façade Noise Map 351 
Grid Noise Map 345 
Meshed Noise Map 356 

Camera track 290 
Capture coordinates 91 
CARD/1 

Contour line export 573 
Card/1-Interface 113 
Centre Time (TS/CT) 365 
Change Geo-File assignment 152 
Change view port (Graphics) 538 
CityGML import 104 
Clarity (C80) 365 
Clean multiple points 164 
Clean-up overlapping areas 160 
Clear selection 145 
CLF import 316 
Color definition 

Library 298 
Color palette 492 
color scale 521 
Colored scale 

Layout 524 
Column layout 

Spreadsheet 434 

Column Layout 
Diagrams 394 

Column setup (ResTab) 393 
Comments and Numeric Values 

Library 296 
Conflict map 674 
Connect lines 158 
Connection to Google Earth 130 
Connection to Google Maps 125 
Connection to online map services 125 
Connection to OpenStreetMap 125 
Connection to Web Map Services 131 
Contour line export 573 
Contour line texts 

Rotate 567 
Contour lines 

label 566 
Convert object type 153 
Coordinate 

capture 91 
Coordinate and reference systems 

Presettings 54 
Coordinate operations 155 
Coordinate systems 45 

Default project coordinate system 55 
Coordinate transformation 174 
Copy 

Library records 295 
project 43 

Copy object 150 
Create 

New Assessment Record 312 
Create an area table 

Spreadsheet 411 
Create map 

File selection 532 
Creating a receiver table 

Spreadsheet 410 
Cross section 284 
Cross sections 

Road profile 185 
Cross-sectional Noise Map calculation 350 
Cut 

Data inside an area 159 
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D 

Day Histogram Library 310 
Definition (D50) 365 
Definition of scale intervals 564 
Delete 

point or object 148 
project 43 
Viewport (GeoDB) 138 

Delete page break 
Spreadsheet 440 

Designing Spreadsheet tables 434 
DGM 121 

Calculate object height 170 
DGM for the calculation 339 
DGM-Darstellung 

Farbverlauf / Höhenlinien 570 
Differenzkarte 

Rasterlärmkarte 561, 577 
Digitizing 

from scanned maps 92 
Digitizing mode 91 
Dimensional chain 82 
Directivity library 304 
Distance 

measure 82 
Distribute occupants or dwellings 168 
Distributed computing 373 
Divide areas 159 
Document project status 

tiles 649 
Documentation 383 

Presentation of numerical values 394 
Drawing sequence 546 
Duplicate calculation runs 323 
Duplicate objects 149 
DXF 

Grid/Contour line export 573 
DXF Export 

Geometry data 100 
DXF Import 97 

E 

Early Decay Time (EDT) 365 
Early latera energy fraction (LF) 365 

Edge 
Boxes / Elements 508 

Edit 
Library Records 294 
Map contents 535 
North arrow 528 
Scale bar 530 
Situation 71 
Text boxes 515 

Edit data 136 
Edit map 535 
Edit mode 136 
Eingabe der Höhe 77 
Element 

Activate (Graphics) 490 
create (Graphics) 488 
Delete (Graphics) 490 
Edge properties 508 
Layout 504 
Move, zoom (Graphics) 490 

Element properties 504 
Elevation from DGM 153 
Elevation Lines 264 
Elevation stretch factor 

Projections GeoDB 84 
Elevations from Google Earth 131 
Emission calculation 

Parking lots 196 
Roads 187 

Emission documentation 
Railway 205 
Road 185 

Emission library 
Values 300 

Emission Library 299 
EPSG-codes 46 
Error message object (Calc) 

Search object (GeoDB) 156 
ESRI ASCII Grid 

elevation data 114 
ESRI Shapefile 

geometry export 103 
Grid/Contour line export 573 
Import 101 

Estimate multiple reflections 177 



 SoundPLAN Manual 8.1 
 Index 

Page •  788/793 

18 

EU Environmental noise regulation 601 
Export 

Grid values / Contour lines 573 
kml contour bands 573 

Export 
ASCII Geometry 109 
ESRI Shapefile (geometry) 103 
Geometry data as DXF 100 
QSI 104 
Result table 405 
Spreadsheet 452 

Export 
Graphics 621 

Extract 
project 44 

F 

Facade Noise Map 
calculation parameters 352 
Object type 578 
Prepare buildings 164 

Façade Noise Map 
File selection 575 

Façade Noise Map calculation 351 
Facade Noise Maps 

Active facades 261 
Farbverlauf für DGM-Darstellung 570 
Field definition for Shapefile Export 144 
File operations (Graphics) 605 
File selection 532 
Filter 

Elevation data 114 
GeoDatabasek 160 

Fix building geometries 163 
Folding marks 508 
Formula editor 425 

Table of the commands 426 
Frame properties 

Map 509 
Front elevation 82 

G 

General objects 
point, polyline, area 287 

Generate areas 158 
Generate parallel object 157 
Geo-File 

change assignment 152 
Geometry bitmaps (Graphics 598 
Geometry parameters 537 
Geometry Texts 286 
GeoTools 

Adjust sharp elevation steps 172 
Assign texts to buildings 167 
Bridge detection 173 
Calculate object height from DGM 170 
Calculate right angles 164 
Clean-up overlapping areas 160 
connect lines 158 
coordinate transformation 174 
Distribute occupants or dwellings 168 
Divide areas 159 
Elevation from terrain intersections 172 
Estimate multiple reflections 177 
Evaluate spot heights for mean building 

height 169 
filter/thin out coordinates 160 
Fix building geometries 163 
generate areas 158 
Generate parallel object 157 
Insert intersections and split 159 
Interpolate elevations 171 
Interpolation 161 
Location correction of road / railway 

alignment 176 
Prepare buildings 164 
Reassign receivers to buildings 165 
Simplify buildings 169 
Smooth elevations 171 
Subdivide into sections 162 
Transformation between coordinate 

systems 175 
Goggle Earth 130 
Google Earth elevations 131 
Google Maps 125 

Elevations 129 
Grafik-Objekttyp 150 
Graphical presentation in calculations 328 
Graphics 
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Export 621 
Graphics 483 

Load data 532 
Graphics file selection manager 531 
Grid Noise Map 

acceleration of calculation 349 
calculation parameters 346 
Interpolation during the calculation 347 
Load (Graphics) 559 
recalculation 349 

Grid Noise Map calculation 345 
Grid values 

Export 573 
Ground absorption 277 
Ground areas 277 
Ground effect 277 
Group 

Insert (parking lot) 196 
Insert (sources) 219 
Sources in industrial buildings 246, 249 

Group Reference 
Libraries 297 

Gruppe einfügen 
Industriequellen 249 

H 

Hardware suggestions 36 
Hatch patterns 554 
Headers and Footers 402, 451, 767 
Helmert transformationintialize Bitmap 97 
Highlighting singles cells 

Spreadsheet 440 
Höhenabfrage 77 
Höhenlinien für DGM-Darstellung 570 

I 

Import 
ArcView 101 
ASCII 107 
ASCII point sources 111 
CityGML) 104 
DXF 97 
elevation data 114 
ESRI Shapefile 101 

OpenStreetMap 127 
OpenStreetMap (manual) 106 
Photos with GPS data) 112 
QSI) 104 
SoundPLAN DOS 113 
SoundPLAN Geo-Files) 111 

Import and filter elevation data 114 
Import Libraries 

ASCII 314 
Excel 314 
SoundPLAN DOS 314 

Import measurement values 
Graphics 571 

Indoor calculations 358 
Industrial Noise Sources 

Definition in the Geo-Database 218 
Industriehalle 227 
Insert point 149 
Installation 

Distribute updates 32 
Netzwerklizenz 26 
SoundPLAN new 22 
Upgrading SoundPLAN 24 

Interpolate colors (Graphic 493 
Interpolate elevations 171 
Interpolation 

Grid Maps 347 
Interpolation (smooth lines) 161 
Intersections with terrain 172 
Invert entry direction 152 

K 

km posts 
Railway 204 
Road 184 

kml 
Contour band export 573 

L 

Label contour lines 566 
Layout 

Element 504 
Legend 516 
Legend definition 
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Spreadsheet 451 
Length scale bar 530 
Library 293 

Absorption 299 
ASCII import 314 
Assessment 312 
Attenuation 299 
Backup copy 299 
CLF import 316 
Copy records 295 
Day histogram 310 
Directivity 304 
Edit records 294 
Emission 299 
Excel import 314 
Li(Calc) day history frequencies 309 
Print 316 
Road day histogram 311 
Transmission 299 

License update 25 
LIMA BNA-Interface 113 
Load 

Bitmap 92 
Load data 

Graphics 532 
Location correction of road / railway 

alignment 176 
Logbook 

error message object (GeoDB) 156 

M 

Map 531 
Mark points or objects 144 
Maximum noise levels 

Library definition 313 
Mean building height 169 
Measure distances 82 
Measuring tape 82 
Meshed Noise Map 

calculation parameters 357 
Meshed Noise Map calculation 356 
Minimizing costs 

Wall Design 475 
Minimum text size 538 

Move objects 149 
Move point 149 

N 

Netzwerklizenz installieren 26 
New 

Situation 71 
New project 40 
Noise protection walls 265 
Noise zones 279 
North arrow 528 
Notification of new Updates 25 

O 

Object 
activate 144 
copy 150 
delete 148 
generate parallel object 157 
search (GeoDB) 156 
select 144 

Object dots 87 
Object height from DGM 170 
Object numbering 55 
Object setup 542 
Object types 542 
Objects 

duplicate 149 
move 149 
rotate 149, 174 

Online map services 125 
Open project 42 
OpenStreetMap 125 

Elevations 129 
OpenStreetMap import 106 
Options 

edit data 502 
Organisation 

Libraries 293 
OSM 125 
Overview of short cut keys in the Geo-DB 181 
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P 

Pack 
project 44 

Page break 
Spreadsheet 440 

Page Format 402, 450, 766 
Parking Lots 196 
Photo documentation 288 
Photo point 287 
Photos with GPS data 112 
Plot 619 
Point 287 

delete 148 
move 149 
select 144 

Point data 
Measurement values 572 

Polar data 
Measurement values 572 

Polyline 287 
Prepare buildings 164 
Print 

Library elements 316 
Run info 385 

Print Graphics 619 
Print preview 

Result tables 404 
Profile Lines 264 
Project 

copy and paste 43 
delete 43 
New 40 
Open 42 
pack and extract 44 
rename 43 

Property operations 155 

Q 

QSI interface (DIN 45687) 104 

R 

Railway 202 
Railway documentation 205 

Rearranging Columns 
Result tables 394 

Reassign receivers to buildings 165 
Receivers connected to buildings 281 
Reference axis 

Railway properties 204 
Reference line 

Road properties 185 
Reference points 

Bitmap 92 
Reference road or railway 

Spreadsheet 422 
Reference scale 545 
Reference systems 45 
Reflection loss 

Buildings 260 
Walls 267 

Regenerate object numbers 179 
Rename 

project 43 
Reset emissions 178 
Result table 

Export 405 
Result Tables 383 
Reverbation time 365 
Right angle mode 81 
Road alignments 

Definition in the Geo-Database 183 
Road day histogram library 311 
Road Properties 184 
Roads 

Emission calculation 187 
Room acoustics parameters 365 
Rotate 

Contour line texts 567 
Geodatabase 86 

Rotate objects 149, 174 
Rounding 

Spreadsheet 435 
Run file 317 

assignment of  Situations and Geo-Files 321 
Run info 

format and printout 385 
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S 

Scale bar 530 
Scale intervals 

define 564 
Scale of y-axis 

Library 298 
SCOP Winput 

elevation data 114 
Search object (GeoDB) 156 
Section layout 

Spreadsheet 442 
Section wrap 

Text boxes 516 
Select points or objects 144 
Selection 

clear 145 
Separate multiple objects 179 
Settings and filter 

Spreadsheet 415 
Shapefile Export 

Store field definition 144 
Shapefile-Import 101 
Sheet components 495 
Sheet manager 496 
Sheet templates 501 
Sheet tree 496 
Side diffraction 333 
Side projection 82 
Signal-Intersection Addition 195 
Signs and symbols 516 
Simplify buildings 169 
Single point calculations 343 
Single Point Receivers 280 
Situation 

edit 71 
new 71 

Situation Manager 71 
Size 

Sheet 508 
Smooth elevations 171 
Sort 

Spreadsheet 439 
Sound Particle Model with Diffraction (SPD) 

360 
SoundPLAN DOS 

Import 113 
SoundPLAN-Manager 40 
SoundStrength (G) 365 
Sources 

Industrial Noise Sources 218 
Railways 202 
Road alignments 183 

Speech Transmittion Index (STI) 365 
Split object 152 
Spot Heights 264 
Spot heights as text 

DXF-Import 100 
Spreadsheet 

Add additional columns 421 
Add result columns 419 
Calculate and highlight 441 
Column layout 434 
Export 452 
Export formulas 434 
Reference road or railway 422 
settings and filter 415 
Structured tables 444 
Table settings 424 
Table statistics 447 
Update results 423 

Spreadsheet file manager 412 
Spreadsheets in the Graphics 616 
Standard deviaton 

initialize bitmap 97 
Start or terminate a calculation run 324 
Starting the optimization 

Wall Design 468, 471 
Stationing 

Railway 204 
Road 184 

Store 
Viewport (GeoDB) 137 

Stratis-Interface 113 
Structured tables 

Spreadsheet 444 
Subdivide into sections 162 
Summed-up conflict maps 677 
Symbol editor 612 
Syntax of a formula 425 



SoundPLAN Manual 8.1 
Index 

 Page •  793/793 

18 

T 

Table layout 
Result tables 396 

Table Settings 
Spreadsheet 424 

Table statistics 
Spreadsheet 447 

Templates 
Graphics 501 
Spreadsheet 411 

Termiante or start a calculation run 324 
Terrain Points 264 
Text boxes 515 
Text variables 

Tables 402, 451, 767 
Texts 

Geometry Texts 286 
Texts are not displayed (Graphics) 538 
Thin out coordinates 160 
Tiling manager 647 
Tiling navigator 650 
Tiling projects 645 
Tools 

Regenerate object numbers 179 
Reset emissions 178 
Separate multiple objects 179 

Transformation between coordinate systems 
175 

Transmission library 
Values 303 

Transmission Library 299 

U 

Undo 
GeoDB 144 

Update 
Results and Geometry (Graphics) 541 

Update Spreadsheet results 423 
Upgrading SoundPLAN 24 

V 

Value grid 290 
VDI 3760 358 

Viewport (GeoDB) 
delete 138 
rename 138 
store 137 

W 

Wall Design 461 
Internal organization 462 
Model restrictions 481 
Performance 466 
Tasks in the Calculation 468 
Tasks in the Geo-Database 467 

Walls 265 
WMS Server 131 
WMS servers (Graphics) 135 
Working with tiling projects 645 

Z 

Zones 279 
Zoom 

Graphics general 494 
Zoom mode 137 

 

 


